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1

CHAPTER 1 Getting Started

Tecplot is a powerful tool for visualizing a wide range of technical data. It offers line plotting, 
2- and 3-D surface plots in a variety of formats, and 3-D volumetric visualization. This chapter 
describes Tecplot’s point-and-click interface.

1.1. Start-Up
The following sections describe how to start Tecplot on Windows or UNIX systems.

1.1.1. Windows
On Windows start Tecplot from the Start button, or from an icon on your desktop. To start Tec-
plot from the Start button:

1. Click Start, then select Programs.

2. Select the Tecplot 10 folder.

3. Click on Tecplot.

Following the opening banner, Tecplot appears.

1.1.2. UNIX
On UNIX systems, Tecplot is typically installed by a system administrator, who makes it avail-
able to users. Run Tecplot by typing:

 tecplot

at the shell prompt. The opening banner appears, followed by the Tecplot window, as shown in 
Figure 1-1.

The directory in which Tecplot is installed, on any platform, is called the Tecplot home direc-
tory. You should know the absolute path of this directory and set your TEC100HOME environ-
ment variable to point to it. The Tecplot home directory includes numerous example files 
referred to throughout this manual; by working with these files you can quickly gain profi-
ciency with Tecplot’s features.

1.2. Interface
There are four main regions in the Tecplot window—menu bar, sidebar, workspace, and status 
line.
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1.2.1. Menu Bar
The menu bar, shown in Figure 1-2, offers rapid access to most of Tecplot’s features, which are 
controlled primarily through dialogs.

Tecplot’s features are organized into the following menus:

• File: Controls reading and writing of data files and plot layouts, printing and exporting of 
plots, recording and playing macros, setting and saving configuration preferences, and exit-
ing Tecplot.

• Edit: Controls Undo functions, cutting, copying, pasting, and clearing objects, as well as 
pushing and popping (changing the draw order for selected items). The Edit menu also con-
tains an option for adjusting data points.

Figure 1-1. Tecplot in Motif showing the four main regions—menu bar, sidebar, 
workspace, status line.

Figure 1-2. Tecplot’s menu bar.
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Tecplot’s Cut, Copy, and Paste options work only within Tecplot. If you are operating in 
Windows and want to place a graphics image of your layout into other word processing or 
design program, use Copy Plot to Clipboard.

• View: Controls the point of view of your data, including scale, view range, and 3-D rota-
tion. You can also use the View menu to copy and paste views between frames.

The View menu includes sizing options for convenience. Center moves the plot image so 
that the data points are centered within the frame. (Only the data is centered; text, geome-
tries, and the 3-D axes are not considered.) Fit to Full Size fits the entire plot into the frame. 
Nice Fit to Full Size sets the axis range to begin and end on major axis increments (if axes 
are dependent Tecplot adjusts the vertical axis length to accommodate a major tick mark). 
Make Current View Nice modifies the range on a specified axis to fit the minimum and 
maximum of the variable assigned to that axis, then snaps the major tick marks to the ends 
of the axis. (If axis dependency is not independent this may affect the range on another 
axis.) Data Fit fits the data points to the frame.

• Plot: Dynamic menus feature different controls depending upon the plot type (3D Carte-
sian, XY Line, Polar Line, and so forth) selected from the sidebar. Plot menu options give 
you control over the style of your plots.

• Insert: Used to add text, geometries (polylines, circles, squares, ellipses, and rectangles), 
or image files.

• Data: Create, manipulate, and examine data. Types of data manipulation available in Tec-
plot include zone creation, interpolation, triangulation, as well as creation or alteration of 
variables by means of FORTRAN-like equations.

• Frame: Create, edit, and control frames.

• Workspace: Controls the attributes of your workspace, including the color map, paper 
grid, display options, and rulers.

• Tools: Run Quick Macros you may have defined, or to create simple animations of your 
plots. Add-ons—other than data loaders and extended curve fits—are accessed through the 
Tools menu.

• Help: Get quick help on features. By selecting About Tecplot. you can obtain specific 
information about your license. The Help menu also accesses information about add-ons 
you have loaded.

1.2.2. Sidebar
Tecplot’s sidebar accesses the most frequently used controls for plotting. Many take the form 
tools, which control the behavior of the pointer. Additional controls determine the plot type, 
which zone or map layers are active, and snap modes. The controls are organized in the follow-
ing functional clusters, as shown in Figure 1-3:

• Plot Types.
• Zone/Map Layers.
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• Zone Effects.
• Zone/Map Style.
• Redraw All/Redraw.
• Performance.
• Tools.
• Quick Edit/Object Details.
• Snap Modes.

1.2.2.1. Plot Types. Plot type, combined with a 
frame’s data set, active layers and their associated 
attributes, define a plot. Each plot type represents 
one view of the data. Plot type determines what type 
of plot can be drawn in the current frame. Five plot 
types are available:

• 3D Cartesian: Create 3-D plots of surfaces and 
volumes.

• 2D Cartesian: Create 2-D plots, such as plots of 
a variable located on a plane.

• XY Line: Create XY Line plots, such as plots of 
independent versus dependent variables.

• Polar Line: Create a Polar Line plot of radius 
versus angle, or vice versa. The polar axes are 
the radial axis (by default zero at the origin) and 
theta axis (by default zero for any data on the 
right running horizontal line).

• S (Sketch): Create plots without data such as 
drawings, flow charts, and viewgraphs.

1.2.2.2. Zone Layers/Map Layers. A layer is a 
way of representing a frame’s data set. The complete 
plot is the sum of all the active layers, axes, text, 
geometries, and other elements added to the data 
plotted in the layers. There are six zone layers for 2- 
and 3-D Cartesian, four map layers for XY Line, 
two for Polar Line, and none for Sketch.

The six zone layers for 2- and 3-D Cartesian plot types, shown in Figure 1-3, are:

• Mesh: Lines connecting the data points within each zone.

• Contour: Lines having a constant value, the region between these lines, or both.

Figure 1-3. Tecplot’s sidebar.
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• Vector: The direction and magnitude of vector quantities.

• Scatter: Symbols at the location of each data point.

• Shade: Used to tint each zone with a specified solid color, or to a add light-source to a 3-D 
surface plot. Used in conjunction with the Lighting zone effect you may set Paneled or 
Gouraud shading. Used in conjunction with the Translucency zone effect you may create a 
translucent surface for your plot.

• Boundary: Zone boundaries for ordered data.

The four XY Line map layers, shown in Figure 1-4, 
are:

• Lines: Plots a pair of variables, X and Y, as a set 
of line segments or a fitted curve.

• Symbols: A pair of variables, X and Y, as individ-
ual data points represented by a symbol you spec-
ify.

• Bars: A pair of variables, X and Y, as a horizontal or vertical bar chart.

• Error Bars: Available in several formats.

The two map layers for Polar Line, shown in 
Figure 1-5, are:

• Lines: A pair of variables, X and Y, as a set of line 
segments or a fitted curve.

• Symbols: A pair of variables, X and Y, as  
individual data points represented by a symbol 
you specify.

1.2.2.3. Zone Effects. For 3-D Cartesian plot types 
the check boxes shown in Figure 1-6 appear—Lighting; 
Translucency. Only shaded and flooded contour surface 
plot types are affected.

1.2.2.4. Zone Style/Mapping Style. Call up the 
appropriate dialog, allowing you to modify the appear-
ance of each zone or map.

1.2.2.5. Redraw Buttons. Allow you to keep your plot up to date: Redraw All redraws all 
frames (Shift-Redraw All causes Tecplot to completely regenerate the workspace); Redraw 
redraws only the current frame.

1.2.2.6. Performance. Calls up a quick access menu of enhancements to speed plotting. 
Selecting Options calls up the Display Performance dialog, where you may configure Tecplot’s 

Figure 1-4. Map layers for XY Line.

Figure 1-5. Map layers for Polar Line.

Figure 1-6. Zone Effects.
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status line, graphics cache, image export, and performance options. For further details, see 
Section 30.3, “Display Performance Dialog.” 

1.2.2.7. Tool Buttons. Each of the tools represented by a button is a mouse mode, specify-
ing the behavior of the pointer anywhere in the workspace. There are 28 modes in 12 catego-
ries, as shown in Figure 1-7.

• Contour mouse modes.
• Streamtrace mouse modes.
• Slicing mouse mode.
• Frame mouse mode.
• Zone creation mouse modes.
• 3-D rotation mouse modes.
• Text mouse mode.
• Geometry mouse modes.
• Mouse pointer modes: 

Selector and Adjustor.
• View mouse modes: 

Zoom and Translate/Magnify.
• Probe mouse mode.
• Data extraction mouse 

modes.

1.2.2.8. Enhanced Tool Oper-
ations. Several sidebar tools offer mouse and keyboard shortcuts which can greatly speed 
Tecplot use, especially when working with large amounts of data. These are:

• Contour tools:

+: Switch to Contour Add tool if you are using Contour Remove.

- : Switch to Contour Remove tool if you are using Contour Add.

• Contour Add tool:

Click: Place a contour line.

Ctrl-click: Replace the nearest contour line with a new line.

Drag: Move the new contour line.

• Streamtrace Placement tool:

D: Switch to streamrods.

R: Switch to streamribbons.

S: Switch to surface lines.

V: Switch to volume lines.

Figure 1-7. Sidebar tools and mouse modes.
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Alt-click/Alt-drag: Determine the XYZ-location by ignoring zones and looking only at 
derived volume objects (streamtraces, iso-surfaces, slices).

1-9: Change the number of streamtraces to be added when placing a rake of streamtraces.

• Slicing tool: 

Click: Place a start slice.

Drag: Move the start slice.

Alt-click/Alt-drag: Determine the XYZ-location by ignoring zones and looking only at 
derived volume objects (streamtraces, iso-surfaces, slices).

Shift-click: Place the end slice.

Shift-drag: Move the end slice.

+: Turns on the start slice if no slices are active, or turns on the end slice if slices are 
already active.

- : Turns off the end slice if the end slice is active, or conversely, turns off the start slice if 
the end slice is not active. 

I, J, K (ordered zones only): Switch to slicing constant I-, J-, or K-planes respectively.

X, Y, Z: Switch to slicing constant X-, Y-, or Z-planes respectively.

0-9: Numbers one through nine activate intermediate slices and set the number of interme-
diate slices to the number entered; zero turns off intermediate slices.

• Zoom tool: 

Click: Center a 200 percent magnification around the location of your click.

1.2.2.9. Mouse Operation Enhancements. The middle and right mouse buttons allow 
you to smoothly zoom and translate your data. Your middle mouse button (or Ctrl-right click) 
zooms smoothly, and your right mouse button translates data.

This advanced functionality is available in: all contour modes; streamline placement; slicing; 
3-D rotation modes; geometry modes (except polyline); zoom; translate/magnify; probe; zone 
creation.

1.2.2.10. Details Button. Immediately under the sidebar tools is a single button with a con-
text-sensitive label, referred to as the Details button. Use this button to call up the dialog most 
directly applicable to your current action. When the currently selected tool is either the Selec-

tor  or the Adjustor  , but no objects are selected in the workspace, the Details button 
is labeled Quick Edit. When either of those tools is selected and one or more objects are 
selected in the workspace, the label changes to Object Details. If any other tool is selected, the 
label changes to read Tool Details.
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1.2.2.11. Quick Edit. Calls up the Quick Edit dialog, where you can make rapid changes to 
selected objects in the workspace.

1.2.2.12. Snap Modes. Allow you to place objects precisely by locking them to the nearest 
reference point, either on the axis grid or on the workspace paper.

1.2.3. Status Line
The status line, running along the bottom of the Tecplot window, gives “hover help.” When 
you move the pointer over a sidebar tool, a button on the Quick Edit dialog, or a menu item, a 
description of the control appears. Brief instructions are displayed for tools.

Configuration of the status line can be changed by selecting Display Performance from the 
Workspace menu, or by clicking Performance on the sidebar and selecting Options from the 
sub-menu.

1.2.4. Tecplot Workspace
The workspace is the portion of your screen in which you create sketches and plots. This is 
done within a frame, which can be manipulated much like a process window. The current state 
of the workspace, including the sizing and positioning of frames, the location of the data files 
used by each frame, and all current attributes for all frames, make up a layout. By default, the 
workspace displays a representation of the paper Tecplot is set up to draw on, as well as a ref-
erence grid and rulers. The active frame, in which you are currently working, is on top. All 
modifications are made to the current frame.

Figure 1-8. The Tecplot workspace.
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1.2. Interface

1.2.5. File Dialogs
Each type of Tecplot file has at least two dialogs associated with it—one for opening files and 
one for saving files. These dialogs are similar, but differ when using Motif or Windows.

1.2.5.1. File Dialogs in Motif.  Figure 1-9 shows the Open Layout dialog for Motif. Near 
the bottom of the dialog is the Selection text field. If you know the complete path of the file 
you want to open or save, type it into this field and click OK.

At the top of the dialog is the Filter (Name Search) text field. Use this field to specify a file 
name filter; Tecplot to displays all sub-directories of the current directory in the Directories 
scrolled list, as well as all files in the current directory ending with the extension .lay in the 
Files scrolled list. The filter determines the initial path displayed in the Selection text field. To 
change the default file extensions, see Section 30.1.4, “Default File Name Extensions.”  

1.2.5.2. File Dialogs in Windows.  Figure 1-10 shows the Open Layout dialog for Win-
dows. In the lower half of the dialog is the File name text field. If you know the complete path 
of the file you want to open or save, you can type it into this field, then click Open. You can 
also use this field to specify a file name filter. By default, the Open Layout dialog has a file 
name filter of *.lay and *.lpk. To change the default file extensions, see Section 30.1.4, 
“Default File Name Extensions.”  

1.2.6. Operations
The operation of Tecplot controls are familiar to anyone who has used Motif or Windows. 
Most actions are performed by clicking the left mouse button. (If your mouse is configured for 
left-hand use, click the right mouse button.)

Figure 1-9. The Open Layout dialog for Motif.
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Another common mouse action is dragging. Dragging is used in resizing frames, creating and 
modifying geometries, and to alter or adjust data. Using your keyboard in conjunction with 
clicking and dragging the mouse produces different actions. For example, Tecplot makes 
extensive use of Ctrl-click (clicking the mouse while holding down the Ctrl key) in its probing 
feature.

The terms click, select, and choose are sometimes used interchangeably. It is useful, however, 
to keep in mind that select in general means to “select an item to operate on,” while choose in 
general means to “pick an action.”

To select an object in the workspace, click on it. To select an object and call up the dialog used 
to modify the object, double-click on it. Double-clicking on a piece of text calls up the Text 
dialog, where you can edit or reformat the text. Select an object, then click on Details on the 
sidebar for the same effect. You can select groups of items, then act on them all at once.

After you have selected a group of items and 
released the mouse key, Tecplot calls up the 
Group Select dialog. Select the objects you 
want using the appropriate check boxes, as 
shown in Figure 1-11.

1.2.7. Object Positioning and 
Resizing
Selected objects such as frames, text, geome-
tries, legends, and so forth, may be moved 
either by clicking and dragging, or by using the 

Figure 1-10. The Open Layout dialog for Windows.

Figure 1-11. The Group Select dialog.
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arrow keys on your keyboard. Arrow keys move objects in one pixel increments. For more 
information on moving and resizing frames, see Section 2.1.3, “Frame Positioning and Siz-
ing.” 

To scale selected objects proportionally, maintaining the vertical to horizontal aspect ratio, 
select the object, then press “+” on your keyboard to enlarge or “-” to reduce. Double-clicking 
a selected object calls up the appropriate style dialog. For example, if you double-click on a 
geometry, the Geometry dialog appears.

1.2.8. Quick Edit Dialog
The map and zone layer controls affecting how 
the individual layers are drawn can be altered 
using controls on the sidebar. You can also con-
trol many of these attributes using the Quick 
Edit dialog, shown in Figure 1-12.

To use the Quick Edit dialog, select one or more 
objects in the workspace, then click the appro-
priate button to change the attribute of the 
selected object(s).

1.3. Help
Tecplot features a fully integrated Help system. 
Quick help on menu items and sidebar controls 
is available from the status line.

Figure 1-13. Tecplot Help in a Windows Web browser.

Figure 1-12. The Quick Edit dialog.
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Detailed help is accessible by:

• Pressing the F1 key anywhere in the Tecplot window. If the pointer is over the sidebar, 
Quick Edit dialog, or a menu, the F1 key provides context-sensitive help on that control or 
menu. Otherwise, F1 calls up the Contents page of Help via your Web browser.

• Selecting Contents from the Help menu. This calls up the Contents page of the Tecplot help 
file via your Web browser.

• Clicking Help on any dialog.

Figure 1-13 shows Tecplot’s Help as it appears in a Web browser in Windows. It supports text 
search, has many hypertext links, and provides detailed information on all menus and dialogs. 
Your answer may be in Technical Support Notes at www.tecplot.com/support. Help is also 
available from 6:30 A.M. to 5 P.M. Pacific Standard Time from Tecplot Technical Support at 
425.653.9393. You may also send e-mail to support@tecplot.com with your questions.
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CHAPTER 2 Frames and the 
Workspace

No matter which type of plot you want to create, certain operations occur repeatedly within 
Tecplot. Those operations concerning files are covered in Chapter 3, “Data Organization.” 
Operations concerning software are covered here, including:

• Working with frames: Plots are created in a frame—a boxed area in the workspace acting 
as a sub-window. You control the format of each individual frame.

• Managing your workspace: Workspace and paper controls determine the color and orien-
tation of your paper, as well as the ruler and grid, to precisely size and position objects.

• Coordinate systems: Learn when and where Tecplot uses different coordinate systems.

• Plot view: Zoom, translate, and fit plots within frames.

• Cut, Copy, Paste: Many plot elements may be cut or copied from the workspace and 
pasted back into other plot elements.

2.1. Frames
All plots and sketches are drawn within frames. By default, the Tecplot workspace contains 
one frame. You may add additional frames, up to 128. You may resize and reposition frames, 
modify background color, and specify border and header appearane. Tecplot acts upon only 
one frame—the current frame—at any given time, except when frames are linked.

2.1.1. Frame Creation
Create new frames interactively by drawing them in the workspace. If printing plots, draw 
frames within the paper displayed in the workspace. (However, this is not required.)

To create a new frame:

1. From the sidebar, select , or choose Create New Frame from the Frame menu.

2. Move the pointer into the workspace; it becomes a cross-hair. Move the cross-hair to the 
desired corner of a new frame, then click and drag. A rubber band box shows the outline of 
the frame.

3. When the box is the desired size and shape, release the mouse button.
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2.1.2. Frame Deletion
Delete frames one at a time using Delete Current Frame from the Frame menu, or using Clear 
from the Edit menu.

To delete a group of frames:

1. Select a group of frames. The Group Select dialog appears.

2. In the Objects area of the dialog, deselect all check boxes except Frames. All the frames 
within the rubber band box are selected.

3. From the Edit menu, choose Clear. (In Motif, with the keyboard focused on Tecplot, type 
Delete.) A warning dialog appears asking if you want to delete the selected items.

4. Click OK to delete; Cancel to retain.

2.1.3. Frame Positioning and Sizing
You can size and position frames in four ways—with your mouse, with the arrow keys on your 
keyboard, by specifying exact coordinates using Edit Current Frame from the Frame menu, or 
by choosing Fit all Frames to Paper (also from the Frame menu).

2.1.3.1. Mouse Positioning and Sizing. If you click anywhere on a frame’s header or 
border, handles appear at its corners and midpoints. Drag any of these to resize the frame. The 
handles on the top and bottom of the frame allow resizing vertically; the handles on the left and 
right of the frame allow resizing horizontally. The handles on the four corners allow simulta-
neous vertical and horizontal resizing. You can also obtain the resizing handles by selecting a 
group of frames. To scale frames proportionally, maintaining the vertical to horizontal aspect 
ratio, select the frames, then press “+” on your keyboard to enlarge or “-” to reduce.

2.1.3.2. Arrow Key Positioning and Sizing. After selecting frames, you may position 
them using the arrow keys on your keyboard. You can move frames up, down, left or right in 
one-pixel increments for precise location. However, you cannot resize a frame using arrow 
keys.

2.1.3.3. Edit Current Frame Dialog Positioning and Sizing. For precise control over 
frame size and location, use the Edit Current Frame dialog. You may specify the exact location 
for the frame’s left and top sides, along with width and height. The same units are displayed on 
the workspace rulers as are on the dialog.

To precisely position and size your frame:

1. From the Frame menu, choose Edit Current Frame, or double-click on the header or border 
of the current frame. The Edit Current Frame dialog appears, as shown in Figure 2-1. 

2. Enter the position of the left side of the frame in the Left Side text field and the position of 
the frame’s top side in the Top Side text field in Paper Ruler units.

3. Using Paper Ruler units, enter the width and height of the frame in the Width and Height 
text fields. (Units other than Paper Ruler may be specified by typing them after the number. 
For example, cm for centimeters, in for inches, or pix for pixels.)
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2.1.4. Frame Background Color Modification
Alter the frame background color for a variety of effects. To create a transparent frame, turn off 
the background color completely.

To turn off the background color and create a transparent frame:

1. From the Frame menu, choose Edit Current Frame.

2. On the Edit Current Frame dialog, deselect the Show Background check box. (By default, 
this check box is selected.)

To set a different background color:

1. From the Frame menu, choose Edit Current Frame.

2. On the Edit Current Frame dialog, verify Show Background is selected. To the right of the 
Show Background check box click Color to set the appropriate color. 

2.1.5. Frame Border and Header Controls
Frame borders act much like a picture frame, giving a visual outline of the drawing region. 
However, visible borders may be undesirable. For example, if you are building a composite 
plot out of multiple frames, multiple borders may detract from the appearance. Tecplot allows 
you to turn off frame borders for any frame. You can make borders invisible (making headers 
invisible), or you can display the border without the header. You can also control border thick-
ness. (Thickness is specified in frame units as a percentage of the frame height.)

The frame header contains user-configurable information which defaults to:

"&(FrameName) | &(date) | &(DataSetTitle)"

This displays information about the frame’s name, date created or revised, and, if applicable, 
the title of the current data set. These defaults can be changed in your configuration file; see 
the $!GLOBALFRAME command in the Tecplot Reference Manual.

Figure 2-1. The Edit Current Frame dialog in Motif.
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The frame header is displayed when the Show Border and Show Header check boxes are 
selected on the Edit Current Frame dialog. However, if you turn off the border by deselecting 
the Show Border check box, the header turns off as well. You can choose any of Tecplot’s 
colors for the frame header.

On most screens, the header information is difficult to read unless you zoom into the paper (for 
example, by selecting Fit All Frames to Workspace from the Workspace menu).

To modify borders and headers:

1. From the Frame menu, choose Edit Current Frame.

2. On the Edit Current Frame dialog, set your header and border settings as desired.

Invisible borders frustrate positioning and resizing. To overcome this, Tecplot displays a 
dashed representation of invisible borders. Turn off this feature using Show Invisible Frame 
Borders from the Workspace menu. When  Show Invisible Frame Borders is selected (the 
default), a small box (or check mark) appears on the Workspace menu. The default can be 
changed in your configuration file; see the $!INTERFACE ShowFrameBorder-
sWhenOff command in the Tecplot Reference Manual.

2.1.6. Frame Name Modification

You may alter any frame name so it reflects the contents of the frame. One advantage of giving 
frames meaningful names is that they are easily distinguished in the Order Frames dialog.

To change the name of the current frame:

1. From the Frame menu, choose Edit Current Frame.

2. On the Edit Current Frame dialog, change the name as desired.

2.1.7. Frame Pushing and Popping
There are times when you want to expose—pop—overlapping or overlaid frames. For partially 
exposed frames, click on the exposed portion (in any mouse mode except Create Frame). For 
completely obscured frames, pop underlying frames by pushing the covering frames to the 
back of the plot, or by using the Frame menu’s Order Frames option.

To push a frame to the back of the plot:

1. Select the appropriate frame by clicking on it. This makes it the current frame.

2. From the Frame menu, choose Push Current Frame Back.

If you have multiple overlaid frames, repeat these steps until the desired frame is on top, or pop 
a specific frame using Order Frames. If part of a frame is visible, pop it to the top by clicking 
on it.

To pop a frame by name using Order Frames:

1. From the Frame menu, choose Order Frames. The Order Frames dialog appears, as shown 
in Figure 2-2.
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2. Select the desired frame by name from the list box and click Pop, or double-click on a 
name.

3. To change the display order of the frame names within the list, select the List By drop-
down. (List By does not affect actual frame order within the workspace, only the display of 
the names within the list box.)

2.2. Workspace Management
The  workspace is the entire region in which you can create Tecplot frames, including, but not 
limited to, the region covered by the paper. You may find yourself using only the paper area in 
creating the screen plots. This is a natural way to work, but not essential, since the paper only 
limits the printing of the plots. If you are creating plots for screen use only, you may find it use-
ful to use the entire workspace. One way to do this is to turn off display of the paper.

2.2.1. Paper Set-Up
Tecplot’s representation of paper in the workspace allows you to lay out plots precisely the 
way you want them printed. If you place a frame on the paper and print the resulting plot, the 
frame appears in the exact relative location on the printed paper.

You can control the size, orientation, even the color of your paper. You can also turn off the 
screen representation of the paper.

2.2.1.1. Paper Size Controls. Tecplot offers the following six paper sizes:

• Letter: Standard U.S. letter size, 8 1/2 by 11 inches.

• Double: Standard U.S. ledger size, 11 by 17 inches.

• A4: Standard European letter size, 21 by 29.7 centimeters.

• A3: Standard European size, 29.7 by 42 centimeters.

• Custom 1: Default is 8.5 by 14 inches.

• Custom 2: Default is 8 by 10 inches.

Figure 2-2. The Frame Order dialog.
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To choose a paper size:

1. From the File menu, choose Paper Setup. The Paper Setup dialog appears.

2. In the Size area of the Paper Setup dialog, select the desired paper size. (In Windows, you 
can also set paper size using the File menu’s Print option.)

All paper sizes may be customized using options in configuration or macro files. It is recom-
mended that you only change the dimensions of the Custom 1 and Custom 2 paper sizes. To 
change the Custome sizes see the $!PAPER command in the Tecplot Reference Manual.

2.2.1.2. Paper Orientation Controls. Tecplot layouts can be landscape or portrait plots. In 
landscape (the default), the long axis of the paper is horizontal, while in portrait the long axis is 
vertical. Portrait orientation uses the width of the specified paper for the horizontal dimension, 
while landscape uses this for the vertical dimension. You specify the orientation as part of 
paper set-up.

To specify a paper orientation:

1. From the File menu, choose Paper Setup. The Paper Setup dialog appears.

2. In the Orientation area of the dialog, select the desired orientation.

2.2.1.3. Screen Paper Controls. If you are creating plots for display on your screen you 
can turn off the screen representation of the paper and use the full workspace.

To turn off the screen paper:

1. From the File menu, choose Paper Setup. The Paper Setup dialog appears.

2. Deselect Show Paper on Screen.

2.2.1.4. Paper Color Controls. You can set up your paper to show any of Tecplot’s colors 
as a background color (the “paper fill color”) on your screen, as well as use that color when 
printing to a color printer. 

To specify paper fill color:

1. From the File menu, choose Paper Setup. The Paper Setup dialog appears.

2. Click Paper Fill Color. On the resulting dialog, choose the desired color.

When you are printing, Tecplot can flood the paper with your specified fill color. (By default, 
the paper fill color is ignored during printing.)

To use the paper fill color when printing:

1. From the File menu, choose Paper Setup. The Paper Setup dialog appears.

2. Select Use Paper Fill Color when Printing.

2.2.2. Grid and Ruler Set-Up
The workspace grid provides a convenient guide for placing objects on your paper. When plac-
ing text or geometric shapes, you can choose to snap the anchor points of the shapes to the 
grid.
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2.3. Coordinate Systems

Rulers provide a reference length for sizing objects. You may draw the rulers in centimeters 
(cm), inches (in), or points (pt), or not draw them at all.

2.2.2.1. Workspace Grid Controls. Tecplot allows you to select grid spacing from several 
pre-set sizes in centimeters (cm), inches (in), or points (pt). You can also specify not to show 
the grid. The grid is not shown if the paper is not visible onscreen, or if the Show Grid check 
box is not selected.

To turn off the grid:

1. From the Workspace menu, select Ruler/Grid. The Ruler/Grid dialog appears.

2. Deselect Show Grid.

To specify the grid spacing:

1. From the Workspace menu, select Ruler/Grid. The Ruler/Grid dialog appears.

2. From the Grid Spacing drop-down, choose the desired spacing.

2.2.2.2. Workspace Ruler Controls. Tecplot allows you to select the ruler markings from 
several pre-set sizes in centimeters (cm), inches (in), or points (pt). You can also specify 
whether to show the ruler.

To turn off the ruler:

1. From the Workspace menu, select Ruler/Grid. The Ruler/Grid dialog appears.

2. Deselect Show Ruler.

To specify the ruler spacing:

1. From the Workspace menu, select Ruler/Grid. The Ruler/Grid dialog appears.

2. From the Ruler Spacing drop-down, choose the desired spacing.

2.2.3. Workspace Maximization
You can create plots up to the full size of the workspace, and you can force the workspace to 
fill the Tecplot window, hiding the sidebar and menu bar.

To maximize your workspace:

1. From the Workspace menu, choose Maximize Workspace. The sidebar and menu bar disap-
pear.

2. Press Esc to return to the standard view.

2.3. Coordinate Systems
Tecplot manages a number of coordinate systems. Four of these coordinate systems that are 
important to know about are the paper, frame, 2- and 3-D physical coordinate systems. The ori-
gins of each coordinate system and how they relate to one another is shown in Figure 2-3.
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Only one of the 2- or 3-D physical coordinate systems is in effect at any given time, depending 
on the plot type in use. The 2- and 3-D physical coordinate systems plot the X-, Y-, and or Z-
coordinates of data points. Two-dimensional physical coordinates are often referred to as grid 
coordinates. The frame coordinate system is shown in Figure 2-4. 

Figure 2-3. Coordinate systems in Tecplot.

 

Figure 2-4. The frame coordinate system.
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2.4. View Modification

The vertical axis of this coordinate system always runs from zero at the bottom border of the 
frame to 100 at the top of the frame. Likewise, the horizontal axis runs from zero to 100 from 
left to right along the bottom edge of the frame. The distance of one horizontal unit is not nec-
essarily equal to the distance of one unit in the vertical direction, since frames take on almost 
any aspect ratio.

Tecplot uses the height of the frame for objects scaled by frame units, such as font size. When-
ever you enter a frame unit value into a dialog, or you are setting frame size and position on the 
paper, you may specify a different unit system as a suffix. Values are converted to frame units 
(or paper units when sizing or positioning a frame) for you. Valid suffixes are “in” (inches), 
“pt” (points), “cm” (centimeters), and “pix” (pixels). For example, if you want a piece of text 
exactly one inch away from the left edge of your frame, you would enter “1in” in the X-Origin 
text field on the Text Details dialog. Tecplot converts this to the appropriate frame unit value.

2.4. View Modification
There are two types of views inside Tecplot. The first is the view of your data inside a frame. 
Each frame can have a separate view of its data. This is controlled using the View menu.

The second type of view is of the frames and paper inside the workspace. This view is con-
trolled using the Workspace menu.

Both views may be controlled by the two view mouse modes on the sidebar—Zoom and Trans-
late. However, other actions differ depending on whether working with a frame or the work-
space.

2.4.1. View of Data within a Frame
The view of your Tecplot data is the position, size, and orientation of the plot within a frame. 
The View menu contains controls to help you adjust the view, as well as copy the view from 
one frame to another. The View menu contains the following options:

• Redraw: Redraws the current frame.

• Zoom: Turns on the Zoom mode to train in on the current frame.

• Fit to Full Size: Resizes plots so all data points, text, and geometries are included in the 
frame.

• Nice Fit to Full Size (2D Cartesian, XY Line, and Sketch plot types only): Sets axis 
range to begin and end on major axis increments (if axes are dependent Tecplot adjusts the 
vertical axis length to accommodate a major tick mark).

• Data Fit: Resizes the plot so all data points are included in the frame. Text and geometries 
are not considered.

• Make Current View Nice (2D Cartesian, XY Line, and Sketch plot types only): Modi-
fies the range on a specified axis to fit the minimum and maximum of the variable assigned 
to that axis, then snaps the major tick marks to the ends of the axis. (If axis dependency is 
not independent this may affect the range on another axis.)
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• Center: Centers the plot within the frame.

• Translate/Magnify: Turns on the Translate mode and calls up the Translate/Magnify dia-
log, which you use to move and resize your plot with respect to the frame.

• Last: Restores the previous view.

• Rotate (3D Cartesian plot type only): Calls up the Rotate dialog for image rotation. For 
further information, see Section 7.6.1, “Three-Dimensional Rotation.” 

• 3D View Details (3D Cartesian plot type only): Calls up the 3D View Details dialog for 
setting the view position and angle of 3-D images. For further information see 
Section 7.6.1, “Three-Dimensional Rotation.” 

• Copy View: Copies the current frame view to a buffer; it can then be pasted onto another 
frame.

• Paste View: Pastes a copied view onto the current frame.

Shortcuts are provided for most View menu controls. For Zoom, use  on the sidebar to 

select the Zoom mode. For Translate/Magnify, use  on the sidebar. For Fit to Full Size, use 
the keyboard shortcut Ctrl-F. For Last, use the keyboard shortcut Ctrl-L. For Paste View, use 
the keyboard shortcut Ctrl-A. There are no shortcuts for Data Fit, Center, or Copy View.

2.4.1.1. Mouse Zoom and Translation. The middle and right mouse buttons allow you to 
smoothly zoom and translate data. Your middle mouse button (Ctrl-right click) zooms 
smoothly, and your right mouse button translates data. (See Appendix C, “Mouse and Key-
board Operations,” for additional functionality.) Advanced functionality is available in: 
Contour Modes; Streamtrace Placement; Slicing; Rotation Modes; Geometry Modes (Except 
Polyline); Zoom; Translate/Magnify; Probe; Zone Creation.

2.4.1.2.  Zoom Tool. Select the Zoom tool from the sidebar; the pointer becomes a magnify-
ing glass. Click and drag to create a rubber band box around the region you want to magnify. 
The plot resizes to fit the longest dimension of the box. Zoom into a region by positioning the 
magnifying glass and clicking your left mouse button. It magnifies the area by 200 percent, 
centering on the position of the magnifying glass.

It may be useful to zoom into successively smaller regions until the area of interest includes 
adequate detail. For example, finite-element data file feexchng.plt shows an area of inter-
est containing many circles. You zoom in on the circles, and then zoom in again on a single 
circle. Finally, you zoom in on the boundary of a circle, as illustrated in Figure 2-5.

Fit one or all frames to the workspace by using the Fit Selected Frame or Fit All Frames to 
Workspace on the Workspace menu. Both are alternative methods of zooming the paper. To 
return to the default view, choose Fit Paper to Workspace from the Workspace menu. At any 
stage of the zoom, you can use Ctrl-L to return to the previous (last) view, Ctrl-F to return to 
the full size initial view, or Ctrl-Z (Undo) to restore the previous view.
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2.4. View Modification

2.4.1.3. Data Translating and Scaling. Use the Translate/Magnify feature to translate the 
view of your data. Translating moves the image of your data in respect to the current frame. 
You can translate plots in any direction within a frame. The Translate/Magnify feature is avail-
able as both a sidebar tool and as a dialog accessed from the View menu, shown in Figure 2-6.

The following options and shortcuts are available for the Translate/Magnify dialog:

• Up, Down, Left, Right: Use the arrows to translate the image in the desired direction.

• Magnification Factor: Change magnification using the arrows, or enter a value in the text 
field.

• Step Size (%): Control the step size for each arrow using pre-set ranges from the drop-
down, or by entering your own value.

To translate an image using the sidebar’s Translate/Magnify tool:

Figure 2-5. Zooming into a plot.

Figure 2-6. The Translate/Magnify dialog.
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1. On the sidebar, click . The pointer changes to an all-direction cursor.

2. In the workspace, drag in the direction you want to transfer the image.

Translate/Magnify tool mode offers the following keyboard options:

+: Increase scale of images.

- : Decrease scale of images.

2.4.1.4. Data Fit. You can use the Fit to Full Size option from the View menu to restore the 
initial view of your data after extensive zooming, scaling, or translating. Tecplot performs the 
Fit to Full Size operation when it first displays your data set. You can perform the operation in 
either of the following ways:

• Select Fit to Full Size from the View menu.

• While the window is active, press Ctrl-F.

2.4.1.5. Last View. Allows you to step backward through the resizings and repositionings of 
plots. Any time you change the view of a frame, either by zooming, centering, translating, or 
fitting the plot, the previous view is placed in a view stack. Each frame has four view stacks, 
one for each plot type. Each view stack stores the last sixteen views for that plot type. Move 
back through the view stack by choosing Last from the View menu repeatedly, or pressing 
Ctrl-L repeatedly.

2.4.1.6. Copy and Paste Views. When you are working with multiple frames attached to 
the same data set, it is often useful to make your view changes to one frame, and then propa-
gate those changes to the other frames. You can do this using the Copy View and Paste View 
options under the View menu, as follows:

1. Make the changes (zooming, translating) you want to make to one frame. 

2. From the View menu, choose Copy View. 

3. Click in another frame sharing the same plot type.

4. From the View menu, choose Paste View (or press Ctrl-A). Note that Copy View and Paste 
View only affect the ranges of XY-axis and tick mark spacing. For complete duplication, 
use Copy Style to File and Paste Style from File from the Style menu.

2.4.2. Frame and Paper Views within the Workspace
The view of your frames and the paper within the workspace is controlled through the Work-
space menu. This is called the workspace view.

The Workspace menu contains the following options:

• Display Performance: Calls up the Display Performance dialog where you can customize 
Tecplot’s graphic resource management to suit your needs.
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2.4. View Modification

• Ruler/Grid: Calls up the Ruler/Grid dialog, controlling for the workspace ruler and paper 
grid.

• Show Invisible Frame Borders: Hide or display invisible frame borders for placement 
purposes.

• Redraw All: Redraws all frames and the paper.

• Fit Selected Frames to Workspace: Resizes the workspace view so selected frames are 
included in the view.

• Fit All Frames to Workspace: Resizes the workspace view so all frames are included in 
the view.

• Fit Paper to Workspace: Resizes the workspace view so the paper is included in the view.

• Last Workspace View: Restores the workspace to its previous view.

• Maximize Workspace: Set the workspace to its largest size. Use Esc to return to your nor-
mal view.

• Color Map: Calls up the Color Map dialog, where you may customize Tecplot’s color map 
settings using five pre-defined schemes, an interpolated scheme, or a user-defined scheme.

• Copy Color Map to File: Allows you to save a color map file.

• Paste Color Map from File: Allows you to load a color map file.

2.4.2.1. Workspace Zooming. Use the  sidebar tool to zoom the workspace. The 
pointer changes to a magnifying glass. Shift-drag the magnifying glass to draw a box around a 
region to magnify. The plot resizes so the longest dimension of the box fits into the workspace. 

2.4.2.2. Workspace Translating and Scaling. Use the  sidebar tool to translate and 
magnify paper and image simultaneously. (Magnifying the screen image does not affect the 
printout size.)

To translate the entire paper and image:

1. Click the  sidebar tool for Translate/Magnify mode.

2. Shift-click to operate on paper and image simultaneously. (Leave the mouse button down.)

3. Drag to move the paper.

To magnify the entire paper and image (operates on the on-screen paper and image only):

1. Click the  sidebar tool for Translate/Magnify mode.

2. Shift-click to operate on paper and image simultaneously. Remember to leave the mouse 
button down.

3. Press “+” to magnify paper and image, “-” to reduce.

You can move and rescale the paper simultaneously as long as you hold down the mouse 
button. If you release the button, “+” and “-” revert to resizing the image.
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2.4.2.3. Workspace View Fit. You can use Fit Paper to Workspace from the Workspace 
menu to restore the initial view of the paper. Tecplot fits the paper to the workspace when it 
first starts.

2.4.2.4. Last Workspace View. You may restore the last workspace view with Last Work-
space View from the Workspace menu. When you change the view of the workspace, using Fit 
Selected Frames to Workspace or Fit All Frames to Workspace for example, the previous view 
is placed in a view stack, which stores the last sixteen views. Cycle back through the view 
stack by choosing Last Workspace View repeatedly, or use Undo from the View menu.

2.5. Cut—Copy—Paste—Clear—Undo
Duplicate frames, text, and geometries with the copy and paste options of the Edit menu (or 
their keyboard equivalents). You can also cut objects from one location and paste them into 
another, or throw them away completely. To select all geometries, zones, text or streamtraces 
in a frame, choose the Select All option from the Edit menu.

Under Windows, the Cut, Copy, and Paste options work only within Tecplot. However, the 
Edit menu’s Copy Plot to Clipboard, option allows you to copy Tecplot frames and paste them 
into other Windows applications. See Section 22.14, “Clipboard Exporting to Other Applica-
tions,”  for a discussion of this feature.

If you cut or clear the last Tecplot frame, Tecplot automatically creates another frame to 
replace it.

Tecplot can undo all plot and mapping style modifications. In addition, Tecplot allows you to 
undo a variety of other plot alterations. As a rule, Tecplot allows undo for reversable opera-
tions that can be restored without significant impact on the operation’s performance. To undo 
an operation, select Undo from the Edit menu, or press Ctrl+Z in the workspace.

Specifically, the Undo option is allowed for the following conditions:

• All zone and map style changes.

• Some (though not all) frame control operations, push and pop.

• Creating new frames.

• View operations.

• Some pick operations.

• Streamtrace actions.

• The following data alterations:

- Deleting zones and variables.

- Renaming data set zones and zones.

- Creation of rectangular or circular zones.

- Duplication of zones.



27

2.5. Cut—Copy—Paste—Clear—Undo

- Equation processing. (Except equations containing derivatives.)

Notes: Undo is unavailable for all data operations once an Undo operation has been performed 
on an un-allowed item. In addition, once an operation is performed that is not undoable, the 
entire undo history for that frame is erased.
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CHAPTER 3 Data Organization

This chapter describes Tecplot’s internal handling and storage of data.

3.1. Data Hierarchy
Tecplot structures data in two levels. The highest level in Tecplot’s internal data structure is a 
data set. Data sets consist of one or more zones. Zones—blocks of data making up a data set—
are the second level in the data hierarchy. They can be created in Tecplot, or loaded from a file. 
A data hierarchy example is shown in Figure 3-1.

Starting with an empty frame, a data set is created and assigned to the active frame whenever 
you read one or more data files into Tecplot, or create a zone within Tecplot. Multiple frames 
can be attached to the same data set. How data sets and frames relate to one another is shown in 
Figure 3-2.

If more than one data file is read into a frame, Tecplot groups all the zones from the files into 
one data set. Once in Tecplot, all zones in a data set must contain the same variables defined 
for each data point. (This does not necessarily mean each of your data files needs to have the 
same number of variables in the same order. See Section 5.1, “Tecplot-Format Data File Load-
ing,” for loading dissimilar data files or parts of data files.) The number of zones in a concate-
nated data set is the sum of the number of zones in the data files that are read. As Figure 3-2 

Figure 3-1. Tecplot data structure.
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shows, one or more frames can access data from the same data set. Frames using the same data 
set initially have the same header color.

A more complex example of Tecplot data structure is shown in Figure 3-3.

Frames 1 and 2 both access data set 1, itself made up of a data file with three zones. Frame 3 
accesses data set 2 containing two data files—one with two zones and one with three zones. 
Frame 4 uses data set 3, containing one data file of two zones. 

Figure 3-2. Data sets and frames.

Figure 3-3. A complex data structure example.
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3.2. Multiple Zones

3.2. Multiple Zones
Multiple zones may be used for plotting complex configurations, or sub-dividing data for con-
venience. You may also represent data taken at different time steps, or using measurement 
methods. An illustration of multiple zones is shown in the left-most plot in Figure 3-4.

You could use multiple zones to show the measurement of snow depth at several different sta-
tions in an XY Line plot. You take measurements once a day at each station, but there are some 
days on which you cannot get to all of the stations. As a result, when you are finished taking 
data, you have a different number of data points for each station. Since each set of data has the 
same number of variables per data point (time and snow depth), you can set up a Tecplot data 
file with the measurements from each station in a separate zone. In Tecplot, you can define a 
set of mappings to plot snow depth versus time for any combination of zones (in this example, 
stations). Figure 4-4 shows a plot of this data.

3.3. Data Structure in Zones
Tecplot accommodates two different types of data: ordered and finite-element. The following 
sections describe each in detail.

3.3.1. Ordered Data
Ordered data is a set of points logically stored in a one-, two-, or three-dimensional array in 
Tecplot. I, J, and K are used as sub-scripts to access values within the array.

Figure 3-4. Example plots showing the use of multiple zones. A 2-D 
Cartesian mesh is on the right; an XY Line plot on the right.
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The most common forms for these arrays are:

• I-ordered: One-dimensional array of data points where the I-dimension is greater than or 
equal to one and the dimension in J- and K-directions is equal to one. The I-dimension rep-
resents the total number of data points for the zone.

• IJ-ordered: Two-dimensional array of data points where both the I- and J-dimensions are 
greater than one and the K-dimension is equal to one. The number of data points is the 
product of the I- and J-dimensions.

• IJK-ordered: Three-dimensional array of data points where all three of the I-, J-, and K-
dimensions are greater than one. The number of data points is the product of the I-, J-, and 
K-dimensions.

Other ordered data types are also valid but are not typically created in Tecplot. These may 
come from data sets created by other applications wishing to retain a particular data order. 
They are:

• J- or K-ordered: The same as I-ordered but the J- or K-dimension is greater than one and 
the remaining dimensions are equal to one.

• JK- or IK-ordered: Similar to IJ-ordered. In both cases two of the three dimensions are 
greater than one and the remaining dimension is equal to one.

In general, discussions which refer to using I-ordered data may be applied to J- or K-ordered 
data. All three represent a logical one-dimensional array of data. Likewise, all discussions 
referring to IJ-ordered data may be applied to JK- or IK-ordered data.

3.3.1.1. I-, J-, or K-Ordered Data Points. Data points for XY Line plots are usually 
arranged in a one-dimensional array indexed by one parameter: I for I-ordered, J for J-ordered, 
or K for K-ordered, with the two remaining index values equal to one. For I-ordered, the most 
common type, I is as follows: I=1 at the first data point, I=2 at the second data point, I=3 at the 
third data point, and so forth to I=IMax for the last point. At each data point, N variables (V1, 
V2, ..., VN) are defined. If you arrange the data in a table where the values of the variables (N 
values) at a data point are given in a row, and there is one row for each data point, the table 
would appear something like that shown in Figure 3-5. For example, if you wanted to make a 
simple XY-plot of pressure versus time, V1 would be time and V2 would be pressure.

V1 V2 V3 V4 V5 V6 ... VN (Values at data point I = 1.)

V1 V2 V3 V4 V5 V6 ... VN (Values at data point I = 2.)

V1 V2 V3 V4 V5 V6 ... VN (Values at data point I = 3.)

V1 V2 V3 V4 V5 V6 ... VN

V1 V2 V3 V4 V5 V6 ... VN

Figure 3-5. Table of values for I-ordered data points (suitable for XY-plots).
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3.3. Data Structure in Zones

You may also input data for 2- and 3-D vector and scatter plots in I-ordered format. You could 
create a 3-D vector plot by setting the first six variables at each data point to the three physical 
coordinates (X, Y, Z) and the three velocity vector components (U, V, W). However, if you did 
this, you would not be able to use features like light source shading, hidden-surface removal, 
or streamtraces. These features depend upon a mesh structure connecting the data points (see 
IJ- and IJK-ordering and finite-element surface points in the next sections).

3.3.1.2. IJ-Ordered Data Points. The data points for 2- and 3-D surface field plots are usu-
ally organized in a two-parameter mesh. Each data point is addressable by a set of the two 
parameters (I and J) and has four neighboring data points (except at the boundaries). The 
points are located above, below, to the left, and to the right as shown in Figure 3-6. 

At each data point define two (or three) spatial variables (X, Y, and Z) plus one or more vari-
ables like temperature, velocity components, or concentration. Plot the data points in a 2- or 3-
D coordinate system where any two (or three) of the variables defined at the data points are the 
spatial coordinates (by default, the first two or three are used).

A family of I-lines results by connecting all of the points with the same I-index. Likewise, a 
family of J-lines is formed in the same way. When both the I- and J-lines are plotted in a two-
dimensional coordinate system, a 2-D mesh plot results. When both the I- and J-lines are 
plotted in a three-dimensional coordinate system, a 3-D surface mesh plot results. Both meshes 
are shown in Figure 3-7.

V1 V2 V3 V4 V5 V6 ... VN

V1 V2 V3 V4 V5 V6 ... VN (Values at data point I = 
IMax.)

Figure 3-5. Table of values for I-ordered data points (suitable for XY-plots).

(I, J)

(I, J+1)

(I+1, J)(I-1, J)

(I, J-1)

Figure 3-6. IJ-ordered data point neighbors.
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The data points lie at the intersections of the I- and J-lines. The points along the I-lines and J-
lines need not be in a straight line. The points may trace out curved, irregularly spaced, and/or 
nonparallel paths. They may lie in a planar 2-D or on a non-planar 3-D surface.

Data organized in IJ-order can also be used for XY Line plots. I-order is actually the same as 
IJ-order with J equal to one. In XY Line plots, you can specify the range (maximum and mini-
mum) and skip interval for the I- and J-indices for plotting data points; data points outside of 
the specified ranges are not plotted. You can also plot the I-lines or the J-lines of an IJ-ordered 
zone.

3.3.1.3. IJK-Ordered Data Points. The data points for 3-D volume field plots are usually 
organized in a three-parameter mesh. Each point is addressable by a set of three parameters (I, 
J, and K) and has six neighboring data points (except at the boundaries). These neighbors are 
located above, below, left, right, in front of, and behind the data point as shown in Figure 3-8.

At each data point, you define three spatial variables (X, Y, Z) plus (typically) one or more 
variables such as pressure, vector components, and vorticity.

A mesh plot of IJK-ordered data is displayed in Figure 3-9. The directions of the I-, J-, and K-
indices are shown. As you can see, the points that define the mesh can form curved, irregularly 
spaced, and/or nonparallel paths.

3.3.1.4. I-, J-, and K-Planes. An important concept in dealing with IJK-ordered data is that 
of I-, J-, and K-planes. A K-plane is the connected surface of all points with a constant K-index 
value. The I- and J-indices range over their entire domains; thus, a K-plane has, in effect, a two 
parameter ordering, much like IJ-ordering. In fact, IJ-ordered data is identical to IJK-ordered 
data with the K-index equal to one (KMax=1). Note that K-planes are not necessarily planes in 
the strict sense. They are called K-planes because they exist as planes in logical (IJK) space. In 
real (XYZ) space, the K-planes may be cones, ellipsoids, or arbitrary surfaces.
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An I-plane is the connected surface of all points with a constant I-index value (with J and K 
ranging over their entire domains), and a J-plane is the connected surface of all points with a 
constant J-index value (with K and I ranging over their entire domains). Examples of I-, J-, and 
K-planes are shown in Figure 3-9.

Figure 3-9. Clockwise from upper left: I-, J-, and K-directions of an IJK-ordered zone; 
I-planes of an IJK-ordered zone; J-planes of an IJK-ordered zone; K-planes of an IJK-
ordered zone.
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Figure 3-8. IJK-ordered data point neighbors.
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3.3.1.5. IJK-Ordered Data Plotting. Plotting IJK-ordered data is more complex than plot-
ting other ordered data types such as I- or IJ-ordered. With the other data types all data will 
typically be plotted. IJK-ordered data offers more options as to which portions of data will be 
viewed, especially when creating 2- or 3-D plots. The Surfaces page of the Zone Style dialog 
allows you to designate which surfaces of IJK-ordered data will be plotted. You may choose to 
plot just outer surfaces, or you may select combinations of I-, J-, and K-planes to be plotted. 
For more information see Chapter 20, “Three-Dimensional Volume Data.” 

3.3.2. Finite-Element Data
Finite-element data, also referred to as FE data, is a method of structuring data as a collection 
of points in 2- or 3-D space with a set of instructions on connecting these points to form ele-
ments, or cells. 

Finite-element data defines a set of points (nodes) and the connected elements of these points. 
Finite-element data can be divided into three types:

• FE-line: A set of line segments defining a 2- or 3-D line.

• FE-surface: A set of triangular or quadrilateral elements defining a 2-D field or a 3-D sur-
face.

• FE-volume: A set of tetrahedral or brick elements defining a 3-D volume field.

In each of the above data-point orderings there is virtually no limit to the number of data 
points; the size of your data set is limited only by the amount of physical resources of your 
computer. You may use a different data point structure for each zone within a data set, as long 
as the number of variables defined at each data point is the same. Chapter 4, “ASCII Data for 
Tecplot,”  gives detailed information about how to format your data for Tecplot.

3.3.2.1. Finite-Element Line Data. Plotting connectivity lines between finite-element line 
data points results in a 2- or 3-D Cartesian coordinate system appearing as a line as shown in 
Figure 3-10. Unlike I-ordered data, a single finite-element line zone may consist of multiple 
disconnected sections.

The values of the variables at each data point (node) are entered in the data file similarly to I-
ordered data, where the nodes are numbered with the I-index. This data is followed by another 
set of data defining connections between nodes. This second section is often referred to as the 
connectivity list. All elements are lines consisting of two nodes, specified in the connectivity 
list.

A common operation creating finite-element line zones is slicing a 3-D surface zone using Tec-
plot’s Slice from Plane option. To do this, select Extract from Tecplot’s Data menu.

3.3.2.2. Finite-Element Surface Data. In finite-element surface data, the values of the 
variables at each node (data point) and the finite-element connectivity lists are entered in the 
data file in the same manner as finite-element line data (described above). The difference is in 
the number of nodes per element.
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Plotting connecting lines between finite-element surface data points in a 2-D Cartesian coordi-
nate system results in a mesh as shown in Figure 3-11. Plotting a finite-element surface mesh 

in a 3-D Cartesian coordinate system results in a mesh like that shown in Figure 3-12.

Figure 3-10. A finite-element line resulting from sliced 3-D surface data.

Figure 3-11. Mesh plot of finite-element surface data in two dimensions.

Figure 3-12. Mesh plot of finite-element surface data in three dimensions.
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You can choose (by zone) to arrange your data in three point (triangle) or four point (quadrilat-
eral) elements. The number of points per node and their arrangement are called the element 
type of the zone. You may repeat a node in the quadrilateral element type to create a triangle if 
a mixture of quadrilaterals and triangles is necessary.

3.3.2.3. Finite-Element Volume Data. Finite-element volume cells may contain four 
points (tetrahedron) or eight points (brick). The elements in each zone must be either all tetra-
hedra or all bricks. Connectivity of a tetrahedron is shown in Figure 3-13.

Connectivity of a brick is shown in Figure 3-14. In the brick format, points may be repeated to 

achieve 4-, 5-, 6-, or 7-point elements. For example, a node list entry of “n1 n1 n1 n1 n5 
n6 n7 n8” results in a quadrilateral-based pyramid element. An example of a finite-element 
volume mesh is shown in Figure 3-15.

In finite-element volume order, the values of the variables at each node (data point) and their 
connectivity lists are entered in the data file in the same manner as finite-element surface data. 
Finite-element zones of element type brick or tetrahedron are referred to as finite-element 
volume zones.

Figure 3-13. Connectivity of tetrahedron finite-element volume.

Figure 3-14. Connectivity of brick finite-element volume.
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3.3.3. Variable Location (Cell-Centered or Nodal)

Our opening chapters presumes data is located at the nodes. However, it is possible for some 
data to be defined at the cell-centers. This is true for all zone types. You choose the location for 
each variable. If a variable is cell-centered, one value is specified for each element (cell).

For finite-element meshes, cell-centers are the centers (centroids) of elements. For I-ordered 
grids, the cell-centers are at the centers of the lines connecting points I and I+1. For IJ-ordered 
grids, the cell-centers are at the centroids of the quadrilaterals defined by points IJ; I+1J; IJ+1; 
I+1; J+1. For IJK-ordered grids, the cell-centers are at the centroids of the hexahedral-like ele-
ments defined by points IJK; I+1JK; IJ+1K; I+1J+1K; IJK+1; I+1JK+1; IJ+1K+1; 
I+1J+1K+1.

For many types of plots, Tecplot internally interpolates cell-centered values to the nodes.

3.4. Data Set Information
The Data Set Information dialog, accessed from the Data Set Info option on the Data menu, 
gives summary information about the current data set, including the data set title, zone and 
variable names, and the minimum and maximum values of a selected variable. You can modify 
the data set title, zone and variable names of any data set. The dialog and its pages (Zone/Vari-
able Info, Data Set, Sharing, Journal, Aux Data) are shown in Figure 3-16.

The following information is provided on the Zone/Variable Info page:

• Zone(s): Lists all zones by number, with their titles. Select one zone to display its name in 
the Zone Name field, where the zone name can be modified.

• Zone Name: Enter a new name for a selected zone.

• Zone Type (Ordered or FE data): Displays the type of zone selected in the Zone(s) list-
ing. For ordered data, it is followed by the index values for IMax, JMax and KMax (shown 
below). For finite-element data, it is followed by the element type, number of points, and 
number of elements (see below).

Figure 3-15. A finite-element volume mesh.
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- IMax (ordered data): Displays the IMax value of the zone selected in the Zone(s) list-
ing.

- JMax (ordered data): Displays the JMax value of the zone selected in the Zone(s) list-
ing.

- KMax (ordered data): Displays the KMax value of the zone selected in the Zone(s) 
listing.

- Pts (finite-element data): Displays the number of data points in the zone selected in the 
Zone(s) listing.

Figure 3-16. The Data Set Information dialog. Above are the Variable and Data Set 
pages. Below, left to right, are the Sharing, Journal and Aux Data pages.
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- Elem (finite-element data): Displays the number of elements in the zone selected in the 
Zone(s) listing.

• Variable(s): Lists all variables by number, with their names. Select one variable to display 
its name in the Variable Name field, where the name can then be modified.

• Variable Name: Enter a new name for a selected variable.

• Var Type: Displays the type of data of the selected variable in the Variable(s) field.

• Var Location: Indicates if variables are located at nodes or cell-centers.

• Var Range -- Selected Zone: Displays the Min and Max values for the selected variable in 
the selected zone.

• Var Range -- Active Zone(s): Displays the Min and Max values for the selected variable 
for all active zones.

On the Data Set page are:

• Data Set Title: Enter a title for the current data set, or edit an existing title. The default is 
the result of concatenating the titles specified in each Title record encountered in the 
data files making up the data set.

• Data File(s): Lists the names and paths of all external data files making up the current data 
set.

• Num Zones: Number of zones in the data set.

• Num Vars: Number of variables in the data set.

• Total Elements: Total number of elements in the data set.

• Var Load Mode: Depending on the method used, this displays either By Position or By 
Name.

• Locked By: This field will inform you if the current data set has been locked by an add-on. 
Add-ons can lock a data set which in turn prevents your from deleting zones or deleting the 
last frame associated with the data set.

On the Sharing page are:

• Zone: Use the drop-down to select the appropriate zone.

• Variable: Use the drop-down to select the appropriate variable.

• Variable is Shared in Zone(s): This list box displays and allows you to select individual 
shared variables.

• Connectivity Shared with Zone(s): This list box displays and allows you to select specific 
connectivity lists.

On the Journal page are:

• Journaled data list box: Lists currently journaled data.

• List Commands: Briefly summarizes actions in Tecplot as they apply to the data set.
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• Expand Commands: Displays the commands above in detail, including such things as the 
zone number, variable, and value.

On the Aux Data page are:

• Show Auxiliary Data: Use the drop-down to display auxiliary data for zones, data sets, 
frames or names. If Zone or Name is selected, a second drop-down is available for further 
selection.

• Data Name/Value: Displays the names and values of any auxiliary data.
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CHAPTER 4 ASCII Data for Tecplot

This chapter discusses how to format data so data files may be loaded directly into Tecplot. 
Data files read by Tecplot may be binary or ASCII. The following sections describe the format 
of ASCII data files. Reading an ASCII data file into Tecplot can be much slower than reading a 
binary data file, as binary data files take up less disk space.

Tecplot or Preplot converts ASCII data files to binary. See Section 5.1, “Tecplot-Format Data 
File Loading,” for converting with Tecplot, or Section 4.5, “ASCII Data File Conversion to 
Binary,” for converting with Preplot. Documentation on the binary format is included as com-
ments in the Preplot source code. Finally, if your data is generated in FORTRAN or C, you 
may be able to generate binary data files directly using the utilities described in Chapter 11, 
“Writing Binary Data for Loading into Tecplot,” of the Tecplot Reference Manual.

You can also load data generated by, or tabulated in, other software packages. In addition, data 
loaders using Tecplot’s Add-on Developer’s Kit (ADK) are available from Amtec. These 
convert data from a number of software packages into a Tecplot-readable format. (This is 
described in Chapter 6, “Data Loaders: Tecplot’s Import Feature.” ) Using ADK, you can write 
loaders of your own.

4.1. ASCII Data File Records
An ASCII data file begins with an optional file header defining a title for the data file and or 
the names of the variables. The header is followed by optional zone records containing the plot 
data. Zone records may contain ordered or finite-element data. You may also include text, 
geometry, and custom-label records that create text, geometries, and/or custom labels on plots. 
Each data file may have up to 32,700 zone records, ten custom label records, and any number 
of text and geometry records. These records may be in any order.

The first line in a zone, text, geometry, custom label, or data set auxiliary data record begins 
with the keyword ZONE, TEXT, GEOMETRY, CUSTOMLABELS, or DATASETAUXDATA. The 
maximum length of a line in a data file is 4,000 characters (unless you edit and recompile the 
Preplot source code). Any line may be continued onto one or more following lines (except for 
text enclosed in double quotes ["]). Double quotes must be used to enclose character strings 
with embedded blank spaces or other special characters. A backslash (\) may be used to 
remove the significance of (or escape) the next character (that is, \" produces a single double-
quote). Any line beginning with an octothorp (#) is treated as a comment and ignored.



Chapter 4. ASCII Data for Tecplot

44

The following simple example of a Tecplot ASCII data file has one small zone and a single line 
of text:

TITLE="Simple Data File" 
VARIABLES="X" "Y" 
ZONE I=4 F=POINT 
1 1 
2 1 
2 2 
1 2 
TEXT X=10 Y=90 T="Simple Text"

The format of the ASCII data file is summarized in Section 4.1.8, “Summary of Data File 
Records.” 

4.1.1. File Header

In the file header of your data file, you may specify an optional title that is displayed in the 
headers of Tecplot frames. The title line begins with TITLE=, followed by the title text 
enclosed in double-quotes. You may also assign a name to each of the variables by including a 
line that begins with VARIABLES=, followed by each variable’s name enclosed in double 
quotes. The quoted variable names should be separated by spaces or commas. Tecplot calcu-
lates the number of variables (N) from the list of variable names. If you do not specify the vari-
able names (and your first zone has POINT data packing), Tecplot sets the number of variables 
equal to the number of numeric values in the first line of zone data for the first zone, and names 
the variables V1, V2, V3, and so forth.

Initially, Tecplot uses the first two variables in data files as the X- and Y-coordinates, and the 
third variable for the Z-coordinate of 3-D plots. You may, however, order the variables in the 
data file any way you want, since you can interactively reassign the variables to the X-, Y-, and 
or Z-axes using Tecplot dialogs.

If the file header occurs in a place other than at the top of the data file, a warning is printed and 
the header is ignored. This allows you to concatenate two or more ASCII data files before 
using Tecplot (provided each data file has the same number of variables per data point).

4.1.2. Zone Records

A zone record consists of a control line that begins with the keyword ZONE followed by a set 
of numerical data called the zone data. The format of the zone control line is shown in 
Section 4.1.8, “Summary of Data File Records.” 

4.1.2.1. The ZONETYPE Parameter. The zone data are of the type specified by the 
ZONETYPE parameter in the control line. There are two basic types of zones: ordered and 
finite-element. Ordered zones have the formats ZONETYPE=ORDERED. Finite-element zones 
have the specific ZONETYPE of FELINESEG, FETRIANGLE, FEQUADRILATERAL, 
FETETRAHEDRON, or FEBRICK. ORDERED is presumed if the ZONETYPE parameter is 
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omitted. See Section 4.2, “Ordered Data,” for more information on ordered zones, and Section 
4.3, “Finite-Element Data,” for details on finite-element data.

4.1.2.2. The DATAPACKING Parameter. The zone data packing is specified by the 
DATAPACKING parameter in the control line. There are two data packing options: POINT and 
BLOCK.

In POINT format, the values for all variables are given for the first point, then the second 
point, and so on. In BLOCK format, all of the values for the first variable are given in a block, 
then all of the values for the second variable, then all of the values for the third, and so forth. 
Zones with cell-centered data must use BLOCK data packing. More detail on this is given 
below.

4.1.2.3. POINT Format Example. If you have only one zone of data in POINT data 
packing format, and it is one-dimensional (that is, JMax=1, KMax =1), you may omit the zone 
control line. If you want Tecplot to determine the number of variables, you may create a data 
file with only the zone data, such as the following:

12.5 23 45 1. 
14.3 24 46 2. 
12.2 24 50 3. 
13.3 26 51 4. 
13.5 27 55 5.

Tecplot calculates the number of data points (IMax) in the zone by assuming that each row rep-
resents a data point and each column represents a variable, and creates an I-ordered zone. This 
type of structure is good for XY-plots and scatter plots. If there are multiple zones, two- or 
three-dimensional zones, finite-element zones, or BLOCK-format zone data, you must include 
a zone control line at the beginning of each zone record.

4.1.2.4. Data Types. Each variable in each zone in the data file may have its own data type. 
Tecplot supports the following six data types:

• SINGLE (four-byte floating point values).

• DOUBLE (eight-byte floating point values).

• LONGINT (four-byte integer values).

• SHORTINT (two-byte integer values).

• BYTE (one-byte integer values, from 0 to 255).

• BIT.

The data type determines the amount of storage Tecplot assigns to each variable. Therefore, the 
lowest level data type should be used whenever possible. For example, imaging data, which 
usually consists of numerical values ranging from zero to 255, should be given a data type of 
BYTE. By default, Tecplot treats numeric data as data type SINGLE. If any variable in the 
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zone uses the BIT data type, the zone format must be BLOCK or FEBLOCK; you cannot use 
POINT or FEPOINT format.

4.1.2.5. Variable Location. Each variable in each zone in a data file may be located at the 
nodes or the cell-centers. Each variable is specified as NODAL or CELLCENTERED in the 
VARLOCATION parameter array, located in the control line. The format is:

VARLOCATION=([set-of-vars]=var-location,[set-of-vars]=var-location, ...)

where set-of-vars is the set of the variables and var-location is either NODAL or CELLCEN-
TERED. Variables omitted from the list are assumed to be NODAL. For example:

VARLOCATION=([3-7,10]=CELLCENTERED, [11-12]=CELLCENTERED)

specifies that variables 3 through 7, 10, 11 and 12 are cell-centered and all other variables are, 
by default, nodal for this zone.

All cell-centered variables must list one value for each element. With nodal variables, one 
value must be listed for each node. Zones with cell-centered variables must be in BLOCK data 
packing format.

4.1.2.6. Data Lists. Numerical values in zone data must be separated by one or more 
spaces, commas, tabs, new lines, or carriage returns. Blank lines are ignored. Integer 
(101325), floating point (101325.0), and exponential (1.01325E+05) numbers are 
accepted. To repeat a particular number in the data, precede it with a repetition number as fol-
lows: “Rep*Num,” where Rep is the repetition factor and Num is some numeric value to be 
repeated. For example, you may represent 37 values of 120.5 followed by 100 values of 0.0 as 
follows:

37*120.5, 100*0.0

4.1.2.7. Auxiliary Data. Auxiliary data strings associated with the current zone are speci-
fied with AUXDATA parameter in the control line. This auxiliary data may be used in dynamic 
text, equations, macros, or add-ons. Auxiliary data is provided as named strings:

AUXDATA TIME="October 13, 2002, 8 A.M."

There may be multiple AUXDATA parameters in the control line for a zone, but names must be 
unique.

4.1.2.8. Variable Sharing between Zones. Frequently, some variables are exactly the 
same for a set of zones. For example, a series of zones may contain measurement or simulation 
data at the same XYZ-locations, but different times. In this case, Tecplot’s memory usage may 
be dramatically reduced by sharing the coordinate variables between the zones. The zones that 
variables are shared from are specified in the VARSHARELIST in the control line of the 
current zone. The format is:

VARSHARELIST=([set-of-vars]=zzz, [set-of-vars]=zzz)
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where set-of-vars is the set of variables that are shared and zzz is the zone they are shared from. 
If zzz is omitted, the variables are shared from the previous zone. For example:

VARSHARELIST=([4-6,11]=3, [20-23]=1, [13,15])

specifies that variables 4, 5, 6 and 11 are shared from zone 3, variables 20, 21, 22, and 23 are 
shared from zone 1, and variables 13 and 15 are shared from the previous zone. For variable 
sharing, ordered zones may only share with ordered zones having the same dimensions. Finite-
element zones may share with any zone having the same number of nodes, for nodal variables, 
or the same number of cells, for cell-centered data.

The connectivity list (finite-element only) and face-neighbors may be shared between zones 
using the CONNECTIVITYSHAREZONE parameter in the control line of the current zone. The 
format is:

CONNECTIVITYSHAREZONE=nnn

where nnn is the number of the zone that the connectivity is shared from. To use connectivity 
sharing, the zone must have the same number of points and elements, and be the same zone 
type.

4.1.2.9. Face Neighbors. The implicit connections between elements in a zone may be 
overridden, or connections between cells in adjacent zones established, using the FACE-
NEIGHBORMODE parameter and FACENEIGHBORCONNECTIONS list in the control line of 
the zone. FACENEIGHBORMODE has four options: LOCALONETOONE, LOCALONETOMANY, 
GLOBALONETOONE, and GLOBALONETOMANY. LOCALONETOONE is the default.

The nature of the FACENEIGHBORCONNECTIONS list depends upon the FACENEIGHBOR-
MODE, described in the table below. To connect the cells along one edge to cells on another 
edge of the same zone, use LOCAL. To connect cells of one zone to cells of another zone or 
zones, use GLOBAL. If the points of the cells are exactly aligned with the neighboring cell 
points, use ONETOONE. If even one cell face is neighbor to two other cell faces, use ONETO-
MANY.

In this table, cz is the cell number in the current zone, fz is the number of the cell face in the 
current zone, nc, is the cell number of the neighbor cell in the current zone, oz is face obscu-

Mode Number of Values Data

LOCALONETOONE 3 cz, fz, nc

LOCALONETOMANY nz+4 cz, fz, oz, nz, nc1, 
nc2, ..., ncn

GLOBALONETOONE 4 cz, fz, zr, cr

GLOBALONETOMANY 2*nz+4 cz, fz, oz, nz, zrl, 
crl, zr2, cr2, ..., 
zrn, crn
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ration flag (zero for face partially obscured, one for face entirely obscured), nz is the number 
of neighboring cells for the ONETOMANY options, ncn is the number of the nth local zone 
neighboring cell in the list, zr is the remote zone number, cr is the cell number of the neigh-
boring cell in the remote zone, zrn is the zone number of the nth neighboring cell in the GLO-
BALONETOMANY list, and crn is the cell number in the remote zone of the nth neighboring 
cell in the GLOBALONETOMANY list. The cz, fz combinations must be unique; multiple 
entries are not allowed. The face numbers for cells in the various zone types are defined in 
Figure 4-1.

A connection must be specified for two matching cell faces to be effective. For example, for 
data with a FACENEIGHBORMODE of GLOBALONETOONE, if cell 6, face 2 in zone 9 
should be connected to cell 1, face 4 in zone 10, the connections for zone 9 must include the 
line:

6 2 10 1 (cell# face#, connecting zone#, connecting cell#)

And the connections for zone 10 must include this line:

1 4 9 6

Global face neighbors are useful for telling Tecplot about the connections between zones. This 
could be used, for example, to smooth out the crease in Gouraud surface shading at zone 
boundaries. For cell-centered data, they can make contours and streamtraces more continuous 
at zone boundaries.

4.1.2.10. Zone Types and Control Lines. As stated above, there are two distinct types 
of zones: ordered zones and finite-element zones. Ordered zones are I-, IJ-, and IJK-ordered 
zones (ZONETYPE=ORDERED). Finite-element zones are FE-line, -surface and -volume zones 
(ZONETYPE of FELINESEG, FETRIANGLE, FEQUADRILATERAL, FETETRAHEDRON, 
and FEBRICK). The control lines for these zone types differ in the parameters needed. Both 

Figure 4-1. Examples of brick (left) and tetrahedron (right) face neighbors.
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zone types can use the C (color), T (zonetitle), DATAPACKING, VARLOCATION, AUXDATA, 
and DT (datatype) parameters.

The T parameter specifies a title for the zone. This may be any text string up to 64 characters in 
length. If you supply a longer text string, it is automatically truncated to the first 64 characters. 
The titles of zones appear in the Zone Style and other dialogs, and, optionally, in the XY- plot 
legend. (You can use keywords in the zone titles to identify sets of zones to enable/disable or to 
change zone attributes.) The C parameter sets an initial color for the zone. This may be overrid-
den interactively, or by use of a stylesheet. The DT (type1, type2, type3, ...) parameter specifies 
the data types for the variables in a zone.

For ordered zones, you may specify the I (IMax), J (JMax), and K (KMax) parameters, which 
store the number of data points in the I, J, and K directions. J and K both default to 1. I must 
be specified if J is used; I and J must be specified if K is used. If all are omitted, Tecplot 
assumes an I-ordered zone and calculates IMax for you.

Note: I and J are not equivalent to either the number of variables or the number of data points. 
The number of data points is equal to the product of I, J, and K.

For finite-element zones, described in Section 4.3, “Finite-Element Data,” you must specify 
the N (numnodes) and may optionally include E (numelements), and or the NV (nodevalue) 
parameter. If the E parameter is not specified, Tecplot calculates it from the number of node 
sets in the connectivity list following the node data. The NV (nodevalue) parameter specifies 
the number of the variables representing the “Node” value in finite-element data. The NV 
parameter is used infrequently, mostly when the order in which nodes are listed in the data file 
do not match the node numbering desired in the plot.

Section 4.2, “Ordered Data,”  provides examples of zone data in various formats, as well as 
sample pieces of FORTRAN code that you can use as templates to print out your own data. 
Our sample code is intended only as a general example—the zone data that it produces con-
tains only one value per line. You may want to modify the code to suit your own needs.

4.1.3. Text Record
Text records are used to import text directly from a data file. Text can also be imported into 
Tecplot using a macro file. Text may be titles, labels, or other information. You may create data 
files containing only text records and read them into Tecplot just as you would read any other 
data file. You may delete and edit text originating from data files just like text created interac-
tively.

The text record consists of a single control line. The control line starts with the keyword TEXT 
and has one or more options:

• The text string is defined in the required T (text) parameter.

• The color is controlled by the C (color) parameter.
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• Use the CS (coordinatesys) parameter to specify the text coordinate system, either FRAME 
or GRID. If you specify the frame coordinate system (the default), the values of the X (xor-
igin) and Y (yorigin) parameters are in frame units; if you specify grid coordinates, X and Y 
are in grid units (that is, units of the physical coordinate system). X and Y locate the anchor 
point of the text string. For Polar Line plots, you may specify THETA and R instead of X 
and Y.

• Use the AN (textanchor) parameter to specify the position of the anchor point relative to the 
text. There are nine possible anchor positions, as shown in Figure 4-2.

• Use the HU (heightunits) parameter to assign units for character heights. If the CS parame-
ter is FRAME, you can set HU to either FRAME or POINT. If the CS parameter is GRID, you 
can set HU to either GRID or FRAME.

• Use the H parameter to specify the height; it is measured in the units defined by the HU 
parameter.

• To include multiple lines of text in a single text record, include \\n in the text string to 
indicate a new line.

• You can assign the line spacing for multi-line text using the LS (linespacing) parameter. 
The default value, 1, gives single-spacing. Use 1.5 for line-and-a-half spacing, 2 for dou-
ble-spacing, and so on.

Optionally, you may draw a box around the text string using the BX (boxtype) parameter. The 
parameters BXO (boxoutlinecolor), BXM (boxmargin), and LT (linethickness) are used if the 
boxtype is HOLLOW or FILLED. The parameter BXF (boxfillcolor) is used only if the boxtype 
is FILLED. The default boxtype, NOBOX, ignores all other box parameters.

The S (scope) parameter specifies the text scope. GLOBAL scope is the same as selecting the 
check box Show in “Like” Frames in the Text Options dialog. See Section 16.1.8, “Text 
Scope,” for details.

You may also use the ZN (zone) parameter to attach text to a specific zone or XY mapping. For 
further information, see Section 16.1.6.4, "Attaching Text to Zones or X-Y Mapping."

4.1.3.1. Text Record Examples. You may attach a macro command to the text with the 
MFC parameter. See Section 16.6, “Text and Geometry Links to Macros.” 

Figure 4-2. Text anchor positions—values for the AN parameter.

Left Center Right

Midleft Midcenter Midright

HeadrightHeadcenterHeadleft
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Some simple examples of text records are shown below. The first text record specifies only the 
origin and the text. The next text record specifies the origin, color, font, and the text. The last 
text record specifies the origin, height, box attributes, and text. Note that the control line for the 
text can span multiple file lines if necessary (as in the last text record below).

TEXT X=50, Y=50, T="Example Text" 
 
TEXT X=10, Y=10, F=TIMES-BOLD, C=BLUE, T="Blue Text" 
 
TEXT X=25, Y=90, CS=FRAME, HU=POINT, H=14,  
    BX=FILLED, BXF=YELLOW, BXO=BLACK, LS=1.5, 
    T="Box Text \\n Multi-lined text"

4.1.4. Geometry Record

Geometry records are used to import geometries from a data file. Geometries are line drawings 
that may be boundaries, arrows, or even representations of physical structures. You may create 
data files containing only geometry and text records and read them into Tecplot. You may 
delete and edit geometries originating from data files just like the geometries that you create 
interactively.

The geometry record control line begins with the keyword GEOMETRY. Use the CS (coordi-
natesys) parameter to specify the geometry coordinate system, either FRAME or GRID. If you 
specify the frame coordinate system (the default), the values of the X (xorigin) and Y (yorigin) 
parameters are in frame units; if you specify grid coordinates, X and Y are in grid units (that is, 
units of the physical coordinate system). For Polar Line plots, you may specify THETA and R 
for X and Y. X and Y (or THETA and R) locate the anchor point, or origin, of the geometry, 
which is the center of a circle or ellipse, the lower left corner of a square or rectangle, and the 
anchor point of a polyline. The anchor point specifies the offset of all the points: if X=1, Y=1, 
and the first point is (1, 2), and the second point is (2, 4), then Tecplot draws at (2, 3) (1+1, 
2+1) then (3, 5) (2+1, 4+1). In other words, the points for any geometry are always relative to 
the specified anchor point. The Z (zorigin) is specified only for LINE3D geometries, and, 
since LINE3D geometries are always in grid mode, Z is always in units of the Z-axis.

Geometry types are selected with the T (geomtype) parameter. The available geometry types 
are listed below:

• SQUARE: A square with lower left corner at X, Y.

• RECTANGLE: A rectangle with lower left corner at X, Y.

• CIRCLE: A circle centered at X, Y.

• ELLIPSE: An ellipse centered at X, Y.

• LINE: A set of 2-D polylines (referred to as multi-polylines) anchored at X, Y.

• LINE3D: A set of 3-D polylines (referred to as multi-polylines) anchored at X, Y, Z.

The color of the geometry is controlled by the C (color) parameter. Any geometry type except 
LINE3D may be filled with a color by using the FC (fillcolor) parameter. With both C (color) 
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and FC (fillcolor) on the control line, the geometry is outlined in one color and filled with 
another. Each polyline of a LINE geometry is filled individually (by connecting the last point 
of the polyline with the first). Not specifying the FC (fillcolor) parameter results in a hollow, or 
outlined, geometry drawn in the color of the C (color) parameter. 

You can control how geometries are drawn using the L (linetype), LT (linethickness), and PL 
(patternlength) parameters. You can set L to any of Tecplot’s line patterns (SOLID, DASHED, 
DOTTED, DASHDOT, LONGDASH, DASHDOTDOT). You can set LT and PL to any value, using 
frame units.

The control line of the geometry is followed by geometry data. For SQUARE, the geometry 
data consists of just one number: the side length of the square.

For RECTANGLE, the geometry data consists of two numbers: the first is the width (horizontal 
axis dimension), and the second is the height (vertical axis dimension).

For CIRCLE, the geometry data is one number: the radius. For ELLIPSE, the geometry data 
consists of two numbers: the first is the horizontal axis length and the second is the vertical 
axis length. For both circles and ellipses, you can use the EP (numellipsepts) parameter to 
specify the number of points used to draw circles and ellipses. All computer-generated curves 
are simply collections of very short line segments; the EP parameter allows you to control how 
many line segments Tecplot uses to approximate circles and ellipses. The default is 72.

For LINE and LINE3D geometries, the geometry data is controlled by the F (format) parame-
ter. These geometries may be specified in either POINT or BLOCK format. By default, POINT 
format is assumed. Each geometry is specified by the total number of polylines, up to a 
maximum of 50. Each polyline is defined by a number of points and a series of XY- or XYZ- 
coordinate points between which the line segments are drawn. In POINT format, the XY- or 
XYZ-coordinates are given together for each point. In BLOCK format, all the X-values are 
listed, then all the Y-values, and (for LINE3D geometries) all the Z-values. All coordinates are 
relative to the X, Y, and Z specified on the control line. You can specify points in either single 
or double precision by setting the DT (datatype) parameter to either SINGLE or DOUBLE.

For LINE geometries, you can specify arrowheads using the AAT (arrowheadattach), AST 
(arrowheadstyle), ASZ (arrowheadsize), and AAN (arrowheadangle) parameters. See 
Section 4.1.8, “Summary of Data File Records,” for details. These parameters provide the 
same functionality available when you create a line geometry interactively.

The S (scope) parameter specifies the geometry’s scope. GLOBAL scope is the same as select-
ing the check box Show in Like Frames in the Geometry dialog. See Section 16.2.2.8, “Geom-
etry Scope,” for details.

You may also use the ZN (zone) parameter to attach geometry to a specific zone or XY-map-
ping.

You may attach a macro command to the text with the MFC parameter. See Section 16.6, “Text 
and Geometry Links to Macros.” 
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LINE3D geometries must be created in a data file. They may not be created interactively. 
LINE3D geometries are always in grid mode. To view LINE3D geometries in Tecplot, your 
plot type must be in 3D Cartesian, which requires at least one zone. Thus, a data file with only 
LINE3D geometries is useful only as a supplement to other data files.

4.1.4.1. Geometry Record Examples. The following geometry record defines a rectan-
gle of 40 width and 30 height:

GEOMETRY  T=RECTANGLE 
40 30

The following geometry record defines an origin and a red circle of 20 radius, with an origin 
of (75, 75) that is filled with blue:

GEOMETRY X=75, Y=75, T=CIRCLE, C=RED, FC=BLUE,CS=FRAME 
 20

The following geometry record defines an origin and two polylines, drawn using the Custom 3 
color. The first polyline is composed of three points, the second of two points.

GEOMETRY X=50, Y=50, T=LINE, C=CUST3 
 2 
 3 
 0 1 
 0 0 
 2 0 
 2 
 0 0 
 1 2

In BLOCK format, the same geometry appears as:

GEOMETRY X=50, Y=50, T=LINE, C=CUST3, F=BLOCK, CS=FRAME 
 2 
 3 
 0 0 2 
 1 0 0 
 2 
 0 1 
 0 2

The next geometry record defines a purple ellipse with a horizontal axis length of 20 and a 
vertical axis length of 10, with an origin of (10, 70), that is filled with yellow. 

GEOMETRY X=10, Y=70, T=ELLIPSE, C=PURPLE, FC=YELLOW 
 20 10

The final geometry record is a 3-D polyline with four points that is composed of one polyline 
using the default origin of (0, 0, 0):

GEOMETRY T=LINE3D 
 1 
 4 
 0 0 0 
 1 2 2 
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 3 2 3 
 4 1 2

In BLOCK format, this geometry record can be written as follows:

GEOMETRY T=LINE3D, F=BLOCK 
 1 
 4 
 0 1 3 4 
 0 2 2 1 
 0 2 3 2

4.1.5. A More Extensive Example of a Geometry Record

In the TextGeom file shown below, there are four text records (showing a circle, ellipse, rect-
angle, and line). A plot of the file is shown in Figure 4-3.

TEXT X=20, Y=85, F=HELV-BOLD, C=BLUE, H=7.5,
      T="Example Text"
TEXT X=20, Y=75, F=TIMES-BOLD, H=5, T="Subtitle"
TEXT X=80, Y=25, F=TIMES-ITALIC-BOLD, H=4, C=RED,
      BX=FILLED, BXF=YELLOW, BXM=50, BXO=CYAN,
      T="Filled Box"
TEXT X=41, Y=8, H=4, F=COURIER-BOLD,
      C=CUST3, BX=HOLLOW, BXO=CUST4, T="Hollow Box"
GEOMETRY X=50, Y=50, T=RECTANGLE, FC=WHITE, C=BLUE
   40 30
GEOMETRY X=30, Y=30, T=CIRCLE, FC=BLUE, C=GREEN
   20
GEOMETRY X=70, Y=65, T=LINE, FC=PURPLE, C=BLACK
   1
   4
   -10 0
   0 10

Figure 4-3. Text and geometries created from the sample in Section 4.1.5, “A More 
Extensive Example of a Geometry Record.” 

(Sketch)  16 Jun 1998 

Example Text
Subtitle

Filled Box

Hollow Box

(Sketch)  16 Jun 1998 
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   010 10
   10 0.6
GEOMETRY T=LINE, C=CUST1
   2
   3
   5 50
   10 10
   20 10
   2
   15 15
   25 25
GEOMETRY X=60, Y=30, T=ELLIPSE, C=CUST8
   30 10

4.1.6. Custom Label Record

The custom label record is an optional record to define sets of text strings for use in custom 
labeling the values of an axis, contour legend or value labels, or variable-value node labels. 
The custom label record begins with the keyword CUSTOMLABELS, followed by one or more 
text strings. The text strings must be enclosed within double quotes (“"”) if they contain any 
commas, spaces or other special characters, or if they might be confused with valid data file 
keywords. Enclosing the strings in double quotes is always recommended.

The first custom label string corresponds to a value of one on the axis, the next to a value of 
two, the next to a value of three, and so forth. Custom labels may appear one to a line, or there 
may be more than one on a line, separated by a comma or space. Multiple custom label records 
can be present in a data file. If this is the case, you choose which set to assign to a given axis, 
contour legend, or variable-value node labels. Custom labels are discussed in more detail in 
Section 17.5.2.3, “Custom Labels.” 

A simple example of a custom-label record is shown below. MON corresponds to a value of 1, 
TUE corresponds to 2, WED to 3, THU to 4, and FRI to 5. Since custom labels have a wrap-
around effect, MON also corresponds to the values 6, 11, and so forth.

CUSTOMLABELS "MON", "TUE", "WED", "THU", "FRI"

4.1.7. Data Set Auxiliary Data Record
There is frequently auxiliary data (or Metadata) that helps describe the data set. For example, 
experimental data my have information about the facility and time at which the data was taken, 
and other parameter that describe the experiment. Likewise, simulation results have auxiliary 
data (such as reference quantities for non-dimensional data) needed to fully analyze and 
present the results. This data may be concerning the data set as a whole or it can vary from 
zone to zone. The ASCII file format for specifying auxiliary data associated with the data set 
are described here. The format for zonal auxiliary data is described in Section 4.1.2.7.

The data set auxiliary data control line is as follows:

DATASETAUXDATA name-string = “value string”
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where name-string is a unique character string with no spaces. There may be multiple 
DATASETAUXDATA records but name-string must be unique for each one.

Auxiliary data may be used in text, macros, equations (if it is numeric), and accessed from add-
ons. It may also be viewed directly in the AuxData page of the Data Set Information dialog.

4.1.7.1. Data Set Auxiliary Data Examples.  The following auxiliary data contain flow 
field information that might be found in output from a computational fluid-dynamics simula-
tion.

DATASETAUXDATA MachNo = "1.2"
DATASETAUXDATA Alpha = "5"
DATASETAUXDATA RefTemperature = "250"
DATASETAUXDATA RefPressure = "101325"
DATASETAUXDATA Configuration = "A2 No. 3"
DATASETAUXDATA Date = "August 5, 2003"
DATASETAUXDATA Region = "NE Quadrant of Sector 47"

You may then use the numerical values in equations to modify the variables like this:

{P} = {P_non_dim} * AuxDataSet:RefPressure

Configuration and Date may then be included in text on the plot. This makes it easier to 
automate your plotting tasks using layout files and/or macros.

4.1.8. Summary of Data File Records
The following table summarizes the records and parameters allowable in Tecplot data files.

Data File 
Section Records Parameter Descriptions
File Header TITLE = "filetitle" 

VARIABLES =  
"vname1" 
"vname2" ...

Title for data file. 
 
Name of first variable. 
Name of second variable.
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Ordered Zone 
Record

ZONE 
T="zonetitle" 
I=IMax 
J=JMax 
K=KMax 
C=color 
 
 
ZONETYPE=ordered 
DATAPACKING=datapack-
ing format 
VARLOCATION=([set-of-
vars]=var-loca-
tion,[set-of-
vars]=var-loca-
tion,...) 
VARSHARELIST=([set-
of-vars]=zzz,[set-of-
vars]=zzz,...) 
 
DT=(datatypelist) 
 
 
 
AUXDATA 
namestring="value 
string" 
 
FACENEIGHBOR-
MODE=faceneighbormode 
 
 
 
FACENEIGHBORCONNEC-
TIONS=faceneighbor-
connectlist 

 
Title for zone. 
Number of points in I-direction. 
Number of points in J-direction. 
Number of points in K-direction. 
One of the following: BLACK, RED, 
GREEN, BLUE, CYAN, YELLOW, PUR-
PLE, WHITE, CUST1, ..., CUST8. 
 
Either POINT or BLOCK. 
 
Lists specifying variable locations. The list, 
nnn, contains variable numbers and var-loca-
tion is either CELLCENTERED or NODAL. 
Lists of variables to share from specified previ-
ous zones. For each pair specified, the vari-
ables listed in set-of-vars are shared from zone 
zzz. 
List specifying data type for each variable, 
from among the following: SINGLE,  
DOUBLE, LONGINT, SHORTINT, BYTE, 
BIT. 
Saves the name/value pairs of strings associ-
ated with the zone. May have multiple AUX-
DATA pairs defined for each 
zone. 
One of the following: LOCALONETOONE, 
LOCALONETOMANY, GLOBALONE-
TOONE, GLOBALONETOMANY. 
Choice of FACENEIGHBORMODE 
will change what is speci-
fied in FACENEIGHBORCONNEC-
TIONS. 
Faceneighborconnectlist starts with the cell 
and cell-face affected by the connection. It then 
contains neighboring cells and zones depend-
ing on the FACENEIGHBORMODE. See Sec-
tion 4.1.2.9, “Face Neighbors,”  for more 
details.

Data File 
Section Records Parameter Descriptions
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Finite-element 
Zone Record

ZONE  
T="zonetitle"  
N=numnodes  
E=numelements 
 
 
C=color 
ZONETYPE=zonetype 
 
 
 
DATAPACKING=datapack-
ing format 
VARLOCATION=([set-of-
vars]=var-loca-
tion,[set-of-
vars]=var-loca-
tion,...) 
VARSHARELIST=([set-
of-vars]=zzz,[set-of-
vars]=zzz,...) 
 
AUXDATA 
namestring="value 
string" 
 
FACENEIGHBOR-
MODE=faceneighbormode 
 
 
 
FACENEIGHBORCONNEC-
TIONS=faceneighbor-
connectlist 
 
 
 
 
NV=nodevariable 
DT=(datatypelist) 
CONNECTIVITYSHARE-
ZONE=nnn

 
Title for zone. 
Number of nodes. 
Number of elements. 
 
 
 
For finite-element zones the 
zonetype options are FELINE-
SEG, FETRIANGLE, FEQUADRI-
LATERAL, FETETRAHEDRON, and 
FEBRICK. 
Either POINT or BLOCK. 
 
Lists specifying variable locations. The list, 
nnn, contains variable numbers and var-loca-
tion is either CELLCENTERED or NODAL. 
Lists of variables to share from specified previ-
ous zones. For each pair specified, the vari-
ables listed in set-of-vars are shared from zone 
zzz. 
Saves the name/value pairs of strings associ-
ated with the zone. May have multiple AUX-
DATA pairs defined for each 
zone. 
One of the following: LOCALONETOONE, 
LOCALONETOMANY, GLOBALONE-
TOONE, GLOBALONETOMANY. 
Choice of FACENEIGHBORMODE 
will change what is speci-
fied in FACENEIGHBORCONNEC-
TIONS. 
Faceneighborconnectlist starts with the cell 
and cell-face affected by the connection. It then 
contains neighboring cells and zones depend-
ing on the FACENEIGHBORMODE. See Sec-
tion 4.1.2.9, “Face Neighbors,”  for more 
details. 
Which variable represents the node number. 
See description above. 
Share the connectivity from zone nnn.

Data File 
Section Records Parameter Descriptions
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Text Record TEXT  
X=xorigin 
Y=yorigin 
Z=zorigin 
Theta=thetaorigin 
R=rorigin 
F=font 
 
 
 
 
THETA=originangle 
 
R=originradius 
 
CS=coordinatesys 
HU=heightunits 
 
AN=textanchor 
 
 
 
C=color 
A=angle 
 
H=height 
LS=linespacing 
S=scope 
T="text" 
BX=boxtype 
BXM=boxmargin 
BXF=boxfillcolor 
BXO=boxcolor 
LT=boxlinethickness 
ZN=zone 

CLIPPING=clipping 
 
MFC="macrofunctioncommand"

 
X origin of object in coordinatesys units. 
Y origin of object in coordinatesys units. 
Z origin of object in coordinatesys units. 
Theta origin of object in coordinatesys units. 
R origin of object in coordinatesys units. 
One of the following: HELV, HELV-BOLD, 
TIMES, TIMES-ITALIC, TIMES-BOLD, 
TIMES-ITALIC-BOLD, COURIER,  
COURIER-BOLD, GREEK, MATH,  
USER-DEF. 
THETA coordinate of origin for Polar Line 
plots (only if X and Y are not specified).
R coordinate of origin for Polar Line plots 
(only if X and Y are not specified).
One of FRAME, GRID or GRID3D. 
One of FRAME, POINT or GRID (GRID not 
allowed for FRAME coord sys). 
One of the following: LEFT, CENTER, RIGHT, 
MIDLEFT, MIDCENTER,  
MIDRIGHT, HEADLEFT, HEADCENTER, 
HEADRIGHT. 
See description above. 
Angle in degrees, counter-clockwise from hori-
zontal. 
Character height in heightunits. 
Line spacing for multiple-line text. 
Either LOCAL or GLOBAL. 
Alphanumeric text string. 
One of NOBOX, HOLLOW, or FILLED. 
Margin around text as fraction of text height. 
Fill color for box; use color options. 
Color of text box outline; use color options. 
Line thickness of text box. 
Zone (or XY-mapping) number to which this 
item is assigned. 
Either CLIPTOVIEWPORT or CLIPTOF-
RAME 
Macro function command.

Data File 
Section Records Parameter Descriptions
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Geometry 
Record

GEOMETRY 
X=xorigin 
Y=yorigin 
Z=zorigin 
 
THETA=originangle 
 
 
R=originradius 
 
CS=coordinatesys 
 
C=color 
L=linetype 
 
 
PL=patternlength 
LT=linethickness 
T=geomtype 
 
EP=numellipsepts 
 
AST=arrowheadstyle 
AAT=arrowheadattach 
 
ASZ=arrowheadsize 
AAN=arrowheadangle 
DT=datatype 
 
S=scope 
F=geomformat 
FC=geomfillcolor 
ZN=zone 
 
DRAWORDER=draworder 
CLIPPING=clipping 
 
MFC="macrofunctioncom-
mand"

 
X-origin of object in coordinatesys units. 
Y-origin of object in coordinatesys units. 
For GRID3D geoms only, the Z-origin of 
object in coordinatesys units. 
For GRID CS only, THETA coordinate of ori-
gin for Polar Line plots (only if X and Y are not 
specified). 
For GRID CS only, R coordinate of origin for 
Polar Line plots (only if X and Y are not speci-
fied). 
One of FRAME, GRID, or GRID3D. 
One of the following: SOLID, DASHED, 
DASHDOT, DOTTED, LONGDASH,  
DASHDOTDOT. 
Pattern length for specified line type. 
Line thickness for geometry outline. 
One of the following: LINE, SQUARE, RECT-
ANGLE, CIRCLE, ELLIPSE (Image geoms 
cannot be in data files). 
Number of points to use to approximate circles 
and ellipses. 
One of PLAIN, HOLLOW, or FILLED. 
One of the following: NONE, BEGINNING, 
END, BOTH. 
Size of arrowhead in Frame units. 
Angle of arrowhead in degrees. 
Either SINGLE or DOUBLE (applies to 2- and 
3-D polylines only). 
Either LOCAL or GLOBAL. 
Either POINT or BLOCK. 
Fill color for geometry; use color options 
Zone (or XY-mapping) number to which this 
geometry is assigned. 
Either AFTERDATA or BEFOREDATA 
Either CLIPTOVIEWPORT or CLIPTOF-
RAME 
Macro function command.

Data File 
Section Records Parameter Descriptions
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4.2. Ordered Data

4.2. Ordered Data
For ordered data, the numerical values in the zone data must be in either POINT or BLOCK 
format, specified by the DATAPACKING parameter.

4.2.1. I-Ordered Data

I-ordered data has only one index, the I-index. This type of data is typically used for XY-plots, 
scatter plots, and irregular (random) data for triangulation or for interpolation into an IJ-or IJK-
ordered zone within Tecplot. 

In I-ordered data, the I-index varies from one to IMax. The total number of data points is IMax. 
For zones with only nodal variables, the total number of values in the zone data is IMax*N 
(where N is the number of variables). For a mixture of nodal and cell-centered variables, the 
number of values in the zone data is IMax*Nn+(IMax-1)*Nc, where Nn is the number of nodal 
variables and Nc is the number of cell-centered variables. For data in POINT format, IMax is 
calculated by Tecplot from the zone data if it is not explicitly set by the zone control line (using 
the I-parameter).

4.2.1.1. I-Ordered Data in POINT Format Example. A simple example of I-ordered 
data in POINT format is listed below. There are two variables (X, Y) and five data points. In 
this example, each row of data corresponds to a data point and each column to a variable. This 
data set is plotted in Figure 4-4; each data point is labeled with its I-index.

VARIABLES = "X","Y" 
ZONE I=5, DATAPACKING=POINT 
2    4 
3    9  
5   25 
6   36 
7   49

For this data try omitting the VARIABLES and ZONE lines, leaving two columns of informa-
tion. In this case, Tecplot would count the columns to determine the number of variables, count 
rows to determine I-dimension, and label the variables V1 and V2.

Custom Labels 
Record

CUSTOMLABELS 
"label1" 
 
"label2" ...

 
String for value of one when using custom 
labels. 
String for value of two when using custom 
labels.

Data Set Aux-
iliary Data 
Record

DATASETAUXDATA 
namestring="value 
string"

Saves name/value pairs of strings associated 
with the data set. May have multiple DATASE-
TAUXDATA pairs defined for the data set.

Data File 
Section Records Parameter Descriptions
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4.2.1.2. FORTRAN Code Example to Generate I-Ordered Data in POINT For-
mat. The following sample FORTRAN code shows how to create I-ordered data in POINT 
format:

 INTEGER VAR 
   . 
   . 
   . 
 WRITE (*,*) ´ZONE DATAPACKING=POINT, I=´, IMAX 
 DO 1 I=1,IMAX 
     DO 1 VAR=1,NUMVAR 
1        WRITE (*,*) ARRAY(VAR,I)

4.2.1.3. I-Ordered Data in BLOCK Format Example. The same data as in Section 
4.2.1.1. is shown below in BLOCK format. In this example, each column of zone data corre-
sponds to a data point; each row to a variable.

VARIABLES = "X", "Y" 
ZONE I=5, DATAPACKING=BLOCK 
2 3 5 6 7 
4 9 25 36 49

In BLOCK format all IMax values of each variable are listed, one variable at a time.

4.2.1.4. FORTRAN Code to Generate I-Ordered Data in BLOCK Format Exam-
ple. The following sample FORTRAN code shows how to create I-ordered data in BLOCK 
format:

 INTEGER VAR 
   . 
   . 
   . 
 WRITE (*,*) ´ZONE DATAPACKING=BLOCK, I=´, IMAX 
 DO 1 VAR=1,NUMVAR 
     DO 1 I=1,IMAX 
1        WRITE (*,*) ARRAY(VAR,I)

Figure 4-4. An I-ordered data set.
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4.2. Ordered Data

4.2.1.5. Multi-Zone XY Line Plot Example. The two tables below show the values of 
pressure and temperature measured at four locations on some object at two different times. The 
four locations are different for each time measurement.

For this case, we want to set up two zones in the data file, one for each time value. Each zone 
has three variables (Position, Temperature, and Pressure) and four data points (one 
for each location). This means that IMax=4 for each zone. We include a text record (discussed 
in Section 4.1.3., “Text Record”) to add a title to the plot. A data file in POINT format is given 
below. The plot shown in Figure 4-6 can be produced from this file.

TITLE = "Example: Multi-Zone XY Line Plot"
VARIABLES = "Position", "Temperature", "Pressure"
ZONE T="0.0 seconds", I=4
71.30 563.7 101362.5
86.70 556.7 101349.6
103.1 540.8 101345.4
124.4 449.2 101345.2
ZONE T="0.1 seconds", I=4

Figure 4-6. A multi-zone XY Line plot.

  

Time = 0.0 seconds:

Position Temperature Pressure
71.30 563.7 101362.5

86.70 556.7 101349.6

103.1 540.8 101345.4

124.4 449.2 101345.2

Figure 4-5. 

  

Time = 0.1 seconds:

Position Temperature Pressure
71.31 564.9 101362.1

84.42 553.1 101348.9

103.1 540.5 101344.0

124.8 458.5 101342.2

Figure 4-5. 
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71.31 564.9 101362.1
84.42 553.1 101348.9
103.1 540.5 101344.0
124.8 458.5 101342.2
TEXT CS=FRAME, HU=POINT, X=16, Y=90, H=28, T="SAMPLE CASE"

A data file in BLOCK format is shown below. All of the values for the first variable (Posi-
tion) at each data point are listed first, then all of the values for the second variable (Tem-
perature) at each data point, and so forth.

TITLE = "Example: Multi-Zone XY Line Plot"
VARIABLES = "Position", "Temperature", "Pressure"
ZONE DATAPACKING=BLOCK, T="0.0 seconds", I=4
71.30 86.70 103.1 124.4
563.7 556.7 540.8 449.2
101362.5 101349.6 101345.4 101345.2
ZONE DATAPACKING=BLOCK, T="0.1 seconds", I=4
71.31 84.42 103.1 124.8
564.9 553.1 540.5 458.5
101362.1 101348.9 101344.0 101342.2
TEXT CS=FRAME, HU=POINT, X=16, Y=90, H=28, T="SAMPLE CASE"

A more compact data file for this example is in the point format shown below. Tecplot deter-
mines the number of variables from the number of values in the first line of data under the first 
zone. The variables and zones are assigned default names.

ZONE
71.30 563.7 101362.5
86.70 556.7 101349.6 103.1 540.8 101345.4 124.4 449.2 101345.2
ZONE
71.31 564.9 101362.1 84.42 553.1 101348.9 103.1 540.5 101344.0
124.8 458.5 101342.2
TEXT CS=FRAME, HU=POINT, X=16, Y=90, H=28, T="SAMPLE CASE"

4.2.1.6. Multi-Zone XY Line Plot with Variable Sharing Example. If the data from 
the section above was taken at the same position for both times, variable sharing could reduce 
memory usage and file size. That file appears as:

TITLE = "Example: Multi-Zone XY Line Plot with Variable Sharing" 
VARIABLES = "Position", "Temperature", "Pressure" 
ZONE T="0.0 seconds", I=4 
71.30 563.7 101362.5 
86.70 556.7 101349.6 
103.1 540.8 101345.4 
124.4 449.2 101345.2 
ZONE T="0.1 seconds", I=4, VARSHARELIST=([1]=1) 
564.9 101362.1 
553.1 101348.9 
540.5 101344.0 
458.5 101342.2 
TEXT CS=FRAME, HU=POINT, X=16, Y=90, H=28, T="SAMPLE VARIABLE SHARING CASE"
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4.2. Ordered Data

4.2.2. IJ-Ordered Data
IJ-ordered data has two indices: I and J. IJ-ordered data is typically used for 2- and 3-D surface 
mesh, contour, vector, and shade plots, but it can also be used to plot families of lines in XY-
plots. See Chapter 7, “Line Plots,” for more information. In IJ-ordered data, the I-index varies 
from 1 to IMax, and the J-index varies from one to JMax. The total number of data points 
(nodes) is IMax*JMax. For zones with only nodal variables, the total number of numerical val-
ues in the zone data is IMax*JMax*N (where N is the number of variables). For a mixture of 
nodal and cell-centered variables, the number of values in the zone data is 
IMax*JMax*Nn+(IMax-1)*(JMax-1)*Nc, where Nn is the number of nodal variables and Nc is 
the number of cell-centered variables. Both IMax and JMax must be specified in the zone con-
trol line (with the I and J parameters). The I- and J-indices should not be confused with the X- 
and Y-coordinates—on occasions the two may coincide, but this is not the typical case.

The I-index varies the fastest. That is, when you write programs to print IJ-ordered data, the I-
index is the inner loop and the J-index is the outer loop. Note the similarity between I-ordered 
data and IJ-ordered data with JMax=1.

4.2.2.1. IJ-Ordered Data in POINT Format Example. An example of IJ-ordered data 
in POINT format is listed below. There are four variables (X, Y, Temperature, Pressure) 

and six data points. In this example, each row of data corresponds to a data point; each column 
to a variable. The first two lines are for J=1, the next two for J=2, the last two for J=3. The 
first, third, and fifth lines are for I=1; the second, fourth, and sixth lines are for I=2. This data 
is plotted in Figure 4-7; each data point is labeled with its IJ-index.

VARIABLES = "X", "Y", "Temperature", "Pressure" 
ZONE I=2, J=3, DATAPACKING=POINT 
3 0 0 50 
7 2 0 43 

Figure 4-7. An IJ-ordered data set.
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2 4 1 42 
6 6 0 37 
1 8 1 30 
5 9 1 21

4.2.2.2. FORTRAN Code to Generate IJ-Ordered Data in POINT Format Exam-
ple. The following sample FORTRAN code shows how to create IJ-ordered data in POINT 
format:

WRITE (*,*) ´VARIABLES = "X", "Y", "Temperature", "Pressure"’ 
WRITE (*,*) ´ZONE I=’, IMAX, ’, J=’, JMAX, ’, ’DATAPACKING=POINT’ 
 DO 1 J=1,JMAX 
    DO 1 I=1, IMAX 
1            WRITE (*,*) X(I,J), Y(I,J), T(I,J), P(I,J)

4.2.2.3. IJ-Ordered Data Set in BLOCK Format Example. The same data set as in 
Section 4.2.2.1. is shown in BLOCK format below. In this example, each column of data corre-
sponds to a data point; each row to a variable.

VARIABLES = "X", "Y", "Temperature", "Pressure" 
ZONE I=2, J=3, DATAPACKING=BLOCK 
3 7 2 6 1 5 
0 2 4 6 8 9 
0 0 1 0 1 1 
50 43 42 37 30 21

In BLOCK format, all IMax*JMax values of each variable are listed, one variable at a time. 
Within each variable block, all the values of a variable at each data point are listed.

4.2.2.4. FORTRAN Code to Generate IJ-Ordered Data in BLOCK Format 
Example. The following sample FORTRAN code shows how to create IJ-ordered data in 
BLOCK format: 

 INTEGER VAR 
   . 
   . 
   . 
 WRITE (*,*) ´ZONE DATAPACKING=BLOCK, I=´, IMAX,  ´, J=´, JMAX 
 DO 1 VAR=1,NUMVAR 
     DO 1 J=1,JMAX 
         DO 1 I=1,IMAX 
1            WRITE (*,*) ARRAY(VAR,I,J)

4.2.2.5. IJ-Ordered Data with Cell-Centered Data. An example of IJ-ordered data 
with cell-centered variables might include four variables (X, Y, Temperature, Pressure), 
nine data points, and four cells where Temperature and Pressure are cell-centered. 

VARIABLES = "X", "Y", "Temperature", "Pressure" 
ZONE I=2, J=3, DATAPACKING=BLOCK, VARLOCATION=(3=CELLCENTERED, 
4=CELLCENTERED) 
3 7 11 2 6 10 1 5 9 
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4.2. Ordered Data

0 2 3 4 6 8 8 9 10 
0 2 1 3 
45 60 35 70

The nodal variables of X and Y are specified at all nine nodes, but cell-centered variables and 
have values specified for the four cells [(IMax-1)*(JMax-1)]. Zones with cell-centered 
data must have DATAPACKING=BLOCK.

4.2.3. IJK-Ordered Data

IJK-ordered data has three indices: I, J, and K. This type of data is typically used for 3-D 
volume plots, although planes of the data can be used for 2- and 3-D surface plots. See 
Chapter 20, “Three-Dimensional Volume Data,”  for more information.

In IJK-ordered data, the I-index varies from 1 to IMax, the J-index varies from one to JMax, 
and the K-index varies from one to KMax. The total number of data points (nodes) is 
IMax*JMax*KMax. For zones with only nodal variables the total number of values in the zone 
data is IMax*JMax*KMax*N, where N is the number of variables. For a mixture of nodal and 
cell-centered variables, the number of values in the zone data is 
IMax*JMax*KMax*Nn+(IMax-1)*(JMax-1)*(KMax-1)*Nc, where Nn is the number of nodal 
variables and Nc is the number of cell-centered variables. The three indices, IMax, JMax, and 
KMax, must be specified in the zone control line using the I-, J-, and K-parameters.

The I-index varies the fastest; the J-index the next fastest; the K-index the slowest. If you write 
a program to print IJK-ordered data, the I-index is the inner loop, the K-index is the outer loop, 
and the J-index is the loop in between. Note the similarity between IJ-ordered data and IJK-
ordered data with KMax=1.

4.2.3.1. IJK-Ordered Data in POINT Format Example. An example of IJK-ordered 
data in POINT format is listed below. There are four variables (X, Y, Z, Temperature) and 

Figure 4-8. An IJ-ordered data set with cell-centered data.
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twelve data points. Each row of data corresponds to a data point; each column to a variable. 
This data is plotted in Figure 4-9; each data point is labeled with its IJK-index. 

VARIABLES = "X" "Y" "Z" "Temp"
ZONE I=3, J=2, K=2,DATAPACKING=POINT

 0 0 0 0
 3 0 1 5 
 6 0 3 10
 0 6 3 10
 3 6 4 41
 6 6 6 72
 0 0 8 0
 3 0 9 29
 6 0 11 66
 0 6 11 66
 3 6 12 130
 6 6 14 169

4.2.3.2. BLOCK Format of the Same Data. The same data set as Section 4.2.3.1., this 
time in BLOCK format, is shown below. For this example, each column of data corresponds to 
a data point; each row to a variable.

VARIABLES = "X" "Y" "Z" "Temp"
ZONE I=3, J=2, K=2, DATAPACKING=BLOCK
 0 3 6 0 3 6 0 3 6 0 3 6
 0 0 0 6 6 6 0 0 0 6 6 6
 0 1 3 3 4 6 8 9 11 11 12 14
 0 5 10 10 41 72 0 29 66 66 130 169

4.2.3.3. FORTRAN Code to Generate an IJK-Ordered Zone in POINT Format 
Example. The following sample FORTRAN code shows how to create an IJK-ordered zone 
in POINT format:

Figure 4-9. An IJK-ordered data set.
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4.2. Ordered Data

 WRITE (*,*) ’VARIABLES = "X", "Y", "Z", "Temp"’
 WRITE (*,*) ’ZONE I=’,IMAX,’ J=’,JMAX,’ K=’,KMAX,’ DATAPACKING=POINT’
DO 1 K=1,KMAX
   DO 1 J=1,JMAX
      DO 1 I=1,IMAX
1         WRITE (*,*) X(I,J,K), Y(I,J,K), Z(I,J,K), Temp(I,J,K)

In BLOCK format, all IMax*JMax*KMax values of each variable are listed, one variable at a 
time. Within each variable block, all the values of the variable at each data point are listed.

4.2.3.4. FORTRAN Code to Generate IJK-Ordered Data in BLOCK Format 
Example. The following sample FORTRAN code shows how to create an IJK-ordered zone 
in BLOCK format:

 INTEGER VAR 
   . 
   . 
   . 
   . 
 WRITE (*,*) ´ZONE DATAPACKING=BLOCK, I=´, IMAX, ´, J=´, JMAX, ´, K=´, KMAX 
 DO 1 VAR=1,NUMVAR 
      DO 1 K=1,KMAX 
         DO 1 J=1,JMAX 
             DO 1 I=1,IMAX 
1                WRITE (*,*) ARRAY(VAR,I,J,K)

4.2.4. One Variable Data Files

For ordered data, it is possible to read in a data file that has only one variable. Tecplot then 
creates the other required variables. That is, if your data is I-ordered, a variable containing the 
I-index values is created, numbered V1, and called I. For IJ-ordered data, two variables, num-
bered V1 and V2 and called I and J, are created to contain the I- and J-index values. For IJK-
ordered data, three variables I, J, and K are created and numbered V1, V2, and V3. The vari-
able in the data file is numbered with the next available variable number, that is, V2 for I-
ordered data, V3 for IJ-ordered data, and V4 for IJK-ordered data. The created variables are the 
default X-, Y-, and Z-variables. The data type for the created variables is determined according 
to the following table:

For example, if you have an ASCII file with 256 by 384 numbers representing intensities of a 
rasterized image, you could make a data file similar to the following:

VARIABLES = "TEMPERATURE"

Maximum of IMax, 
JMax, and KMax Data Type

< 256 BYTE

<32,766 SHORTINT

>=32,766 SINGLE
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 ZONE I=256, J=384
List all 98,304 values of temperature here.

Read the data file into Tecplot. Two new variables of type SHORTINT are created and used as 
the default X- and Y-coordinates. These variables are the I- and J-index values; they are named 
I and J. You can now create any type of 2-D plot with the data.

If you have finite-element data, Tecplot will not create any new variables for you. If you need 
to add variables to finite-element data, you can do so using the Data menu.

4.3. Finite-Element Data
For finite-element data, the zone types, specified in the ZONETYPE parameter, may be 
FELINESEG, FETRIANGLE, FEQUADRILATERAL, FETETRAHEDRON, or FEBRICK. For 
any of these DATAPACKING may be POINT or BLOCK.

The number of nodes (data points) is given by the N=numnodes parameter, and the number of 
elements is given by the E=numelements parameter (this is also the total length of the connec-
tivity list).

Zone data is divided into two logical sections. It has no markers, but you may place blank lines 
between the sections to distinguish them. The first section, the node (and sometimes element) 
data, lists the values of the variables at the data points (or nodes) or cell-centers (elements) as if 
they were I-ordered (one-dimensional) zone data. The second section, the connectivity list, 
defines how the nodes are connected to form elements. There must be numelements lines in the 
second section; each line defines one element. The number of nodes per line in the connectiv-
ity list depends on the element type specified in the zone control line (ZONETYPE parameter). 
For example, ZONTYPE=FETRIANGLE has three numbers per line in the connectivity list. If 
nodes 5, 7, and 8 are connected, one line reads: 5 7 8.

In the descriptions below, NE is the Eth node at a vertex of an element. The subscripts of NE 
refer to the element number. For example, N23 represents the second node of the third ele-

ment.

For the triangle element type, each line of the connectivity list contains three node numbers 
that define a triangular element:

N1M, N2M, N3M

For the quadrilateral element type, each line of the connectivity list contains four node 
numbers that define a quadrilateral element:

N1M, N2M, N3M, N4M

If you need to mix quadrilateral and triangle elements, either create two zones or use the quad-
rilateral element type with node numbers (N4M=N3M) repeated to form triangles.

Zones created from the quadrilateral and triangle element types are called FE-surface zones.
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4.3. Finite-Element Data

For the tetrahedron element type, each line of the second section of the zone data contains four 
node numbers that define a tetrahedral element:

N1M N2M N3M N4M

For the brick element type, each line of the second section contains eight node numbers that 
define a ‘‘brick-like” element:

N1M N2M N3M N4M N5M N6M N7M N8M

Tecplot divides the eight nodes into two groups of four; nodes N1M, N2M, N3M, and N4M make 

up the first group, and N5M, N6M, N7M, and N8M make up the second group. Each node is con-
nected to two nodes within its group and the node in the corresponding position in the other 
group. For example, N1M is connected to N2M and N4M in its own group, and to N5M in the 
second group. To create elements with fewer than eight nodes, repeat nodes as necessary, 
keeping in mind the basic brick connectivity just described. Figure 4-10 shows the basic brick 
connectivity. For example, to create a tetrahedron, you can set N3M=N4M and N5M=N6M 
=N7M=N8M. To create a quadrilateral-based pyramid, you can set N5M=N6M=N7M=N8M. If you 
need a mixture of bricks and tetrahedra, either use two zones or use the brick element type with 
node numbers repeated so that tetrahedra result.

Zones created from the brick and tetrahedron element types are called finite-element volume 
zones.

If CONNECTIVITYSHAREZONE=nnn is in the zone control line, the connectivity list is 
shared from zone nnn. In this case, no connectivity list is given, just the node (and possibly ele-
ment) data. If nnn is greater than or equal to the current zone number, Tecplot generates an 
error message.

4.3.1. Triangle Data in POINT Format Example

An example of triangle element type finite-element data with POINT datapacking is listed 
below. There are two variables (X, Y) and five data points. In this example, each row of the 

Figure 4-10. Basic brick connectivity.
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data section corresponds to a node and each column to a variable. Each row of the connectivity 
list corresponds to a triangular element and each column specifies a node number. This data set 
is plotted in Figure 4-11. Each data point is labeled with its node number.

VARIABLES = "X", "Y" 
ZONE N=5, E=3, DATAPACKING=POINT, ZONETYPE=FETRIANGLE 
1.0 1.0 
2.0 3.0 
2.5 1.0 
3.5 5.0 
4.0 1.0 
 
1 2 3 
3 2 4 
3 5 4

4.3.1.1. BLOCK Format of the Same Data. The same data in BLOCK format is shown 
below. In this example, each column of the data section corresponds to a node and each row to 
a variable. As above, each row of the connectivity list corresponds to a triangular element and 
each column specifies a node number.

VARIABLES = "X", "Y" 
 ZONE N=5, E=3, DATAPACKING=BLOCK, ZONETYPE=FETRIANGLE 
 1.0 2.0 2.5 3.5 4.0 
 1.0 3.0 1.0 5.0 1.0 
 1 2 3 
 3 2 4 
 3 5 4

4.3.2. FORTRAN Code Generating Triangle Data in POINT Format 

Figure 4-11. A finite-element triangle data set.
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4.3. Finite-Element Data

Example

The following sample FORTRAN code shows how to create triangle element type finite-
element data in POINT format:

   INTEGER VAR 
   . 
   . 
   . 
   WRITE (*,*) ´ZONE DATAPACKING=POINT, ZONETYPE=FETRIANGLE,N=´, 
  &    NNODES,´,E=´,NELEM 
   DO 1 N=1,NNODES 
     DO 1 VAR=1,NUMVAR 
1        WRITE(*,*) VARRAY(VAR,N) 
 
   DO 2 M=1,NELEM 
     DO 2 L=1,3 
2       WRITE (*,*) NDCNCT(M,L)

4.3.3. FORTRAN Code Generating Triangle Data in BLOCK Format 
Example

This FORTRAN code creates triangle element type finite-element data in BLOCK format:

   INTEGER VAR 
   . 
   . 
   . 
   WRITE (*,*) ´ZONE DATAPACKING=BLOCK, ZONETYPE=FETRIANGLE,N=´,NNODES, 
  &´,E=´,NELEM 
    DO 1 VAR=1,NUMVAR 
      DO 1 N=1,NNODES 
1        WRITE(*,*) VARRAY(VAR,N) 
    DO 2 M=1,NELEM 
      DO 2 L=1,3 
2        WRITE (*,*) NDCNCT(M,L)

4.3.4. Finite-Element Zone Node Variable Parameters Example
The node variable parameter allows setting of the connectivity to match the value of the 
selected node variable. In the example below, the files appear to be identical in Tecplot, 
although the connectivity list has changed to reflect the values of the node variable node order. 
Notice that the index value of the nodes is not changed by the node variable value.

The original data set:

TITLE     = "Data with original node ordering"
VARIABLES = "X"
"Y"
ZONE T="Triangulation"
 N=6, E=5,DATPACKING=POINT, ZONETYPE=FETRIANGLE
DT=(SINGLE SINGLE )
 2.00E+000 3.00E+000
 2.20E+000 3.10E+000



Chapter 4. ASCII Data for Tecplot

74

 3.10E+000 4.20E+000
 2.80E+000 3.50E+000
 2.40E+000 2.10E+000
 4.30E+000 3.20E+000
 1 2 5
 6 4 3
 5 4 6
 2 3 4
 5 2 4

The data set with the nodes re-ordered for connectivity:

TITLE     = "Data with modified node ordering"
VARIABLES = "X"
"Y" "Node-Order"
ZONE T="Triangulation"
 N=6, NV = 3, E=5,DATAPACKING=POINT, ZONETYPE=FETRIANGLE
DT=(SINGLE SINGLE )
 2.00E+000 3.00E+000 5
 2.20E+000 3.10E+000 4
 3.10E+000 4.20E+000 1
 2.80E+000 3.50E+000 2
 2.40E+000 2.10E+000 6
 4.30E+000 3.20E+000 3
 5 4 6
 3 2 1
 6 2 3
 4 1 2
 6 4 2

4.4. Variable and Connectivity List Sharing
The VARSHARELIST in the ZONE record allows you to share variables from specified previ-
ous zones. The CONNECTIVITYSHAREZONE parameter in the ZONE record allows you to 
share the connectivity list from a specified previous zone. The following is an example to illus-
trate these features.

The table below shows Cartesian coordinates X and Y of six locations, and the pressure mea-
sured there at three different times (P1, P2, P3). The XY locations have been arranged into 
finite-elements.

X Y P1 P2 P3

-1.0 0.0 100 110 120

0.0 0.0 125 135 145

1.0 0.0 150 160 180

-0.5 0.8 150 165 175

Figure 4-12. 
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4.4. Variable and Connectivity List Sharing

For this case, we want to set up three zones in the data file, one for each time measurement. 
Each zone has three variables: X, Y, and P. The zones are of the triangle element type, meaning 
that three nodes must be used to define each element. One way to set up this data file would be 
to list the complete set of values for X, Y, and P for each zone. Since the XY-coordinates are 
exactly the same for all three zones, a more compact data file can be made by using the VAR-
SHARELIST. In the data file given below, the second and third zones have variable sharing 
lists that share the values of the X- and Y-variables and the connectivity list from the first zone. 
As a result, the only values listed for the second and third zones are the pressure variable 
values. Note that the data could easily have been organized in a single zone with five variables. 
Since blank lines are ignored in the data file, you can embed them to improve readability. A 
plot of the data is shown in Figure 4-13.

TITLE = "Example: Variable and Connectivity List Sharing"
VARIABLES = "X", "Y", "P"
ZONE T="P_1", DATAPACKING=POINT, N=6, E=4, ZONETYPE=FETRIANGLE
-1.0  0.0  100
0.0  0.0  125
1.0  0.0  150
-0.5  0.8  150
0.5  0.8  175
0.0  1.6  200

0.5 0.8 175 185 195

0.0 1.6 200 200 200

Figure 4-13. A plot of finite-element zones.
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1 2 4
2 5 4
3 5 2
5 6 4
ZONE T="P_2", DATAPACKING=POINT, N=6, E=4, ZONETYPE=FETRIANGLE, VARSHARELIST 
= ([1, 2]=1), CONNECTIVITYSHAREZONE = 1
110 135 160 165 185 200

ZONE T="P_3", DATAPACKING=POINT, N=6, E=4, ZONETYPE=FETRIANGLE, VARSHARELIST 
= ([1, 2]=1), CONNECTIVITYSHAREZONE = 1
120 145 180 175 195 200

4.5. ASCII Data File Conversion to Binary
Although Tecplot can read and write ASCII or binary data files, binary data files are more 
compact and are read into Tecplot much more quickly. Your Tecplot distribution includes Pre-
plot, which converts ASCII to binary data files. You can also use Preplot to debug ASCII data 
files Tecplot cannot read.

4.5.1. Preplot Options

To use Preplot, type the following command from the UNIX shell prompt, from a DOS 
prompt, or using the Run command in Windows:

preplot infile [outfile] [options]

where infile is the name of the ASCII data file, outfile is an optional name for the binary data 
file created by Preplot, and options is a set of options from either the standard set of Preplot 
options or from a special set of options for reading PLOT3D format files. If outfile is not spec-
ified, the binary data file has the same base name as the infile with a .plt extension. You may 
use a minus sign (“-”) in place of either the infile or outfile to specify standard input or stan-
dard output, respectively.

Any or all of -iset, -jset, and -kset can be set for each zone, but only one of each per 
zone.

For more Preplot command lines, see Appendix B.3, “Preplot.”

4.5.2. Preplot Examples
If you have an ASCII file named dset.dat, you can create a binary data file called 
dset.plt with the following Preplot command:

preplot dset.dat dset.plt

By default, Preplot looks for files with the .dat extension, and creates binary files with the 
.plt extension. Thus, either of the following commands is equivalent to the above command:

preplot dset
preplot dset.dat
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4.5. ASCII Data File Conversion to Binary

Preplot checks the input ASCII data file for errors such as illegal format, numbers too small or 
too large, the wrong number of values in a data block, and illegal finite-element node numbers. 
If Preplot finds an error, it issues a message displaying the line and column where the error was 
first noticed. This is only an indication of where the error was detected; the actual error may be 
in the preceding columns or lines.

If Preplot encounters an error, you may want to set the debug option to get more information 
about the events leading up to the error:

preplot dset.dat -d

You can set the flag to -d2, or -d3, or -d4, and so forth, to obtain even more detailed infor-
mation.

In the following Preplot command line, the number of points that are written to the binary data 
file dset.plt is less than the number of points in the input file dset.dat:

preplot dset.dat -iset 3,6,34,2 -jset 3,1,21,1 -iset 4,4,44,5

For zone 3, Preplot outputs data points with I-index starting at 6 and ending at 34, skipping 
every other one, and J-index starting at one and ending at 21. For zone 4, Preplot outputs data 
points with the I-index starting at four, ending at 44, and skipping by five.

In the following Preplot command line, every other point in the I-, J-, and K-directions is 
written to the binary data file:

preplot dset.dat -iset ,,,2 -jset ,,,2 -kset ,,,2

The zone, start, and end parameters are not specified, so all zones are used, starting with index 
1, and ending with the maximum index. The overall effect is to reduce the number of a data 
points by a factor of about eight.

4.5.3. Preplot Conversion of the PLOT3D Format
PLOT3D is a graphics plotting package developed at NASA. Some numerical simulation 
packages and other programs can create graphics in PLOT3D format. There are two paths by 
which you can get files in PLOT3D format into Tecplot. This section describes the Preplot 
path; you can also use the PLOT3D Loader described in Section 6.8, “The PLOT3D Data 
Loader.” The PLOT3D Loader has more advanced capabilities than Preplot.

Preplot can read files in the PLOT3D format and convert them to Tecplot binary data files 
through the use of special switches. You do not need to know about these switches unless you 
have data in PLOT3D format.

PLOT3D files typically come in pairs consisting of a grid file (with extension .g) and a solu-
tion file (with extension .q). Sometimes only the grid file is available. The grid itself may be 
either a single grid, or a multigrid, and the data may be 1D, 2D, 3D-planar, or 3D-whole 
(equivalent to Tecplot’s 3-D volume data). The PLOT3D files may be binary or ASCII. The 
PLOT3D-specific switches to Preplot allow you to read PLOT3D files with virtually any com-
bination of these options.
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The ilist, jlist, and klist are comma-separated lists of items of the form:

start[:end][:skip]]

where start is the number of the starting I-, J-, or K-plane, end is the number of ending I-, J-, or 
K-plane, and skip is the skip factor between planes. If end is omitted, it defaults to the starting 
plane (so if just start is specified, only that one plane is included). The skip defaults to one 
(every plane) if omitted; a value of two includes every other plane, a value of three include 
every third plane, and so on.

You must specify one of the flags -1d, -2d, -3dp, or -3dw. You may also specify only one 
of -ip, -jp, or -kp and only one of -b or -f.

If the input PLOT3D file is 3-D whole (-3dw) and none of the plane-extraction switches -ip, 
-jp, or -kp is specified, the PLOT3D file is converted directly to an IJK-ordered zone (or 
multiple zones if the file is multi-grid).

For example, in the following command line, Preplot reads from the PLOT3D files aero.g 
and aero.q. The input is binary and 3-D whole. The J-planes 2, 3, 4, 45, 46, and 47 are pro-
cessed and made into six IJ-ordered zones, in a binary data file named aero.plt:

preplot aero -plot3d -b -3dw -jp 2,3,4,45,46,47

In the following command line, the plane-extraction switches are omitted, so Preplot creates a 
single IJK-ordered zone:

preplot aero -plot3d -b -3dw

The following command line reads an ASCII file airplane.g for which there is no corre-
sponding .q file; the data is 3-D whole:

preplot airplane -plot3d -gridonly -3dw

The following command line reads a multi-grid, 3-D planar, binary-FORTRAN pair of 
PLOT3D files, multgrid.g and multgrid.q:

preplot multgrid -plot3d -m -f -3dp
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CHAPTER 5 Working with Tecplot 
Files

Tecplot reads and writes a number of different files. In general, these operations are performed 
using the File menu. With the File menu, you can instruct Tecplot to read or write data files, 
layout files, and macro files.

This chapter presumes your data files are in a form readable by Tecplot. Chapter 4, “ASCII 
Data for Tecplot,”  discusses data files structured for direct reading by Tecplot. Chapter 6, 
“Data Loaders: Tecplot’s Import Feature,”  discusses importing a variety of other formats. 
Some files, such as stylesheets and equation files, are read and written from other menus and 
dialogs. Other files can be loaded from the Tecplot command line. For more information, 
please see Appendix A, “Command Line Options.” 

5.1. Tecplot-Format Data File Loading
This section describes the process for loading Tecplot-format data files, as well as reading data 
files formatted for other software.

Tecplot cares about the format of a data file and the context in which the file is read, but is not 
concerned about file names (including extensions). Tecplot uses the standard extensions 
.dat for ASCII and .plt for binary.

There are four ways to work with Tecplot-format data files:

• Generate a Tecplot-format ASCII data file. Read the file into Tecplot and work without 
conversion. If the data set is altered, save it as an ASCII data file. This method works for 
smaller data sets where the convenience of an ASCII file outweighs any inefficiencies.

• Generate a Tecplot-format ASCII data file. Read it into Tecplot, then save it as a binary 
data file, then work with the binary file. Once you have saved a binary version, you can 
delete the ASCII version. This works well for large data sets where ASCII inefficiencies 
are noticeable.

• Generate a Tecplot-format ASCII data file, then convert it to a binary file with Preplot. 
(Preplot, a utility program included with Tecplot, converts ASCII and PLOT3D to binary 
Tecplot-format data files. Preplot also converts PLOT3D files to Tecplot-format binary data 
files.) Once the binary file is created, delete the ASCII version to save space. This works 
well for identifying problems with data files, since Preplot’s error messages include precise 
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details. This method also works well in batch processing, or if the ASCII data files are gen-
erated on another machine. (See Section 4.5, “ASCII Data File Conversion to Binary,”  for 
a description of Preplot.)

• Generate a Tecplot-format binary data file. Read the binary data file into Tecplot and work 
without conversion. This works well if you use routines provided by Amtec to write Tec-
plot-format binary files from C or FORTRAN programs. See Chapter 11, “Writing Binary 
Data for Loading into Tecplot,” in the Tecplot Reference Manual, for complete details.

5.1.1. Data File Loading

Tecplot allows you to read multiple data files to create a data set. However, you usually start 
with a single data file. Tecplot uses separate procedures for loading single versus multiple data 
files.

To load a single data file:

1. From the File menu, choose Load Data File(s). The Load Data File dialog appears, as 
shown in Figure 5-1.

2. Navigate to the appropriate file, or enter the file name in the File Name field and click 
Open.

3. The Select Initial Plot dialog appears. Use the Initial Plot Type drop-down to set the plot 
type (2- or 3-D, XY, Polar, Sketch, or Automatic, where Tecplot chooses the most appropri-
ate type.) Use Show First Zone Only if you have many zones and intend to view a small 
fraction of them at any given time. This reads all zones, but only performs initial calcula-
tions and drawings for the first zone. The Select Initial Plot dialog is shown in Figure 5-2.

To load multiple data files:

Figure 5-1. Load Data File (left) and the Load Multiple Data Files dialogs (right).
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5.1. Tecplot-Format Data File Loading

1. From the File menu, choose Load Data File(s). The Load Data File dialog appears.

2. Click Multiple Files. The Load Data File dialog for multiple files appears, also shown in 
Figure 5-1.

3. Navigate to the appropriate file, or enter the file name in the File Name field. Open now 
reads Add To List. Click to add the file, repeating the process for additional files. Specify a 
URL by selecting the URL check box. Your URL must start with ftp:// or http://. For exam-
ple, ftp://ftp.microsoft.com/myplot.plt. To add a disk file name you must deselect the URL 
check box. You may add any combination of URLs and disk file names to the Selected 
File(s) list.

or 

Double-click on the name of the file in the Look in drop-down. The file is added to the 
Selected File(s) scrolled list.

4. To remove files from the Selected File(s) scrolled list, select the files, then click Remove.

5. When the Selected File(s) scrolled list contains only those files you want to read in, click 
Open Files to read in the files.

The order of the list of files to be read in is important. Tecplot numbers the zones based on the 
ordering in this list.

5.1.1.1. Data File Loading Options. Tecplot allows you to specifically control what is 
loaded from your data files. This gives you the ability to load only certain zones or variables, 
or even part of a zone. You can also choose to load the variables in your data files by name or 
by position. Use the Load Data File Options dialog to specify these and other options.

To select options when loading one or more data files:

1. Select files for loading as described in Section 5.1.1, “Data File Loading,”  without clicking 
Open.

2. Select Specify Options.

3. Click Open. The Load Data File Options dialog appears, as shown in Figure 5-3.

4. Select the desired options (described in detail below).

Figure 5-2. The Select Initial Plot Type dialog.
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5. Click OK to read the selected data.

6. On the Select Initial Plot dialog, make the appropriate choices, then click OK.

The Load Data File Options dialog has three pages—General, Zones, Vars (Variables)—dis-
cussed separately in Sections 5.1.1.2. through 5.1.1.6.

5.1.1.2. Data File Loading General Options. On the General page (Figure 5-3), you 
have the option to load a subset of record types or load only portions of the data.

To load specific record types from the data file, select the desired record types by choosing the 
appropriate check boxes:

The check boxes are available only if those records exist in the data files. By default, all of the 
records in the data files are selected.

If you want to load a portion of the data points, specify skip factors for the I-, J-, and K-dimen-
sions in the corresponding text fields. Each skip factor n tells Tecplot to read in every nth point 
in the specified direction. By default, all the skip factors are set to one, so every data point is 
loaded.

5.1.1.3. Data File Loading Zone Options. On the Zones page, shown in Figure 5-4, 
allows selection of specific zones to load from data files and, if appropriate, whether to col-
lapse the zone list.To specify which zones to load, select them in the Select Zones to Load list 
box. Zones are listed in the order (that is, all zones from the first data file, then all zones from 
the second, and so forth). By default, all zones are selected to be loaded.

Figure 5-3. The General page of the Load Data File Options dialog.

Field Data Load zone records (the actual data). If not selected, the Zones 
and Vars pages of the dialog are inactive.

Text Load text records.

Geometries Load geometry records.

Custom Labels Load custom label records.
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5.1. Tecplot-Format Data File Loading

If you have selected to only load specific zones and want them renumbered upon loading, 
select Collapse Zone List. (If you are loading variables by position, the check box reads Col-
lapse Zone and Variable Lists.) See Section 5.1.1.7, “Zone and Variable List Collapsing,”  for 
more information.

5.1.1.4. Data File Loading Variable Options. The Variables page loads variables by 
name or position. The default is to load variables by name. When loading variables by name, 
Tecplot creates variables based on the variable names in the data files. When loading variables 
by position, Tecplot creates variables based on their order in the data files. Tecplot creates vari-
able order based on their order in the first data file loaded. This is true when loading by posi-
tion or by name.

For example, consider two data files: file1.plt and file2.plt. File file1.plt has 
variables X, Y, and P, in that order. File file2.plt has variables P, X, and Y, in that order. If 
these two files are loaded by position, the first variable in Tecplot is created from X in 
file1.plt and P in file2.plt. The second variable is from Y in file1.plt and X in 
file2.plt. The third variable is from P in file1.plt and Y in file2.plt.

If these two files are loaded by name, the first variable is created from X in file1.plt and X 
in file2.plt. The second is from Y in file1.plt and Y in file2.plt. The third vari-
able is from P in file1.plt and P in file2.plt.

5.1.1.5. Variable Loading by Name. Using the Load Variables by Name area of the 
Load Data File Options dialog’s Vars page, you may select specific variable names to load 
from the data files. This is shown in Figure 5-5.

Figure 5-4. The Zones page of the Load Data File Options dialog.

Data File file1.plt file2.plt

Variable 1 X P

Variable 2 Y X

Variable 3 P Y
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When loading variables by name, variables are associated by name then loaded into Tecplot. 
Variable names can be combined; two variables with different names in different files can be 
loaded into a single Tecplot variable. When a variable name is missing the variable is set to all 
zeros for all zones loaded from that file.

The Show Variables From list box displays variable names from the data files to load. Filter the 
list with the drop-down above the list. Choosing All Data Files shows variable names from all 
data files in order (that is, all of the variable names from the first data file are listed, then all 
variable names from the second file, and so forth). Identical variable names from more than 
one file appears only once in the list. An asterisk (*) next to a variable name indicates the vari-
able name does not exist in all the files. A number next to a variable name indicates the vari-
able to be loaded into. For example, a “2” next to a variable name means that variable name is 
loaded into the second Tecplot variable.

The Variables to Load list box displays variables to be loaded into Tecplot. By default, it shows 
only variable names existing in all of the data files selected. If no matching variable names 
exist, the list is empty. An asterisk (*) next to a variable name indicates the name does not exist 
for all files. If you load a file with an asterisk, the file’s zones are set to zero for that variable. 
Duplicate variable names are not allowed.

The following options allow you to manipulate the lists:

•   Take all of the variable names in Show Variables From and add them to 
Variables to Load.

•   Take the selected variable name in Show Variables From and add it to 
Variables to Load.

•   Take the variable name selected in Show Variables From and combine it 
with the variable name selected in Variables to Load.

Figure 5-5. The Load Variables By Name area of the Load Data File Options dialog.
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5.1. Tecplot-Format Data File Loading

•   Remove the selected variable name from Variables to Load list.

•   Remove all variable names from Variables to Load list.

You have limited options in changing Variables to Load when appending data files to the 
current data set or replacing the current data set while retaining the plot style. The list is par-
tially determined by the current data set. You can add names or combine new names, but you 
cannot remove any variable names.

When appending data files to the current data set by adding names to Variables to Load, adding 
a new name which already exists in the current data set, but which was not loaded initially, 
causes Tecplot to reload the affected data files to include the new name. First change the data 
set using the Data menu’s Alter option.

5.1.1.6. Variable Loading by Position. The Load Variables By Position area of the 
Load Data File Options dialog’s Vars page allows you to select specific variables to load from 
data files, and to collapse the zone and variable lists when possible. The Loading Variables by 
Position section of the dialog is shown in Figure 5-6.

To specify variables to load from data files, select them in Select Variables to Load. This is a 
multiple selection list box where you can click-and-drag, Ctrl-click, or Shift-click to choose 
variable. The variable names listed come from the first data file. If variable names in the other 
files do not match those in the first, an asterisk (*) appears next to the name. The number of 
variables listed is limited to the minimum number in all of the files. By default, all of the vari-
ables are selected to be loaded.

If you have selected to only load specific variables and want them renumbered, select the “Col-
lapse Zone and Variable Lists” check box. See Section 5.1.1.7, “Zone and Variable List Col-
lapsing,”  for more information.

Figure 5-6. The Load Variables by Position section of the Load Data File Options 
dialog.
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When appending files to the current data set or replacing the current data set while retaining 
the plot style, you cannot select the variables to load. These are determined by the variables 
currently in Tecplot. When appending files to the current data set, the new files must have at 
least as many variables as are currently in Tecplot.

5.1.1.7. Zone and Variable List Collapsing. When loading files you have the option of 
reading only selected zones (and variables when loading by position). You may either preserve 
existing zone and variable numbering, or “collapse” the data read so zones and variables are 
renumbered according to their positions in Tecplot.

For example, zones 2 and 5 of a five zone data file are loaded. If the zones and variables are 
not collapsed (the default), Tecplot reads them in as zones 2 and 5. Writing this data set to an 
ASCII file, it has five zones; zones 1, 3, and 4 have no data (“Zombie” zones). Selecting the 
collapse option, Tecplot reads them in as zones 1 and 2. Writing this data set to a file yields 
only two zones.

In most cases collapsing zones and variables is unnecessary. All dialogs showing zones or vari-
ables list the zones read in, though they may not be numbered sequentially. Do not collapse 
zones and variables when:

• You have a large data set and read a portion of the data to reduce the amount of memory 
used in processing. You then create a stylesheet to use at a later time with a different sub-set 
of the data.

• You have many zones and variables and you are familiar with certain ranges of them. (For 
example, you may know that zones 150-200 represent a known portion of the data.) If you 
partially read the data and do not collapse it, these zones continue to be designated with 
their familiar numbers.

5.2. Data File Writing
You can write out the data set in the current frame as either an ASCII or binary data file. 
Tecplot asks you to choose which part of the data to write, as well as to specify the format for 
the saved file.

To write the data set in the current frame to a file:

1. From the File menu, choose Write Data File. The Write Data File Options dialog appears, 
as shown in Figure 5-7.

2. (Optional) Select the zones and or variables you want to write to the saved data file.

3. (Optional) Specify which record types you want to write to the saved data file by selecting 
the appropriate check boxes: 

- Text: Select this check box to save any text attached to the current frame.

- Geometries: Save any geometries attached to the current frame.

- Custom Labels: Save any custom labels attached to the current data set. 
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5.2. Data File Writing

- Field Data: Save the zone data.

- Data Sharing Linkage (If Possible): Save the variable and connectivity sharing 
between zones existing in the data set, reducing its size and loading time.

- Face Neighbor Information Generated by Tecplot: Automatically save the face 
neighbor information generated by Tecplot for finite-element zones. This increases the 
data set size and loading time, but speeds performance after loading.

By default, all record types that are present in the current data set are selected.

4. (Optional) Choose whether to save the file as ASCII or Binary.

5. (Optional) For ASCII, choose to write the file in POINT format or BLOCK format (BLOCK 
is required if any variables are cell-centered). (POINT format organizes the data by data 
points, BLOCK format organizes it by variables. See Chapter 4, “ASCII Data for Tecplot,” 
for a complete description of both formats.)

6. (Optional) You can also specify the precision of your Float and Double variables. These 
variable types are written in exponent format and the precision determines the number of 
digits included past the decimal point (a precision of three would result in numbers of the 
form 4.657E+02).

7. (Optional) Associate Layout with Newly Saved Data File: Tecplot associates this data file 
with the layout’s style. If not selected, Tecplot asks you for a file name when writing out the 
file.

8. Click OK; the Write Data File dialog appears, as shown in Figure 5-8.

9. Specify a file name, then click OK.

Figure 5-7. The Write Data File Options dialog.
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5.3. Layout Files, Layout Package Files, Stylesheets
Tecplot has three different types of files for storing plot information: 

• Stylesheets: Stylesheets store information about a single frame, but do not include any 
information about the data used by the frame.

• Layout files: Layout files store information about all the frames in the workspace, includ-
ing identification of the data used by each frame.

• Layout Package files: Layout package files are an extension to layout files where data and 
an optional preview image are included.

This section describes the three types of files and gives suggestions on when to use each one.

5.3.1. Stylesheets

Layout and layout package files for the most part are the preferred medium for saving the style 
of your plot. They are quick and easy to load and save, and they save your complete picture. 
Unlike layout and layout package files, which contain the complete style of all the frames in 
your workspace, stylesheets contain only the style of a single frame in Tecplot. Despite this 
limitation, there are situations where stylesheets are useful, including:

• When pre-processing must be done to a data set prior to attaching a style. You may need to 
load a data set and run some equations or do interpolation or zone extraction before assign-
ing a style. The style may reference objects or variables that do not exist in the original data 
and it is necessary to assign the style after they are created. Note that Tecplot’s data journal-
ing capabilities eliminate this situation in many cases.

Figure 5-8. The Write Data File dialogs in Windows (left) and Motif (right).
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5.3. Layout Files, Layout Package Files, Stylesheets

• When switching styles on large data sets. You may want to load a large data set and gener-
ate two full page plots. Each plot has a different style. By using a stylesheet for the second 
plot you avoid having to reload the data set.

• When copying the style of one frame to another frame in the same layout.

• When saving just part of a frame’s style, such as just the contour levels.

A stylesheet is a special type of macro file that contains commands used to define the style of a 
single frame in Tecplot. The style includes attributes such as the type of plot (a 2-D contour 
plot in 2-D or an XY Line plot), the colors used, the current view of the data, how axes are dis-
played, or enhancements such as text or geometries. Some items comprising the style of a 
frame are shown in Figure 5-9.

If the frame contains any image geometries (see Section 16.3. “Images” on page 290), Tecplot 
will save references to the image files in the stylesheet. If the images came from a layout 
package file, Tecplot will save references to this file in the stylesheet.

Stylesheets are copied (created, by extracting from a frame and writing to a file) or pasted 
(applied to a frame) by using the Copy Frame Style to File or Paste Frame Style from File 
options of the Frame menu. A stylesheet does not contain any information about the frame’s 
data (if required), or where that data set comes from.

To select part or all of a frame style and create a stylesheet:

1. On the Frame menu, select Copy Frame Style to File; the Copy Style to File dialog appears.

Figure 5-9. Some of the items considered part of the frame style.
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2. Select a path and file name.

3. By default, Tecplot saves the names of the image files used in the stylesheet with their rela-
tive file paths. If you want to save your stylesheet using absolute file paths, turn off the Use 
Relative Path check box.

4. (Optional) Click Options. The Copy Style Options dialog appears. On the Copy Style 
Options dialog, select the aspects of the frame style that you want to save, then click Close.

5. On the Copy Style to File dialog, click OK.

To apply all or part of a stylesheet to a data set:

1. In the Frame menu, click Paste Frame Style from File. The Paste Style from File dialog 
appears.

2. Specify the path and name of the file containing the style to be copied.

3. (Optional) Click Options. The Paste Style Options dialog appears. Specify style items to 
paste, then click Close.

4. When you have finished click OK.

5.3.2.  Layout Files

A plot often consists of multiple frames or even multiple data sets. To capture all the informa-
tion on the plot, use a special type of Tecplot macro file called a layout file (usually with an 
extension of .lay), with a complete description of your plot. Layout files include the names 
of the data files used to create the plot, the frame layout and data set attachments, axis and plot 
attributes, the current color map, and so forth.

Figure 5-10 shows a layout with four frames. The frame in the upper left-hand corner is 
attached to data set 1. The two frames on the right are both attached to data set 2. The frame in 
the lower left is not attached to a data set.

Figure 5-10. Layout of four frames using two data sets.
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If a frame defined in a layout file requires an attached data set, the data files necessary to build 
the data set are referenced in the layout file. These data files can be referenced using absolute 
paths or relative paths. Use relative paths if you intend to move both the layout file and the data 
files to some other location on disk, or some other platform, at a later date. When using relative 
paths under Windows, the data files must be on the same drive as the layout file.

A layout file may also contain the data journal; a set of macro commands which alter the data 
or create new data. The data journal commands replicate the data modifications made to the 
original data (in files) during prior Tecplot sessions. Not all data operations are supported by 
the data journal. For more information, see Chapter 22, “Data Operations.”

Aside from the commands needed to build the individual style of each frame, layout files also 
include macro commands to set the following:

• Page layout information including the size and orientation of the paper.

• Some print setup information, including how colors are to be mapped to monochrome gray 
scales for monochrome output.

• Color spectrum information, including what basic global color map is installed and what 
adjustments have been made.

For complete details on the structure of Tecplot macro files and the commands available in 
layout files, see Chapter 27, “Macro Commands,” and the Tecplot Reference Manual.

To include the field data with a layout, use a layout package file. For more information, see 
Section 5.3.3, “Layout Package Files.” 

5.3.2.1. Layout File Saving. You save layout files using the Save Layout or Save Layout 
As options under the File menu.

To save your layout, do the following:

1. From the File menu, select Save Layout As. The Save Layout dialog appears.

2. Choose “Linked Data (*.lay)” using the File of type drop-down, as shown in Figure 5-11.

3. By default, Tecplot saves the name of the data files used in the layout with their relative file 
paths. If you want to save your layout using absolute file paths, turn off the Use Relative 
Path check box.

4. Specify a file name for the layout file. In Windows, you may specify a URL by selecting 
the URL check box. When selected, you may enter a full URL as the file name, as shown in 
Figure 5-12.

The URL must start with either ftp:// or http://. For example, ftp://ftp.microsoft.com/
myplot.plt. The two file types are mutually exclusive. You cannot browse disk files when 
the URL check box is selected, and you cannot enter a URL if the URL check box is not 
selected. To open (or save) the URL, click Open URL (or Save URL).

5. If you have changed a data set since you last read it in or wrote it out and only data opera-
tions supported by the data journal have been performed, Tecplot asks if you want to use 
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the original data set along with journaled data instructions. This is the default; it continues 
to reference the original data files, minimizing disk storage requirements and changes to 
the original data are reflected in later Tecplot sessions.

If you choose to save the current data to new files and reference the new files in the layout, 
or if you have modified the data in ways not supported by the data journal, Tecplot prompts 
you for a file name under which to save the changed data. If your layout has multiple data 
sets, Tecplot prompts you for a file name for each modified data set.

Once you save a layout, the layout file name appears in the Tecplot header. To save your layout 
to this file again, choose Save Layout from the File menu.

Figure 5-11. The Save Layout dialog in Motif, showing the Linked Data (*.lay) option.

Figure 5-12. The Save Layout dialog in Windows, showing the URL check box.
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5.3.2.2. Layout File Opening. You open layout files using the Open Layout option under 
the File menu.

To open your layout file:

1. From the File menu, select Open Layout. The Open Layout dialog appears.

2. Specify a file name, then click OK. If you have an unsaved layout, Tecplot asks you if you 
want to save it before opening a new layout file.

3. (Optional) To combine the layout file with the current layout in Tecplot, click on the 
Append check box prior to clicking OK.

5.3.2.3. Layout File Opening with Different Data Files. When you open your layout 
files in Tecplot, you have the option of overriding the data files that are referenced in the layout 
file. This does not change the layout file, however, you can save a layout file with the new data 
files.

This section describes the process for overriding a data file from the Open Layout dialog. A 
second method is described in Appendix A, Section A.5, “Overriding the Data Sets in Layouts 
by Using "+" on the Command Line.” 

To open a layout file with different data files than those specified in the layout file:

1. From the File menu, choose Open Layout. The Open Layout dialog appears.

2. Select Data Override.

3. Specify the layout file name, and click Open.

4. The Override Layout Data dialog appears, as shown in Figure 5-13.

5. One line is listed for each data set in the layout file. Each line contains the data reader name 
(TECPLOT for Tecplot-format data files). If the data set is being loaded by the Tecplot 
reader, this line shows the number of files making up the data set, and a partial list of file 
names. If a data loader add-on is used, instructions used by the loader are listed here. (This 
could be a list of file names identical to the Tecplot loader’s list.)

Figure 5-13. The Override Layout Data dialog.
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6. To change the data files or instructions making up a data set, double-click on the appropri-
ate line, or select the line and click Change.

7. This process includes one or more dialogs allowing you to change the list of file names or 
instructions. Tecplot-format data files include a dialog to select new files. If the data loader 
does not have the capability to override the instructions, an error message appears.

8. Repeat steps 6 and 7 until the files you want are listed, then click OK.

5.3.3.  Layout Package Files

Layout package files allow you to transmit raw data, along with style information, so col-
leagues can view the results in Tecplot. With layout package files the view can be changed, dif-
ferent plot types tested, and so forth.

Layout package files are very useful if you are making large documents containing many 
images, or other situations when you need to catalog your images. You can extract contents 
using the command line utility lpkview. This utility allows you to look at thumbnail sketches 
of each image in a layout packing file without having to load each separately into Tecplot. For 
more information see Section 5.3.3.3, “Layout Package Utility.” 

Layout package files have the same properties as standard layout files. (For more information 
about layout files, see Section 5.3.2, “Layout Files.” ) Layout package files also contain all 
data associated with frames in the layout, and an optional preview image of the Tecplot work-
space. An extension of .lpk is used.

5.3.3.1. Layout Package File Opening. Open a layout package file using the Open 
Layout option of the File menu. You may open both standard layout files and layout package 
files from this dialog.

The Data Override check box is only applicable when the file being opened is a standard layout 
file. If you select Data Override, and the file you open is a layout package file, a warning 
dialog appears; Tecplot loads the layout package with the original data.

5.3.3.2. Layout Package File Saving. Save a layout package file using the Save Layout 
or Save Layout As options of the File menu.

To save your layout package file:

1. From the File menu, select Save Layout As. The Save Layout dialog appears.

2. Choose “Packaged Data (*.lpk)” from the Files of type drop-down, as shown in Figure 
5-14.

3. Choose whether or not you want a preview image included with your layout package file.

4. Specify a file name for the layout package file.

Once you save a layout package file, the layout package file name appears in the Tecplot 
header. To save your layout package to this file again, choose Save Layout from the File menu.
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5.3.3.3. Layout Package Utility. As a convenience a command line utility, lpkview, is 
also provided to catalog and unpack layout packages. In its simplest form, only a layout 
package file is given to the utility; all default options are assumed. Using default options cause 
the utility to unpack the preview image (if present), the layout, and all associated data files into 
the directory in which the utility was run. For example:

    lpkview myplot.lpk

might unpack the following files in the current directory:

    myplot.png 
    myplot.lay 
    welldata.plt 
    grid_1.plt 
    grid_2.plt

Tecplot determines the names for unpacked files when the package is created. Tecplot elimi-
nates name conflicts within the package by appending unique numbers to non-unique names. 
However, no attempt is made by lpkview to ensure that names are unique with other files 
located in the directory where the items are unpacked.

If only the layout and associated data files are desired then run the command as follows:

    lpkview -l -d myplot.lpk

Figure 5-14. The Save Layout dialog in Motif, showing the Packaged Data (*.lpk) and 
Include Preview Image options.
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Using the -t options will output the names of the items within the layout package file without 
unpacking them. For example:

    lpkview -t wingperf.lpk

might output the following catalog to standard output:

wingperf.png 
wingperf.lay 
run_alpha12beta5.plt

For a complete list of lpkview command lines, see Appendix B.2, “LPKView.”

5.4. Plot Publishing for the Web
Publish allows saving plots directly to an HTML file, from which you may read and write data 
and layout files to ftp:// and http:// sites. A Tecplot HTML file could include a reference to a 
layout package file of your analysis, enabling other Tecplot users browsing your files to review 
your results directly. The Publish Options dialog and a Tecplot HTML file are shown in Figure 
5-15.

Publish creates an HTML file referencing the plot images in your Tecplot workspace. Publish 
also creates layout package files with a link from the HTML file to the layout package file.

To create a Publish file:

1. Choose Publish from the File menu.

2. Decide whether you would like to reference a layout package file. Selecting this option cre-
ates a layout package file, along with a reference to that file in the resulting Publish file.

3. Select what images are to be referenced in your Publish file.

Figure 5-15. The Publish Options dialog creates layout package files for the Web.
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Selecting the Make Single Image for the Workspace check box creates a single image file 
of your entire Tecplot workspace. A single reference is added to your Publish file for this 
image file.

Selecting the Make Separate Images for Each Frame check box creates an image for each 
frame in your Tecplot workspace. A separate reference for each frame is added to your Pub-
lish file.

4. Click OK. You will be presented with a standard file input/output dialog. The name you 
enter for your file will be used to create the HTML file, create the associated image files, 
and optionally, the layout package file.

5.5. Other Tecplot Files
In addition to the basic ASCII and binary data files, Tecplot uses a number of other files:

• Equation: Equation files are used to store equations for data manipulation. They are dis-
cussed in their entirety in Chapter 24, “Data Operations.” 

• Macro: Macro files are used to record and play back Tecplot operations and to set up Tec-
plot for animation or batch mode. See Chapter 27, “Macro Commands,”  for more details, 
and the Tecplot Reference Manual for an annotated list of all macro commands.

• Color map: A color map file is a Tecplot macro file that saves and restores RGB color val-
ues used for contour flooding and multi-coloring. See Chapter 10, “Contour Plots,” for 
details on creating and modifying Tecplot color map files.

• Print: Print files are files created with Tecplot (or Windows) printer drivers. See 
Chapter 21, “Printing,”  for more details.

• Export: Export files are graphics files created by Tecplot for import into graphics editing 
or word processing programs. All the print file formats are available for export, as are sev-
eral types of bitmaps, Windows Metafile (WMF) Format, and Encapsulated PostScript 
(EPS) format. For more information on creating bitmap files for export, see Chapter 22, 
“Exporting.” 

• Curve-coefficient: These files contain the coefficients for the equations used to draw 
curves in XY-plots. These are output files only; they cannot be read back into Tecplot. See 
Chapter 7, “Line Plots,” for more details.
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6.1.The CGNS Loader

CHAPTER 6 Data Loaders: Tecplot’s 
Import Feature 

Tecplot allows you to load data in a number of formats with loaders that Amtec has produced 
using the Add-on Developer’s Kit. The Import option on the File menu accesses a scrolled list 
of data loaders.

This chapter tells you how to load data in the following formats: Computational Fluid Dynam-
ics General Notation System (CGNS); Digital Elevation Map (DEM); Digital eXchange 
Format (DXF); Excel (Windows only); Fluent Version 5 and 6 (.cas and .dat); Gridgen; 
Hierarchical Data Format (HDF); Image; PLOT3D; Polygon (PLY); text spreadsheet.

Access data loaders using the File menu’s Import option. The Import dialog appears, as shown 
in Figure 6-1.

New data loaders are posted at our Web site, www.tecplot.com, as they become available. You 
can also build your own data loaders using the Add-on Developer’s Kit.

6.1. The CGNS Loader
The CGNS Loader reads files created with CGNSLib Version 2.2 or earlier into Tecplot. 
Choose either all or specific bases, zones, and solutions for loading into Tecplot zones. You 
can also select field variables individually. Define index ranges to load specific sub-zone 
blocks or planes for structured-grid zones.

Only CGNS bases and zones with valid grids can be read by the CGNS Loader. For unstruc-
tured grids Version 2.0 of the CGNS Loader supports TRI_3, QUAD_4, TETRA_4, PYRA_5, 

Figure 6-1. The Import dialog, accessed via the File menu.
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PENTA_6, HEXA_8, MIXED element types and their combinations on every section. How-
ever, the CGNS Loader does not support higher-order element types.

Only vertex and cell-center field variable locations are supported. Cell-centered data is aver-
aged to the nodes when the file is read. For cell-centered structured grids arithmetic averaging 
is used. Rind data is used in the averaging if it is available. For cell-centered unstructured grids 
either a Laplacian averaging or arithmetic averaging can be selected to average the cell data to 
the surrounding nodes.

The dialog for the CGNS Loader is shown in Figure 6-2.

The following options are available: 

• File: Enter the name of the file to load, including the complete path, or click "..." to browse 
for the file.

• Specify Options: Active when a valid file is entered or selected. If not selected, every base, 
zone, solution, and variable is loaded into Tecplot when you click OK. This option allows 
you to control the data loaded from your CGNS file, including loading only particular 
zones, field variables, or partial zones.

• Select Zones: Launches the Load CGNS Options: Zones dialog, which allows you to select 
specific zones and partial zones to load.

• Select Variables: Launches the Load CGNS Options: Variables dialog, which allows you 
to select specific field variables to load. Grid variables are always loaded automatically.

6.1.1. CGNS Loader Options: Zones Dialog
Tecplot zones are not always equivalent to CGNS zones. This dialog specifies zones to load 
from CGNS data files; it is shown in Figure 6-3.

For example, each solution for a CGNS zone is considered a unique Tecplot zone. The CGNS 
base, zone, and solution hierarchy orders the zones. The integer preceding the word Zone is the 
Tecplot zone number assigned to that zone. The integer following Zone represents the order 
the zone was found in the CGNS file. The zone description includes the CGNS hierarchy infor-

Figure 6-2. The dialog for the CGNS Loader.
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mation. “CGNS B, Z, S =” followed by three integers represents the CGNS order for the base, 
zone, and solution, respectively. “CGNS Z, S =” and two integers are displayed if a single base 
is found. The description also indicates whether the zone is ordered (structured) or finite-
element (unstructured). I-, J-, and K-dimensions are provided for ordered zones; the number of 
nodes and elements are provided for finite-element zones.

By default all zones are selected for reading and displayed in Zones to Load. Delete the list by 
clicking Remove All. You can also remove zones by selecting them, then clicking Remove. 
This does not affect the order of the zones in Zones from CGNS. However, zones not shown 
Zones to Load are not assigned a Tecplot zone number. Similarly, all zones can be added to 
Zones to Load by clicking Move All, or added selectively using Move. Zones in Zones to Load 
are listed in the order they were added to the list, regardless of their order in Zones from 
CGNS. This order is the basis for their Tecplot zone number and how they are identified in 
Tecplot.

To load a partial zone or sub-zone, first highlight the zone of interest in Zones to Load, then 
click Index Ranges for Zone(s). The Load CGNS: Index Ranges dialog appears.

6.1.1.1. CGNS Loader Options: Index Ranges Dialog. This dialog specifies a sub-set 
of the selected ordered/structured zone(s) to be loaded. Define a block, plane, or line of points 
for extraction on loading.

This is accomplished by inputting the ranges for the I-, J-, and K-indices. Each index requires 
Start, End, and Skip values. The Skip value reduces the number of points loaded by skipping 
points. A Skip value of three loads every third point after the Start point. (Start and End points 
are always loaded.) If multiple zones are selected prior to calling up the CGNS Loader: Index 
Ranges dialog, the default values for End are Mx, indicating the maximum value for each zone. 
You can enter any value for End; it is only be used in the appropriate zones. If the value is 
greater than the maximum index for a zone, End is replaced by the maximum index.

For multi-dimensional zones the number of points that can specified to load for the I- and J-
directions must be greater than one. If the inputs for Start, End, and Skip result in a single point 

Figure 6-3. CGNS Loader: Zones dialog.
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in either direction, an error message appears; change the inputs or cancel the dialog. The 
CGNS Loader: Index Ranges dialog is shown in Figure 6-4

6.1.2. CGNS Loader Options: Variables Dialog

The CGNS Loader: Variables dialog includes the Variables from CGNS and Variables to Load 
list boxes. It is shown in Figure 6-5.

The Variables from CGNS list includes all field variables that were found in the CGNS data 
file regardless of the zone(s) to which they belong, since CGNS files may contain zones that 
have different field variables. The Variables to Load list contains the field variables that have 
been selected to load into Tecplot. Initially, both lists are the same. A Tecplot variable number 
is assigned to each CGNS field variable that appears in the Variables to Load list. Since 
Tecplot requires every zone to have the same number of variables, each zone that is loaded into 
Tecplot will include every variable in the Variables to Load list. This will occur regardless of 
whether the zone included that field variable in the CGNS file. The variables that were not 
originally in the zone will be initialized to zero before they are loaded into Tecplot. Since this 
can unnecessarily increase the size of the data set in Tecplot, you are cautioned to carefully 

Figure 6-4. CGNS Loader: Index Ranges dialog.

Figure 6-5. CGNS Loader: Variables dialog.
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examine the Variables from CGNS list to guarantee that the field variables selected for the 
Variables to Load list will be consistent with the zones to be loaded.

Remove All lets you delete all variables from the Variables to Load list. Move All lets you 
include all variables from the Variables from CGNS list. You can also selectively remove vari-
ables from the Variables to Load list by highlighting the variable(s) with a click, click-and-
drag, Ctrl-click, or Shift-click, and then clicking Remove. The field variables that do not 
appear in the Variables to Load list will not have a Tecplot variable number assigned to them. 
Similarly, variables can be added to the Variables to Load by selectively highlighting the vari-
able(s) to be added in the Variables from CGNS list and then clicking Move. Note that vari-
ables in the Variables to Load list will be listed in the order in which they were added to the list 
regardless of their order in the Variables from CGNS list. This order is the basis for their 
Tecplot variable number, which is how they will be ordered in Tecplot. 

6.2. The DEM Loader
The DEM Loader add-on can load Digital Elevation Map files that have the same file format as 
the U.S. Geological Survey’s standard DEM format. These files are generally used by cartog-
raphers and geologists to map terrain. The DEM Loader will not accept Spatial Data Transfer 
Standard (SDTS) formatted data.

DEM files are available on the Web for a number of states within the U.S. For more informa-
tion, refer to the following references:

• General: edcwww.cr.usgs.gov/doc/edchome/ndcdb/ndcdb.html.

• User’s guide: edcwww.cr.usgs.gov/glis/hyper/guide/l_dgr_dem.

The DEM Loader first launches a multi-file selection dialog. After choosing one or more DEM 
files to load, you are presented with a simple dialog where you can set the I- and J-skipping. 
Since DEM files are quite large, you will likely want to set both of these to be 10 or more.

Figure 6-6 shows the DEM Loader dialog.

6.3. The DXF Loader
The DXF Loader add-on can import AutoCAD DXF (drawing interchange) files. When 
importing a file, Tecplot creates an appropriate geometry for each of the following entity types:

• Text.

• Lines.

• Arc.

• Circle.

• Point.

• Solid.

• 3-D faces.
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Note: When importing a DXF file, no zones are created. Instead, the geometries representing 
each entity type are simply added to the frame. Be aware that a typical DXF file can contain 
several thousand geometries, and these are all included when you save a layout file.

6.3.1. The Load DXF File Dialog

The Load DXF File dialog (Figure 6-7) has a variety of features, most of which are self-
explanatory.

You can select any of the following:

Figure 6-6. The Digital Elevation Map (DEM) Loader dialog.

Figure 6-7. The Load DXF File dialog.
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• Import: Select any or all geometries to import -- Text, Lines, Arcs, Circles, Points, Solids, 
3D Faces.

• Font: Select the font to use for text.

• Attach Imported Items to Zone: Specify a zone to which all imported geometries will be 
attached. Clicking the Select Zone button produces a menu of zone options.

• Polylines/Import as 2D: All lines and polylines are stored with three coordinates in DXF 
files. If you select this option, the loader will add 2-D line geometries for all lines and 
polylines in the DXF file (the third coordinate will be ignored).

• Polylines/Import as 3D: If you select this option, the loader will add 3-D line geometries 
for all lines and polylines in the DXF file. To view a 3-D DXF file, create or load a 3-D 
zone, import your DXF file, then choose Fit to Full Size from the View menu.

• Hide Invisible Layers: If this option is checked, objects in layers which are “off” in the 
DXF file will be imported with the background color.

6.3.2. DXF Loader Limitations
The DXF Loader does not create any field data. Loading a DXF file only adds geometries to 
your existing frame.

Since most geometries in Tecplot are 2-D, best results will be obtained by loading “flat” DXF 
files, such as maps.

Binary AutoCAD (*.dwg) are not supported in this release.

6.4. The Excel Loader
The Excel Loader add-on can read numeric data from Microsoft Excel version 5.0 or higher 
.xls files and import the data into Tecplot. It is shown in Figure 6-8. The Excel Loader is 
available only for Windows platforms.

This Import function is only useful for basic formats, requiring your Excel file to contain only 
values, no functions. Amtec recommends use of the Excel macro from the Util/Excel 
folder as an easier method to open Excel data with Tecplot.

Figure 6-8. The initial Excel Loader dialog.
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The Excel loader is a point-and-click operation if your spreadsheet is arranged in either of two 
ways, which we refer to as table format and carpet format. Other formats can also be loaded 
and imaged, but they require a little more work, and in some cases more sophistication, on 
your part.

Once you have chosen an Excel file to load into Tecplot, the Excel Loader leads you through a 
series of dialogs that let you specify a variety of attributes such as the format of the data in the 
Excel spreadsheet, the variables to read into Tecplot, and zone information.

6.4.1. Spreadsheet Data Formats
The Excel Loader will automatically identify blocks of data in table or carpet format, that is, 
blocks that satisfy the conditions of these formats. The characteristics of these formats are 
described in Section 6.4.1.1, “Table Format,” and Section 6.4.1.2, “Carpet Format.” If the 
loader has identified any carpet or table format blocks, you may select them from a list.

The loader will list blocks of data in standard Excel notation. For example, a block found on 
worksheet sheet1, cells A1-D8, is listed as follows: (sheet1 ! A1:D8). It is important to 
verify that the matrix specified is actually the matrix of data you wish to load.

If you select a user-defined format (or if the loader did not identify any carpet or table blocks), 
then you will be prompted to enter the names and number of variables, and one or more zones 
and associated properties. For each zone you will also have to enter the location of the field 
data in the spreadsheet.

6.4.1.1. Table Format. Table format is especially applicable to spreadsheets containing data 
that will be plotted in line plots—generally, data that represent an independent and one or more 
dependent variables. Many spreadsheets containing data to be plotted in 2D or 3D Cartesian 
plots will also satisfy the conditions of table format. A table formatted data set has the follow-
ing characteristics:

• The data set is arranged in one or more adjacent columns.

• Each column is the same length and contains numeric data.

• At the top of each column is a variable name (that is, a cell containing the text label of the 
variable).

• The spreadsheet data set is imported as a single I-ordered zone in POINT format with N 
variables, where N is the number of columns in the table.

• There must be no blank cells within the block of data. An empty cell will prevent the loader 
from recognizing the block. You can satisfy this condition by filling blank cells with 0.0.

• The block of data must be surrounded by empty cells, text-filled cells, or table boundaries. 
The loader will not recognize a block of data as being in table format if any cell adjacent to 
the block is filled with a number.

Figure 6-9 shows an Excel block in table format.
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6.4.1.2. Carpet Format. A spreadsheet to be plotted in a 2D or 3D Cartesian plot is likely to 
be in carpet format. The carpet formatted data set, shown in Figure 7-10, has the following 
characteristics:

• The spreadsheet data set is imported as an IJ-ordered zone. In Figure 6-10, the spreadsheet 
is imported as I=4 and J=4. The three variables are X, Y and V. In the spreadsheet cell 2B 
is index 1, 1, cell 3B is index 2, 1. See section 4.2.2, “IJ-Ordered Data.”

• The top row in the block contains the values of the X-variable, the first column of the block 
contains the values of the Y-variable, and the V-values are the interior data. This format is 
useful if your data set was generated from a function f, such that f(X, Y) = V. This may be a 
simple arithmetic function of X and Y, or may represent measurements of some variable at 
points on a grid.

• The block is a rectangular arrangement of numeric data in the spreadsheet, with a blank cell 
in the upper left hand corner.

• There must be no blank cells within the block of data. An empty cell will prevent the loader 
from recognizing the block. You can satisfy this condition by filling blank cells with 0.0.

• The block of data must be surrounded by empty cells, text-filled cells, or table boundaries. 
The loader will not recognize a block of data as being in carpet format if any cell adjacent 
to the block is filled with a number.

6.4.1.3. Other Formats. The Other format option gives you a great deal of flexibility in 
loading data into Tecplot, but also requires you to give the loader more information about the 
block of data you are loading. A series of dialogs leads you through the process of describing 
your data, similar to the way you would specify this information in a Tecplot ASCII file. Some 

Figure 6-9. A block of data in table format. Note that for the block to be recognized 
as such by Tecplot, it must be bounded by spreadsheet edges, text, or empty cells.
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of the most relevant attributes of your data set and its format are described in Section 4.1.2.4, 
“Data Types,” Section 4.2, “Ordered Data,” and Section 4.3, “Finite-Element Data.” 

• Default format: The Excel Loader offers a semiautomatic option that requires only that 
you specify the upper left and lower right corners of your data block. Once you’ve speci-
fied those corners, it handles the data in the same way that Tecplot handles an unformatted 
block in an ASCII file. That is, it assumes one zone of I-ordered data in POINT format.

• Custom format: Using the Custom format option, you can specify characteristics of your 
data set. Custom format has the following features:

- It allows you to work with spreadsheets containing blank cells or text cells.

- For XY-, IJ- and IJK-ordered data, you’ll tell the loader the boundaries of the block to 
load, and how many data points there are within that block (IMax, JMax, KMax).

- For finite-element data, the number of data points is implied by the number of nodes and 
number of elements.

- Allows you to load blocks of cells that you delimit interactively. 

- It is the only option for loading finite-element, IJK-ordered, or zone data from Excel. If a 
user wants to read in data from an Excel spreadsheet into more than one Tecplot zone 
the custom format must be used. The default assumes that all data read should be put 
in a single I-ordered zone. 

Figure 6-10. The carpet table shows values as a simple arithmetic function                 
of X and Y.
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6.4.2. FEPOINT Excel File in User-Defined Format Example
The Excel spreadsheet in Tec90/examples/loaders/xls/fe1.xls (Figure 6-11) 
contains data in finite-element POINT format (refer to Section 4.3, “Finite-Element Data,” for 
a discussion of FE-point format). The procedure for loading the data into Tecplot is as follows:

1. Select the Import option from the File menu.

2. Choose Excel.

3. In the Read Excel File, specify a path and a file, and click OK.

4. In the Import Excel File—Step 1 dialog, you are restricted to Other format, because 
fe1.xls does not satisfy the conditions of table or carpet format. Click Next>.

5. In the Step 2 of 4 dialog, add seven variables of type Double, and a title if you wish. Click 
Next>.

6. In the Step 3 of 4 dialog, click Add.

7. From the Add menu select the Edit Zone option and specify that:

- You choose the block of data that extends from B1 to H33.

- The format of the data file is FEPOINT.

- The data set contains 13 nodes.

- Those nodes are connected into 20 elements.

- The element type is TETRAHEDRON.

8. Click OK. The Step 3 of 4 dialog now displays the zone you have described, with a + but-
ton that you can press to display your parameters.

9. Click Next>.

10. The Import dialog displays some of your choices. Confirm them and click Finish.

Figure 6-11. Excel file fe1.xls, used in the example in Section 6.4.2. 
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11. The initial plot is 2D Cartesian, which you can convert to 3D Cartesian for a full view of 
the finite-element volume (Figure 6-12).

6.4.3. Excel Loader Restrictions
Recall that a block of data is a rectangular group of numbers in the spreadsheet. The loader 
places the following restrictions on blocks:

• Carpet and table format, which the loader detects and loads automatically, are fairly nar-
rowly defined. All other formats must be loaded on the user-defined pathway.

• Numeric cells within each block should contain only numbers or numeric characters such 
as +, -, and so forth. For example, a cell which contains X=34 is interpreted by the loader 
as text, since it begins with text. 

• Cells containing formulas (therefore displaying calculated values) will be skipped by the 
loader. You can convert the formulas to values within Excel.

• The spreadsheet file must have been written by Excel Version 5.0 or higher. Earlier ver-
sions of Excel are not supported.

6.5. The Fluent Loader
The Fluent Data Loader allows you to read Fluent Version 5 and 6 case (.cas) and data 
(.dat) files into Tecplot. To load files from earlier versions of Fluent, you must first import 
them into Fluent 5 or 6, then save them as Fluent 5 or 6 files.

Fluent stores solution data at cell centers (face centers for boundary zones). By default, the 
Fluent data loader loads the data cell-centered as well, but it has options to average the data to 
the nodes if this should be necessary (for use by other add-ons, for example). Two averaging 
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options are available. Arithmetic averaging is faster, but calculates values at hanging nodes 
(nodes in the center of a cell face or edge) only from those cells of which the node is a corner. 
This can lead to discontinuous contours due in part to this one-sided averaging. The slower 
Laplacian averaging option takes additional neighboring cells into account, and gives 
smoother contours when hanging nodes are present.

The Fluent Data Loader dialog is shown in Figure 6-13.

The following options are available:

• Load Case and Data Files: Loads both a case and a data file. The grid comes from the 
case file, and the solution comes from the data file.

• Load Case File Only: Loads the grid from a case file.

• Load Residuals Only: Loads the residual data (convergence history) from a data file. The 
residuals are not scaled or normalized.

• Load Multiple Case and Data Files: Displays the File List form in the dialog. You can 
load matched pairs of case and data files, or one cae file and any number of data files that 
match it (that is, that have the same zones).

For all load options above except Load Multiple Case and Data Files, the following controls 
are available:

Figure 6-13. The Fluent Data Loader dialog.
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• Case File: Type the name of the case file you wish to load, or click Select, then select the 
name of the file from the resulting dialog.

• Data File: The data (.dat) file contains the solution and the residual (convergence history) 
data. Type the name of the data file, or click Select, then select the name of the file from the 
resulting dialog.

For the Load Multiple Case and Data Files load option, the following controls are available:

• Add Files: Choose case and data files to load from a file selection dialog. Selected files are 
appended to the file list.

• Remove: Remove files you have selected in the file list.

• Remove All: Remove all files in the file list.

• Flow Solution is Unsteady: Indicates that the set of case and data files represents an 
unsteady solution. The loader adds a TIME auxiliary data item to each loaded zone. Tecplot 
does not use this data, but other add-ons may.

• Time Interval: The time interval between successive data files in the file list. The TIME 
auxiliary data item will be incremented by this amount (starting at zero) for each successive 
data file loaded.

For all load options except Load Residuals, some or all of the following controls are available:

• Select Zones and Variables to Load: Select in a separate dialog which zones and variables 
to load. The option requires the loader to pre-scan all files, which can be time-consuming.

• Load Cells and Boundaries: Loads the cell (solution) and boundary zones from the case 
file. Each fluid or solid cell zone and each boundary zone will be displayed as a separate 
zone in Tecplot.

• Load Cells Only: Loads only the cell (solution) zones. Each zone will be displayed as a 
separate zone in Tecplot.

• Load Boundaries Only: Loads only the boundary zones. Each zone will be displayed as a 
separate zone in Tecplot.

• Average to Nodes: By default, non-grid variables are stored at cell centers, consistent with 
Fluent. Selecting this option directs the loader to average Fluent’s cell-centered data to the 
grid nodes. Choose the averaging method below.

• Arithmetic: A simple, fast arithmetic averaging will be performed.

• Laplacian: A more accurate, much slower averaging will be performed that accounts for 
hanging nodes and cell sizes.

If you chose the Select Zones and Variables to Load option, the Fluent Loader Options dialog, 
as shown in Figure 6-14, will be displayed when you click OK. This dialog allows you to 
select only those zones and variables you wish to load from the files. 
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This dialog has a Zones page and a Variables page. The left-hand list of each page shows, 
respectively, all zones and variables contained in the files you selected. The right-hand list of 
each page shows the zones and variables that will be loaded when you click OK. Both pages 
have the following controls:

• Move All: Adds all zones or variables to the list of those to be loaded.

• Move: Adds the zones or variables selected in the left-hand list to the list of those to be 
loaded.

• Remove: Removes the zones or variables selected in the right-hand list so they will not be 
loaded.

• Remove All: Empties the list of items to be loaded. You must subsequently add at least one 
item to load.

6.6. The Gridgen Loader
The Gridgen Loader add-on accepts output from Pointwise, Inc.’s Gridgen Version 11. (Amtec 
has not tested previous versions.) The Gridgen Loader can import the following types of 
Gridgen files into Tecplot:

• Database Network (*.net)—one IJ-ordered zone is created for each network in the file.

• Volume Grid (*.dat)—one IJK-ordered zone is created for each block of data in the file.

More information on Gridgen Volume Grid and Database Network files can be found in the 
Gridgen User’s Manual.

The files can be in any of the following formats, which are automatically detected:

• ASCII.

Figure 6-14. The Fluent Loader Options dialog.



Chapter 6. Data Loaders: Tecplot’s Import Feature

114

• Binary formatted.

• Binary unformatted.

• Single or double precision.

The data set is given a default title of “Imported Gridgen Data,” which you may change by 
selecting the Data Set Info option from the Data menu.

Variables names default to “X,” “Y,” and “Z.” These can be changed within Tecplot after the 
data set is loaded.

The Gridgen Loader leads you through several screens, each of which allows you to specify 
one or more attributes of the input files (Figure 6-15).

6.6.1. Gridgen Data Loading with Tecplot

The Gridgen Loader dialog asks for the following information:

• File Type: Select the type of file you wish to import.

• I-Skip, J-Skip, K-Skip: Select the I-, J-, and K-Skip values. A value of 1 will read every data 
point, 2 will read every other data point, and so on.

After you have selected the file type and skip values, click OK and you will be prompted for 
one or more files to load. Select one or more files and click OK to load the files.

6.7. The HDF Loader
The Tecplot HDF Loader add-on can load 1-D, 2-D, and 3-D Scientific Data Sets (SDS) from 
HDF files.

Figure 6-15. The Gridgen Loader dialogs.
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The HDF Loader dialog is shown in Figure 6-16.

A data set from an HDF file is imported as follows:

1. The file is scanned and a list of all SDS in the file is created.

2. You select one or more SDS to import. Each SDS that you select must have the same 
dimension.

3. A rectangular I-, IJ-, or IJK-ordered zone (for 1-, 2-, or 3-D data, respectively) is created 
for each SDS that you select to load.

4. The data is imported.

The HDF Loader dialog asks the following information:

• Scientific Data Sets to load: Select one or more SDS’s to load. Each SDS that you select must 
have the same rank (dimension).

• I-Skip: Select the I-Skip value. A skip value of 1 loads every data point, a skip value of two 
loads every second data point, and so on.

• J-Skip: Select the J-Skip value.

• K-Skip: Select the K-Skip value.

• Select File: Select an HDF file.

• Attributes: Displays attributes of each SDS found, such as number type, rank, label, and so 
on.

Note: The HDF Loader uses the public-domain HDF API code library from the National 
Center for Supercomputing Applications (NCSA), University of Illinois, Urbana-Champaign.

6.7.1. HDF Loader Limitations

The HDF Loader can import only Scientific Data Sets from HDF files, and these are imported 
in a manner similar to NCSA’s own HDF viewer. The way in which the data file is interpreted 
cannot be altered in this release of the loader. However, it is possible to write a Tecplot add-on 
(using the NCSA code library) which loads HDF data in a manner more suited to your particu-

Figure 6-16. The HDF Loader dialog.
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lar use of the HDF format. See the ADK User’s Manual for more information on writing add-
ons.

6.8. The PLOT3D Data Loader
The PLOT3D Loader add-on can import data files formatted for the PLOT3D program devel-
oped by Pieter Buning at the NASA Ames Research Center. Some extensions such as unstruc-
tured data that are now available in FAST, the successor to PLOT3D, are also supported.

6.8.1. File Combinations

The File Selection page of the PLOT3D Loader dialog is shown in Figure 6-17. 

You may specify to load just the grid file, both the grid and solution files, or just solution files.

The following table describes all six scenarios and what the PLOT3D loader does: 

Figure 6-17. The File Selection page of the PLOT3D Loader dialog.

Load Not Appending Appending

Grid Only Existing data set is deleted and 
zones (one per grid are loaded).

New zones are added (one per grid). 
Solution vars in new zones are 
zeroed out.

Grid and Solution Existing data set is deleted and 
zones (one for each grid in each 
solution file) are loaded. Each set of 
zones loaded shares spatial vars with 
the first set of grids loaded.

Same as Not Appending except orig-
inal data set is preserved. Existing 
data set must have at least as many 
variables as the number needed by 
the incoming data.
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6.8.2. PLOT3D File Structure
The File Structure page of the PLOT3D Loader dialog allows you to choose to have the 
PLOT3D Loader auto detect the file structure, or override and manually describe the structure. 
The dialog is shown in Figure 6-18.

The PLOT3D Loader can auto detect most PLOT3D file variants. ASCII files are the most dif-
ficult to auto detect as there are a few combinations that have the exact same signature. Pure 
binary files also have some combinations that have the same signature. If all else fails use the 
manual settings to load in the files.

6.8.2.1. Unstructured Data Files. You must manually specify the data structure for all 
unstructured solution files if loaded without an accompanying grid file. Auto detect will think 
solution files are 3DW if loaded by themselves.

Solution Only A data set must already be present. 
The existing data set is reduced to 
contain the same number of zones as 
there are grids in each incoming 
solution file. Solution vars in the 
first solution file replace the solution 
vars in the original zones. Subse-
quent solution files create new sets 
of zones with spatial variables 
shared with the first set of zones.

Same as Not Appending except orig-
inal data set is preserved. Existing 
dataset must have at least as many 
variables as the number contained in 
incoming solution file. Spatial vars 
are shared with last n original zones 
where n is the number of grids in 
each incoming solution file.

Figure 6-18. The File Structure page of the PLOT3D Loader dialog.

Load Not Appending Appending



Chapter 6. Data Loaders: Tecplot’s Import Feature

118

The following ASCII file conditions require special attention: 

6.8.2.2. Pure Binary Files. The following pure binary files (binary files without record 
markers) require special attention:

6.8.3. PLOT3D Data Subsets
The Data Subset page of the PLOT3D Loader (see Figure 6-19) allows you to read subsets of 

ordered zones within the files. Specify the desired beginning and ending index values to read 
and a skip value for each index direction. A skip of one results in every value in the specified 
index range being read. A skip of 2 reads every second value, and so on.

Condition Notes

Double Precision You must tell the loader if the incoming file is single or double preci-
sion.

I-Blanking You must tell the loader if the incoming file contains I-blanking.

3-D Planar There are some cases where these files can appear exactly the same if 
they are 3-D Whole. The PLOT3D loader always favors 3-D Whole. If 
you need to load 3-D Planar in 3-D Planar ASCII files you must specify 
the data structure manually.

Condition Notes

3-D Planar There are some cases where these files can appear exactly the same if 
they are 3-D Whole. The PLOT3D loader always favors 3-D Whole. If 
you need to load in 3-D Planar pure binary files you must specify the 
data structure manually.

Figure 6-19. The Data Subset page of the PLOT3D Loader dialog.
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6.8.4. Macro Language
The macro language syntax for the PLOT3D Loader shipped with Tecplot version 10 has 
changed from that of previous versions. Layouts created with previous versions can still be 
read, but will be saved with the newer syntax.

6.8.4.1. New Instruction Syntax. The new loader uses the Standard syntax so layouts can 
be saved and automatically use relative paths for file names. The following table lists the stan-
dard syntax name-value pairs used by the PLOT3D Loader:

Where

datastructure is “1D”, “2D”, “3DP”, “3DW”, or “UNSTRUCTURED”

Keyword Value(s) Default Notes

STANDARDSYNTAX 1.0 None/
Required

Must be the first 
instruction.

FILELIST_SOLUTION
FILES

“n”  “file-1” “file-2” .... “file-n” Empty

FILENAME_GRIDFILE “filename” Empty

IINDEXRANGE “indexrange” “1, ,1” Start, End, Skip

JINDEXRANGE “indexrange” “1, ,1” Start, End, Skip

KINDEXRANGE “indexrange” “1, ,1” Start, End, Skip

APPEND “Yes” or “No” “No”

ASCIIISDOUBLE “Yes” or “No” “No”

ASCIIHASBLANK “Yes” or “No” “No”

AUTODETECT “Yes” or “No” “Yes”

DATASTRUCTURE “datastructure” --- Required if 
AUTODETECT is 
“No,” otherwise 
ignored.

ISMULTIGRID “Yes” or “No” --- Required if 
AUTODETECT is 
“No,” otherwise 
ignored.

STYLE “plot3dstyle” --- Required if 
AUTODETECT is 
“No,” otherwise 
ignored.
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plot3dstyle is “PLOT3DCLASSIC”, “PLOT3DFUNCTION”, or “OVERFLOW”

6.8.5. PLOT3D Auxiliary Data
The following auxiliary data is created by the PLOT3D Loader:

Notes: (1) Auxiliary data assigned to both zones and the data set assign the value from the last 
zone processed to the data set; (2) Overflow specific constants.

Auxiliary Name Assigned To

Common.ReferenceMachNumber Data Set and Individual Zones (1)

Common.AngleOfAttack Data Set and Individual Zones (1)

Common.ReynoldsNumber Data Set and Individual Zones (1)

Common.Time Individual Zones

Common.DensityVar Data Set

Common.UVar Data Set

Common.VVar Data Set

Common.WVar Data Set

Common.StagnationEnergyVar Data Set

Common.GammaVar Data Set

Common.TurbulentKineticEnergyVar Data Set

Common.TurbulentDissipationRateVar Data Set

Common.VectorVarsAreVelocity Data Set

Common.SpeedOfSound Data Set

G (2) Individual Zones

B (2) Individual Zones

T (2) Individual Zones

I (2) Individual Zones

H (2) Individual Zones

H1 (2) Individual Zones

H2 (2) Individual Zones



121

6.9.The Text Spreadsheet Loader

6.8.6. PLOT3D Loader Limitations
The -ip, -jp, -kp options in older PLOT3D Loader are not supported in the initial release. 
Tecplot handles I-, J- and K-planes well, so loading 3-D planar files as a single zone is typi-
cally sufficient.

6.9. The Text Spreadsheet Loader
The Text Spreadsheet Loader add-on is both an example of how to write a loader add-on and a 
utility which lets you import simple data from ASCII files. The complete source code for the 
Text Spreadsheet Loader is included in the ADK Examples directory.

6.9.1. Data File Format

The Text Spreadsheet Loader can read ASCII files of the following format (blank lines are 
ignored):

 Variable 1, Variable 2, ..., Variable N
 datapoint1,datapoint2, ..., datapoint N
 .
 .
 .
 datapoint1,datapoint2, ..., datapointN

Here is an example of a valid ASCII spreadsheet file:

Month, Rainfall
1, 15.0
2, 21.0
3, 21.0
4, 32.0
5, 10.3
6, 5.1
7, 2.3
8, 0.2
9, 1.4
10, 8.3
11, 12.2
12, 15.4 

6.9.2.  Text Spreadsheet Loader Limitations

All of the variable names must be on the first line.
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CHAPTER 7 Field Plots

A field plot is any 2D Cartesian or 3D Cartesian plot. Such plots combine one or more of the 
following zone layers:

• Mesh.
• Contour.
• Vector.
• Scatter.
• Shade.
• Boundary.

By default, 2- and 3-D field plots consist of the Mesh and Boundary zone layers. For example, 
when you read in the data set cylinder.plt (included with your Tecplot distribution), you 
automatically see the plot shown in Figure 7-1. The cylinder.plt data set contains three 
zones. By default all zones are plotted; Tecplot assigns basic colors cyclically to the individual 

zones. However, you can assign any of Tecplot’s basic colors to each zone. By default, the X- 
and Y-axes are dependent; if you change the range of one, the other changes to preserve the 
XY-aspect ratio. You can change virtually all attributes of the plot using the Axis, Field, and 
Style menus. This chapter discusses the basic plot attributes that are common to all field plots.

Figure 7-1. A 2-D mesh plot.
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7.1. Two-Dimensional Field Plots
A 2-D field plot typically uses an IJ-ordered or finite-element surface data set. (You can view 
I-ordered data in a 2-D field plot, but XY-plots are typically more informative. Similarly, you 
can view IJK-ordered and FE-volume data with 2-D field plots, but 3-D views are usually bet-
ter.) An IJ-ordered data file has the basic structure shown below:

TITLE = "Example: Multi-Zone 2-D Plot" 
VARIABLES = "X", "Y", "Press", "Temp", "Vel" 
ZONE T="BIG ZONE", I=3, J=3, DATAPACKING=POINT 
1.0 2.0 100.0 50.0 1.0 
1.0 3.0 95.0 50.0 1.00 
1.0 4.0 90.0 50.0 0.90 
2.0 2.0 91.0 40.0 0.90 
2.0 3.0 85.0 40.0 0.90 
2.0 4.0 80.0 40.0 0.80 
3.0 2.0 89.0 35.0 0.85 
3.0 3.0 83.0 35.0 0.80 
3.0 4.0 79.0 35.0 0.80 
ZONE T="SMALL ZONE", I=3, J=2, DATAPACKING=POINT 
3.0 2.0 89.0 35.0 0.85 
3.5 2.0 80.0 35.0 0.85 
4.0 2.0 78.0 35.0 0.80 
3.0 3.0 83.0 35.0 0.80 
3.5 3.0 80.0 35.0 0.85 
4.0 3.0 77.0 33.0 0.78

This data file has two zones and five variables, and is included with Tecplot as the file exam-
ples/dat/multzn2d.dat. The first zone has nine data points arranged in a three-by-
three grid. The second zone has six data points in a three-by-two mesh. Reading this data file 
yields the mesh plot shown in Figure 7-2.

A 2-D finite-element data file is shown below:

TITLE = "Example: 2D Finite-Element Data" 
VARIABLES = "X", "Y", "P", "T" 
ZONE N=8, E=4, DATAPACKING=POINT, ZONETYPE=FEQUADRILATERAL 
0.0 1.0 75.0 1.6 
1.0 1.0 100.0 1.5 
3.0 1.0 300.0 2.0 
0.0 0.0 50.0 1.0 
1.0 0.0 100.0 1.4 
3.0 0.0 200.0 2.2 
4.0 0.0 400.0 3.0 
2.0 2.0 280.0 1.9 
1 2 5 4 
2 3 6 5 
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6 7 3 3 
3 2 8 8

The above finite-element data file has eight nodes and four elements, with four variables, and 
is included in your Tecplot distribution as examples/dat/2dfed.dat. It yields the 
simple mesh plot shown in Figure 7-3.

7.2. Three-Dimensional Field Plots
Creating a 3-D field plot from a 2-D plot is usually as simple as selecting 3D Cartesian from 
the plot type dropdown on the sidebar. For example, suppose you read in the file spc-
ship.plt from the demo/3d directory, an IJ-ordered data set which by default is displayed 
in 2-D. Selecting 3D Cartesian yields the 3-D surface mesh plot shown at the left in Figure 7-4. 
The spaceship appears on its side by default; you can change this either by rotating the plot 
around the X-axis or by interchanging the axis assignments of the X- and Y-variables.

Figure 7-2. A 2-D field plot.

Figure 7-3. A 2-D mesh plot of a finite-element data set.
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To change the axis assignments:

1. From the Plot menu, choose Assign XYZ. The Select Variables dialog appears.

2. For the Y-axis, choose variable Y, and for the Z-axis, choose variable X.

3. Redraw the plot to obtain the view displayed at the right of Figure 7-4.

For 3-D volume data sets, which include both IJK-ordered and FE-volume data sets, 3D Carte-
sian is the default plot type. That is, when you read in such data sets, Tecplot automatically dis-
plays them in 3-D.

IJK-ordered data sets have the general form shown below:

TITLE = "Example: Simple 3-D Volume Data" 
 VARIABLES = "X", "Y", "Z", "Density" 
 ZONE I=3, J=4, K=3, DATAPACKING=POINT 
 1.0 2.0 1.1 2.21 
 2.0 2.1 1.2 5.05 
 3.0 2.2 1.1 7.16 
 1.0 3.0 1.2 3.66 
...

The complete ASCII data file is included with Tecplot as simp3dpt.dat (POINT format), 
and in block format as simp3dbk.dat. When you read either of these files into Tecplot, you 
immediately get the plot shown in Figure 7-5.

Finite-element volume data sets, like FE-surface data sets, consist of two separate lists—the 
value list and the connectivity list. A portion of a finite-element volume data file is shown 
below:

TITLE = "Example: FE-Volume Brick Data" 
 VARIABLES = "X", "Y", "Z", "Temperature" 
 ZONE N=14, E=5, DATAPACKING=POINT, ZONETYPE=FEBRICK 
 0.0 0.0 0.0 9.5 

Figure 7-4. A 3-D field plot (left). The same plot after interchanging X and Y (right).
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 1.0 1.0 0.0 14.5 
 1.0 0.0 0.0 15.0 
 1.0 1.0 1.0 16.0 
... 
 1 1 1 1 2 4 5 3 
 2 4 5 3 7 10 11 8 
 4 4 5 5 10 13 14 11 
 4 4 4 4 9 12 13 10 
 2 2 4 4 7 6 9 10

The full data file, consisting of a single FE-Brick zone, is included with Tecplot as 
febrfep.dat (POINT format), and in BLOCK format as febrfeb.dat. When you read 
either of these files into Tecplot, you obtain the plot shown in Figure 7-6.

7.3. Field Plot Modification
Once you have read in your data, you can modify your field plot attributes using one or more 
pages of the Zone Style dialog (Mesh, Contour, and so forth) or the Quick Edit dialog. No 
matter which zone layer you are currently modifying, you can control the following attributes 
from its corresponding page in the Zone Style dialog:

• Which zones are active.
• Whether the zone layer is visible for each active zone.
• The color. (For the Scatter zone layer, you may specify two colors, an outline color and a 

fill color.)

Figure 7-5. Plot of a 3-D volume.
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A few other attributes are common to some, but not all, zone layers:

• The plot type. (For the Scatter zone layer, this is the symbol shape.)
• The line pattern.
• The pattern length.
• The line thickness.

7.3.1. Zone Style Dialog
The following pages are available in the Zone Style dialog:

• Mesh.
• Contour.
• Vector.
• Scatter.
• Shade.
• Boundary.
• Points.
• Surfaces.
• Volume.
• Effects Attributes.

The last two are only available for 3D Cartesian plots. These pages allow you to specify plot 
attributes for each zone layer, zone by zone. On each page, the zone information is in the form 
of a scrolled list. To modify an attribute, the general procedure is the following:

Figure 7-6. A 3-D field plot of a finite-element volume data set.
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1. Call up the Zone Style dialog via the Plot menu or the Zone Style button on the sidebar. The 
Mesh page of the dialog is shown in Figure 7-7.

2. Select one or more zones, listed in the left hand column of the scrolled list.

3. Click on a column header, which is usually a drop-down showing all the options for that 
attribute.

4. Choose the desired option to change the attribute for all selected zones.

5. You can quickly move between the different Zone Style dialog pages by clicking the page 
tabs at the top of the dialog.

7.3.2. Zone Display
By default, all zones are active, meaning capable of being displayed. If a zone is not active, it 
will not be plotted. At least one zone must be active at all times; if you attempt to deactivate all 
zones, Tecplot activates the first zone of the group which you tried to deactivate. For example, 
suppose zones 2 and 3 are active, and you try to turn off both of them. Tecplot automatically 
turns zone 2 back on. You can activate and deactivate zones from any page of the Zone Style 
dialog.

To activate or deactivate a zone or zones:

1. From any page of the Zone Style dialog, select the zone or zones you want to activate or 
deactivate.

2. Click Zone Show. The choices Activate and Deactivate appear.

3. Click Activate to activate the zones, Deactivate to deactivate the zones, or Show Selected 
Only to activate the selected zones and deactivate all others.

7.3.3. Zone Layer Display
Whether a given zone layer is displayed for a given zone depends on three things:

• Whether the zone layer is active (controlled via the zone layer buttons on the sidebar).
• Whether the zone is active (controlled in the Zone Style dialog).

Figure 7-7. The Mesh page of the Zone Style dialog.
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• Whether the zone is enabled to show the layer (controlled in the relevant zone layer’s page 
of the Zone Style dialog).

When you read in a data set, all three conditions are true for all zones and for the Mesh and 
Boundary zone layers, and the Mesh and Boundary zone layers are shown for all zones. How-
ever, you can deactivate certain zones, and for those zones nothing is plotted. You can also 
disable individual zone layers for any zone. This is useful if you are creating a complex plot 
with different plot types for different zones. For example, you might have one zone plotted 
with contour flooding and another with multi-color mesh lines. In this case, you would selec-
tively turn off the Mesh zone layer in the contour flooded zone and turn off the Contour zone 
layer in the mesh zone. Both the Mesh and the Contour zone layers would be active globally.

To enable or disable a field layer for a zone or zones:

1. Choose the appropriate page of the Zone Style dialog.

2. Select the zone or zones for which you want to enable or disable the zone layer.

3. Click on the column header for showing the zone layer (Mesh Show, Contour Show, and so 
forth). The choices Yes and No appear.

4. Click Yes to enable the zone layer for the selected zones, or No to disable the zone layer for 
the selected zones.

If you click Yes to enable plotting when the corresponding zone layer is disabled, Tecplot dis-
plays a dialog asking if you want to turn on the corresponding zone layer. Click Yes to turn on 
the zone layer, No to leave it turned off. In either case, the zone has that zone layer enabled, 
and that zone layer will be displayed at the first Redraw after turning on the corresponding 
zone layer.

You can also enable or disable each zone layer using the Quick Edit dialog for zones you select 
interactively in the workspace. Figure 7-8 shows the region of the Quick Edit dialog you use to 
enable or disable mesh display and also to control the mesh plot type.  

To enable or disable a field layer for a zone from the Quick Edit dialog:

1. In the workspace, use the Selector tool to select the zone or zones for which you want to 
enable or disable a plotting layer.

2. Call up the Quick Edit dialog by selecting Quick Edit... from the Edit menu.

3. Click Y in the appropriate display area to enable the zone layer for the selected zones; click 
N to disable the zone layer for the selected zones.

Figure 7-8.  Mesh display and plot type region of the Quick Edit dialog.
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7.3.4. Color Choice
For each zone layer, you can pick a color independently for each zone in the data set. The color 
chosen for each zone layer is independent of the colors chosen for the other layers. Thus, the 
mesh color is independent of the colors that you choose for contour lines, vectors, scatter sym-
bols, solid shading, or boundaries. You can choose from any of Tecplot’s basic colors, or (for 
mesh, contour lines, scatter symbols, and vectors) choose a Multi-color option or RGB color-
ing. When you select a Multi-color option, the zone layer is colored as a function of the con-
tour variable for the selected contour group (C1, C2, C3 or C4). If no contour variable is 
currently active, the Contour Details dialog appears with the default contour variable high-
lighted. You can either select a new contour variable, or click Close to accept the default. A 
multi-colored plot varies in color like a flooded contour plot—the color of each line segment 
(between adjacent data points) is determined from the average value of the contour variable at 
the two data points (together with other options such as the number of contour levels and the 
current color map).

If you choose RGB coloring, you will be prompted for three variables to use for the red, green, 
and blue color components. Choose the desired variables and click OK. RGB coloring is 
covered in more detail in CHAPTER 10 “Contour Plots” on page 199.

Specifying a color is essentially the same for all zone layers; to be specific, the procedure for 
modifying mesh plots is given below. The procedure for changing the color for other zone 
layers is similar.

To choose a mesh color for a zone or zones:

1. From the Zone Style dialog, select the zone or zones for which you want to specify a color.

2. Click Mesh Color. A drop-down appears containing Tecplot’s basic colors and the Multi-
color option.

3. Click on the desired color option.

You can also choose the mesh color from the Quick Edit dialog for zones chosen interactively 
in the workspace. The color region consists of a row of options labeled Fill, Line, and Text, 
respectively, followed by a button that displays the Select Color dialog and a button labeled X, 
which is not used for mesh plots. When you choose a color via the Quick Edit dialog, the color 
changes for all visible zone layers for the selected zones.

To choose a mesh color for a zone or zones from the Quick Edit dialog:

1. In the workspace, use the Selector tool to select the zone or zones for which you want to 
assign a new mesh color.

2. Call up the Quick Edit dialog by choosing Quick Edit... from the Edit menu.

3. Click Line.

4. Click Color...

5. Click on the desired color option.
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7.3.5. Line Pattern
For mesh plots, contour line plots, and vector plots, you can pick a line pattern independently 
for each zone in the data set. The line pattern chosen for one layer is independent of the line 
patterns of the other plot layers. You can choose from any of Tecplot’s six line patterns:

• Solid.
• Dashed.
• Dash Dot.
• Dotted.
• Long Dash.
• Dash Dot Dot.

Choosing a line pattern is essentially the same for all zone layers; to be specific, the procedure 
for modifying mesh plots is given below. The procedure for changing the line pattern for other 
zone layers is similar.

To choose a mesh line pattern for a zone or zones:

1. From the Mesh page of the Zone Style dialog, select the zone or zones for which you want 
to specify a line pattern.

2. Click Line Pttrn. A drop-down appears containing six line pattern types.

3. Click on the desired line pattern option. If you choose any option besides Solid, you can 
also check the Pattern Length, and modify it as necessary. See Section 8.3.6, “Choosing a 
Pattern Length.” 

You can also choose the line pattern from the Quick Edit dialog for zones chosen interactively 
in the workspace. Figure 7-9 shows the line pattern region of the Quick Edit dialog, which con-
tains one option for each of Tecplot’s six line patterns. When you choose a line pattern from 
the Quick Edit dialog, the line pattern changes for all visible layers for the selected zones. 

To choose a line pattern for a zone or zones from the Quick Edit dialog:

1. In the workspace, use the Selector tool to select the zone or zones for which you want to 
assign a line pattern.

2. Call up the Quick Edit dialog from the sidebar.

3. Click on the option with the desired line pattern:

-  Chooses a solid line.

Figure 7-9. The line pattern region of the Quick Edit dialog.
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-  Chooses a dotted line.

-  Chooses a dashed line.

-  Chooses a long dashed line.

-  Chooses an alternating dash-and-dot line.

-  Chooses an alternating dash-and-two-dots line.

7.3.6. Pattern Length
The pattern length determines the cycle length for your line pattern, that is, how long the pat-
tern appears before repeating. In practice, this determines the length of dashed lines, and the 
spaces between dots and dashes. The pattern length has no effect on solid lines. You specify the 
pattern length as a percentage of the frame height.

Choosing a pattern length is essentially the same for all zone layers; to be specific, the proce-
dure for modifying mesh plots is given below. The procedure for changing the pattern length 
for other zone layers is similar.

To choose a mesh pattern length for a zone or zones:

1. From the Mesh page of the Zone Style dialog, select the zone or zones for which you want 
to specify a pattern length.

2. Click Pttrn Lngth. A drop-down appears containing five pre-set lengths and an Enter 
option.

3. Click on the desired option. If you select Enter, an Enter Value dialog appears.

4. (Enter option only) Enter a percentage of the frame height in the Enter Value dialog.

You can also choose the pattern length from the Quick Edit dialog for zones chosen interac-
tively in the workspace. When you choose a pattern length from the Quick Edit dialog, the 
pattern length changes for all visible zone layers for the selected zones.

To choose a pattern length for a zone or zones from the Quick Edit dialog:

1. In the workspace use the Selector tool to select the zone or zones for which you want to 
specify the pattern length.

2. Call up the Quick Edit by choosing Quick Edit... from the Edit menu.

3. Click Pttrn Length. A drop-down appears containing five pre-set lengths and an Enter 
option.

4. Click on the desired option. If you select Enter, an Enter Value dialog appears.

5. (Enter option only) Enter a percentage of the frame height in the Enter Value dialog.
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7.3.7. Line Thickness
For all field layers except Shade zone layer, you can specify a line thickness independently for 
each zone. The line thickness is independent for each zone layer. The thickness is specified as 
a percentage of the frame height (see Figure 7-10). Differing line thicknesses can be drawn on 
the screen, but are not supported on all printers. In particular, HP-GL print files do not support 
varying line thicknesses. The minimum screen line thickness is one pixel.

Choosing a line thickness is essentially the same for all zone layers; to be specific, the proce-
dure for modifying mesh plots is given below. The procedure for changing the line thickness 
for other zone layers is similar.

To choose a mesh line thickness for a zone or zones:

1. From the Mesh page of the Zone Style dialog, select the zone or zones for which you want 
to specify a line thickness.

2. Click Line Thck. A drop-down appears containing five pre-set widths and an Enter option.

3. Click on the desired option. If you select Enter, an Enter Value dialog appears.

4. (Enter option only) Enter a percentage of the frame height in the Enter Value dialog.

You can also choose the line thickness from the Quick Edit dialog for zones chosen interac-
tively in the Tecplot workspace. When you choose a line thickness from the Quick Edit dialog, 
the line thickness changes for all visible zone layers for the selected zones.

To choose a line thickness for a zone or zones from the Quick Edit dialog:

1. In the workspace, use the Selector tool to select the zone or zones for which you want to 
specify the line thickness.

2. Call up the Quick Edit dialog by choosing Quick Edit... from Tecplot’s Edit menu.

Figure 7-10. Varying line thicknesses in Tecplot.
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3. Click Line Thcknss. A drop-down appears containing five pre-set lengths and an Enter 
option.

4. Click on the desired option. If you select Enter, an Enter Value dialog appears.

5. (Enter option only) Enter a percentage of the frame height in the Enter Value dialog.

7.4. Data Point and Cell Labels
You can label all or some of the data points, or nodes, in your field plots with either the index 
value(s) of the data point or the value of some specified variable at each point. You can also 
label each cell, or element, of the data, with its index (which for finite-element data is its ele-
ment number).

For example, Figure 7-11 shows a finite-element data set with each node labeled with its node 
number.

To create data labels:

1. From the Plot menu, choose Label Points and Cells... The Label Points and Cells dialog 
appears, as shown in Figure 7-12.

2. To label the data points, or nodes, select the Show Node Labels check box. If you select this 
check box, choose one of the two option buttons Show Index Value or Show Variable Value. 
If you select the Show Variable Value option, choose a variable from the drop-down imme-
diately to the right of the option.

3. To label the cells, or elements, select the Show Cell Labels check box.

Figure 7-11. Finite-element data with data labels.
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4. To label all nodes or cells, confirm that the Index Skip text field contains the default value 
1. To label only some of the nodes or cells, enter a larger number in the text field. A value 
of 2 labels every other point, a value of 3 labels every third point, and so on.

5. Specify the format of the data labels using the following controls:

- Color Text by Zone: Color the text with the outline color of the scatter symbols for each 
zone. You may change this on the Scatter page of the Zone Style dialog.

- Color: Choose a color from Tecplot’s Select Color dialog.

- Font: Choose font options from Tecplot’s Select Font dialog.

- Number Format: If you are using a variable value as the data label, you can specify the 
format of the labels using the controls in Tecplot’s Specify Number Format dialog. 
The available formats are the same as for tick mark labels; see Section 17.5.2, “Tick 
Mark Labels,” for details.

- Include Text Box: Select this check box to include a filled box around each data label.

6. Redraw your plot to see the data labels.

7.5. Two-Dimensional Plotting Order
In 2-D plots, by default, each zone layer is drawn for all zones before the next layer is drawn. 
Sometimes, you will want to plot the data zone by zone instead of layer by layer. To do this, 
choose 2D Draw Order from the Plot menu and select the By Zone check box.

7.6. Three-Dimensional Plot Control
You can view any type of data as a 3-D plot. By default, only IJK-ordered data and finite-
element volume data are displayed in 3-D, but you can view other data in 3-D simply by select-

Figure 7-12. The Label Points and Cells dialog.
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ing 3D Cartesian in the plot type menu on the sidebar. Three-dimensional plots can be rotated 
in space, allowing you to look at your data from any angle. This rotation is probably the most 
common control you will exercise over your 3-D plots, but Tecplot gives you control over a 
number of other 3-D plotting attributes that determine precisely how your plot is displayed. 
This control is necessary because 3-D plots need to provide an illusion of depth in a two-
dimensional screen display. The available controls are as follows:

• 3D Rotation: Control the 3-D orientation of the plot. See Section 7.6.1, “Three-Dimen-
sional Rotation,” for details.

• 3D View Details: Set the specifications for a variety of parameters affecting the 3-D dis-
play of your plot, including the perspective, field of view, angular orientation of the plot, 
and view distance. See Section 7.6.2, “Three-Dimensional View Details,” for details.

• 3D Orientation Axis: Allows you to control the optional 3-D orientation axis, which 
shows the current orientation of the three axes. See Section 7.6.6, “Three-Dimensional Ori-
entation Axis,” for details.

• Reset 3D Axes: Allows you to reset the 3-D axis sizes and the 3-D origin of rotation. See 
Section 7.6.7, “Reset 3-D Axes,” for details.

• 3D Axis Limits: Allows you to control the data and axis aspect ratios for 3-D plotting. See 
Section 7.6.8, “Three-Dimensional Axis Limits,” for details.

• Light Source: Control the light source position, as well as the intensity of the light, the 
background light, and the surface color contrast. See Section 15.1.2, “Lighting Effects,”  
for more details.

• Advanced 3D Control: Specify the default lift fraction for 3-D lines, symbols, and tangent 
vectors, as well as the 3-D sorting algorithm for the plot. See Section 7.6.4, “Three-Dimen-
sional Sorting,”  for more details.

7.6.1. Three-Dimensional Rotation
Tecplot allows you to rotate your data in a variety of different ways. Choose one of the six 3-D 
rotation mouse modes, then drag the pointer in the workspace to rotate your 3-D image. The 
six rotation mouse modes can be entered by selecting the appropriate sidebar tools, as follows:

• Spherical : Drag the mouse horizontally to rotate about the Z-axis; drag the mouse ver-
tically to control the tilt of the Z-axis.

• Rollerball : Drag the mouse in the direction to move with respect to the current orien-
tation on the screen. In this mode, your mouse acts much like a rollerball.

• Twist : Drag the mouse clockwise around the image to rotate the image clockwise. 
Drag the mouse counterclockwise around the image to rotate the image counterclockwise.

• X-axis : Drag the mouse to rotate the image about the X-axis.

• Y-axis : Drag the mouse to rotate the image about the Y-axis.

• Z-axis : Drag the mouse to rotate the image about the Z-axis.
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Once you have chosen a rotation mouse mode, you can quickly switch to any of the others 
using the following keyboard shortcuts:

• s: Spherical.
• r: Rollerball.
• t: Twist.
• x: X-axis.
• y: Y-axis.
• z: Z-axis.

7.6.2. Three-Dimensional View Details

The angular orientation of the plot is defined by three spherical rotation angles:

• ψ (Psi): Tilt of eye origin ray away from Z-axis.
• θ (Theta): Rotation of the eye origin ray about the Z-axis.
• α (Alpha): Twist about the eye origin ray.

The eye origin ray is a line from the origin of the 3-D object to your eye. The eye origin ray is 
perpendicular to the plane of the computer screen. These angles define a unique view. These 
angles are shown in Figure 7-13.

When rotating an object, there is a center of rotation about which the rotation takes place. This 
is called the 3-D origin, and it should not be confused with the actual XYZ-origin of the data. 
The default 3-D origin is approximately the centroid of all the data in the active zones.

Besides being able to set the 3-D rotate origin via the 3D Rotate dialog, you may also set the 
origin by positioning the rotation cursor over your data, then pressing the letter O. The rotation 
origin will then be shifted to the point on the closest surface underneath the cursor.

Figure 7-13. The 3-D angles and 3-D projection.
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From the 3D Rotate dialog, you can also choose from four pre-set views or precisely specify 
the desired orientation of your 3-D plot by entering exact values for the three spherical angles 
Psi, Theta, and Alpha. You can also define the origin of the 3-D rotation.

7.6.2.1. Rotate About the Viewer Position. In addition to the rotation capabilities 
described above, you may use the Alt key and mouse to rotate about the viewer (instead of 
rotating the object). Although you may use this feature while in orthographic projection, it is 
best suited for when perspective projection is being used. The Alt key and your middle mouse 
button may be used to simulate fly-through type motion. You may move closer to the object 
using the Alt key and middle mouse button (or Ctrl-Alt-right mouse button), then turn your 
head using the Alt key and left mouse button.

7.6.2.2. The Rotate Dialog. You may also rotate your plots using the 3D Rotate dialog 
under the View menu, shown in Figure 7-14. At the top of this dialog, there are three options 
specifying three rotation modes—XYZ-Axis, Spherical, and Rollerball. Depending on the 
rotation mode chosen, the array of buttons to the right of the options will vary. To rotate the 
image, click these options. Each click rotates the image by the number of degrees specified in 
the Rotation Step Size text field.  

Figure 7-14. The Rotate dialog.
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7.6.3. Three-Dimensional Zooming and Translating

Just as in all other plots, you may zoom and translate your plot using the mouse. This may be 
done using either the Zoom or Translate tools. For most sidebar tools you may also use your 
middle and right mouse buttons (or Ctrl-right mouse button) to zoom and translate.

When the plot projection is orthographic, zooming with the middle mouse button magnifies the 
plot. When the plot projection is perspective, zooming with the middle mouse button changes 
the viewer angle, making the plot appear larger or smaller. If you want to change the viewer’s 
position by moving closer to or further away from an object hold the Alt key down while using 
the middle mouse button.

Working with very large data sets may result in slow zooming, rotating and translating. If this 
is the case you may use an approximate plot of the data instead of the full plot during these 
operations.

To change the transient drawing behavior:

1. In the sidebar, click the Performance button. This displays a dropdown that allows you to 
choose the level of approximation to plot during zooming, rotating and translating.

2. Click Draw Level for 3D View Changes, then select Trace from the drop-down.

If performance remains slow you may also want to turn off the caching of graphics in display 
lists. This option is also in the Display Performance dialog, which you may show by clicking 
Options... in the Performance dropdown.

If you are working with multiple frames you may increase performance by choosing to approx-
imate all non-current frames. The option is also on the Display Performance dialog.

See Section 30.2, “Interactive Customization,”  for further information on customizing the dis-
play.

7.6.4. Three-Dimensional Sorting

For some 3-D plots, Tecplot uses a painter’s algorithm. The data objects are divided into 
smaller objects. The smallest object is usually a cell, finite-element, vector, or scatter symbol. 
These objects are sorted based upon the distance from viewer. Tecplot draws the image starting 
with the objects farthest from the viewer and working forward.

In Tecplot, 3-D sorting occurs whenever you use translucency in a 3-D plot, or whenever you 
print or print preview a 3-D plot. A quick sorting algorithm is used by default. This does not 
detect problems such as intersecting objects. The 3-D sorting for each frame is controlled by 
the Perform Extra 3D Sorting check box on the Advanced 3D Control dialog, shown in 
Figure 7-15. If the Perform Extra 3D Sorting check box is selected, a slower, more accurate 
approach is used to detect problems for you. Call up the Advanced 3D Control dialog by 
selecting the Plot menu’s Advanced 3D Control option.

Note: All of the settings in the Advanced 3D Control dialog are specific to the current frame.
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There are instances when Tecplot cannot sort correctly. For example, consider elements A, B, 
and C, where element A overlaps part of element B which overlaps part of element C which 
overlaps part of element A. Since Tecplot draws only whole elements, one of these elements 
will be drawn last and (incorrectly) cover a portion of another element. If this occurs while 
printing or exporting, choosing an image format will often resolve the problem.

If you specify lift fractions for 3-D lines, tangent vectors, or scatter symbols, plotted objects of 
the appropriate type are lifted slightly towards you by this fraction so that they lie on top of 
surface elements. The lift fraction is the fraction of the distance from the 3-D origin of the 
object to your eye. You may specify lift fractions with the Advanced 3D Controls dialog.

7.6.5. Three-Dimensional Projection
The image you see on the screen is a 2-D representation of a 3-D image. Three-dimensional 
data is projected onto a 2-D plane, your screen. Tecplot offers two projection methods: ortho-
graphic and perspective. Orthographic projection is used as the default.

In the 3D View Details dialog, shown in Figure 7-16, you can choose either of the following 
two types of 3-D projection:

• Orthographic: The shape of the objects is independent of distance. This is sometimes an 
“unrealistic” view, but it is often used for displaying physical objects when preserving the 
true lengths is important (such as drafting).

• Perspective: The shape of the objects is dependent on the field of view angle. The larger 
the angle the larger the perspective effects. From the 3D View Details dialog you can con-
trol the field of view angle and the viewer position. As a convenience you can also change 
the viewer position by moving closer to or further from the object by changing the view 
distance.

Figure 7-15. The Advanced 3D Control dialog.
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7.6.6. Three-Dimensional Orientation Axis
Depending on the view, it may be difficult to determine the current orientation of your 3-D 
axes. The 3-D orientation axis is a (usually small) representation of your axes that shows you 
the orientation immediately. By default, all 3-D plots show the 3-D orientation axis in the 
upper right of the frame. Using the 3D Orientation Axis dialog under the Plot menu, you can 
control whether the 3-D orientation axis is shown in your plot, and if so, its color, size, line 
thickness, and the position of the axis origin. You can also position the 3-D orientation axis 
simply by clicking on it and dragging it to the desired location in the frame.

7.6.7. Reset 3-D Axes
By default, the 3-D axes are calculated so that they just surround the data. If you alter your data 
to expand or contract the overall data size, the axes do not automatically adjust to the new size. 
For example, if you multiply your X-variable by four, the data will extend four times the length 
of the X-axis.

You can use the Reset 3D Axes option under the Plot menu to reset the axes so that they once 
again just surround the data.

The Reset 3D Axes option also resets the 3-D origin, that is, the origin of 3-D rotation. If you 
have modified your 3-D origin using the 3D Rotate dialog (see Section 7.6.1, “Three-Dimen-
sional Rotation,” for details), the Reset 3D Axes option will reset it to approximately the cen-
troid of the data.

Figure 7-16. The 3D View Details dialog.
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7.6.8. Three-Dimensional Axis Limits

In a 3-D plot, whenever you read a data file or manipulate the values of variables assigned to 
axes or change variables assigned to the axes, Tecplot examines the data and determines how 
to plot it. The data may require scaling in one or more axis directions, a change of the axis 
dependency, an adjustment of the space between the data and the axis box, and/or an adjust-
ment of the shape of the axis box.

For example, suppose you read into Tecplot X-Y-Z data that defined a pencil: a long and thin 
shape. You may want Tecplot to plot this true to scale (that is, a scale factor of one for each 
axis) in the dependent axis mode, with a long, thin axis box adapted closely to the pencil. Or 
you may want the data plotted true to scale, but with an axis box nearly cubic in shape. Or 
perhaps you want the data scaled so the pencil actually appears short and stubby and fills a 
nearly cube-shaped axis box. Tecplot can plot all of these variations.

Because there are many valid forms in which the data could be plotted, Tecplot requires some 
user input to determine how to automatically configure the plot the way you want. There are 
several parameters used by Tecplot to determine when and how the axes are rescaled and 
resized which are described below. These parameters make up the 3-D axis limit options 
described below.

You control the allowable shape of your data and axes using the 3D Axis Limits dialog, shown 
in Figure 7-17. From this dialog accessed from the Plot menu, you can set an aspect ratio and 
reset limits for both your data and your axes.

The data aspect ratio is the ratio of the range of the variable assigned to one axis (multiplied by 
the axis size factor), divided by the range of the variable assigned to another axis (multiplied 
by that axis size factor).

For example, if the variable assigned to the X-axis ranged from -2 to 2 (range of four), the 
X-axis scale factor was one, the variable assigned to the Y-axis ranged from 100 to 500 (range 
of 400), and the Y-axis scale factor was 0.2, the data aspect ratio would be 20, which is 
[400*0.2]/[4*1].

Figure 7-17. The 3D Axis Limits dialog.
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The Data Aspect Ratio Limit is the ratio used when Tecplot is automatically resetting data. 
When the data aspect ratio of any two axes exceeds the Data Aspect Ratio Limit, Tecplot auto-
matically rescales the longer axis (that which has the larger value of range multiplied by scale 
factor) so that the new data aspect ratio is equal to the Data Aspect Ratio Reset value.

If your plots are usually unscaled, such as plots of real physical objects, you should set the data 
aspect ratio maximum to a large number like 30. This allows you to plot data that is thirty 
times longer than it is wide without Tecplot automatically resizing it. If your plots are usually 
scaled, then you should set the data aspect ratio to a small number like two.

The Data Aspect Ratio Reset value should be equal to or smaller than the data aspect ratio 
limit. For scaled plots, a reset value of one is reasonable, making the two scale axes equal in 
length when automatic rescaling takes place.

The Axes Aspect Ratio Limit works like the Data Aspect Ratio Limit, except that it deals with 
the shape and size of the axes box. For example, if you are viewing a long, slender, physical 
object, you may want a high data-aspect-ratio limit to keep from rescaling the physical object, 
but you might also want a low axis-aspect-ratio limit to keep the axes box in a reasonable 
shape.

The Axes Aspect Ratio Reset value works like Data Aspect Ratio Reset, except that it deals 
with the shape and size of the axes box. This is the ratio used when Tecplot is automatically 
resetting the axes box. When the data aspect ratio of any two axes exceeds the Data Aspect 
Ratio Limit, Tecplot also automatically rescales the longer axis of the axes box (which has the 
larger value of range multiplied by scale factor) so that the new axes box aspect ratio is equal 
to the Axes Aspect Ratio Reset value.

Sometimes maintaining the same size factor for each axis is not desirable, especially if the 3-D 
data do not represent a real physical object. For example, a carpet plot is a 3-D surface where 
the height (Z) is a single-valued function of width (X) and depth (Y). The data points are 
usually arranged in an IJ-ordered rectangular array (although this is not required by Tecplot). 
The variable assigned to the Z-axis could have a range of values that differs greatly from the 
ranges on the X- and Y-axes. If you plotted this data with equal size factors for each of the 
three axes, the plot could be long and thin (or very flat). Usually the desired axes for carpet 
plots are nearly equal in length, but with different size factors. You can have Tecplot automati-
cally rescale the axes for you by changing the Data Aspect Ratio Limit.
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CHAPTER 8 XY and Polar 
Line Plots

A line plot is a graph of one or more series of data points. The data points consist of a depen-
dent value and an independent value. Tecplot provides two different types of line plots: XY 
and Polar.

In the XY Line plot type, the independent and dependent values represent X and Y (in either 
order) and are plotted within Cartesian axes. You can create plots with lines, symbols, bars, 
and/or error bars. Using just bars, you can create bar charts.

In the Polar Line plot type, the independent and dependent values represent Theta and R (in 
either order) and are plotted within polar axes. You can create plots with lines and/or symbols.

Each series of data points in a line plot is referred to as a mapping. Tecplot dialogs often con-
dense this as maps. Each mapping associates two variables. In XY Line, one variable is associ-
ated with an X-axis and one variable with a Y-axis. In Polar Line, one variable is associated 
with the Theta-axis and one variable with the R-axis.

For example, you may create a line plot of speed versus angle. In XY Line, the angle might be 
on the horizontal axis (the X-axis), while the speed might be on the vertical axis (the Y-axis). 
In Polar Line, one choice is to have the angle on the angular axis (the Theta-axis) and the speed 
on the radial axis (the R-axis).

To create this plot, you need only one mapping to associate angle with one axis and with 
another axis. In this case, Tecplot creates the mapping for you. Line plots of this data in XY 
and Polar Line are shown in Figure 8-1.

To create a line plot such as in Figure 8-1, perform the following steps:

1. From the Data menu, select Create Zone.

2. From the Create Zone menu, select Enter Values. The Enter Values to Create a Zone dialog 
appears.

3. On the Enter Values text field enter the value pairs, one pair per line; separate the values 
with one or more spaces. The first value is treated as X in XY Line plot types, or as Theta in 
Polar Line plot types. The second value is treated as either Y or R as appropriate.
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4. If you would like to specify a data type for the data (integer, float, double, byte, bit), select 
the desired data type from the Destination Data Type drop-down. For a basic plot, do not 
change this.

5. After entering all of the values, click Create, then Close.

6. An XY Line plot of your data appears. If you desire a Polar Line plot, select Polar Line 
from the Plot Type drop-down on the sidebar.

7. For Polar Lines, the Theta values are treated as angles in degrees. If your angle values are 
not in degrees, change settings via the Axis Details dialog. See Section 17.3.3.2, “Theta 
Mode,”  for a discussion of how to change the units of the Theta-axis.

You can also create this plot using a data file. For example, consider the data file line-
data.dat (found in the examples/dat directory in your Tecplot home directory). This 
file lists the values of temperature measured at 20 locations unequally spaced along a wire. 
Each line of the file contains a single data point of location and temperature. Tecplot assigns an 
index (I) to identify each data point. Thus each data point can be identified uniquely by its I-
index. Data point number 1 is addressed as I=1, data point number 2 is addressed as I=2, and so 
on up to I=20. Data that can be addressed in this way is called I-ordered data.

To plot this data, read the data file into Tecplot. You are prompted for an initial plot type. 
Choose either XY Line (default) or switch to Polar Line using the Initial Plot Type drop-down.

For XY Line, Tecplot (by default) plots the first variable (V1) on the X-axis versus the second 
variable (V2) on the Y-axis. For Polar Line, the defaults are V1 on the Theta-axis and V2 on 
the R-axis. Use the Mapping Style dialog to reassign variables to the axes. If you assign a dif-
ferent variable to the X-axis in XY Line, that variable is used for the Theta-axis if you switch 
plot types to Polar Line, and vice versa. Y- and R-axis variables behave similarly.

Tecplot initially sets the view of the plot and the ranges on the axes such that you can see all of 
your data points, text, and geometries. For Polar Line, the initial view also shows the entire 

Figure 8-1. A plot of speed versus angle in Tecplot’s XY Line (left) and Polar Line 
(right) plot types.
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8.1. Line Plot Data

circle of the axes. If you change the variable or variables assigned to a mapping, the axis range 
or view may need to be reset.

For XY Line, the default axis mode is independent; the scales on the X- and Y-axes are unre-
lated. This, and many other axis settings, can be changed using the Axis Details dialog.

When you create a line plot, Tecplot assigns colors, symbol types, and line patterns to each 
mapping. These and other line plot attributes can be changed using the pages of the Mapping 
Style dialog. To bring up the Mapping Style dialog, go to the Plot menu and select Mapping 
Style, or click the Mapping Style button on the sidebar.

The initial behavior of line plots can be changed in the Tecplot configuration file to create dif-
ferent default settings. See Section 30.1, “Configuration Files,”  for details on how to change 
settings in the Tecplot configuration file.

8.1. Line Plot Data
Line plots are usually created from one-dimensional data in the I-ordered structure. Tecplot 
also allows you to create line plots from two- or three-dimensional data in the IJ- or IJK-
ordered structure, or finite-element data. Finite-element data sets are treated as I-ordered; the 
connectivity list is ignored. IJ-ordered data sets are a family of J-sets of I-ordered data; I-
ordered data can be thought of as IJ-ordered data with J=1. IJK-ordered data sets are K-planes 
of J-families of lines; I-ordered data can be thought of as IJK-ordered data with J=K=1.

Use the Indices page of the Mapping Style dialog to select different ranges and skip intervals 
for the I-, J-, and K-indices. See Section 8.9, “I-, J- and K-Indices,” later in this chapter for 
more information.

The data used for line plots must have at least two variables defined at each data point. The 
same number of variables must be defined at each data point. You may have up to 32,700 vari-
ables defined at each data point. For example, you could be recording the pressure at a set of 
500 pressure probes every minute for two hours (120 time samples). The data could be orga-
nized into an array of numbers with 120 rows and 501 columns. The first column is the time, 
and columns 2 through 501 are the pressure measurements. Each row represents a data point. 
Each data point has 501 variables. In Tecplot, you can plot all or some of the pressure probes 
versus time on one plot. Since you can select any variable for any axis, you could create an XY 
Line plot with the pressure at probe 5 on the X-axis plotted against the pressure at probe 59 on 
the Y-axis. Or you could create a Polar Line plot with the Theta-axis as time and the R-axis as 
the pressure from various probes.

8.2. Map Creation
Line plots in Tecplot are composed of the graphs of one or more pairs of variables (XY pairs in 
XY Line plots or Theta-R pairs in Polar Line plots). These pairs and their dependency relations 
are defined in Tecplot as mappings. Mappings are defined for each frame; the same data set 
can have a different set of mappings in each frame it is attached to.

Mappings can be displayed as a combination of one or more of two basic plot styles:
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• Lines: Can be drawn as linear segments that connect the data points in order, or as a curve 
that represents a fit of some mathematical function to the data.

• Symbols: Each data point is represented by a symbol (for example, a circle or a square).

For XY Line plots, there are two additional plots styles:

• Bars: Each data point is represented by a vertical or horizontal bar, according to whether 
the dependent variable of the XY-pair is the X- or the Y-variable.

• Error Bars: From each data point, a line is drawn a specific distance either vertically, hor-
izontally, or both. The distance is determined by a third variable.

For XY Line, each mapping can be assigned to one of five X-axes and to one of five Y-axes. 
For Polar Line, there is only one Theta-axis and only one R-axis, and these axes are used by all 
mappings.

Mappings are defined using the Plot menu’s Mapping Style dialog (active when the sidebar 
plot type drop-down is set to XY Line or Polar Line).

To define a new mapping:

1. From the Plot menu, select Mapping Style. The Mapping Style dialog appears. You may 
also open this dialog by clicking Mapping Style on the sidebar, or double clicking any map-
ping in the plot. Figure 8-2 shows the Mapping Style dialog for each line plot type when the 
demo file rainfall.plt is loaded.

2. Click Create Map. The Create Mappings dialog appears. The Create Mappings dialog for 
each line plot type is shown in Figure 8-3.

3. Choose what sort of mapping (or mappings) to add. In XY Line plots, you have the follow-
ing options:

Figure 8-2. The Definitions page of the Mapping Style dialog for XY Line plots (top) 
and for Polar Line plots (bottom).
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X-Axis Var versus Y-Axis Var for One Zone (Default): Click to add a single mapping 
with one X- and one Y-variable for one zone. If you select this option, continue with Step 4.

X-Axis Var versus Y-Axis Var for All Zones: Click to add one mapping for each zone. 
You choose one X- and one Y-variable; Tecplot creates a mapping with those variables for 
each zone. If you select this option, continue with Step 5.

X-Axis Var versus All Other Variables: Click to create a new set of mappings using one 
variable as the X-variable and each of the other variables as Y-variables. When you choose 
this option, you must also specify the zone for which this set of mappings is defined. If you 
select this option, continue with Step 5 and then skip Step 6.

Y-Axis Var versus All Other Variables: Click to create a new set of mappings using one 
variable as the Y-variable and each of the other variables as X-variables. When you choose 
this option, you must also specify the zone for which this set of mappings is defined. If you 
select this option, continue with Step 6.

In Polar Line plots, you have the following options:

Theta-Axis Var versus R-Axis Var for One Zone (Default): Click to add a single map-
ping with one Theta- and one R-variable for one zone. If you select this option, continue 
with Step 4.

Theta-Axis Var versus R-Axis Var for All Zones: Click to add one mapping for each 
zone. You choose one Theta- and one R-variable; Tecplot creates a mapping with those 
variables for each zone. If you select this option, continue with Step 5.

Theta-Axis Var versus All Other Variables: Click to create a new set of mappings using 
one variable as the Theta-variable and each of the other variables as R-variables. When you 
choose this option, you must also specify the zone for which this set of mappings is 
defined. If you select this option, continue with Step 5 and then skip Step 6.

Figure 8-3. The Create Mappings dialog for XY Line plots (left) and for Polar Line 
plots (right).
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R-Axis Var versus All Other Variables: Click to create a new set of mappings using one 
variable as the R-variable and each of the other variables as Theta-variables. When you 
choose this option, you must also specify the zone for which this set of mappings is 
defined. If you select this option, continue with Step 6.

(Optional): Enter a name for the mapping in the Mapping Name text field. The default 
name is “Map n,” where n is the number of the mapping to be created.

4. For XY Line plots, choose an X-axis variable using the X-Axis Var drop-down. For Polar 
Line plots, choose a Theta-axis variable using the Theta-Axis Var drop-down. In either 
case, the default is the first variable (V1).

5. For XY Line plots, choose a Y-axis variable using the Y-Axis Var drop-down. For Polar 
Line plots, choose an R-axis variable using the R-Axis Var drop-down. In either case, the 
default is the second variable (V2).

6. Choose a zone using the Zone drop-down. The default is the first zone.

When you first read an ordered data set, Tecplot defines some mappings for you. If your data 
set has more than two variables, Tecplot creates mappings that associate the first variable with 
each of the other variables for the first zone only. If your data set has only two variables, 
Tecplot creates mappings which associate the first variable with second variable for each zone. 
In XY Line plots, each of these mappings assigns the first variable to the first X-axis (X1) and 
the other variable to the first Y-axis (Y1). In Polar Line plots, each of these mapping assigns 
the first variable to the Theta-axis and the other to the R-axis. In either case, Tecplot activates 
the first mapping; the other mappings are left inactivated.

8.3. Mapping Definitions
Existing mappings are edited with the Plot menu’s Mapping Style dialog. Choose Mapping 
Style from the Plot menu, the sidebar, or double-click on a line plot.

From the Definitions page of the Mapping Style dialog, you can perform the following tasks: 
modify names; activate and deactivate mappings; assign axis variables; assign zones; sort data 
points in a mapping; control the mappings appearance in the line plot legend; and for XY Line 
plots, assign particular X- and Y-axes.

In general, select mappings you want to change, and then select the appropriate button above 
the list of mappings. Some buttons call up drop-downs; others call up dialogs. You may change 
mapping whether they are shown on the plot or not (activated or deactivated).

8.3.1. Map Name Modification
Tecplot assigns each mapping a name. The nature of the name varies with the type of data used 
to create the mapping. If your data has only one dependent variable, the default is to use the 
zone name for the mapping. If your data has multiple dependent variables, then the default is to 
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use the dependent variable name for the mapping. You can modify any mapping’s name using 
the Enter Mapping Name dialog. This dialog is accessible from the Mapping Style dialog by 
selecting Edit Name from the Map Name drop-down.

To modify a mapping name:

1. On the Definitions page of the Mapping Style dialog, select the appropriate mappings.

2. Click Map Name, then select Edit Name. The Enter Mapping Name dialog appears, as 
shown in Figure 8-4.

3. Enter a new name for the selected mappings, or construct a new name from text you enter 
and/or one or more of the pre-defined options:

Zone Name: Adds the string “&ZN&” to the Map Name field, which is then replaced with 
the actual name of the zone assigned to that mapping.

X-Axis Num: Adds the string “&X#&” to the Map Name field, which is then replaced with 
the actual number of the X-axis assigned to that mapping for XY Line plots. For Polar Line 
plots, this option is not available.

Y-Axis Num: Adds the string “&Y#&” to the Map Name field, which is then replaced with 
the actual number of the Y-axis assigned to that mapping for XY Line plots. For Polar Line 
plots, this option is not available.

Independent Var: Adds the string “&IV&” to the Map Name field, which is then replaced 
with the actual name of the independent variable assigned to that mapping.

Dependent Var: Adds the string “&DV&” to the Map Name field, which is then replaced 
with the actual name of the dependent variable assigned to that mapping.

To add an insert, click on its button or type the associated string into the Map Name field.

4. When the Map Name field is as desired, click OK.

Figure 8-4. The Enter Mapping Name dialog.
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8.3.2. Mapping Activation
Each mapping may be shown on the plot (called activated) or not shown on the plot (called 
deactivated).

To activate or deactivate mappings:

1. On the Definitions page of the Mapping Style dialog, select the appropriate mappings.

2. Click Map Show, then select one of these options:

Activate: Turns selected mappings on.

Deactivate: Turns selected mappings off.

Show Selected Only: Turns on selected mappings, and turns off all other mappings.

Invert: Simultaneously turns on the selected mappings that are off, and turns off those 
selected mappings that are on.

Active mappings have the word Yes in the column under Map Show; inactive mappings have 
the word No.

8.3.3. Axis Variable Selection
The choice of variables is the heart of the mapping. Each mapping is defined by two variables: 
X and Y in XY Line plots; Theta and R in Polar Line plots. You may change the variables 
assigned to a mapping using the Mapping Style dialog. For XY Line plots, click X-Axis Vari-
able or Y-Axis Variable. For Polar Line plots, click Theta-Axis Variable or R-Axis Variable.

To change a variable for a mapping or a group of mappings:

1. On the Definitions page of the Mapping Style dialog, select the appropriate mappings.

2. Click the appropriate Variable option. The Select Variable dialog appears. Choose a vari-
able from the drop-down.

8.3.4. Zone Selection
Each mapping uses variable values from a specified zone. If your data set has multiple zones, 
you may want to change this specification.

To change the zone for a mapping or a group of mappings:

1. In the Mapping Style dialog, select the appropriate mappings.

2. Click Zone. The Select Mapping Zone dialog appears. Choose the desired zone from the 
drop-down.

8.3.5. Data Point Sorting
Certain line types and curve types use the points in a mapping in a specific order. Other curve-
fits do not use this option. (See Section 8.6, “Curve-Fits and Splines,” for details on curve and 
line types.)
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By default mappings are sorting by the order they occur in the data file. You can change this 
order with the Sort option on the Mapping Style dialog.

To change the sorting behavior for mappings:

1. In the Mapping Style dialog, select the appropriate mappings.

2. Click Sort. The drop-down offers four options:

None: Default behavior of sorting by the order in the data file.

By Independent Variable: Points are sorted in ascending order of the values of the inde-
pendent variable.

By Dependent Variable: Points are sorted in ascending order of the values of the depen-
dent variable.

By Specify Variable: The Select Variable dialog appears. Select a variable. The points of 
the selected mappings are sorted in ascending of the values of this variable.

Regardless of the sorting options, most curve-fit types result in the same curve, and splines are 
always sorted by the independent variable. Of the standard curve types, only Line Segment and 
ParaSpline show a noticeable difference for changing this setting. See Section 8.6, “Curve-Fits 
and Splines,” for more information on curve types.

8.3.6. Line Plot Legend Control
By default, all active mappings appear in the line legend, but the legend only lists mappings 
with identical entries once. (See Section 8.10, “Line Legend,”  for details on the Line Plot Leg-
end.)

To change the line plot legend behavior of mappings:

1. In the Mapping Style dialog, select the appropriate mappings.

2. Click Show in Legend. The drop-down presents three options:

Always: The mapping appears in the legend even if the mapping is turned off (deactivated) 
or its entry in the table looks exactly like another mapping’s entry.

Never: The mapping never appears in the legend.

Auto: The mapping appears in the legend only when the mapping is turned on. If two map-
ping would make the same entry in the legend, only one entry is shown.

8.3.7. XY Line Plot Axis Assignment
XY Line plots support five X-axes (X1-X5) and five Y-axes (Y1-Y5). Newly created mapping 
use the X1- and Y1-axes. You can change these assignments, using the Which X-Axis and 
Which Y-Axis fields on the Mapping Style dialog.

To change the axis assignments for mappings:

1. From the Mapping Style dialog, select the appropriate mappings.

2. Click Which X-Axis or Which Y-Axis, and select the desired axis from the drop-down.
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For more information on working with multiple X- and Y-axes, see Section 8.5.4, “Multiple X- 
and Y-Axes for XY Line Plots.” 

8.4. Mapping Style
Style is broadly defined as the total look of the plot. The style of a line plot includes each map-
ping’s color, curve type (such as line segment, spline), line pattern, symbol type, symbol size 
and many other attributes. One graph is drawn for each active mapping.

For example, an XY Line plot could have many mappings all of which use the same zone and 
have variable V1 as the X-variable V1 and variable V2 as the Y-variable, but the style of the 
mapping could be entirely different. On mapping might display symbols and a linear curve-fit 
while another shows a cubic spline. They could be sorted differently, as shown in Section 
8.3.5, “Data Point Sorting,” use different X- or Y-axes, as shown in Section 8.5.4, “Multiple X- 
and Y-Axes for XY Line Plots,” or draw from different indices in the data, as shown in Section 
8.9, “I-, J- and K-Indices.” ).

Each graph is composed of one or more map layers. The main map layers in line plots are 
Lines and Symbols. XY Line plots also contain Bars (bar charts) and Error Bars as map layers. 
By default, only the Lines map layer is turned on, so no symbols are plotted.

Style attributes in line plots are assigned on a per-mapping basis. Each created mapping is 
given an initial color to distinguish it from others. All mappings are assigned line segments and 
square symbols by default.

Use the Mapping Style dialog to set attributes for lines, symbols, and in XY Line plots, bar 
charts and error bars. You can also make many of these changes using the Quick Edit dialog 
(accessible from the Edit menu or the sidebar). You can set the style of any mapping indepen-
dently of all other mappings, and regardless of whether that mapping is activated or deacti-
vated.

8.4.1. Map Layer Display
Changing map layers is the quickest and most visually striking means of changing line plot 
style. Switching from a line plot to a symbol plot dramatically alters the style. You can also 
combine layers to create striking visuals—for example in XY Line plots, a curve-fit together 
with a bar chart can clearly outline the trend in the data. The same data is plotted as a polar plot 
with symbols and a curve-fit on right side of Figure 8-5.

To activate or deactivate a map layer, click on the map layer’s check box on the sidebar. The 
map layer areas of the sidebar for both XY and Polar Lines plots with both the Lines and 
Symbols map layers active is shown in Figure 8-6.
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8.4.2. Line Attributes
The Lines page of the Mapping Style dialog, with information from the demo file chem.plt 
is shown in Figure 8-7. The Mapping Style dialog for XY Line plots is the same for Polar Line 

plots except for the Error Bars and Bars pages.

Figure 8-5. Using multiple layers: An XY Line plot showing a bar chart combined with 
a curve-fit (left), and a Polar Line plot showing symbols and a curve-fit.

Figure 8-6. The map layers area of the sidebar for XY Line plots (left) and for Polar 
Line plots (right).

Figure 8-7. The Lines page of the Mapping Style dialog.
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The first two columns, Map Num and Map Name, list the mapping number and name. The 
Map Show field shows which mappings are currently active. A mapping must be active for it 
to be displayed, although an active mapping is not always visible. The remaining columns of 
the Lines page of the Mapping Style dialog contain specific line attributes, as follows: Line 
Show; Line Color; Line Pattern; Pattern Length; Line Thickness.

The Quick Edit dialog for XY Line and Polar Line plots is shown in Figure 8-8. It allows you 

to control all of the line attributes. The Quick Edit dialog can be accessed via the Edit menu or 
the sidebar.

8.4.2.1. Line Visibility. You can specify whether lines are shown for individual mappings. 
This option allows you to turn off selected mapping lines, keeping both the selected mappings 
and the Lines map layer active. You might want to do this, for example, if you want to plot two 
mappings, one as a line and the other as symbols. In this case, you would set Line Show to No 
for the symbol plot, and Symb Show to No for the line plot. See Section 8.4.3.1, “Symbol Vis-
ibility,”  for details on using Symb Show.

To turn on or off the line portion of a mapping or group of mappings:

1. From the Lines page of the Mapping Style dialog, select the appropriate mappings.

2. Click Line Show. Select Yes from the drop-down to show the line for the selected map-
pings; select No to turn off the line.

Figure 8-8. The Quick Edit dialog for XY Line plots (left) and for Polar Line plots 
(right).
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Alternatively, you may:

1. Click on the appropriate mapping in the plot. Either the lines or the symbols of the mapping 
work fine.

2. On the Quick Edit dialog, next to the Lines map layer icon, click Y to show the line for the 
selected mappings, N to turn off the line.

8.4.2.2. Line Color. You can set line color for line plots using the Line Color button on the 
Lines page of the Mapping Style dialog, or via the Quick Edit dialog. Note that there is a dif-
ference between the two methods. The Quick Edit dialog changes the line color for all selected 
objects (for example, if there are symbols as well as lines drawn, the symbol color would 
change with the line color). If you use Line Color, only the lines change (unless you have set 
style linking; see Chapter 18, “Frame Linking,” for more information).

To change the line color from the Mapping Style dialog:

1. Select the mapping or mappings for which you want to assign a new color.

2. On Lines page of the Mapping Style dialog, click Line Color; the Select Color dialog 
appears.

3. Click the desired color; the dialog closes automatically.

To change the line color using the Quick Edit dialog:

1. Click on the appropriate mapping in the plot.

2. On the Quick Edit dialog, select the Line option immediately above the Color area. The 
Color area of the Quick Edit dialog is shown in Figure 8-9.

3. Click Color on the Quick Edit dialog. The Select Color dialog appears. Click on the desired 
color.

8.4.2.3. Line Pattern. Set line patterns for line plots using the Line Pttrn drop-down on the 
Mapping Style dialog, or the Line Pattern area of the Quick Edit dialog, shown in Figure 8-10.

The choices are Solid, Dashed, DashDot, Dotted, LongDash, and DashDotDot. The line 
pattern setting affects the line or curve drawn for a plot, but not the symbols. Also, in XY Line 
plots, line pattern also has no effect on bar charts or error bars. Symbols, bar charts, and error 
bars are always drawn using solid lines.

Figure 8-9. The Color area of the Quick Edit dialog.
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8.4.2.4. Pattern Length. Set the pattern length for patterned lines using either the Pttrn 
Lngth drop-down on the Lines page of the Mapping Style dialog, or the Pttrn Length drop-
down menu on the Quick Edit dialog. Pattern length is measured as a percentage of the frame 
height for one complete cycle of the pattern.

8.4.2.5. Line Thickness. Set the thickness of lines using the Line Thck drop-down on the 
Lines page of the Mapping Style dialog, or the Line Thcknss drop-down on the Quick Edit dia-
log. You can choose from pre-set widths, or enter an arbitrary width. Line thickness is mea-
sured as a percentage of the frame height. If you use the Quick Edit dialog, the new line thick-
ness affects all displayed attributes of the selected mappings, so it also affects symbol, error 
bar, and bar chart line thickness. Using the Mapping Style dialog, the values can be set inde-
pendently.

8.4.3. Symbol Attributes
The Symbols page of the Mapping Style dialog, with information from the demo file rain-
fall.plt, is shown in Figure 8-11. The dialog is the same for XY Line plots except for two 

additional pages: Error Bars and Bars.

The first two columns list the mapping number and name. The Map Show field lists currently 
active mappings. A mapping must be active for it to be displayed, although an active mapping 
need not be displayed. The remaining columns of the Symbol page of the Mapping Style 

Figure 8-10. Line Pattern, Pttrn Length and Line Thickness on the Quick Edit dialog.

Figure 8-11. The Symbols page of the Mapping Style dialog.
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dialog contain specific attributes: Symb Show; Symb Shape; Outline Color; Fill Mode; Fill 
Color; Symb Size; Line Thck; Symb Spacing. Each of these attributes can also be modified 
using the Quick Edit dialog, shown in Figure 8-8.

8.4.3.1. Symbol Visibility. You can specify whether symbols are shown for individual map-
pings. This option allows you to turn off selected mapping symbols, while keeping both the 
selected mappings and the Symbols map layer active. You might want to do this, for example, 
if you want to plot two mappings, one as a line and the other as symbols. In this case, you 
would set Symb Show to No for the line plot, and Line Show to No for the symbol plot. See 
Section 8.4.2.1, “Line Visibility,” for details on using Line Show.

To turn on or off the symbol portion of a mapping or group of mappings:

1. From the Symbols page of the Mapping Style dialog, select the appropriate mappings.

2. Click Symb Show. Select Yes from the drop-down to show symbols for the selected map-
pings; select No to turn symbols off.

Alternatively, you may:

1. Click on the appropriate mapping in the plot. Either the lines or the symbols of the mapping 
work fine.

2. On the Quick Edit dialog, next to the Symbols map layer icon, click Y to show the symbols 
for the selected mappings, N to turn off the symbols.

8.4.3.2. Symbol Shape. Use the Symb Shape drop-down on the Symbols page of the Map-
ping Style dialog or use the Symbol area of the Quick Edit dialog, to select the symbol type for 
each mapping. The Symbol area of the Quick Edit dialog is shown in Figure 8-12.

There are seven pre-defined symbols: Square; Delta (equilateral triangle pointing up); Gradient 
(equilateral triangle pointing down); Right Triangle (equilateral triangle pointing to the right); 
Left Triangle (equilateral triangle pointing to the left); Diamond; Circle. (The symbol types 
Point, Cube, Sphere, and Octahedron are not available for line plots, and thus grayed out in 
Figure 8-12.)

In addition to the predefined symbols, you can choose as a symbol any ASCII character in the 
following Tecplot fonts: Helvetica-Bold, Math, Greek, User-Defined.

To change the symbol shape using the Symb Shape drop-down on the Symbols page of the 
Mapping Style dialog:

1. Select the appropriate mappings.

2. Click Symb Shape. Select the desired symbol shape from the drop-down.

Figure 8-12. The Symbol area of the Quick Edit dialog.
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3. If you select Other, the Enter ASCII Character dialog appears, as shown in Figure 8-13. 

Enter the ASCII character to use as a symbol, and select a font from which to display the 
symbol. When you are done, click OK.

To change the symbol shape using the Quick Edit dialog:

1. Click on the appropriate mapping in the plot. Either the lines or the symbols of the mapping 
work fine.

2. In the Symbol area of the Quick Edit dialog, click on the desired symbol.

3. If you select , the Enter ASCII Character dialog appears, as shown in Figure 8-13. Enter 
the ASCII character to use as a symbol, and select a font from which to display the symbol. 
When you are done, click OK.

8.4.3.3. Symbol Outline Color. Symbols can be filled or unfilled; by default they are 
unfilled. The symbol’s outline color is the color of the unfilled symbol. You can choose an out-
line color using the Outline Color button on the Symbols page of the Mapping Style dialog, or 
using the Color area of the Quick Edit dialog. There is a difference between the two methods. 
The Quick Edit dialog changes the line color for all selected objects. For example, if there are 
lines as well as symbols drawn, the line color changes as well as the symbol color. If you use 
the Outline Color field to change the symbol color, only the symbols change (unless you have 
set style linking; see Chapter 18, “Frame Linking,” for more information).

To change the symbol outline color using the Mapping Style dialog:

1. Select the appropriate mappings.

2. On the Symbols page of the Mapping Style dialog, click Outline Color.

3. The Select Color dialog appears. Click the desired color; the dialog closes automatically.

To change the symbol outline color using the Quick Edit dialog:

1. Click on the appropriate mapping in the plot.

2. On the Quick Edit dialog, select the Line option immediately above the Color area. 
Figure 8-9 shows the Color area of the Quick Edit dialog.

Figure 8-13. The Enter ASCII Character dialog.
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3. Click Color on the Quick Edit dialog. The Select Color dialog appears. Click on the desired 
color; the dialog closes automatically.

8.4.3.4. Filled Versus Outline Symbols. Symbols may be either filled or unfilled. Filled 
symbols are outlined using the specified outline color, and then filled with a fill color. You can 
specify filled symbols either by selecting an option from the Fill Mode button on the Symbols 
page of the Mapping Style dialog, or by specifying a fill color in the color area of the Quick 
Edit dialog. The methods are slightly different, however: the Fill attribute on the Symbols page 
affects only plotting symbols, while the fill color on Quick Edit affects all selected objects. 
Thus, you could end up filling any selected geometries, as well as filling mapping symbols 
when you use the Quick Edit approach. Also, there are more options when you use the Map-
ping Style dialog approach.

To change the symbol filling using the Fill Mode drop-down on the Symbols page of the 
Mapping Style dialog:

1. Select the appropriate mappings.

2. Click the Fill Mode button. The drop-down presents four options:

None: The symbols are not filled. The symbol are just outlines.

Use Line Color: The symbols are filled with the same color specified in Outline Color and 
appear as a a solid color.

Use Back Color: The symbols are filled with background color of the grid area, and appear 
hollow, blotting out objects behind the symbol (such as grid lines or other mappings).

Use Specific Color: The symbols are filled with the color specified in Fill Color, and can 
appear in two different colors.

To choose filled symbols using the Quick Edit dialog, or to turn off fill if you already have 
filled symbols:

1. Click on the appropriate mapping in the plot.

2. Click  for filled symbols (equivalent to Use Specific Color in the Mapping Style dialog), 

or  for symbols that are not filled. The Quick Edit dialog does not have options equiva-
lent to Use Line Color and Use Back Color.

If you have filled symbols, and you select the Line option in the Color area of the Quick Edit 
dialog, choosing X makes the symbol outline color the same as the symbol fill color. If you 
select the Fill option in the Color area of the Quick Edit dialog, choosing X gives the symbol 
have a Fill Mode of None.

8.4.3.5. Symbol Fill Color. If the symbol is filled with a specific color, see Section 8.4.3.4, 
“Filled Versus Outline Symbols,” for more information, you set the fill color with either the 
Symbols page of the Mapping Style dialog or with the Quick Edit dialog.
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To change the symbol fill color using the Mapping Style dialog:

1. Select the appropriate mappings.

2. On the Symbols page of the Mapping Style dialog, make sure the mappings have Fill Mode 
set to Use Specific Color. If not, see Section 8.4.3.5, “Symbol Fill Color.” 

3. Click Fill Color. The Select Color dialog appears. Click the desired color; the dialog closes 
automatically.

To change the symbol fill color using the Quick Edit dialog:

1. Click on the appropriate mapping in the plot.

2. On the Quick Edit dialog, select the Fill option immediately above the Color area. 
Figure 8-9 shows the Color area of the Quick Edit dialog.

3. Click Color on the Quick Edit dialog. The Select Color dialog appears. Click the desired 
color; the dialog closes automatically.

If you have unfilled symbols, selecting a fill color on the Quick Edit dialog makes the symbols 
use the Fill Mode of Use Specific Color.

8.4.3.6. Symbol Size. Select the symbol size for your line plotting symbols using either the 
Symb Size drop-down on the Symbols page of the Mapping Style dialog, or the Size drop-
down next to the Symbol area on the Quick Edit dialog. Symbol size is measured as percentage 
of the frame height.

8.4.3.7. Symbol Line Thickness. To specify the thickness of lines used to draw the plot-
ting symbols, use either the Line Thck drop-down on the Symbols page of the Mapping Style 
dialog, or the Line Thcknss drop-down on the Quick Edit dialog. The Line Thck drop-down on 
the Symbols page affects only line plotting symbols, while the Line Thcknss drop-down on the 
Quick Edit dialog affects all selected objects (including lines for the same mapping if they are 
turned on). Line thickness is measured as a percentage of the frame height.

8.4.3.8. Symbol Spacing. If you are plotting many points, you might not want every point 
to show a symbol. To specify the spacing between symbols, use the Symb Spacing drop-down 
on the Symbols page of the Mapping Style dialog. The spacing is specified either as a percent-
age of the frame height or as a number of indices to skip.

You may either enter a value or use one of the following pre-set values:

• Draw All: All symbols are drawn at every data point.
• ISkip=2: Symbols are drawn every other data point.
• ISkip=3: Symbols are drawn every third data point.
• ISkip=4: Symbols are drawn every fourth data point.
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• Distance=1%: Symbols are drawn at the first data point and subsequently at data points 
that are at least one percent of the frame height distant from the previously plotted data 
point.

• Distance=2%: Symbols are drawn at the first data point and subsequently at data points 
that are at least two percent of the frame height distant from the previously plotted data 
point.

• Distance=3%: Symbols are drawn at the first data point and subsequently at data points 
that are at least three percent of the frame height distant from the previously plotted data 
point.

To specify the symbol spacing:

1. On the Symbols page of the Mapping Style dialog, select the appropriate mappings.

2. Click Symb Spacing, and then select the desired option.

3. If you selected Enter Index or Enter Distance, an Enter Value dialog appears. For Enter 
Index, Enter the index skip between symbols. For Enter Distance, enter the distance 
between symbols as a percentage of the frame height.

8.5. Line Plot Axis
Line plots support many varied axis options, including two features unique to line plots: log 
scale and multiple axes. See Chapter 17, “Axes,” for a complete description of all axis options.

8.5.1. XY Line Axis Range Control
Controlling the axis range is a very common action in XY Line plots. You may want to modify 
the range, for example, to include additional text or geometries in your axis area; or you may 
want to have the axes begin and end at round numbers. You control the range of your X- and Y-
axes using the Range page of the Axis Details dialog, shown in Figure 8-14.

To call up this page, select Axis from the Plot menu to bring up the Axis Details dialog, and 
then click on the Range button.

Figure 8-14. The Range page of the Axis Details dialog.
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For XY Line plot types, the default range for both X and Y is the range of the X- and Y-vari-
ables for the initial active mappings. You can alter the range of any active axis. For more 
details on modifying the axis range, see Section 17.3, “Axis Range Modification.” 

If you simply want the values on the axes to being and end at round numbers, you can choose 
Make Current Values Nice from the View menu.

8.5.2. Polar Line Axis Control
For Polar Line plots, Tecplot by default treats Theta values as angles in degrees. If your angle 
values are not in degrees, you may change the settings. From the Plot menu, select Axis. This 
will bring up the Axis Details dialog. Half-way down the Range page, there is a Reset button, 
which allows you to reset the polar axis to radians or arbitrary angle units.

You may also change the range on Theta to create a quarter circle; or change the range on R to 
create a “hole” in the center of your polar axis grid area. For more information on polar axis 
options, see Section 17.7.2, “Polar Axes Positioning.” 

8.5.3. Log Axes
The X- and Y-axes of XY Lines plot types and the R-axis of Polar Line plot types can have a 
linear scale (default) or a logarithmic scale. The logarithmic scale is only available only for 
line plots (and not for Theta-axes).

When Auto Spacing is selected with logarithmic scale, large numbers are displayed in scien-

tific notation (that is, 3.48x105). It is strongly recommended that you use Auto Spacing with 
log axes.

To specify a log axis:

1. From the Plot menu, choose Axis. The Axis Details dialog appears.

2. On the Range page of the dialog, select the check box labeled Use Log Scale for each axis 
you wish to have a log scale.

3. On the Ticks or Labels page of the dialog, confirm that the check box labeled Auto Spacing 
is selected (Auto Spacing is turned on by default).

Two line plots using logarithmic scales are shown in Figure 8-15.

8.5.4. Multiple X- and Y-Axes for XY Line Plots

You may want to display mappings which have greatly differing scales on a single plot. For 
example, you might want to plot a function and its derivative together, or see a plot of both alti-
tude and engine temperature versus elapsed time. To plot this type of data, XY Line plot types 
provide for multiple X- and Y-axes. You can assign each mapping to a separate Y-axis and use 
the natural scale of the variables assigned to that mapping.
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For example, consider the data in the example Tecplot demo data file rainfall.plt; it 
includes monthly rainfall observations for three U.S. cities, along with two error measure-
ments. The rainfall observations and the error measurements have very different scales.

To plot the Seattle rainfall observations and the second error measurement, do the following:

1. Read in the data file rainfall.plt from the demo/xy sub-directory of your Tecplot 
home directory.

2. Select XY Line Plot on the Select Initial Plot dialog. Tecplot creates a default line plot of 
the Seattle rainfall observations (V2) on the Y-axis versus the Month (V1) on the X-axis.

3. Bring up the Mapping Style dialog, select the Definitions page.

4. Select the mapping Error 2, click Map Show, and choose Activate.

5. Click Which Y-Axis, then choose Y2. The resulting plot shown in Figure 8-16.

By default, Tecplot places axis X1 at the bottom of your axis grid area, and subsequent X axes 
at the top. Similarly, it places axis Y1 at the left of your axis grid area and subsequent Y-axes at 

Figure 8-15. Logarithmic scale in an XY Line plot (left) and a Polar Line plot (right).

Figure 8-16. An XY Line plot using two Y-axes.
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the right. Thus, in Figure 8-16, the Seattle rainfall observations are shown along axis Y1 at the 
left of the axis grid area, while the error observations are shown along Y2 at the right.

You can also use multiple axes to cycle through mappings with different ranges or axis set-
tings. You may find it convenient to assign different mappings to different axes so that you can 
set axis ranges, axis positions, or other axis attributes independently for each mapping. Then as 
you activate and deactivate your mappings, each appears with the settings you have previously 
set.

8.6. Curve-Fits and Splines
By specifying a curve type, you control whether Tecplot simply connects the data points or 
performs a more sophisticated analysis to determine the drawn curve. Curve-fitting is an 
important data analysis tool because it lets you discover hidden trends in seemingly random 
scatters of data. Curve-fits can also help you determine if experimental results match theoreti-
cal predictions.

8.6.1. Curve Types
Tecplot offers a variety of curve-fits and spline fits. You set the type of curve plotted for a map-
ping using the Curve Type drop-down on the Curves page of the Mapping Style dialog, or by 
using the Line on the Quick Edit dialog.

Tecplot offers the following curve types (the names are as shown under the Curve Type drop-
down; the buttons as shown in the Quick Edit dialog):

• Line Segments : A series of linear segments connect adjacent data points. In XY Line 
plots, these will be line segments. See Section 8.12, “Polar Drawing Options,” for a discus-
sion of Line Segments in Polar lLine plots.

• Linear Fit: A linear function is fit to the data points. In XY Line plots, this will be a 
straight line. (Linear fit is not available on Quick Edit dialog.)

• Polynomial Fit : A polynomial of order N is fit to the data points (where 1 <= N <= 10, 
for N=1 a Linear Fit is done).

• Exponential Fit : An exponential curve fit that finds the best curve of the form Y=eb*X+c 

(equivalent to Y=a*eb*X, where a = ec). To use this curve type, Y-values for this variable 
must be all positive or all negative. If the function dependency is set to X=f(Y) all X-values 
must be all positive or all negative. Dependent values are discussed in Section 8.6.10, 
“Dependent and Independent Variables.” 

• Power Fit : A power curve fit that finds the best curve of the form Y=eb * ln X + c (equiva-

lent to Y=a*Xb, where a = ec). To use this curve type, Y-values for this variable must be all 
positive or all negative; X-values must be all positive. If the function dependency is set to 
X=f(Y), X-values must be all positive or all negative, and the Y-values must all be positive.



167

8.6. Curve-Fits and Splines

• Spline : A smooth curve is generated that goes through every point. The spline is drawn 
through the data points after sorting the points into increasing values of the independent 
variable, resulting in a single-valued function of the independent variable. The spline may 
be clamped or free. With a clamped spline, you supply the derivative of the function at each 
end point; with a non-clamped (natural or free) spline, these derivatives are determined for 
you. In XY Line plots, specifying the derivative give you control over the initial and final 
slopes of the curve.

• ParaSpline : Creates a smooth curve as with a spline, except the assumption is that both 
variables are functions of the index of the data points. (For example in XY Line plot, ParaS-
pline fits x=f(i) and y=g(i) where f() and g() are both smooth.) No sorting of the points is 
performed; the order of the data points from the data file is used. This spline may result in a 
multi-valued function (of either or both axis variables).

• Extended : Uses a curve-fit supplied by an add-on. These curve-fits may be provided by 
Amtec, a third party, or written by users. The functionality of each extended curve-fit is 
defined by its creator. If you wish to write an extended curve fit add-on, see the Add-On 
Developer’s Kit User’s Manual for more information.

Linear Fit, Polynomial Fit, Exponential Fit, and Power Fit are all determined by using a least 
squares algorithm. Examples of each of Tecplot’s curve-fit types are shown in Figure 8-17.

Figure 8-17. Tecplot’s curve-fit types.
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The Curves page contains fields for controlling the following attributes:

• Dependent Variable: The Dependent Variable drop-down controls how Tecplot interprets 
curve fits and splines. Dependent Variable has no effect on mappings of the Line Segment 
curve type. For the XY Line plot type, the choices are y=f(x) or x=f(y). For Polar Line plot 
types, the choices are R=f(Theta) and Theta=f(R).

• Curve Points: Controls the number of points used to draw curve fits and splines. Raising 
the number of points increases the accuracy of curve but also increases plotting time and 
the size of print files.

• Curve Settings: Control options specific to the curve type. For example, weighting for 
curve fits, or starting derivatives for splines.

The coefficients used to draw curve fits and splines may be output to a file, as can the actual 
points used to draw curve fits and splines.

8.6.2. Linear Fits
Tecplot can fit a linear function to data using the standard least-squares algorithm. It calculates 
the function for which the sum of the squared differences from the data points is a minimum. 
For the XY Line plot type, the linear function is a straight line.

To fit a linear function to your data:

1. From the Curves page of the Mapping Style dialog, select the mappings for which you want 
to fit a linear function.

2. Click Curve Type, and select Linear Fit from the drop-down.

3. By default, linear fits use all the points in the mapping, weighting them equally. Use the 
Curve Fit Settings dialog to specify different settings. The dialog is shown in Figure 8-18.

4. Select the appropriate mappings in the Mapping Style dialog and click Curve Settings. The 
Curve Fit Settings dialog appears as shown in Figure 8-19.

5. To limit the points used in the mapping, select Use Only Points Within Range, and enter 
minimum and maximum values.

Figure 8-18. The Curves page of the Mapping Style dialog.



169

8.6. Curve-Fits and Splines

6. To assign a curve-weighting variable, select Use Weighting Variable, and select the variable 
from the drop-down. For more information on curve weighting, see Section 8.6.11, “Curve-
Fit Weighting Variables.” 

7. Polynomial Order is shown on the dialog, but should always be one for a linear fit. If you 
change this away from one, Tecplot changes the curve type to Polynomial Fit. See Section 
8.6.3, “Polynomial Curve-Fits,”  for more information.

To choose the dependent and independent variables for this fit, see Section 8.6.10, “Dependent 
and Independent Variables.” 

8.6.3. Polynomial Curve-Fits
Tecplot can fit a polynomial function to data using the standard least-squares algorithm. You 
specify the order of the polynomial (from one to ten), and Tecplot calculates the polynomial 
for which the sum of the squared differences from the data points is a minimum.

To fit a polynomial to your data:

1. From the Curves page of the Mapping Style dialog, select the mappings for which you want 
to fit a polynomial function.

2. Click Curve Type, and select Polynomial Fit from the drop-down.

3. You can also switch to a polynomial by selecting a mapping in the plot and clicking  on 
the Quick Edit dialog.

By default, this option fits a cubic polynomial, using all the points in the mapping and weight-
ing them equally. Use the Curve Fit Settings dialog, shown in Figure 8-19, to specify different 
settings:

1. Select the appropriate mappings in the Mapping Style dialog and click Curve Settings. The 
Curve Fit Settings dialog appears.

Figure 8-19. The Curve Fit Settings dialog.
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2. To change the polynomial order, use the Polynomial Order drop-down. Select the desired 
polynomial order (one to ten). An order of two is a quadratic polynomial, an order of three 
is a cubic polynomial, etc. If you select one, the curve type is set to Linear Fit as a polyno-
mial of order one is a linear function. (See Section 8.6.2, “Linear Fits.” )

3. To limit the points used in the mapping, select Use Only Points Within Range, and enter 
minimum and maximum values.

4. To assign a curve-weighting variable, select Use Weighting Variable, and select the variable 
from the drop-down. For more information on curve weighting, see Section 8.6.11, “Curve-
Fit Weighting Variables.” 

To choose the dependent and independent variables for this fit, see Section 8.6.10, “Dependent 
and Independent Variables.” 

8.6.4. Exponential Curve-Fits
Tecplot can fit an exponential function to data using the standard least-squares algorithm. The 
dependent-variable values must be either all positive or all negative. Tecplot finds the best 

curve (in the least-squares sense) of the form Y=eb*X+c  (equivalent to Y=a*eb*X where a=ec). 

If Theta is the independent variable, the equation is  or  , and simi-
larly for other independent variables.

To fit an exponential curve to your data:

1. From the Curves page of the Mapping Style dialog, select the mappings for which you want 
to fit an exponential function.

2. Click Curve Type, and select Exponential Fit from the drop-down.

You can also switch to an exponential fit by selecting a mapping in the plot and clicking  on 
the Quick Edit dialog.

By default, this option uses all the data points in the mapping, weighting them equally. Use the 
Exponential Fit Settings dialog to specify different settings. The dialog is shown in 
Figure 8-20.

To specify different settings:

1. Select the appropriate mappings in the Mapping Style dialog and click Curve Settings. The 
Exponential Fit Settings dialog appears.

2. To limit the points used in the mapping, select Use Only Points Within Range, and enter 
minimum and maximum values.

3. To assign a curve-weighting variable, select Use Weighting Variable, and select the variable 
from the drop-down. For more information on curve weighting, see Section 8.6.11, “Curve-
Fit Weighting Variables.” 

R e bθ c+( )±= R aebθ±=
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To choose the dependent and independent variables for this fit, see Section <<8.6.10>>, 
“Dependent and Independent Variables.”

8.6.5. Power Curve-Fits
Tecplot can fit a power function to data using the standard least-squares algorithm. The depen-
dent-variable values must be either all positive or all negative, and the independent values 
should be all positive (although Tecplot will ignore data points with zero or negative indepen-

dent values). Tecplot finds the best curve (in the least-squares sense) of the form Y=eb*lnX+c 

(equivalent to Y=a*Xb where a=ec). If Theta is the independent variable, the equation is 

 or , and similarly for other independent variables.

To fit a power curve to your data:

1. From the Curves page of the Mapping Style dialog, select the mappings for which you want 
to fit a power function.

2. Click Curve Type, and select Power Fit from the drop-down.

You can also switch to a power fit by selecting a mapping in the plot and clicking  on the 
Quick Edit dialog.

1. From the Curves page of the Mapping Style dialog, select the mappings for which you want 
to fit a power function.

2. By default, this option uses all the data points in the mapping, weighting them equally. Use 
the Power Fit Settings dialog to specify different settings. The dialog is shown in 
Figure 8-21.

3. To limit the points used in the mapping, select Use Only Points Within Range, and enter 
minimum and maximum values.

4. To assign a curve weighting variable, select Use Weighting Variable, and select the variable 
from the drop-down. For more information on curve weighting, see Section 8.6.11, “Curve-
Fit Weighting Variables.” 

Figure 8-20. The Exponential Fit Settings dialog.

R eb ln Θ( ) c+±= R aΘb±=
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To choose the dependent and independent variables for this fit, see Section 8.6.10, “Dependent 
and Independent Variables.” 

8.6.6. Splines
A spline is a mathematical function defined to link a specified set of points in such a way that 
the resulting function is continuous and smooth (differentiable) at every point. The most com-
mon type of spline, the cubic spline, is defined using a set of cubic polynomials, one for each 
interval between the data points.

Splines can be natural or clamped; natural splines are twice-differentiable at the end points and 
the second derivative is zero at those points, while clamped splines need not be twice-differen-
tiable, but have known first-derivatives at the boundary points.

Before plotting the spline, Tecplot sorts the data points in increasing value along the indepen-
dent axis. The Sort option of the Definitions page of the Mapping Style dialog has no effect on 
splines (see Section 8.3.5, “Data Point Sorting,”  for a discussion of sorting).

To fit a spline to your data:

1. Use the Curves page of the Mapping Style dialog to select the mappings for which you 
want to fit a spline.

2. Click Curve Type, and select Spline from the drop-down.

You can also switch to a spline by selecting a mapping in the plot and clicking  on the Quick 
Edit dialog.

By default, this option fits a natural cubic spline. To specify a clamped spline:

1. Select the appropriate mappings in the Mapping Style dialog and click the Curve Settings 
button. The Spline Settings dialog appears as shown in Figure 8-22.

2. Select Clamp the Spline, and enter values for the derivative at the start and end of the 
spline.

Figure 8-21. The Power Fit Settings dialog.
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8.6.7. Parametric Splines
Tecplot’s cubic spline fit assumes that the spline function is a single-valued function of the 
independent variable. Sometimes, however, you have data that curves back upon itself, but you 
would still like to have a spline-like curve fit to it. Parametric splines solve this problem by 
presuming that both variables (X&Y or Theta&R) are functions of the data-point index. The 
spline is then defined by two single-valued functions of the data-point index.

Unlike cubic splines, parametric splines are plotted in the order set in the Sort option of the 
Definitions page of the Mapping Style dialog. By default, the points are unsorted, and thus the 
spline is drawn in order the data points appear in the data file. See Section 8.3.5, “Data Point 
Sorting,”  for a discussion of sorting.

To fit a parametric spline to your data:

1. Use the Curves page of the Mapping Style dialog to select the mappings for which you 
want to fit a parametric spline.

2. Click Curve Type, and select ParaSpline from the drop-down.

You can also switch to a parametric spline by selecting a mapping in the plot and clicking  
on the Quick Edit dialog.

By default, this option fits two natural cubic splines to the data point index. To specify a 
clamped spline:

1. Select the appropriate mappings in the Mapping Style dialog and click Curve Settings. The 
Parametric Spline Settings dialog appears as shown in Figure 8-23.

Figure 8-22. The Spline Settings dialog.

Figure 8-23. The Parametric Spline Settings dialog.
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2. Select Clamp the Spline, and enter values for the derivative at the start and end of the 
spline.

For the XY Line plot type, the derivatives are either dy/dx or dx/dy depending on the Function 
Dependency for the mapping. Tecplot calculates dx/ds and dy/d from these values (where s is 
the parametric variable). For the Polar Line plot type, the derivatives are either dR/dTheta or 
dTheta/dR (depending on the Function Dependency for the mapping), and Tecplot calculates 
dx/ds and dy/ds from these values (where s is the parametric variable). See Section 8.6.10, 
“Dependent and Independent Variables,” for a full description of the Function Dependency 
option.

8.6.8. Extended Curve-Fit
Tecplot add-ons can provide new curve-fit types. These curve types are called extended curve-
fits. These curve-fits may be provided by Amtec, a third party, or written by users. The func-
tionality of each extended curve-fit is defined by its creator. (If you wish to write an extended 
curve-fit add-on, see the Add-On Developer’s Kit User’s Manual for more information.)

To fit an extended curve to your data:

1. 1. Use the Curves page of the Mapping Style dialog to select the mappings for which you 
want to apply an extended curve-fit.

2. 2. Click Curve Type, and select Extended from the drop-down.

3. 3. The Choose Extended Curve Fit dialog appears with a list of optional curve fits, as 
shown in Figure 8-24. Select the desired curve fit.

You may also switch to an extended curve-fit by selecting a mapping in the plot, then clicking 

 on the Quick Edit dialog. This calls up the Choose Extended Curve Fit dialog, from which 
you may select the desired curve-fit.

Some curve-fits allow optional parameters. These can be accessed by selecting the Curve Set-
tings option on the Curves page of the Mapping Style dialog. When the curve-fit includes 
optional settings, a dialog for that curve-fit appears. For example, the options available for the 
Stineman Interpolation curve-fit are shown in Figure 8-25.

Figure 8-24. The Choose Extended Curve-Fit dialog.
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8.6.9. Line Segments (No Curve-Fit)
By default, Tecplot draws a series of linear segments between each set of points. For the XY 
Line plot type, these will be line segments. See 8.12, “Polar Drawing Options,”  for a discus-
sion of Line Segments in Polar Line plots. This is not really a curve-fit, but it is a good fall 
back if other fits are not appropriate.

To turn off curve fits for your data and just use linear segments between points:

1. From the Curves page of the Mapping Style dialog, select the mappings which you want to 
show as linear segments.

2. Click Curve Type. Select Line Segments from the drop-down.

You can also switch to line segments by selecting a mapping in the plot and clicking  on the 
Quick Edit dialog.

Line Segments are plotted in the order set in the Sort option of the Definitions page of the 
Mapping Style dialog. By default, the points are unsorted, and thus the lines segments are 
drawn in order the data points appear in the data file. See Section 8.3.5, “Data Point Sorting,”  
for a discussion of sorting.

8.6.10. Dependent and Independent Variables
Every mapping has a dependent variable and an independent variable. The dependency rela-
tionship determines the shape of your plot for most curve types. This dependency has no effect 
on line segment curve types, and for parametric splines, the dependency is only used to deter-
mine starting derivatives for clamped parametric splines. Extended curve-fits are free to use or 
not use this dependency depending on the type of curve-fit supplied.

You specify the dependency relationship between your axis variables using the Dependent 
Variable drop-down on the Curves page of the Mapping Style dialog.

For the XY Line plot type, the default setting is y=f(x), and you may change the value to 
x=f(y). With y=f(x), the X-axis variable is treated as the independent variable and the Y-axis 
variable as the dependent variable. With x=f(y), the Y-axis variable is treated as the indepen-

Figure 8-25. Stineman Interpolation curve-fit options.
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dent variable and the X-axis variable as the dependent variable. Two polynomial curve-fits of 
the same data using different dependency settings are shown in Figure 8-26. 

Similarly for Polar Line plots, the default setting is R=f(Theta), and you may change the value 
to Theta=f(R). With R=f(Theta), the Theta-axis variable is treated as the independent variable 
and the R-axis variable as the dependent variable. With Theta=f(R), the R-axis variable is 
treated as the independent variable and the Theta-axis variable as the dependent variable.

To change the dependency setting:

1. From the Curves page of the Mapping Style dialog, select the mappings to change.

2. Dependent Variable and choose the appropriate option.

For the XY Line plot type, the dependency setting determines the direction of bar charts. To 
create a vertical bar chart set the dependency to y=f(x); to create a horizontal bar chart set the 
dependency to x=f(y). See Section 8.8, “XY Line Bar Charts,”  for information on bar charts.

8.6.11. Curve-Fit Weighting Variables
Linear, polynomial, exponential, and power fits allow you to specify a weighting variable. By 
default each data point is weighted equally. With the weighting variable, individual points can 
be given more or less weight. Relatively larger numbers in the curve weighting variable mean 
more significance for a given point. If the curve-weighting variable is zero at a data point, that 
data point has no effect upon the resulting curve. If the curve weighting variable is two at a 
data point and one at all the other points, that data point will have twice the effect upon the 
resulting curve. If the curve weighting variable is much larger at one point than the others, the 
weighting of that point pulls the resulting curve close to that point. The weighting coefficients 
must be integers in the range of zero to 9,999. Tecplot truncates weighting coefficients defined 
as floating-point numbers (that is, a weighting coefficient of 1.99 is truncated to 1.0).

For example, consider the distance-temperature data in the example data file simpxy.dat 
(found in the examples/dat directory in your Tecplot home directory). There is a small 

Figure 8-26. An XY Line plot type dependencies.
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cluster of points centered about Distance=0.1 and Temperature=550. If we add the following 
weighting variable to the original data file sympxy.dat, we can omit this cluster from our 
analysis:

1 1 0 0 0 0 0 0 1 1 1 1 1 1 1 1 1 1 1 1

The data file sympxy2.dat (also found in the examples/dat directory in your Tecplot 
home directory) contains this additional variable as variable 6, Weight4. (There are other 
potential weightings in variables 3, 4 and 5.)

To assign the curve weighting variables, see the instructions for Linear Fit, Polynomial Curve-
Fit, Exponential Curve-Fit or Power Curve-Fit.

The left side of Figure 8-27 shows an XY Line plot with weighted linear fit with the cluster of 
points omitted. For comparison, the original data points and the un-weighted least-squares fit 
are also plotted. The right side shows the same data in a Polar Line plot.

To create this plot, following these steps:

1. Read in the data set simpxy2.dat from the examples/dat directory of your Tecplot 
home directory.

2. Call up the Mapping Style dialog. On the Definitions page, create two copies of the dis-
tance-temperature mapping, and activate the new mappings.

3. Name the first mapping “Temperature,” the second mapping “Weighted Temperature” and 
the third mapping “Data Points.”

4. Turn on both the Lines and Symbols map layers.

5. On the Lines Page, turn off Line Show for the “Data Points” mapping.

6. Set the line pattern for the Weighted Temperature to be dashed.

7. On the Curves Page, set the Line Type for Temperature and Weighted Temperature to Lin-
ear Fit.

8. For the Weighted Temperature mapping, click Curve Settings on the Curves Page. Turn on 
Use Weight Variable, and select a Weighting Variable of Weight4. Click OK.

Figure 8-27. Weighted linear fits.
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9. On the Symbols page, turn off Symb Show for the same two mappings.

10. Add the line plot legend. See Section 8.10, “Line Legend.” .

8.6.12. Curve-Fit Coefficients
You can view information about curve-fits and splines using the Data menu’s Curve Informa-
tion dialog and write that information to a file.

To view information about curve-fits and splines in your plot:

1. From the Data menu, select Curve Info. The Curve Information dialog appears, as shown in 
Figure 8-28. 

2. Select a mapping from the Mapping drop-down.

3. The curve-fit coefficients for the selected mapping are shown in the Curve Details section 
of the Curve Details dialog.

4. To create an ASCII file with the curve-fit coefficients, click Write Curve Details to File.

The information presented in the Curve Details section and in the coefficient file is dependent 
on the curve type selected. For example, the dialog shown in Figure 8-28, shows the informa-
tion for a linear fit. For extended curve-fits, the documentation for the extended curve-fit add-
on supplies any necessary information on the format used.

8.6.13. Curve Data Point Extraction
Using the Curve Information dialog, you can save the calculated data points along the curve 
for further analysis in later sessions. 

To create an ASCII data file of the points of the curve fits:

1. From the Data menu, select Curve Info. The Curve Information dialog appears.

2. Select a mapping from the Mapping drop-down.

3. Click Write Data Points to File.

Figure 8-28. The Curve Information dialog.
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The data file contains one zone for each line in the mapping. For mappings made from I-
ordered zones, there is one zone. See Section 8.9, “I-, J- and K-Indices,”  for details on map-
pings using IJ- and IJK-ordered data.

Each zone in the data file is I-ordered with the number of points equal to the active curve 
points setting (set via the Curve Points option on the Curves page of the Mapping Style dia-
log). The data file has two variables: one for the independent variable and one for the depen-
dent variable. This is a valid Tecplot ASCII data file that can be read into another frame.

8.7. XY Line Error Bars
In the XY Line plot type, you can assign one or more variables to be used to compute error 
bars for another variable using the Error Bars page of the Mapping Style dialog, shown in 
Figure 8-29.

Error bars are not available for the Polar Lines plot type. Each mapping has an associated error 
bar variable; if you want to assign multiple error bar variables to a mapping, you can create one 
copy of the mapping for each error bar variable.

You can use any variable in your data set as an error bar variable. However, for them to be 
meaningful, they should have the same units as the axis along which they are drawn. Some-
times, error variables are part of your original data file. At other times, you may create error 
variables using Tecplot’s data manipulation utilities. For example, if you know that the values 
of some measured variable are accurate only to within ten percent, you may create a new vari-
able to use as the error bar variable by multiplying the measured variable by 0.10.

To add error bars to a plot:

1. Select the Error Bars check box on the sidebar. The Select Variable dialog appears; select 
the desired error bar variable. This variable is assigned as the error bar variable for each 
mapping.

2. No error bars appear on your plot, because they are off by default for each mapping. To turn 
on error bars for a mapping, select the appropriate mapping on the Error Bars page of the 
Mapping Style dialog, and choose EBar show.

Figure 8-29. The Error Bars page of the Mapping style dialog.
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3. To change the error bar variable for a mapping, select the appropriate mapping on the Error 
Bars page of the Mapping Style dialog, and choose EBar Var. The Select Variable dialog 
appears; select the desired error bar variable.

8.7.1. Error Bar Type
There are seven types of error bars:

• Top: Extends upward for positive values (and downward for negative values) of the error 
bar variable.

• Bottom: Extends downward for positive values (and upward for negative values) of the 
error bar variable.

• Left: Extends to the left for positive values (and to the right for negative values) of the 
error bar variable.

• Right: Extends to the right for positive values (and to the left for negative values) of the 
error bar variable.

• Horizontal: Extends left and right.
• Vertical: Extends up and down. (This is the default value.)
• Cross: Extends up, down, left, right.

To select an error bar type:

1. From the Error Bars page, select the appropriate mappings.

2. Click EBar Type, and select the desired error bar type.

Although the values are called Left, Right, Up and Down, the direction is determined by the 
direction of positive values in your plot. If you reverse the direction of an axis (using the 
Reverse Axis Direction option on the Range page of the Axis Details dialog), the error bars 
point in the opposite direction. For example, if you reverse the X-axis, left error bars will point 
to the right for positive values and to the left for negative values of the error bar variable.

You can use several variables as error bars. Each assignment, however, requires a separate 
mapping. For example, you could assign one variable for the left error bar, copy the mapping, 
and then assign another for the right error bar. You can even assign different variables with the 
same error bar type. For example, you could assign two variables to be vertical error bars 
resulting in two vertical error bars at the data point. An example plot with error bars is shown 
in Figure 8-30.

Variable V5 (called “Error 1”) is assigned as a vertical error bar for one mapping. Variable V6 
(called “Error 2”) is assigned as a left error bar for a copy of the same mapping. These vertical 
and left error bars are plotted on the curve for variable V2 (called “Seattle Rainfall”). The data 
is in the demo data file rainfall.plt. The Error Bars page for this plot is shown in 
Figure 8-29.
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8.7.2. Error Bar Attributes
You can modify most of the attributes with which error bars are drawn—their color, their thick-
ness, their spacing, and the width of the endpoint crossbars. You can make these changes from 
the Error Bars page of the Mapping Style dialog, or for some settings you can use the Quick 
Edit dialog.

8.7.2.1. Error Bar Color. The line color of the error bars is separate from the color of the 
lines or symbols of the mapping. You can change the error bar line color using either the Map-
ping Style dialog or the Quick Edit dialog.

To change the line color using the Mapping Style dialog:

1. On the Error Bars page of the Mapping Style dialog, select the mappings to assign a new 
error bar color.

2. Click EBar Color. The Select Color dialog appears; click the desired color.

To change the Error Bar color using the Quick Edit dialog:

1. Click on the appropriate mapping in the plot.

2. If the Line option in the color edit area is not already selected, select it.

3. Click Color. The Select Color dialog appears. Select the desired color.

If you change the line color of the error bars using the Quick Edit dialog, all other lines shown 
for that mapping will also change. So if the line layer is shown, the lines will be affected as will 
the outline of symbols (if shown). For individual control, use the Mapping Style dialog.

8.7.2.2. Crossbar Size. While the length of the error bar is determined by the error bar vari-
able, the size of the crossbar is set on the Error Bars page of the Mapping Style dialog. Cross-
bar size is measured as a percentage of frame height.

To specify the crossbar size for error bars:

Figure 8-30. An XY Line plot with symbols and error bars.
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1. On the Error Bars page of the Mapping Style dialog, select the mappings to change the 
crossbar size.

2. Click EBar Size. Select the desired size from the drop-down.

3. If you selected Enter, the Enter Value dialog appears. Enter the desired value.

8.7.2.3. Error Bar Line Thickness. The line thickness of the error bars is separate from 
the thickness of the lines or symbols of the mapping. You can change the error bar line thick-
ness using either the Mapping Style dialog or the Quick Edit dialog. The error bar line thick-
ness is measured as a percentage of frame height.

To change the line thickness using the Mapping Style dialog:

1. On the Error Bars page of the Mapping Style dialog, select the mappings to assign a new 
error bar line thickness.

2. Click Line Thck. Select the desired line thickness from the drop-down.

3. If you selected Enter, an Enter Value dialog appears. Enter the desired value.

To change the Error Bar thickness using the Quick Edit dialog:

1. Click on the appropriate mapping in the plot.

2. Click Line Thcknss on the Quick Edit dialog.

3. Select the desired line thickness from the drop-down.

4. If you selected Enter, an Enter Value dialog appears. Enter the desired value.

If you change the line thickness of the error bars using the Quick Edit dialog, all other lines 
shown for that mapping also change. So if the Lines layer is shown, the lines are affected as is 
the outline of symbols (if shown). For individual control, use the Mapping Style dialog.

8.7.2.4. Error Bar Spacing. If you are plotting many points, you might not want every 
point to show an error bar. You can control the spacing between error bars using the EBar 
Spacing drop-down on the Error Bars page of the Mapping Style dialog. The spacing is speci-
fied either as a percentage of the frame height or as a number of indices to skip. You may either 
enter a value or use one of the following pre-set values:

• Draw All: Error bars are drawn at every data point.
• ISkip=2: Error bars are drawn every other data point.
• ISkip=3: Error bars are drawn every third data point.
• ISkip=4: Error bars are drawn every fourth data point.
• Distance=1%: Error bars are drawn at the first data point and subsequently at data points 

that are at least one percent of the frame height distant from the previously plotted data 
point.
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• Distance=2%: Error bars are drawn at the first data point and subsequently at data points 
that are at least two percent of the frame height distant from the previously plotted data 
point.

• Distance=3%: Error bars are drawn at the first data point and subsequently at data points 
that are at least three percent of the frame height distant from the previously plotted data 
point.

To specify the error bar spacing:

1. On the Error Bars page of the Mapping Style dialog, select the appropriate mappings.

2. Click EBar Spacing, and then select the desired option.

3. If you selected Enter Index or Enter Distance, an Enter Value dialog appears. For Enter 
Index, Enter the index skip between error bars. For Enter Distance, enter the distance 
between error bars as a percentage of the frame height.

8.8. XY Line Bar Charts
A bar chart is an XY Line plot that uses vertical or horizontal bars placed along an axis to rep-
resent data points. (There is no equivalent to bar charts in Polar Line plots.) You create bar 
charts by activating the Bars map layer on the sidebar. You can use the Bars map layer alone to 
create a pure bar chart, or add symbols, lines, or error bars to create useful visual effects. An 
example plot with bar charts is shown in Figure 8-5.

To create a pure bar chart:

1. Read in a data file.

2. Select the initial plot type to be XY Line.

3. Select the Bars map layer check box. Deselect the check boxes for all other plot layers.

The style of the bar chart is controlled on the Bars page of the Mapping Style dialog, shown in 
Figure 8-31.

Figure 8-31. The Bars page of the Mapping Style dialog.
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8.8.1. Bar Chart Direction
By default, bars are vertical. Change between vertical or horizontal bars:

1. On the Bars page of the Mapping Style dialog, select the mappings to change the bar direc-
tion.

2. Click Bars Dir, then choose Horizontal or Vertical.

Changing the direction of the bars changes the dependent variable attribute used for line curves 
(either y=f(x) or x=f(y)), and vice versa. By default, all mappings use y=f(x) and appear as ver-
tical bar charts. If a mapping uses horizontal bars, the mapping will also use x=f(y) for curve 
fits. Of course, this only matters if you plot bars and curve-fits for the same mapping. For more 
information about dependency, see Section 8.6.10, “Dependent and Independent Variables.” 

To modify other attributes (Bars Show, Outline Color, Fill Mode, Fill Color, Bar Size, Line 
Thck), use the Bars page, following the same procedures used to set symbol attributes. See 
Section 8.4.3, “Symbol Attributes,” for details. There is no skipping option for the Bars layer.

8.9. I-, J- and K-Indices
Whether you are making a Polar or XY Line plot, if your data is IJ- or IJK-ordered, a mapping 
consists of a family of lines; each line varies along one index while the other indices are held 
constant. By default, Tecplot displays the I-varying family of lines. For example, read in the 
demo data file cylinder.plt and choose the XY Line plot type as the initial plot type. You see 
the family of I-varying lines for Zone 1 of the data, as shown in Figure 8-32.

Each mapping can show either I-, J-, or K-varying families of lines. By default, Tecplot dis-
plays the I-varying family of lines. You can change the family of lines using the Indices page 
of the Mapping Style dialog as shown in Figure 8-33. The Mapping Style dialog for Polar Line 
plot type is shown; the dialog is the same for the XY Line plot type except for two additional 
pages: Bar Chart and Error Bars.

Figure 8-32. A family of I-varying lines for the cylinder data.
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8.9. I-, J- and K-Indices

You can also choose which members of the family are drawn (and using which data points), by 
specifying index ranges for each of I, J, and K. The index range for the varying index tells 
Tecplot which points to include in each line, and the index ranges for the other indices tell 
Tecplot which lines in the family to include. Thus, you may use this option for selecting a 
subset of an I-ordered zone to plot.

8.9.1. Varying Index
To choose the varying index, and thus specify the family of lines to be drawn:

1. On the Indices page of the Mapping Style dialog, select the mapping for which you want to 
change the varying index. This mapping should be using an IJ- or IJK-ordered zone.

2. Click on Varying Index, and choose the desired family (I-, J-, or K-varying). K-varying is 
only available if the mapping is using an IJK-ordered zone.

For example, if you read in the cylinder.plt data file and change to use the J-varying 
index, the plot will appear as shown in Figure 8-34.

You may define families of lines in IJ- and IJK-ordered zones to have curve types of splines or 
curve fits. This means that you can plot the I-, J-, or K-varying lines of an IJ- or IJK-ordered 
zone using these curve types. For example, suppose you create a circular zone with a small 

Figure 8-33. The Indices page of the Mapping Style dialog.

Figure 8-34. A family of J-varying lines for the cylinder data.
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number (seven for example) of points around the circumference. A two-dimensional plot or a 
straight line segment line plot of the J-lines of this zone will show a polygon-shaped zone. 
Using the Paraspline curve type for the J-lines results in splined mesh lines that reveal the cir-
cular shape of the zone.

8.9.2. Index Ranges
By default, the entire range of points is plotted in your mapping. For IJ- and IJK-ordered data, 
you may want to specify an index range to limit the number of lines drawn. Or, for any type of 
data, you may want to limit the points drawn to a select range.

To specify the index ranges:

1. On the Indices page of the Mapping Style dialog, select the mapping for which you want to 
specify an index range.

2. Click on one of I-, J-, or K-Index range. The Enter Range dialog appears.

3. Enter a starting index in the Begin field, an ending index in the End field, and a skip factor 
in the Skip field. A skip of one means “use every point in the range,” a skip of two means 
“use every other point,” and so on.

If you change index range of the varying index of the mapping, you limit the points in each line 
drawn in that mapping. For example, for the cylinder data, if you change the I-Index Range 
End to 15 while displaying I-varying lines, you obtain the plot shown in Figure 8-35. Compare 

this to Figure 8-32 which shows I-varying lines for the entire I-index Range.

If you change index range of the non-varying indices of the mapping, you limit lines drawn for 
that mapping. For example, for the cylinder data, if you change the J-Index Range End to 15 
while displaying I-varying lines, you obtain the plot shown in Figure 8-36. Compare this to 
Figure 8-32 which shows I-varying lines for the entire J-index Range.

Figure 8-35. XY Line plot with a family of I-varying lines and the I-index ending at 15.
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8.10. Line Legend

8.10. Line Legend
You can generate a legend that shows the line and symbol attributes of the mappings. In XY 
Line plots, this legend includes the bar chart information. The legend can be positioned any-
where within the line plot frame.

The mappings that are shown in the legend are selected on the Definitions page of the Mapping 
Style dialog. By default, all mappings are shown, but Tecplot removes redundant entries. That 
is, if two entries in the legend would look exactly alike, only one is printed. See Section 8.3.6, 
“Line Plot Legend Control,” for more details.

To include the line plot legend:

1. From the Plot menu, choose Line Legend. The Line Legend dialog appears, as shown in 
Figure 8-37.

2. Select the check box labeled Show Line Legend.

Mapping names are included in the legend by default. If you do not want to see the mapping 
names, uncheck the Show Mapping Names check box.

The Line Legend dialog also allows you to format the text for the legend by choosing a color 
and font, and specifying the text height, and to enter a line spacing between entries in the 
dialog.

The legend is automatically placed for you. You may specify the position of the legend by 
entering values in the X (%) and Y (%) text fields. Enter X as a percentage of the frame width 
and Y as a percentage of the frame height.

You may also specify the anchor location of the legend with the Anchor button. This is the 
point on the legend that corresponds to the entered position. The anchor is also the point on the 
legend that does not move when the frame is resized. By default, the legend is anchored in the 
top right.

Figure 8-36. XY Line plot with a family of I-varying lines and the J-index ending at 15.
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The Line Legend can include a box. By default, the box is set to Plain, which is just an outline, 
but you can change to No Box or a Filled box using the appropriate check boxes. If the legend 
is Plain or Filled, the box attributes may be changed with the following controls:

• Line Thickness: Specify the line thickness as a percentage of frame height.
• Box Color: Choose a color for the legend box outline.
• Fill Color: Choose a color for the legend box fill. This option is only available if the Leg-

end box is filled.
• Margin: Specify the margin between the legend text and legend box as a percentage of the 

text height.

8.11. Data Point Labels
You can label all or some of the data points, or nodes, in your line plots with either the index of 
the data point, the value of the dependent variable at the point, or the both the values (X&Y or 
Theta&R) for the data point. For example, Figure 8-38 shows an XY Line plot with each data 
point labeled with its X-Y value pair, while Figure 8-39 shows a Polar Line plot with each 
point labeled with its Theta-R value pair.

To add data labels to your plot:

1. From the Plot menu, choose Label Points. The Label Points dialog appears, as shown in 
Figure 8-40.

2. Select Show Node Labels.

Figure 8-37. The Line Legend dialog.
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8.11. Data Point Labels

3. Choose one of the three toggles: Show Index Value, Show Dependent Variable Value, or 
Show X,Y Value Pair. For Polar Line, the third option is Show Theta-R Value Pair.

Figure 8-38. An XY Line plot with data labels.

Figure 8-39. A Polar Line plot with each data point labeled.

Figure 8-40. The Label Points dialog.
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By default, all points of all mappings are labeled. If you want to label only some points, you 
can choose to skip labels by index or by distance. If you click the By Index check box, you can 
enter an index skip in the adjacent text field: a value of one shows a label at all points, a value 
of two labels every other point, and so on. If you click the By Distance (%) check box, you can 
enter a frame distance in the adjacent text field; data points closer than the specified distance to 
the last labeled point are not labeled.

The style of labels can be altered with the following controls:

• Color Text by Map: If this check box is checked, the labels will be the same color as the 
outline color used for symbols for the mapping. This color is set on the Symbols page of the 
Mapping Style dialog, and will be used even if symbols are turned off.

• Color: Choose a text color from the Select Color dialog. This option is only available if 
Color Text by Map is off (which by default, it is).

• Font: Select a font and size from the Select Font dialog.
• Include Text Box: Add a filled box around each data label. The box is always filled with 

the background color of the frame and outlined with the text color.
• Number Format: If you are using a variable value as the data label (as opposed to the 

index value), you can specify the format of the labels using the Specify Number Format 
dialog.

8.12. Polar Drawing Options
Options specific to the Polar Line plot type are found in the Polar Drawing Options dialog 
shown in Figure 8-41. These settings apply to all mappings in the frame.

In the Polar Line plot type, a line between two points may be drawn in one of two ways: they 
may be drawn as a straight line between the two points, or they may be drawn as an interpola-
tion of the Theta-R values. In the latter case, the connection between the two points is a smooth 
curve.

By default, lines are drawn straight. This works for plots where the angular differences 
between consecutive points are not great. If the angular differences are great, or if you prefer a 
Theta-R interpolation over the default X-Y interpolation, you may change the drawing mode in 

Figure 8-41. The Polar Drawing Options dialog.
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8.12. Polar Drawing Options

the Polar Drawing options dialog. However, this can result in slow performance with large data 
sets.

The difference between the two Polar Line Drawing Modes is shown in Figure 8-42.

With Theta-R interpolation, Tecplot will stop drawing a line that involves too many revolu-
tions around the circle. For example, if adjacent points have angle values of 0 degrees and then 
36000 degrees, the plot would involve 100 complete revolutions around the origin. If this is the 
case, Tecplot will draw only ten revolutions. If you need that many revolutions, create a new 
zone that has points interpolated in between the two points.

The Polar Drawing Options dialog also allows you to control the approximate used to draw 
arcs in Polar Line plots. This includes the axes, grid lines, and lines drawn in Curved Line 
mode. All arcs are drawn as a series of lines with a maximum angular difference. You can 
change this difference for more accurate Polar Line plots, but at a cost of reduced performance.

Figure 8-42. The Polar Drawing Options dialog.
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CHAPTER 9 Mesh Plots and 
Boundary Plots

A mesh plot is a field plot of the lines connecting neighboring data points within a zone. For 
I-ordered data, the mesh is a single line connecting all of the points in order of increasing I-
index. For IJ-ordered data, the mesh consists of two families of lines connecting adjacent data 
points of increasing I-index and increasing J-index. For IJK-ordered data, the mesh consists of 
three families of lines, one connecting points of increasing I-index, one connecting points of 
increasing J-index, and one connecting points of increasing K-index. By changing the zone’s 
Surfaces to Plot on the Surfaces page of the Zone Style dialog, you may limit the plotted mesh 
to the exterior surface (exposed cell faces) or to selected I-, J-, and K-grid planes. For finite-
element zones, the mesh is a plot of all edges of all elements which are defined by the connec-
tivity list for the node points. Mesh lines are straight lines between adjacent points.

A boundary plot is a field plot of the boundaries of ordered-data zones or 2-D finite-element 
zones. Boundary plots are frequently combined with other plot types.

Because the default field plot type consists of the Mesh and Boundary layers, we have already 
seen numerous examples of these plots in Chapter 7, “Field Plots.”  This chapter concentrates 
on those aspects of mesh and boundary plots unique to those plot types.

9.1. Mesh Plot Modification
Once you have read in your data, you can modify your mesh plot attributes using either the 
Mesh page of the Zone Style dialog or the Quick Edit dialog. You can control any of the fol-
lowing attributes from the Mesh page of the Zone Style dialog, shown in Figure 9-1:

• Which zones are active. See Section 7.3.2, “Zone Display.” 
• Whether the mesh is visible for each active zone. See Section 7.3.3, “Zone Layer Display.” 
• The mesh type. See Section 9.2, “Mesh Plot Types,” below.
• The mesh color. See Section 7.3.4, “Color Choice.” 
• The mesh line pattern. See Section 7.3.5, “Line Pattern.” 
• The mesh line pattern length. See Section 7.3.6, “Pattern Length.” 
• The mesh line thickness. See Section 7.3.7, “Line Thickness.” 
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9.2. Mesh Plot Types
Tecplot has three distinct mesh types:

• Wire Frame: Mesh lines are drawn underlying all other field plots. Wire frame meshes are 
drawn below any other field plots (such as contours or vectors) on the same zone. In 3D 
Cartesian plots, no hidden lines are removed. For 3-D volume zones (finite-element volume 
or IJK-ordered), the full 3-D mesh consisting of all the connecting lines between data 
points is not generally drawn because the sheer number of lines would make it confusing. 
The mesh drawn will depend upon your choice of Surfaces to Plot on the Surfaces page of 
the Zone Style dialog. See Section 20.1, “Surfaces to Plot,”  for further details. By default, 
only the mesh on exposed cell faces is shown.

• Overlay: Like Wire Frame, except that mesh lines are drawn over all other field-plot types 
except vectors and scatter symbols. For example, if you have flooded contours on a zone, 
you do not see a wire frame mesh (which would be underneath the contour flooding), but 
you can see an overlay mesh. In 3D Cartesian plots, the area behind the cells of the plot is 
still visible (unless some other plot type such as contour flooding prevents this). As with 
Wire Frame, the mesh drawn is dependent upon your choice of Surfaces to Plot in the Vol-
ume page of the Zone Style dialog. See Section 20.1, “Surfaces to Plot,”  for further details. 

• Hidden Line: Like Overlay above, except hidden lines are removed from behind the mesh. 
In effect, the cells (elements) of the mesh are opaque. Surfaces and lines that are hidden 
behind another surface are removed from the plot. For 3-D volume zones, using this plot 
type obscures everything inside the zone. If you choose this option for 3-D volume zones, 
then choosing to plot every surface (using the Volume page of the Zone Style dialog) has 
the same effect as plotting only exposed cell faces, but is much slower. You may want to 
use a different Surfaces to Plot option or use a wire frame mesh instead. If this option is set 
and the plot type is not 3D Cartesian, you get a mesh identical to that for Overlay. The 
opaque surfaces crated by Hidden Line are not affected by the Lighting zone effect (there is 
no light source shading).

Figure 9-2 shows the available mesh plot types, along with the effects of choosing Overlay and 
Wire Frame in combination with contour flooding. 

Figure 9-1. The Mesh page of the Zone Style dialog.



195

9.3. Boundary Plot Modification

To choose a mesh plot type for a zone or zones:

1. From the Mesh page of the Zone Style dialog, select the zone or zones for which you want 
to specify a plot type.

2. Click Mesh Type. The options Wire Frame, Overlay, and Hidden Line appear.

3. Click on the desired type.

You can also choose the mesh type from the Quick Edit dialog for zones chosen interactively 
in the workspace.

To choose a mesh type for a zone or zones from the Quick Edit dialog:

1. In the workspace, use the Selector tool to select the zone or zones for which you want to 
specify a plot type.

2. Call up the Quick Edit dialog from the sidebar or by choosing Quick Edit from the Edit 
menu.

3. Click  in the Mesh display area for a wire frame plot, click  for an overlay plot, or 

click  for a hidden line plot.

9.3. Boundary Plot Modification
The Boundary layer controls the boundary lines for zones. Zone boundaries exist only for 
ordered zones, or 2-D finite-element zones. They appear as lines around the edges of the zone. 
Figure 9-3 shows a boundary plot of multiple zones.

Three-dimensional finite-element zones do not have boundaries, although you may use the 
Extract FE Boundary dialog to create a zone that is the outer boundary or surface of a finite-
element zone. See Section 19.4, “Boundary Extraction of Finite-Element Zones,” for details.

You can control any of the following attributes from the Boundary page of the Zone Style 
dialog, shown in Figure 9-4:

Figure 9-2. Mesh plot types.
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• Which zones are active. See Section 7.3.2, “Zone Display.” 
• Whether the boundary is visible for each active zone. See Section 7.3.3, “Zone Layer Dis-

play.” 
• Which boundaries are displayed for each zone. See Section 9.4, “Boundary Display,” 

below.
• The boundary color for each zone. See Section 7.3.4, “Color Choice.” 
• The boundary line thickness for each zone. See Section 7.3.7, “Line Thickness.” 

9.4. Boundary Display
For IJ-ordered zones, the available boundaries are the lines I=1, I=IMax, J=1, and J=JMax. 
When the Surfaces to Plot option is set to Boundary Cell Faces, Exposed Cell Faces, or Every 
Surface for IJK-ordered zones, the available boundaries are the boundaries of the surface areas, 
forming a “box” that contains the data. Surfaces to Plot can be set on the Surfaces page of the 
Zone Style dialog. When the Surfaces to Plot option is set to one of the planes options, such as 
I-, J-, or K-planes, for IJK-ordered zones the boundaries are the boundaries of each plane (I-, J-

Figure 9-3. The boundary of a multiple-zone data set.

Figure 9-4. The Boundary page of the Zone Style dialog.
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9.4. Boundary Display

, or K-plane). By default, all available boundaries are drawn when the Boundary layer is active. 
You can specify which of the available boundaries are plotted using either the Zone Style 
dialog or the Quick Edit dialog.

To specify which boundaries to draw: 

1. From the Boundary page of the Zone Style dialog, select the zone or zones for which you 
want to specify which boundaries to draw.

2. Click I-Indx Bndy (or J-Indx Bndy or K-Indx Bndy). The options None, Min Only, Max 
Only, and Both appear.

3. Click on the desired option.

To specify which boundaries to draw using the Quick Edit dialog:

1. In the workspace, use the Selector tool to select the boundary of the zone for which you 
want to specify the boundaries to be drawn. When you select a zone boundary, an extra 
selection handle shows which of the zone’s available boundaries is currently selected. Click 
on any other available boundary to select that boundary.

2. Call up the Quick Edit dialog from the sidebar or by selecting Quick Edit... from the Edit 
menu.

3. Click on one of the following buttons in the Boundary display area: 

-  To display all available boundaries for the zone.

-  To display the currently selected boundary.

-  To turn off the currently selected boundary.

-  To turn off all boundaries except the currently selected boundary.
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CHAPTER 10 Contour Plots

Contour plots show the variation of one variable across the data field. Contour lines and con-
tour flooding are examples of contour plots, as are multicolored mesh, scatter, and vector plots. 
In this chapter, however, we restrict our attention to plots having contour lines and/or contour 
flooding.

Plotting contours allows you to add an extra dimension to a plot, and thus contour plots may 
require one more variable than mesh plots of the same dimension. Where a 2-D mesh plot 
shows two variables, a contour plot can show three, and a 3-D contour plot can show four. This 
extra variable is called the contour variable.

The procedure for creating a contour plot is:

1. Read in a data set.

2. Select the Contour check box on the sidebar to activate the Contour zone layer. If no con-
tour variable is currently assigned, the Contour Details dialog appears with the default con-
tour variable selected. You can either choose a different contour variable, or click Close to 
accept the default. Many other options can be set on the Contour Details dialog. you can 
also choose to use more than one contour variable in a plot. See 10.2, “Contour Groups.” 

3. Deselect the Mesh check box on the sidebar. This turns off the Mesh zone layer, which is on 
by default.

The default contour plot is a flood contour plot with contour levels spanning a range calculated 
by Tecplot from the range of your contour variable is shown in Figure 10-1.

Figure 10-1.  A contour plot of the cylinder data.
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10.1. Contour Plot Settings
You can modify the attributes of your contour plot using either the Contour page of the Zone 
Style dialog or the Quick Edit dialog. You can control any of the following attributes from the 
Contour page, shown in Figure 10-2.

• Which zones are active. See Section 7.3.2, “Zone Display.” 
• Whether the contours are visible for each active zone. See Section 7.3.3, “Zone Layer Dis-

play.” 
• The contour type. See Section 10.1.1, “Contour Plot Type.” 
• The contour group used for flooding. See Section 10.2, “Contour Groups.” 
• The contour group used for multi-color lines. See Section 10.2, “Contour Groups.” 
• The contour line color. See Section 7.3.4, “Color Choice.” 
• The contour line pattern. See Section 7.3.5, “Line Pattern.” 
• The contour line pattern length. See Section 7.3.6, “Pattern Length.” 
• The contour line thickness. See Section 7.3.7, “Line Thickness.” 
• Whether the lighting effect for contour flooding should be active for this zone. See Section 

11.3.3, “Lighting Effects and Contour Flooding.”

Options such as contour labels, contour legends and special settings for contour bands or 
contour lines are set by the selected contour group. See Section 10.2, “Contour Groups.”  The 
color map is set globally. See Section 10.4, “Global Color Map.” 

10.1.1. Contour Plot Type
Tecplot allows you to create contour plots of five different types:

• Lines: Draws lines of constant value of the specified contour variable.
• Flood: Floods regions between contour lines with colors from the global color map.
• Both Lines and Flood: Combines above two options.
• Average Cell: Floods cells or finite-elements with colors from the global color map 

according to the average value of the contour variable over the data points bounding the 
cell.

Figure 10-2. The Contour page of the Zone Style dialog.
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10.1. Contour Plot Settings

• Primary Value: Floods cells or finite-elements with colors from the global color map 
according to the primary value of the contour variable for each cell. If the variable is cell 
centered, the primary value is the value assigned to the cell. If the variable is node located, 
the primary value comes from the lowest index node in the cell.

An example of each contour plot type is shown in Figure 10-3.

To modify the contour plot type:

1. Choose Zone Style on the sidebar, or from the Plot menu. Click Contour on the Zone Style 
dialog.

2. Select the zone or zones for which you want to modify the plot type.

3. Click Contour Type. A drop-down appears listing the available plot types. Click on the 
desired plot type.

To modify the contour plot type from the Quick Edit dialog:

1. From the sidebar, click Quick Edit. The Quick Edit dialog appears.

2. In the workspace, use the Selector tool to select the zone or zones for which you want to 
modify the plot type.

3. On the Quick Edit dialog, click on the appropriate button, as follows:

-  Lines.

-  Flood.

-  Both Lines and Flood.

Figure 10-3. Contour plot types.
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-  Average Cell.

-  Corner Cell.

A flooded contour plot is a contour plot in which the area between contour levels is filled (that 
is, flooded). Flooded contour plots give an immediate visual impression of how the contour 
variable is changing. All contour types except Lines use flooding.

The distribution of colors used for contour flooding may be banded or continuous. When 
banded distribution is used for flooding a solid color is used between contour levels. If contin-
uous color distribution is used the flood color will vary linearly in all directions. See Section 
10.2.4, “Color Distribution Methods,” for details on Tecplot’s color distribution methods.

To create a flooded contour plot from the Contour page of the Zone Style dialog, set the 
contour plot type to either Flood or Both Lines and Flood. The area between adjacent contour 
levels is colored according the value of the contour variable, the color distribution method, the 
number of contour levels (banded distribution only), and the active color map. If you select the 
contour plot type Both Lines and Flood, the flooding is displayed along with the contour lines. 
(If the contour lines are multi-colored by the same contour group, you will not be able to see 
them against the contour flooding.) 

Each object in a field plot, such as a zone layer for a particular zone, the mesh or contour layer 
for streamtraces or iso-surfaces, or any of the layers for slices, can have its own setting for col-
oring by selecting one of the contour groups or RGB coloring. See Section 10.2, “Contour 
Groups,”  and Section 10.3, “RGB Coloring.” 

In addition to the standard contour flooding, Tecplot supports two other types of flooded 
contour plots: average cell and primary value. Unlike the standard flooding, which floods the 
regions between adjacent contour levels, these options flood individual cells or elements. Col-
oring will be affected by the location (nodal or cell-centered) of the contour variable. The fol-
lowing table shows how Tecplot creates average cell and primary value contour plots:

Contour 
Variable 
Location Average Cell Primary Value
Nodal Values at the nodes 

are averaged.
The value of the lowest indexed node is the cell is used. 
When plotting IJK-ordered, FE-brick or -tetra cells, each 
face is considered independently of the other faces. You 
may get different colors on the different faces of the same 
cell.

Cell-Centered Cell-centered values 
are averaged to the 
nodes and the nodes 
are then averaged.

The cell-centered value is used directly. When plotting I-, 
J-, or K-planes in 3-D, the cell on the positive side of the 
plane supplies the value, except in the case of the last 
plane, where the cell on the negative side supplies the 
value.
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10.2. Contour Groups

10.1.2. Flood By Options
For any Contour Type except Lines, the flooding of a zone is set to one of the contour groups 
or to RGB coloring. By default, the first contour group, C1, is used for flooding. To choose a 
different contour group (C2, C3, or C4) or RGB coloring (RGB), click Flood By, then select 
the desired option from the drop-down. If you choose a contour group for which no variable 
has been specified, the Contour Details dialog in its condensed form appears. Click the arrow 
and choose a variable from the drop-down. See Section 10.2, “Contour Groups.”  If you choose 
to color by RGB and no variables have been selected, the Select Variables dialog appears, 
allowing you to specify variables for R, G, and B. See Section 10.3, “RGB Coloring.” 

10.1.3. Lines By Option
When the Contour Type is set to Lines or Both Flood and Lines, the Lines are positioned by 
one of the contour groups. By default, the contour levels of the first contour group, C1, are 
used for placing the lines. To choose a different contour group (C2, C3, or C4), click Lines By, 
then select the desired option from the drop-down. If you choose a contour group for which no 
variable has been specified, the Contour Details dialog in its condensed form appears. Click 
the arrow and choose a variable from the drop-down. See Section 10.2, “Contour Groups.” 

10.1.4. Use Lighting Option
Lighting effects on 3-D plots may distort the surface color, depending on the orientation of the 
surface with respect to the light source. You may want to turn off the lighting effects when cre-
ating flooded contour plots in 3-D to assure the surface colors match those in the contour leg-
end. The easiest way to do this for zones is via the Lighting Zone Effects check box on the 
sidebar. Another option is to keep Lighting active on the sidebar, but set Use Lighting to No for 
any selected zone.

10.2. Contour Groups
Although most settings for contour plots can be unique for each zone, some settings are linked 
by a contour group. Zone layers or other objects that reference the same group for an attribute 
show the same plot style for that attribute. Up to four different contour groups can be set. Each 
contour group has its own settings for the following attributes:

• The contour variable.
• Contour levels.
• Coloring options (banded or continuous color distribution, or flood cutoff).
• Control of band coloring, such zebra shading.
• The contour line mode.
• Contour labeling.
• The contour legend.

Each of these attributes can be set in the Contour Details dialog and is explained in the follow-
ing sections. The Contour Details dialog in its condensed form is shown in Figure 10-4.
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10.2.1. Contour Variable Selection
You choose a contour variable from the Contour Details dialog. This dialog comes up automat-
ically when you turn on the Contour zone layer for the first time in a frame, or can be accessed 
via the Contour option on the Plot menu. The Contour Details dialog is shown in Figure 10-4. 
Choose one of the data set’s variables from the Var drop-down.

10.2.2. Contour Levels
A contour level is a value at which contour lines are drawn, or for banded contour flooding, the 
border between different colors of flooding. The range of contour levels is the interval between 
the minimum contour level and the maximum contour level.

You control contour levels using the Levels page of the Contour Details dialog. Call up this 
dialog by choosing Contour Levels option from the Field menu. From this dialog, you can 
perform any of the following tasks:

• Specify a new range or number of contour levels.
• Add levels to an existing set of contour levels.
• Remove selected contour levels.

The Levels page of the Contour Details dialog is shown in Figure 10-5.

Figure 10-4. The Contour Details dialog in its condensed form.

Figure 10-5. The Levels page of the Contour Details dialog.
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10.2.2.1. New Contour Level Specification. You may specify a new set of contour levels 
via the Reset Levels or New Levels options on the Contour Details dialog. The Reset Levels 
dialog only asks you to supply an approximate number of levels to use. Tecplot estimates a 
starting point, end and increment which may use slightly more or less levels than you speci-
fied.

If you want more control over the exact values generated for contour levels, click New Levels. 
This calls up the Enter Contour Level Range dialog. The dialog is shown in Figure 10-6.

You can specify the range and number of levels in any of three ways:

• As a minimum and maximum level value, together with the number of levels to be distrib-
uted equally through the range. Choose this option (the default) by selecting the check box 
labeled Min, Max, and Number of Levels, then filling in the appropriate text fields.

• As a minimum and maximum level value, together with a delta, that is, the difference or 
change in contour value between two adjacent contour levels. You choose this option by 
selecting the check box labeled Min, Max, and Delta, then filling in the appropriate text 
fields. Tecplot generates contour levels beginning at the minimum level specified, then at 
intervals of Delta, until adding Delta would result in a level higher than the maximum level 
specified. Thus the highest actual contour level is usually somewhat less than the maximum 
level unless Delta is chosen precisely.

• As a minimum and maximum level value, together with the number of levels to be distrib-
uted exponentially through the range. You choose this option by selecting the check box 
labeled Exponential Distribution, then filling in the appropriate text fields.

In specifying a range, you can refer to the main Contour Levels dialog, which displays the 
minimum and maximum range of the contour variable. You can specify contour levels that 
extend beyond the range of the contour variable; any levels outside the range of the data are not 
displayed.

Figure 10-6. The Enter Contour Level Range dialog.
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10.2.2.2. Contour Level Addition. You can add contour levels to an existing set of con-
tours. You might do this to get a clearer idea of how the contour variable is varying in areas 
with few visible contour lines.

You can add new levels in any of three ways:

• Add a new range of contour levels to the existing set by clicking Add Levels on the Con-
tour Levels dialog, then using the Enter Contour Level Range dialog as described in Sec-
tion 10.2.2.1, “New Contour Level Specification.” 

• Enter a value in the Level To Add text field in the Levels page of the Contour Details dialog 
and then clicking Add Level.

• Choose  from the sidebar, then click at any location in the contour plot where you 
would like a new contour level. Tecplot adds a new contour level that goes through the 
specified point. By holding down the mouse button you can drag and interactively position 
the new contour level until you release the button. While using this tool you may also press 
the “-” key to switch to the Remove Contour tool.

10.2.2.3. Contour Level Removal. You can remove contour levels in either of two ways:

• In the Levels scrolled list in the Levels page of the Contour Details dialog, select one or 
more contour levels, then click Remove Selected Levels.

• Choose  from the sidebar, then click on any contour line in your contour plot. Tecplot 
deletes the specified contour level, or the nearest contour level to the specified point. While 
using this tool you may also press the “+” key to switch to the Add Contour tool.

10.2.2.4. Contour Level Adjustment. You can interactively adjust a contour level with 

the  tool from the sidebar. Hold down the Ctrl key; then click and drag the contour level 
you want to adjust. Move the contour to the desired location and release the mouse button. The 
value of the contour level will change as can be viewed in the Contour Levels dialog.

10.2.3. Contour Coloring

Although the color map is global, affecting all frames, there are some adjustments you can 
make that apply only a contour group in the current frame. These adjustments allow you to 
customize the look of a single contour plot without changing the global color map. Adjust-
ments to the color map for individual frames are made from the Coloring page of the Contour 
Details dialog, shown in Figure 10-7.

• The color distribution method may be continuous or banded.
• The color map may be cut off such that coloring outside of a given range is not done at all.
• The color map can be reversed.
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• The color map can contain multiple cycles.

10.2.4. Color Distribution Methods

The color distribution method determines how to look up the colors in the global color map. 
There are two options; Banded and Continuous.

Banded color distribution is closely tied to the contour levels. A solid color is assigned for all 
values within the band between two levels. For contour flooding this means the area between 
two levels is filled with a single solid color. For multi-color scatter symbols or vectors this 
means all scatter symbols or vectors that have a contouring value between two contour levels 
are assigned the same color.

When banded coloring is in effect the following options are available:

• Color bands can be zebra shaded. This in effect colors every other band with a specific 
color (or no color at all).

• Specific contour bands can be assigned a unique basic color. This is useful for forcing a 
particular region to use blue, for example, to designate an area of water. You can define up 
to 16 color overrides.

The Bands page of the Contour Details dialog is shown in Figure 10-8.

Continuous color distribution assigns linearly varying colors to all multi-colored objects or 
contour flooded regions. You can vary the default assignment of colors by entering a Min or 
Max value for Color Map Endpoints. For example, if your contour variable has values ranging 

Figure 10-7. The Coloring page of the Contour Details dialog.
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from -2 to ten, but you are only interested in the values less than two, setting Max to two deter-
mines that the entire color map is used for values from -2 to two.

The Use Approximate Continuous Flooding option, if selected, causes each cell to be flooded 
using the RGB values at each node, without considering values at adjacent nodes. When the 
transition from a color at one node to another node crosses over the boundary between control 
points in the color spectrum, approximate flooding may produce colors not in the spectrum. 
Leaving this option unchecked is slower but more accurate.

10.2.5. Color Cutoff

Color cutoff lets you specify a range within which contour flooding and multi-colored objects, 
such as scatter symbols, are displayed. For example, you may specify that only contour flood-
ing in the range of -4.5 to 4.5 should be displayed; contour flooding outside this range is not 
plotted.

To use color cutoff:

1. Select the Contour tool from the sidebar, or choose Contour from the Plot menu. Go to the 
Coloring page of the Contour Details dialog, as shown in Figure 10-7.

2. To set a minimum color cutoff select the Cutoff Color Below check box and enter a value in 
the text field.

3. To set a maximum color cutoff select the Cutoff Color Above check box and enter a value 
in the text field.

A flooded contour plot before and after color cutoff has been applied is shown in Figure 10-9.

Figure 10-8. The Bands page of the Contour Details dialog.
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10.2.6. Reversed Color Map

You can reverse the color map by selecting the check box at the bottom of the Contour Color-
ing Options dialog. Two plots, one with the color map going in the default direction, and one 
with the color map reversed, are shown in Figure 10-10.

10.2.7. Color Map Cycles

You may choose to cycle the color map. This is useful if you have data where there is a great 
deal of activity in multiple ranges of the contour variable and you want to cycle through all 
colors in each region. A plot with the color map cycled two times is shown in Figure 10-11.

10.2.8. Contour Bands
When Coloring Distribution for a group is set to Banded, the following options are available:

• Color bands can be zebra shaded. This in effect colors every other band with a specific 
color (or no color at all). 

• Specific contour bands can be assigned a unique basic color. This is useful for forcing a 
particular region to use blue, for example, to designate an area of water. You can define up 
to 16 color overrides.

Figure 10-9. Flooded contour plot without and with flood cutoff.

Figure 10-10. Flooded contour plot with a standard and a reversed color map.
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For these selections, click the Bands tab on the Contour Details dialog. The Bands page of the 
dialog appears, as shown in Figure 10-8.

10.2.9. Contour Lines
You can control the color and thickness of the contour lines on a zone-by-zone basis, using the 
procedures of Section 7.3, “Field Plot Modification.” You can also specify the line pattern and 
pattern length on a zone-by-zone basis, but whether those settings are used depends on the cho-
sen contour group’s line mode in that frame. The contour line settings determine how contour 
lines are drawn for all zones in the current frame’s data set.

To specify the contour line mode:

1. On the Contours page of the Zone Style dialog, set Lines By to the desired contour group

2. Open the Contour Details dialog by clicking Contours on the sidebar, or by selecting Con-
tours from the Plot menu. Choose the appropriate contour group, C1, C2, C3 or C4.

3. Go to the Lines page of the Contour Details dialog, as shown in Figure 10-12.

Figure 10-11. Flooded contour plot with the color map cycled two times.

Figure 10-12. The Lines page of the Contour Details dialog.
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4. Choose one of the following options:

- Use Zone Line Pattern: For each zone, draw the contour lines using the line pattern and 
pattern length specified in the Contour page of the Zone Style dialog.

- Skip to Solid: Draw n dashed lines between each pair of solid lines, where n is an inte-
ger you enter in the text field Number of Dashed Lines to Draw between Solid Lines.

- Dashed Negative Lines: Draw lines of positive contour variable value as solid lines and 
lines of negative contour variable value as dashed lines.

5. If you choose Skip to Solid or Dashed Negative Lines, specify a pattern length for the 
dashed lines.

6. If you choose Skip to Solid, enter the number of dashed lines to draw between solid lines.

10.2.10. Contour Labels
Contour labels are labels that identify particular contour levels either by number or by value. 
You can place contour labels interactively, or have Tecplot create them for you automatically. 
You can also have Tecplot create a set of contour labels automatically, then interactively add 
contour labels to this saved set. You control contour labels with the Contour Labels dialog 
under the Field menu, and with the Add Contour Label mouse mode tool from the sidebar.

To add contour labels to your plot, you can use either of the following procedures. The first 
describes using the Add Contour Label tool; the second describes using the Contour Labels 
dialog to have Tecplot automatically generate the contour labels. If you are using the Add 
Contour Label tool, you still use the Contour Labels dialog to specify whether contour level 
numbers or values are used and to specify formatting and alignment options for the labels. 
Contour labels show the value or number of the nearest contour level. In other words, if you 
add a label between two contour lines, the label will show the value or number of the nearest 
line. This can be misleading when contour labels are far away from contour lines.

To add contour labels interactively using the Add Contour Label tool:

1. Create a plot with an active Contour zone layer, where at least one zone has a contour type 
of Lines or Both Lines and Flood, with Lines By set to the appropriate contour group.

2. From the sidebar, choose the Add Contour Label tool by clicking .

3. In the workspace, click on the location at which you want a contour label to appear. By 
default, Tecplot uses contour values and aligns the labels with the contour line. You can 
modify the following options using the Contour Labels dialog.

- The label color.

- The label font.

- The label size.

- The numeric format. The available formats are described in Section 17.5.2, “Tick Mark 
Labels.” 
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- Whether there is a color fill behind the labels, and if so, its color and the margin of fill 
around the labels.

- Label alignment. If the Align Next User-Positioned Label is selected, the next label 
placed is aligned with the contour line. Otherwise, the label is written with normal, 
upright text.

To have Tecplot generate contour labels automatically with each redraw:

1. Create a plot with an active Contour zone layer, where at least one zone has the contour 
type of Lines or Both Lines and Flood, with Lines By set to the appropriate contour group.

2. On the Contour Details dialog, choose the right contour group, then select Labels. The 
Labels page of the dialog appears, as shown in Figure 10-13.

3. Select the check box labeled Show Labels.

4. Choose whether contour numbers or contour values are used in the labels by selecting the 
appropriate option.

5. If you want the labels aligned with the contour lines, select the Align Labels check box.

6. Specify the spacing between labels in frame units.

7. Specify the number of levels to skip in the Level Skip text field. The default of one labels 
all contour labels.

8. Select the Generate Automatic Labels (with each Redraw) check box.

Figure 10-13. The Labels page of the Contour Details dialog.
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At each Redraw, Tecplot creates a new set of contour labels. At any time, you can deselect the 
Generate Automatic Labels (with each Redraw) check box, and Tecplot retains the last set of 
labels generated. Thus you can create labels for several redraws, then save a set to which you 
can interactively add more labels.

When Generate Automatic Labels is deselected, you can click Clear All Contour Labels to 
erase the current set of contour labels.

10.2.11. Contour Legend Creation

A contour legend is a key to the contour flooding in your flooded contour plot. It relates the 
displayed colors to the actual values of the contour variable. The contour legend can also relate 
contour level numbers to contour values. This is useful if you are using contour number labels. 
To create a contour legend, select the Legend page of the Contour Details dialog for the appro-
priate contour group. The Legend page of the Contour Details dialog is shown in Figure 10-14.

The following options are available:

• Show Contour Legend.
• Show Header to include the name of the contour variable.
• Separate Color Bands.
• Alignment: Vertical or Horizontal.
• Position: X (%) and Y (%) as percentages of the frame width and height. (You can also 

move the legend interactively.)

Figure 10-14. The Legend page of the Contour Details dialog.
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• Anchor: Specify which part of the legend is anchored in the selected position. The Anchor 
Alignment dialog is shown in Figure 10-15.

• Label Placement: If you have chosen Continuous Color Distribution on the Coloring page 
of the Contour Details dialog, you have three options for placement of labels on the legend:

- Label at Contour Levels: This option places one label for each contour level. See Sec-
tion 10.2.2, “Contour Levels.” 

- Label at Specified Increment: Enter a value in the Increment text field when selected.

- Label at Color map Divisions: Places one label for each control point on the global 
color map. See Section 10.4, “Global Color Map.” 

• Resize Automatically: Legend is roughly 50 percent of the frame width (for horizontal 
legends) or height (for verticals).

• Include Cutoff Levels: Color bands and labels for levels affected by Color Cutoff are 
shown in the legend. See Section 10.2.5, “Color Cutoff.” 

• Line Spacing: Adjusts the height of individual color bands on the legend.
• Font and height for the legend header or the legend labels.
• Color: Affects all text in the legend.
• Number Format: The available options are the same as for axis tick mark labels; see Sec-

tion 16.5.3 Tick Mark Label Formats.
• Legend Box (No Box, Filled, Plain): If you choose Filled or Plain, format the box using 

the following controls:

- Line Thickness: Specify the line thickness as a percentage of frame height.

- Box Color: Choose a color for the legend box outline.

- Fill Color (Filled only): Choose a color for the legend box fill.

- Margin: Specify the margin between the legend text and legend box as a percentage of 
the text height.

Figure 10-15. The Anchor Alignment dialog.
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10.3. RGB Coloring
RGB coloring occurs when Red, Green, and Blue values are supplied at each vertex. It may be 
used to create special flooding such as for Oil/Water/Gas plots. RGB coloring may be used for 
each field plot object in Tecplot: zone layers, the mesh or contour layer for streamtraces or iso-
surfaces, or any of the layers for slices. This affects multi-coloring for that object as well as 
any contour flooding. With RGB coloring, multi-colored objects such as vectors or scatter 
symbols have their color determined based on the RGB components of the field variables at 
their location. Multi-colored mesh and contour lines use the average value across the mesh 
line.

Note: RGB Coloring Limitation in Exported Vector-Based Files. Vector-based export files 
such as WMF do not show continuous RGB flooding. Objects that use RGB flooding are 
reduced to contain average cell flooding where each cell is flooded a solid color based on the 
averages of the RGB values at each vertex. The user is warned before such output is generated. 
The RGB coloring legend uses a resolution defined by a configuration file entry. The default 
resolution is usually be sufficient.

10.3.1. RGB Variable Assignment
The first time RGB coloring is assigned in a plot, the Select Variables dialog appears. Assign 
one variable for R, one for G, and one for B. If you have only two of these variables in your 
data set, use the RGB Coloring Options dialog to set them.

10.3.2. RGB Coloring Options
If your data has only two RGB variables, or if the sum of the variables is not normalized, you 
can adjust the settings using the RGB Coloring Options dialog. From the Plot menu, select 
RGB Coloring, then Variables/Range. The RGB Coloring Options dialog appears, as shown in 
Figure 10-16.

Figure 10-16. The RGB Coloring Options dialog.



Chapter 10. Contour Plots

216

10.3.2.1. RGB Mode. You can choose to:

• Assign variables to R, G, and B.
• Assign variables to two of R,G,B entries and leave the third to be calculated, where 

f(R)+f(G)+f(B)=1.0 (assuming f() is a function that maps R,G,B values into [0,1.0]).

10.3.2.2. Channel Variables. Assign the variables which supply the values for the color 
components, as specified in the RGB Mode. For example, if the Mode says G is calculated, 
only variables for R and B are assigned.

10.3.2.3. Channel Variable Range. By default, it is assumed that the minimum value for 
any of the Channel Variables is zero, the maximum is one, and the sum of the three variables is 
one at every point. If the sum is not normalized, you can set a new minimum and maximum. 
For example, if your variables sum to 100 at every point, you can enter 100 in the field for 
Value at Maximum Intensity.

10.3.3. RGB Legend
To create an RGB legend, perform the following steps:

1. From the Plot menu, select RGB Coloring, then Legend. The RGB Legend dialog appears.

2. Select Show RGB Coloring Legend.

3. Specify the position of the anchor point with X (%) and Y (%) as percentages of the frame 
width and height. (You can also move the legend interactively.)

4. Specify the height of the legend in frame units.

5. Choose the Orientation of the Legend from the drop-down. The first channel listed is 
shown on the lower left corner, the second on the lower right, and the third at the top.

6. To specify which part of the legend is anchored to the selected position, click Anchor. The 
Anchor Alignment dialog appears.

7. To show labels, click Show Text Labels.

8. Specify the text color.

9. Choose the text font and height.

10. Each channel can be labeled by the name of the assigned variable, or by text you enter. To 
choose a new label for a channel, click Specify, and type in the alternate label. When a 
channel has been calculated (no variable assigned), no label is shown unless the user enters 
text.

11. Select which kind of box you want drawn around the legend (No Box, Filled, or Plain). If 
you choose Filled or Plain, format the box using the following controls:

- Line Thickness: Specify the line thickness as a percentage of frame height.

- Box Color: Choose a color for the legend box outline.

- Fill Color (Filled only): Choose a color for the legend box fill.

- Margin: Specify the margin between the legend text and legend box as a percentage of 
the text height.
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Notes: When two channels are selected (and one is calculated), the legend is a simple ternary 
plot with each corner labeled with variable name or a user-specified text string. It is possible to 
have a plot that may contain colors not displayed in the legend. This occurs if you supply all 
three channel variables, and for one or more points, the sum of the variables values does not 
equal 1.0 or the specified Value at Maximum Intensity. See Section 10.3.2, “RGB Coloring 
Options.” 

10.4. Global Color Map
The colors used in flooded contour plots are determined by the global color map, controlled in 
the Workspace menu, or by frame-specific color options controlled in the Plot menu. This sec-
tion discusses the global color map.

By default, Tecplot uses a color map called Small Rainbow, which is a rainbow of colors from 
blue to cyan to green to yellow to red. This default color map is called Small Rainbow to dis-
tinguish it from another color map, Large Rainbow, which adds purple and white beyond the 
red. The color map is used by all frames; if you change the color map to modify the look of one 
frame, all frames with contour flooding or any form of multi-colored are modified as well.

To choose a color map:

1. From the Workspace menu, choose Color Map. The ColorMap dialog appears, as shown in 
Figure 10-17. 

2. From the Base Color Map drop-down, choose one of the following color maps:

- Small Rainbow: Five color spectrum from blue to cyan to green to yellow to red.

Figure 10-17. The Color Map dialog.
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- Large Rainbow: Seven color spectrum from blue to cyan to green to yellow to red to 
purple to white.

- Modern: Seven color spectrum; within each color band colors change in intensity from 
dark to light.

- GrayScale: Color spectrum from black to white.

- Wild: random Color spectrum. Wild is different each time you select it.

- Two Color: A two-color spectrum.

- User-Defined: A customizable version of one of the first four options above. You can 
add or delete control points, as well as change RGB values for each control point. See 
Section 10.4.2, “User-Defined Color Map,” for details on modifying a User Defined 
color map.

- Raw User-Defined: A customizable version of one of the first four options above. To 
customize the color map, however, you must save your Raw User-Defined map to a file 
using the Copy Color Map to File option in the Workspace menu. See Section 10.4.3, 
“Raw User-Defined Color Map,” for details on modifying a Raw User Defined color 
map.

You can modify any color map, except the Raw User-Defined color map, using the controls in 
the Color Map dialog.

10.4.1. Standard Color Map Adjustments

You can modify the standard color maps either by altering the position of the color map control 
points or by modifying the RGB values of the control points. Altering the position of the 
control points allows you to alter the proportions of colors in the spectrum. Modifying the 
RGB values of the control points changes the spectrum itself. All of the control points except 
the first and last are two-sided; they have both a left- and a right-RGB value. This allows you 
to define color maps such as Modern, which has sharp demarcations between color bands. To 
define smoothly varying color maps, select the Right RGB Same as Left check box for each 
two-sided control point. Except for the Wild and Modern color maps (and, if suitably modified, 
the Raw User-Defined color map), all color maps vary smoothly between control points.

To alter the position of control points:

1. Move the pointer into the color bar in the Color Map dialog.

2. Drag a point on the color bar. The entire color bar, including the control points, is distorted 
relative to the point where the drag started. If the point is dragged to the right, control 
points to the left of the drag point become more widely spaced, while control points to the 
right of the drag point are moved closer together. An XORed line shows the point being 
dragged. To move just a single control point, which does not affect the position of other 
control points, Ctrl-drag on the color bar to select the nearest control point, then drag as 
before. To return the control points to their original positions, click Redistribute Control 
Points.

To modify the RGB values for a control point:
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10.4. Global Color Map

1. Select the control point for which you want to modify RGB values. You can do this either 
by entering a value (or using the up and down arrows to choose a value) in the field labeled 
RGB Values for Control Point, or by Ctrl-clicking on the control point in the color bar.

2. Use the three sliders under the heading Left RGB to specify the left-RGB colors for the 
control point. (These sliders are disabled for the left-most control point.)

3. Use the three sliders under the heading Right RGB to specify the right-RGB colors for the 
control point, or select the check box Right RGB Same as Left to use the same values you 
just set for the left-RGB colors. (The Right RGB sliders are disabled for the right-most con-
trol point, or if the check box Right RGB Same as Left is selected.)

To reset the RGB values to their original values (and also reposition the control points in their 
original locations), click Reset.

10.4.2. User-Defined Color Map

You can modify a User-Defined color map in the same way you modify a standard color map, 
by altering the position of control points or modifying the RGB values of the control points, 
but you have the added ability to modify the number of control points.

To change the number of control points in a user defined color map:

1. Choose the User Defined color map. By default, the User-Defined color map has the same 
settings as the standard Small Rainbow color map.

2. Enter a value from two through nine in the Number of Control Points field.

If you choose a number greater than the current value, the new control points are added to the 
right of the existing control points; click Redistribute Control Points to see all your control 
points. If you choose a number less than the current value, the control points are removed 
rightmost first.

10.4.3. Raw User-Defined Color Map

You can modify a Raw User-Defined color map only by saving it to a file and then editing the 
resulting file, which consists of RGB triplets for every color in the spectrum. You can modify 
these RGB triplets as you want, using any ASCII text editor. In most cases, you want to use the 
User-Defined color map rather than the Raw User-Defined, since you cannot edit the raw color 
map in Tecplot.

10.4.4. Color Map Files

The position of color map control points and their RGB values can be stored in color map files; 
you can then edit the color map files to modify either the position or RGB values of the control 
points.

To create a color map file:

1. From the menu, choose Copy Color Map to File. The Write Color Map dialog appears.
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2. Specify a file name for the color map.

3. Click OK.

To use the saved color map in a new plot, choose Paste Color Map from File on the workspace 
menu. The color map file is a Tecplot macro file with a limited set of commands (only 
$!COLORMAP and $!COLORMAPCONTROL commands are allowed). The first part of the 
color map file generated from the Large Rainbow color map is shown below:

#!MC 1000 
$!COLORMAP  
 CONTOURCOLORMAP = LGRAINBOW 
$!COLORMAPCONTROL RESETTOFACTORY 
$!COLORMAP  
 LGRAINBOW 
    { 
    CONTROLPOINT 1 
      { 
      COLORMAPFRACTION = 0 
      LEADRGB 
        { 
        R = 0 
        G = 0 
        B = 255 
        } 
 
 
 
      TRAILRGB 
        { 
        R = 0 
        G = 0 
        B = 255 
        } 
      } 
. . .
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CHAPTER 11 Vector Plots

Vector plots are field plots of the direction and or magnitude of vector quantities. The vector 
quantities can be displacements, velocities, forces, or anything else that can be represented by 
vectors. You create vector plots by activating the Vector layer in the Tecplot sidebar, and, if you 
have not done so already, specifying two or three vector component variables.

One important use of vector components in Tecplot is to allow you to compute the trajectories 
of massless particles in a steady-state velocity field. These trajectories are called streamtraces. 
Streamtraces do not need to be created in vector plots, even though they require vector compo-
nents. For this reason, they are discussed in a separate chapter. See Chapter 12, “Streamtraces.” 

11.1. Vector Plot Creation
When you select the Vector check box in the Tecplot sidebar, Tecplot checks to see whether 
vector components have been assigned for the current data set in the current plot type, whether 
2D or 3D Cartesian. If you have not assigned vector components, the Select Variables dialog 
appears. In 2D Cartesian plots, the Select Variables dialog allows you to choose two vector 
components, as shown in Figure 11-1.

Choose variables by selecting the desired U-, V-, and in 3D Cartesian plots, W-variables from 
their respective drop-downs. You may select any of the current data set’s variables as any com-
ponent. You can change the component variables at any time by choosing Vector Variables 
from the Vector sub-menu of the Plot menu.

Once you have selected the Vector check box and have chosen your vector components your 
vector plot will appear as shown in Figure 11-2 for the cylinder data. If vectors are not visible, 
see 11.5, “Vector Length.” 

Figure 11-1. The Select Variables dialog for assigning 2-D vector components.
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11.2. Vector Plot Modification
You can modify your vector plot attributes using either the Vector page of the Zone Style 
dialog or the Quick Edit dialog. You can control any of the following attributes from the Vector 
page of the Zone Style dialog (Figure 11-3):

• Which zones are active. See Section 7.3.2, “Zone Display.” 
• Whether the vectors are visible for each active zone. See Section 7.3.3, “Zone Layer Dis-

play.” 
• The vector plot type. See Section 11.3, “Vector Types.” 
• The arrowhead style. See Section 11.4.1, “Arrowhead Style.” 
• Whether 3-D vectors are tangent vectors or regular vectors. See Section 11.7.1, “Tangent 

Vectors.” 
• The vector color. See Section 7.3.4, “Color Choice.” 
• The vector line pattern. See Section 7.3.5, “Line Pattern.” 
• The vector line pattern length. See Section 7.3.6, “Pattern Length.” 
• The vector line thickness. See Section 7.3.7, “Line Thickness.” 
• The vector spacing. See Section 11.6, “Vector Spacing.” 

The following attributes are assigned on a frame-by-frame basis, rather than zone-by-zone:

• Vector lengths. See Section 11.5, “Vector Length.” 
• Arrowhead angle and size. See Section 11.4, “Vector Arrowheads.” 
• The optional reference vector. See Section 11.8, “Reference Vectors.” 

11.3. Vector Types
Tecplot allows you to plot vectors of four different types:

• Tail at point: Vectors are drawn with the tail of the vector positioned at the data point, 
which for ordered data is a corner of the cell.

• Head at point: Vectors are drawn with the head of the vector positioned at the data point.

Figure 11-2. A vector plot of the cylinder data.
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11.3. Vector Types

• Anchor at midpoint: Vectors are drawn with the midpoint of the vector positioned at the 
data point.

• Head only: A vector arrowhead (but no tail) is drawn with the head of the arrow centered 
at the data point.

By default, Tecplot uses the “Tail at Point” type. Figure 11-4 shows examples of each of the 
vector plot types.

To modify the vector plot type:

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

2. Display the Vector page, as shown in Figure 11-3.

3. Select the zone or zones for which you want to modify the plot type.

4. Click Vector Type. A drop-down appears listing the available types.

5. Click on the desired type.

To modify the vector type from the Quick Edit dialog:

Figure 11-3. The Vector page of the Zone Style dialog.

Figure 11-4. Vector plot types.
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1. On the sidebar, click Quick Edit, or select Quick Edit... from the Edit menu. The Quick Edit 
dialog appears.

2. In the workspace, use the Selector tool to select the zone or zones for which you want to 
modify the plot type.

3. On the Quick Edit dialog, click on the appropriate button, as follows:

-  Tail at point.

-  Head at point.

-  Anchor at midpoint.

-  Head only.

11.4. Vector Arrowheads
Tecplot allows you a good deal of control over your vector arrowheads. You can control the 
style of the arrowhead, its size, and the angle it makes with the vector. The style of the arrow-
head can change from zone to zone; the size and angle are global attributes affecting vectors in 
all zones.This section explains how to perform these tasks.

11.4.1. Arrowhead Style
You can assign arrowhead styles on a zone-by-zone basis. Tecplot arrowheads come in three 
styles:

• Plain: Line segments drawn from the head of the vector.
• Filled: Filled isosceles triangles with apex at the head of the vector.
• Hollow: Hollow isosceles triangles with apex at the head of the vector.

By default, Tecplot draws plain arrowheads. Figure 11-5 shows an example with all three 
arrowhead styles. 

Figure 11-5. Examples of Tecplot’s three arrowhead styles.
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11.4. Vector Arrowheads

To modify the arrowhead style for a zone or zones:

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

2. Display the Vector page.

3. Select the zone or zones for which you want to modify the arrowhead style.

4. Click Head Style. A drop-down appears containing the available choices.

5. Click on the desired arrowhead style.

or

1. In the workspace, use the Selector tool to select the zone or zones for which you want to 
modify the arrowhead style.

2. On the sidebar, click Quick Edit, or select Quick Edit... from the Edit menu. The Quick Edit 
dialog appears.

3. In the Quick Edit dialog, click on the button for the desired arrowhead style, as follows:

-  Plain arrowhead style.

-  Filled arrowhead style.

-  Hollow arrowhead style.

11.4.2. Arrowhead Size
You can specify arrowhead sizes as either a fraction of the vector length or in frame units (that 
is, as a percentage of the frame height). Arrowhead size is a global attribute; it applies to all 
arrowheads in all zones in the current frame. By default, Tecplot specifies size as a fraction of 
the vector length.

To modify the arrowhead size:

1. Choose Arrowheads from the Vector sub-menu of the Plot menu. The Vector Arrowheads 
dialog appears as shown in Figure 11-6.

2. Select one of the two option buttons in the box labeled Set Size Based On: either Fraction 
of Length or Frame Units (%). 

Figure 11-6. The Vector Arrowheads dialog.
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3. Enter a value in the text field to the right of the selected option button. Use a fraction (a dec-
imal value from zero to one) in the Fraction of Length text field. Use a percentage (a deci-
mal value from zero to 100) in the Frame Units (%) field. Entering a value of zero in either 
field effectively “turns off” the vector arrowhead in the current frame.

11.4.3. Arrowhead Angle
Arrowhead angle is another global attribute; you assign one angle for all vector arrowheads in 
all zones in the current frame. The arrowhead angle is the angle (in degrees) that one side of the 
arrowhead makes with the vector; thus, the apex angle is twice the arrowhead angle. For exam-
ple, to create hollow equilateral triangles as arrowheads, specify an arrowhead angle of 30 glo-
bally in conjunction with an arrowhead style of hollow for all zones.

To specify the arrowhead angle:

1. Choose Vector Arrowheads from the Vector sub-menu of the Plot menu. The Vector Arrow-
heads dialog appears.

2. In the field labeled Angle (deg), either enter a value from 1 to 90, or choose a value from 
the drop-down, indicated by the down-arrow button.

11.5. Vector Length
You can specify the length of vectors in any of three different ways. In the first two, the length 
of any given vector is proportional to the vector magnitude, while in the third, all vectors have 
the same length. The difference between the first two methods is the units used to specify the 
relative size of the vectors, either grid units or screen centimeters. Vector length is a global 
attribute — it applies to all zones in the current frame.

To specify the vector length:

1. Choose Length from the Vector sub-menu of the Plot menu. The Vector Length dialog 
appears as shown in Figure 11-7.

2. Select one of the three option buttons:
- Relative (Grid Units/Magnitude): specify the vector length as the number of grid units 

per unit of vector magnitude.

Figure 11-7. The Vector Length dialog.
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11.6. Vector Spacing

- Relative (Cm/Magnitude): specify the vector length as the number of centimeters per 
unit of vector magnitude.

- Uniform (%): specify the vector length as a percentage of frame height.

3. Enter a value in the text field to the right of the selected option button. For either of the 
“Relative” options, the value you specify is a scale factor which is multiplied by the vector 
magnitude to determine the length of the vector.

By default, Tecplot calculates a reasonable default based on the size of the longest vector. You 
can have Tecplot recalculate this default length by clicking Recalculate Length.

11.6. Vector Spacing
You can draw every vector or specify a skip factor that lets you plot only every nth vector (in I-, 
J-, or K- coordinates). Spacing the drawn vectors is useful in situations where you have an 
extensive vector field, and plotting all the vectors makes the general flow of the vector field dif-
ficult to discern. For example, Figure 11-8 shows the cylinder data with every other vector 
shown in the I direction and every third vector shown in the J direction. Compare this to the 
vector plot shown in Figure 11-2.

To specify the spacing of points for vectors (this also affects point spacing for scatter symbols):

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

2. Display the Points page.

3. Select the zone or zones for which you want to specify the vector spacing.

4. Click Index Skip. A drop-down appears with the options No Skip and Enter Skip. (No Skip 
is the default.)

5. Click on the desired option. If you click on Enter Skip, the Enter Index Skipping dialog 
appears, as shown in Figure 11-9 below.

6. (Enter Skip only) Enter the desired values of I-Skip, J-Skip, and K-Skip. Figure 11-8 was 
created with the following settings: I-Skip=2, J-Skip=3, K-Skip=1.

Figure 11-8. A vector plot with Index Skip specified.
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For irregular and finite-element data, only the I-Skip has an effect, skipping through nodes in 
the order they are listed in the data file.

11.7. Three-Dimensional Vector Plots
To create a 3-D vector plot, simply read a data set into Tecplot, choose the 3D Cartesian plot 
type, and select the Vector check box in the Tecplot sidebar. Three-dimensional vector plots 
require three vector components, U, V, and W, for the three axes X, Y, and Z. The Select Vari-
ables dialog appears asking you to specify vector variables.

11.7.1. Tangent Vectors
In 3D Cartesian plots, Tecplot allows you to display 3-D surface tangent vectors. These are 3-
D vectors that have been projected onto the 3-D surface; in other words, the component of the 
3-D vectors normal to the surface is removed, leaving only the component parallel to the sur-
face. Figure 11-10 shows how tangent vectors compare to regular vectors.

To select tangent vectors for a zone:

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

2. Display the Vector page.

3. Select the zone or zones for which you want to draw tangent vectors.

Figure 11-9. The Enter Index Skipping dialog.

Vectors TangentVectors not Tangent

Figure 11-10. Regular vectors compared to tangent vectors.



229

11.8. Reference Vectors

4. Click Vect Tang. A drop-down appears with the choices Yes and No.

5. Click Yes.

Tangent vectors are drawn on 3-D surfaces only where it is possible to determine a vector 
normal to the surface. A plot where multiple surfaces intersect each other using common nodes 
is a case where tangent vectors are not drawn because there is more than one normal to choose 
from. An example of this would be a volume IJK-ordered zone where both the I- and J-planes 
are plotted. If tangent vectors cannot be drawn then regular vectors are plotted instead.

11.7.2. Three-Dimensional Vector Lengths
Since 3-D vectors are plotted in the plane of the screen, a 3-D vector’s length will depend on 
both the vector length settings and the orientation of the vector. The length may be distorted 
even further if the vector length setting is Relative and the 3-D projection is Perspective.

11.8. Reference Vectors
A reference vector is a vector of specified magnitude placed on the plot as a measure against all 
other vectors. You can specify whether to show a reference vector, and if so, its color, orienta-
tion, line thickness, magnitude, and position.

To display a reference vector:

1. From the Vector sub-menu of the Plot menu, choose Reference Vector. The Reference Vec-
tor dialog appears as shown in Figure 11-11.

2. Select the Show Reference Vector check box.

Figure 11-11. The Reference Vector dialog.
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3. Modify any of the following options, as desired:
- Origin (%): Enter the coordinates of the starting point of the reference vector, as a per-

centage of the frame width (X) and frame height (Y).
- Color: Choose a color from the Select Color dialog. Multi-color and RGB coloring are 

not available.
- Angle (deg): Enter the orientation of the vector in degrees from horizontal, or choose a 

value from the drop-down.
- Line Thickness (%): Enter the desired line thickness or choose a value from the drop-

down.
- Magnitude: Enter the magnitude of the reference vector. The units correspond to those 

of the vector components.

4. If you want the magnitude of the reference vector labeled, select the Include Magnitude 
Label toggle and modify any of the following options:
- Text Color: Choose a color from the Select Color dialog. Multi-color and RGB coloring 

are not available.
- Font: Click the button to choose the font typeface and size from the Select Font dialog, 

or lick the up and down arrows to adjust the size alone.
- Number Format: Click the button to specify how the number will be formatted. See 

17.5.2.2. “Tick Mark Label Formats” on page 310 for a discussion of this dialog.
- Offset: Choose the spacing between the label and the reference vector as a percentage of 

frame height.

5. Click OK to close the dialog.

Figure 11-12 shows a plot with a reference vector.

Figure 11-12. Vector plot with reference vector.
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CHAPTER 12 Streamtraces

A streamtrace is the path traced by a massless particle placed at an arbitrary location in a 
steady-state vector field. Tecplot’s streamtrace features may be used to illustrate the nature of 
the vector field flow in a particular region of the plot.

Because streamtraces are dependent upon a vector field, you must define vector components 
before creating streamtraces in Tecplot. You do not, however, have to activate the Vector zone 
layer. You may place streamtraces on any of Tecplot’s field layers, or even on bare axes.

There are two main categories of streamtraces:

• Surface line streamtraces, or streamlines.
• Volume streamtraces.

Surface streamtraces are confined to the surface on which they are placed. They can only be 
placed in zones displayed as a 2- or 3-D surface. If you try to place streamlines in a zone dis-
played as a 3-D volume, an error dialog appears, and no streamlines are drawn.

Volume streamtraces can be created only in 3-D volume zones (IJK-ordered or FE-volume 
zones). Volume streamtraces themselves fall into three categories:

• Volume Lines, or volume streamlines.
• Volume Ribbons, or streamribbons.
• Volume Rods, or streamrods.

You can add streamtraces to your plot either singly or in a rake, which is a set of streamtraces 
with starting positions along a defined line. Once the rake is added, the individual streamtraces 
of the rake are identical to singly placed streamtraces.

12.1. Surface Streamlines
Surface streamlines include all 2-D streamtraces and 3-D surface streamtraces, which are con-
fined to the surface on which they are placed. You can place streamlines one at a time, or in 
groups called rakes. A streamline rake is a set of streamlines with starting points along a given 
line.

You can place streamlines and streamline rakes using either the mouse or the Streamtrace 
Details dialog. The mouse enables you to place streamtraces quickly, but the Streamtrace 
Details dialog gives you precise control over the starting points.
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To create a streamline or streamline rake using the mouse:

1. On the sidebar, choose the Place Streamtrace tool, represented by .

2. If you have not already assigned vector components you will be prompted for them.

3. Move the pointer into the workspace. The pointer changes to a cross-hair.

4. To place a single streamline, click at the desired starting point for the streamline, or Ctrl-
click to begin the streamline at the data point nearest to the cross-hair.

5. To create a rake of streamlines, click-and-drag from one end point of the desired rake start-
ing line to the other, then release. 

Before placing streamlines, you can change the streamtrace direction or the number of 
streamtraces per rake using the Streamtrace Details dialog as discussed below.

To create a streamline or rake of streamlines using the Streamtrace Details dialog:

1. From the Plot menu, choose Streamtraces. If you have not yet assigned vector components 
for the current plot type, the Vector Variables dialog appears for you to assign them. Other-
wise, the Position page of the Streamtrace Details dialog appears, as shown in Figure 12-1. 

2. Choose a direction for the streamline integration from the Direction drop-down:
- Forward: The streamline is calculated downstream, that is, in the direction of the flow.
- Backward: The streamline is calculated upstream, that is, against the flow.
- Both: Both the forward and backward streamlines are calculated.

No matter which direction is chosen for the integration, the arrowheads still point in the for-
ward, “downstream” direction.

Figure 12-1. The Streamtrace Placement dialog.
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12.2. Volume Streamtraces

3. In the remainder of the Position page, select either the Use IJK or Use XYZ option. (Use 
XYZ is the default). If you select Use IJK, also pick a zone from the drop-down labeled 
Zone.

If you select Use IJK, the fields under Start Position and Rake End Position are labeled I, J, 
and K. Otherwise, they are labeled X, Y, and Z.

4. Enter the starting position by specifying either a set of IJK-indices or XYZ-coordinates. For 
finite-element zones, only enter I. The J and K fields will not be available.

5. To place a single streamline, click Place Streamtrace(s).

To place a rake of streamlines, select the Enter Rake Positions check box and enter the end 
positions for the rake as either a set of IJK indices or XYZ-coordinates. Then click Place 
Streamtrace(s). By default, Tecplot draws ten streamlines per rake. To change this, enter a 
new value in the Streams per Rake field.

Streamtraces will be terminated at the edge of any cell which is all or partially value-
blanked.

Figure 12-2 shows some surface line streamtraces and a streamtrace rake on the cylinder data.

12.2. Volume Streamtraces
You can place volume streamtraces using either the mouse or the Streamtrace Details dialog. 
The mouse enables you to place streamtraces quickly, but the Streamtrace Details dialog gives 
you precise control over the starting points.

Volume streamtraces may only be drawn in 3-D volume zones so you must have at least one 
volume zone active. It does not matter what plot style you choose for the zone, but you must 
choose a setting that includes streamtraces on the Volume page of the Zone Style dialog. The 
default is to allow streamtraces to be drawn in all zones.

There are a number of different ways to place volume streamtraces. It is best to have some 
knowledge of the general direction of flow for the velocity field in the zones, so that you may 
place your streamtraces in a location of interest. Often it is a good idea to start streamtraces 
from somewhere within the volume, as opposed to starting on the outer surface of the volume. 
One of the best ways to start a volume streamtrace is to create a slice through the volume, then 

Figure 12-2. Surface line streamtraces and a streamtrace rake.
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place the streamtrace starting position on the slice. A slice through a volume zone and a rake of 
streamtraces starting from the slice is shown in Figure 12-3.

To place volume streamtraces on a slice perform the following steps:

1. Add a slice plane to your volume zone using the Slice tool  from the sidebar. Click on 
the volume zone to add a slice. You may press I, J, K, X, Y, or Z on your keyboard first to 
orient the slice in one of the constant I-, J-, K-, X-, Y-, or Z-planes.

2. Click on the Place Streamtrace tool  on the sidebar.

3. Press D on your keyboard to create streamrods, R for streamribbons, or V to create volume 
streamlines. You may also choose streamtrace types using the Streamtrace Details dialog 
from the Plot menu.

4. Place a single streamtrace by holding down Alt on your keyboard while clicking on the 
slice, or place a rake of streamtraces by holding down Alt and clicking-and-dragging. Alt 
will make sidebar tools operate on any objects except for zones, which in this case is the 
slice.

5. If you want to place streamtraces starting on the outer boundary of your zone, perform steps 
2, 3, and 4 without holding down Alt.

Figure 12-3. A slice through a volume zone with a rake of streamlines starting         
from the slice.
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12.3. Streamtrace Plot Appearance

To create a volume streamtrace or a rake of volume streamtraces using the Streamtrace Details 
dialog:

1. From the Plot menu, choose Streamtraces. If you have not yet assigned vector components 
for the 3D Cartesian plot type, the Vector Variables dialog appears for you to assign vector 
components. Otherwise, the Position page of the Streamtrace Details dialog appears, as 
shown in Figure 12-1.

2. Choose a format for the streamtrace from the drop-down labeled Format. You can choose 
Surface Line, Volume Line, Volume Ribbon, or Volume Rod. The default is Volume Line 
for 3-D volume zones, and Surface Line for all other zones.

3. Choose a direction for the streamtrace integration from the Direction drop-down:
- Forward: The streamtrace is calculated “downstream,” that is, in the direction of the 

flow.
- Backward: The streamtrace is calculated “upstream,” that is, against the flow.
- Both: Both the forward and backward streamtraces are calculated. You should use this 

only for surface and volume lines. For ribbons and rods, Tecplot always integrates 
one step from the starting position before actually plotting or extracting the 
streamtrace.

No matter which direction is chosen for the integration, the arrowheads still point in the for-
ward, “downstream” direction.

4.  Select either the Use IJK or Use XYZ option. (Use XYZ is the default). If you select Use 
IJK, also pick a zone from the drop-down labeled Zone. If you select Use IJK, the fields 
under Start Position and Rake End Position are labeled I, J, and K. Otherwise, they are 
labeled X, Y, and Z.

5. Enter the starting position by specifying either a set of IJK-indices or XYZ-coordinates.

6. To place a single streamtrace, click Place Streamtrace(s). To place a rake of streamtraces, 
select the Enter Rake Positions check box and enter the end positions for the rake as either 
a set of IJK-indices or XYZ-coordinates. Then click Place Streamtrace(s). By default, Tec-
plot draws ten streamtraces per rake. To change this, enter a new value in the Streams per 
Rake field.

Figure 12-4 shows several examples of volume streamtraces.

12.3. Streamtrace Plot Appearance
You can control the style of your streamtraces using the Streamtrace Details dialog. These style 
attributes affect all streamtraces in the current frame, including those already placed. They do 
not affect extracted streamtrace zones, discussed in Section 12.7, “Streamtrace Extraction as 
Zones,” because these are now ordinary ordered zones, not streamtraces at all.

12.3.1. Streamlines

The following attributes may be set with the Line page of the Streamtrace Details dialog, 
shown in Figure 12-5.
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• Whether streamtraces are displayed: Select the Show Streamtraces check box if you 
want streamtraces drawn on your plot. By default, this check box is selected.

• Line Color: Enter the color for all streamtraces. You may set the color to Multi-Color to 
color the streamtraces by the chosen contour group variable in the same manner as color 
flooding. (If the contour variable is not currently defined, the Contour Variable dialog 
appears so that you can define it.) You can use the Multi-Color option, for example, to color 
the streamtraces by the local temperature or by the velocity magnitude. You can also spec-
ify RGB coloring.

Figure 12-4. Volume streamlines, volume ribbons, and volume rods.

Figure 12-5. The Line page of the Streamtrace Details dialog in Motif.
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12.3. Streamtrace Plot Appearance

The following attributes affect surface and volume streamlines only:

• Line Thickness: Either enter a value for the streamline thickness (as a percentage of the 
frame height for 2-D lines and as a percentage of the median axis length for 3-D surface 
lines and volume lines), or choose a pre-set value from the drop-down.

• Arrows: Select the Show Arrowheads on Lines check box to display arrowheads along all 
streamlines (surface and volume) in the current frame. Arrows are not shown on volume 
ribbons or volume rods. You can also control the following attributes of the displayed 
arrows:
-   Arrowhead Size: Either enter a value for the arrowhead size (as a percentage of the 

frame height), or choose a pre-set value from the drop-down.
-   Arrowhead Spacing: Enter the distance between arrowheads in terms of Y-frame 

units. A value of ten percent will space arrowheads approximately ten percent of the 
frame height apart from each other along each streamline.

12.3.2. Streamrods and Streamribbons
The following attributes may be set with the Rod/Ribbon page of the Streamtrace Details dia-
log, shown in Figure 12-6. They affect volume ribbons and volume rods only:

• Rod/Ribbon Width: Enter a width for the volume ribbons and volume rods. The width is 
expressed in grid units. If you want two sets of streamtraces with different widths, you must 
create one set and then extract them as zones, then configure a new set of streamtraces with 
the second width.

• Rod Points: Volume rods have a polygonal cross-section; this parameter tells Tecplot what 
that cross-section should be. Three is an equilateral triangle; four is a square; five, a regular 
pentagon; and so on. If you want two sets of volume rods with different cross-sections, you 
must create one set and then extract them as zones, then configure a new set of streamtraces 
with the second cross-section.

• Show Mesh: Select this check box to display a mesh.

Figure 12-6. The Rod/Ribbon page of the Streamtrace Details dialog in Motif.
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• Mesh Color: Select a mesh color from the drop-down, or choose a custom color or multi-
color.

• Mesh Line Thickness: Select a line thickness from the drop-down, or enter your own 
number in the text field.

• Show Contour Flood: Select this check box to display contour flooding. 
• Flood by: Select the contour group by which to flood.
• Show Shade: Select this check box to display shading.
• Shade Color: Select a shade color from the Select Color dialog. Multi-Color and RGB col-

oring are not available—use contour flooding instead.
• Use Lighting Effect: Select this check box to enable the lighting effect drop-down where 

you may choose Paneled or Gouraud shading.
• Use Surface Translucency: Select this check box to enable the surface translucency text 

field, where you may set the surface translucency from one (opaque) to 99 (translucent).

12.4. Streamtrace Deletion
You can delete streamtraces, either individually or in groups, by first selecting them and then 
either pressing Delete or choosing Clear from the Edit menu. You may delete all streamtraces 
at once by clicking Delete All on the Position page of the Streamtrace Details dialog. You may 
delete the last streamtrace placed by clicking Delete Last on this page.

12.5. Streamtrace Termination Lines
A streamtrace termination line is a polyline that terminates any streamtraces that cross it. The 
termination line is useful for stopping streamtraces before they spiral or stall. If a streamtrace 
and the termination line intersect on the screen, the streamtrace is considered to cross the ter-
mination line. This is true for volume streamtraces within a 3-D volume zone as well as for 
surface streamlines. Figure 12-7 shows the cylinder data with some streamtraces terminated 
with a 2-D streamtrace termination line.

Figure 12-7. Surface streamlines and 2-D termination line.
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12.5. Streamtrace Termination Lines

Streamtraces are also terminated whenever any of the following occur:

• The maximum number of integration steps is reached.
• Any point in the streamtrace passes outside the available data.
• The streamtrace enters a cell for which the velocity magnitude is zero.

For more details, see Section 12.8, “Streamtrace Integration.” 

12.5.1. Termination Line Creation

To add a streamtrace termination line:

1. From the sidebar, choose the Add Streamtrace Termination Line tool, represented by the 

 button, or from the Term Line page of the Streamtrace Details dialog, click Draw 
Stream Term Line.

2. Move the pointer into the workspace. The pointer becomes a cross-hair.

3. Click at the desired starting point for the termination line, then click at additional points to 
define the desired polyline. 

4. To end the termination line, press Esc or select another tool from the sidebar.

Only one termination line can exist at any one time in a given frame. If you draw a second ter-
mination line, the first is automatically deleted.

In 2D Cartesian plots, the termination line is drawn in the grid coordinate system and moves 
with the data as you zoom and translate. In 3D Cartesian plots, unlike most Tecplot objects, the 
termination line is drawn in the eye coordinate system, which is essentially the plane of your 
computer screen. This coordinate system also moves with the data as you zoom and translate. 
If you rotate a 3-D data set after drawing a streamtrace termination line, streamtraces previ-
ously terminated by the termination line may be terminated at different places, or not termi-
nated at all if the rotated streamtrace no longer intersects the termination line.  Figure 12-8 
shows a 3-D volume plot with streamribbons and a streamtrace termination line, and how the 
termination points vary as the plot is rotated. Notice that the termination line itself remains in 
place on the screen as the plot is rotated.

12.5.2. Termination Line Controls
You control the streamtrace termination line from the Term Line page of the Streamtrace 
Details dialog, shown in Figure 12-9.

From the Term Line page, you can control the following attributes of the termination line:

• Active: If the Active Termination Line check box is selected, the termination line is active, 
and any streamtraces that cross it are terminated. You can deselect the check box and 
redraw the plot to view the unterminated streamtraces.
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• Shown: If the Show Termination Line check box is selected, the termination line is dis-
played. You can deselect the check box and redraw the plot so that only the terminated 
streamtraces are displayed, not the termination line.

• The color, line pattern, pattern length, and line thickness of the termination line.

You can select a termination line with the Selector or Adjustor tool. This allows you to interac-
tively move the line (with the Selector), modify the line (with the Adjustor), or delete the line 
(with either tool).

Figure 12-8. Terminating volume streamtraces with a termination line.

Figure 12-9. The Term Line page of the Streamtrace Details dialog.
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12.6. Streamtrace Timing

12.6. Streamtrace Timing
Stream markers are symbols plotted along streamtrace paths to identify the positions of parti-
cles at certain times. Streamtrace dashes are another means of indicating the passage of time by 
causing a streamtrace to be “on” for a time interval, then “off” for another time interval. 

Figure 12-10 shows a plot with both streamtrace markers and dashes.

12.6.1. Stream Markers

Stream markers are drawn at timed locations along streamlines. The spacing between stream 
markers is proportional to the magnitude of the local vector field—that is, it is large in regions 
where the local magnitude is large, small in regions where the local magnitude is small. You 
can adjust the spacing between stream markers by specifying the time interval, or delta, 
between stream markers. Increasing the delta time will increase the space between stream 
markers and vice versa. The actual spacing is the product of the local vector magnitude and the 
specified delta.

You may also select the shape of your stream marker using the pre-set list under the Shape 
drop-down. Selecting Other from the list activates the Enter ASCII Character option. Clicking 
this will call up the Enter ASCII Character dialog, where you may enter an ASCII character to 
be used as your stream marker.

Figure 12-10. Streamtrace markers (top), dashes (bottom), and both (middle).
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Stream markers are available only for streamlines (surface and volume); they are not available 
for volume ribbons or volume rods.

To place stream markers along your streamtraces:

1. From the Plot menu, choose Streamtraces. The Streamtrace Details dialog appears.

2. Click Timing (Timing tab in Windows). The Timing page of the Streamtrace Details dialog 
appears, as shown in Figure 12-11.

3. Select the check box labeled Show Markers. The three fields immediately below Show 
Markers become active, as do the fields grouped under the heading Timing.

4. Specify the size, color, and shape of the markers in the fields provided. For more informa-
tion on marker shapes see Section 13.3. “Scatter Symbols” on page 248.

5. Specify the timing for the stream markers by entering values in the following fields:
- Start Time: Enter the time at which the first marker is drawn. A start time of zero means 

that the first marker is drawn at the starting point. A start time of 2.5 means that the 
first stream marker is drawn 2.5 time units downstream of the starting point.

- End Time: Enter the time after which no more stream markers are drawn.
- Delta Time: Enter the time interval which measures the time between stream markers. 

The actual distance between markers is the product of this number and the local vec-
tor magnitude.

6. On the sidebar, click Redraw to see the stream markers on existing streamlines; subsequent 
streamlines are drawn automatically.

12.6.2. Stream Dashes

Stream dashes, unlike stream markers, are not restricted to streamlines; you can also apply 
stream dashes to volume ribbons and volume rods. A stream dash shows the streamtrace with a 

Figure 12-11. The Timing page of the Streamtrace Details dialog.
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12.7. Streamtrace Extraction as Zones

dashed line pattern. The streamtrace is “on” for a time interval, then “off” for a time interval, 
then “on” again, and so on. The lengths of the dashes and the spaces between them are con-
trolled by the same time delta used for stream markers.

To use stream dashes:

1. From the Plot menu, choose Streamtraces. The Streamtrace Details dialog appears. 

2. Click Timing (Timing tab in Windows). The Timing page of the Streamtrace Details dialog 
appears, as shown in Figure 12-11.

3. Select the check box labeled Show Dashes. The Dash Skip field immediately below Show 
Dashes becomes sensitive, as do the fields grouped under the heading Timing.

4. Enter the dash skip factor, which controls the number of time deltas used for the “off” sec-
tions of the streamtraces. Using a dash skip factor of one produces an on-off-on-off pattern. 
A skip factor of two produces an on-off-off-on-off-off pattern. The actual lengths of the 
dashes are computed as the product of the delta time and the local vector magnitude.

5. Specify the timing for the stream dashes by entering values in the following fields:
-   Start Time: Enter the time at which the first dash is drawn. A start time of zero means 

that the first dash is drawn at the starting point. A start time of 2.5 means that the first 
stream dash is drawn 2.5 time units downstream of the starting point.

- End Time: Enter the time after which no more stream dashes are drawn.
-   Delta Time: Enter the time interval which controls the length of the dashes. The actual 

dash length is the product of this number and the local vector magnitude.

6. Click Redraw on the sidebar to see the stream dashes on existing streamtraces; subsequent 
streamtraces are drawn automatically.

12.7. Streamtrace Extraction as Zones
In Tecplot you should be able to assign any style you desire to streamtraces without further 
processing. Temporary streamtrace objects are created and drawn just like zones. However, if 
you need to make permanent objects from streamtraces you may extract them to zones.

To extract your streamtraces as zones:

1. Create a plot containing streamtraces. You may (if your data includes any 3-D volume 
zones) use multiple streamtrace formats.

2. From the Data menu, choose Extract, then choose Streamtraces. The Extract Streamtraces 
dialog appears, containing the single check box Concatenate Common Streamtraces into 
One Zone.

3. If you want all streamtraces of a given format extracted to a single zone, select the check 
box labeled Concatenate Common Streamtraces into One Zone. If you select this check 
box, Tecplot extracts all surface lines into one zone, all volume lines into another, all vol-
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ume ribbons into a third, and all volume rods into a fourth. Tecplot uses value-blanking to 
blank out the intervals between streamtraces (and between stream dashes). This is dis-
cussed more fully later in this section.

4. If you do not select the check box, each streamtrace is extracted into its own zone.

5. Click Extract to extract the streamtraces to zones. A Working dialog appears while the 
extraction is proceeding; click Cancel to interrupt the extraction.

Once you have created these new zones, you may treat them as any other zone, and by default, 
that is what Tecplot does. If you have a mesh plot, you will see the mesh of your original data 
plotted with the mesh for each of the new zones. You will also see the original streamtraces, 
which may obscure the plotted streamtrace zones. Once you have extracted the zones, you can 
delete the original streamtraces by clicking Delete All Streamtraces in the Streamtrace Details 
dialog. Figure 12-12 shows some extracted volume ribbon zones, with the original 
streamtraces deleted.

If timed dashes are active, all extracted streamtraces will be finite-element zones. Otherwise, 
all extracted streamline zones are I-ordered, and extracted volume ribbon and volume rod 
zones are IJ-ordered.

12.8. Streamtrace Integration
Tecplot uses a predictor-corrector integration algorithm to calculate streamtraces. The basic 
idea is to create the streamtrace by moving in a series of small steps from the starting point in 
the direction of, or in opposition to, the local vector field. Each step is only a fraction of a cell 
or element. Tecplot automatically adjusts the step size based on the local cell shape and vector 
field variation.

Figure 12-12. Extracted volume ribbons.
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12.8. Streamtrace Integration

You can control the streamtrace integration by modifying the following parameters in the Inte-
gration page of the Streamtrace Details dialog, shown in Figure 12-13:

• Step Size: Enter the initial and maximum step size Tecplot uses while integrating through 
the vector field, as a decimal fraction of the local cell or element width. A typical value 
(and the default) is 0.25, which results in four integration steps through each cell or ele-
ment. The value for Step Size affects the accuracy of the integration. Setting Step Size too 
small can result in round-off errors, while setting it too large can result in errors due to 
missed cells.

• Max Steps: Enter the maximum number of steps before the streamtrace is terminated. This 
prevents streamtraces from spinning forever in a vortex, or from wandering aimlessly in a 
region where the vector components are very small, very random, or both. If you choose a 
small Step Size, you should enter a larger Max Steps.

• Minimum Step Size: The smallest step size for Tecplot to use. Setting this too small results 
in integration problems. Setting this greater than or equal to the Step Size results in a con-
stant step size.

During the integration, a streamtrace is terminated if any of the following conditions occur:

• The maximum number of integration steps (Max Steps) have been taken.
• Any point in the streamtrace passes outside the available data. This is a particular concern 

with volume ribbons: a volume ribbon with a large width may terminate when one edge 
passes outside the vector field, even though the center is within the field. You can avoid this 
problem by entering a smaller Ribbon/Rod Width on the Rod/Ribbon page of the 
Streamtrace Details dialog.

• The streamtrace enters a cell for which the velocity magnitude is zero.
• The streamtrace crosses the stream termination line.

Streamtraces may terminate at a zone boundary even if there is an adjacent zone into which the 
streamtraces should proceed. This can happen if there is a small gap between the zones. Speci-

Figure 12-13. The Integration page of Streamtrace Details dialog.
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fying face neighbors in the data file to connect the zones can alleviate this problem. increasing 
the minimum integration step size can also eliminate this problem.
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CHAPTER 13 Scatter Plots

Scatter plots are plots of symbols at the data points in a field. The symbols may be sized 
according to the values of a specified variable, colored by the values of the contour variable, or 
may be uniformly sized or colored. Unlike contour plots, scatter plots do not require any mesh 
structure connecting the points, allowing you to make scatter plots of irregular data.

13.1. Scatter Plot Creation
A 2-D scatter plot plots the position of the Y-variable against the position of the X-variable. 
Thus, it is a representation of the location of data points in the 2-D field. Thought of somewhat 
differently, the scatter plot is a plot of the vertices of an ordered mesh or the nodes of a finite-
element mesh.

To create a scatter plot in Tecplot, you activate the Scatter layer (and deactivate any active 
layers that you do not want to appear). For example, to create the scatter plot shown in 
Figure 13-1, do the following:

1. Read in the data file simpscat.plt from your Tecplot examples/dat directory. (If 
you currently have a data set in your Tecplot frame, choose to replace the data set and reset 
the frame style.)

Figure 13-1. A scatter plot.
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2. From the sidebar, select the Scatter check box and deselect the Mesh check box (and any 
other active layer check box).

13.2. Scatter Plot Modification
Once you have read in your data, you can modify your scatter plot attributes using either the 
Scatter page of the Zone Style dialog or the Quick Edit dialog. You can control any of the fol-
lowing attributes from the Scatter page of the Zone Style dialog, shown in Figure 13-2:

• Which zones are active. See Section 7.3.2, “Zone Display.” 
• Whether the scatter symbols are visible for each active zone. See Section 7.3.3, “Zone 

Layer Display.” 
• The scatter symbol shape. See Section 13.3, “Scatter Symbols.” 
• The scatter outline color. See Section 13.4.1, “Outline Colors.” 
• The scatter fill color. See Section 13.4.2, “Filled Symbols and Fill Colors.” 
• The scatter symbol size. See Section 13.5, “Scatter Symbol Sizes and Fonts.” 
• The scatter line thickness. See Section 7.3.7, “Line Thickness.” 
• The scatter symbol spacing (Index Skip). See Section 13.6, “Symbol Spacing.” 

The following scatter attributes are assigned on a frame-by-frame basis:

• The scatter-size variable. See Section 13.5, “Scatter Symbol Sizes and Fonts.” 
• The optional reference scatter symbol. See Section 13.5.4, “Reference Scatter Symbols.” 
• The scatter legend. See Section 13.7, “Scatter Legends.” 

13.3. Scatter Symbols
By default, Tecplot uses outlined squares for the scatter symbols. You can choose a different 
scatter symbol for each zone from any of Tecplot’s seven predefined scatter symbols, or any 
printable character in any of Tecplot’s four character sets. You can change the scatter symbol 
either from the Scatter page of the Zone Style dialog or from the Quick Edit dialog.

To choose a scatter symbol:

1. Go to the Scatter page of the Zone Style dialog, as shown in Figure 13-2.

2. Select the zone or zones for which you want to choose a scatter symbol.

3. Click Symbol Shape. A drop-down appears listing predefined scatter symbols together with 
an Other option. Figure 13-3 shows the predefined scatter shapes from the Quick Edit dia-
log. The options include:

- Square: Plot with square plotting symbols.

- Delta: Plot with upward pointing equilateral triangles.

- Gradient: Plot with downward pointing equilateral triangles.

- Right Triangle: Plot with rightward pointing equilateral triangles.
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13.3. Scatter Symbols

- Left Triangle: Plot with leftward pointing equilateral triangles.

- Diamond: Plot with diamonds.

- Circle: Plot with circles.

- Point: Plot as points, always one pixel on screen and in exported images.

- Cube: Plot as cubes in a 3-D; reduced to Square for 2-D plots.

- Sphere: Plot as spheres in a 3-D; reduced to Circle for 2-D plots.

- Octahedron: Plot as octahedrons in a 3-D; reduced to Diamond for 2-D plots.

- Other: Plot with a specified ASCII character.

Spheres, Cubes, and Octahedrons are always light-source shaded. Spheres are Gouraud 
shaded, and Cubes and Octahedrons are Panel shaded. Cube edges are aligned with X-, Y-, 
and Z-axes. Octahedrons are oriented so one vertex points in the Z-direction and one vertex 
points in the X-direction. For best appearance of 3-D shapes, adjust the Light Source and 
use Specular Highlighting.

4. Click on the desired symbol shape. If you click on Other, the Enter ASCII Character dialog 
appears, as shown in Figure 13-4.

5. (Other option only) Enter a character to use as a symbol, and then specify the Tecplot char-
acter set from which to obtain the symbol: Base (the Courier, Helvetica and Times fonts are 
collectively referred to as English fonts), Greek, Math, or User Defined. Click OK to dis-
miss the Enter ASCII Character dialog.

Figure 13-2. The Scatter page of the Zone Style dialog.

Figure 13-3. Pre-defined scatter symbols of the Quick Edit dialog.
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To choose a scatter symbol from the Quick Edit dialog:

1. In the workspace, select the zone or zones for which you want to choose a scatter symbol.

2. On the sidebar, click on Quick Edit to call up the Quick Edit dialog.

3. In the Quick Edit dialog, click on the button for the desired symbol shape, as follows:

-  Plot with square plotting symbols (Square).

-  Plot with upward pointing equilateral triangles (Delta).

-  Plot with downward pointing equilateral triangles (Gradient).

-  Plot with rightward pointing equilateral triangles (Right Triangle).

-  Plot with leftward pointing equilateral triangles (Left Triangle).

-  Plot with diamonds (Diamond).

-  Plot with circles (Circle).

-  Plot with a specified ASCII character from one of Tecplot’s four character sets 
(Other). When you select this option, the Enter ASCII Character dialog appears.

4. (  option only) Enter a character to use as a symbol, and then specify the Tecplot char-
acter set from which to obtain the symbol: Base (English Font), Greek, Math, or User 
Defined. Click OK to close the Enter ASCII Character dialog.

Figure 13-4. The Enter ASCII Character dialog.
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13.4. Symbol Color

13.4. Symbol Color
By default, scatter symbols are drawn as outlined symbols, that is, unfilled geometric shapes in 
a single color. You control the basic color by choosing an outline color for each zone’s scatter 
symbols. For 2-D symbols, you can also choose a fill mode for a zone’s symbols, and specify a 
fill color. (If you fill a symbol chosen from the ASCII character set, you obtain a filled rectan-
gle with the character drawn inside in the outline color; the perimeter of the box is also drawn 
in the outline color.)

For both outline and fill color, available options allow you to choose on of the Multi-Color 
contour groups or RGB coloring. See Section 10.2.1, “Contour Variable Selection,” for infor-
mation about multi-color options.

13.4.1. Outline Colors
For unfilled scatter symbols, the outline color is simply the symbol color. You can specify a 
different outline color for each zone using either the Scatter page of the Zone Style dialog or 
the Quick Edit dialog.

To specify an outline color:

1. Choose the Scatter page of the Zone Style dialog.

2. Select the zone or zones for which you want to choose an outline color.

3. Click Outline Color. A dialog appears listing Tecplot’s basic colors together with a multi-
color option.

4. Click on the desired color or option.

or

1. On the sidebar, click on Quick Edit to call up the Quick Edit dialog.

2. In the workspace, select the zone or zones for which you want to choose a scatter symbol.

3. On the Quick Edit dialog, click Line, then click Color. On the Select Color dialog, choose 
the desired option. If your symbols are filled, click X to make the line color match the cur-
rent fill color.

If you select the Multi-Color contour group option, each plotting symbol is colored according 
to the value of the selected contour variable at that data point. If no contour variable is cur-
rently assigned, the Contour Details dialog appears with the default contour variable assign-
ment. You can either accept the default or choose a new contour variable.

If you select the RGB coloring option, each plotting symbol is colored according to the values 
at that data point for the variables assigned to RGB. If no variables are currently assigned, the 
Select Variables dialog appears with the default variable assignments. You can either accept 
the default or choose new variables.
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13.4.2. Filled Symbols and Fill Colors
The 3-D symbol shapes, Cube, Sphere, and Octahedron, are filled with the line color, but the 
other shapes have several optional fill modes. Symbols may be unfilled, filled with the back-
ground color or the outline color, or filled with a chosen color.

To control filling of a zone’s scatter symbols:

1. Go to the Scatter page of the Zone Style dialog.

2. Select the zone or zones for which you want to specify filled or unfilled symbols.

3. Click Fill Mode; the drop-down options are:

- None: Lines or objects behind each symbol are seen.

- Use Line Color: Symbols are filled with the outline color.

- Use Back Color: Symbols are filled with the color of the frame background. No objects 
or lines behind them appear.

- Use Specific Color: Default fill color is white.

4. 4. Choose the desired mode. You can change Specific Color using the Fill Color button. 

You can optionally control whether a zone’s scatter symbols are filled, and if so, what color 
they are filled with, using the Quick Edit dialog.

1. On the sidebar, click Quick Edit to call up the Quick Edit dialog.

2. In the workspace, select the zone or zones for which you want to specify filled or unfilled 
symbols.

3. On the Quick Edit dialog, click on the  button for unfilled symbols; click on  for 
filled symbols. If you choose filled symbols and want them filled with a color other than 
the default white, you should also specify a fill color.

4. With Fill selected, click Color and choose a color or Multi-color option. You can click on X 
to turn off fill.

13.5. Scatter Symbol Sizes and Fonts
You can have Tecplot draw each zone’s scatter symbols at a specified size, or you can size each 
scatter symbol according to the value of a specified variable at that point. To specify fixed-size 
scatter symbols, you can use either the Scatter page of the Zone Style dialog, or Quick Edit dia-
log. To specify variable-size scatter symbols, you must use the Zone Style dialog.

13.5.1. Symbol Sizes

To specify a fixed symbol size:

1. Go to the Scatter page of the Zone Style dialog.

2. Select the zone or zones for which you want to specify the symbol size.
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13.5. Scatter Symbol Sizes and Fonts

3. Click Scat Size. A drop-down appears listing five preset options, an Enter option, and a 
Size by Variable option. Click the appropriate option.

4. If you click Enter, the Enter Value dialog appears. Enter a percentage of the frame height in 
the Enter Value dialog.

5. If you click Size by Variable, the Scatter Size/Font dialog appears asking you to choose a 
scatter-sizing variable. (See Section 13.5.2, “Variable Symbol Sizes,” for complete instruc-
tions for sizing scatter symbols by variable.) From the Scatter Size Variable drop-down, 
choose the variable you want to use to size the scatter symbols. Specify a size multiplier by 
selecting one of the two options labeled Grid Units/Magnitude or Cm/Magnitude, then 
enter a value in the text field. The Scatter Size/Font dialog is shown in Figure 13-5.

For fixed size only:

1. On the sidebar, click Quick Edit to call up the Quick Edit dialog.

2. In the workspace, select the zone or zones for which you want to specify the symbol size.

3. On the Quick Edit dialog, click Size to the right of the Scatter Symbol buttons. A drop-
down appears listing five preset options and an Enter option.

4. Click on the desired option.

5. If you click Enter, the Enter Value dialog appears. Enter a percentage of the frame height in 
the Enter Value dialog.

A sample scatter plot sized by a variable is shown in Figure 13-6.

13.5.2. Variable Symbol Sizes
When you choose Size by Variable for scatter plots, Tecplot multiplies the value of the scatter-
size variable at each point by a specified multiplier to determine the actual size of the plotting 
symbol. You can modify this multiplier from the Scatter Size/Font dialog. You can also change 
the variable used for sizing, or the base font used for ASCII character symbols.

Figure 13-5. The Scatter Size/Font dialog.
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To modify the settings:

1. Choose Scatter Size/Font from the Scatter sub-menu of the Plot menu. The Scatter Size/
Font dialog appears.

2. Select Base Font for ASCII Symbols and choose the desired font.

3. If you have not specified a scatter-size variable, or if you want to use a different variable, 
choose a variable from the Scatter Size Variable menu on the Scatter Size/Font dialog. The 
Size Multiplier region becomes active.

4. Choose the Grid Units/Magnitude or Cm/Magnitude option. By default, Tecplot uses Grid 
Units/Magnitude. Tecplot calculates and displays an initial size multiplier in the adjacent 
text field.

5. Enter the desired multiplier in the text field to the right of the selected option.

13.5.3. Variable Size Multiplier and Fonts

When you choose Size by Variable for scatter plots, Tecplot multiplies the value of the scatter-
size variable at each point by a specified multiplier to determine the actual size of the plotting 
symbol. You can modify this multiplier from the Scatter Size/Font dialog. 

You can change the base font used for ASCII character symbols to any of Tecplot’s basic fonts 
(Helvetica, Courier Bold, etc.). To do this, choose Scatter Size/Font from the Field menu. The 
Scatter Size/Font dialog appears. Choose the desired font from the drop-down labeled Base 
Font for ASCII Symbols. The base font affects all ASCII symbols using the base font in the 
current frame.

To modify the scatter size multiplier and font:

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

2. Display the Scatter page.

3. Select the zones for which you want to modify the multiplier for scatter symbols.

Figure 13-6. Scatter plot sized by a variable.
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13.5. Scatter Symbol Sizes and Fonts

4. Click Scat Size. On the drop-down which appears, select Size by Variable.

5. Choose Scatter Size/Font from the Scatter sub-menu of the Field menu. The Scatter Size/
Font dialog appears.

6. Select Base Font for ASCII Symbols and choose the desired font from the list shown.

7. If you have not specified a scatter-size variable, or if you want to use a different variable, 
choose a variable from the Scatter Size Variable menu on the Scatter Size/Font dialog. The 
Size Multiplier region becomes active.

8. Choose the Grid Units/Magnitude or Cm/Magnitude option. By default, Tecplot uses Grid 
Units/Magnitude. Tecplot calculates and displays an initial size multiplier in the adjacent 
text field.

9. Enter the desired multiplier in the text field to the right of the selected option.

13.5.4. Reference Scatter Symbols
If you are using a scatter-size variable, it is sometimes useful to create a reference scatter sym-
bol that shows the size at which a data point of a given magnitude will be represented. You cre-
ate the reference scatter symbol using the Reference Scatter Symbol dialog. The Reference 
Scatter Symbol appears only if a scatter size variable is defined; if you have not yet created 
one, select one by choosing Scatter Font/Size from the Field menu, then choosing a Scatter 
Size Variable from the drop-down.

To create a reference scatter symbol:

1. Choose Reference Scatter Symbol from the Scatter sub-menu of the Field menu. The Ref-
erence Scatter Symbol dialog appears, as shown in Figure 13-7. 

2. Select the check box labeled Show Reference Scatter Symbol.

Figure 13-7. The Reference Scatter Symbol dialog.
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3. Enter an appropriate value in the Magnitude text box. It may be useful to use the Probe tool 

 on a symbol of appropriate size, then set the Reference Scatter Symbol magnitude 
accordingly.

4. Modify the shape, color, line thickness, fill color, and origin as desired.

5. Click OK.

Figure 13-8 shows a scatter plot with a reference scatter symbol.

13.6. Symbol Spacing
If your data consists of a dense mesh of points, a scatter plot may be too crowded to be of much 
use. You can “thin” the scatter plot by plotting only a certain subset of the data points.

You control the number of points plotted with the Index Skip attribute from the Points page of 
the Zone Style dialog. For IJ-ordered data, you can specify both an I-skip and a J-skip, while 
for IJK-ordered data, you can specify I-, J-, and K-skips. (For I-ordered data and finite-element 
data, only an I-skip is permitted; it allows you to plot every nth data point, using the natural 
order of nodes and data points in the original data set.) 

For example, a typical scatter plot from a full-size mesh has so many points it is difficult to see 
individual symbols (shown in Figure 13-9). Figure 13-10, on the other hand, shows a 
“thinned” scatter plot of the same data with Index Skip specified, showing every third point in 
the I-direction and every fourth point in the J-direction.

To specify the symbol spacing:

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

Figure 13-8. Scatter plot with reference scatter symbol.

0.020 0.030 0.040 0.050

0.020

0.030

0.040

0.050

X (meters)

Y
 (

m
et

er
s)

= 2E-14



257

13.7. Scatter Legends

2. Display the Points page.

3. Select the zone or zones for which you want to specify the symbol spacing.

4. Click Index Skip. A drop-down appears with the options No Skip and Enter Skip. (No Skip 
is the default.)

5. Click the desired option. If you click Enter Skip, the Enter Index Skipping dialog appears.

6. (Enter Skip only) Enter the desired values of I-Skip, J-Skip, and K-Skip. Figure 13-10 was 
created with the following settings: I-Skip=3, J-Skip=4, K-Skip=1.

13.7. Scatter Legends
You can generate a legend that shows the style attributes of all scatter symbols. This legend can 
be positioned anywhere on the plot. You can elect to have the zone names included in the 
legend. 

To create the scatter legend:

1. Choose Scatter Legend from the Scatter sub-menu of the Field menu. The Scatter Legend 
dialog appears.

2. Select the check box labeled Show Scatter Legend.

Figure 13-9. A crowded scatter plot, using the cylinder data.

Figure 13-10. A scatter plot with Index Skip specified.
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3. Select the Show Zone Names check box to include zone names in the legend.

4. Format the text for the legend by choosing a color and font, and specifying the text height 
as a percentage of the frame height. Enter the desired line spacing in the Line Spacing text 
field.

5. Specify the location of the upper left corner of the legend by entering values in the X (%) 
and Y (%) text fields. Enter X as a percentage of the frame width and Y as a percentage of 
the frame height.

6. Select which kind of box you want drawn around the legend (No Box, Filled, or Plain). If 
you choose Filled or Plain, format the box using the following controls:

- Line Thickness: Specify the line thickness as a percentage of frame height.

- Box Color: Choose a color for the legend box outline.

- Fill Color: (Filled only) Choose a color for the legend box fill.

- Margin: Specify the margin between the legend text and legend box as a percentage of 
the text height.

Figure 13-11 shows a scatter plot with a scatter legend.

Figure 13-11. Scatter plot with legend.
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CHAPTER 14 Shade Plots

Shade plots cover the surface of zones with a single color. In 2-D plots, each shaded zone will 
have one constant color. In 3-D plots, effects such as translucency and lighting will cause vari-
ation in color at different locations on the zone. 

Shade plots require IJ- or IJK-ordered, or finite-element data. I-ordered, or irregular data, 
cannot be used to create shade plots.

14.1. Two-Dimensional Shade Plots
In 2D Cartesian plots, the only type of shading available is solid zone flooding. Each shaded 
zone is drawn as a uniform color.

To create a 2-D shade plot:

1. Select the Shade zone layer from the sidebar.

To control the 2-D shade color for a zone or zones:

1. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

2. Display the Shade page. The Shade page appears as shown in Figure 14-1.

3. In the Zone Style dialog, select the zone or zones for which you want to modify the shade 
color.

4. Click Shade Color. A drop-down appears containing Tecplot’s basic colors.

5. Click on the desired color.

Figure 14-1. The Shade page of the Zone Style dialog.
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14.2. Three-Dimensional Surface Shade Plots
Three-dimensional shade plots may be created with surface or volume zones. Surface zones, 
such as IJ-ordered, finite-element triangle or finite-element quadrilateral, are loaded by default 
into Tecplot as 2-D plots. They may be viewed as 3-D surfaces by selecting the 3D Cartesian 
plot type from the sidebar. Volume zones, IJK-ordered, finite-element brick, and finite-element 
tetrahedral, by default will plot the outer surface with the field layer you select.

To create a 3-D shade plot:

1. Select the Shade zone layer from the sidebar.

2. Control which zones are shaded using the Shade Show option of the Shade page of the 
Zone Style dialog.

3. Control the shade color for each zone using the Shade Color option of the Shade page of the 
Zone Style dialog.

4. Choose which zones will have a 3-D shade effect using the Use Lighting option on the 
Shade page of the Zone Style dialog. To change the lighting effect, go to the Effects page of 
the Zone Style dialog.

Figure 14-2 shows a 3-D surface shade plot, with the Use Lighting option selected and the 
default Paneled lighting effect. The data file from which this plot was generated is delivered 
with Tecplot as demo/3d/spcship.plt.

You may specify zone colors for each plotted zone. When Use Lighting is set to No, the zone 
color is used to uniformly color the zone. For Paneled and Gouraud shading, the zone color is 
combined with the light source effect, as described in Section 15.1.2, “Lighting Effects.” 

To specify the zone color, use the procedures for choosing colors in Section 7.3.4, “Color 
Choice.”  (The Multi-Color option is not available for shade plots.)

Figure 14-2. A 3-D surface shade plot.
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CHAPTER 15 Translucency and 
Lighting

The 3-D Effects, Translucency and Lighting, are effective with shaded or contour flooded 
zones. Each must be selected on the sidebar to be available for zones with a plot. Streamtraces, 
slices and iso-surfaces all have separate controls from zones for lighting and translucency. The 
Effects page of the Zone Style dialog is shown in Figure 15-1.

15.1. Three-Dimensional Effects
When a zone is translucent, you may view objects inside or beyond the zone. You control the 
translucency of a zone using the Surface Translucency attribute in the Effects page of the Zone 
Style dialog. Translucency may be set to a value between one, nearly solid, and 99, nearly 
invisible. There are nine pre-set percentages ranging from ten to 90. You may also use the 
Enter option to define a percentage of your own. An example of a translucent plot is shown in 
Figure 15-2.

Figure 15-1. The Effects page of the Zone Style dialog.
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To create a plot using translucency:

1. Create a 3-D shade or contour flooded plot.

2. Select the Translucency check box on the sidebar.

3. Click the Zone Style button in the sidebar. The Zone Style dialog appears.

4. Display the Effects page.

5. Select the zone or zones that you want to plot using translucency, then set Use Surface 
Translucency to Yes.

6. Click Surface Translucency, then select a percentage from the drop-down. Alternatively, 
you may click Enter to type in a value between one and 99.

15.1.1. Translucency

All surfaces in 3D Cartesian plots may be made translucent. A different translucency may be 
assigned to individual zones, and may also be assigned to derived objects such as slices, 
streamtrace ribbons or rods, and iso-surfaces. Please note that the Translucency check box on 
the side bar applies only to zones, not slices, streamtraces, or iso-surfaces. Translucency for 
those objects is controlled through their respective dialogs.

Plots with translucency cannot be printed. Translucency will only appear on your screen, or in 
exported bitmap images. See Appendix E, “Limits of Tecplot Version 10,” for more details.

Figure 15-2. A plot with translucency.
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15.2. Three-Dimensional Light Source

15.1.2. Lighting Effects

There are two types of lighting effects, Paneled and Gouraud.

• Paneled: Within each cell the color assigned to each area by shading or contour flooding is 
tinted by a shade constant across the cell. This shade is based on the orientation of the cell 
relative to your 3-D light source.

• Gouraud: This plot type offers a more continuous and much smoother shading than Pan-
eled shading, but also results in slower plotting and larger print files. Gouraud shading is 
not continuous across zone boundaries. Gouraud shading is not available for finite-element 
volume zones when blanking is included. A finite-element volume zone set to use Gouraud 
shading will revert to Paneled shading when blanking is included.

IJK-ordered data with Surfaces to Plot set to Exposed Cell Faces, faces exposed by blank-
ing will revert to Paneled shading.

Figure 15-3 shows two shade plots. The one on the left uses a Paneled lighting effect and the 
one on the right a Gouraud lighting effect.

15.2. Three-Dimensional Light Source

Open the Light Source dialog by clicking the  next to Lighting zone effect check box on 
the sidebar, or by selecting Light Source from the Plot menu. The light source position is indi-
cated by a dot over the origin of the 3-D orientation axes displayed in the Light Source Posi-
tion control.

Figure 15-3. Plots showing Paneled and Gouraud lighting effects.
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15.2.1. Light Source Position
The 3-D light source is a point of light infinitely far from the drawing area. The 3-D light 
source may be different for each frame. By default, the light source is positioned at infinity 
along the eye-origin axis. You can specify its location as a point on a hemisphere with a pole 
along the eye-origin axis. Control the location with the Light Source Position control on the 
Light Source dialog, shown in Figure 15-4.

The following options are available:

In the Light Source Position area, click the mouse at the desired light source location. You may 
also drag the mouse to move the light source position. As the light source position moves away 
from the eye origin ray, its representation appears as an arrow. The length of the arrow indi-
cates how far from the eye origin ray the light source position is. At the eye origin ray, the 
arrow is pointing directly into the screen, so just a dot is visible; at the horizon (on the circle 
surrounding the 3-D orientation axes in the Light Source Position control), the arrow is at its 
longest.

15.2.2. Light Source Attributes
The following options are available:

• Intensity (%): Controls the amount of lighting effect produced by the directional light 
source. An intensity of 100 produces the maximum contrast between lit and unlit areas, and 
fully lit areas use the full surface color. Lesser values produce less contrast between lit and 
unlit areas, and fully lit areas use darker colors. An intensity of zero means the light source 
produces no contrast between lit and unlit areas, and all areas are black.

Figure 15-4. The Light Source dialog.
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15.2. Three-Dimensional Light Source

• Background Light (%): Controls the amount of lighting effect applied to all objects 
regardless of the light source position. A background light of zero means that areas unlit by 
the directional light source receive no lighting at all and are entirely black, while areas lit 
by the directional light source get only the effect of that light. Larger values produce more 
lighting effect in areas not lit by the directional light source, making these areas show some 
of the surface color. A background light of 100 means that all areas are lit by the maximum 
amount, and areas unlit by the directional light source use the full surface color.

Note: Intensity and Background Light are cumulative; they can add up to more than 100 
and result in colors lightened beyond the base surface color. For example, reds will become 
pink and grays will become white.

• Surface Color Contrast (%): Controls the contrast of the color of light source shaded sur-
faces before applying lighting effects. A surface color contrast of 100 means that light 
source shaded surfaces use the full surface color for applying lighting effects. Lesser values 
mean that the surface color is blended with progressively more white, making light source 
shaded surface colors lighter. A surface color contrast of zero means that colors are pure 
white before applying lighting effects; the plot will only be shades of gray.

15.2.3. Specular Highlighting
Specular Highlighting adds the semblance of reflected light to 3-D shaded or flooded objects.

Options include:

• Include Specular Highlighting: Turns on/off specular highlight for all light-source shaded 
objects in the plot.

• Intensity (%): Controls intensity of specular highlights (that is, the amount of reflected 
light, which controls the amount of whiteness at the peak of the highlight).

• Shininess: Controls shininess of specular highlight (that is, roughly the size and spread of 
specular highlight).

15.2.4. Lighting Optimizations

Some combinations of lighting type and plot style may result in very slow redrawing of plots. 
Tecplot provides lighting optimizations to avoid such conditions and instead draws a similar, 
but less intensive plot. These optimizations are on by default. Turn them off if you need to see 
the exact effects you have specified. You may want to turn off the graphics cache before 
turning off those optimizations for plots with large amounts of data. (See Section 30.3.2, 
“Graphics Cache,”  for information on the graphics cache.)
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CHAPTER 16 Text, Geometries and 
Images

You can enhance any plot, or create a drawing from scratch, using Tecplot’s text and drawing 
tools. Tecplot provides tools for creating polylines, circles, ellipses, squares, and rectangles, in 
addition to a text tool for creating titles, labels, and any other text you want. In addition to add-
ing text and geometries, you can insert BMP, JPEG, or PNG images to enhance your plot. You 
can annotate line and Cartesian plots.

Alternatively, pure sketches are created with the “Sketch” plot type. Figure 16-1 shows a 

sketch created with Tecplot drawing tools.

16.1. Text
Text strings are used for plot titles and labels. Figure 16-2 shows a small sample of the types of 
text you can create with Tecplot.

To add text to your plot or sketch:

1. From the sidebar, choose the Text tool , or from the Insert menu, choose Text. In either 
case, when you move the pointer into the workspace it becomes a cross-hair. 

Figure 16-1. A sketch created with Tecplot.
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2. Click anywhere in a frame to indicate the location of the text. The Text Details dialog 
appears, as shown in Figure 16-3.

3. Enter the desired text in the text area labeled Enter Text String. As you type, the text you 
enter is echoed in the frame.

4. Modify the text color, font, angle, height, position, and clipping as desired.

5. Click Options to add a box around your text, modify the line spacing for multi-line text, or 
set a text anchor location.

Figure 16-2. Text examples created with Tecplot.

Figure 16-3. The Text Details dialog.
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16.1. Text

6. Click Close to place the text and close the dialog, or click elsewhere in the work area to 
place additional text.

16.1.1. Text Editing

To edit text already placed:

1. From the sidebar, choose the Selector tool .

2. Double-click on the text you wish to edit. The Text Details dialog appears.

3. Make the desired modifications to the text.

4. To cancel your modifications, click Cancel.

To modify the text attributes of several text items at once, drag the mouse to create a group 
select rubber band box to enclose the items you want to edit. In the Group Select dialog, dese-
lect all object type check boxes except for Text, and click OK. Then click Quick Edit on the 
sidebar, or from the Edit menu. The Quick Edit dialog appears. You can use the Quick Edit 
dialog to modify the font, size, and color of your text items.

16.1.2. Text Deletion
To delete text:

1. From the sidebar choose the Selector tool . 

2. Select the text you wish to delete, then from the Edit menu, choose Clear, or press Delete. 
A confirmation dialog appears asking if you are sure you want to clear the selected text.

3. Click OK.

16.1.3. Text Fonts
You can create text using any of Tecplot’s eleven built-in fonts. Samples of all eleven fonts are 
shown in Figure 16-4. Any of these eleven build-in fonts may be selected by using the Select 
Font dialog, which is displayed by pressing the Font button on the Text Details dialog. Eight of 
the fonts (Courier, Helvetica and Times) are collectively referred to as English fonts. You can 
embed Greek, Math, and User-Defined characters into English-font strings by enclosing them 
with special character sequences called text formatting tags, together with the keyboard char-
acters that correspond to the desired characters in the chosen font, as shown in Figure 16-5.

The text formatting tags and their effects are as follows (format tags are not case sensitive and 
may be either upper or lower case):

• <b>...</b>: Draw the enclosed characters using bold (if possible).

• <i>...</i>: Draw the enclosed characters using italics (if possible).

• <verbatim>...</verbatim>: Draw the enclosed characters verbatim.

• <sub>...</sub>: Draw the enclosed characters as subscripts.

• <sup>...</sup>: Draw the enclosed characters as superscripts.
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• <greek>...</greek>: Draw the enclosed characters using the Greek font.

• <math>...</math>: Draw the enclosed characters using the Math font.

• <userdef>...</userdef>: Draw the enclosed characters using the User-
Defined font.

• <helvetica>...</helvetica>: Draw the enclosed characters using the Helvet-
ica font.

• <times>...</times>: Draw the enclosed characters using the Times font.

• <courier>...</courier>: Draw the enclosed characters using the Courier font.

• <userdef>...</userdef>: Draw the enclosed characters from the User-Defined 
font.

For example, to insert the Greek letter Φ into a Tecplot text string, use the combination 
“<greek>F</greek>.” A serif registered trademark symbol (such as that accompanying 
the word “Tecplot” in Figure 16-2) can be created with the combination “<math>R</
math>.”

Similarly, you can produce subscripts or superscripts by enclosing any characters with 
<sub>...</sub> or <sup>...</sup>, respectively. Tecplot has only one level of 

superscripts and subscripts; expressions requiring additional levels, such as , must be 
created by hand using multiple Tecplot text strings. If you alternate subscripts and superscripts, 
Tecplot positions the superscript directly above the subscript. Thus, the string a<sub>b</

sub><sup>c</sup> produces . To produce consecutive superscripts, enclose all super-

script characters in a single pair of tags. The string x<sup>(a+b)</sup> produces  
in your plot.

Figure 16-4. Examples of Tecplot’s text fonts.
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16.1. Text
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Figure 16-5. Character indices in Tecplot.



Chapter 16. Text, Geometries and Images

272

To insert a tag into text literally, precede the first angle bracket with a backslash (“\”). To insert 
a backslash in the text, just type two backslashes (“\\”). In ASCII input files, the number of 
backslashes must be doubled (two to precede a special character, four to create a backslash) 
because the Preplot program also requires a backslash to escape special characters.

16.1.4. European Characters

Tecplot supports the ISO-Latin one-character encodings. Characters in the ASCII ordinal range 
from 160-255 are now available, providing support for most of the major European languages.

Figure 16-5 shows the characters supported by Tecplot. Note that the two right-hand columns 
represent the extended European characters. Using text formatting tags to produce Greek, 
Math, or User-Defined characters only works with characters in the range 32-126 and is not 
available for the extended European characters.

If your keyboard is configured to produce European characters, then the European characters 
should appear and print automatically with no further setup.

16.1.5. European Characters and Character Codes

If your keyboard is not configured to produce a specific European character you can generate it 
by including the sequence \nnn in your text where nnn the character index value is taken from 
the character index table found in Figure 16-5. For example, if your keyboard will not generate 
the é and you want to show the word “latté,” you would enter:

latt\233

You may need to redraw to get the characters to display clearly.

16.1.6. Text Size and Position
Text can be specified using either of two coordinate systems: frame or grid. In the frame coor-
dinate system, text is positioned relative to the frame, but not to any data that might be in the 
frame. Thus, if you change the view of the data (for example, by zooming, or translating, or 
rotating), the frame coordinate text does not move. In the grid coordinate system, on the other 
hand, the text does move as you alter the view by zooming or translating. If you want to anno-
tate individual data points, it is wise to use grid coordinates.

Once you have chosen a coordinate system, you can choose the units and height for your text.

16.1.6.1. Text Size.  You specify the text size and font by using the Select Font dialog, 
which is launched by pressing the Font button on the Text Details dialog. For text using the 
Frame coordinate system, you may specify your text size in point units or as a percentage of 
the frame height. For text in the grid coordinate system, you may also specify your text size in 
the same units as the data in your frame.

To change the size of your text:
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1. In the workspace, double-click on the text for which you want to change the size. The Text 
Details dialog appears.

2. On the Text Details dialog, press the Font button. The Select Font dialog appears.

3. Specify the units in which you want to express the size of the text. The options are Point 
and Frame(%). For grid mode text an additional option, Grid Units, is available.

4. In the Height text field, specify the desired height.

If you simply want to change the text height, without changing the units in which the height is 
specified, you can simply click on the up/down arrows to the right of the Font button.

16.1.6.2. Text Position. You specify the anchor position for each piece of text by clicking at 
the desired location in the frame. You have some guidance in this by using the workspace 
rulers, and you can gain some specific control by using the Snap to Paper or Snap to Grid 
sidebar options. However, for complete control over the position of your anchor point, you can 
specify exact coordinates for the anchor position, or origin of the text, using the Origin controls 
in the Text Details dialog.

To specify an exact position for the text anchor position:

1. In the workspace, double-click the text for which you want to specify an origin. The Text 
Details dialog appears.

2. Enter a value for the X-position in the text field labeled X and a value for the Y-position in 
the text field labeled Y. For grid mode geometries in the Polar plot type, values are 
expressed in units of Theta and R. Values are expressed in the coordinate system specified 
for the text, either frame units or grid units.

The text anchor can be at any of nine locations with respect to the text: vertically, one of Head-
line, Midline, or Baseline, and horizontally, one of Left, Center, or Right. The anchor location 
determines whether text is centered about the text origin, or right, left, top, or bottom justified.

To specify the anchor location:

1. In the workspace, double-click the text for which you want to specify the anchor position. 
The Text Details dialog appears.

2. Click Options. The Text Options dialog appears as shown in Figure 16-6.

3. Under the heading Text Anchor Location, select one of the nine option buttons correspond-
ing to the allowable anchor locations.

16.1.7. Text Boxes

You can put a plain or filled box around any piece of text. A filled text box obscures all por-
tions of the plot under the text box; a plain box is a transparent outline.

To add a text box:

1. In the workspace, double-click the text for which you want to specify a text box. The Text 
Details dialog appears.
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2. Click Options. The Text Options dialog appears.

3. Choose one of the option buttons Filled or Plain.

4. Specify the line thickness and box outline color, and for a filled box, select a fill color.

5. Specify the margin around the text as a percentage of the text character height.

16.1.8. Text Scope

By default, text is displayed only in the frame in which it is created. You can, however, choose 
to have the text appear in all frames using the same data set as the one in which the text was 
created. Such frames are called like frames.

To propagate text to all like frames:

1. In the workspace, double-click the text that you want to appear in like frames. The Text 
Details dialog.

2. Click Options. The Text Options dialog appears.

3. Select the check box labeled Show in All Like Frames.

4. Click Close.

16.1.9. Text Attachment to Zones or Mappings

By default, text is always displayed, regardless of which zones or mappings are currently 
active. Sometimes, however, you use text to highlight a particular feature of a specific zone or 
mapping, and that text is meaningless unless the zone or map is displayed as well. In such 
cases, you can control the display of the text by attaching the text to the zone or map.

To attach text to a zone or map:

1. In the workspace, select the text that you want to attach to a zone or map.

2. On the sidebar, click Object Details. The Text Details dialog appears.

3. Click Options. The Text Options dialog appears.

4. Select the check box labeled Attach to Zone/Map.

Figure 16-6. The Text Options dialog.
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5. Enter a zone or mapping number in the text field immediately to the right of the Attach to 
Zone/Map check box.

Once attached to a zone or map, the text is displayed when the zone or map is active, and not 
displayed when the zone or map is inactive. In line plots, this option is controlled by just the 
mapping number. In 2- and 3-D plots, it is controlled by just the zone number.

16.1.10. Text Clipping

Clipping refers to displaying only that portion of an object that falls within a specified clipping 
region of the plot. If you have specified your text position in the Frame coordinate system, the 
text will be clipped to the frame—any portion of the text that falls outside the frame is not dis-
played. If you have specified the Grid coordinate system, you can choose to clip your text to 
the frame or the viewport. If you choose Viewport clipping, the text is clipped to the viewport. 
The size of the viewport depends on the plot type as follows:

• 3D Cartesian: The viewport is the same as the frame, so viewport clipping is the 
same as frame clipping.

• 2D Cartesian/XY Line: The viewport is defined by the extents of the X and Y axes. 
You can modify this with the Area page of the Axis Details dialog.

• Polar Line/Sketch: By default, the viewport is the same as the frame. You can mod-
ify this with the Area page of the Axis Details dialog.

16.1.11. Dynamic Text

You can add special placeholders to text that changes with the data or the display environment. 
For example, you can add a date placeholder that Tecplot will replace with the current date at 
each Redraw. Similarly, you can add a zone name or variable name placeholder.

The complete list of placeholders is as follows:

Variables Notes
&(AUXDATASET:name) The named auxiliary data attached to the current 

frame.

&(AUXFRAME:name) The named auxiliary data attached to the data set of 
the current frame.

&(AUXZONE[nnn]:name) The named auxiliary data attached to the data set of 
the current frame.

&(AXISMAXA) Maximum value of current Theta-axis range.

&(AXISMAXR) Maximum value of current R-axis range.

&(AXISMAXX) Maximum value of current X-axis range.

&(AXISMAXY) Maximum value of current Y-axis range.
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&(AXISMAXZ) Maximum value of current Z-axis range.

&(AXISMINA) Minimum value of current Theta-axis range.

&(AXISMINR) Minimum value of current R-axis range.

&(AXISMINX) Minimum value of current X-axis range.

&(AXISMINY) Minimum value of current Y-axis range.

&(AXISMINZ) Minimum value of current Z-axis range.

&(BYTEORDERING) Platform’s byte ordering: "INTEL" or "MOTOROLA"

&(COLORMAPDYNAMIC) Returns one if the color map is dynamic, zero if 
static.

&(DATE) Replaced with the current date in the format dd Mon 
yyyy.

&(DATASETFNAME[nnn]) Data set file name of the nth file associated with the 
current data set. If n is omitted then all data set file 
names are show, separated by new lines.

&(DATASETTITLE) Replaced with the current data set title.

&(ENDSLICEPOS) Replace with the position of the ending slice plane. 

&(EXPORTISRECORDING) Returns “YES” if currently recording, otherwise 
returns “NO.”

&(FRAMENAME) Replaced with the current plot.

&(INBATCHMODE) A value of one if Tecplot is in batch mode, zero if 
interactive.

&(ISDATASETAVAILABLE) A value of one if a data set exists for the current 
frame, zero if nonexistent.

&(ISOSURFACELEVEL[nnn]) Replace with the value of the contour variable on the 
nnnth iso-surface.

&(LAYOUTFNAME) Replaced with the name of the current layout file.

&(LOOP) Innermost loop counter.

&(MACROFILEPATH) Path to the directory containing the most recently 
opened macro file.

&(MAXA) Maximum value for the Theta variable. The value is 
calculated from the zone assigned to the lowest num-
bered active line mapping.

Variables Notes
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&(MAXB) Maximum value for blanking variable. If the plot 
type is 2D or 3D Cartesian, the value is calculated 
from the current set of active zones. If the plot type is 
XY or Polar Line, the value is calculated from the 
zone assigned to the lowest numbered active line 
mapping.

&(MAXC) Maximum value for contour variable. If the plot type 
is 2D or 3D Cartesian, the value is calculated from 
the current set of active zones. If the plot type is XY 
or Polar Line, the value is calculated from the zone 
assigned to the lowest numbered active line map-
ping.

&(MAXI) I-dimension for the lowest numbered active zone for 
2D and 3D Cartesian plot types. For line plots this 
represents the maximum I-value for the zone 
assigned to the lowest numbered active line map-
ping. For finite-element data, this represents the 
number of nodes in the lowest numbered active 
zones.

&(MAXJ) J-dimension for the lowest numbered active zone for 
2D and 3D Cartesian plot types. For line plots this 
represents the maximum J-value for the zone 
assigned to the lowest numbered active line map-
ping. For finite-element data, this shows the number 
of elements in the lowest numbered active zone.

&(MAXK) K-dimension for the lowest numbered active zone 
for 2D and 3D Cartesian plot types. For line plots 
this represents the maximum K-value for the zone 
assigned to the lowest numbered active line map-
ping. For finite-element data, this shows the number 
of nodes per element for the lowest numbered active 
zone.

&(MAXR) Maximum value for the R variable. The value is cal-
culated from the zone assigned to the lowest num-
bered active line mapping.

&(MAXS) Maximum value for scatter sizing variable for the 
currently active zones.

&(MAXU) Maximum value for variable assigned to the X-vec-
tor component for the currently active zones.

Variables Notes
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&(MAXV) Maximum value for variable assigned to the Y-vector 
component for the currently active zones.

&(MAXVAR[nnn]) Maximum value of variable nnn.

&(MAXW) Maximum value for variable assigned to the Z-vector 
component for the currently active zones.

&(MAXX) Maximum value for variable assigned to the X-axis. 
For 2D or 3D Cartesian plots, the value is calculated 
from the current set of active zones. For line plots, 
the value is calculated from the zone assigned to the 
lowest numbered active line mapping.

&(MAXY) Maximum value for variable assigned to the Y-axis. 
For 2D or 3D Cartesian plots, the value is calculated 
from the current set of active zones. For line plots, 
the value is calculated from the zone assigned to the 
lowest numbered active line mapping.

&(MAXZ) Maximum value for variable assigned to the Z-axis 
for the currently active zones.

&(MINA) Minimum value for the Theta variable. The value is 
calculated from the zone assigned to the lowest num-
bered active line mapping.

&(MINB) Minimum value for blanking variable. For 2D or 3D 
Cartesian plots, the value is calculated from the cur-
rent set of active zones. For line plots, the value is 
calculated from the zone assigned to the lowest num-
bered active line mapping.

&(MINC) Minimum value for contour variable. For 2D or 3D 
Cartesian plots, the value is calculated from the cur-
rent set of active zones. For line plots, the value is 
calculated from the zone assigned to the lowest num-
bered active line mapping.

&(MINR) Minimum value for the R variable. The value is cal-
culated from the zone assigned to the lowest num-
bered active line mapping.

&(MINS) Minimum value for scatter sizing variable for the 
currently active zones.

&(MINU) Minimum value for variable assigned to the X-vector 
component for the currently active zones.

Variables Notes
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&(MINV) Minimum value for variable assigned to the Y-vector 
component for the currently active zones.

&(MINVAR[nnn]) Minimum value of variable nnn.

&(MINW) Minimum value for variable assigned to the Z-vector 
component for the currently active zones.

&(MINX) Minimum value for variable assigned to the X-axis. 
For 2D or 3D Cartesian plots, the value is calculated 
from the current set of active zones. For line plots, 
the value is calculated from the zone assigned to the 
lowest numbered active line mapping.

&(MINY) Minimum value for variable assigned to the Y-axis. 
For 2D or 3D Cartesian plots, the value is calculated 
from the current set of active zones. For line plots, 
the value is calculated from the zone assigned to the 
lowest numbered active line mapping.

&(MINZ) Minimum value for variable assigned to the Z-axis 
for the currently active zones.

&(NUMFRAMES) Number of frames.

&(NUMPLANES) Returns number of graphics bit-planes

&(NUMVARS) Number of variables in current data set.

&(NUMXYMAPS) Number of XY-maps assigned to the current frame.

&(NUMZONES) Number of zones in current data set.

&(OPSYS) Returns 1=UNIX, 2=DOS.

&(PAPERHEIGHT) Paper height in inches.

&(PAPERWIDTH) Paper width in inches.

&(PLATFORM) Platform name (such as "SGI" or "WINDOWS").

&(PLOTTYPE) Plot type for the current frame: Zero for Sketch, one 
for XY Line, two for Cartesian 2D, three for Carte-
sian 3D, and four for PolarLine.

&(PRINTFNAME) Replaced with the name of the current print file.

&(SLICEPLANETYPE) Replace with the type of slice plane (X-, Y-, Z-, I-, J- 
or K-planes).

&(STARTSLICEPOS) Replace with the position of the starting slice plane.

&(STREAMSTARTPOS[nnn]) Starting position (X, Y, Z) of the nnnth streamtrace.

Variables Notes
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The placeholders must be typed exactly as shown, except that the nnn in the zone name and 
variable name placeholders should be replaced by the actual number of the zone or variable, 
such as &(ZONENAME[3]) or &(VARNAME[2]).

You can, of course, embed the dynamic text strings in text records in a Tecplot-format data file, 
as in the following example:

TEXT CS=FRAME HU=POINT T="&(DATE)"

System environment variables can be accessed directly from Tecplot by using the following: 
&($string), where string is the name of your environment variable. Using environment variables 
within Tecplot can add another degree of flexibility by taking advantage of your customized 
environment. If an environment variable is missing, the environment variable name itself will 
appear on the screen.

16.2. Geometries
Geometries in Tecplot are simply line drawings. Geometries include polylines (a set of line 
segments), circles, ellipses, rectangles, and squares. Images are also considered geometries, 
but they are discussed below in Section 16.3, “Images.” Polylines may include arrowheads at 
either or both ends. Figure 16-7 shows some examples of geometries.

16.2.1. Geometry Creation
You create geometries by drawing them in a frame using one of the following sidebar tools:

&(STREAMTYPE[nnn]) Type (Surface Line, Volume Line, Volume Ribbon, 
Volume Rod) of the nnnth streamtrace.

&($string) Replaced with the value of the system environment 
variable string.

&(TECHOME) Path to the Tecplot home directory.

&(TECPLOTVERSION) Returns Tecplot Version. (Currently returns “100.”)

&(TIME) Replaced with the current time in the format 
hh:mm:ss.

&(VARNAME[nnn]) Replaced with the variable name for variable nnn.

&(ZONEMESHCOLOR[nnn]) Color of the mesh for the nnnth zone.

&(ZONENAME[[ACTIVEOFF-
SET=]nnn])

Replaced with the zone name for zone nnn. If ACTIVEO-
FFSET= is used, the integer value indicates the nnnth 
active zone for field plots and the zone associated with the 
nnnth active line mapping for line plots.

Variables Notes
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• The button to draw polylines. You can also choose this tool by choosing Polyline 
from the Insert menu.

• The button to draw circles. You can also choose this tool by choosing Circle from 
the Insert menu.

• The button to draw ellipses. You can also choose this tool by choosing Ellipse 
from the Insert menu.

• The  button to draw squares. You can also choose this tool by choosing Square 
from the Insert menu.

• The  button to draw rectangles. You can also choose this tool by choosing Rectan-
gle from the Insert menu.

After choosing any of these tools, when you move the pointer into the workspace, it becomes a 
cross-hair. Click once in a frame to set the anchor position for the geometry. To complete the 
geometry, follow the instructions for each geometry type as follows:

• For polylines: Move the mouse (without dragging) to the desired end point of the 
first line segment, then click the left mouse button. Move the pointer to the next end 
point, click, and so on. After placing the last segment, double-click on the final end 
point or press Esc on your keyboard. To draw a horizontal or vertical line segment, 
press the H or V keys, respectively, while drawing the segment. After you place the 
segment’s end point, the horizontal or vertical restriction is lifted. To lift the horizon-
tal or vertical line segment restriction without placing the end point, press A on your 
keyboard. You can draw unconnected line segments in a single polyline; press U on 
your keyboard to “lift the pen.” You can then move the pointer to the start of the next 
line segment.

Figure 16-7. Sample geometries.
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• For circles: Click at the desired center point of the circle; drag the mouse until the 
circle is the desired radius, then release.

• For ellipses: Click at the desired center point of the ellipse; drag the mouse until the 
ellipse is the desired size and shape, then release.

• For squares: The anchor point of the square is either the lower left-hand corner or 
the upper right corner of the square. Drag the mouse to the right of the anchor to cre-
ate a square with the anchor at lower left; drag the mouse to the left to create a square 
with the anchor at upper right. Release when the square is the desired size.

• For rectangles: Drag the mouse until the rectangle is the desired size and shape. In 
contrast to squares, rectangles can propagate in any direction.

16.2.2. Geometry Modification
You can modify the outline color, line pattern, line thickness, fill color, and position of your 
geometries, along with other attributes that affect the relationship of the geometry to the frame 
and the data set (if any). Individual geometry types have their own specific attributes.

16.2.2.1. Geometry Colors. Geometries may be filled or unfilled. Unfilled geometries 
have a single color attribute: the line color. Filled geometries have both a line color and a fill 
color. You can control the colors from either the Geometry dialog or the Quick Edit dialog.

To specify a geometry’s colors:

1. In the workspace, select the geometry or geometries for which you want to modify the 
color.

2. On the sidebar, click Object Details. If you have selected a single geometry, the Geometry 
dialog appears. Continue with Step 3. If you have selected multiple geometries, the Quick 
Edit dialog appears. Continue with Step 4. 

3. (Geometry dialog) Specify the geometry’s outline color by pressing the Color button next 
to the Outline Color label. The Select Color dialog appears, allowing you to select one of 
Tecplot’s 64 colors. If you want the geometry filled, select the check box labeled Fill Color, 
then select a fill color by clicking on the Fill Color button and selecting the desired color 
from the Select Color dialog.

4. (Quick Edit dialog) Specify the outline color for all selected geometries by selecting the 
Line option button, then clicking the Color button. If you want the geometries filled, select 
the Fill option button, then click on one of the basic colors. The X button causes fill to be 
turned off (when Fill option button is selected), or causes line color to match fill color 
(when Line option button is selected, and fill is present). If no fill is present, the X button 
also has no effect.

16.2.2.2. Geometry Line Patterns. The outline of a geometry, or any polyline, can be 
drawn in any of Tecplot’s line patterns. You control the line pattern from either the Geometry 
dialog or the Quick Edit dialog.
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To specify a geometry’s line pattern:

1. In the workspace, select the geometry or geometries for which you want to modify the line 
pattern.

2. On the sidebar, click Object Details. If you have selected a single geometry, the Geometry 
dialog appears. Continue with Step 3. If you have selected multiple geometries, the Quick 
Edit dialog appears. Continue with Step 4. 

3. (Geometry dialog) Specify the geometry’s line pattern by choosing one of Tecplot’s six line 
patterns (Solid, Dashed, Dotted, Dash Dot, Long Dash, and Dash Dot Dot) from the Line 
Pattern menu. Specify a pattern length by either choosing a pre-set value from the drop-
down or entering a percentage of the frame height in the text field.

4. (Quick Edit dialog) Specify the line pattern for all selected geometries by selecting the 
appropriate line pattern button, as follows:

-  Chooses a solid line.

-  Chooses a dotted line.

-  Chooses a dashed line.

-  Chooses a long dashed line.

-  Chooses an alternating dot-and-dash line.

-  Chooses an alternating dash-and-two-dots line.

Specify a pattern length by clicking on the Pttrn Length button, and choosing either one of 
the pre-set values or Enter. If you choose Enter, an Enter Value dialog appears; enter the 
desired pattern length as a percentage of frame height and click OK.

16.2.2.3. Geometry Line Thickness. You can control the thickness of polylines and the 
outlines of other geometries. You control the line thickness from either the Geometry dialog or 
the Quick Edit dialog.

To specify a geometry’s line thickness:

1. In the workspace, select the geometry or geometries for which you want to modify the line 
thickness.

2. On the sidebar, click Object Details. If you have selected a single geometry, the Geometry 
dialog appears. Continue with Step 3. If you have selected multiple geometries, the Quick 
Edit dialog appears. Continue with Step 4. 

3. (Geometry dialog) Specify the geometry’s line thickness by either choosing a pre-set value 
from the drop-down or entering a percentage of the frame height in the Line Thickness (%) 
field.
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4. (Quick Edit dialog) Specify a line thickness by clicking Line Thcknss, and choosing either 
one of the pre-set values or Enter. If you choose Enter, an Enter Value dialog appears; enter 
the desired line thickness as a percentage of frame height and click OK.

16.2.2.4. Geometry Coordinate Systems. Geometries, like text, can be positioned using 
either frame coordinates or grid coordinates. Grid coordinates are used by default. Unlike text, 
however, geometries are sized using the units of the coordinate system in which they are 
placed. That is, geometries that use frame coordinates use frame units to specify both the posi-
tion and the size, while geometries that use grid coordinates use grid units to specify both the 
position and size. When frame coordinates are used, the geometry is locked at a particular loca-
tion within the frame, and actions which modify the view (such as zooming, translating, and 
rotating) have no effect on the geometry. When grid coordinates are used, the geometry is part 
of the view, subject to change when the view changes. For example, a circle in frame coordi-
nates retains its size and shape when you zoom into the plot, while a circle in grid coordinates 
grows as you zoom in. You specify the coordinate system using the Geometry dialog.

To specify a geometry’s coordinate system:

1. In the workspace, select the geometry for which you want to specify a coordinate system.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Select either Frame or Grid from the Coordinate System drop-down list.

16.2.2.5. Geometry Position. You specify the anchor position for a new geometry by 
clicking anywhere in the frame. You have some guidance in this by using the workspace rulers, 
and you can gain some specific control by using the Snap to Paper or Snap to Grid sidebar 
options. Users can also move a geometry to the front or the back of a group of geometries by 
selecting it, then choosing Edit, Push or Edit, Pop. However, for complete control over the 
position of your anchor point, you can specify exact coordinates for the anchor position, or 
origin of the geometry, using the Origin controls in the Geometry dialog.

To specify an exact position for a geometry’s origin:

1. In the workspace, select the geometry for which you want to specify an origin.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a value for the X-position in the text field labeled X, a value for the Y-position in the 
text field labeled Y, (and, for 3-D line geometries brought in from data files, a value for the 
Z-position in the text field labeled Z). Values are expressed in the coordinate system speci-
fied for the geometry, either frame units or grid units. For grid mode geometries in the Polar 
plot type, values are expressed in units of Theta and R.

16.2.2.6. Geometry Clipping. Clipping refers to displaying only that portion of an object 
that falls within a specified clipping region of the plot. If you have specified your geometry 
position in the Frame coordinate system, the geometry will be clipped to the frame—any 
portion of the geometry that falls outside the frame is not displayed. If you have specified the 
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Grid coordinate system, you can choose to clip your geometry to the frame or the viewport. If 
you choose Viewport clipping, the geometry is clipped to the viewport. The size of the view-
port depends on the plot type as follows:

• 3D Cartesian: The viewport is the same as the frame, so viewport clipping is the 
same as frame clipping.

• 2D Cartesian/XY Line: The viewport is defined by the extents of the X and Y axes. 
You can modify this with the Area page of the Axis Details dialog.

• Polar Line/Sketch: By default, the viewport is the same as the frame. You can mod-
ify this with the Area page of the Axis Details dialog.

16.2.2.7. Geometry Draw Order. Geometries can be draw either before the data, or after 
the data. If a geometry is drawn before the data, the plot layers, such as mesh, contour lines, 
etc. will be drawn on top of the geometry. If a geometry is drawn after the data, the geometry 
will be drawn last, obscuring the data. The draw order setting is particularly useful for Images, 
which are discussed in Section 16.3. “Images” 

To change the draw order for a geometry:

1. In the workspace, double-click the geometry for which you want to change the draw order. 
The Text Details dialog appear.

2. In the Draw Order field, select either Before Data or After Data.

16.2.2.8. Geometry Scope. By default, a geometry is displayed only in the frame in which 
it is created. You can, however, choose to have the geometry appear in all frames using the 
same data file as the one in which the geometry was created. Such frames are called like 
frames.

To propagate a geometry to all like frames:

1. In the workspace, select the geometry that you want to appear in like frames.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Select the check box labeled Show in All Like Frames.

16.2.2.9. Geometry Attachment to Zones or Mappings. By default, geometries are 
always displayed, regardless of which zones or mappings are currently active. Sometimes, 
however, you draw a geometry to highlight a particular feature of a specific zone or mapping, 
and that geometry is meaningless unless the zone or map is displayed as well. In such cases, 
you can control the display of the geometry by attaching the geometry to the zone or map.

To attach a geometry to a zone or map:

1. In the workspace, select the geometry that you want to attach to a zone or map.

2. On the sidebar, click Object Details. The Geometry dialog appears.
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3. Select the check box labeled Attach to Zone/Map.

4. Enter a zone or mapping number in the text field immediately to the right of the Attach to 
Zone/Map check box.

Once attached to a zone or map, the geometry is drawn when the zone or map is active, and not 
drawn when the zone or map is inactive.

16.2.2.10. Arrowheads and Polylines. You can add arrowheads to either or both ends of 
any polyline, and control the arrowhead style, size, and angle. You control polyline arrowheads 
from either the Geometry dialog or the Quick Edit dialog.

To control polyline arrowheads:

1. In the workspace, select the polyline or polylines for which you want to specify arrowhead 
attachment.

2. On the sidebar, click Object Details. If you have selected a single polyline, the Geometry 
dialog appears. Continue with Step 3. If you have selected multiple polylines, the Quick 
Edit dialog appears. Continue with Step 4. 

3. (Geometry dialog) Specify where to place arrowheads for the geometry by selecting none, 
one, or both of the check boxes labeled Start and End beside the label Attachment. If you 
select one or both of Start and End, specify a style by selecting one of the option buttons 
labeled Plain, Filled, or Hollow. Specify a size by either choosing a pre-set value or enter-
ing a value in the Size (%) field. Specify an angle by either choosing a pre-set value or 
entering a value in the Angle (deg) field.

4. (Quick Edit dialog) Specify where to place arrowheads by clicking on one of the following:

-  No arrowheads.

-  Arrowheads at both ends.

-  Arrowhead at start of polyline.

-  Arrowhead at end of polyline.

Specify a style by clicking on one of the following buttons:

-  Plain arrowhead style.

-  Filled arrowhead style.

-  Hollow arrowhead style.
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Specify a size for the arrowheads by clicking Size, located beneath the Arrowhead Style 
options, then choosing either one of the pre-set sizes, or Enter. If you choose Enter, an Enter 
Value dialog appears. Enter the desired size as a percentage of the frame height, then click 
OK.

Specify an angle for the arrowheads by clicking Angle, then choosing either one of the pre-
set values, or Enter. If you choose Enter, an Enter Value dialog appears. Enter the desired 
arrowhead angle, which is the angle that one side of the arrowhead makes with the polyline, 
in degrees.

16.2.2.11. Circle Attributes. Using the Geometry dialog, you can modify the radius of a 
circle and also the number of line segments used to approximate the circle. 

To modify a circle’s radius:

1. In the workspace, select the circle for which you want to modify the radius.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a new value in the text field labeled Radius.

To modify the number of line segments used to approximate the circle:

1. In the workspace, select the circle for which you want to specify a different number of line 
segments.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a new value in the text field labeled Approximated by Number of Sides.

16.2.2.12. Ellipse Attributes. Using the Geometry dialog, you can modify the horizontal 
and vertical axes of an ellipse and also the number of line segments used to approximate the 
ellipse.

To modify an ellipse’s axes:

1. In the workspace, select the ellipse for which you want to modify the axes.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a new value for the horizontal axis length in the text field labeled Horizontal Axis.

4. Enter a new value for the vertical axis length in the text field labeled Vertical Axis.

To modify the number of line segments used to approximate the ellipse:

1. In the workspace, select the ellipse for which you want to specify a different number of line 
segments.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a new value in the text field labeled Approximated by Number of Sides.

16.2.2.13. Square Attributes. The only specific attribute of a square that you can modify is 
the side length.
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To modify the size of a square:

1. In the workspace, select the square for which you want to modify the size.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a new value in the text field labeled Size.

16.2.2.14. Rectangle Attributes. The only specific attributes of a rectangle that you can 
modify are the width and height.

To modify the size of a rectangle:

1. In the workspace, select the rectangle for which you want to modify the size.

2. On the sidebar, click Object Details. The Geometry dialog appears.

3. Enter a new value in the text field labeled Width.

4. Enter a new value in the text field labeled Height.

5. Click Close.

16.2.2.15. Individual Point Modification. With the Adjustor tool, you can move one or 
more points from polyline geometries, as follows:

1. On the sidebar, choose the Adjustor tool by clicking .

2. Click the point you want to move. If you want to move more than one point, you can drag a 
box around them to select them as a group, or Shift-click each point in turn. Handles appear 
on the selected points. (The points do not all have to be in the same polyline.)

3. Drag the selected points to move them. The points move as a group.

As you move the points, you can use the V and H keys on your keyboard to restrict motion to 
the vertical and horizontal directions, respectively. Press A to allow movement in all directions 
(the default).

16.2.3. Three-Dimensional Line Geometries

Three-dimensional line geometries cannot be created interactively; they must be created in a 
data file. For example, the following data file includes two 3-D line geometries representing 
the trajectories of two bugs in a cubic room (10 x 10 x 10). Two zones are used to represent the 
ceiling and floor of the room. (In order to display 3-D geometries, you must either include at 
least one zone in the data file with the 3-D geometries or read the 3-D geometries in, using the 
Add to Current Data Set option, after having first read a data set into the frame.) A plot of this 
data set (included in your Tecplot distribution as examples/dat/3dgeom.dat) is shown 
in Figure 16-8.

TITLE = "EXAMPLE: 3D GEOMETRIES"  
 VARIABLES = "X", "Y", "Z" 
 ZONE T="Floor", I=3, J=3, F=POINT  
 0. 0. 0. 



289

16.2. Geometries

 5. 0. 0. 
 10. 0. 0. 
 0. 5. 0. 
 5. 5. 0. 
 10. 5. 0. 
 0. 10. 0. 
 5. 10. 0. 
 10. 10. 0. 
 ZONE T="Ceiling", I=3, J=3, F=POINT 
 0. 0. 10. 
 5. 0. 10. 
 10. 0. 10. 
 0. 5. 10. 
 5. 5. 10. 
 10. 5. 10. 
 0. 10. 10. 
 5. 10. 10. 
 10. 10. 10. 
 GEOMETRY X=0, Y=0, Z=0, CS=GRID, C=BLUE, T=LINE3D, F=POINT 
 1  
 12  
 10. 4.0 10. 
 9.5 5.0 10.0 
 9.3 4.0 9.0 
 10. 5.0 9.5 
 9.2 4.0 8.2 
 8.8 5.3 7.6 

Figure 16-8. Three-dimensional line geometries.
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 7.8 5.6 7.0 
 7.2 5.2 5.0 
 6.9 6.0 5.5 
 6.9 4.5 6.4 
 7.3 4.6 6.8 
 8.2 4.8 7.0 
 GEOMETRY X=0, Y=0, Z=0, CS=GRID, C=RED, T=LINE3D, F=BLOCK 
 1 
 20 
 0 .1 .5 .7 1. 2. 4.9 6.3 6.5 6.6 6.9 8. 8.5 9. 10. 10. 10. 9.5 
8. 9. 
 0 .1 .3 .4 .5 .7 .8 1. 2. 3. 3.5 3.7 4. 4. 4. 4. 4.5 5. 5. 6. 
 0 .1 .3 1. 3. 5. 6. 8. 10. 10. 10. 9. 7. 5. 2. 1. 0. 0. 0. 3.

16.3. Images
Tecplot can import images from JPEG, BMP, and PNG files. These images can be used as 
logos or as a backdrop to your plot.

16.3.1. Inserting Images
You create an image by using the insert image menu option.

To add an image to your plot:

1. From the Insert menu, choose Image.

2. Select an image file. Tecplot can read in images in JPEG, BMP, or PNG format.

When you insert an image, the image is initially centered in the frame at a preset size.

16.3.2. Modifying Images
The Image Geometry Details dialog is used to modify an image just like it is used to modify 
other geometries. The dialog also displays the file name of the image and its resolution (num-
ber of pixels in each direction) for informational purposes. The Image Geometry Details dialog 
is shown in Figure 16-9.

Images share many properties of other Tecplot geometries, including coordinate system, posi-
tion, scope, clipping, draw order, and attachment to zones or mappings. See Section 16.2. 
“Geometries” for details.

16.3.2.1. Image Size. Using the geometry dialog, you can specify the width and height of 
the image.

To modify the size of an image:

1. Select the image on the screen and then select Object Details on the sidebar. Alternatively, 
double-click the image on the screen.
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2. Enter a new value in one of the text fields labeled Width or Height. Units may be specified 
by typing them after the number. Use cm for centimeters, in for inches, or pix for pixels.

3. Click close on the Geometry dialog when you are done.

To interactively resize an image:

1. Select the image on the screen. Pick handles appear on the corners and sides image.

2. To resize the image, drag the handle on the appropriate side or corner.

3. To drag the image to another location without resizing, click and drag anywhere else in the 
image.

16.3.2.2. Image Aspect Ratio. By default, the image maintains its shape. That is, if you 
change the width, the height changes so the image is the same shape; likewise, if you change 
the height, the width changes so the image is the same shape. You can change this behavior 
with the Preserve Aspect Ratio toggle.

When the Preserve Aspect Ratio toggle is off, the width and height of the image can be set 
independently. If the Preserve Aspect Ratio is then turned back on, the current image aspect 
ratio is used. That is, future changes to width or height change the other to maintain the image 
in its current shape. To return the image to its original shape, you can press the Reset button.

16.3.2.3. Image Filter. The image size on the screen is most likely not the same size as the 
original image. The Resize filter determines how the image is resized to fit the screen.

Figure 16-9. The Image Geometry Details dialog
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To change the resize filter:

1. Select the image on the screen and then select Object Details on the sidebar. Alternatively, 
double-click the image on the screen.

2. Select a new filter in the Filter drop-down.

3. Click close on the Geometry dialog when you are done.

The following filters are available:

• Fast (textures): Tecplot uses OpenGL textures to resize the image. Assuming you 
have enough graphics memory, this is the fastest option, although the accuracy of the 
image may suffer, especially when reducing an image to a size much smaller than it 
was before. This is the default setting.

• Pixelated: Choose this option when the image is much larger than its original size 
and you want to see the individual pixels. This option is slower than the Fast (tex-
tures) for increasing the size of images.

• Smooth: There are seven smooth options, all producing slightly different effects. 
These options are slower, often dramatically slower than the Fast (textures), but pro-
duce better effects for highly reduced images. In general, use the Smooth (Lanczos2) 
option unless you have specific image processing needs. 

The resize filter has no effect on vector-based output, only on the screen and for exported 
images.

16.3.3. Images and Tecplot Files
Unlike other geometries, images cannot be included in data files. When you save a data file, 
even if you specify to include geometries, any images in the plot are not saved.

In layout and style sheet files, the image is referenced from its original location. This reference 
can be a relative reference or an absolute (as with data files). See Section 5.3.2. “Layout Files” 
on page 90 for details.

For layout package files, images are included.

16.3.4. Example: Using Image as a Backdrop to Data
Sometimes, you want to import an image and use it behind your data. Figure 16-10 shows a 
crude mesh displayed on top of a simple black-and-white image.

If you know the size and position of the image with respect to the data, you can follow these 
steps:

1. Read in your data file.

2. Choose Cartesian 2D as the plot type.

3. Import the image file.

4. Double-click on the image. This brings up the Image Geometry Details dialog.
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5. Change the coordinate system to Grid.

6. Enter the grid data position of the lower-left corner of your image in the X and Y text fields.

7. Enter the grid data width and height of the Width and Height text fields. You can easily cal-
culate these if you know the grid data position of two opposing corners of your data. You 
may have to turn off the Preserve Aspect Ratio toggle if the image has a different aspect 
ratio than the data.

8. Change the draw order to Before Data. The image will not show up behind the data until 
you close the Image Geometry Dialog.

9. Close the Image Geometry Dialog.

If you do not know the size and position of the image with respect to the data, you can follow 
these steps:

1. Read in your data file.

2. Choose Cartesian 2D as the plot type.

3. Import the image file.

4. Double click on the image. This brings up the Image Geometry Details dialog.

5. Change the Draw Order to Before Data. The image will not show up behind the data until 
you close the Image Geometry Dialog.

6. Close the Image Geometry Dialog.

7. Zoom in and out of your plot and translate the plot until the data is right over the image.

Figure 16-10. Using an Image as the backdrop to data
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8. Double click the image again. Be sure to get the image and not the data.

9. Change the image to Coordinate System to Grid.

10. Close the Image Geometry Dialog.

Now when you zoom or translate the plot, the image stays with the data.

16.4. Text and Geometry Pushing and Popping
You can place text and geometries in any order you like. Tecplot draws all geometries first, in 
the order in which they were placed, then all text. There are times, however, when you want to 
override this default order. Sometimes, for example, you may place one geometry, then draw a 
second geometry that partially obscures the first. You can pop the first geometry to the top of 
the draw stack, so that Tecplot draws it after the geometry that had partially obscured it.

Popping raises the object to the top of its draw stack. Pushing lowers the object to the bottom 
of its draw stack. The text stack is always drawn on top of the geometry stack.

To push a text or geometry object:

1. Select the object.

2. From the Edit menu, choose Push.

To pop a text or geometry object:

1. Select the object.

2. From the Edit menu, choose Pop.

16.5. Text and Geometry Alignment
When you have a number of text and geometries, 
you may want to align them after placing them. You 
can do this using the alignment tools in the Quick 
Edit dialog, shown in Figure 16-11.

You can use these tools as follows:

1. On the sidebar, choose the Selector tool by clicking .

2. In the workspace, select a text or geometry with which you want to align other objects. 

3. Drag the mouse to draw a rubber band box around the text and geometries you want to 
align. The Group Select dialog appears.

4. Select the Text and Geometries check boxes in the Group Select dialog, then click OK. 
Selection handles appear on the selected text and geometries.

5. On the sidebar, click Quick Edit to call up the Quick Edit dialog, if it is not already dis-
played.

6. Use the alignment buttons as follows:

Figure 16-11. Alignment tools.
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-  Left align the selected text and geometries with the original selected object.

-  Center the selected text and geometries with the original selected object.

-  Right align the selected text and geometries with the original selected object.

-  Top align the selected text and geometries with the original selected object.

-  Bottom align the selected text and geometries with the original selected object.

16.6. Text and Geometry Links to Macros
Each text or geometry you create can be linked to a macro function. This macro function is 
called whenever the user holds down the control key and clicks the right mouse button on the 
text or geometry.

For example, if you have pieces of text, each representing a different well, Ctrl-right-click on 
any piece could run a macro that brings up an XY-plot of that well’s data.

Macro functions are specified with the “Macro Function” field in the Geometry dialog or in the 
Text Options dialog. If desired, the macro function may be listed with one or more parameters. 
See Chapter 27, “Macro Commands,” and the Tecplot Reference Manual, for more detailed 
information on using macros in Tecplot.

16.7. Custom Characters
You can create symbols, characters, and even custom fonts for use in Tecplot. See Section 
30.5, “Custom Character and Symbol Definition,” for instructions.
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Tecplot creates axes automatically for all line plots, as well as 2- and 3-D field plots. For these 
automatically created axes, Tecplot determines good tick mark position and spacing, and cre-
ates reasonable tick mark and axis labels. You can modify your Tecplot configuration file to 
change the default behavior, and you can use the Axis Details dialog to exercise control over 
your axes.

You control each axis individually. You specify whether each axis is displayed, its color, posi-
tion, range, length, tick mark spacing, and other attributes. You can also specify dependencies 
between axes that help control the shape of your data when you change the view, or individual 
axis ranges. For 3-D axes, these dependencies can be used to automatically rescale the axes 
when the X-, Y-, or Z-ranges of your data are significantly different.

Most axis controls are concentrated in the Axis Details dialog. Each page of the Axis Details 
dialog controls a different aspect of the axis, and each page is repeated for each axis. The 
Range page of the Axis Details dialog is shown in Figure 17-1.

Tecplot maintains five distinct sets of axes, one for each plot type. This means that modifying 
the color, say, of your X-axis line for 2-D plots will not affect 3-D plots. The 2-D X-axis and 
the 3-D X-axis are different objects.

To edit an axis from the Axis Details dialog, you must be sure you are working on the correct 
axis. At the top of the dialog there are buttons that indicate which axis you are working with. 
To edit a different axis, select a different axis by clicking a different axis button.

Figure 17-1. The Range page of the Edit Axis dialog for a 3-D plot.
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17.1. Axis Display
The most basic axis control is whether or not to display the axis. Showing an axis, by default, 
shows the axis line, tick marks, tick mark labels, and title for the axis. It is possible to disable 
any of these components separately, including the axis line. But if you choose not to show an 
axis, none of the plot components associated with that axis (line, tick marks, tick mark labels, 
title, or grid lines) is displayed. You can control whether an axis is shown from any page 
(except Area) of the Axis Details dialog, using the Show a-Axis check box, where a is Theta or 
R for Polar Line plots, X or Y for 2D Cartesian and Sketch plots, X1 – X5 or Y1 – Y5 for XY 
Line plots and X, Y, or Z for 3D Cartesian plots.

To control the display of an axis, perform the following steps:

1. From the Plot menu, choose Axis. The Axis Details dialog appears.

2. At the top of the Axis Details dialog, click X, Y, or Z (Theta or R for Polar Line plots) to 
select the axis you want to change. The check box to the left of the axis buttons is labeled 
Show a-Axis, where a is one of X, Y, or Z (Theta or R for Polar Line plots). For example, 
by default X is selected for all plot types except Polar Line, and the check box is labeled 
Show X-Axis.

3. Select the Show Axis check box to show the axis; deselect the check box to hide the axis.

You can display axes for Sketch plots as well as frames containing data. By default, sketch 
axes are not displayed. Follow the above procedure to display sketch axes.

17.2. Axis Variable Assignment
For 2-D axes, Tecplot initially assigns the first and second variables in the data set to the X- 
and Y-axes, respectively. For 3-D axes, Tecplot initially assigns the first three variables in the 
data set to the X-, Y-, and Z-axes respectively.

To change variable assignments for 2-D and 3-D axes:

1. From the Plot menu, choose Assign XY in 2-D or Assign XYZ in 3-D. A Select Variables 
dialog appears, with a drop-down for each available axis listing the variables in the data set.

2. Choose one variable for each axis.

For line plots, assigning axis variables is part of defining the mappings. See Chapter 7, “Line 
Plots,”  for more information.

17.3. Axis Range Modification
The range of an axis specifies the minimum and maximum data values displayed along it. The 
length of an axis is its physical length on the screen or paper. The scale of an axis is the ratio of 
its length to its range. You can modify the range in two ways. In the first case, changing the 
range does not affect the length of the axis, and thus modifies the scale. In the second, chang-
ing the range preserves the scale, and thus modifies the length.
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To change range and preserve axis length:

1. From the Plot menu, choose Axis. The Axis Details dialog appears.

2. Choose the Range page and the appropriate axis.

3. Select the check box labeled Preserve Length when Changing Range.

4. Enter the desired range in the text fields labeled Min and Max. You may also use the up and 
down arrows to increase or decrease the displayed values, or click Reset Range and choose 
from one of three options:

Reset to Nice Values: Sets the range to slightly larger than the range of the axis variable in 
order to begin and end the axis at major axis increments.

Reset to Var Min/Max: Sets the range to slightly larger than the range of the axis variable.

Make Current Values Nice: Moves the axis range to the nearest major axis increments.

To change range and preserve axis scale:

1. From the Plot menu, choose Axis. The Axis Details dialog appears.

2. Choose the Range page and the appropriate axis.

3. Deselect the check box labeled Preserve Length when Changing Range.

4. Enter the desired range in the text fields labeled Min and Max. You may also use the up and 
down arrows to increase or decrease the displayed values, or click Reset Range and choose 
from one of three options:

Reset to Nice Values: Sets the range to slightly larger than the range of the axis variable in 
order to begin and end the axis at major axis increments.

Reset to Var Min/Max: Sets the range to slightly larger than the range of the axis variable.

Make Current Values Nice: Moves the axis range to the nearest major axis increments.

The difference between the two methods of changing the range is shown in Figure 17-2.

Figure 17-2. Preserving length versus preserving scale while changing range (left); 
preserving length versus preserving scale while changing range in a Polar Line plot 
(right).
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In the 3D Cartesian plot type, you can change the length of axes using the X-, Y-, and Z-Size 
Factor fields, which also affects scale. If the 3-D axes are independent (see Section 17.3.2, 
“Axis Dependency,”  for details), you can resize each axis independently. If the axes are XY-
dependent, changing the X or Y-size factor changes the other. If the axes are XYZ-dependent, 
changing one size factor changes the other two.

For XY- and Polar Line plots, you can display the axis range using a logarithmic scale. For 
Polar plots, log axes are only available for the R-axis. See Section 7.5.2. “Log Axes” on 
page 135.

17.3.1. Axis Direction
You can reverse the direction of any axis. Normally, values along an axis increase as you move 
from bottom to top on the Y-axis and from left to right on the X-axis. When you reverse the 
axis direction, the value increase from top to bottom and right to left. For Polar axes, the Theta 
axis increases in the counter-clockwise direction, and the R axis increases from the middle of 
the plot to the outer circle. Reversing the Theta axis makes Theta increase in the clockwise 
direction, and by reversing the R axis, R increases from the outer circle to the center.

To reverse the axis direction for Sketch, XY-, Polar- or 2D Cartesian axes:

1. From the Plot menu, choose Axis. The Axis Details dialog appears.

2. Choose the Range page and the appropriate axis.

3. Select the check box labeled Reverse Axis Direction.

For 3-D axes, you can use negative size factors and/or negative X-to-Y and X-to-Z ratios to 
reverse the direction of an axis. This can create a left-handed coordinate system, or rotate the 
plot so that, for example, the Z-axis is pointed downward. If the axis mode is Dependent, 
changing the size factor for one axis changes it on all axes. If the axis mode is XY Dependent, 
changing the sign of either the X- or Y-axis size factor changes the sign of the other. If the axis 
mode is Independent, changing the sign of the size factor does not affect the signs of the size 
factors for the other axes, but it does change the sign of the corresponding X-to-Y and X-to-Z 
ratios.

To reverse the direction of your 3-D axis:

1. From the Axis menu, choose Edit. The Edit Axis dialog appears.

2. Choose the Range page and the appropriate axis.

3. Select the Independent axis mode.

4. Enter a negative number in the Size Factor text field for the axis you want to reverse.

17.3.2. Axis Dependency
Axis dependency is available for all plot types except Polar Line. When you modify the range 
on one axis, other axes may be affected as well, depending on the current dependency settings 
for the axes. Axes may be dependent or independent; in general, if axes are dependent, chang-
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ing the range for one axis causes similar changes in the other axes, while changing the range of 
an independent axis has no effect on the other axes. As you can see, axis dependency within 
Tecplot is distinct from dependency relations within your data.

For Sketch, XY Line, and 2D Cartesian axes, the dependency relations Dependent and Inde-
pendent are the only choices. For XY Line plots, independent axes are the default; for 2D Car-
tesian field plots, dependent axes are the default. You can effect the shape of the axes by using 
the X to Y Ratio field on the dialog. This field changes the relationship between your X and Y 
axes.

To control the dependency of your axes:

1. From the Plot menu, choose Axis. The Axis Details dialog appears; choose the Range page 
and the appropriate axis.

2. In the region labeled Dependency, choose Independent or Dependent.

3. If you choose dependent, enter a value in the X to Y Ratio text field.

For example, if you enter 2 in the X to Y Ratio text field and Dependent is checked, the Y axis 
will be twice as long as the X axis.

Axis dependency for 3D Cartesian plots is similar to XY Line and 2D Cartesian, however you 
can also change the dependency of the Z-axis.

For 3-D axes, there are three dependency modes, as follows:

• Independent: All axes are independent.

• XY Dependent: The X- and Y-axes are dependent upon each other just as for dependent 2-
D axes. The Z-axis is independent.

• XYZ Dependent: Changing the scale on any axis results in a proportional change in scale 
on the other two axes, so that the specified X to Y Ratio and X to Z Ratio are preserved.

To control the dependency of your axes:

1. From the Plot menu, choose Axis. The Axis Details dialog appears; choose the Range page 
and the appropriate axis.

2. In the region labeled Dependency, choose Independent, XY Dependent, or XYZ Depen-
dent.

3. For XY Dependent axis mode, enter the X to Y Ratio in the text field.

4. For XYZ Dependent mode, also enter the X to Z Ratio in the text field.

17.3.3. Polar Axis
Polar axes are different than any other axis type due to their cyclical nature. Polar axes are sep-
arated into the Theta- and R-axis. Each axis has very different settings, unlike XY- or XYZ- 
axes. For the Theta-axis you can change the Theta Mode, Theta Period, and orientation; for the 
R-axis you can change the origin; and for both axes you can clip the data to the axes. Below is 
a discussion of each of these features.
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By default the Theta-axis is in degrees mode with a range of zero to 360. This default can be 
changed through the Tecplot configuration file. In the Tecplot configuration file there is a 
section dedicated to polar plots. See Section 30.1, “Configuration Files,”  for more information 
on changing settings in the Tecplot configuration file.

17.3.3.1. Clip Data to Axes. For Polar Line plots, it is possible to have data that extends 
beyond the edges of the axes. Use this feature to eliminate data drawn outside of the range of 
the axes. Clipping data can be set independently for the axes. For example, you may clip data 
for the Theta-axis, yet see points extending beyond the R-axis. To change this setting, use the 
Clip Data to Axis toggle on the Range page of the Axis Details dialog. This feature is illus-
trated in Figure 17-3.

17.3.3.2. Theta Mode. For the Theta axis you can change the mode in which the axis is 
drawn. There are three modes available: Radians, Degrees and Arbitrary. The options for the 
Theta Mode are 0 - 360 degrees, -180 – 180 degrees, 0 – 2 Pi radians, -Pi – Pi radians, and Fit 
to Var Min/Max. Selecting any of these options changes the Theta Mode, resets the Theta-axis 
range, and resets the Theta Period.

To change the Theta Mode:

1. Launch the Axis Details dialog. Select the Range page and the Theta-axis.

2. Click Reset (next to Theta Mode).

3. Select the appropriate Theta Mode.

When the Theta Mode is radians, Tecplot attempts to draw theta labels as fractional units of Pi. 
An example is shown in Figure 17-4.

17.3.3.3. Theta Period. The Theta Period specifies the theta range that is required to create 
a complete circle. If your Theta Mode is Degrees, the Theta Period is forced to 360; for 
Radians the period is 2 Pi. For Arbitrary you can set the period to any value.

Figure 17-3. An example of clipping polar data to an axis.
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17.3.3.4. Theta Value on Circle Right. The Theta Value on Circle Right setting changes 
the orientation of the Theta-axis. By default this value is zero, which means that the value zero 
(or equivalent value, 360 degrees, 720 degrees, and so forth) is displayed on the right hand side 
of the circle. You can change this value to change the orientation of the axis. For example, if 
your plot has a Theta Mode of Degrees and you set the Theta Value on Circle Right to be 270, 
the value 270 appears on the right hand side of the plot and zero is straight up. If the axis is 
reversed, zero is straight down.

17.3.3.5. R-Origin. The R-Origin can be changed on the Range page of the Axis Details dia-
log. This setting specifies what value of R is represented at the center of the axis. The R-axis 
has a range of 0.3 to 0.6 and the effect of changing the R-origin value may be seen in 
Figure 17-5.

Figure 17-4. An example of polar radian labels.

Figure 17-5. An example of changing the R-origin on a polar plot.
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17.4. Axis Grids
The grid area is one or more regions defined and bounded by the axes. For XY Line and 2D 
Cartesian plot types, the grid area is the rectangle defined by the X- and Y-axes. For 3D Carte-
sian plot types, the grid area consists of the three rectangles defined by the X-, Y-, and Z-axes. 
For Polar Line plots, the grid area is defined by the annular segment of the axes.

Gridlines are a set of lines drawn from one or more axes. Gridlines extend from the tick marks 
on an axis, across the grid area. Minor gridlines extend from the minor tick marks. Gridlines 
make it easier to determine the values of individual data points. For polar axes, the R-grid lines 
form circular lines, while Theta-grid lines are rays emanating from the center of the grid out-
ward.

The precise dot grid is a set of small dots drawn at the intersection of every minor gridline. In 
line plots, the axis assignments for the first active mapping govern the precise dot grid. The 
precise dot grid option is disabled for the 3D Cartesian plot type, and line plots when either 
axis for the first active line mapping uses a log scale.

You control the gridlines and precise dot grid from the Grid page of the Axis Details dialog, as 
shown in Figure 17-6.

17.4.1. Gridlines
You can control whether grid lines or minor gridlines are shown using the Grid page of the 
Axis Details dialog. This includes line pattern, pattern length, or line thickness. The spacing of 
gridlines is controlled by the tick mark spacing; see Section 17.5, “Tick Marks and Labels,”  
for more information.

To control grid lines and minor grid lines:

1. From the Plot menu, select Axis. The Axis Details dialog appears. Select the Grid page.

2. To show gridlines, select the Show check box under Gridlines. To show minor gridlines, 
select the Show check box under Minor Gridlines.

Figure 17-6. The Grid page of the Edit Axis dialog for a Polar Line plot.
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3. On the Grid page, specify a line pattern, line pattern length, and line thickness for both the 
gridlines and minor gridlines.

For the Theta-axis in the Polar Line plot type, you can also specify a gridline cutoff. The grid-
line cutoff is the point along the R-axis in which you want to stop drawing Theta-gridlines. In a 
Polar Line plot the abundance of gridlines at the center may obscure data, in which case you 
may want to adjust this setting. For an example of polar grid cutoff, see Figure 17-7.

17.4.2. Precise Dot Grid
From the Grid page of the Axis Details dialog, you can control whether the precise dot grid is 
shown, and if so, the size and color. The effect of turning on the precise dot grid is shown in 
Figure 17-8.

To control the precise dot grid:

1. From the Plot menu, select Axis. The Axis Details dialog appears. Select the Grid page.

2. To show the precise dot grid, select the Show check box under Precise Dot Grid.

Figure 17-7. An example of polar grid cutoff.

Figure 17-8. An example of polar plot showing the precise dot grid (left); the effect of 
turning on the precise dot grid (right).

Theta

R

0

20

40

60

80100

120

140

160

180

200

220

240

260 280

300

320

340

0 0.1 0.2 0.3 0.4 0.5

No Gridline Cut-Off

Theta

R

0

20

40

60

80100

120

140

160

180

200

220

240

260 280

300

320

340

0 0.1 0.2 0.3 0.4 0.5

Using Gridline Cut-Off

Theta

R

0

20

40

60

80100

120

140

160

180

200

220

240

260 280

300

320

340

0 0.1 0.2 0.3 0.4 0.5 0.6

Station

T
em

pe
ra

tu
re

°C

0 1 2 3 4 5
0

100

200

300

Skin Temperature



Chapter 17. Axes

306

3. Specify dot size (measured in centimeters on the output) and color as desired.

17.4.3. Gridline Draw Order
For all axes except 3-D, you may specify a gridline draw order. Gridlines may be drawn either 
first, before any of the other plotting layers, or last, so they overlay any plotting layers. These 
different options are illustrated in Figure 17-9.

You can also specify the gridline draw order by “pushing” or “popping” the axis grid area from 
the Edit menu. First select the axis grid area by clicking on a gridline, then choose Push from 
the Edit menu to plot the gridlines first, or choose Pop to plot the gridlines last.

17.5. Tick Marks and Labels
Each axis can be marked with tick marks, and those tick marks may or may not be labeled, 
either with numbers or with custom text strings. You control tick marks and their placement 
using the Ticks page of the Axis Details dialog. You control the tick mark labels using the 
Label page of the Axis Details dialog. You can control the tick mark spacing from either page.

17.5.1. Tick Marks
From the Ticks page of the Axis Details dialog, you can specify any of the following tick mark 
attributes independently for each axis:

• Whether tick marks are displayed.

• Length of tick marks and minor tick marks.

• Thickness of tick marks and minor tick marks.

• Number of minor tick marks between tick marks.

• Direction of the tick marks (into the plot, out of the plot, or centered on the axis line).

• Spacing and position of tick marks.

Figure 17-9. The grid plotting order.
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17.5.1.1. Tick Mark Display. You can show tick marks on any, all, or none of your axes.

To show tick marks for an axis:

1. From the Plot menu, choose Axis. The Axis Details dialog appears. Select the Ticks page, 
as shown in Figure 17-10.

2. Choose the axis for which you want to show tick marks. Select one of the toggles below the 
Show Ticks On label.

Note: There is no separate control for showing minor tick marks, as there is for minor grid-
lines. To show no minor tick marks, enter zero in the Number of Minor Ticks text field.

To hide tick marks, deselect the toggles below the Show Ticks On label.

For each plot type there are many different sections of the axis on which you can display tick 
marks (this description also applies to Labels and Titles).

Sketch, XY Line, and 2D Cartesian axes allow tick marks to be displayed in the following 
areas:

• Axis Line.

• Grid Border Left (Grid Border Bottom).

• Grid Border Right (Grid Border Top).

Where Axis Line is the line that represents the specified axis. By default the axis line and grid 
border left/bottom are in the same position. Grid Border Left is the left most position of the 
grid as defined by the viewport settings on the Area page of the Axis Details dialog. Grid 
Border Bottom, Right, and Top are similarly defined by the viewport settings.

Polar R-axis allows tick marks to be displayed in the following areas:

• Axis Line.

• All R-axes.

Figure 17-10. The Ticks page of the Axis Details dialog.
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• Grid Border Start.

• Grid Border End.

Where Axis Line is the line that represents the R-axis. The option, All R-axes, is only available 
if the Draw Axis in Both Directions toggle or Draw Perpendicular Axis toggle is checked for 
the R-axis, see Section 17.7.2, “Polar Axes Positioning.”  The All R-axes setting will draw tick 
marks on the additional axes that are drawn if the aforementioned toggles are checked. Grid 
Border Start and Grid Border End are the start and end points of the polar grid area. These 
options are only available if the polar plot does not form a complete circle. For example a plot 
that only goes from zero to 90 degrees can have tick marks drawn at the grid border start/end. 
If the data forms a complete circle, there is no start or end point on which to draw the ticks.

Polar Theta-axis allows tick marks to be displayed in the following areas:

• Axis Line.

• Inner Circle.

• Outer Circle.

Where Axis Line is the line that represents the Theta-axis. Inner Circle is only available if the 
minimum value on the R-axis is greater than the R-Origin value; when this is the case, the 
center of the polar plot is a circle rather than a single point, therefore ticks can be drawn on the 
inner circle. Outer Circle is the outer edge of the polar grid area.

Three-dimensional axes allow tick marks to be displayed in the following areas:

• Axis Line.

• Opposite Edge.

Where Axis Line is the line that represents the specified axis. Opposite Edge is complimentary 
line that is opposite the axis line.

17.5.1.2. Tick Mark Length and Thickness. Tick mark length and thickness can be set 
independently for tick marks and minor tick marks using the Length and Thickness fields on 
the Ticks page of the Axis Details dialog.

17.5.1.3. Number of Minor Tick Marks. The number of minor tick marks can be set in the 
Number of Minor Ticks text field on the Ticks page of the Axis Details dialog. By selecting the 
Auto Spacing toggle at the bottom of the page, Tecplot will determine an optimal number of 
minor ticks for you.

17.5.1.4. Tick Mark Direction. You can specify the direction in which the tick marks are 
drawn.
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The following options are available:

• In: Tick marks and minor tick marks are drawn from the axis toward the center of the plot-
ting region.

• Out: Tick marks and minor tick marks are drawn from the axis away from the center of the 
plotting region. 

• Center: Tick marks and minor tick marks are centered on the axis line.

17.5.2. Tick Mark Labels
Tick mark labels are the values that are displayed next to the axis tick marks and represent the 
data value at that tick mark. From the Labels page of the Axis Details dialog, you can specify 
attributes for tick mark labels for each axis.

The following options are available:

• Whether tick mark labels are displayed.

• The color, font, and size of the tick mark labels.

• The format of the tick mark labels.

• The offset of the tick mark labels—that is, the distance between the tick mark labels and the 
axis line (in frame units for Polar Line, XY Line, and 2D Cartesian axes, and as a percent-
age of the median axis length for 3D Cartesian axes).

• The orientation of the tick mark labels. This is the angle the labels make with the horizon-
tal, or they can be placed parallel or perpendicular to the axis.

• Show label at axis intersection.

• Erase behind labels.

• A label skip for each axis. This is the number of major tick marks to skip. For example, 
with the label skip set to 2, every other major tick mark will be labeled.

• The position and spacing of the tick marks and tick mark labels

17.5.2.1. Tick Mark Label Display. Tick mark labels can be displayed on the same objects 
as tick marks themselves. For a discussion of where tick mark labels can be displayed see Sec-
tion 17.5.1.1, “Tick Mark Display.” 

There are however two other settings that affect the tick label display. These settings are Show 
Label at Axis Intersection and Erase Behind Labels. The Show Label as Axis Intersection 
toggle draws a label at the point where two axes intersect. When the toggle is unchecked, 
Tecplot does not draw labels at axis intersection points. Use this toggle if you have axis labels 
that are colliding, or stacked on top of one another a the intersection of two axes. This problem 
is common for polar axes, so the default for polar axes is to have this toggle turned off. The 
Erase Behind Labels toggle creates a rectangle behind the label so in some cases the labels are 
more easily seen.
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17.5.2.2. Tick Mark Label Formats. You can choose several numeric formats for your tick 
mark labels, or specify a set of text strings to use as custom labels.

The following numeric formats are available:

• Integer: Tick marks are labeled in integer format (for example, 12). If this format is 
selected, tick mark labels with a decimal part are truncated.

• Float: Tick marks are labeled with floating-point numbers (for example, 10.2).

• Exponent: Tick marks are labeled using numbers in exponential format (for example, 
1.02E-03).

• Best Float: Tecplot selects the best floating-point representation of the tick mark labels.

• Range Best Float: Tecplot selects the best floating-point representation of the tick mark 
labels, taking into account the range of values on the axis.

• Superscript: Tick marks are labeled with numbers in scientific notation (for example, 
1.2x10-3).

• Custom: Uses the specified custom label set to label the axes.

Custom labels are text strings defined in your data file that allow you to print meaningful labels 
for variables that do not contain numeric data, such as variables that contain names or levels 
(such as Yes/No, Small/Medium/Large, or months of the year) of a categorical variable. 
Custom labels are defined using the CUSTOMLABELS record; each CUSTOMLABELS record 
corresponds to one custom set. When you choose custom labels for an axis, you also choose 
which custom set should be used for that axis.

To specify the format for your tick mark labels:

1. From the Labels page of the Axis Details dialog, choose the axis for which you want to 
specify the format of the tick mark labels.

2. Click Number Format on the Label page; the Specify Number Format dialog appears, ash 
shown in Figure 17-11.

3. Choose one of formats from the Format drop-down: Integer, Float, Exponent, Best Float, 
Range Best Float, Superscript, Custom.

(Float, Exponent, or Superscript only): Enter a value in the Precision field to specify the 
number of digits to the right of the decimal point in the tick mark labels. The default is four.

(Custom only): Enter a value in the Custom Set field to specify which set of custom labels 
to use on this axis.

Other options for changing the format of your labels include:

• Show Decimal on Whole Numbers: When this toggle is checked, whole numbers include 
a trailing decimal (that is, the number 2 is displayed as 2.).

• Remove Leading Zeros: When this toggle is checked leading zeros are removed from 
numbers (that is, 0.25 is displayed as .25).
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• Show Sign on Negative Numbers: When this toggle is checked negative numbers show 
the negative sign. When unchecked the negative sign will be removed (that is, -1.43 is dis-
played as 1.43). This is useful if you have specified a special prefix or suffix for negative 
values.

• Prefix and Suffix: You can specify a custom prefix and/or suffix for numbers in Tecplot 
using the Prefix/Suffix text fields. Tecplot allows you to specify separate prefixes and suf-
fixes for zero values and negative values as well.

17.5.2.3. Custom Labels. As a simple example of using custom labels, consider the follow-
ing data file, containing data about attendance at two schools:

VARIABLES="SCHOOL", "ATTENDANCE"

CUSTOMLABELS "Cleveland", "Garfield"

ZONE T="1991"

1 950

2 640

ZONE T="1992"

1 1010

2 820

Figure 17-11. The Specify Number Format dialog.
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The numbers 1 and 2 represent the school number, and the CUSTOMLABELS record defines 
Cleveland as school one and Garfield as school two. Once you assign custom labels in Tecplot, 
the School axis is labeled with Cleveland and Garfield rather than 1 and 2.

To create a plot with custom labels:

1. Create a data file with one or more CUSTOMLABELS records, and one or more variables 
with ordered integer values 1, 2, 3, and so forth. The first string in the CUSTOMLABELS 
record corresponds to a value of 1, the second string to 2, and so on. Read the data file into 
Tecplot.

2. Create a plot. XY Line plots are the most likely to use custom labels, but you can use them 
anywhere.

3. From the Plot menu, choose Axis, and select the Label page of the Axis Details dialog.

4. Choose the axis for which you want to assign custom labels, click Number Format, and 
select Custom from the Format drop-down. Choose a set of custom labels for the axis from 
among all the CUSTOMLABELS records in the data file. For this example, edit the X-axis 
and choose custom set 1.

5. Go to the Ticks page of the Axis Details dialog. Deselect Auto Spacing, then set the spac-
ing to one. (You may also want to set the number of minor ticks to zero.)

6. Go to the Range page of the Axis Details dialog. Set the Min and Max value to 0.5 and 2.5 
respectively.

7. Close the Axis Details dialog, then go to the sidebar. From the plot layers, select the Bars, 
deselect the Lines check box.

The attendance data are plotted in Figure 17-12.

Figure 17-12. Bar charts with custom labels.
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As another example, consider the following data file containing temperature and rainfall data:

VARIABLES="MONTH", "TEMPERATURE", "RAINFALL" 
CUSTOMLABELS "Jan", "Feb", "Mar", "Apr", "May", "Jun" 

"Jul", "Aug", "Sep", "Oct", "Nov", "Dec" 
CUSTOMLABELS "Cold", "Cool", "Warm", "Hot" 
CUSTOMLABELS "Dry", "Average", "Wet" 
1 1 1 
2 1 2 
3 2 3 
4 2 3 
5 3 3 
6 3 2 
7 4 1 
8 4 1

This weather data file is plotted in Figure 17-13.

Custom labels are used cyclically. That is, if the variable assigned to the axis using custom 
labels goes over the number of custom labels, Tecplot starts with the first label again. This is 
useful for days of the week, months of the year, or other cyclical data. In the weather data set 
above, a value of 13 for the MONTH variable yields a tick mark label of “Jan.” Similarly, a 
value of five for TEMPERATURE yields a tick mark label of “Cold.”

17.5.3. Tick Mark and Label Spacing
You can control tick mark and tick mark label spacing directly, or use Auto Spacing (the 
default), to calculate an optimal spacing for tick marks and tick mark labels. As you change 
views, particularly in zooming, Tecplot recalculates the spacing. With Auto Spacing selected, 
Tecplot also calculates the number of minor tick marks for you.

The tick mark and label spacing values are shared between the tick marks and tick labels. If 
you change the spacing for your axis labels, the tick marks use the same spacing. You can 

Figure 17-13. A 3-D plot with custom labels on each axis.
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change the spacing by adjusting the controls at the bottom of the Ticks or Label pages of the 
Axis Details dialog.

For a particular view, you may want to exercise manual control by specifying the spacing, and 
an anchor position, which specifies a particular value at which one tick mark should be drawn; 
additional tick marks are drawn at intervals determined by the spacing value.

To exercise manual control of tick marks and tick mark labels:

1. From the Plot menu, choose Axis. The Axis Details dialog appears. Click Ticks to display 
the Ticks page, or Label to display the Label page.

2. Choose the axis for which you want to specify tick mark and tick mark label spacing.

3. In the area labeled Tick Mark and Label Spacing, deselect Auto Spacing.

4. In the text field labeled Spacing, specify a spacing value in the units of the variable 
assigned to the axis.

5. In the text field labeled Anchor, specify a value at which you want one tick mark drawn. 
Additional tick marks are spaced according to the Spacing parameter away from this 
anchor tick mark.

17.6. Axis Titles
An axis title is a text label that identifies the axis. By default, Tecplot labels each axis with the 
name of the variable assigned to that axis.

From the Title page of the Axis Details dialog, you can specify the following attributes for 
each axis title:

• Whether axis titles are displayed, and if so, where, and what text to use for the title.

• The color, font, and size of the axis title.

• The offset of the axis title—that is, the spacing between the axis title and the axis line.

• The position of the axis title along the axis line.

17.6.1. Axis Title Display
Axis titles can be displayed on the same objects as tick marks and tick mark labels. For a dis-
cussion of where axis titles can be displayed see Section 17.5.1.1, “Tick Mark Display.” 

If you choose to show the axis title, you can either specify to use the variable name that is 
assigned to the selected axis, or you can specify text string to use.

To specify the axis title:

1. From the Axis Details dialog select the Title page, as shown in Figure 17-14.

2. Select Use Variable Name or Use Text. 

3. If you select Use Text, enter the desired axis title in the appropriate text field.
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You may also specify the color and font of the axis title by using Color and Font on the Title 
page. To more easily adjust the font size of the axis titles, use the up/down arrows to the right 
of the Font option.

17.6.2. Axis Title Offset
The axis title offset prevents Tecplot from printing your axis title directly on top of the axis. 
You specify the offset as a percentage. You may specify a negative offset, which moves the 
axis title to the other side of the axis. Zero offset prints the edge of the axis title on the axis.

To specify an axis title offset:

1. From the Plot menu, choose Axis. The Axis Details dialog appears; click Title.

2. Choose the axis for which you want to modify the axis title offset.

3. Enter the desired offset in the Offset (%) field.

4. (Optional) You may also adjust the axis title offset using the Adjustor  tool from the 
sidebar.

17.6.3. Axis Title Position
Using the Position along Line field you can change where the axis title is positioned along the 
axis line. For example, in an XY Line plot, if you want the axis title to be on the left side of the 
X-axis, specify a position near zero. If you want the axis title to be near the right side of the 
axis, specify a position near 100.

To specify an axis title position:

1. From the Plot menu, choose Axis. The Axis Details dialog appears; click Title.

2. Choose the axis for which you want to modify the axis title position.

3. Enter the position as a percentage in the Position Along Line text field.

Figure 17-14. The Title page of the Axis Details dialog.
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17.7. Axis Lines
The actual axis line is shown by default whenever the axis is shown, but it is just as much an 
optional part of the plot as the tick marks or tick mark labels. There may be situations when 
you want to see an axis represented simply by the tick marks or the gridlines, without an addi-
tional line for the axis itself. In such cases, you can hide the axis line without turning off the 
axis as a whole.

To show or hide the axis line:

1. From the Plot menu, choose Axis. The Axis Details dialog appears.

2. Click Line to call up the Line page of the Axis Details dialog, as shown in Figure 17-15.

3. Choose the axis for which you want to show or hide the axis line.

4. To show the axis line, select the Show Axis Line check box. To hide the axis line, deselect 
the Show Axis Line check box.

For Sketch, XY Line, Polar Line, and 2D Cartesian axes you can also show the Grid Border. 
The grid border is defined as the extents of the grid area, which is defined in Section 17.8, 
“Grid Area.” For Polar Line plots, you may also show the Viewport border, which is defined 
on the Area page of the Axis Details dialog. For 3D Cartesian plots you may elect to show the 
line opposite the axis line. The axis line and line on opposite edge are always drawn if any of 
the faces adjacent to them have grid lines or are filled, or are part of the axis box; in this case 
the toggles have no effect.

For Sketch, XY Line, and 2D Cartesian axes you can specify a separate color and line thick-
ness for the axis line and grid border. For Polar Line plots, the grid border color and line thick-
ness is shared with the axis line, however the viewport border may have separate color and line 
thickness settings. In 3D Cartesian plots, the axis line, line on opposite edge, and axis box all 
share the same color and line thickness settings.

Figure 17-15. The Line page of the Axis Details dialog.
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17.7. Axis Lines

17.7.1. Sketch, XY Line, and 2D Cartesian Line Position
Sketch, XY, and 2D axes can be positioned in a couple different ways. The first, and easiest is 

to use the Adjustor  by selecting the axis you want to move and simply drag it into the 
desired position. When dragging the axis, it pins itself at the minimum or maximum of the grid 
area. Once the axis is pinned at the edge of the grid area, you may reselect it an move it beyond 
the edge of the grid area, but you cannot drag it beyond the edge of the frame. The second 
method for positioning the axis line is manually through the Line page of the Axis Details dia-
log.

To manually position the axis line follow these steps:

1. From the Plot menu, choose Axis. The Axis Details dialog appears; click Line.

2. Choose the axis for which you want to change the axis position.

3. Select the desired option from the Align Axis with drop-down.

4. Enter the desired offset or position in the sensitive text field.

17.7.2. Polar Axes Positioning
Polar axes, unlike Sketch, XY Line, and 2D Cartesian axes, cannot be positioned interactively. 
You must use the Axis Details dialog to change the position of a given axis line.

For the Theta axis, you can align the axis with the following objects:

• R-Value.

• Inner Circle.

• Outer Circle.

When aligning with an R-value you may enter an R-axis value to specify the position of the 
axis line. When aligning with the inner or outer circle, specify an offset. With a zero offset, the 
axis line is on the inner or outer circle, a positive offset moves the axis line outside the grid 
area. A negative offset moves the axis line within the grid area.

For the R-axis the alignment options are more numerous. The possible options are:

• Theta Value: Align the R-axis with a specific Theta-value. The axis is limited to the grid 
area.

• Grid Border Start: Align the R-axis with the start of the grid border. The axis is limited to 
the grid area.

• Grid Border End: Align the R-axis with the end of the grid border. The axis is limited to 
the grid area.

• Specific Angle: Align the R-axis with a specific screen angle. The axis is limited to the 
grid area.

• Top of Grid Area: Align the R-axis with the top of the grid area. The axis may be drawn 
outside the grid area.
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• Bottom of Grid Area: Align the R-axis with the bottom of the grid area. The axis may be 
drawn outside the grid area.

• Left of Grid Area: Align the R-axis with the left side of the grid area. The axis may be 
drawn outside the grid area.

• Right of Grid Area: Align the R-axis with the right side of the grid area. The axis may be 
drawn outside the grid area.

In addition to setting the alignment of the R-axis, you may choose to extend the R-axis by 
drawing an axis line perpendicular or parallel to the existing axis line. When the Draw Axis in 
Both Directions toggle is selected, Tecplot extends the axis line so it spans the width of the grid 
area. If the Draw Perpendicular Axis toggle is selected, Tecplot draws an axis line perpendicu-
lar to the main axis line.

17.7.3. Three-Dimensional Axes Position
In three dimensions, a given axis line might appear in any of four locations relative to the other 
axes. By default, Tecplot automatically places the three axis lines so they will not interfere 
with the drawing of the plot.

You can override this automatic edge assignment for each axis line as follows:

1. From the Plot menu, choose Axis. The Axis Details dialog appears; click Line.

2. Choose the axis for which you want to change the edge assignment.

3. Deselect Auto 3D Edge Assignment. Four option buttons, labeled Min-Min, Max-Min, 
Min-Max, and Max-Max, become active.

4. Select the option yielding the desired edge assignment.

17.8. Grid Area
The grid area of your plot is the area defined by the axes. For Sketch, XY Line, and 2D Carte-
sian plots you can alter the size of the grid area by changing the extents of the viewport. (For 
these plot types the viewport and grid area are synonymous.) For Polar Line and 3D Cartesian 
plots, the grid area is altered by changes to the axis ranges. For 3-D axes, you can also specify 
an axis box padding, the minimum distance from the data to the axis box, and whether to light-
source shade the axis planes. From the Area page of Axis Details, you control whether the grid 
area or viewport are color-filled. The Area page is shown in Figure 17-16.
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17.8. Grid Area

Figure 17-16. The Area page of the Axis Details dialog.
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18.1. Attribute Linking Between Frames

CHAPTER 18 Frame Linking

Tecplot’s frame linking feature allows you to link specific style attributes either between 
frames or within a frame.

The Set Links for Current Frame dialog controls linking. To access the dialog, select Style 
Linking on the Plot menu.

18.1. Attribute Linking Between Frames
Linking between frames allows you to quickly make changes in one frame and propagate them 
through a number of other frames. For example, you might link the contour levels in one frame 
to the contour levels in another frame. If you change the contour levels in one of the linked 
frames, the resulting contour levels will also be used in the other linked frame.

18.1.1. Attributes Linkable Between Frames

The Between Frames page of the Set Links for Current Frame dialog is shown in Figure 18-1. 

It allows you to link the following attributes:

• Frame Size and Position: Allows you to stack transparent frames. (See Section 2.1.4, 
“Frame Background Color Modification,” for further information.)

• X-Axis Range: For XY Line and 2-D plots. This links not only the ranges on the X-axis 
but also the positioning of the left and right sides of the viewport.

• Y-Axis Range: For XY Line and 2-D plots. Links not only the ranges on the Y-axis but also 
the positioning of the top and bottom of the viewport.

Figure 18-1. The Between Frames page of the Set Links for Current Frame dialog.
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• XY-Axis Position: For XY Line and 2-D plots. Links the positioning of the X- and Y-axes 
between frames. This includes the method used for positioning the axes, such as aligning 
with an opposing axis value. The axis positioning has no bearing on the range of values on 
the axis.

• Polar Plot View: Link views for frames using the Polar Line plot type.

• 3D Plot View: Link the 3-D axes and 3-D view.

• Slice Positions: Link slice positions and slice planes for active slices (but not slice style).

• Iso-Surface Locations: Link iso-surface values (but not iso-surface plot style).

• Contour Levels: Link the values and number of contour levels for 2- and 3-D plots.

• Value Blanking Constraints: Link all value-blanking attributes.

18.1.2. Frame Linking Groups

In addition to setting which attributes to link between frames, you can also choose to which 
group the current frame belongs. The first step when linking attributes between frames is to 
identify which frames are going to be assigned to which group. If you only have two frames, 
then this is unimportant as both frames default to being in group 1 and there is no need to have 
any other groups. Attributes are only propagated to other frames that are members of the same 
group and that have the same link attributes selected.

Figure 18-2 shows five frames. Frames A, B, and C are in group 1. Frames D and E are in 
group 2. Note that all five frames have their X-axis ranges linked. If you change the X-axis 
range in frame A, the corresponding change will occur in frames B and C. It will not occur in 
frames D and E, as they are not in group 1. A change to the X-axis range in frame D will only 
be propagated to frame E.

Figure 18-2. Five frames in two groups with different linking options.
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18.2. Attribute Linking Within A Frame

Some frames in Figure 18-2 also have linked contour levels. Changes in the contour levels in 
frame A would propagate to frame C only. Setting the link for contour levels in frame D has no 
effect as frame E, the only other frame in group 2, does not have the same attribute linked.

New frames added to a group take on the characteristics of previous members of the group. For 
this reason, it is important to start the group with a frame that has the characteristics you want 
for that group (though, once frames are in a group, a change to a linked attribute of one frame 
changes that attribute for all frames in that group).

18.1.3. Between Frame Link Attributes Propagation to Other Frames
Once link attributes are set in a frame, you must set these same attributes in other frames for 
linking to occur. Each frame may have each of the attributes selected or not linked. If you want 
all or a select group of frames to have the same link attributes click the appropriate Apply Set-
tings to All Frames button to quickly propagate the link settings. The alternative is to select 
each frame individually, making the same selections on the Set Links for Current Frame dia-
log.

18.1.4. Dependent Axes

When 2-D or XY Line frames have dependent axes and the axis ranges are linked, Tecplot 
makes a “best-fit” attempt to match the axis ranges between frames. Misalignments can occur 
when the aspect ratios for the lengths of the axes is not the same between two frames with 
linked X- and Y-axes. Setting the X- and Y-axes to be independent allows a precise match.

18.2. Attribute Linking Within A Frame
This section describes how to link attributes between similar objects within a frame. An exam-
ple of within frame linking is to link the axis label style. Changing the font for the labels on the 
X-axis is automatically propagated to the other axes for the current frame.

18.2.1. Attributes Linkable Within Frames

The Within Frame page of the Set Links for Current Frame dialog is shown in Figure 18-3. It 
allows you to link the following attributes:

• Axis Style: Link activation, colors, line styles, font styles for objects associated with axes.

• Gridline Style: Link activation, colors, line styles for gridlines.

• Zone/Map Color between Plot Layers: Link the color of meshes, contour lines, and other 
zone layers for Cartesian plots, or link the color of lines, symbols and other map layers for 
line plots.

• Zone Line Pattern between Plot Layers: Link line pattern style and length for meshes, 
vector and contour lines for Cartesian plots.
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18.2.2. Within Frame Link Attribute Propagation to Other Frames
The Apply Settings buttons quickly propagate link settings from the current frame to other 
frames. The alternative is to visit each frames one by one, making the same selections on the 
Set Links for Current Frame dialog.

Keep in mind that Within-Frame linking only links attributes between similar objects within a 
frame. These attributes are not linked to other frames. The Apply Settings buttons only makes 
other frames have the same Within-Frame linking properties (the same objects within the other 
frames are linked to themselves).

Figure 18-3. The Within Frame page of the Set Links for Current Frame dialog.
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CHAPTER 19 Finite-Element Data

A finite-element zone consists of a set of points (nodes) that are connected into polygonal or 
polyhedral units called elements. Associated with each element is a list of the nodes used by 
that element, in the order in which they are connected. A complete finite-element zone consists 
of the set of nodes plus the connectivity list for each element.

Tecplot supports both triangular and quadrilateral elements; these are collectively referred to as 
finite-element surface zones. Tecplot also supports tetrahedral or brick polyhedral elements, 
which are referred to as finite-element volume zones. Each Tecplot zone must be composed 
exclusively of one element type. You can, however, simulate zones with mixed element types 
by repeating nodes as necessary. Thus, a triangle element can be included in a quadrilateral 
zone by repeating one node in the element’s connectivity list, and tetrahedral, pyramidal, and 
prismatic elements can be included in a brick zone by repeating nodes appropriately.

While finite-element data is usually associated with numerical analysis for modeling complex 
problems in 3-D structures, heat transfer, fluid dynamics, and electromagnetics, it also pro-
vides an effective approach for organizing data points in or around complex geometrical 
shapes. For example, you may not have the same number of data points on different lines, there 
may be holes in the middle of the data set, or the data points may be irregularly (randomly) 
positioned. For such difficult cases, you may be able to organize your data as a patchwork of 
elements. Each element can be virtually independent of the other elements, so you can group 
your elements to fit complex boundaries and leave voids within sets of elements. Figure 19-1 
shows how finite-element data can be used to model a complex boundary.

Figure 19-1. Finite-element data used to model a complex boundary.
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19.1. Finite-Element Data Sets
Creating a finite-element data set is generally somewhat more work than creating a similar 
sized ordered data set, because in addition to specifying all the data points, you must also spec-
ify the connectivity list which describes how the data points are connected into elements. As an 
example, consider the data shown in Table 19-1.

We can create a POINT Tecplot data file for this data set as follows (a 2-D mesh plot of this 
data set is shown in Figure 19-2):

TITLE = "Example: 2D Finite-Element Data" 
VARIABLES = "X", "Y", "P", "T" 
ZONE N=8, E=4, DATAPACKING=POINT, ZONETYPE=FEQUADRILATERAL 
0.0 1.0 100.0 1.6 
1.0 1.0 150.0 1.5 
3.0 1.0 300.0 2.0 
0.0 0.0 50.0 1.0 
1.0 0.0 100.0 1.4 
3.0 0.0 200.0 2.2 
4.0 0.0 400.0 3.0 
2.0 2.0 280.0 1.9 
1 2 5 4 
2 3 6 5 
6 7 3 3 
3 2 8 8

The ZONE record describes completely the form and format of the data set: there are eight 
nodes, indicated by the parameter N=8; four elements, indicated by the parameter E=4, and the 
elements are all quadrilaterals, as indicated by the parameter ZONETYPE=FEQUADRILAT-
ERAL.

The same data file can be written more compactly in BLOCK format as follows:

Node X Y P T

A 0.0 1.0 100.0 1.6

B 1.0 1.0 150.0 1.5

C 3.0 1.0 300.0 2.0

D 0.0 0.0  50.0 1.0

E 1.0 0.0 100.0 1.4

F 3.0 0.0 200.0 2.2

G 4.0 0.0 400.0 3.0

H 2.0 2.0 280.0 1.9
Table 19-1. Finite-element data.
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19.1. Finite-Element Data Sets

TITLE = "Example: 2D Finite-Element Data" 
VARIABLES = "X", "Y", "P", "T" 
ZONE N=8, E=4, DATAPACKING=BLOCK, ZONETYPE=FEQUADRILATERAL 
0.0 1.0 3.0 0.0 1.0 3.0 4.0 2.0 
1.0 1.0 1.0 0.0 0.0 0.0 0.0 2.0 
100.0 150.0 300.0 50.0 100.0 200.0 400.0 280.0 
1.6 1.5 2.0 1.0 1.4 2.2 3.0 1.9 
1 2 5 4 
2 3 6 5 
6 7 3 3 
3 2 8 8

In BLOCK format, all values for a single variable are written in a single block. The length of the 
block is the number of data points in the zone. In POINT format, all variables for a single data 
point are written in a block, with the length of the block equal to the number of variables. The 
connectivity list, however, is the same for both formats.

You can change the connectivity list to obtain a different mesh for the same data points. In the 
above example, substituting the following connectivity list yields the five-element mesh 
shown in Figure 19-3. (You must also change the E parameter in the zone control line to 
specify five elements.)

1 2 4 4 
4 2 3 5 
5 3 6 6 
6 7 3 3 
3 2 8 8

Figure 19-2. A mesh plot of 2-D finite-element data.
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Finite-element surface data specify node 
locations in three dimensions. For example, 
consider the data in Table 19-2. Locations 
are listed for eleven nodes, each having 
only the three spatial variables X, Y, and Z. 
We would like to create an finite-element 
surface zone with this data set, where some 
of the elements are triangles and some are 
quadrilaterals. All the elements could be 
organized into one zone, of element type 
Quadrilateral, but as an illustration of creat-
ing 3-D surface data, create three zones: 
one triangular, one quadrilateral, and one a 
mixture (using quadrilaterals with repeated 
nodes for the triangles).

A Tecplot data file for the data in Table 
19-2 is shown below in POINT format and 
plotted in Figure 19-4:

TITLE = "Example: 3D FE-SURFACE 
ZONES" 
VARIABLES = "X", "Y", "Z" 
ZONE T="TRIANGLES", N=5, E=4, DATAPACKING=POINT, ZONETYPE=FETRIANGLE 
0.0 0.0 1.0 
-1.0 -1.0 0.0 
-1.0 1.0 0.0 
1.0 1.0 0.0 
1.0 -1.0 0.0 

Figure 19-3. Finite-element data of Figure 19-2 with different connectivity list.

(2D)    5 Aug 1996 Example: 2D Finite-Element Data
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(2D)    5 Aug 1996 Example: 2D Finite-Element Data

 X  Y  Z

 0.0  0.0  1.0

 0.0  0.0 −2.0

 1.0  0.0 −2.0

 1.0  1.0  0.0

 1.0  1.0 −1.0

 1.0 −1.0  0.0

 1.0 −1.0 −1.0

−1.0  1.0  0.0

−1.0  1.0 −1.0

−1.0 −1.0  0.0

−1.0 −1.0 −1.0
Table 19-2. Data set with eleven nodes and 
three variables.
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19.2. Three-Dimensional Volume Data Files

1 2 3 
1 3 4 
1 4 5 
1 5 2 
ZONE T="PURE-QUADS", N=8, E=4, DATAPACKING=POINT, 

ZONETYPE=FEQUADRILATERAL 
-1.0 -1.0 0.0 
-1.0 1.0 0.0 
1.0 1.0 0.0 
1.0 -1.0 0.0 
-1.0 -1.0 -1.0 
-1.0 1.0 -1.0 
1.0 1.0 -1.0 
1.0 -1.0 -1.0 
1 5 6 2 
2 6 7 3 
3 7 8 4 
4 8 5 1 
ZONE T="MIXED", N=6, E=4, DATAPACKING=POINT, ZONETYPE=FEQUADRILATERAL 
-1.0 -1.0 -1.0 
-1.0 1.0 -1.0 
1.0 1.0 -1.0 
1.0 -1.0 -1.0 
0.0 0.0 -2.0 
1.0 0.0 -2.0 
1 5 2 2 
2 5 6 3 
3 4 6 6 
4 1 5 6

19.2. Three-Dimensional Volume Data Files
Finite-element volume data in Tecplot is constructed from either tetrahedrons having four 
nodes or bricks having eight nodes. Bricks are more flexible, because they can be used 
(through the use of repeated nodes in the connectivity list) to construct elements with fewer 
than eight nodes and combine those elements with bricks in a single zone. Bricks, on the other 
hand, are harder to construct because care must be taken to make sure all faces in all bricks are 
planar.
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19.2.1. A Finite-Element Volume Brick Data Set

As a simple example of finite-element volume brick data, consider the data in Table 19-3. The 
data can be divided into five brick elements, each of which is defined by eight nodes. 

Figure 19-4. Three-dimensional mesh plot of finite-element surface data. 

X Y Z Temperature

0.0 0.0 0.0  9.5

1.0 1.0 0.0 14.5

1.0 0.0 0.0 15.0

1.0 1.0 1.0 16.0

1.0 0.0 1.0 15.5

2.0 2.0 0.0 17.0

2.0 1.0 0.0 17.0

2.0 0.0 0.0 17.5

2.0 2.0 1.0 18.5

2.0 1.0 1.0 20.0

2.0 0.0 1.0 17.5

2.0 2.0 2.0 18.0

2.0 1.0 2.0 17.5

2.0 0.0 2.0 16.5
Table 19-3. Data with fourteen nodes and four variables.
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19.2. Three-Dimensional Volume Data Files

In each element’s connectivity list, Tecplot draws connections from each node to three other 
nodes. You can think of the first four nodes in the element as the “bottom” layer of the brick, 
and the second four nodes as the “top.” Within the bottom or top layer, nodes are connected 
cyclically (1-2-3-4-1; 5-6-7-8-5); the layers are connected by connecting corresponding nodes 
(1-5; 2-6; 3-7; 4-8). Figure 19-5 illustrates this basic connectivity. When you are creating your 

own connectivity lists for brick elements, you must keep this basic connectivity in mind, par-
ticularly when using duplicated nodes to create pyramids and wedges. Tecplot lets you create 
elements that violate this basic connectivity, but the result will probably not be what you want.

The data file in POINT format is shown below:

TITLE = "Example: FE-Volume Brick Data" 
VARIABLES = "X", "Y", "Z", "Temperature" 
ZONE N=14, E=5, DATAPACKING=POINT, ZONETYPE=BRICK 
0.0 0.0 0.0 9.5 
1.0 1.0 0.0 14.5 
1.0 0.0 0.0 15.0 
1.0 1.0 1.0 16.0 
1.0 0.0 1.0 15.5 
2.0 2.0 0.0 17.0 
2.0 1.0 0.0 17.0 
2.0 0.0 0.0 17.5 
2.0 2.0 1.0 18.5 
2.0 1.0 1.0 20.0 
2.0 0.0 1.0 17.5 
2.0 2.0 2.0 18.0 
2.0 1.0 2.0 17.5 
2.0 0.0 2.0 16.5 
 
1 1 1 1 2 4 5 3 

Figure 19-5. Basic connectivity for finite-element bricks.
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2 4 5 3 7 10 11 8 
4 4 5 5 10 13 14 11 
4 4 4 4 9 12 13 10 
2 2 4 4 7 6 9 10

The same data in BLOCK format is shown below:

TITLE = "Example: FE-Volume Brick Data" 
VARIABLES = "X", "Y", "Z", "Temperature" 
ZONE N=14, E=5, DATAPACKING=BLOCK, ZONETYPE=FEBRICK 
0.0 1.0 1.0 1.0 1.0 2.0 2.0 2.0 2.0 2.0 2.0 2.0 2.0 2.0 
0.0 1.0 0.0 1.0 0.0 2.0 1.0 0.0 2.0 1.0 0.0 2.0 1.0 0.0 
0.0 0.0 0.0 1.0 1.0 0.0 0.0 0.0 1.0 1.0 1.0 2.0 2.0 2.0 
9.5 14.5 15.0 16.0 15.5 17.0 17.0 
17.5 18.5 20.0 17.5 18.0 17.5 16.5 
 
1 1 1 1 2 4 5 3 
2 4 5 3 7 10 11 8 
4 4 5 5 10 13 14 11 
4 4 4 4 9 12 13 10 
2 2 4 4 7 6 9 10

Figure 19-6 shows the resulting mesh plot from the data set listed in this section.

Figure 19-6. A finite-element brick zone.
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19.2. Three-Dimensional Volume Data Files

19.2.2. Creating a Finite-Element Volume Tetrahedral Data Set
As a simple example of an finite-element volume data set using tetrahedral elements, consider 
the data in Table 19-4. The data set consists of thirteen nodes, with seven variables. The nodes 
are to be connected to form twenty tetrahedral elements, each with four nodes. 

The data file in POINT format for the data in Table 19-4 is shown below, and plotted in 
Figure 19-7:

TITLE = "Example: FE-Volume Tetrahedral Data" 
VARIABLES = "X", "Y", "Z", "C", "U", "V", "W" 
ZONE N=13, E=20, DATAPACKING=POINT, ZONETYPE=FETETRAHEDRON 
0 0 -95 -1 1 0 8 
0 85 -42 0 -85 -3 9 
81 26 -42 2 -22 80 8 
50 -69 -42 -6 72 52 9 
-50 -69 -42 14 67 -48 9 
-81 26 -42 20 -30 -82 9 
0  0 0 1 -2 -5 10 
50 69 43 14 -68 48 11 
81 -26 43 20 31 82 11 
0 -85 43 0 84 3 10 
-81 -26 43 2 21 -80 11 
-50 69 43 -6 -71 -51 11 
0  0 96 1 0 -1 12 

X Y Z C U V W

  0   0 −95 −1   1   0  8

  0  85 −42  0  −5  −3  9

 81  26 −42  2 −22  80  8

 50 −69 −42 −6  72  52  9

−50 −69 −42 14  67 −48  9

−81  26  −2 20 −30 −82  9

  0   0   0  1  −2  −5 10

 50  69  43 14 −68  48 11

 81 −26  43 20  31  82 11

  0 −85  43  0  84  −3 10

−81 −26  43  2  21 −80 11

−50  69  43 −6 −71 −51 11

  0   0  96  1   0  −1 12
Table 19-4. Data with thirteen nodes and seven variables.
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1 2 3 7 
1 3 4 7 
1 4 5 7 
1 5 6 7 
1 6 2 7 
2 8 3 7 
3 9 4 7 
4 10 5 7 
5 11 6 7 
6 12 2 7 
12 2 8 7 
8 3 9 7 
9 4 10 7 
10 5 11 7 
11 6 12 7 
12 8 13 7 
8 9 13 7 
9 10 13 7 
10 11 13 7 
11 12 13 7 

This data file is included in your Tecplot distribution’s examples/data directory as the file 
fetetpt.dat. A block format version of the same data is included as the file 
fetetbk.dat.

19.3. Triangulated Data Sets
One common source of finite-element surface data is Tecplot’s triangulation option. If you 
have 2-D data without a mesh structure, it is probably simplest to enter your data points as an 
I-ordered data set, then use Tecplot’s triangulation feature to create a finite-element data set. 

Figure 19-7. Finite-element volume tetrahedral data.
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19.3. Triangulated Data Sets

You can then edit the file, and particularly the connectivity list, to obtain the set of elements 
you want, rather than having to create the entire connectivity list by hand. 

For example, consider again the data of Table 19-1. We can triangulate that data set as follows:

1. Enter the data as a simple ordered data file, as follows:
VARIABLES = "X", "Y", "P", "T" 
0.0 1.0 100.0 1.6 
1.0 1.0 150.0 1.5 
3.0 1.0 300.0 2.0 
0.0 0.0 50.0 1.0 
1.0 0.0 100.0 1.4 
3.0 0.0 200.0 2.2 
4.0 0.0 400.0 3.0 
2.0 2.0 280.0 1.9

2. Read the data file into Tecplot and switch the plot type to 2D Cartesian.

3. From the Data menu, choose Triangulate, then select the simple ordered zone as the source 
zone, and click Compute.

4. From the File menu, choose Write Data File. The Write Data File Options dialog appears.

5. Select the ASCII check box and the Point Format check box, then click OK.

6. Save to a file name of your choice. The result is the following finite-element surface zone 
(in addition to your original zone):
VARIABLES = "X" 
"Y" 
"P" 
"T" 
ZONE T="Triangulation" 
 N=8, E=7,DATAPACKING=POINT ZONETYPE=Triangle 
DT=(SINGLE SINGLE SINGLE SINGLE ) 
 0.000000000E+000 1.000000000E+000 1.000000000E+002 1.600000024E+000 
 1.000000000E+000 1.000000000E+000 1.500000000E+002 1.500000000E+000 
 3.000000000E+000 1.000000000E+000 3.000000000E+002 2.000000000E+000 
 0.000000000E+000 0.000000000E+000 5.000000000E+001 1.000000000E+000 
 1.000000000E+000 0.000000000E+000 1.000000000E+002 1.399999976E+000 
 3.000000000E+000 0.000000000E+000 2.000000000E+002 2.200000048E+000 
 4.000000000E+000 0.000000000E+000 4.000000000E+002 3.000000000E+000 
 2.000000000E+000 2.000000000E+000 2.800000000E+002 1.899999976E+000 
 2 3 5 
 5 4 2 
 4 1 2 
 7 6 3 
 5 3 6 
 3 2 8 
 8 2 1
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Figure 19-8 shows a plot of the resulting data. With triangulation, we obtain more elements 
(seven) than when we created the data set by hand (four), and the elements are triangles (natu-
rally) rather than quadrilaterals. However, when you have many data points, triangulation is 
the most reasonable approach.

19.4. Boundary Extraction of Finite-Element Zones
Boundary lines for finite-element data are similar to boundary lines in ordered data, with a few 
exceptions. For triangular and quadrilateral meshes a boundary is drawn along the edges of 
elements that have no neighboring element according to the element connectivity. In some 
cases finite-element data will be supplied to Tecplot where each element is independent of all 
the others, that is, elements do not share common nodes. For this type of data a boundary will 
be drawn around each element.

Finite-element volume data, such as tetrahedral and brick element types, will not plot boundary 
lines, as opposed to ordered volume data. With finite-element volume data there are, by defini-
tion, no boundary lines. However, some plot styles will draw on the outer surface of these 
zones, in effect they are just drawing on the boundary. Extracting the boundary of these zones 
extracts the outer surface.

To extract the boundary of a finite-element zone:

1. Choose the appropriate plot type for your data, either 2D or 3D Cartesian. If the zone for 
which you are extracting the boundary is a 3-D surface, make sure the plot type is set to 3D 
Cartesian. If you create the boundary zone in a 2D Cartesian plot, the Z-coordinate is not 
taken into account, and points that are not coincident in 3D Cartesian plots may become 
coincident in 2D plots. Tecplot eliminates coincident points in the final phase of the bound-
ary extraction, so you could lose important boundary points.

2. From the Data menu, choose Extract, then choose FE-Boundary. The Extract FE-Boundary 
dialog appears as in Figure 19-9.

3. Choose the source zone, that is, the zone for which you want to extract the boundary zone.

Figure 19-8. Triangulated data from Table 19-1.
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19.5. Finite-Element Data Limitations

4. If blanking is on, decide whether to include the boundary between blanked and un-blanked 
cells in the zone boundary. To include this boundary, select the check box labeled Retain 
boundaries between blanked and un-blanked cells.

5. Click Extract. The extracted boundary zone is an FE-surface zone with quadrilateral ele-
ments, but each element has two repeated nodes so that each element is a single line seg-
ment along the boundary.

19.5. Finite-Element Data Limitations
Working with finite-element data has some limitations, as follows:

• Finite-element data cannot be smoothed.

• Finite-element data cannot be mathematically differentiated.

• XY-plots of finite-element data treat the data as I-ordered; that is, the connectivity list is 
ignored. Only nodes are plotted, not elements, and the nodes are plotted in the order in 
which they appear in the data file.

• Index skipping in vector and scatter plots treats finite-element data as I-ordered; the con-
nectivity list is ignored. Nodes are skipped according to their order in the data file.

Figure 19-9. Extract FE-Boundary dialog.
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CHAPTER 20 Three-Dimensional 
Volume Data

This chapter brings together descriptions of most of the Tecplot tasks involving 3-D volume 
data, whether IJK-ordered or finite-element. In this chapter, you will find descriptions of the 
following common 3-D volume tasks:

• Choosing which surfaces you want to plot from your volume data.

• Choosing which data points to use for vector and scatter plots.

• Interpolating 3-D volume irregular data.

• Extracting I-, J-, and K-planes from an IJK-ordered zone.

• Generating and extracting iso-surfaces.

• Generating and extracting planar slices.

• Extracting the outer surface of an FE-volume zone.

• Generating and extracting volumes with a plane.

• Creating specialized 3-D volume plots.

Other related topics such as IJK-blanking and animating IJK-planes are discussed in Chapter 
25, “Blanking,” and Chapter 28, “Animation and Movies,” respectively.

20.1. Surfaces to Plot
There are many ways to divide volume data for plotting. One way to view volume data is to 
select surfaces from part of the data. For example, a typical plot would view a contour flooded 
plot drawn only on the outer surface of the volume data.

In Tecplot you may choose which surfaces to plot for volume zones from the Surfaces page of 
the Zone Style dialog. You can call up the Zone Style dialog by clicking Zone Style on the 
sidebar, or by double-clicking on a zone.

Figure 20-1 shows the Surfaces page of the Zone Style dialog. 

The Surfaces to Plot option allows you to choose on of the following:
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• Boundary Cell Faces: This will plot all surfaces on the outside of the volume zone. For 
IJK-ordered data this amounts to plotting the minimum and maximum I-, J-, and K-planes. 
For finite-element volume data this will plot all faces that do not have a neighbor cell 
(according to the connectivity list). If blanking is turned on, the boundary cells in the 
blanked region will not be drawn and you will be able to see the interior of the volume 
zone. Figure 20-2 shows plots of a volume zone with surface to plot set to Boundary Cell 
Faces without blanking, with value blanking, and with IJK-blanking.

• Exposed Cell Faces (Default): This setting is similar to the Boundary Cell Faces setting, 
save for cases in which value blanking is turned on. When value blanking is used the outer 
surfaces are drawn, similar to results from the Boundary Cell Faces setting. In addition, the 
cells faces between blanked and non-blanked cells are drawn. Figure 20-3 shows a plot of a 
volume zone with Surfaces to Plot set to Exposed Cell Faces with and without value blank-
ing.

• Planes Settings (I-, J-, K-, IJ-, JK-, IK-, and IJK-planes): These settings will plot the 
appropriate combination of I-, J-, and or K-planes. The planes are determined by the Range 
for columns to the right of the dialog. These settings are available only for IJK-ordered 
data. Figure 20-4 shows a number of examples of plotting I-, J-, and K-planes.

• Every Surface (Exhaustive): This setting will plot every face of every cell in volume data. 
It is not recommended for large data sets. Unless the surfaces are translucent, the plot will 
appear the same as for the Exposed Cell Faces setting.

Figure 20-1. The Surfaces page of the Zone Style dialog.
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20.2. Points to Plot

20.2. Points to Plot
You may select the source for the data points used to plot vectors and scatter symbols from the 
Points page of the Zone Style dialog. Your choices are Surface Nodes, All Nodes, All Con-
nected, Cell Centers Near Surfaces, and All Cell Centers. 

Choosing Surface Nodes will draw a vector or scatter symbol (when the appropriate zone layer 
is active) at every data point on all surfaces being plotted. To select the surface use the Sur-
faces to Plot option, discussed in the section above.

Choosing All will enable the plotting of vector or scatter symbols at every data point.

A plot where zone 1 is plotting scatter symbols only on one plane (J=5) and zone 2 is plotting 
all symbols is shown in Figure 20-5. 

Figure 20-2. Boundary Cell Face plotting without blanking, with value-blanking, and 
with IJK-blanking.

Figure 20-3. Examples of plots where Surfaces to Plot has been set to Exposed Cell 
Faces with (left) and without (right) value-blanking.
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In addition to selecting which surfaces to use to plot vector and scatter symbols, you may 
further limit these objects by setting the index skip on the Points pages of the Zone Style 
dialog. You can only set a skip value for ordered zones.

Figure 20-4. Examples of plotting I-, J-, and K-planes.

Figure 20-5. A plot showing two zones set to show only J-planes equal to five, with 
scatter symbols plotted on the surface in zone 1 and all symbols in zone 2.
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20.3. Derived Volume Object Plotting

20.3. Derived Volume Object Plotting
Volume streamlines, volume streamribbons, volume streamrods, slices and iso-surfaces are all 
derived from volume data automatically. The data used to generate these objects only exists for 
the life of the frame they are plotted in. When you save a layout or the style of a frame only the 
instructions necessary to recreate these objects are saved.

From the Volume page of the Zone Style dialog you may include or exclude volume zones 
from consideration in the construction of volume objects. Figure 20-6 shows a plot with two 

zones where streamribbons and an iso-surface have been excluded from zone 2.

20.4. Three-Dimensional Volume  
Irregular Data Interpolation

To use 3-D volume irregular data in Tecplot field plots, you must interpolate the data onto a 
regular, IJK-ordered zone. (Tecplot does not have a 3-D equivalent for triangulation.) To inter-
polate your data, perform the following steps:

1. Place your 3-D volume irregular data into an I-ordered zone in a data file.

2. Read in your data file and create a 3-D scatter plot.

3. From the Data menu, choose Create Zone, then choose Rectangular. The Create Rectangu-
lar Zone dialog appears.

4. Enter the I-, J-, and K-dimensions for the new zone; at a minimum, you should enter 10 for 
each dimension. The higher the dimensions, the finer the interpolation grid, but the longer 
the interpolating and plotting time.

Figure 20-6. A plot where streamribbons and an iso-surface have been excluded from 
zone 2.
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5. Enter the minimum and maximum X, Y, and Z values for the new zone. The default values 
are the minimums and maximums of the current (irregular) data set.

6. Click Create to create the new zone, and close to dismiss the dialog.

7. From the Data menu, choose Interpolate, then choose Kriging. The Kriging dialog appears 
(alternatively, choose Inverse Distance).

8. Choose the irregular data zone as the source zone, and the newly created IJK-ordered zone 
as the destination zone. Set any other kriging parameters as desired (see Section 24.8.2, 
“Kriging,” for details).

9. Click Compute to perform the kriging.

Once Tecplot completes the interpolation, you can plot the new IJK-ordered zone as any other 
3-D volume zone. You may plot iso-surfaces, volume streamtraces, and so forth. At this point, 
you may want to deactivate or delete the original irregular zone so as not to conflict with plots 
of the new zone.

Figure 20-7 shows an example of irregular data interpolated into an IJK-ordered zone, with 
iso-surfaces plotted on the resultant zone.

20.5. I-, J-, and K-Plane Extraction
Suppose you want to plot a collection of I-, J-, and K-planes that cannot be specified using the 
index range and index skip options of the Surfaces page of the Zone Style dialog. You can plot 
an arbitrary set of planes in Tecplot, but you must first extract each plane as a separate zone. 
Extracting planes is very simple using the Create SubZone dialog.

Figure 20-7. Irregular data interpolated into an IJK-ordered zone.
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20.6. Iso-Surface Generation and Extraction

To extract a K-plane from an IJK-ordered zone, follow these steps:

1. From the Data menu, choose Create Zone, then choose SubZone. The Create SubZone dia-
log appears as shown in Figure 20-8.

2. From the Source Zone drop-down, select the IJK-ordered zone.

3. In the K-Index fields, set Start and End to the same value: the number of the desired 
K-plane. Set Skip to 1. 

For example, to extract the K=5 plane, set Start to 5, End to 5, and Skip to 1.

4. Click Create to extract the plane. Tecplot creates an IJ-ordered zone containing just the data 
points in the extracted plane.

Extracting I- and J-planes is similar.

20.6. Iso-Surface Generation and Extraction
An iso-surface is a surface having a constant value for the contour variable. Iso-surfaces 
require that your data contains volume zones, such as IJK-ordered, finite-element brick, or 
finite-element tetrahedral zones. In Tecplot you control iso-surfaces from the Iso-Surface 
Details dialog under the Plot menu, shown in Figure 20-9.

20.6.1. Iso-Surface Locating

The locations of iso-surfaces are set on the Definition page of the Iso-Surface Details dialog. 
The contour values where iso-surfaces are defined can either be associated with the current set 
of levels for the selected contour group, or you may specify up to three unique levels indepen-
dent of the contour group levels. To enter unique levels, chose the 1, 2, or 3 Specified Values 
option from the Definition page of the Iso-Surface Details dialog. You can then either enter 
values in the appropriate text fields, or use the increase or decrease arrows.

If you choose the Contour Group Levels option to draw iso-surfaces, you may control the iso-
surface positions using the Contour Details dialog from the Plot menu, or by using a contour 
level tool from the sidebar. The Contour Add and Contour Delete tools may also be used to add 

Figure 20-8. The Create SubZone dialog.
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or delete iso-surfaces because they add and delete contour levels. The Contour Add tool may 
also adjust existing levels if you hold down the Ctrl key while clicking and dragging.

20.6.2. Iso-Surface Style
Style settings for all iso-surfaces are handled through the Style page of the Iso-Surface Details 
dialog. (These are independent of the style assigned to zones by the Zone Style dialog.) The 
following options are available:

• Show Iso-Surfaces: Select this check box to display iso-surfaces.

• Show Mesh: Select this check box to display the mesh on iso-surfaces.

• Mesh Color: Select a mesh color from the drop-down, or choose a custom color or multi-
color.

• Mesh Line Thickness: Select a mesh line thickness from the drop-down, or enter your 
own number in the text field.

• Show Contour: Select this check box to display contours on iso-surfaces.

• Contour Type: Select the contour display type.

• Flood by: If you chose contour flooding, select the contour group by which to flood the 
contours, or select RGB flooding.

• Contour Lines by: If you chose contour lines, select the contour group by which to draw 
lines.

Figure 20-9. The Iso-Surface Details dialog.
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20.6. Iso-Surface Generation and Extraction

• Contour Line Color: If you chose contour lines, click this button to display the Select 
Color dialog and choose the line color.

• Line Thickness: If you chose contour lines, select a contour line thickness from the drop-
down, or enter your own number in the text field.

• Show Shade: Select this check box to display shading on iso-surfaces.

• Shade Color: Select a shade color from the drop-down, or choose a custom color.

• Use Lighting Effect: Select this check box to enable the lighting effect drop-down where 
you may choose Paneled or Gouraud shading.

• Use Surface Translucency: Select this check box to enable the surface translucency text 
field, where you may set the surface translucency from one (opaque) to 99 (translucent).

20.6.3. Iso-Surface Extraction

You may wish to extract existing iso-surfaces to Tecplot zones to retain these surfaces while 
switching the contour variable to generate a different set of iso-surfaces. Once extracted, the 
new zones may be plotted like any other zone in which case style is set with the Zone Style 
dialog instead of the Iso-Surface Details dialog.

To extract iso-surfaces to zones, perform the following steps:

1. Add iso-surfaces to your plot as described above.

2. From the Data menu, choose Extract, then choose Iso-Surfaces. The Extract Iso-Surfaces 
dialog appears, as shown in  Figure 20-10.

3. Click Extract to create the new iso-surface zones, one zone for each contour level. All of 
the variables in the data set are interpolated from the 3-D volume zones to the data points of 
the iso-surfaces.

Iso-surface zones are FE-surface quadrilateral element-type zones, regardless of the original 3-
D volume zone types. The mesh of the iso-surfaces is derived from the mesh of the original 
zones, so that in regions where the original mesh was coarse, the iso-surface mesh is coarse, 
and where the original mesh was fine, the iso-surface mesh is fine.

Figure 20-10. The Extract Iso-Surfaces dialog.
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After creating the new iso-surface zones, it is often a good idea to turn off or reconfigure the 
current settings for iso-surfaces because the new zones will occupy the same physical space as 
the iso-surfaces.

20.7. Three-Dimensional Data Slicing
There are two methods for creating slices:

1. Create slicing planes defined by a constant X-, Y-, or Z-location, or constant I-, J-, or K-
index for IJK-ordered zones. These slices are created using either the Slice tool from the 
sidebar, or the Slices option of the Plot menu.

2. Extract an arbitrary slice using the Slice from Plane option on the Extract sub-menu of the 
Data menu. This option allows you to slice through 3-D surface as well as 3-D volume 
zones.

These operations are separate and each has unique advantages.

20.7.1. Slice Plane Definition

Slicing planes defined with the Slice Details dialog or the Slice tool become part of the style of 
your plot. They do not add to the data set used to create your plot unless you extract them. 
When you save a layout or stylesheet the information about where the slices are defined will be 
saved in your file.

Starting and ending slice positions may be defined. Intermediate slice positions between the 
start and end slice may also be activated. You may generate slices of constant X, Y, or Z, or, if 
you have IJK-ordered data, you may create slices of constant I, J, or K. Only volume zones 
may be sliced using this feature. The resulting slices are always 3-D surfaces.

Figure 20-11 shows the pages of the Slice Details dialog. Selecting the Show Slices check box 
activates the start slice.

20.7.1.1. The Position Page. Use the slider to move the start slice, or you may type in the 
slice position. Activate the end slice and move it with the end slice slider. You may also acti-
vate intermediate slices. Intermediate slices are distributed evenly between the start and end 
slices.

The following options are available:

• Show Slices: Select this check box to enable 3-D slicing.

• Draw Slices at: Select which plane to slice on.

• Slice 1: Your first slice.

• Position: Indicates the current location of your slice. Use the slider to select the position of 
your slice, or enter a value in the field.

• Show Slice 2: Select this check box to show a second slicing plane.
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20.7. Three-Dimensional Data Slicing

Figure 20-11. The pages of the Slice Details dialog, from upper left: the Position page, 
the Contour page, the Vector page, and the Other page.
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• Position: Indicates the current location of your slice. Use the slider to select the position of 
your slice, or enter a value in the field.

• Slider Range: Limit the range for the slides. A value of 100 means the slider range is the 
same as the range of the axis variable currently being sliced.

• Show Intermediate Slices: Select this check box to show intermediate slices between the 
first and second slices.

• Number of Intermediate Slices: Enter the number of intermediate slicing planes in the 
text field. (Range 1-100.)

20.7.1.2. The Contour Page. Use the Contour page to control the contour attributes of your 
3-D slices. The following options are available:

• Show Contours: Select this check box to show contours.

• Contour Type: Select the contour type of the flood from the drop-down. Lines, Flood, 
Lines and Flood, Average Cell Flood, and Primary Value Flood are available.

• Flood by: If you chose contour flooding, select the contour group by which to flood, or 
RGB flooding.

• Contour Lines by: If you chose contour lines, select the contour group by which to draw 
the lines.

• Line Color: Choose the line color from the Select Color dialog. Multi-Color will color the 
slice contour lines based on the contour group variable.

• Line Thickness: Specify the line thickness as a percentage of the frame width. You may 
enter a value in the text field, or choose one of the values in the drop-down.

• Use Lighting Effect: Select this check box to enable the lighting effect drop-down where 
you may choose Paneled or Gouraud shading.

• Use Surface Translucency: Select this check box to enable the surface translucency text 
field, where you may set the surface translucency from one (opaque) to 99 (translucent).

20.7.1.3. The Vector Page. Use the Vector page to control the vector attributes of your 3-D 
slices. The following options are available:

• Show Vectors: Select this check box to show vectors.

• Tangent Vectors: Select to use tangent vectors for your slices.

• Line Color: Choose the line color from the Select Color dialog. Multi-Color will color 
vectors based on the contour group variable. If no contour variable is set for the selected 
contour group, the Contour Details dialog will appear.

• Line Thickness: Specify line thickness as a percentage of the frame width. You may enter 
a value in the text field, or choose one of the values in the drop-down.

• Vector Type: Use this drop-down to set the vector type for your slices. Choose from Tail at 
Point, Head at Point, Anchor at Midpoint, and Head Only.
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20.7. Three-Dimensional Data Slicing

• Vector Head Style: Use this drop-down to set the vector head style for your slices. Choose 
from Plain, Filled, and Hollow.

20.7.1.4. The Other Page. Use this page to control the mesh, shade, and boundary 
attributes of your 3-D slices. The following options are available:

• Show Mesh: Select this check box to show mesh lines.

• Color: Choose the line color from the Select Color dialog. Multi-Color will color meshes 
based on the contour group variable. If no contour variable is set for the selected group 
when selecting Multi-Color, the Contour Details dialog will appear.

• Line Thickness: Specify the mesh line thickness as a percentage of the frame width. You 
may enter a value in the text field, or choose one of the values in the drop-down.

• Show Shade: Select this check box to show shading on the slice when Show Contour has 
not been selected or is set to Lines.

• Color: Choose the shade color from the Select Color dialog. Multi-Color and RGB color-
ing are not available—use flooded contours for multi-color or RGB flooding.

• Use Lighting Effect: Select this check box to enable the lighting effect drop-down where 
you may choose Paneled or Gouraud shading.

• Use Surface Translucency: Select this check box to enable the surface translucency text 
field, where you may set the surface translucency from one (opaque) to 99 (translucent).

• Show Boundary: Select this check box to show selected boundary lines on all slices.

• Color: Choose the boundary color from the drop-down of Tecplot’s basic colors. Multi-
Color and RGB coloring are not available.

• Line Thickness: Specify the boundary thickness as a percentage of the frame width. You 
may enter a value in the text field, or choose one of the values in the drop-down.

20.7.1.5. Slice Tool Use. The Slice tool allows you to position slice planes with your 
mouse. Select the tool from the sidebar, then click on a surface anywhere in your data. A slice 
will be positioned according to the XYZ-location of the nearest surface below where you 
clicked.

When adding a slice to volume data it is often a good idea to plot the original data using the 
Shade zone layer and set the translucency to a high level, such as 70 percent. This will allow 
you to see the outer bounds of your data while placing your slice. It is necessary to see the 
surface in order to be able to place your slice by mouse-click.

The Slice tool offers mouse and keyboard shortcuts which can greatly speed Tecplot use, espe-
cially when working with large amounts of data. These are:

Click: Place a start slice.

Drag: Move the start slice.

Shift-click: Place the end slice

Shift-drag: Move the end slice.
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+: Turn on the start slice if no slices are active, or turns on the end slice if slices are already 
active.

- : Turn off the end slice if the end slice is active, or conversely, turns off the start slice if the 
end slice is not active. 

I, J, K (ordered zones only): Switch to slicing constant I-, J-, or K-planes respectively.

X, Y, Z: Switch to slicing constant X-, Y, or Z-planes respectively.

1-9: Activate intermediate slices and set the number of intermediate slices to the number 
entered.

0: Turn off intermediate slices.

Alt-click/Alt-drag: Determine the XYZ-location by ignoring zones and looking only at 
derived volume objects (streamtraces, slices, iso-surfaces, slices).

20.7.2. Slice Extraction

In most cases it is not necessary to extract slices to zones. Most existing slice features allow 
you to set almost any style. There are cases where you may need to display multiple sets of 
slices in various directions, so it is necessary to extract at least some of the slices to zones.

20.7.2.1. Pre-Defined Slice Extraction. To extract slices that you have pre-defined with 
the Slice tool or the Slice Details dialog choose the Current 3D Slices option from the Extract 
sub-menu of the Data menu. This option will create a separate zone for each slice plane.

20.7.2.2. Arbitrary Slice Extraction. To extract a slice at an arbitrary orientation, or to 
slice a 3-D surface instead of a volume, use the Slice from Plane option from the Extract sub-
menu of the Data menu.

Specify any of four different types of cutting planes, as follows: 

• Arbitrary: An arbitrary cutting plane. You may specify the position and orientation of the 
cutting plane using three points or an origin and a normal vector, or you can interactively 
place and rotate the cutting plane using the controls in the Extract Slice dialog.

• Constant X: A cutting plane of constant X-value. You may specify the X-value either by 
entering a value, or using a position slider.

• Constant Y: As Constant X above, but for a cutting plane of constant Y-value.

• Constant Z: As Constant X above, but for a cutting plane of constant Z-value.

To slice a 3-D zone with a plane:

1. From the Data menu, choose Extract, then choose the Slice from Plane option. The Extract 
Slice from Plane dialog appears as in Figure 20-12. 

2. Choose the option button corresponding to your desired slice plane (Arbitrary, Constant X, 
Constant Y, or Constant Z).
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3. If you choose Arbitrary as your cutting plane, you can either use the Position sliders and 
Rotate About buttons to position the cutting plane, or choose one of the following buttons:

- Three Points: Calls up the Enter Three Points dialog, in which you specify the cutting 
plane by entering the X-, Y-, and Z-coordinates of three points on the cutting plane 
(nine numbers in all). These points must form a triangle; they cannot be coincident or 
collinear.

- Origin and Normal: Calls up the Enter Slice Origin and Normal dialog in which you 
specify the cutting plane by entering the coordinates of a point and the components of 
a normal vector. Using this option, you enter six numbers to specify the cutting plane: 
the X-, Y-, and Z-coordinates of a point on the cutting plane (called the slice origin), 
and the X-, Y-, and Z-components of a vector normal to the cutting plane (called the 
slice normal).

Use the X,Y, and Z Position sliders (or the associated text fields) to move the cutting 
plane’s slice origin. A representation of the slice plane is shown in the workspace. Use 
Rotate About to rotate the slice plane about the slice origin.

4. To see a “trace” of the current slice, select the Show Trace check box. If Show Trace is 
selected, Tecplot draws an approximation of the intersection of the slicing plane with the 
active 3-D zones. For finite-element zones, the trace in fact draws all line segments of the 
intersections of the slicing plane with the cells in the zone. For IJK-ordered data, the trace 
is simply the line resulting from the intersection of the slicing plane and the outer surface of 
the zone. If Show Trace is not selected, Tecplot simply draws the intersection of the slicing 
plane with the axis box.

5. Choose to create slices from volume zones, surface zones, or surfaces of a volume zone. A 
slice from a volume zone will create a plane. A slice from a surface zone, or the surface of 
a volume zone, will be as a line or curve.

6. Click Extract to extract the slice as a finite-element surface zone.

Figure 20-12. The Extract Slice from Plane dialog.
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Once you have created the slice zone, you may plot it, write it out to a data file, delete it, etc. It 
is the same as any zone that was read into Tecplot. If you slice volume zones the resulting slice 
zones created are finite-element surface, quadrilateral element-types. If you slice surface zones 
the resulting zones are finite-element surface, triangle element types.

See Figure 20-13 for an example of a zone created by a slice.

20.8. Special 3-D Volume Plots
Special 3-D volume plots include fence plots, so called because they look like a flat plane 
divided by fences, and analytic iso-surface plots, which plot iso-surfaces for analytic functions 

such as F(x,y,z)=2x2-3y2-7z2, and cutaway plots, which are discussed in Chapter 26, “Blank-
ing.” 

20.8.1.  Fence Plots
A fence plot is a plot of planes of a 3-D data field. These planes may be IJ-ordered zones, or 
combinations of I-, J-, and K-planes of an IJK-ordered zone. In particular, the “bottom” plane 
of the plot is plotted, plus a few planes that are perpendicular to this plane. These perpendicular 
planes are the “fences.” Typically, flooded contours are plotted on each plane. An example 
fence plot is shown in Figure 20-14.

Creating a fence plot with IJK-ordered data is simple; just perform the following steps:

1. Read in the IJK-ordered data set.

2. Select the Contour zone layer check box on the sidebar. (This will initially be an iso-surface 
plot.)

3. Deselect the Mesh zone layer.

4. From the sidebar click Zone Style. The Zone Style dialog appears.

5. From the Surfaces page set Surfaces to Plot to I&J&K Planes.

Figure 20-13. Zone extracted by slicing 3-D volume zone.
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6. For each of I, J, and K, set the index range as appropriate. In Figure 20-14, the ranges cho-
sen were as follows:

- I-planes: Start=1, End=1, Skip=1 (the bottom plane)

- J-planes: Start=1, End=Mx, Skip=7 (the three parallel planes)

- K-planes: Start=1, End=Mx, Skip=17 (the two parallel planes)

7. From the Contour page of the Zone Style dialog, set the contour plot type to Flood or Both 
Lines and Flood. Set the Flood Translucency to Medium.

8. Select the Shade zone layer.

9. Redraw your plot. You should see a fence plot similar to that in Figure 20-14.

You can also create fence plots using IJ-ordered zones. For the best effect, the plotted zones 
should be perpendicular to each other when plotted in 3-D. For example, you can create a fence 
plot from the planes extracted using the procedure in Section 20.5, “I-, J-, and K-Plane Extrac-
tion.” 

20.8.2. Analytic Iso-Surface Plots
Using Tecplot’s data manipulation tools, you can create iso-surface plots of 3-D volume ana-

lytic functions such as F(x,y,z)=2x2-3y2-7z2. An iso-surface plot of this function in the range 
x=0 to x=1, y=0 to y=1, and z=0 to z=1 is shown in Figure 20-15.

To create an iso-surface plot of an analytic function, perform the following steps:

1. From the File menu, choose New Layout to clear the workspace.

2. From the Data menu, choose Create Zone, and then choose Rectangular. The Create Rect-
angular Zone dialog appears.

Figure 20-14. A fence plot.
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3. Enter the dimensions of I, J, and K. These will be, respectively, the number of points plot-
ted in the X-, Y-, and Z-directions. Figure 20-15 was plotted using a dimension of 20 for 
each index.

4. Enter zero for each of XMin, YMin, and ZMin; enter one for each of XMax, YMax, and 
ZMax.

5. From the Data menu, choose Alter, then choose Specify Equations. The Specify Equations 
dialog appears.

6. In the Equation(s) text field, enter the following equation:
V4 = 2*X*X - 3*Y*Y - 7*Z*Z

7. Click Compute to create the new variable.

8. Deselect the Mesh zone layer check box on the sidebar.

9. Bring up the Iso-Surface Details dialog from the Plot menu. When the Contour Details dia-
log appears, accept the default, v4, as the contour variable.

10. Turn on Iso-Surfaces.

Figure 20-15. Iso-surface plot of an analytic function.
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Printing your plot is the process of sending the plot image to an output device, print spooler, or 
a file. Typically the output devices is a printer, but it may be a plotter, film recorder, or typeset-
ting machine. Instead printing it directly on the device, you can print any plot to a file and print 
that file later. If you are creating files for use in another program, you should use Tecplot’s 
Export option to create your files—Export includes all the supported print file types, as well as 
several standard graphics formats such as TIFF, WMF, JPEG, and EPS. See Chapter 22, 
“Exporting,” for complete details.

21.1.  Plot Printing
To print a plot, select Print from the File menu. This brings up the Print dialog as shown in 
Figure 21-1.

From the Print dialog you can specify whether the output is sent directly to the printer (or print 
spooler) or to a file. If the Send Output to File check box is selected, the Print to a File dialog 
appears when you click OK, otherwise the output goes directly to the printer. If you do not 
select the Send Output to File check box, Tecplot prints the plot directly on the printer (or to 
the print spooler). The printed plot includes everything on the Tecplot paper. (The UNIX 
version also allows you to the number of output copies in the Print dialog.)

The Print dialog lets you specify options for your printer by accessing the Print Setup dialog as 
discussed in Section 21.3, “Printer Setup,” and for setting additional controls for the plot via 
the Print Render Options dialog as discussed in Section 21.4, “Print Render Options.” The 
Print dialog also provides access to Print Preview, which is discussed in Section 21.5, “Print 
Preview.” 

Figure 21-1. The Print dialog (under Windows).
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21.2. Paper Setup
You can set various parameters relating to the paper, including paper size and orientation, 
using the Paper Setup dialog or the Print Setup dialog. A change to your paper settings in either 
the Paper Setup dialog or the Print Setup dialog will automatically update the other.

21.2.1. Windows Print Setup Dialog

The Print Setup dialog is preferable under Windows for setting up your paper. It lists all the 
paper sizes your printer supports. Tecplot can produce output to fit virtually any paper size. 
You may select a paper size using the Print Setup dialog’s Size drop-down.

The Print Setup dialog is called up by clicking Print Setup on the Print dialog. The Print dialog 
is accessed from the File menu’s Print option.

Print Setup allows you to specify the paper source tray if your printer has multiple paper trays. 
Do this by choosing a tray from the Print Setup dialog’s Source drop-down.

You can choose either Portrait or Landscape paper orientation from the Print Setup dialog. In 
Portrait orientation, the long axis of the paper is aligned with the vertical axis of the plot. In 
Landscape orientation, the long axis of the paper is aligned with the horizontal axis of the plot.

The Print Setup dialog is shown in Figure 21-2.

21.2.2. Paper Setup Dialog

To adjust the paper size, orientation, and background color for your plots, select the Paper 
Setup option from the File menu. The current settings for these options are reflected in the rep-
resentation of the paper in the workspace. (To view the paper, select the Show Paper on Screen 
check box in either the Paper Setup dialog or the Ruler/Grid dialog under the Workspace menu. 
This check box is selected by default.)

The Paper Setup dialog, in contrast with the Print Setup dialog under Windows, offers you only 
six paper sizes. These may not be compatible with the paper sizes your printer supports. You 
cannot select from multiple paper trays with the Paper Setup dialog. You may set screen 

Figure 21-2. The Print Setup dialog under Windows.
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display options and fill colors with the Paper Setup dialog. The Paper Setup dialog is shown in 
Figure 21-3.

The following options are available in the Paper Setup dialog:

• Size: Choose the size of the paper from the following six selections: 

- Letter (8.5 x 11 inches).

- Double (11 x 17 inches).

- A4 (21x 29.7 cm).

- A3 (29.7 x 42 cm).

- Custom 1 (8.5 x 14 inches).

- Custom 2 (8 x 10 inches).

Under Windows, paper size Custom 2 is overwritten with the size selected in Print Setup if 
that size does not exist in Tecplot.

You can customize all six paper sizes in the configuration file, as well as their hard-clip lim-
its. The hard-clip limits are the lines on the edges of the paper that show where your printer 
cannot print. You can set the hard-clip limits to larger values for use as guides in placing 
your plots on the paper.

• Orientation: Choose the paper orientation. You have two options: Portrait and Landscape. 
In Portrait orientation, the long axis of the paper is aligned with the vertical axis of the plot. 
In Landscape orientation, the long axis of the paper is aligned with the horizontal axis of 
the plot.

• Paper Fill Color: Select a color to use for the paper background. This color is used to dis-
play the paper in the workspace. You can select the check box Use Paper Fill Color when 
Printing to have Tecplot print this background color on the hard-copy as well.

Figure 21-3. The Paper Setup dialog.
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21.3. Printer Setup
You use the Print Setup dialog to set up Tecplot for printing on a particular printer. The avail-
able options are different on Windows and UNIX systems. The Print Setup dialog is called up 
by clicking Print Setup on the Print dialog. The Print dialog is accessed from the File menu’s 
Print option.

21.3.1. Windows Printing

To set up for printing on Windows systems, select the Print option from the File menu. The 
Print dialog will appear, which was shown in Figure 21-1. Click Print Setup to launch the Print 
Setup dialog, shown in Figure 21-2.

You may choose to use the printer and specifications presented, or you may click Print Setup or 
(Print) Render Options to customize your printing.

You may choose to use the Windows default printer, or choose from any currently installed 
printers. To change to another installed printer, click on the Name drop-down and select 
another printer from the list.

21.3.2. UNIX Printing
Setting up to print under UNIX includes the following tasks:

• Specifying a spool command, if you are using a print spooler. This may include specifying 
a device-dependent startup string to condition the output device for the Tecplot output, or a 
mopup string to reset the output device upon completion of plotting.

• Specifying the precision of the output for those formats which support variable precision.

• Assigning pen colors to pens for pen plotters, if applicable.

You perform most of these tasks from the UNIX version of the Print Setup dialog, accessed 
from the Print option of the File menu, and shown in Figure 21-4. Some of the Print Setup 
dialog options launch additional dialogs, which are discussed at the appropriate places in the 
following sections.

21.3.2.1.  Print Formats. In Tecplot, you can choose from any of the following print for-
mats:

• PostScript (color or monochrome): PostScript is the recommended output format, since it 
supports all Tecplot fonts (including Greek and Math), color flooding (or gray-scale flood-
ing), hidden surface (or line) removal, and overlaid frames (plots).

• HP-GL (line color only): The HP-GL format generates output for most HP pen plotters as 
well as other pen plotters that emulate the HP-GL language. Screen colors are mapped to 
pen numbers on the plotter. HP-GL output can be imported into some programs, such as 
WordPerfect, but it has some limitations. It does not support contour flooding, multi-color-
ing, or hidden-surface removal, and it is restricted to using the Tecplot stroke (screen) fonts.
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• HP-GL/2 (color or monochrome): The HP-GL/2 format can be used for HP-GL pen plot-
ters as well as the HP LaserJet III, LaserJet 4, and PaintJet XL printers. When used with a 
supported printer (as opposed to a pen plotter), HP-GL/2 can show contour flooding, multi-
coloring and hidden-surface removal, but plots are always limited to using the Tecplot 
stroke fonts.

To choose the print format:

1. Call up the Print Setup dialog by clicking Print Setup on the Print dialog, accessed from the 
File menu.

2. Choose the desired format from the Format drop-down.

If your printer is incompatible with all of the above formats, you might consider a PostScript 
converter such as the freeware program Ghostscript. These programs interpret PostScript 
output and translate it to the native languages for dozens of supported devices. 

21.3.2.2. Spool Commands. Printers on most UNIX systems are accessed via print spool-
ers that manage the print queue. Under UNIX, you typically use either the lp or lpr com-
mands to send files to the print spooler. There may be command-line options that need to be set 
on your system, as well, such as a flag to specify a particular printer. You use the Print Setup 
dialog to specify the appropriate spool command for your system. 

To specify the spool command for your system:

1. Call up the Print Setup dialog, and choose the desired format. (Spool commands will most 
likely be different for different print formats, and Tecplot stores one spool command for 
each print format.)

2. In the Spooler Cmd text field, enter the appropriate spool command for your system, using 
the @ symbol to represent a file name. 

Figure 21-4. The UNIX version of the Print Setup dialog.
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For example, suppose you routinely use the following spool command to print a file named 
myfile.ps:  “lpr -m -r myfile.ps.” The appropriate spooler command to enter in 
the Spooler Cmd field is then “lpr -m -r @.” 

When printing to a spooler, Tecplot creates temporary files with names of the form 
tp??????, where the ?s are randomly generated characters. Tecplot does not delete these 
temporary files automatically; commands to do so should be included in your spool command. 
In our example, the -r flag says to remove the file when done.

21.3.2.3. Startup and Mopup Strings. A startup string is an initialization string that sets 
up your output device to accept the plot created by Tecplot. A mopup string is a reset signal 
that tells your output device that the special output has ended. For most devices no startup or 
mopup strings are needed. However, some common devices, such as the HP LaserJet III when 
printing HP-GL/2, require both startup and mopup strings.

To specify a startup or mopup string:

1. Call up the Print Setup dialog, and choose the desired format. (Startup and mopup strings 
will be different for each format, and Tecplot stores one startup and mopup string for each 
print format.)

2. Enter the appropriate startup string or mopup string in the appropriate text field. Special 
characters are generated by using Macro Codes (such as “%E” for the escape character and 
“^nnn” for any ASCII character with a decimal ordinal value of nnn). Check your printer 
documentation for the appropriate strings. For example, with some HP-GL implementa-
tions, the HP-GL startup string must be set to the following:
$E.J$E.N;19:$E.I81;;17:

The HP LaserJet III requires the HP-GL/2 startup and mopup strings shown below:

- Startup String: $E%-1B

- Mopup String: $E%0A^012

21.3.2.4. Printing Precision. For PostScript and HP-GL/2 output, you can control the 
numerical precision used in your print files. Print files contain numbers that define sizes and 
positions of pieces of the plot on the output paper. These numbers are defined as integers 
between zero and about 8,000. Usually, this provides sufficient resolution for most output 
devices. Occasionally, you may need more resolution. For example, printing to a high-resolu-
tion output device like a Linotronic typesetter may require more precision; making print output 
with very small cells or elements may also require more precision.

To increase the precision of the output, increase the value in the Extra Precision field of the 
Print Setup dialog. You specify one Extra Precision value for all formats that supports preci-
sion control. The precision is defined as the number of digits to the right of the decimal. Nor-
mally, precision is zero. The disadvantage of setting precision high is that the print files 
increase in size. The higher the Extra Precision setting, the larger your print files, but the more 
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accurate the plot. Numbers above two are not normally required unless you need extremely 
fine resolution. The maximum setting for the precision is eight. 

21.3.2.5. Pen Plotter Configuration. If you are using a pen plotter, you can use the Pen 
Plotter Device Configuration dialog shown in Figure 21-5 to specify plotter speed and pen 
assignments for particular colors and Tecplot object types. You access this dialog by clicking 
Pen Plotter on the HP-GL page of the Print Setup dialog. You can associate each of Tecplot’s 
basic colors with any of the plotter’s pens.

You may also specify that the following object types be associated with a particular pen: 

• Axes.

• Tick mark labels.

• Major grid lines.

• Minor grid lines.

• Objects colored with the multi-color option.

• Streamtraces.

• Zone boundaries.

To specify a pen assignment, simply enter the number of the desired pen in the appropriate 
color or object field. 

To specify a plotter speed, either enter a value in the Plotter Speed field, or use the up and 
down arrow buttons to increment and decrement the current value.

Figure 21-5. The Pen Plotter Device Configuration dialog.
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Click OK to accept your changes, Cancel to quit with no changes, or Reset to reset the config-
uration to its last saved value.

The pen plotter configuration settings only affect the output only when the print format is HP-
GL; they have no effect on PostScript or HP-GL/2. There are no settings for Flood Pens 
because flooding is not supported under HP-GL. The default is for all lines and text to use Pen 
1.

21.4. Print Render Options
Clicking the Print dialog’s (Print) Render Options calls up the Print Render Options dialog, 
shown in Figure 21-6.

The Print Render Options dialog offers you the following choices:

• Color: Select this check box for color output; deselect the check box for monochrome out-
put.

• Vector: Select this option to create print output using the drawing commands of the printer. 
The printer renders the plot, yielding higher resolution, but some plot options, such as 
translucency, are not available.

• Image: Select this option to create print output using an image. Rendering is done by Tec-
plot at the specified resolution, usually less than the printer’s resolution. However, all plot 
options are available.

• Force Extra Sorting for all 3D Frames: This option is available when the Vector option 
has been selected. Selecting this check box will cause Tecplot to use extra sorting in all 3-D 
frames. This overrides the setting in the Advanced 3D dialog. If this check box is not 
selected, Tecplot will choose sorting algorithms based on the Advanced 3D dialog options 
that were chosen for each frame. When printing 3-D plots in a vector graphics format, Tec-
plot must sort the objects so that it can draw those farthest from the screen first and those 
closest to the screen last. By default, Tecplot uses a quick sorting algorithm. This is not 
always accurate and does not detect problems, such as intersecting objects. If Extra Sorting 
is selected, Tecplot uses a slower, more accurate approach that detects problems.

Figure 21-6. The Print Render Options dialog under Windows.
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• Resolution (dpi): Available when the Image option is selected. Enter the resolution in 
terms of dpi in the text field. Larger resolutions may result in an out-of-memory condition, 
or produce very large files. Smaller resolutions may yield less-attractive output images.

The Print Render Options dialog also indicates the amount of memory your final output will 
require when the selected Render Type is Image.

21.5. Print Preview
A preview of your screen image as it will be rendered for the printer may be generated by 
selecting Print Preview from the File menu. The preview image may be accessed by clicking 
Preview on the Print dialog, which is shown in Figure 21-1. There are several reasons for 
viewing the print preview image prior to sending the plot to the printer. They are associated 
with the image quality and reduced image content that can be supported for vector graphics 
printer formats such as PostScript.

As discussed in Section 21.4, “Print Render Options,”  the default sorting algorithm used by 
Tecplot may have problems with intersecting objects. This will typically not show up in the 
OpenGL-rendered screen image. However, sorting errors may occur for vector print output. 
These will be visible in the preview. The Print Preview option provides access to the Print 
Render Options dialog, where you may improve sorting by selecting Force Extra Sorting for 
All 3D Frames. If extra sorting does not solve the problem, the only option available is to 
export the plot using an image format, discussed in Chapter 22, “Exporting.” By increasing the 
resolution for an image format you can obtain a quality comparable to PostScript without the 
sorting errors.

Vector graphics formats do not support translucency, contour flooding with Gouraud shading, 
or contour flooding using the continuous color distribution method (which is only available 
with OpenGL). Print Preview will not display translucency. Gouraud shading for contour 
flooding will be reduced to Paneled shading. Continuous color flooding will be reduced to 
color flooding with average-cell color. When you print, warning messages will be displayed to 
advise you about the unsupported plot styles. The resulting printed output will closely match 
the print preview image.
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CHAPTER 22 Exporting

In Chapter 21, “Printing,” we stated that all Tecplot plots could be printed to files, as well as 
directly to printers. Print files are useful only for printing at a later time. Sometimes, however, 
you want to create files for use in other applications, such as plots to be included in a word-
processor document, or to be edited by a graphics program. Sometimes, you can use print files 
for these purposes. More often, however, you need plots in different formats. Use the Export 
dialog under the File menu to create files for export into other applications.

Tecplot generates types of export files—vector graphics and image. Vector export files have 
device-independent resolution and thus can be easily resized, but they have the same limita-
tions as vector print output. Image output has the advantage of accurately representing translu-
cency and smooth color gradations, but with the disadvantage of generally being larger than 
vector output, particularly when a high image resolution is specified. Image files are some-
times called raster or bit-mapped.

Tecplot exports the following formats:

• AVI: Image in Audio Visual Interleaved format (a common Windows movie file format). 
AVI files may contain multiple images for animations.

• BMP: Image in Windows Bitmap format.

• Encapsulated PostScript (EPS): Vector or image graphics in a special type of PostScript 
file designed for inclusion in other applications.

• HP-GL: Vector graphics mainly for pen plotters, although you can import these files into 
some applications.

• HP-GL/2: Vector graphics mainly for pen plotters, some HP LaserJets or PaintJets.

• JPEG: Image in JPEG format. JPEG files are very small for their resolution and quite com-
mon on the internet, but they do involve some loss of image quality that may affect certain 
plot images.

• PNG: Image in Portable Network Graphic format. Also common on the internet, but creat-
ing files with no loss in image quality but with larger file size than JPEG.

• PostScript (PS): Vector or image graphics suitable for direct printing, but usually unsuit-
able for import into other applications. It is recommended that you use the Encapsulated 
PostScript (EPS) format for importing into other applications.

• Raster Metafile: Image in NASA’s Raster Metafile format. Raster Metafile files may con-
tain multiple images for animations. Used for creating movies for Framer.
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• Sun Raster: Image in Sun Microsystems’ Sun Raster format.

• TIFF: Image in Tagged Image File Format.

• WMF (Windows Metafiles): Vector graphics to import into various Windows applica-
tions.

• X-Windows: Image in “xwd” (X-Window Raster) format.

On Windows and Macintosh systems, Tecplot can export directly to the clipboard instead of to 
a file. Windows systems export BMP and WMF directly to the clipboard. Macintosh systems 
export PICT files directly to the clipboard. PICT files are an image format unique to the Mac-
intosh version of Tecplot, and are only available through when copying directly to the clip-
board.

Certain images formats support anti-aliasing, a feature that removes “jaggies” from text, lines 
and edges. This feature is discussed at the end of this chapter.

22.1. Export File Creation
The basic procedure for creating an export file is the same regardless of the exported file 
format:

1. From the File menu, select Export. This calls up the Export dialog, shown in Figure 22-1.

2. Select a format from the Export Format drop-down.

3. Set format-specific options.

4. Click OK in the Export dialog, and specify a file name for the export file.

Figure 22-1. The Export dialog.
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22.2. Audio-Visual Interleaved (AVI) Export

22.2. Audio-Visual Interleaved (AVI) Export
The AVI format is used for viewing movies created in Tecplot. AVI is an image format, but 
Tecplot uses only 256-color images with AVI files. Thus, AVI can accurately represents some 
plots with translucency and smooth color gradations. The AVI export options are shown in 
Figure 22-2. 

When you select AVI in the Export dialog, you have the following options:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,” for details.

• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

• Antialiasing: Select this option to remove jaggies from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details.

Figure 22-2. AVI options on the Export dialog.
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• Use Multiple Color Tables: Select this check box to create an AVI file with a separate 
color table each step in the animation. If this check box is not selected, Tecplot scans all 
steps in the animation and creates one color table for the entire animation. Multiple color 
tables can provide better image quality for the animation, but many applications display 
only the first color table provided.

• Animation Speed: Set the speed of the animation in frames per second.

For more information on AVI files, see Chapter 29, “Animation.” 

22.3. Bitmap (BMP) Export
BMP is an image format, and thus accurately represents plots with translucency and smooth 
color gradations. The BMP export options are shown in Figure 22-3.

When you select BMP in the Export dialog, you have the following options:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,” for details.

• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

Figure 22-3. BMP options on the Export dialog.
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22.4. Encapsulated PostScript (EPS) Export

• Antialiasing: Select this option to remove “jaggies” from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details.

• Convert to 256 Colors: Select this check box generate an image with only 256 colors 
(down from a possible 16 million colors). Tecplot selects the best color match. The image 
will have a greatly reduced file size, but for plots with many colors, the results may be sub-
optimal. Using this option with transparency, smooth color gradations, or antialiasing may 
result in poor image quality.

22.4. Encapsulated PostScript (EPS) Export
Encapsulated PostScript file (EPS) are Postscript files with additional commands that another 
program can use to determine the size of your plot. After you import your EPS file into another 
program, you can position it and usually resize it before printing. (If you try to send an EPS 
directly to a printer, it may not be positioned correctly on the paper. Use Tecplot’s PS export 
format to create files to send directly to a printer.)

EPS files may also contain a preview image, which allows you to see a rough picture of your 
plot in the program that loads the EPS file. There are two basic types of preview images:

• An EPS file with a TIFF preview image has a binary header giving some information about 
the TIFF image. The preview image is in binary at the bottom of the file. In order for a pro-
gram to read in an EPS file with a TIFF preview image, it must be able to interpret these 
binary sections. This type of EPS file can not be sent directly to a printer.

• All of the other preview image types are included within the body of the EPS file as Post-
Script comments. An EPS file with these types of preview images can be sent directly to 
the printer. The printer ignores the preview commands, however, and may place the plot 
incorrectly.

For some applications, if you import an EPS file and print to a non-PostScript printer, only the 
preview image is printed. Under Windows you must tell Windows that the printer is a PS 
printer, or you also get the preview image.

The EPS export options are shown in Figure 22-4.

The following options are available:

• Color: Choose between color and gray-scale EPS output.

• Vector/Image: Choose the Render Type used—vector PS commands or a PS image in the 
file. Vector commands generally result in a smaller file, but a PS image is required to accu-
rately represent translucency or smooth color gradations.

If you choose Vector Render Type, the following options are also available:



Chapter 22. Exporting

372

• Extra Precision: Specify the number of decimal places to which size and position parame-
ters are carried in the resulting vector-based EPS output. Use the increase or decrease 
arrows, or enter a value in the text field. Larger values create more accurate plots, but result 
in larger file sizes.

• Force Extra Sorting for All 3D Frames: Selecting this check box causes Tecplot to use 
extra sorting in all 3-D frames.This overrides the setting in the Advanced 3D dialog. If this 
check box is not selected, Tecplot chooses sorting algorithms based on the Advanced 3D 
dialog options for a given frame.

If you choose Image Render Type, the following options are available instead of the above:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Resolution: Enter the resolution of the image in dots per inch. Larger values create more 
accurate plots, but result in larger file sizes.

Regardless of the Render Type, you may choose the type of preview image included in your 
EPS files. A preview image is a rough sketch of your print file used by importing programs. 
You may also specify the preview images size (in pixels) in the width and height fields. Low 
values make the preview image poor. High values can make the EPS file large. (Note: When 
using Render Type Image, these preview image width and height values are separate from the 
size of the actual EPS image. The actual EPS image size is determined by the Resolution set-
ting.)

Figure 22-4. EPS options on the Export dialog.
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22.5. HP-GL and HP-GL/2 Export

Tecplot provides the following options for the preview image:

• None: No preview image information is include. This is good for importing into applica-
tions that do not use preview image information.

• TIFF: Include a monochrome or gray-scale TIFF preview image. (Color preview images 
are not available.) This is the most common preview image format. You may specify an 
image depth for the preview image in the Depth drop-down. TIFF image depth options are 
described in Section 22.11, “Tagged Image File Format (TIFF) Export.” (This preview 
image depth is separate from the depth of the actual image for EPS files generated with 
Render Type Image. The actual image depth is determined by Tecplot.) 

• EPSIV2: Include a monochrome (one bit per pixel) Encapsulated PostScript Version 2 pre-
view image. This is also a common preview image type in EPS files.

• FrameMaker: Include a monochrome preview image tuned to work with older versions of 
Adobe FrameMaker. This preview image type is rarely necessary.

22.5. HP-GL and HP-GL/2 Export
The Export dialog allows you to export plots in HP-GL and HP-GL/2, although these formats 
are usually used for printing directly to a plotter or LaserJet or PaintJet printer. Some applica-
tions import HP-GL format files, but the format strips much of the information out of the plot, 
and you are generally better off using another format.

If you want to export an HP-GL or HP-GL/2 file, the process for creating these export files is 
very similar to printing to a file on a UNIX system (even under Windows). See Chapter 21, 
“Printing,” for details.

22.6. Joint Photographic Experts Group (JPEG) Export
JPEG is an image format, and thus accurately represent plots with translucency and smooth 
color gradations. However, JPEG is a highly compressible, “lossy” format, and can result in 
poor image quality for some types of images. The advantage of JPEG is very small file sizes 
and near universal acceptance on the internet. JPEG supports different qualities of compres-
sion, and Tecplot allows you to control the image quality (and thus, inversely, the file size).

When you select JPEG in the Export dialog, you have the following options:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,” for details.
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• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

• Antialiasing: Select this option to remove “jaggies” from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details.

• Encoding: Choose an encoding method for the JPEG file. Standard encoding creates a 
JPEG which downloads one line at a time, starting at the top line. Progressive encoding cre-
ates a JPEG image that can be displayed with a “fade in” effect in a browser. This is some-
times useful when viewing the JPEG in a browser with a slow connection, since it allows 
an approximation of the JPEG to be drawn immediately, and the browser does not have to 
wait for the entire image to download. Given the same Quality level (see below), Standard 
encoded JPEG files look better, although they are larger than the equivalent Progressive 
encoded JPEG files.

• Quality: Select the quality of JPEG image. Higher quality settings produce larger files and 
better looking export images. Lower quality settings produce smaller files. For best results, 
use a quality setting of 75 or higher.

22.7. Portable Network Graphics (PNG) Export
PNG is an image format, and thus accurately represent plots with translucency and smooth 
color gradations. The PNG export options are shown in Figure 22-5.

Figure 22-5. PNG options on the Export dialog.
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22.8. PostScript (PS) Export

When you select PNG in the Export dialog, you have the following options:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,”  for details.

• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

• Antialiasing: Select this option to remove jaggies from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details.

• Convert to 256 Colors: Select this check box generate an image with only 256 colors 
(down from a possible 16 million colors). Tecplot selects the best color match. The image 
will have a greatly reduced file size, but for plots with many colors, the results may be sub-
optimal. Using this option with transparency, smooth color gradations, or antialiasing may 
result in poor image quality.

22.8. PostScript (PS) Export
The Export dialog allows you to export plots in PostScript, although this format is usually used 
for printing directly to a printer or print spooler. It is recommended that you use the Encapsu-
lated PostScript (EPS) format for importing into other applications. See 22.4, “Encapsulated 
PostScript (EPS) Export,” for details.

If you want to export PostScript file (perhaps for later printing), the process for creating a Post-
Script export file is very similar to printing to a file on a UNIX system (even under Windows). 
See Chapter 21, “Printing,” for details.

22.9. Raster Metafile (RM) Export
Raster is an image format, but Tecplot create 256-color images with Raster Metafiles files. 
Thus, Raster Metafile can accurately represents some plots with translucency and smooth color 
gradations. The Raster Metafile format was defined by NASA, but is also the format used the 
Framer program for viewing movies created in Tecplot. The Raster Metafile export options are 
shown in Figure 22-6. 
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When you select Raster Metafile in the Export dialog, you have the following options:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,”  for details.

• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

• Antialiasing: Select this option to remove jaggies from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details.

• Use Multiple Color Tables: Select this check box to create a Raster Metafile with a sepa-
rate color table each step in the animation. If this check box is not selected, Tecplot scans 
all steps in the animation and creates one color table for the entire animation. Multiple 
color tables can provide better per-step image quality for the animation, but may result in 
flicker during playback.

For more information on Raster Metafiles and Framer, see Chapter 29, “Animation.” 

Figure 22-6. Raster Metafile options on the Export dialog.
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22.10. Sun Raster (RAS) Export

22.10. Sun Raster (RAS) Export
Sun Raster is an image format, and thus accurately represent plots with translucency and 
smooth color gradations. Sun Raster files can be created in either of two formats—the standard 
format, which is not compressed, and a byte-encoded format, which is compressed. The Sun 
Raster export options are shown in Figure 22-7.

When you select Sun Raster in the Export dialog, you have the following options:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,”  for details.

• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

• Antialiasing: Select this option to remove jaggies from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details.

Figure 22-7. Sun Raster options on the Export dialog.
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• Format: You may select Standard, which will create an uncompressed file, or Byte-
Encoded, which will create a compressed file. You should select Byte-Encoded unless you 
have a compelling reason to do otherwise.

22.11. Tagged Image File Format (TIFF) Export
TIFF (Tagged Image File Format) is an image format, and thus accurately represent plots with 
translucency and smooth color gradations. Tecplot generates both color and gray-scale TIFF 
images. The Export TIFF dialog is shown in Figure 22-8.

When you select TIFF in the Export dialog, you have the following options:

• Color: Choose between color and gray-scale TIFF output.

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,”  for details.

• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering.

Figure 22-8. TIFF options on the Export dialog.
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22.12. Windows Meta File (WMF) Export

• Antialiasing: Select this option to remove jaggies from the image. See Section 22.15, 
“Antialiasing Images,” for details.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15 “Antialiasing Images” for details.

• Convert to 256 Colors: Select this check box generate an image with only 256 colors 
(down from a possible 16 million colors). Tecplot selects the best color match. The image 
will have a greatly reduced file size, but for plots with many colors, the results may be sub-
optimal. Using this option with transparency, smooth color gradations, or antialiasing may 
result in poor image quality.

• Depth: For gray-scale images, this specifies the number of shades of gray by how many 
bits of gray-scale information is used per pixel. The larger the number of bits per pixel, the 
larger the resulting file. Your options are:

- On/Off: One bit per pixel using an on/off strategy. All background pixels are made 
white (on), and all foreground pixels, black (off). This setting creates small files and 
is good for images with lots of background, such as line plots and contour lines.

- 1 Bit/Pixel: One bit per pixel using gray scale values of pixels to determine black or 
white. Those pixels that are more than 50 percent gray are black; the rest are white. 
This setting creates small files that might be useful for a rough draft or a preview 
image.

- 4 Bit/Pixel: Four bits per pixel resulting in sixteen levels of gray scale. This setting gen-
erates fairly small image files with a fair number of gray levels. This setting works 
well for most preview image purposes.

- 8 Bit/Pixel: Eight bits per pixel resulting in 256 levels of gray. This setting is useful for 
full image representation, but the files generated by this setting can be large.

22.12. Windows Meta File (WMF) Export
WMF is a vector graphics format and thus can be easily resized by the importing application. 
WMF files can be imported into many applications. As a vector format, WMF cannot accurate 
represent plots with translucency or smooth color gradations. Selecting WMF from the Export 
Format drop-down displays WMF options, shown in Figure 22-9.

The following options are available:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames.

• Color: Choose between color and gray-scale WMF output.

• Force Extra Sorting for All 3D Frames: Selecting this check box causes Tecplot to use 
extra sorting in all 3-D frames.This overrides the setting in the Advanced 3D dialog. If this 
check box is not selected, Tecplot chooses sorting algorithms based on the Advanced 3D 
dialog options for a given frame.
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22.13. X-Windows Format (XWD) Export
XWD (X-Windows format) is an image format, and thus accurately represent plots with trans-
lucency and smooth color gradations. XWD can be generated on Windows, Macintosh, and 
UNIX versions of Tecplot.

When you select XWD in the Export dialog, you have the same options as BMP or PNG. See 
Section 22.3, “Bitmap (BMP) Export,” or Section 22.7, “Portable Network Graphics (PNG) 
Export,” for details.

22.14. Clipboard Exporting to Other Applications
Tecplot’s Cut, Copy, and Paste commands work only within Tecplot. However, the Copy Plot 
to Clipboard command is available in the Windows and Macintosh versions of Tecplot. With 
this option, you can copy and paste Tecplot images directly into other applications such as 
Microsoft Word, Adobe FrameMaker, and many other applications. The Copy Plot to Clip-
board dialog for Windows is shown in Figure 22-10.

The following options are available:

• Region: Choose to export only the current frame, or the smallest rectangle containing all 
frames, or everything shown in the workspace.

Figure 22-9. WMF options on the Export dialog.
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22.14. Clipboard Exporting to Other Applications

• Format: On Windows, plots may be copied as a vector (WMF) or image (BMP) format. 
See Section 22.3, “Bitmap (BMP) Export,” and Section 22.12, “Windows Meta File 
(WMF) Export,” for a discussion of these formats. On the Macintosh, the plot is copied as a 
PICT image, and this is the only way to generate a PICT image from within Tecplot.

• Force Extra Sorting for All 3D Frames: Selecting this check box causes Tecplot to use 
extra sorting in all 3-D frames.This overrides the setting in the Advanced 3D dialog. If this 
check box is not selected, Tecplot chooses sorting algorithms based on the Advanced 3D 
dialog options for a given frame. This option is only available for WMF, and thus only on 
Windows.

• Color: Choose between color and gray-scale output.

• Convert to 256 Colors: On Windows, select this check box generate an image with only 
256 colors (down from a possible 16 million colors). Tecplot selects the best color match. 
The image will take up less memory on your Windows clipboard, but for plots with many 
colors, the results may be suboptimal. Using this option with transparency, smooth color 
gradations, or antialiasing may result in poor image quality. On the Macintosh, the image is 
always generated with only 256 colors because that is all the PICT format supports.

• Use Width of Image on Screen: Select this option to generate an image file the same size 
as the current plot on the screen. This option is forced on if you use on-screen image ren-
dering in the Display Performance dialog. See Section 30.3, “Display Performance Dia-
log,” for details. This option is only available for BMP and PICT.

Figure 22-10. The Copy Plot to Clipboard dialog (Windows and Macintosh only).
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• Enter Width: Select this option to specify a width (in pixels) for the generated image. The 
greater the width you specify, the longer it will take to export the image and the larger the 
exported file. However, a larger width increases the quality of your image. This option is 
not available if you have chosen to use on-screen image rendering. This option is only 
available for BMP and PICT.

• Antialiasing: Select this option to remove jaggies from the image. See Section 22.15, 
“Antialiasing Images,” for details. This option is only available for BMP and PICT.

• Supersample Factor: Control the amount of antialiasing used in the image. See Section 
22.15, “Antialiasing Images,” for details. This option is only available for BMP and PICT.

To copy and place a Tecplot image into a document or other art work:

1. In the Edit menu, click Copy Plot to Clipboard. Choose the appropriate options as dis-
cussed above, then click OK.

2. In your other software package, place your cursor or select the frame or site where you 
want to place the Tecplot plot.

3. From the menu of the other software package, execute the Paste command. The plot 
appears. Some packages push other content out of the way to create a spot for the plot, 
while others will draw the plot on top of existing content.

4. Resize and reposition the plot as needed within the other software package.

22.15. Antialiasing Images
Antialiasing removes jaggies from text, lines, and edges of image output formats by the 
process of supersampling. A large intermediate image is rendered and then reduced to the final 
image size. Each pixel on the final image is created from multiple rendered pixels. The width 
and height of the intermediate image are the width and height of the final image times some 
scale factor. This scale factor is the Supersample Factor. You can use values from 2 to 16. 
Factors greater than 3 are seldom necessary. Large scale factors take a lot more time and 
memory. Some graphics cards limit the dimensions of rendered images to a maximum of 
2048x2048 or 4096x4096 pixels, and thus Tecplot cannot antialias if the intermediate image 
would be larger than this limit.

Antialiasing uses many colors. Certain image formats are limited to 256 colors, and cannot 
represent all antialiased images correctly. The image formats limited to 256 color include X-
Windows, AVI, Raster Metafile, SunRaster, and any image format with the Convert to 256 Col-
ors. With these formats, the antialiasing works fine for plots with a very limited selection of 
colors (like a red mesh on a black field). Otherwise, antialiasing with 256 colors is a waste of 
time and may result in a worse plot.

The antialiasing and 256-color problem can be amplified by animation formats. Both AVI and 
Raster Metafile support only 256-colors, and need to use them to display multiple frames. For 
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22.15. Antialiasing Images

these formats, try a test animation of a few steps with antialiasing on before creating the entire 
animation.
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23.1. Data Set Viewing

CHAPTER 23 Data Spreadsheet

All ordered and finite-element data can be viewed using Tecplot’s data spreadsheet. The data 
may be modified within the spreadsheet in order to change the plots Tecplot produces.

The spreadsheet only allows the viewing and altering of data loaded into Tecplot. If you want 
to add zones, variables, or values, you can do so in your original data files before loading into 
Tecplot, or through the Create Zone or Alter options on the Data menu.

23.1. Data Set Viewing
The spreadsheet displays Tecplot's data differently depending on the type of zone being exam-
ined. I-ordered and finite element data sets are displayed with each zone's variable displayed in 
a column. IJ-ordered data sets are displayed in the spreadsheet with I along the rows and J 
along the columns. IJK-ordered data sets are displayed one plane at a time: selecting the K-
plane displays I along the rows and J along the columns, selecting the J-plane displays I along 
the rows and K along the columns, and selecting the I-plane displays J along the rows and K 
along the columns. With IJK-ordered data the slice of interest can be selected by entering a 
specific index or using the up and down arrows provided.

You view data using the Spreadsheet option under the Data menu. To view your data set:

1. From the Data menu, choose Spreadsheet. The Data Spreadsheet dialog appears, as shown 
in Figure 23-1.

2. From the Data Spreadsheet dialog select a desired zone and variable to examine.

Figure 23-1. The Data Spreadsheet dialog.
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3. Use the scroll bars to examine all of your data.

4. To see the values for a specific data point, you may click the mouse on that point in the plot. 
The spreadsheet will then be positioned to display that point.

You can change the format of data in a spreadsheet without changing the appearance of your 
plot. To change the data spreadsheet’s display format:

1. On the Data Spreadsheet dialog click Format. The Data Format dialog appears.

2. Select a number format from the option menu that best represents the data of interest.

3. If available for the selected number format, specify precision (number of decimal places).

4. Enter a column width that best fits the data of interest.

23.2. Spreadsheet Data Editing
You can change your data set within Tecplot without changing your original data file. You do 
this by editing values in the cells of the spreadsheet. To modify data:

1. From the Data Spreadsheet dialog select a desired zone and variable to modify.

2. If the variable is shared with another zone or zones, the Alter in all Shared Zones toggle 
will be enabled. Select this toggle to keep the variable shared as you modify data, propagat-
ing changes to the other zones that share the variable.

3. Select the value of interest from the spreadsheet. This will highlight and expand the value 
to its full precision.

4. To replace the highlighted value simply enter the new value. Anything highlighted is 
instantly replaced with new digits entered.

5. To slightly modify a highlighted value select the value a second time. This will un-highlight 
the value and place the edit cursor at the desired position. Make desired modifications to 
the existing value.

6. To undo a modification of a given cell press Esc. To commit to a modification press the 
Enter, Tab, or Shift-Tab keys, or click on another cell.



387

CHAPTER 24 Data Operations

All plots in Tecplot, with the exception of sketches, rely on the data sets attached to each 
frame. You can modify, create, transform, interpolate, duplicate, and delete the data in the cur-
rent data set using the Data menu. You can also use the data operation capabilities of Tecplot to 
create plots of analytical functions. By using Tecplot’s linked layout files, or macro capabilities 
and equation files, you can create complex data operations that can be repeated on different 
data sets.

Changes to the data set within Tecplot do not affect the original data file(s). You can save the 
modified data to a data file by selecting Write Data File from the File menu. When you save a 
layout file, a journal of data operations is saved and those operations are repeated when the 
layout file is read at a later time. If the data in the file has changed, or the data file is overridden 
with a different file, the operations are applied to the new data. Alternatively, any data sets that 
have been modified are also saved to data files (see Section 5.3, “Layout Files, Layout Package 
Files, Stylesheets,” for details).

24.1. Data Journaling
Data is often loaded into Tecplot from external sources, such as data files. On occasion you 
may modify this data prior to making a final plot. Some (but not all) of the data operations 
mentioned in this chapter modify data. Tecplot simultaneously “journals” the corresponding 
instructions. If you then save a layout file, it can reference the original data and include in the 
layout the instructions necessary to reconstruct the final data used for plotting.

If you perform some type of operation in Tecplot that it is unable to journal then you are 
prompted to save the data set to a new file when you go to save a layout file. This is necessary 
for the layout to reproduce exactly what you have in your plot.

24.1.1. Data Journaled Operations
Tecplot journals the following operations:

• Data alteration (except for derivatives).

• Creation of rectangular zones, circular zones, and 1-D zones from within Tecplot.

• Zone duplication.

• Zone deletion.
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24.1.2. Data Journaling Example
Suppose you have axi-symmetric data for an airplane and you are only provided with one-half 
of the data for plotting. The final plot must show the full body of the airplane with flooded con-
tours of pressure on one side of the plane and flooded contours of temperature on the other 
side.

To create the duplicate image in Tecplot perform the following steps:

1. Go to the Data menu. Select Duplicate from the Create Zone sub-menu to duplicate the 
original zones.

2. Also on the Data menu, select Specify Equations from the Alter sub-menu. The Specify 
Equations dialog appears. Set Y = -Y for all of the new zones.

The desired plot styles can now be assigned to the zones on both halves of the plane. The orig-
inal data after loading and the plot with the duplicated zone are shown in Figure 24-1.

A layout can now be saved that only needs to reference the original data file containing just the 
left half of the plane.

24.2. Data Alteration through Equations
Tecplot allows you to alter data in existing zones. You can alter the values of a variable or 
create new variables as functions of existing variables and index values. Data can be altered 
simultaneously in one or more zones (or in all zones). For ordered zones, you can also restrict 
the alteration to specified ranges of indices (I, J, and K).

To modify your data set, follow these steps.

1. From the Data menu, choose Alter.

2. From the Alter menu, choose Specify Equations. The Specify Equations dialog appears, as 
shown in Figure 24-2.

3. Using the Specify Equations dialog, perform the following steps:

Figure 24-1. Axi-symmetric data before and after duplication.
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- Enter the equations. 

- (Optional) Select the set of zones to alter using the appropriate region of the Specify 
Equations dialog. The default is to alter all zones. You may skip this step if you want to 
apply the equation to all zones.

- (Optional) Select the index ranges to alter in the selected zones. You may skip this step 
if you want to apply the equation to all points of the selected zones.

- (Optional) Select the data type of the new variable from the New Var Data Type drop-
down. Options are Auto (the default, where Tecplot selects), Single, Double, Long Int, 
Short Int, Byte, Bit. If appropriate for the variable, memory usage can be reduced by 
using one of the smaller variable types.

- (Optional) Select the location of the new variable using the New Var Location drop-
down. Options are Auto (the default), Node, Cell-Center. Auto is node unless all vari-
ables in the equation are located at the cell center.

4. Click Compute to alter the data. This is important. If you do not click Compute, the data 
values do not change.

These steps are discussed in more detail in the following sections.

24.2.1. Equation Syntax

Tecplot equations have the following form:

LValue = F(RValue1, RValue2, RValue3, ...)

Where F() is a mathematical expression, with some limitations and some extensions as dis-
cussed below. LValue is a reference to an existing or non-existing variable, and RValueN is a 
reference to a value (such as a constant, variable value, or index value).

There may be any number of spaces within the equation, between operators, and so forth. 
There cannot, however, be any spaces between the letters of intrinsic-function names nor for 
variables referred to by name. (See Section 24.2.1.1, “Equation Variables and Values.”)

Figure 24-2. The Specify Equations dialog.
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If the variable on the left-hand side (LValue) already exists in the data set of the active frame, 
the equation is used to modify that variable. If the variable does not already exist, the equation 
is used to create a new variable as a function of existing variables.

If the equation contains a syntax error, the equation is displayed in an error dialog. The error 
dialog informs you of the approximate location of the syntax error.

Each equation occupies one line of the Equation(s) text field of the Specify Equations dialog. 
You can use multiple equations, all of which use as defaults, the zones and index ranges set up 
at the time you click Compute. Each equation is applied to all specified zones and data points 
before subsequent equations are computed.

24.2.1.1. Equation Variables and Values. A variable is specified in one of three ways: 
according to its order in the data file, by its name, or by a letter code.

A variable may be referenced according to its order in the data file. V1 is the first variable in 
the data file, V2 is the second, and so forth.

For example, to set the first variable in the data file equal to the sum of the values of the second 
and third variables, type:

V1 = V2 + V3

To create a new variable using this specification, you must specify the number of the next 
available variable. Assuming there are five variables in the data file, you can create a new vari-
able that is equal to half of the fourth variable as follows:

V6 = V4 / 2

You must specify the number of the next available variable. If you try to assign the result to a 
higher numbered variable, Tecplot pops up an error dialog informing you that you have speci-
fied an invalid variable number.

A variable may also be referenced by its name. You refer to a variable by its name by enclosing 
the name within curly braces (“{” and “}”). For example, to set V3 equal to the value of the 
variable named R/RFR, you can type:

V3 = {R/RFR}

Variable names are case insensitive, meaning that any combination of uppercase and lowercase 
letters matches the variable name. Leading and trailing spaces are also not considered. So the 
following equations are equivalent:

v3 = {R/rfr} 
V3 = { r/rfr }

Spaces within the variable name are significant, so the following equation is not equivalent to 
the equations above:

V3 = {R / rfr}
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If two or more variables have the same name, Tecplot uses the first variable. So, if both V5 and 
V9 are named R/rfr, V5 is used.

The curly braces can also be used on the left-hand side of the equation. In this case, if a vari-
able with that name does not exist, a new variable is created with that name. This is useful in 
equation files (see Section 24.2.1.6, “Equation Examples,” for details). For example, the fol-
lowing equation sets a variable called T/R to the value of a variable called T divided by the 
value of a variable called R. If no variable called T/R exists, a new variable is created.

{T/R} = {T} / {R}

Variables may also be referenced by letter codes. Letter codes can also be used to reference 
index values. Valid letter codes are:

• I: The I-index value at the data point.

• J: The J-index value at the data point (1 for finite-element zones).

• K: The K-index value at the data point (1 for finite-element zones).

• X: The variable assigned to the X-axis (in XY-plots, all active mappings must have the 
same X variable in order for this variable name to be valid).

• Y: The variable assigned to the Y-axis (in XY-plots, all active mappings must have the same 
Y variable in order for this variable name to be valid).

• Z: The variable assigned to the Z-axis (if in 3-D).

• A: The variable assigned to the Theta-axis for Polar plots. For this variable to be valid, the 
plot type must be set to Polar Line. In addition, all active mappings must have the same 
Theta-variable.

• R: The variable assigned to the R-axis for Polar plots. The plot type must be Polar Line, and 
all active mappings must have the same R-variable for this variable name to be valid.

• U: The X-component of vectors (if set).

• V: The Y-component of vectors (if set).

• W: The Z-component of vectors (if set, and if in 3-D).

• B: The value-blanking variable (if set).

• C: The contour variable (if set).

• S: The scatter-sizing variable (if set).

Letter codes may be used anywhere on the right-hand side of the equation. Do not enclose 
them in curly braces. Some examples follow:

V3 = I + J 
V4 = cos(X) * cos(Y) * cos(Z) 
{Dist} = sqrt(U*U + V*V + W*W) 
{temp} = min(B,1)
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Those letter codes representing variables (all letter codes except I, J, and K) may be used on 
the left-hand side of the equation, as well. For example:

Z = X*X/(1+Y*Y) 
W = 0 
S = 1+ABS(S)

You receive an error message if the appropriate Tecplot feature is not available. For example, if 
you try to use Z and the current frame is not in the 3D Cartesian plot type, you get an error 
message. The variables referenced by the letter codes are for the current frame.

You may use auxiliary data containing numerical constants in equations. For example, using 
reference quantities read from the data file as auxiliary data to compute dimensional variables 
from non-dimensional variables. The syntax for using auxiliary data in equations is:

AUXZONE[nnn]:Name

AUXDATASET:Name

AUXFRAME:Name

For instance, a data set auxiliary data constant called Pref would be referenced using AUX-
DataSet:Pref. Equations using this auxiliary data might appear as:

{P} = {P_NonDim} *  AUXDataSet:Pref

A frame auxiliary data constant called Mach would be referenced using AUXFrame:Mach. 
Zone auxiliary data constants may be referenced in one of two ways: AUXZone:Name uses 
the Name auxiliary data constant for the zone being operated on while AUX-
Zone[nnn]:Name uses the Name auxiliary data constant for zone number nnn. For exam-
ple, if you are operating on zones 1-3, AUXZone:Reynolds references the auxiliary data 
constant named Reynolds attached to zone 1 when operating on zone 1, the auxiliary data 
constant name Reynolds attached to zone 2 when operating on zone 2, and so on. For the 
same case, AUXZone[2]:Reynolds references the auxiliary data constant named Rey-
nolds attached to zone 2 for all zones it is operating on.

24.2.1.2.  Data Set Information. To view a host of information about the current data set, 
select Data Set Info on the Data menu. You may also select Specific Equations from the Alter 
sub-menu of the Data menu. The Data Set Information dialog appears, as shown in 
Figure 24-3. This dialog has five pages providing information on the zones and variables, 
general data set information including source files, variable sharing,the data journal, and auxil-
iary data. Zone/Variable Info is the default page; it provides a list of zones and variables in the 
data set.

To see more information about a zone, select one of the zone names listed under Zone(s) in the 
upper left-hand corner. The information about that zone is displayed in the lower left-hand 
corner. If it is an ordered zone, the I-, J-, and K-values are shown. If it is a finite-element zone, 
the number of points and elements are shown. While a zone is selected you may edit its name 
in the Zone Name text field.
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For viewing more information about a variable, select one of the variable names listed under 
Variables in the upper right-hand corner. Information about that variable, such as its type (dou-
ble, float, long integer, and so forth), its location (nodal or cell-centered), its range in values, 
and the range in values for all active zones (field plots) or all referenced zones (line plots), is 
displayed in the lower right-hand corner. The set of all referenced zones is the set of all zones 
used by the current set of active line mappings. To see a variable’s range for a particular zone, 
select the zone from Zone(s) while the variable is highlighted under Variables. While a vari-
able is selected you may edit its name in the Variable Name text field.

Get additional information about the data set by clicking Data Set. If the data has not been 
changed since a data file was loaded, the name of that data file appears in the Data File(s) field. 
The Data Set Title field shows the current name of the data set. While a data set is selected you 
may edit its name in this field. The lower part of the page shows the Variable Load Mode, 
which affects your ability to load additional data files to append your current data set. See 
Chapter 5, “Working with Tecplot Files,” for a discussion of loading variables by name or 
position. The Locked By field informs you if the current data set has been locked by an add-on. 
Add-ons can lock a data set, preventing the deletion zones or deleting the last frame associated 
with a data set.

Click Sharing for information about data sharing within a data set. Select the zone and variable 
of interest and a list of zones that variable is shared with appears. To the right is a list of zones 
the connectivity is shared with.

Information on data journaling for data sets is available on the Journal page. This shows the 
journaled macro commands. Select Expand Command to see details of the commands. For a 
complete description of data journaling, see Section 24.1, “Data Journaling.”

Auxiliary data information is available on the Aux Data page. View auxiliary data information 
by zones, data sets, frames, or by name. When viewing zone information, all auxiliary data 
name/value pairs for selected zones are shown. Likewise, when viewing data set or frame 

Figure 24-3. The Data Set Information dialog.



Chapter 24. Data Operations

394

information, all auxiliary data name/value pairs attached to the data set or selected frame are 
displayed. Viewing by name allows you to see the auxiliary data of a given name at all loca-
tions (frame, data set, all zones). This is useful because the same auxiliary data name may have 
different values at different locations.

24.2.1.3. Equation Operators and Functions. In an equation, the valid binary operators 
are as follows:

Binary operators have the following precedence:

For example, the expression V1+2*V2 is evaluated as V1+(2*V2), not as (V1+2)*V2. 
Operators are evaluated from left to right within a precedence level (that is, “*” and “/” are 
evaluated left to right).

The available functions are as follows (except where noted, all take a single argument):

+ Addition.

- Subtraction.

* Multiplication.

/ Division.

** Exponentiation.

** Highest precedence.

*,/  

+,- Lowest precedence.

SIN Sine (angle must be specified in radians).

COS Cosine (angle must be specified in radians).

TAN Tangent (angle must be specified in radians).

ABS Absolute value.

ASIN Arcsine (result is given in radians).

ACOS Arccosine (result is given in radians).

ATAN Arctangent (result is given in radians).

ATAN2(A,B) Arctangent of A/B (result is given in radians).

SQRT Positive square root.

LOG, ALOG Natural logarithm (base e).

LOG10, ALOG10 Logarithm base 10.

EXP Exponentiation (base e); EXP(V1)=e**(V1).
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LOG and ALOG are equivalent functions, as are LOG10 and ALOG10.

First- and second-derivative and difference functions are also available. These are discussed 
later in this section.

To call an intrinsic function, place its argument within parentheses (“(” and “)”). For example, 
to set V4 to the arctangent of V1, use:

V4 = ATAN(V1)

24.2.1.4. Zone Number Specification. By following a variable reference with square 
brackets (“[” and “]”), you can specify a specific zone from which to get the variable value. 
Some examples follow:

V3 = V3 - V3[1] 
X = ( X[1] + X[2] + X[3] ) / 3 
{TempAdj} = {Temp}[7] - {Adj} 
V8 = V1[19] - 2*C[21] + {R/T}[18]

The zone number must be a positive integer constant less than or equal to the number of zones. 
The zone specified must have the same structure (I-, IJ-, or IJK-ordered or finite-element) and 
dimensions (IMax, number of nodes) as the current zone. If you do not specify a zone, the 
current zone is used.

Zone specification works only on the right-hand side of the equation. All values used on the 
right-hand side of the equation are the values before the alteration began. To specify zones for 
the left-hand side, use the Zones region of the Specify Equations dialog.

24.2.1.5. Index Specification. By following a variable reference with parentheses (“(” and 
“)”), you can specify indices. Indices can be absolute or an offset from the current index. For 
example:

V2 = ( V2(i+1) + V2(i-1) ) / 2 
U = U(i+1,j) - U(i-1,j) + V(i+2,1) + 3*W(i-1) 
{NTQ} = {TQ} + {TQ}(i-3,j+7,k-1) - {TQ}(3,j+1,k+8} 
S = S(i+1,j) - V3(2) + {RFR/T}(J+2)

Index offsets are specified by using the appropriate index “i”, “j” or “k” followed by a “+” or 
“-” and then an integer constant. Any integer offsets may be used. If the offset moves beyond 
the end of the zone, the boundary value is used. For example, V3(i+2) uses the value 

MIN(A,B) Minimum of A or B.

MAX(A,B) Maximum of A or B.

SIGN Returns -1 if argument is negative, +1 otherwise.

ROUND Round off to the nearest integer.

TRUNC Remove fraction part of a value.
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V3(IMAX) when I=IMax-1 and I=IMax. V3(I-2) uses the value of V3(1) whenI=1 or 
I=2. 

Absolute indices are specified by using a positive integer constant only. For example, V3(2) 
references V3 at index 2 regardless of the current i index.

Indices must be listed I-index, then J-index, then K-index. The J-index is omitted if the data set 
is I-ordered; the K-index is omitted if the data set is not IJK-ordered. Indices are not allowed 
for finite-element data.

Index specification works only on the right-hand side of the equation. If the indices are not 
specified, the current index values are used. To specify indices for the left-hand side, use the 
Index Ranges section of the Specify Equations dialog.

Indices may be combined with zone specifications. The zone is listed first, then the index 
offset. For example:

V3 = V3 - V3[1](i+1) 
Y = Y[1] - Y[2](1) + Y(1,j+3) + Y

24.2.1.6. Equation Examples. In the following equation, V1 (the first variable defined in 
the data file) is replaced by two and a half times the existing value of V1:

V1 = 2.5*V1

The following equation sets the value of a variable called Density to 205. A new variable is 
created if a variable called Density does not exist.

{Density} = 205

In the next equation, the values for Y (the variable assigned to the Y-axis) are replaced by the 
negative of the square of the values of X (the variable assigned to the X-axis):

Y = -X**2

The following equation replaces the values of V3 with the values of V2 rounded off to the 
nearest integer. A new variable is created if there are only two variables currently in the data 
set.

V3 = round(V2)

In the following equation, the values of the fourth variable in the data set are replaced by the 
log (base 10) of the values of the third variable.

V4 = ALOG10(V3)

Suppose that the third variable and fourth variable are the X- and Y-components of velocity 
and that there are currently a total of five variables. The following examples create a new vari-
able (V6) that is the magnitude of the components of velocity.

V6 = (V3*V3+V4*V4)**0.5

or
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V6 = sqrt(V3**2+V4**2)

The above operation can also be accomplished with the following equation (assuming you 
have already defined the vector components for the current frame):

{Mag} = sqrt(U*U + V*V)

The following equation sets the value of a variable named diff to the truncated value of a 
variable named depth subtracted from the existing value of depth:

{diff} = {depth} - trunc({depth})

In the next equation, C (the contour variable) is set to the absolute value of S (the scatter-sizing 
variable), assuming both C and S are defined:

C = abs(S)

In the following example, a new variable is created (assuming that only seven variables ini-
tially existed in the data file). The value for V8 (the new variable) is calculated from a function 
of the existing variables:

V8 = SQRT((V1*V1+V2*V2+V3*V3)/(287.0*V4*V6))

The above operation could have been performed in two simpler steps as follows:

V8 = V1*V1+V2*V2+V3*V3 
V8 = SQRT(V8/(287.0*V4*V6))

The following equation replaces any value of a variable called TIME that is below 5.0 with 
5.0. In other words, the values of TIME are replaced with the maximum of the current value 
of TIME and 5.0:

{TIME} = max({TIME},5)

The following equation creates variable V4 which has values of X at points where X<0; at other 
points, it has a value of zero (this does not affect any values of X):

V4 = min(X,0)

Another example using intrinsic functions is shown below:

V8 = 55.0*SIN(V3*3.14/180.0) + ALOG(V4**3/(v1+1.0))

You can also reference the I-, J-, and K-indices in an equation. For example, if you wanted to 
cut out a section of a zone using value-blanking, you could create a new variable that is a func-
tion of the I- and J-indices (for IJ-ordered data). Then, by using value-blanking, you could 
remove certain cells where the value of the value-blanking variable was less than or equal to 
the value-blanking cut-off value.

Here is an example for calculating a value-blanking variable that is zero in a block of cells 
from I=10 to 30, and is equal to one in the other cells:

V3 = min((max(I,30)-min(I,10)-20),1) 
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The following equation replaces all values of Y with the difference between the current value 
of Y and the value of Y in zone 1. (If zone 1 is used for the data alteration, the new values of Y 
will be zero throughout that zone.)

Y = Y - Y[1]

The following equation replaces the values of V3 (in an IJ-ordered zone) with the average of 
the values of V3 at the four adjacent data points:

V3 = (V3(i+1,j)+V3(i-1,j)+V3(i,j+1)+V3(i,j-1))/4

The following equation sets the values of a variable called TEMP to the product of the values of 
a variable called T measured in four places: in zone 1 at two index values before the current 
data point, in the current zone at an absolute index of three, in zone 4 at the current data point, 
and in the current zone at the current data point.

{TEMP} = {T}[1](i-2) * {T}(3) * {T}[4] * {T}

24.2.1.7. Derivative and Difference Functions. Tecplot has a complete set of first- and 
second-derivative and difference functions. These functions are listed below:

ddx     ddy     ddz     dda     ddr 
d2dx2   d2dy2   d2dz2 
d2dxy   d2dyz   d2dxz 
ddi     ddj     ddk     d2daz   d2dar     d2dr2z 
d2di2   d2dj2   d2dk2 
d2dij   d2djk   d2dik

The derivative function ddx is used to calculate ; d2dx2 calculates ; d2dxy calcu-

lates , and so on. The derivatives dda, ddr, d2da2, and so forth, are with respect to the 

Theta angle (a) and radius (r) in Polar plots. They may only be used with Polar Line plot 
types. The difference functions ddi, d2di2, and so forth, calculate centered differences of 
their argument with respect to the indices I, J, and K based on the indices of the point. For 
example:

The difference functions may not be used with finite-element zones. The derivative and differ-
ence functions are used just like the intrinsic functions described above. For example:

V4 = ddx(V3) 
V6 = d2dx2(v5) 
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{dC/dx} = ddx(C) 
V8 = ddj(X) 
{Vt12} = ddy({Vt11}(i+1)) + ddy({Vt11}(i-1)) 
Z = d2dj2(sin(v5*v6)) 
V9 = ddj(ddx({R/T})) 
C = d2dij(C[1]-C) 
{NEWVAR}=ddi(X)+ddj(Y)+ddk(Z)

The use of derivative and difference functions is restricted as follows:

• Derivatives and differences for IJK-ordered zones are calculated for the full 3-D volume. 
The IJK-mode for such zones is not considered.

• If the derivative cannot be defined at every data point in all the selected zones, the operation 
is not performed for any data point.

• Derivative functions are calculated using the current frame’s axis assignments. Be careful if 
you have multiple frames with different variable assignments for the same data set.

• Derivatives at the boundary of two zones may differ since Tecplot operates on only one 
zone at a time while generating derivatives.

Boundary values for first-derivative and difference functions (ddx, ddy, ddz, ddi, ddj, and 
ddk) of ordered zones are evaluated in one of two methods: simple or complex. The default is 
simple. The following parameter in the configuration file selects the method to use:

$!INTERFACE 
  DATA {DERIVATIVEBOUNDARY=SIMPLE}

Change the parameter SIMPLE to COMPLEX to use the complex boundary condition.

For simple boundary conditions, the boundary derivative is determined by the one-sided first 
derivative at the boundary. This is the same as assuming that the first derivative is constant 
across the boundary (with the second derivative equal to zero).

For complex boundary conditions, the boundary derivative is extrapolated linearly from the 
derivatives at neighboring interior points. This is the same as assuming that the second deriva-
tive is constant across the boundary (with the first derivative varying linearly).

For second-derivatives and differences (d2dx2, d2dy2, d2dz2, d2dxy, d2dyz, d2dxz, 
d2di2, d2dj2, d2dij, d2dk2, d2djk, and d2dik), these boundary conditions are 
ignored. The boundary derivative is set equal to the derivative one index in from the boundary. 
This is the same as assuming that the second derivative is constant across the boundary.

You can create your own derivative boundary conditions by using the index range and the 
indices options discussed previously.

24.2.1.8. Variable Sharing Between Zones. For zones with the same structure and index 
ranges, you can set a variable to be shared by specifying that the variable for those zones have 
the values from one zone. For example, if zones 3 and 4 have the same structure and you 
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compute V3=V3[3] for zones 3 and 4, V3 will be shared. However, it is also possible for 
zones to lose the sharing of variables by equations altering those variables.

24.2.2. Zone Selection

You may select which zone(s) to alter using the Zones to Alter area of the Specify Equations 
dialog. By default, all zones are altered. If you are creating a new variable, all zones must be 
selected since all zones in a data set must have the same number of variables per data point.

24.2.3. Index Range and Skip Selections for Ordered Zones

For ordered zones, you can use the Index Ranges area of the Specify Equations dialog to select 
which data points to alter (based upon the index values). You can specify an I-Index range, a J-
Index range, and/or a K-Index range.

For each index range, you enter the start index value, the end index value, and a skip factor. A 
skip factor of one applies your equation to every index value; two does every other; three, 
every third; and so forth. Use the special value 0 or Mx to specify the maximum index. You can 
also use the values Mx-1 (to specify the index one less than the maximum index), Mx-2, and 
so forth. By default, these ranges are set to the entire range of points (that is, the start index 
defaults to one, the end index defaults to Mx, and the skip factor defaults to one). 

The index ranges are applied to all ordered zones that are selected using the Zones to Alter 
area. Index ranges are ignored for finite-element zones; every data point of a finite-element 
zone is altered regardless of the settings in the Index Ranges area.

If you are creating a new variable, the new variable’s value is set to zero at any index value that 
is skipped.

24.2.4. Data Type Specification for New Variables
If your equations are creating one or more new variables, you can specify a data type for these 
new variables using the New Var Data Type drop-down. By default, this is set to Auto, and 
Tecplot assigns the most appropriate data type to the variables. However, if you want to be sure 
that your new variables have a particular data type, choose the type from the New Var Data 
Type drop-down.

The following data types are available:

• Single: Four-byte floating point values.

• Double: Eight-byte floating point values.

• Long Int: Four-byte integer values.

• Short Int: Two-byte integer values.

• Byte: One-byte integer values (zero to 255).

• Bit: Either zero or one.
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24.2.5. Data Location Specification for New Variables
If your equations are creating new variables, you can specify the location for these new vari-
ables using the New Var Location drop-down. By default this is set to Auto, and Tecplot pre-
sumes the variable is located at the node, unless all variables used in the equation are cell-
centered. If you want to be sure of the location, specify node or cell-center from the New Var 
Location drop-down.

24.2.6. Equation Restriction Overriding
The zone and index restrictions specified in the equation dialog can be overridden on an equa-
tion by equation basis. To specify restrictions for a single equation add the colon character (:) 
at the end of the equation followed by one or more of the following:

For example, to add one to X in zones 1, 3, 4, and 5:

X=X+1:<Z=[1,3-5]>

The following example adds one to X for every other I-index. Note that zero represents the 
maximum index.

X=X+1:<I=1,0,2>

The next example creates a new variable of type Byte:

{NewV}=X-Y:<D=Byte>

24.2.7. Data Alteration

After you have set the index ranges and zones that are to be altered and have entered the equa-
tions, click Compute to apply the equations to your data. Each equation is applied to each data 
point in each zone independently of the other points. Each equation is applied to all specified 
zones and data points before subsequent equations are processed.

If an error occurs during the alteration (because of division by zero, overflow, underflow, and 
so forth), an error message is displayed, and all of the zones are restored to the state they were 
in before the bad equation was processed. Thus, if you have three equations A, B, and C, and B 
contains an error, the final state is the result of processing equation A.

Equation Restrictor Comments

<Z=<set>> Restrict the zones.

<I=start[,end[,skip]]> Restrict the I-range.

<J=start[,end[,skip]]> Restrict the J-range.

<K=start[,end[,skip]]> Restrict the K-range.

<D=<datatype>> Set the data type for the variable on the 
left hand side. This only applies if a new 
variable is being created.
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24.2.8. Macros and Equations

Tecplot allows you to put your equations in macros. In fact, we sometimes refer to a macro 
with just equations as an equation file. An equation in a macro file is specified using the 
$!ALTERDATA macro command. Equation files may also include comment lines, and in fact 
must start with the comment #!MC 1000, like other macro files. If you are performing 
complex operations on your data, and/or the operations are repeated frequently, equation files 
can be very helpful.

You can create equation files from scratch using an ASCII text editor, or you can create your 
equations interactively using the Specify Equations dialog, and then save the resulting equa-
tions. The standard file name extension for equation files is .eqn.

For example, you might define an equation to compute the magnitude of a 3-D vector. In the 
Specify Equations dialog, it would have the following form:

{Mag} = sqrt(U*U + V*V + W*W)

In a macro file, it would have the following form:

#!MC 1000 
$!ALTERDATA 
  EQUATION = "{Mag} = sqrt(U*U + V*V + W*W)"

That is, the interactive form of the equation must be enclosed in double quotes and supplied as 
a value to the EQUATION parameter of the $!ALTERDATA macro command.

To read an equation file, click Load Equations on the Specify Equations dialog. The Load 
Equation File dialog appears. Select an equation file that contains a set of equations to apply to 
the selected zones of your data. The equations in the equation file are added to the list of equa-
tions in the dialog. All equations are applied to your data when you click Compute.

Equations in equation files may be calculated somewhat differently depending on whether the 
computation is done from within the Specify Equations dialog or by running the equation file 
as a macro. When loaded into the Specify Equations dialog, equations that do not contain zone 
or index restrictions use the current zone and index restrictions shown in the dialog. When pro-
cessed as a macro file, such equations apply to all zones and data points. To include zone and 
index restrictions, you must include them in the equation file as part of the $!ALTERDATA 
command. See Section 24.2.8.2, “Zones To Operate On Specification,” and Section 24.2.8.4, 
“Range and Skip Factor Specification,” for details.

24.2.8.1. Equation File Comments. As with any macro file, any line with a pound sign 
(“#”) as the first character is considered a comment and ignored. For example:

#!MC 1000 
# 
# calculate magnitudes of vectors 
# 
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$!ALTERDATA 
  EQUATION = "{Mag} = sqrt(U*U + V*V + W*W)" 
# 
# normalize 
# 
$!ALTERDATA 
  EQUATION = "U = U/{Mag}" 
$!ALTERDATA 
  EQUATION = "V = V/{Mag}" 
$!ALTERDATA 
  EQUATION = "W = W/{Mag}" 
# 
# done 
#

24.2.8.2. Zones To Operate On Specification. To restrict the zones to operate on, 
specify the number of the zone or zones to the $!ALTERDATA command as a square-brack-
eted parameter:

$!ALTERDATA [zonelist] 
  EQUATION = "equation"

where zonelist is a list of zones or zone ranges separated by a comma (“,”). Zone ranges are 
separated by a hyphen (“-”). For example, the following macro command restricts the equa-
tion to only the second zone:

$!ALTERDATA [2] 
  EQUATION = "X=X+1"

If you do not specify the zones in your equation file, Tecplot defaults to the dialog settings if 
you read the equations into the Specify Equations dialog. (If you run the equations from a 
macro file, Tecplot defaults to all zones.) The default setting in the Specify Equations dialog is 
all zones. To create a new variable, you must have all zones available for data operation.

For example:

#!MC 1000 
# do the following to default set of zones  
$!ALTERDATA 
  EQUATION = "Y = Y*2" 
# now just do zone 1 
$!ALTERDATA [1] 
  EQUATION = "Y = 0" 
# now just do zones 2 and 3 
$!ALTERDATA [2-3] 
  EQUATION = "Y = Y[4]" 
# now just do zones 4, 5, 6, 7, and 19 
$!ALTERDATA [4-7,19] 
  EQUATION = "Y = Y(i-1) + Y(i+1)" 
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# now do all zones to create a new variable 
$!ALTERDATA  
  EQUATION = "{SomeNewVariable} = 0"

24.2.8.3. Zone Number Specification for Operands. By following a variable reference 
with brackets “[” and “]” you may designate a specific zone from which to get the variable 
value. For example:

V3 = V3 -V3[1] 
X = ( X[1] + X[2] + X[3] ) / 3 
{TempAdj} = {Temp}[7] - {Adj} 
V7 = V1[19] - 2*C[21] + {R/T}[18]

The zone number must be a positive integer constant less than or equal to the number of zones. 
The zone designated must have the same structure (finite-element, I-, IJ-, or IJK-ordered) and 
dimensions (number of nodes and so forth). If you do not designate a zone, the current zone 
will be used.

Specifying a zone only works on the right-hand side of an equation. All values used on the 
right-hand side of the equation are the values from before the alteration began.

24.2.8.4. Range and Skip Factor Specification. You can restrict index ranges from 
within your Equation file by specifying the following parameters to the $!ALTERDATA macro 
command:

IRANGE = min, max, skip 
JRANGE = min, max, skip 
KRANGE = min, max, skip

where min is the minimum value for that index; max, the maximum; and skip, the skip factor. 
Index ranges are described in Section 24.2.3, “Index Range and Skip Selections for Ordered 
Zones.” If these commands are not used, the default index ranges use the currently selected 
indices (if the equations are executed from a macro, all points are used). Index ranges are 
effective only for ordered zones.

For example:

#!MC 1000 
# 
# use default index range 
# 
$!ALTERDATA 
  EQUATION = "{K/10} = round(K/10)" 
# 
# calculate d2dxy(C) everywhere 
# 
$!ALTERDATA 
  IRange = 1,0,1 
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  JRange = 1,0,1 
  KRange = 1,0,1 
  EQUATION = "V5 = d2dxy(C)" 
# 
# set corner values to zero 
# 
$!ALTERDATA  
 IRange = 1,0,0 
 JRange = 1,0,0 
 KRange = 1,0,0 
 EQUATION = "V5 = 0"

24.2.8.5. New Variable Data Type Specification. You can specify the data type for new 
variables that are created in equations in the $!ALTERDATA command by including the fol-
lowing parameter:

DATATYPE = <datatype>

where datatype can be one of SINGLE, DOUBLE, LONGINT, SHORTINT, BYTE, or BIT.

For example, to create a new variable and set its data type to BYTE:

$!ALTERDATA 
  EQUATION = "{NewV} = X-Y" 
  DATATYPE = BYTE

24.2.8.6. New Variable Value Location Specification. You can specify the value loca-
tion for new variables that are created in equations in the $!ALTERDATA command by includ-
ing the following parameter:

VALUELOCATION = <valuelocation>

where datatype can be one of SINGLE, DOUBLE, LONGINT, SHORTINT, BYTE, or BIT.

For example, to create a new variable and set its data type to BYTE:

$!ALTERDATA 
  EQUATION = "{NewCC} = X-Y" 
  VALUELOCATION = CELLCENTERED

24.2.8.7. Variable Naming in an Equation File. To name a variable when creating it in 
an equation file, simply provide the name within curly braces ({}) on the left hand side of the 
equation, as in the example below:

#!MC 1000 
$!ALTERDATA 
  EQUATION = "{myvar} = V4 / V5"

To rename a variable using a macro, use the macro command $!RENAMEDATASETVAR, as 
in the example below:
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#!MC 1000 
$!RENAMEDATASETVAR 
  VAR = 6 
  NAME = "myvar"

The macro listed above may be played back using Play option of the Macro command under 
the File menu. It cannot, however, be loaded in as an equation in the Specify Equations dialog.

24.2.8.8. Equation File Examples. If you want to cut out a section of a zone using value-
blanking, you can create a new variable that is a function of the I- and J-indices (for IJ-ordered 
data). Then, by using value-blanking, you can remove certain cells where the value of the 
value-blanking variable is less than or equal to the value-blanking cut-off value. Below is an 
example equation file for calculating a value-blanking variable that is zero in a block of cells 
from I=10 to 28 and from J=5 to 16 and is equal to one in the other cells.

#!MC 1000 
## create a mask for the cells in the I-direction 
$!ALTERDATA 
  EQUATION =  "{MASK_I} = max(I,28) - min(I,10) - 18" 
$!ALTERDATA 
  EQUATION = "{MASK_I} = min({MASK_I},1)" 
## create a mask for the J-direction  
$!ALTERDATA 
  EQUATION = "{MASK_J} = max(J,16) - min(J,5) - 11" 
$!ALTERDATA 
  EQUATION = "{MASK_J} = min({MASK_J},1)" 
## create the value-blanking variable that is the 
## intersection ("and") of the above conditions 
$!ALTERDATA  
  EQUATION = "{VBLANK} = {MASK_I} + {MASK_J}" 
## create a second value-blanking variable that is 
## the union ("or") of the above conditions 
$!ALTERDATA 
  EQUATION = "{OR_VBLANK} = {MASK_I} * {MASK_J}"

Another example of an equation file is shown below. In this example, V8 is a new variable, so 
all zones must be selected when V8 is created.

#!MC 1000 
## The first three equations are applied to all zones  
$!ALTERDATA 
  EQUATION = "V4 = SQRT(V4) / 460.0" 
$!ALTERDATA 
  EQUATION = "V4 = (V4*V5 + V4*V6)/2" 
$!ALTERDATA 
  EQUATION = "V5 = SIN(V4/V3) * EXP(-0.53*V2/V1)" 
## Creating New Variable, Operate on all zones 
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$!ALTERDATA [1,|NUMZONES|] 
  EQUATION = "{CRITT} = 0.5396E-3 * V4**2" 
## Operate on Zone 5 only 
$!ALTERDATA [5] 
  EQUATION = "V1 = V1 / 2" 
$!ALTERDATA [5] 
  EQUATION = "V2 = V2 / 2" 
## Operate On Zones 6,7,8,9, and 23 Only 
$!ALTERDATA [6-9,23] 
  EQUATION = "V1 = V1 * 4.3" 
$!ALTERDATA [6-9,23] 
  EQUATION = "V2 = V2 * 4.3" 
## Operate On All Zones, But Limit Index Ranges 
## To Every Fifth Point in the I- or J-Direction 
$!ALTERDATA  
  IRange = 1,0,5 
  JRange = 1,0,5 
  EQUATION = "V5 = EXP(V3(i-2)+V5(i+4))" 
## 
##

24.3. Coordinate Transformation
All 2- and 3-D Tecplot plots use a rectangular coordinate system with axes X and Y. Some 2- 
and 3-D data may be represented in polar coordinate form, in which each point is represented 
by the radius r and by an angle θ (in radians). For line plots you should plot this data using the 
Polar Line plot type. For field plots, such a data set initially displays as a rectangle in Tecplot.

In 3-D, transformation, Tecplot assumes the current X-variable represents the radius ρ, the 
current Y-variable the angle θ (in radians), and the current Z-variable the angle ψ. Figure 24-4 
shows ρ, θ, and ψ in the spherical coordinate system. 

Use the Transform Coordinates dialog to transform data sets in polar coordinates to a rectangu-
lar coordinate system. When you use this dialog, Tecplot assumes the current X-variable repre-

Figure 24-4. Three-dimensional angles of rotation.
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sents the radius r, and the current Y-variable represents the angle θ.These variables are listed 
in the upper portion of the Transform Coordinates dialog, shown in Figure 24-5.

The following options are available:

• Transformation: Select the type of transformation for changing all points in one or more 
zones from one coordinate system to another. Options include Polar to Rectangular, Spher-
ical to Rectangular, Rectangular to Polar, Rectangular to Spherical.

• Theta/X Variable: Selects variable to use for Theta/X in transformation equations.

• R/Y Variable: Selects variable to use for R/Y in transformation equations.

• Psi/Z Variable: Selects variable to use for Psi/Z in transformation equations.

• Create New Variables: When checked, new variables are created to hold the transformed 
values. Tecplot comes up with names so the data set integrity is maintained (no two vari-
ables with same names).

• Put Results in Existing Variables: When checked, results are put into variables in the cur-
rent data set.

• X/Theta Variable: Selects variable to receive X/Theta values from transformation.

• Y/R Variable: Selects variable to receive Y/R values from transformation.

• Z/Psi Variable: Selects variable to receive Z/Psi values from transformation.

• Angles in: Selects whether to calculate using values in Theta and Psi variable as radians or 
degrees.

• Select Zones to Transform: Selects zones to alter (also displays that all are transformed).

To transform your data in polar coordinates to rectangular coordinates:

Figure 24-5. The Transform Coordinates dialog.
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1. From the Data menu, choose Alter, then choose Transform Coordinates. The Transform 
Coordinates dialog appears as shown in 

2. Select the type of transformation desired. Options include polar or spherical to rectangular, 
rectangular to polar or spherical. Verify that the X- and Y-variables shown represent r and 
θ, respectively, in your polar coordinate data. The data must be in radians.

3. Select the zones for the transformation, then click Compute.

24.4. Two-Dimensional Data Rotation
Use the 2D Rotate dialog to rotate 2-D field data about a user specified XY-origin. Unlike 3-D 
rotation, which does not alter the data but merely the user’s view of the data, 2-D rotation actu-
ally modifies the data.

To rotate data in 2-D:

1. From the Data menu, choose Alter, then choose 2D Rotate. The 2D Rotate dialog appears, 
as shown in Figure 24-6.

2. Specify the angle of rotation, in degrees, using the Angle (deg) drop-down.

3. Enter the X- and Y-coordinates of the origin of rotation (that is, the point around which the 
data rotate).

4. Select the zones to rotate.

5. Click Compute.

24.5. Zone Creation
You create zones in Tecplot as part of any number of operations: zone duplication, iso-surface 
extraction, streamtrace zone generation, 3-D data slicing, finite-element boundary extraction, 
and triangulation. Most of these tasks are discussed in the chapter related to those topics—
streamtrace zone generation, for example, is discussed in Chapter 13, “Streamtraces.” This 
section concentrates on zone creation that is also essentially data creation—creating new rect-
angular, circular, or linear zones. We also describe briefly the data duplication aspects of zone 
creation—zone duplication, mirror zones, and finite-element zone creation from polylines, and 
creation of 1-D zone by direct entry of values.

Figure 24-6. The 2D Rotate dialog.
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24.5.1. One-Dimensional Line Zone Creation
A 1D-line zone is an I-ordered set of points along a line. You can create a 1-D line zone as the 
first step in plotting an analytic function. Typically, you create the 1-D line zone, then use the 
Specify Equations dialog to modify the Y-variable, then plot the result.

To create the 1-D line zone:

1. From the Data menu, choose Create Zone, then choose 1-D Line. The Create 1-D Line 
Zone dialog appears.

2. In the text field labeled Number of Points, enter the number of points you want to have in 
the zone.

3. In the text fields labeled XMin and XMax, enter the range of X-values for the defined 
points.

4. Click Create. A dialog informs you that the zone was created. Tecplot uniformly distributes 
the points along the X-axis between XMin and XMax. Y, and any other variables, are set to 
zero.

24.5.2. Rectangular Zone Creation

Creating a rectangular zone is often the first step in interpolating irregular data into an ordered 
grid (see Section 20.4, “Three-Dimensional Volume Irregular Data Interpolation,” ) or in plot-
ting analytic functions as described in Section 20.8.2, “Analytic Iso-Surface Plots.”

Tecplot allows you to create a new ordered rectangular zone with the dimensions in the I-, J- 
and K-directions you specify. This is done either with the Create Rectangular Zone tool or the 
Create Rectangular Zone dialog. The zone that you create has the same number of variables as 
other zones in the data set, if any. Otherwise, it has just two or three variables, depending on 
the value specified for the K-dimension. For the 3D Cartesian plot type, you can specify three 
dimensions when creating a zone. For the 2D Cartesian plot type, you can specify two dimen-
sions. If you have a data set attached to your plot, Create Rectangular Zone does not work in 
the XY Line or Sketch plot types.

If you have no current data set, Tecplot creates one with two or three variables, depending on 
the specified K-dimension. If you specify K=1 (the default), the data set is created as IJ-
ordered, and has just two variables. If you specify K>1, the data set is created as IJK-ordered, 
and has three variables.

24.5.2.1. New Rectangular Zones in 2D Cartesian Plot Type. In 2D Cartesian plot 
type, you may create IJ-ordered zones. You may interactively draw the boundary of the new 
zone, or use the Create Rectangular Zone dialog to enter the X- and Y-coordinates of the lower-
left and upper-right corners of the new zone.

To create a rectangular zone interactively:
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1. From the sidebar, choose the Create Rectangular Zone tool. The tool is only available if a 
data set is attached to the current frame. Use the Create Rectangular Zone dialog to create a 
zone in an empty frame.

2. In the frame in which you want to create the zone, press down and hold the left mouse but-
ton to specify one corner of the zone.

3. Drag until the boundary of the zone is as desired, then release. The Create Rectangular 
Zone dialog appears (see Figure 24-7) with the X and Y extents for the rectangular zone 
already filled in. You can adjust the I- and J-dimensions and the X- and Y-coordinates.

4. Click Create to create the zone.

To create a rectangular zone using the Create Rectangular Zone dialog:

1. From the Data menu, choose Create Zone, then Rectangular. The Create Rectangular Zone 
dialog appears, as in Figure 24-7.

2. In the Create Rectangular Zone dialog, you enter the number of data points in the I-direc-
tion and the number of data points in the J-direction. Also enter the X- and Y-coordinates of 
the two corners.

3. Click Create.

Tecplot uniformly distributes the data points in the I- and J-directions. In this situation, the I-
direction is along the X-axis, and the J-direction is along the Y-axis as shown in Figure 24-8. 
All other variables (those not assigned to the X- and Y-axes) are set to zero.

After creating a rectangular zone, you can modify the X- and Y-coordinates and/or the other 
field variables using the tools under the Alter sub-menu of the Data menu.

24.5.2.2. New Rectangular Zones for the 3D Cartesian Plot Type. In 3D Cartesian 
plot type, you can create an I-ordered (linear) zone, an IJ-ordered (planar) zone or an IJK-
ordered (3-D volume) zone. In 3D Cartesian, the Create Rectangular Zone mouse mode is dis-
abled; you do not have the option to interactively draw the new zone.

Figure 24-7. The Create Rectangular Zone dialog.
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To create a rectangular zone for the 3D Cartesian plot type:

1. From the Data menu, choose Create Zone, then choose Rectangular. The Create Rectangu-
lar Zone dialog appears.

2. Enter the dimensions (that is, number of data points) in the I-direction, the J-direction, and 
the K-direction in the text fields grouped under the label Dimensions.

To create an I-ordered zone, enter one for both the J- and K-dimensions.

To create an IJ-ordered zone, enter one for the K-dimension. Z=ZMin throughout the cre-
ated zone.

To create an IJK-ordered zone, enter a K-dimension greater than one.

3. Enter the minimum and maximum coordinate values for X, Y, and Z in the text fields 
grouped under the label Coordinates.

4. Click Create to create the new zone.

The values for X, Y, and Z are calculated at each data point in the new zone. Tecplot distributes 
the data points uniformly in the I-, J-, and K-directions. In this situation, the I-direction is along 
the X-axis, the J-direction along the Y-axis, and the K-direction along the Z-axis. All other 
variables are set to zero. If you plot the new zone, you will see a rectangular mesh with 
uniform spacing in the X-, Y-, and Z-directions. The mesh lines are straight and parallel to the 
axes.

Using Alter option under the Data menu, you can modify the X-, Y-, and Z-coordinates, and 
the values of the other variables as well, by using equations or Equation files. See Section 24.2, 
“Data Alteration through Equations.”

24.5.3.  Circular or Cylindrical Zone Creation

Tecplot allows you to create a new ordered circular or cylindrical zone with the dimensions in 
the I-, J-, and K-directions you specify. The I-dimension determines the number of points on 
each radius of the zones. The J-dimension determines the number of points around the circum-
ference. The K-dimension determines the number of layers in the zone, creating a cylinder. 

Figure 24-8. A rectangular zone.
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24.5. Zone Creation

You create a circular or cylindrical zone with the Create Circular Zone dialog, or, in 2D Carte-
sian, with the Create Circular Zone tool. The zone that you create has the same number of vari-
ables as other zones in the data set, if any. In the 3D Cartesian, you can specify three 
dimensions when creating a data set. In 2D Cartesian, you can specify two dimensions. In the 
Sketch and XY Line plot types, the create circular zone options are not available, except in 
Sketch when no data set is attached to the current frame. 

If you have no current data set, Tecplot creates one with two or three variables, depending on 
the K-dimension. If you specify K=1 (the default), the data set is created as IJ-ordered, and has 
just two variables. If you specify K>1, the data set is created as IJK-ordered, and has three 
variables.

24.5.3.1. New Circular Zones for the 2D Cartesian Plot Type. In the 2D Cartesian 
plot type, you may create circular IJ-ordered zones. You may interactively draw the boundary 
of the new zone, or use the Create Circular Zone dialog to enter the radius and X- and Y-coor-
dinates of the center of the new zone.

To create a circular zone interactively:

1. From the sidebar, choose the Create Circular Zone tool. The tool is only available if a data 
set is attached to the current frame. Use the Create Circular Zone dialog to create a zone in 
an empty frame.

2. In the frame in which you want to create the zone, press down and hold the left mouse but-
ton to specify the center of the zone.

3. Drag the mouse until the boundary of the zone is as desired, then release. The Create Circu-
lar Zone dialog appears (see Figure 24-9) with the current origin and radius filled in for 
you. You may adjust the dimensions and coordinates as necessary.

4. Click Create to create the new zone.

To create a circular zone using the Create Circular Zone dialog:

1. From the Data menu, choose Create Zone, then Circular. The Create Circular Zone dialog 
appears, as in Figure 24-9.

Figure 24-9. The Create Circular Zone dialog.
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2. In the Create Circular Zone dialog, you enter the number of data points in the I-direction 
(radial) and the number of data points in the J-direction (circumferential). You must supply 
a J-dimension of at least 2.

3. Click Create to create the new zone.

Tecplot creates a zone in which I-circles are connected by J-radial lines, as shown in 
Figure 24-10. All other variables (those not assigned to the X- and Y-axes) are set to zero.

After creating a circular zone, you can modify the X- and Y-coordinates and/or the other field 
variables using the tools under the Alter sub-menu of the Data menu.

24.5.3.2. New Cylindrical Zones for the 3D Cartesian Plot Type. In 3D Cartesian, 
you can create an IJ-ordered (planar) zone or an IJK-ordered (3-D volume) zone. In 3-D, the 
Create Circular Zone mouse mode is disabled, so that you do not have the option to interac-
tively draw the new zone. 

To create a cylindrical zone in 3-D Cartesian:

1. From the Data menu, choose Create Zone, then choose Circular. The Create Circular Zone 
dialog appears. 

2. Enter the dimensions (that is, number of data points) in the I-direction (radial), the J-direc-
tion (circumferential), and the K-direction (layers) in the text fields grouped under the label 
Dimensions. 

To create an IJ-ordered zone, enter one for the K-dimension. Z=ZMin throughout the cre-
ated zone. 

To create an IJK-ordered zone, enter a K-dimension greater than one.

3. Enter the radius, the X- and Y-coordinate values for the zone center, and the minimum and 
maximum Z-coordinates in the text fields grouped under the label Coordinates.

4. Click Create to create the new zone.

Figure 24-10. A circular zone.

X

Y

-1 -0.5 0 0.5 1
-1

-0.75

-0.5

-0.25

0

0.25

0.5

0.75

1



415

24.5. Zone Creation

The values for X, Y, and Z are calculated at each data point in the new zone. If K>1, Tecplot 
creates a K-layered cylindrical zone having I-circles connected by J-radial planes as shown in 
Figure 24-11. All other variables are set to zero.

Using the Alter option from the Data menu, you can modify the X-, Y-, and Z-coordinates, and 
the values of the other variables as well, by using equations or equation files. See Section 24.2, 
“Data Alteration through Equations.”

24.5.4. XY Data Entry

If you have a fairly small number of XY-pairs, you can enter them directly into Tecplot to 
create a zone with XY-values.

To create an I-ordered zone for XY-plots:

1. From the Data menu, choose Create Zone, then choose Enter Values. The Enter XY-Values 
to Create a Zone dialog appears, as shown in Figure 24-12. 

2. In the text box labeled Enter XY Values, enter X- and Y-value pairs, one per line; first X, 
then one or more spaces, then Y.

3. If you would like to specify a data type for the data (long or short integer, float, double, 
byte, bit), select the desired data type from the drop-down labeled Destination Data Type.

4. Click Create to create the zone.

Figure 24-11. A 3-D circular zone.

Figure 24-12. The Enter XY-Values to Create a Zone dialog.
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24.5.5. Data Extraction from an Existing Zone

You may create new zones by extracting (or interpolating) data from existing zones in a 
number of ways. Derived objects, such as contour lines, FE-boundaries, iso-surfaces, current 
slices, or streamtraces may be extracted to be independent zones. You may also extract data 
using a specified slice plane, discrete points, points from a polyline, or points from a geometry. 
Finally, you may extract a sub-zone of an ordered zone.

The procedures for extracting derived objects are discussed in the chapters related to those 
objects. For details see Chapter 10, “Contour Plots,” Section 19.4, “Boundary Extraction of 
Finite-Element Zones,” Section 20.6.3, “Iso-Surface Extraction,” and Section 12.7, 
“Streamtrace Extraction as Zones.” Extracting slices, both derived objects and arbitrarily 
defined, is described in Section 20.7.2, “Slice Extraction.”

24.5.5.1. Sub-Zone Extraction. You can only extract a sub-zone out of an existing I-, IJ-, 
or IJK-ordered zone. You cannot create a sub-zone out of a finite-element zone. 

To create a sub-zone of an existing zone:

1. From the Data menu, choose Extract, then Sub-Zone. The Extract SubZone dialog appears, 
as shown in Figure 24-13.

2. Select the source zone from the Source Zone drop-down.

3. Specify the desired sub-zone as a range of I-, J-, and K-indices. For each of I-Index, 
J-Index, and K-Index (if applicable), specify a start index, an end index, and a skip. You 
may use the special value 0 or Mx to indicate the maximum of that index, and the values 
Mx-1 to represent one index less than the maximum, Mx-2 for two less than the maxi-
mum, and so forth.

4. Click Create to create the sub-zones. Each sub-zone is given the name “SubZone.”

24.5.6. Data Point Extraction
Another method for creating an I-ordered zone is to extract data points from the current data 
set using any of three methods:

Figure 24-13. The Extract SubZone dialog.



417

24.5. Zone Creation

• Choosing a discrete set of points with the mouse.

• Drawing a polyline with the mouse from which points are extracted at regular intervals.

• Selecting an existing polyline geometry from which points are extracted, either at regular 
intervals or at the points which define the geometry.

The difference between the second and third methods is that in the second method, the polyline 
used to extract the points is not a geometry and is not part of your plot—it is simply a transient 
structure used to extract the points. The points which define the polyline are not treated spe-
cially in any way. When you extract points from a polyline geometry, however, you can choose 
to use the points that define the polyline as the extracted points.

Note: To extract points from a geometry or polyline, it must lie within the boundaries of a zone 
with connectivity.

24.5.6.1. Discrete Point Extraction. To extract a discrete set of points with the mouse:

1. From the Data menu, choose Extract, then choose Discrete Points. 

2. Click at each location from which you want to extract a point.

3. Double-click on the last data point or press Esc to end. The Extract Data Points dialog 
appears; use it to specify how to save the data.

24.5.6.2. Point Extraction from a Polyline. To extract points from a polyline:

1. From the Data menu, choose Extract, then choose Points from Polyline. 

2. Click at the desired beginning of the line, and at all desired breakpoints.

3. Double-click on the last data point or press Esc to end. The Extract Data Points dialog 
appears; use it to specify how many points to extract and how to save the data.

24.5.6.3. Point Extraction from a Geometry. To extract points from a polyline geome-
try:

1. In the workspace, select the polyline geometry from which you want to extract data points.

2. From the Data menu, choose Extract, then choose Points from Geometry. The Extract Data 
Points dialog appears; use it to specify how many points to extract and how to save the 
data.

24.5.6.4. Data Point Extraction Controls. Use the Extract Data Points dialog to control 
how data points are extracted. Use the following controls:

• Extract Data to:

- File: Select this check box if you want the data points extracted to an ASCII Tecplot 
data file. If this check box is selected, the Extract Data Points to File dialog appears 
when you click Extract. Use this dialog to specify a file name for the extracted data file.
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- Zone: Select this check box if you want the data points extracted to a zone in the current 
data set.

• Include distance variable: Select this check box if you want the extracted data file to con-
tain an additional variable, DISTANCE, which contains the accumulated distance from the 
first point.

• Number of points to extract: Enter the number of points to extract. This field is sensitive 
only if you are extracting data points from a polyline or geometry. It is insensitive if you are 
extracting discrete points. If you are extracting from a geometry, you must also select the 
check box labeled “Extract regular points along a geometry.”

• Extract regular points along geometry: Select this check box if you want to extract the 
specified number of points distributed uniformly along the geometry. This check box is sen-
sitive only if you are extracting points from a geometry.

• Extract only points which define geometry: Select this check box if you want to extract 
only the endpoints of the segments in the geometry. This check box is sensitive only if you 
are extracting points from a geometry.

After specifying any desired options, click Extract.

24.5.7. Zone Duplication

Tecplot can create a new zone by duplicating all or part of an existing zone. This is useful for 
creating projections, mirror images, and sub-zones of existing zones.

24.5.7.1. Full Zone Duplication. To create a full duplicate of one or more existing zones:

1. From the Data menu, choose Create Zone, then Duplicate. The Create Duplicate Zone dia-
log appears, as shown in Figure 24-14.

2. Select the source zone or zones from the scrolled list labeled Source Zone.

3. Click Create to create the duplicate zone or zones. Each duplicate zone has the same name 
as the zone of which it is a copy.

Figure 24-14. The Create Duplicate Zone dialog.
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24.5. Zone Creation

Duplicate zones can be used as the first step to create new zones which are projections of exist-
ing 3-D surface zones onto a plane. To do this, follow these steps:

1. Create a plot of a 3-D surface zone.

2. Create a duplicate of the surface zone using the procedures in Section 24.5.7.1, “Full Zone 
Duplication.”

3. From the Data menu, choose Alter, then choose Specify Equations.

4. Make the new zone a plane by setting the Z-coordinate to a constant value (-20,000 in this 
example) by entering the following equation in the Specify Equations dialog:
Z = -20000

5. Select the new zone in the Zones to Alter region of the Specify Equations dialog, deselect-
ing other zones as necessary.

6. Click Compute to complete modifying the new zone.

Figure 24-15 shows an example of a projection of a 3-D surface zone.

24.5.7.2. Mirror Zone Creation. Tecplot makes it very simple to create a duplicate zone 
that is the mirror image of an existing zone if the desired mirror axis or mirror plane is one of 
the standard axes (2-D) or the plane determined by any two axes (3-D). To create a mirror 
image of one or more existing zones using one of these standard mirrors:

1. From the Data menu, choose Create Zone, then Mirror. The Create Mirror Zone dialog 
appears, as shown in Figure 24-16.

2. Select the source zone or zones from the scrolled list labeled Source Zone(s).

3. Specify the axis (2-D) or axis plane (3-D) to mirror about.

4. Click Create to create the mirror zone or zones. Each mirror zone has a name of the form 
“Mirror of zone sourcezone,” where sourcezone is the number of the zone from which the 
mirrored zone was created.

Figure 24-15. Projection of a 3-D surface.
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For example, consider the case where your input file describes a 90 degree wedge which occu-
pies the positive X-positive Y-quadrant. You want to create the complete circle based on your 
inputs. To do this, perform the following steps:

1. Mirror the original zone about the X-axis.

2. Mirror both the original zone and the mirrored zone created in Step 1 about the Y-axis.

It is also possible to create a mirror zone that is mirrored about a different axis or plane. For 
example, suppose you wanted to mirror a 2-D zone about the line X=5. You can do this as fol-
lows:

1. Create a mirror zone about the Y-axis as described above

2. From the Data menu, choose Alter, then choose Specify Equations. 

3. Enter the following equation in the Equations text field:
X = 10 - X

4. Specify the new mirror zone as the only zone to alter.

5. Click Compute to complete the process.

Figure 24-17 shows an example of creating mirror image zones.

Figure 24-16. The Create Mirror Zone dialog for a 2-D image.

Figure 24-17. Creating a mirrored zone.
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24.6. Zone or Variable Deletion

24.5.8. Finite-Element Surface Zone Creation from I-Ordered Zones
To create a finite-element surface zone from two or more I-ordered zones go to the Data 
menu’s Create Zone sub-menu. Select the Polylines option. The Create Zone from Polylines 
dialog appears, as shown in Figure 24-18.

Only I-Ordered zones (the polylines) will appear in the list. Select two or more zones.

An option is also available to connect the start and end points for each supplied polyline. This 
is especially useful when creating 3-D surfaces. The supplied polylines and the resulting 3-D 
surface are shown in Figure 24-19.

24.6. Zone or Variable Deletion
In any data set with more than one zone, you can use the Delete Zone dialog to delete any 
unwanted zones. You cannot delete all zones; if you attempt to delete all zones, the lowest 
numbered zone is not deleted.

Figure 24-18. The Create Zone from Polylines dialog.

Figure 24-19. Supplied polylines and the resulting 3-D surface.
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To delete a zone:

1. From the Data menu, choose Delete. From the Delete sub-menu, select Zone. The Delete 
Zone dialog appears as shown in Figure 24-20.

2. Select the zone or zones you want to delete.

3. Click Delete to delete the zones.

To delete a variable:

1. From the Data menu, choose Delete. From the Delete sub-menu, select Variable. The 
Delete Variable dialog appears; it is similar to the Delete Zone dialog shown in 
Figure 24-20.

2. Select the variable or variables to delete.

3. Click Delete to delete the variables.

24.7. Irregular Data Point Triangulation
Triangulation is a process in which data points are connected to form triangles. You can use tri-
angulation to convert irregular, I-ordered data sets into a finite-element surface zone. You can, 
in fact, use triangulation on any type of source zone, ordered or finite-element. But its use on 
irregular data is most common. Triangulation is one of two options for creating 2-D field plots 
from irregular data. The other is interpolation, discussed in Section 24.8, “Data Interpolation.” 
Triangulation preserves the accuracy of the data by creating an finite-element surface zone 
with the source data points as nodes and a set of Triangle elements. Triangulation is only avail-
able for the 2D Cartesian plot type.

Triangulation works best for 2-D data; you can, however, triangulate 3-D surface data as long 
as the Z-coordinate is single-valued (the surface does not wrap around on itself). When you tri-
angulate 3-D surface data, the Z-coordinate of the data is ignored, causing a less-than-optimal 
triangulation in some cases.

To triangulate your data:

Figure 24-20. The Delete Zone dialog.
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24.8. Data Interpolation

1. From the Data menu, choose Triangulate. The Triangulate dialog appears, as shown in 
Figure 24-21. 

2. Select the zone or zones to triangulate from the scrolled list labeled Source Zone(s).

3. If you want to specify a boundary zone for the triangulation, select the Use Boundary 
Zone(s) check box and select the boundary zone or zones from the Boundary Zone(s) 
scrolled list. The boundary zones define the boundaries in the triangulation region; if you 
do not include boundary zones, Tecplot assumes the data points lie within a convex poly-
gon and that all points in the interior can be connected.

4. (If Use Boundary Zone(s) is selected) If you want to include the points in the boundary 
zones in the triangulated zone, select the Include Boundary Points check box.

5. (Optional) Modify the Triangle Keep Factor, if desired. This factor is used to define “bad” 
triangles on the outside of the triangulated zone. See below for complete details.

6. Click Compute to perform the triangulation.

At the completion of triangulation, Tecplot attempts to remove bad triangles from the outside 
of the triangulation. This does not include any triangles next to the boundary zone, only those 
along the edges where there is no boundary (or where the boundary zone points are excluded). 
The definition of a bad triangle is stored as the Triangle Keep Factor as a number between zero 
(three collinear points) and 1.0 (an equilateral triangle). Typical settings are values between 0.1 
and 0.3; settings above 0.5 are not allowed.

After triangulating your data, you can use the resulting finite-element surface zone to create 
plots. Generally, you turn off the original zone(s) and plot the new zone only, but you can, for 
example, plot a scatter plot of the original zone(s) along with the contours of the new zone.

24.8. Data Interpolation
Interpolation, in Tecplot, means assigning new values for the variables at data points in a zone 
based on the data point values in another zone (or set of zones).

For example, you may have a set of data points in an I-ordered zone that are distributed in a 
random-like fashion in the XY-plane. This type of data is sometimes referred to as unordered, 

Figure 24-21. The Triangulate dialog.
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ungridded, or random data; in Tecplot, it is called irregular data. Using data in this form, you 
can create mesh plots and scatter plots, but you cannot create contour plots, light-source shad-
ing, or streamtraces. In Tecplot, you can interpolate the irregular I-ordered data onto an IJ-
ordered mesh, and then create contour plots and other types of field plots with the interpolated 
data. You can also interpolate your 3-D, I-ordered irregular data into an IJK-ordered zone and 
create 3-D volume plots from the IJK-ordered zone. You can even interpolate to a finite-
element zone.

There are three types of interpolation available:

• Linear: Interpolate using linear interpolation from a set of finite-element, IJ-ordered, or 
IJK-ordered zones to one zone.

• Inverse Distance: Interpolate using an inverse-distance weighting from a set of zones to 
one zone.

• Kriging: Interpolate using kriging from a set of zones to one zone.

Each of these options is described in the following sections.

24.8.1. Inverse-Distance Interpolation
Inverse-distance interpolation averages the values at the data points from one set of zones (the 
source zones) to the data points in another zone (the destination zone). The average is weighted 
by a function of the distance between each source data point to the destination data point. The 
closer a source data point is to the destination data point, the greater its value is weighted.

In many cases, the source zone is an irregular data set—an I-ordered set of data points without 
any mesh structure (a list of points). Inverse-distance interpolation may be used to create 2- or 
3-D surface, or a 3-D volume field plots of irregular data. The destination zone can, for exam-
ple, be a circular or rectangular zone created within Tecplot. See Section 24.5, “Zone Cre-
ation.”

To perform inverse-distance interpolation in Tecplot, use the following steps:

1. Read the data set to be interpolated into Tecplot (the source data).

2. Read in or create the zone onto which the data is to be interpolated (the destination zone).

3. From the Data menu, choose Interpolate, then choose Inverse Distance. The Inverse-Dis-
tance Interpolation dialog appears, as shown in Figure 24-22.

4. Select the zones to be interpolated from those listed in the Source Zone(s) scrolled list.

5. Select which variables are to be interpolated from those listed in the Variable(s) scrolled 
list. By default, all variables are interpolated except those assigned to the X-, Y-, and 
Z-axes. If, after interpolating, you will be working with just one or two interpolated vari-
ables, you can speed up the calculations by interpolating only those needed variables.

6. Select the destination zone into which to interpolate. Existing values for the interpolated 
variables in the destination zone will be overwritten.
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24.8. Data Interpolation

7. (Optional) Enter the minimum distance used for the inverse-distance weighting in the Min-
imum Distance text field. Source data points which are closer to a destination data point 
than this minimum distance are weighted as if they were at the minimum distance, thus 
reducing the weighting factor for such points. This tends to reduce the peaking and plateau-
ing of the interpolated data near the source data points.

8. (Optional) Enter the exponent for the inverse-distance weighting in the Exponent text field. 

9. (Optional) Select the method used for determining which source points to consider for each 
destination point from the Point Selection drop-down. There are three available methods, as 
follows: 

- Nearest N: For each point in the destination zone, consider only the closest n points to 
the destination point. These n points can come from any of the source zones. You spec-
ify n after selecting this option. This option may speed up processing if n is significantly 
smaller than the entire number of source points.

- Octant: Like Nearest N above, except the n points are selected by coordinate-system 
octants. The n points are selected so they are distributed as evenly as possible through-
out the eight octants. This reduces the chances of using source points which are all on 
one side of the destination point.

- All: Consider all points in the source zone(s) for each point in the destination zone. 

10.  (Optional) If you specified Nearest N or Octant for the point selection method, enter the 
number of points.

11.  Click Compute to perform the interpolation. While the interpolation is proceeding, a work-
ing dialog appears showing the progress of the interpolation. This dialog has a Cancel but-
ton allowing you to interrupt the interpolation.

If you click Cancel during the interpolation process, the interpolation is terminated prema-
turely. The destination zone is left in an indeterminate state, and you should redo the inter-
polation.

Figure 24-22. The Inverse-Distance Interpolation dialog.
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Inverse-distance interpolation ignores the IJK-mode of IJK-ordered zones. All data points in 
both the source and destination zones are used in the interpolation.

Note: Tecplot uses the current frame’s axis assignments to determine the variables to use for 
coordinates in interpolation, but it ignores any axis scaling that may be in effect.

24.8.1.1. The Inverse-Distance Algorithm. The algorithm used for inverse-distance 
interpolation is simple. The value of a variable at a data point in the destination zone is calcu-
lated as a function of the selected data points in the source zone (as defined in the Point Selec-
tion drop-down).

The value at each source zone data point is weighted by the inverse of the distance between the 
source data point and the destination data point raised to a power as shown below:

 (summed over the selected points in the source zone)

where  and  are the values of the variables at the destination point and the source point, 

respectively, and ws is the weighting function defined as:

D in the equation above is the distance between the source point and the destination point or 
the minimum distance specified in the dialog, whichever is greater. E is the exponent specified 
in the Exponent text field. The exponent should be set between 2 and 5. The algorithm is 
speed-optimized for an exponent of 4, although in many cases, the interpolation looks better 
with an exponent of 3.5.

Smoothing may improve the data created by inverse-distance interpolation. Smoothing adjusts 
the values at data points toward the average of the values at neighboring data points, removing 
peaks, plateaus, and noise from the data. See Section 24.9, “Data Smoothing,”  for information 
on smoothing.

24.8.2. Kriging

Kriging is a more complex form of interpolation than inverse-distance. It works similar to 
inverse-distance interpolation discussed in Section 24.8.1, “Inverse-Distance Interpolation,” 
and is used for the same purposes. Kriging generally produces superior results to the inverse-
distance algorithm but requires more computer memory and time.

To perform kriging in Tecplot, perform the following steps:

1. Read the data set to be interpolated into Tecplot (the source data).

2. Read in or create the zone onto which the data is to be interpolated (the destination zone).
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24.8. Data Interpolation

3. From the Data menu, choose Interpolate, then choose Kriging. The Kriging dialog appears, 
as shown in Figure 24-23

4. Select the zones to be interpolated from those listed in the Source Zone(s) scrolled list.

5. Select which variables are to be interpolated from those listed in the Variable(s) scrolled 
list. By default, all variables are interpolated except those assigned to the X-, Y-, and 
Z-axes. If, after interpolating, you will be working with just one or two interpolated vari-
ables, you can speed up the calculations by interpolating only those needed variables. In 
kriging, interpolating fewer variables can have a significant effect on the speed of interpo-
lation.

6. Select the destination zone into which to interpolate. Existing values for the interpolated 
variables in the destination zone will be overwritten.

7. (Optional) In the Range text field, enter the distance beyond which source points become 
insignificant for the kriging. The value is stated as the fraction of the length of the diagonal 
of the box which contains the data points. A range of zero means that any point not coinci-
dent with the destination point is statistically insignificant; a range of one means that every 
point in the data set is statistically significant for each point. In general, values between 0.2 
and 0.5 should be used.

8. (Optional) In the Zero Value text field, enter the semi-variance at each source data point on 
a normalized scale from zero to one. Semi-variance is the certainty of the value at a data 
point. A value of zero means that the values at the source points are exact. Greater values 
mean the values at the source points have some uncertainty or noise. Zero is usually a good 
number for the zero value, and it causes the interpolated data to fit closely to all the source 
data points. Increasing the zero value results in smoother interpolated values that fit 
increasingly more to the average of the source data.

9. (Optional) Select the overall trend for the data in the Drift drop-down. This can be No Drift, 
Linear, or Quadratic.

Figure 24-23. The Kriging dialog in Motif.
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10.  (Optional) Select the method used for determining which source points to consider for 
each destination point from the Point Selection drop-down. There are three available meth-
ods, as follows:

- Nearest N: For each point in the destination zone, consider only the closest n points to 
the destination point. These n points can come from any of the source zones. 

- Octant: Like Nearest N above, except the n points are selected by coordinate-system 
octants. The n points are selected so they are distributed as evenly as possible through-
out the eight octants. This reduces the chances of using source points which are all on 
one side of the destination point.

- All: Consider all points in the source zone(s) for each point in the destination zone.

This option is very important for kriging, since kriging involves the computationally 
expensive inversion and multiplication of matrices. The computational time and memory 
requirements increase rapidly as the number of selected source data points increases. In 
general, you should not use the All option unless you have very few source points.

11.  If you specified Nearest N or Octant for the point selection method, enter the number of 
points.

12. Click Compute to perform the kriging. While the kriging is proceeding, a working dialog 
appears showing its progress. This dialog has a Cancel button allowing you to interrupt the 
kriging.

If you click Cancel during the kriging process, the kriging is terminated prematurely. The 
destination zone is left in an indeterminate state, and you should redo the kriging.

Note: Tecplot uses the current frame’s axis assignments to determine the variables to use for 
coordinates in kriging, but it ignores any axis scaling that may be in effect. Also, if the Drift is 
set to Linear or Quadratic, Tecplot requires that the points selected be non-collinear (non-
coplanar in 3-D). To avoid this limitation, set the Drift to None. Tecplot requires that no points 
be coincident. You can eliminate coincident points by triangulation before you interpolate.

24.8.2.1. The Kriging Algorithm. For a detailed discussion of the kriging algorithm see:

Davis, J. C., Statistics and Data Analysis in Geology, Second Edition, John Wiley & Sons, 
New York, 1973, 1986.

24.8.2.2. Kriging and Inverse Distance Interpolation Improvements. For better 
results with 3-D data, try changing the range of your Z-variable to one similar to the X-range 
the Y-range. Also, set Zero Value to 0.05.

24.8.3. Linear Interpolation

Linear interpolation differs from the two previous interpolation schemes previously discussed 
in that the source zone must have some 2- or 3-D structure. That is, the source zones must be 
IJ-ordered, IJK-ordered, or finite-element. Irregular I-ordered data cannot be used for the 
source zones. (For 2-D data, you may be able to first create a finite-element zone from an irreg-
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ular, I-ordered zone by using triangulation. See Section 24.7, “Irregular Data Point Triangula-
tion.”)

Linear interpolation finds the values in the destination zone based on their location within the 
cells of the source zones. The value is linearly interpolated to the destination data points using 
only the data points at the vertices of the cell (or element) in the source zone(s).

To perform linear interpolation in Tecplot, perform the following steps:

1. Read the data set to be interpolated into Tecplot (the source data).

2. Read in or create the zone onto which the data is to be interpolated (the destination zone).

3. From the Data menu, choose Interpolate, then choose Linear. The Linear Interpolation dia-
log appears, as shown in Figure 24-24.

4. Select the zones to be interpolated from those listed in the Source Zone(s) scrolled list.

5. Select which variables are to be interpolated from those listed in the Variable(s) scrolled 
list. By default, all variables are interpolated except those assigned to the X-, Y-, and 
Z-axes. If, after interpolating, you will be working with just one or two interpolated vari-
ables, you can speed up the calculations by interpolating only those needed variables.

6. Select the destination zone into which to interpolate. Existing values for the interpolated 
variables in the destination zone will be overwritten.

7. (Optional) Select what to do with points that lie outside the source-zone data field. You 
have two options, represented by option buttons on the dialog: Constant, which sets all 
points outside the data field to a constant value that you specify; and Do Not Change, 
which preserves the values of points outside the data field. Do Not Change is appropriate in 
cases where you are using one interpolation algorithm inside the data field, and another 
outside.

8. (Optional) If you choose Constant as the Outside Points option, specify the constant value 
in the Constant Value text field.

Figure 24-24. The Linear Interpolation dialog.
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9. Click Compute to perform the interpolation. While the interpolation is proceeding, a work-
ing dialog appears showing the progress of the interpolation. This dialog has a Cancel but-
ton allowing you to interrupt the interpolation.

If you click Cancel during the interpolation process, the interpolation is terminated prema-
turely. The destination zone is left in an indeterminate state, and you should redo the inter-
polation.

24.8.4. Interpolation Alternatives

An alternative to 2-D interpolation is to triangulate your irregular data points. This creates a 
mesh of triangles (a Triangle element-type, finite-element zone) using the source data as node 
points. No interpolation is required. See Section 24.7, “Irregular Data Point Triangulation,”  
for a description of triangulation.

24.9. Data Smoothing
You can smooth the values of a variable of any zone (in either 2- or 3-D) to reduce “noise” and 
lessen discontinuities in data. Smoothing can also be used after inverse-distance interpolation 
to reduce the artificial peaks and plateaus.

Smoothing is applied to XY-lines, in 2-D, across a 3-D surface, or in a 3-D volume, depending 
on the state of the current frame and the type of zone structure. Each pass of smoothing shifts 
the value of a variable at a data point towards an average of the values at its neighboring data 
points.

To smooth data in Tecplot, use the following steps:

1. From the Data menu, choose Alter, then choose Smooth. The Smooth dialog appears as 
shown in Figure 24-25.

2. Select the zone to smooth from the Zone drop-down. The zone should not intersect itself.

3. Select the variable to smooth from the drop-down of variables in the zone. For the XY Line 
plot type, the variable must be a dependent variable for one active mapping for that zone.

4. (Optional) Specify the number of smoothing passes to perform. The default is 1. A greater 
number of passes will take more time but smooth the data more.

Figure 24-25. The Smooth dialog.
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5. (Optional) Specify the relaxation factor for each pass of smoothing in the field labeled 
Coefficient. Enter a number between zero and one (exclusively). Large numbers flatten 
peaks and noise quickly. Small numbers smooth less each pass, rounding out peaks and val-
leys rather than eliminating them.

6. (Optional) Select the boundary conditions by which to smooth from the Boundary drop-
down. The options are Fixed, First Order, and Second Order, as follows:

- Fixed: The points at the boundary are not changed in value. For finite-element data, 
only fixed boundary conditions may be used.

- First Order: The points at the boundary are smoothed based on the assumption that the 
first derivative normal to the boundary is constant. This will tend to cause contour lines 
of the smoothed variable to be perpendicular to the boundary.

- Second Order: The points at the boundary are smoothed based on the assumption that 
the second derivative normal to the boundary is constant. This option may overextrapo-
late derivatives at the boundary. 

7. Click Compute to perform the smoothing. While the smoothing is underway, a working 
dialog appears showing the progress of the smoothing. This dialog has a Cancel button 
allowing you to interrupt the smoothing.

If you click Cancel during the smoothing process, you will interrupt the smoothing, and 
Tecplot will report back the number of passes completed. For example, if you specified ten 
passes in Number of Passes but hit escape halfway through, Tecplot would report five 
passes complete.

Limitations to smoothing:

• Finite-element zones cannot be smoothed with anything other than Fixed boundary condi-
tions.

• Tecplot uses the current frame’s axis assignments to determine the variables to use for the 
coordinates in the smoothing, and also to determine whether the smoothing should be done 
with XY Line, 2-, or 3D Cartesian plot types. Be careful if you have multiple frames with 
different variable assignments for the same data set.

• Any axis scaling is ignored by Tecplot while smoothing.

• For I-ordered or finite-element line segment zones, the current frame can be in the XY 
Line, 2- or 3D Cartesian plot types. In XY Line, the variable must be the dependent vari-
able of one active mapping for that zone.

• For IJ-ordered, finite-element triangle, or finite-element quadrilateral zones, the current 
frame can be a 2- or 3D Cartesian plot type, but you cannot smooth the variables assigned 
to the X- and Y-axes in 2D Cartesian.

• For IJK-ordered, finite-element tetrahedral, or finite-element brick zones, the plot type 
must be 3D Cartesian, and you cannot smooth the variables assigned to the X-, Y-, and Z-
axes. The IJK-mode is ignored. The zone is smoothed with respect to the entire 3-D vol-
ume.
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• Smoothing does not extend across zone boundaries. If you use a boundary condition option 
other than Fixed (such that values along the zone boundary change), contour lines can be 
discontinuous at the zone boundaries.

• Smoothing is performed on all nodes of a zone, and disregards value-blanking if it is active.
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CHAPTER 25 Probing

In Tecplot probing is the ability to select a point and view the values of all variables at that 
point. You can also view information about the data set itself while probing. Similar to probing 
is probing-to-edit, a feature which allows you to modify your data interactively. To prevent you 
from inadvertently changing your data, probing-to-edit is disabled by default. You can enable 
the feature by toggling the option Allow Data Point Adjustment in the Edit menu. Use either 
the Probe At dialog or the Probe tool to obtain point information from a data field. 

With the Probe At dialog, you can specify the location of the probe as set of spatial coordinates 
X, Y, and Z, one of the polar coordinates Theta and R, or as a set of I-, J-, and K-indices. You 
select one or more locations in the data field where information is to be collected, and the 
resulting information is displayed in the Probe dialog.

When you probe with the mouse, you can probe in either of two modes: Interpolate and 
Nearest Point. In Interpolate mode, accessed by a mouse click, the value returned is the lin-
early interpolated value for the specified locations. In Nearest Point mode, accessed by Ctrl-
click, the value returned is the exact value at the closest data point in the field.

25.1. Field Plot Probing with the Mouse
The most direct method of probing is to use the Probe tool. When you select the Probe tool 
from the sidebar and move the pointer into the workspace, where it becomes a cross-hair. Click 
at any point to probe in Interpolate mode, which calls up a dialog showing the probe informa-
tion interpolated for that point. Ctrl-click at any location to probe in Nearest Point mode which 
will obtain probe information for the data point closest to the cross-hair.

The following table shows the information returned for each type of probe action for field 
plots. (All mouse click operations are using the left mouse button.)

Probe Action Information Returned

Click If the pointer is over a valid cell return the interpolated field values from 
all nodes in the cell. If multiple cells are candidates then for 2D Carte-
sian plots, the cell from the highest number zone is used, and for 3D 
Cartesian plots, the cell closest to the viewer is used.
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To obtain interpolated variable values for the exact probed location:

1. Select the Probe tool, represented by , from the sidebar.

2. Move the pointer into the workspace. The pointer changes to a cross-hair.

3. Click at the desired location. A cross appears at the probed location, and the Probe dialog 
appears as shown in Figure 25-1, showing variable values. The variable values are interpo-
lated linearly from the values of the data set. If you probe a 3-D volume zone in a 3D Car-
tesian plot, the probe cross-hairs point to locations on the surface of the plot, not to 
locations within the plot.

4. To view zone and cell information, click Zone/Cell Info to bring up the Zone/Cell Info 
page, as shown in Figure 25-1.

5. To view cell-centered values, click Cell Center. This shows values at the center of the cell 
you clicked on. For node-centered variables, this value will be interpolated from the cor-
ners of the cell.

6. Click at additional locations to view variable values or zone and cell information for other 
data points.

Note: Interpolate mode does not work for I-ordered data displayed in a 2D or 3D Cartesian 
plot; if you probe such data you will always get the error message “Point is outside of data 

Ctrl-Click If the pointer is over a valid cell return the field values from the nearest 
node in the cell. If multiple cells are candidates then, for 2D Cartesian 
plots the cell from the highest number zone is used, and for 3D Carte-
sian plots the cell closest to the viewer is used. If the pointer is not over 
any cell then the field values from nearest data point as measured in dis-
tance on the screen are returned.

Shift-Ctrl-Click Return the field values from the nearest point on the screen ignoring 
surfaces and regardless of zone number or depth of the point. This is 
useful in 3-D for probing on data points that are on the back side of a 
closed surface without having to rotate the object. In 2-D this is useful 
for probing on data points for zones that may be underneath other zones 
because of the order in which they were drawn.

Alt-Click
(3D Cartesian plots only)

Same as Click except ignore zones while probing. (Probe only on 
streamtraces, iso-surfaces, or slices.)

Alt-Ctrl-Click Same as Ctrl-Click except ignore zones while probing. (Probe only on 
streamtraces, iso-surfaces, or slices.)

Alt-Ctrl-Shift-Click Same as Shift-Ctrl-Click except ignore zones while probing. (Probe 
only on streamtraces, iso-surfaces, or slices.)

Probe Action Information Returned
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field,” because Tecplot cannot interpolate without a field mesh structure. You can, however, 
use the Nearest Point mode (described below) in such situations.

To obtain exact results for the data point nearest the probed location:

1. On the sidebar select the Probe tool, represented by .

2. Move the pointer into the workspace where it will change to a cross-hair.

3. Ctrl-click at the desired location. An XORed cross appears at the data point closest to the 
probed location, and the Probe dialog appears showing variable values, including the X-, Y-
, and Z-coordinates of the nearest point. 

The variable values are the exact values for the nearest point. If the zone is not I-ordered 
and the cross-hairs are placed within the data field, the point reported is the closest data 
point in the cell pointed to by the pointer. (This may not be the closest point in the entire 
data field.) If you probe a 3-D volume zone in a 3D Cartesian plot, the probe cross-hairs 
point to locations on the surface of the plot, not to locations within the plot.

4. To view zone and cell information, click the Zone/Cell Info to call up the Zone/Cell Info 
page.

5. Ctrl-click at additional locations to view variable values or zone and cell information for 
other data points.

Figure 25-1. The Var Values and Zone/Cell Info pages of the Probe dialog.
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You may alternate between interpolated and exact values by clicking and Ctrl-clicking.

25.2. Advanced Field Plot Probing
By default a Tecplot probe first detects a zone cell face. It then finds the nearest point of that 
face if Ctrl-click was used while probing. However, advanced probe options let you probe 
points behind a cell face, or objects that are contained within zones.

25.2.1. Obscured Point Probing

Nearest point probing using Ctrl-click is limited in two ways. In a 2D Cartesian plot the Probe 
tool will select mesh intersection points only according to drawing order when using Ctrl-
click. By default, when probing data in a 3D Cartesian plot using Ctrl-click with the Probe 
tool, the probe will only select the surface nearest you. Thus, if you are viewing a 3-D wire 
mesh, the probe will not select mesh intersection points shown on the far side of an enclosed 
surface, and you would need to rotate the view in order to select points on the far side.

To overcome this, you may use Shift-Ctrl-click. This option lets you select points to probe as if 
all visible points were projected onto the 2-D plane of the screen and a ruler was laid on the 
screen to measure the distance from the cross-hair to each point, allowing you to find the 
nearest point.

25.2.2. Streamtrace, Iso-Surface, and Slice Probing

In a 2D Cartesian plot Shift-Ctrl-click allows users to probe mesh intersection points regard-
less of drawing order. In a 3D Cartesian plot it will allow you to chose mesh intersection points 
independent of surface depth. Thus, when viewing a 3-D wire mesh for example, you may use 
Shift-Ctrl-click to select points on the far side of an enclosed surface.

You may probe for values on volume objects such as streamtraces, iso-surfaces and slices, with 
the Alt key. Using the Alt key alone when probing will give you interpolated values of the 
nearest volume object. Using Alt-Ctrl-click will probe a point where the mesh intersects the 
closest object. Using Alt-Shift-Ctrl-click will probe the closest point where the mesh intersects 
any object.

25.3. Field Plot Probing by Specifying  
Coordinates and Indices

If you want precise control over your probe location, or if you want to probe using I-, J-, and 
K-indices, or if you want to probe inside a 3-D volume, you need to use the Probe At dialog to 
specify the probe location. You can launch the Probe At dialog either from the Data menu (by 
choosing Probe At), from the Var Values page of the Probe dialog (using the Probe At button), 
or by clicking Details in Probe mode.

To probe at a specified location using spatial coordinates (in Interpolate mode):
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1. Launch the Probe At dialog. The 
Probe At dialog appears, as in 
Figure 25-2, ready for you to enter 
X-, Y-, and Z-coordinates.

2. Enter the X-, Y-, and Z-coordinates 
of the desired probe location.

3. If the zone you are probing is a 3-D 
volume zone, select the check box 
labeled Probe Within Volume to 
ensure that the probe is performed 
at the indicated point. If you spec-
ify a position within a 3-D volume 
zone and the Probe Within Volume 
check box is not selected, Tecplot 
probes at the surface of the zone 
nearest the user’s eye along the ray 
defined by the specified point and the user’s eye.

4. Click Do Probe to perform the probe. The Probe dialog appears with interpolated values for 
the specified location.

To probe at a specified location using data set indices (in Nearest Point mode):

1. Launch the Probe At dialog. The Probe At dialog appears.

2. Click the Index button (Index tab in Windows) to bring up the Index page of the Probe At 
dialog, shown in Figure 25-3.

3. Select the desired zone from the 
Zone drop-down.

4. Enter the I-, J-, and K-indices of 
the desired probe location. (For 
finite-element and I-ordered 
data, you can enter only the I-
index. For IJ-ordered data, you 
can enter both I- and J-indices. 
For IJK-ordered data, you can 
enter I-, J-, and K-indices.) 

5. Click Do Probe to perform the 
probe. The Probe dialog appears.

If you have already probed one 
point, you can specify new indices 
by increasing or decreasing the dis-
played values using the up and down 

Figure 25-2. The Position page of the Probe At dialog.

Figure 25-3. Index page of the Probe At dialog.
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arrows at the right of each index field. Doing this automatically performs the probe; you need 
not click Do Probe again.

25.4. Field Plot Probed Data Viewing
You view probed data in the Probe dialog. The Probe dialog has four pages:

• Var Values: Examine values of all variables at any selected location.

• Zone/Cell Info: Report characteristics of any location in a data field. The characteristics 
reported include the indices of the selected cell or point, the zone number, the dimensions 
of the zone, and the type of zone (ordered or finite-element).

• Cell Center: Examine values of all variables at the center of the clicked-on cell.

• Face Neighbor: Examine neighboring cells of the click-on cell.

25.4.1. Variable Value Viewing
The Var Values page of the Probe dialog, shown in Figure 25-1, lists every variable in the cur-
rent data set, together with its value at the specified probe point. By default, each variable is 
shown on a single line, which allows display of about the first ten characters of the variable 
name and seven significant digits of the variable value.

To display longer variable names or see more digits of the value, deselect the check box 
labeled One Line per Variable. If there are more variables than will fit in one window, use the 
Scroll Up and Scroll Down buttons. The Var Values page also displays the zone name and 
number.

25.4.2. Zone and Cell Information Viewing

The Zone/Cell Info page of the Probe dialog, shown in Figure 25-1, lists the following infor-
mation about any probed data point, regardless of the format of the data:

• The number and name of the probed zone.

• The format of the zone, either ordered or one of the finite-element formats: 

- FE-Triangle.

- FE-Quad.

- FE-Tetra. 

- FE-Brick. 

For ordered zones, the following additional information is displayed:

• The maximum I-, J-, and K-indices of the zone. JMax is 1 for I-ordered data, and KMax is 
one for I-ordered and IJ-ordered data.

• The type of plane (I, J, or K) which was probed. (For I-ordered and IJ-ordered data, this is 
always K.)
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• In Interpolate mode, the I-, J-, and K-indices of the principal data point of the cell contain-
ing the probed point. 

• In Nearest Point mode, the I-, J-, and K-indices of the nearest point to the probed point.

For finite-element zones, the following additional information is displayed:

• The total number of points in the zone.

• The total number of elements (cells) in the zone.

• The number of the probed node. This field is filled in only if the point is probed in Nearest 
Point mode.

• The number of the probed element.

• The number of each node of the probed cell. There are three nodes for FE-surface triangle 
zones, four nodes for FE-surface quadrilateral and FE-volume tetrahedral zones, and eight 
nodes for FE-volume brick zones.

25.4.3. Cell Center Viewing
The Cell Center page of the Probe dialog, like the Var Values page, lists every variable in the 
current data set, but lists values at the center of the cell that was clicked on. By default, each 
variable is shown on a single line, which allows display of about the first ten characters of the 
variable name and seven significant digits of the variable value.

To display longer variable names or see more digits of the value, deselect the check box 
labeled One Line per Variable. If there are more variables than will fit in one window, use the 
Scroll Up and Scroll Down buttons. The Cell Center page also displays the zone name and 
number.

25.4.4. Face Neighbor Viewing
The Face Neighbor page of the Probe dialog displays cells that neighbor the selected cell. A 
cell is considered a neighbor if one of its faces shares all nodes in common with the selected 
cell, or if it is identified as a neighbor by face neighbor data in the data set. Refer to 4.1.2.9. 
“Face Neighbors” on page 47 for more information on face neighbor data.

25.5. Line Plot Probing with the Mouse
You may probe XY and Polar Line plots in much the same way you probe field plots. You can 
use the probe mouse mode to obtain interpolated variable values at any given location, or 
obtain exact values from a specified (X, Y) or (Theta, R) data point. When you probe an XY 
Line plot in the standard mode, Tecplot displays a vertical or horizontal line, depending on 
whether you are probing along an X- or a Y-axis.When you probe a Polar Line plot, a radial 
line or a circle is displayed depending on whether you are probing along the Theta- or R-axis. 
In either case, the probe is performed along the displayed line (or circle). Axis variable values 
of all active mappings that lie along the probe line are interpolated and displayed.
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When you hold down the Ctrl key Tecplot enters Nearest Point probe mode, and the displayed 
line disappears. Now the exact location of the pointer is important. When you Ctrl-click, 
Tecplot displays the exact X- and Y- or Theta- and R-values of the data point closest to the 
location clicked.

Note: When probing line plots, keep in mind whether you are in nearest point or interpolate 
mode. The presence or absence of the XORed line should indicate the current mode.The exact 
position of the mouse pointer, while relatively unimportant in interpolate mode, is significant 
in determining the nearest point.

25.5.1. Line Plot Probing in Interpolate Mode

Interpolate mode is the standard probe mouse mode in line plots just as for field plots. For XY 
Line plots, you can probe along any of Tecplot’s five X-axes, or along any of Tecplot’s five Y-
axes. By default, probing is performed along the X1 axis. For Polar Line, probing is done along 
the Theta-axis by default.

Note: In Polar Line, many combinations of Theta- and R-values can result in the same point on 
the screen. When using the mouse in Interpolate mode to probe along the Theta-axis, Tecplot 
uses the Theta-value within the current Theta-axis range to determine the corresponding R-
values reported in the Probe dialog. This behavior may even result in no probe information 
shown for a mapping that has Theta-values entirely outside the current Theta-axis range even 
though the mapping crosses the probe line on the screen. (For example, probing along the 
Theta-axis in interpolate mode misses a mapping representing only Theta-values several cycles 
outside the current Theta-axis range.) Similarly, when using the mouse in Interpolate mode to 
probe along the R-axis, Tecplot uses the R-value within the current R-axis range and may miss 
mappings that are shown on the plot but have R-values different from the R-axis range.

To enter the Probe Interpolate mode:

1. Choose the Probe tool, indicated by , from the sidebar. 
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2. Move the pointer into the workspace, 
where it becomes a cross-hair. When 
you move into the axis grid area, the 
cross-hair is augmented by a line 
indicating along which axis you are 
probing. Click at the desired location. 
A cross appears on each probed map-
ping at the probed location, and the 
Probe dialog appears with a title of 
Interpolated Values, as in 
Figure 25-4.

3. Read the desired information from 
the Probe dialog.

Repeat steps 2 and 3 as desired. 
Figure 25-5 shows a workspace with an 
XY Line plot being probed along the X-
axis.

 
Figure 25-4. The Probe dialog for XY Line plots.

Figure 25-5. Probing an XY Line plot along the X-axis.
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To specify which axis to probe along:

1. Choose the Probe tool from the sidebar.

2. Click Tool Details on the sidebar. The Probe At dialog appears. The Probe At dialogs for 
XY and Polar Line plots are shown in Figure 25-6

3. Click the button labeled with the name of the axis you want to probe along.

Alternatively, you can press the  X, Y, T, or R keys on the keyboard while moving the mouse 
over the plot to selects the axis to probe along. You can also press the 1, 2, 3, 4, or 5 keys to 
select different X- or Y-axes for multiple-axis XY Line plots.

25.5.2. Line Plot Probing in Nearest Point Mode

Nearest Point probe mode provides the exact X- and Y- or Theta- and R-values of the data 
point closest on the screen to the probed location, together with information on the mapping 
and the zone to which the probed point belongs. If a data point is common to multiple map-
pings, the probe returns information on the highest numbered mapping. For example, if a data 
point is plotted as part of two mappings, numbered 1 and 2, the probe results are displayed for 
mapping 2.

To enter the Probe Nearest Point mode:

1. Choose the Probe tool, indicated , from the sidebar. 

2. Move the pointer into the workspace, where it becomes a cross-hair. When you move into 
the axis grid area, the cross-hair is augmented by a line indicating along which axis you are 
probing. Press and hold down the Ctrl key to see only the cross-hair as you move the 
mouse. Nearest Point probing is independent of the axis you were probing along.

3. Ctrl-click at the desired probe location. Remember, the nearest point is calculated from the 
actual location of the cross-hair.

Figure 25-6. The Probe At dialog for XY and Polar Line plots.
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A cross appears at the probed location, and the Probe dialog appears with the title Specific 
Values, as shown in Figure 25-7.

4. Read the desired data from the Probe dialog.

5. Repeat steps 3 and 4 as often as desired.

25.6. Line Data Probing by Specifying Coordinates and 
Indices

If you want precise control over your probe location, or if you want to probe using I-, J-, and 
K-indices, you need to use the Probe At dialog rather than the Probe mouse mode to specify 
the probe location. You can launch the Probe At dialog from the Data menu (by choosing 
Probe At), from the Probe dialog (using the Probe At button), or by clicking the Details button 
while in Probe mouse mode.

To probe at a specified location using position (in Interpolate mode):

1. Launch the Probe At dialog. The Probe At dialog appears, ready for you to enter a coordi-
nate. By default the probe is done along the X1 axis for XY Line and Theta for Polar Line.

2. To probe along a different axis, click the button labeled with the name of the axis you want.

3. Enter the exact coordinate of the desired probe location.

4. Click Do Probe to perform the probe. The Probe dialog appears and a small cross appears 
on the plot to show the probed location.

Figure 25-7. The Probe dialog for Polar Line plots (Nearest Point mode).
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To probe at a specified location using data set indices (in Nearest Point mode):

1. Launch the Probe At dialog. The Probe At dialog appears.

2. Click Index to bring up the Index page of the Probe At dialog, shown in Figure 25-8

3. Select the desired mapping from the Mapping drop-down.

4. Enter the I-, J-, and K-index of the desired probe location. (For finite-element and I-ordered 
data, you can enter only the I-index. For IJ-ordered data, you can enter both I- and J-indi-
ces. For IJK-ordered data, you can enter I-, J-, and K-indices.)

5. Click Do Probe to perform the probe. The Probe dialog appears.

If you have already probed one point, you can specify a new index by increasing or decreasing 
the displayed values using the up and down arrows at the right of the index fields. Doing this 
automatically performs the probe; you do not need to click Do Probe again. If you choose a 
combination of I-, J-, and K-indices that is valid for the data set but not included in the current 
mapping, the correct values are returned. No cross appears on the screen because that portion 
of the data is not being plotted.

25.7. Line Plot Data Viewing
The Probe dialog for line plots has two different forms, depending on whether you are probing 
for interpolated values or for information on the nearest data point.

25.7.1. Interpolated Line Plot Data Viewing

For interpolated values, the Probe dialog appears lists every active mapping and the interpo-
lated value the opposing axis variable for that mapping. The value along the probed axis is 
listed at the bottom of the dialog. For example, Figure 25-4 shows a probe along the X1 axis 
and the corresponding Y-values.

Figure 25-8. The Index page of the Probe At dialog for line plots. 
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25.8. Data Editing with Probe

In the Probe dialog, the probe value is dashed (---) if the probe is out of range for the mapping. 
The probe value is gray (inactive) if the mapping is not using the specific axis which you are 
probing. For example you probe the X1 axis and the mapping uses the X2 axis. This will only 
happen in XY Line plots with multiple X- or Y-axes.

By default, each mapping is shown on a single line, which allows display of about the first ten 
characters of the mapping name and seven significant digits of the variable value.

To display longer mapping names or see more digits of the value, deselect the check box 
labeled One Line per Mapping. If there are more mappings than will fit in one window, use the 
Scroll Up and Scroll Down buttons. Below the list of mappings, the position of the probe is 
listed.

25.7.2. Nearest Point Line Plot Data Viewing

In Nearest Point mode, the Probe dialog appears with the heading Specific Values (see 
Figure 25-7). You obtain this version of the Probe dialog if you use Probe At Index to specify a 
probe position, or if you use the Probe tool and Control-click to specify the probe position. 
This form displays the following information about the nearest data point to the probed posi-
tion:

• X- or Theta-value.

• Y- or R-value.

• I-index.

• J-index.

• K-index.

• The number and name of the mapping associated with the data point. 

• The number and name of the zone referenced in the mapping.

• The maximum I-index of the zone.

• The maximum J-index of the zone.

• The maximum K-index of the zone.

• For XY Line plots, the X-axis associated with the mapping.

• For XY Line plots, the Y-axis associated with the mapping.

25.8. Data Editing with Probe
Using the Adjustor tool, you can probe and edit specific data points. In Adjustor mode, you can 
actually modify the coordinates of your data with the mouse.

You can edit data points either by moving them with the mouse (in XY Line and 2D Cartesian 
plots only), or by using the Probe/Edit Data dialog to enter new values for any variable in the 
probed data point.
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If you modify a shared variable with the Adjustor tool, the variable will be branched--a sepa-
rate copy of the variable will be created for the edited zone. If you use the Probe/Edit Data 
dialog, you can inhibit branching by selecting the Alter in all Shared Zones toggle.

25.8.1. Data Editing with the Mouse
In XY Line and 2D Cartesian plots, you can select and move data points with the Adjustor 
mouse mode. You can select multiple data points and move them as a group. When you move 
data points with the mouse, you will not actually see the changes until you redraw the screen.

To edit your data with the mouse:

1. On the sidebar, choose the Adjustor tool, indicated by .

2. Move the pointer into the workspace, where it becomes the Adjustor.

3. Click on a single point to select it. In the Adjustor mode, you must be within one-half of the 
selection handle’s width to select the data point. To select multiple points, you can either 
Shift-click after selecting your initial point to select additional points, or you can draw a 
group select band to select the points within the band. (In line plots, you can select points 
from only one mapping at a time.)

4. Once you have selected all desired points, move the Adjustor over the selection handles of 
one of the points, then click-and-drag to the desired location of the chosen data point. Other 
selected points will move as a unit with the chosen data point, maintaining their relative 
positions.

For XY Line plots, if several mappings are using the same data for one of the variables, 
adjusting one of the mappings will result in simultaneous adjustments to the others. You 
can avoid this by pressing the H or V keys on your keyboard while adjusting the selected 
point. The H and V keys restrict the adjustment to the horizontal and vertical directions, 
respectively.

25.8.2. Data Editing with the Probe/Edit Data Dialog 

To probe to edit using the Probe/Edit Data dialog:

1. On the sidebar, choose the Adjustor tool, indicated by the  button.

2. Move the pointer into the workspace, where it becomes the Adjustor.

3. Double-click on the point you want to edit, or click on the point and then click Object 
Details on the sidebar. The Probe/Edit Data dialog appears, as shown in Figure 25-9. All 
variables in the zone or mapping are listed, along with their values at the probed point. For 
2D and 3D plot types, the Probe/Edit Data dialog has Scroll Up and Scroll Down buttons 
which are active if the data set has more variables than can be displayed on one page of the 
dialog.

Note: If you attempt to double-click, but move the mouse between clicks, you may find 
that you have accidentally moved your data point.
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25.8. Data Editing with Probe

4. If the variable you with to modify is shared by other zones and you want the modification 
to be used by all zones (and the variable to remain shared), select the Alter in all Shared 
Zones toggle.

5. Enter new values as desired.

The lower half of the Probe/Edit Data dialog is a copy of the Probe At dialog’s Index page. You 
can use this area to specify a new zone or mapping to probe, along with the specific points to 
probe and edit. Thus, for example, you can edit one point, then increase or decrease the dis-
played indices to edit the next point along a mapping.

Figure 25-9. Probe/Edit Data dialog for field plots (left) and XY Line plots (right).
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CHAPTER 26 Blanking

Blanking is the capability of Tecplot to exclude certain portions of zones from being plotted (in 
other words, selectively display certain cells or data points). In 3-D, the result is analogous to a 
cutaway view.

26.1. Two- and Three-Dimensional Blanking
In the following discussions, the term cell is used. In I-ordered data sets, a cell is the connec-
tion between two adjacent points. In IJ-ordered data sets, a cell is the quadrilateral area 
bounded by four neighboring data points. In IJK-ordered data sets, a cell is the six-faced (hexa-
hedral) volume bounded by eight neighboring data points. For finite-element data sets, a cell is 
equivalent to an element.

There are three forms of blanking, as follows:

• Value-Blanking: Cells of all zones or line plot mappings are excluded based on the value 
of a variable (the value-blanking variable) at the data point of each cell or at the point 
where each cell intersects with a constraint boundary depending on the type of value blank-
ing applied.

• IJK-Blanking: Cells of one IJK-ordered zone are included or excluded based on the index 
values.

• Depth-Blanking: Cells in a 3-D plot are visually excluded based on their distance from the 
viewer plane.

All types of blanking affect all field layers, except the Boundary zone layer. Value-blanking 
and IJK-blanking affect data operations such as streamtrace extraction, iso-surface extraction, 
slicing, and so on. Blanking affects linear interpolation and kriging, but not inverse-distance 
interpolation. Blanking is not performed in 3D plots when wire-frame sketches are drawn 
while rotating, translating, slicing, and so on.

For plots with more than one frame, changes in blanking settings are only applied to the 
current frame. Value blanking settings for multiple frames may be synchronized using frame 
linking. Refer to 18.1. “Attribute Linking Between Frames” on page 321 for more information 
on linking.

Blanking on volume zones may produce different results, depending upon the Surfaces to plot 
setting on the Surfaces page of the Zone Style dialog. See Section 20.1, “Surfaces to Plot,”  for 
more details.
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All types of blanking may be used in a single plot. They are cumulative: cells blanked from 
any of the options do not appear.

Value-blanking and depth-blanking affect all zones of all types of data, while IJK-blanking 
affects only one IJK-ordered zone. IJK-blanking is available for 2D or 3D Cartesian plot types; 
value-blanking is available for Line, 2D, or 3D plot types; depth-blanking is only available for 
the 3D plot type. 

26.1.1. Two- and Three-Dimensional Value-Blanking 

Value-blanking allows you to selectively eliminate or trim cells and elements from Line, 2-D, 
and 3-D field plots. The two forms of value-blanking are referred to as whole cell and precise 
blanking. The whole cell or precise blanking of cells is based on one or more user-defined con-
straints. For each active constraint you specify a value-blanking variable, a constant value or 
another variable, and a conditional statement telling Tecplot that region to blank in relation to 
the specified variable or constant. Whole cell blanking eliminates entire cells and therefore can 
result in a jagged blanking boundary, while precise blanking trims the display of data along a 
constraint boundary that you specify (precise blanking is only available for the 2D plot type).

26.1.1.1. Whole Cell Blanking. To use whole cell blanking:

1. From the Plot menu, choose Blanking/Value-Blanking. The Value-Blanking dialog appears 
as in Figure 26-1.

2. Select the Include Value-Blanking check box. Value-blanking has no effect until this check 
box is turned on and at least one constraint is activated (see step 4), regardless of the set-
tings of the other value-blanking parameters.

Figure 26-1. The Value-Blanking dialog when plot type is 2D or 3D Cartesian.
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26.1. Two- and Three-Dimensional Blanking

Figure 26-2 demonstrates the various effects of whole cell and precise value-blanking 
modes.

3. Choose the Blank entire cells option. Specify how the cell is blanked by selecting one of 
three selections from the option menu:

- All corners are blanked: Cells are removed from the plot if all of their data points 
satisfy one or more of the active blanking constraints.

- Any corner is blanked: Cells are removed from the plot if any of their data points 
satisfy one or more of the active blanking constraints.

- Primary corner is blanked: Cells are removed from the plot based on the value at 
the primary corner of each cell. For ordered zones, the primary corner of a cell is the 
data point with the smallest indices of that cell. For finite-element zones, the primary 
corner is the first node listed in the data file’s connectivity list for that element.
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Figure 26-2. The effects of the different value-blanking options for a constraint 
where a variable is less than or equal to zero. The dark shading indicates the areas 
which are not blanked. A) Blank cell when primary corner is blanked. B) Blank 
cell when all corners are blanked. C) Blank cell when any corner is blanked. D) 
Trim cells along mathematical constraint boundary.
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4. Activate a constraint by selecting the Active check box associated with the desired con-
straint number.

5. For any active constraint select the variable to use for value-blanking. This may be any vari-
able, even one that is being used elsewhere in the plot. It is often convenient to create a new 
variable for use as the value-blanking variable. In this way you can manipulate its values 
without changing any other part of the plot. If no value-blanking variable is available, you 
can create one using the Specify Equations dialog, accessed from the Alter option of the 
Data drop-down (for instance, “{VBlank}=1”). See Section 24.2.1, “Equation Syntax.” 

6. Specify one of the following operations to describe how the blanking variable will be com-
pared to the constant or variable following it:

- Is less than or equal to: Cells for which the value-blanking variable has a value less 
than or equal to the specified constant or variable are removed from the plot.

- Is greater than or equal to: Cells for which the value-blanking variable has a value 
greater than or equal to the specified constant or variable are removed from the plot.

- Is less than: Cells for which the value-blanking variable has a value less than the 
specified constant or variable are removed from the plot.

- Is greater than: Cells for which the value-blanking variable has a value greater than 
the specified constant or variable are removed from the plot.

- Is equal to: Cells for which the value-blanking variable has a value equal to the spec-
ified constant or variable are removed from the plot.

- Is not equal to: Cells for which the value-blanking variable has a value not equal to 
the specified constant or variable are removed from the plot.

7. Specify the value-blanking constant or variable used for comparison with the value-blank-
ing variable:

- Variable: This is the variable that is compared against the value-blanking variable to 
determine which cells are removed from the plot.

- Constant: This is the number that is compared against the value-blanking variable to 
determine which cells are removed from the plot.

The Show Constraint Boundary check box will show you the line which separates the region of 
your data which is blanked from the region which is not blanked. Value-blanking has no effect 
on boundaries of an ordered zone. If the boundary is turned on, the boundary of the entire zone 
(without value-blanking) is plotted. 

For finite-element data, value-blanking can affect the view of previously extracted boundaries, 
because each extracted boundary is a zone (see Section 19.4., “Boundary Extraction of Finite-
Element Zones” ).

Figure 26-3 shows an IJ-ordered mesh with whole cell and precise value-blanking in use.

26.1.1.2. Precise Blanking. Precise blanking is only available for the 2D plot type. To use 
precise blanking:
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26.1. Two- and Three-Dimensional Blanking

1. From the Plot menu, choose Blanking/Value-Blanking. The Value-Blanking dialog appears 
as in Figure 26-4.

2. Select the Include Value-Blanking check box. Value-blanking has no effect until it is turned 
on and at least one constraint is activated (see step 4), regardless of the settings of the other 
value-blanking parameters.
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Figure 26-3. An IJ-ordered mesh with whole cell and precise value-blanking.

Figure 26-4. The Value-Blanking dialog for 2- and 3-D Cartesian plot types, set for 
precise blanking.
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Figure 26-2 demonstrates the various effects of whole cell and precise value blanking 
modes.

3. Choose the Trim Cells along Constraint Boundary option.

4. Activate a constraint by selecting the Active check box associated with the desired con-
straint number.

5. For any active constraint select the variable to use for value-blanking. This variable can be 
any variable, even one that is being used elsewhere in the plot. It is often convenient to cre-
ate a new variable for use as the value-blanking variable. In this way you can manipulate its 
values without changing any other part of the plot. If no value-blanking variable is avail-
able, you can create one using the Specify Equations dialog (for example, “{VBlank}=1”). 
See Section 24.2.1, “Equation Syntax.” 

6. Specify one of the following operations to describe how the blanking variable will be com-
pared to the constant or variable following it:

- Is less than or equal to: Trim away all regions where the value-blanking variable is 
less than or equal to the specified constant.

- Is greater than or equal to: Trim away all regions where the value-blanking variable 
has a value greater than or equal to the specified constant or variable.

7. Specify the value-blanking constant or variable used for comparison with the value-blank-
ing variable:

- Variable: This is the variable that is compared against the value-blanking variable.

- Constant: This is the number that is compared against the value-blanking variable.

8. Select the Show Constraint Boundary check box to control the visibility of the defined con-
straint boundary line. The various attributes of the constraint line such as color, line pattern, 
pattern length, and line thickness can also be set to produce the desired effect.

Value-blanking has no effect on boundaries of an ordered zone. If the boundary is turned on, 
the boundary of the entire zone (without value-blanking) is plotted. For finite-element data, 
value-blanking can affect the boundary extraction. For more information see Section 19.4. 
“Boundary Extraction of Finite-Element Zones” on page 336.

Figure 26-3 shows a mesh with whole cell and precise value-blanking in use. Figure 26-5 dem-
onstrates a more complex usage of precise value-blanking by overlaying multiple frames, each 
using some of the same constraints.

26.1.2. IJK-Blanking 

IJK-blanking is available only for 3-D volume zones. IJK-blanking removes a selected portion 
of one IJK-ordered zone from the plot. This allows you to create cutaway plots, plots showing 
the exterior of some data set with a section “cut away” to show the interior, such as the plot 
shown in Figure 26-6. You define the blank region by specifying the following:

• The IJK-ordered zone in which the blanking is to be performed.
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26.1. Two- and Three-Dimensional Blanking

• I-, J-, and K-index ranges for the blank region, either using specific index values or per-
centages of the index range.

• Whether Tecplot should blank the interior or exterior of the defined region. 

To use IJK-blanking, you must have an IJK-ordered zone, and the current plot type must be 2D 
or 3D Cartesian. Unlike value-blanking, which operates on all zones within a single frame, 
IJK-blanking can only be used on a single zone within a frame, and the zone must be IJK-
ordered.

To use IJK-blanking:

Figure 26-6. A cutaway plot created with IJK-blanking.
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1. From the Plot menu, choose Blanking/IJK-Blanking. The IJK-Blanking dialog appears as 
in Figure 26-7.

2. Select the Include IJK-Blanking check box to turn on IJK-blanking for the current frame. 
IJK-blanking does not take effect until this option is turned on, nor are any of the other con-
trols sensitive.

3. Specify the domain of the IJK-blanking by choosing one of the following options:

- Interior: Cells within the specified index ranges are blanked. Those outside are plot-
ted. This creates a “hole” in the zone. The left side of Figure 26-8 shows an ordered 
zone with IJK-blanking with Interior domain.

- Exterior: Cells outside the specified index ranges are blanked. Those inside are plot-
ted. This plots a sub-zone of the zone. The right side of Figure 26-8 shows an ordered 
zone with IJK-blanking with Exterior domain.

4. Select the zone to which IJK-blanking is applied from the Zone drop-down. The zone must 
be IJK-ordered. You may select only one zone at a time. 

5. Specify the format in which you will specify the index ranges by selecting one of the fol-
lowing option buttons:

- Select IJK-Ranges Using Index Values: If you select this option, you specify the I-, 
J-, and K-index ranges using actual minimum and maximum indices.

- Select IJK-Ranges Using % of Max: If you select this option, you specify the I-, J-, 
and K-index ranges as start and end percentages of the maximum index. For example, 
you could blank the middle third of a data set by setting the start percentage to 33.3 
and the end percentage to 66.6. 

6. Enter the I-, J-, and K-index ranges in the fields provided.

Figure 26-7. The IJK-Blanking dialog.
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26.1. Two- and Three-Dimensional Blanking

When you save a layout, macro, or stylesheet, the IJK-blanking index ranges are stored as the 
percentage of the maximum index regardless of how you chose to enter them. This way, one 
file can be used for different zone sizes. 

26.1.3. Cutaway Plots

Cutaway plots are plots of a 3-D volume zone in which a portion of the zone is blanked using 
IJK-blanking so that the interior of the zone can be seen. Create Figure 26-6 as follows:

1. Create an IJK-ordered zone, and create a 3-D contour plot of the zone. (Leave the Mesh 
zone layer turned on.)

2. Set the contour plot type to either Flood or Both Lines and Flood.

3. Use the IJK-Blanking dialog to blank out the appropriate region. Use the Interior blanking 
domain.

A more complex cutaway plot is shown in Figure 26-9. This plot contains iso-surfaces inside 
the cutout region.

To create the plot in Figure 26-9, continue with the following steps:

1. Set the contour plot type of the IJK-ordered zone to Both Lines and Flood.

2. Set the IJK-mode of the IJK-ordered zone to Volume.

3. Use the IJK-Blanking dialog to blank out the appropriate region, and choose the Exterior 
blanking domain. You should now have a plot of the region you want to blank out.

4. Call up the 3D Iso-Surface Details dialog from the Field menu. Select Show Iso-Surfaces 
and set the Draw Iso-Surfaces At drop-down to Each Contour Level.

5. From the Data menu, choose Extract, then choose Iso-Surfaces to extract the contour iso-
surfaces of the region you want to blank out.

6. Change the contour plot type of the new iso-surface zones to Flood.

Figure 26-8. IJK-blanking with Interior domain (left) and Exterior domain (right).
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7. Change the IJK-blanking domain to Interior. This changes the IJK-blanking to plot the 
entire zone minus the blanked region.

8. Set the IJK mode of the IJK-ordered zone to Face.

The iso-surfaces appear in the plot because they were extracted as separate zones.

26.1.4. Depth-Blanking

Depth-blanking removes cells in a 3-D plot based upon how close or far they appear from the 
screen. The options below are available on the Depth Blanking dialog, displayed by selecting 
Blanking/Depth Blanking from the Plot menu. This dialog is shown in Figure 26-10.

• Include Depth Blanking: Select this check box to toggle depth-blanking on and off.

• Blank from Front (%): Blank cells appearing closer to the viewer than this plane. The 
value entered is the plane position in percentage of depth from the closest corner of the 
bounding box of the data to the furthest corner of the bounding box.

Figure 26-9. Cutaway plot with iso-surfaces inside cutout region.

Figure 26-10. The Depth Blanking dialog.
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26.2. Line Plot Blanking

At the default of zero, the plane is at the depth of the closest corner of the bounding box. No 
cells on the front of the plot are blanked. At 50, the front half of the plot will be blanked. In 
particular, cells closer to the viewer than the front of the blanking plan, and cells further 
from the viewer than the blanking plane, may be blanked.

• Blank from Back (%): Blank cells appearing farther from the viewer than this plane. The 
value entered is the plane position in percentage of depth from the furthest corner of the 
bounding box of the data to the closest corner of the bounding box.

At the default of zero, this plane is at the depth of the furthest corner of the bounding box. 
No cells on the back of the plot will be blanked. At 50, the back half of the plot will be 
blanked.

26.2. Line Plot Blanking
For line plots, blanking is the capability of Tecplot to exclude data points from consideration in 
the resulting plot. On a global scale, only value-blanking is available. To plot specific index 
ranges you can use the Indices page of the Mapping Style dialog to limit index ranges per map-
ping. The Curves page can provide another form of blanking, by allowing you to limit the 
range for the independent variable for individual mappings.

Figure 26-11 shows two plots. The original data for the plots contain some “bad” data points. 
The bad data points were identified as those with a Y-value greater than 0.6. The plot on the 
left uses all data points, including the bad data points, to draw a curve. The plot on the right has 
filtered out the bad data points by using value-blanking where all points are removed if Y > 
0.6. Blanking does not necessarily have to be on the independent or dependent variable.

Figure 26-11. XY Line plots showing the effect of value-blanking.
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CHAPTER 27 Macro Commands

Macro files allow you to automate Tecplot. Macro files contain a sequence of macro com-
mands, and may contain macro function definitions. Macro functions act like macros-within-
macros: they allow you to combine macro commands that you frequently use into a single unit 
callable from within another macro. This chapter focuses on the Tecplot menu options for 
recording and playing back macros. The Tecplot Reference Manual describes the Tecplot 
macro language in detail.

Macros are very useful for performing repetitive operations such as setting up frames, reading 
in data files and layout files, manipulating data, and creating plots. They are also necessary for 
running Tecplot in batch mode. See Chapter 28, “Batch Processing.” 

The Macro sub-menu, found under the File menu, provides the following control options:

• Play: Calls up the Load/Play Macro File dialog, to select a macro file to load and play.

• View: Select this option to call up the Macro Viewer dialog, which provides several com-
mand buttons for stepping through and debugging a macro file.

• Record: Calls up the Macro Recorder dialog, which provides several command buttons 
for recording a series of actions to a macro file for playing back at a later time.

27.1. Macro Creation
The simplest way to create a macro is to have Tecplot record it for you. You can then use any 
ASCII text editor to edit the macro file. While editing your file, you can, for example, add 
macro function definitions, or add loops and other control commands.

Tecplot’s Macro Recorder lets you record a macro as you perform a sequence of actions inter-
actively to obtain precisely the results you want. After recording your macro, you can edit it 
with an ASCII text editor to remove redundant operations, compress repetitive actions into 
loops, and otherwise modify the macro. Using the Macro Recorder is the quickest and surest 
way to become familiar with the Tecplot macro language.

To record a macro with the Macro Recorder:

1. From the File menu, choose Macro, then choose Record. The Write Macro File dialog is 
displayed.

2. Specify a macro file name.
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3. Click OK to initiate the recording of the macro file. The Macro Recorder dialog now 
appears, as shown in Figure 27-1. This dialog must remain up during the recording session.

4. Perform the actions you want recorded using the Tecplot interface.

5. Click Stop Recording on the Macro Recorder dialog when you are finished with the 
sequence of actions you want recorded.

While recording macros, you can use any of the following four buttons on the Macro Recorder 
dialog to add specific macro commands to your macro:

• Insert “Pause”: Adds a “pause” command to the macro. When you play a macro includ-
ing a pause command, Tecplot displays a message box when it reaches the pause com-
mand, and waits for you to click OK before continuing to process the macro.

• Insert “Graphics Off”: Adds a “graphics off” command to the macro. When you play a 
macro containing a “graphics off” command, Tecplot stops displaying graphics in the 
workspace from the “graphics off” command until a “graphics on” command is encoun-
tered.

• Insert “Graphics On”: Adds a “graphics on” command to the macro.

• Insert Raw Command: Brings up a dialog in which you can enter any valid Tecplot 
macro command. For example, you can add “$!LOOP 10” at the start of a section you 
want to repeat 10 times, then “$!ENDLOOP” at the end. See the Tecplot Reference Man-
ual for information on the Tecplot macro language.

27.1.1. Macro Functions
When editing your macros, you can add macro function definitions and macro function calls. 
Macro functions have the following form:

Figure 27-1. The Macro Recorder dialog.
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27.2. Macro Play Back

$!MACROFUNCTION 
  NAME = functionname 
 . 
 . 
 . 
$!ENDMACROFUNCTION

Between $!MACROFUNCTION and $!ENDMACROFUNCTION, you can include any legal 
macro command except $!MACROFUNCTION. These included macro commands are associ-
ated with the functionname specified as the value of the NAME parameter, but are not executed 
until the macro function is called with the $!RUNMACROFUNCTION macro command.

For example, the following macro function turns on the Contour zone layer, turns off the Mesh 
zone layer, sets the contour plot type to Both Lines and Flood for zones 1, 2 and 3, then 
chooses gray scale color mapping:

$!MACROFUNCTION 
  NAME = "graycontour" 
  RETAIN = Yes 
$!FIELDLAYERS SHOWCONTOUR = YES 
$!FIELDLAYERS SHOWMESH = NO 
$!FIELD [1-3]  CONTOUR{CONTOURTYPE = BOTHLINESANDFLOOD} 
$!COLORMAP CONTOURCOLORMAP = GRAYSCALE 
$!REDRAW  
$!ENDMACROFUNCTION 

The RETAIN parameter tells Tecplot to retain the macro function definition for use in subse-
quent macro calls; this allows you to define a macro function once in some macro you load 
every time you run Tecplot, and continue to use it throughout your Tecplot session. See 
Section 27.4, “Doing More with Macros,” for a more sophisticated example of a macro func-
tion.

Use the $!RUNMACROFUNCTION macro command to call your macro function. For exam-
ple, to call the “graycontour” macro function defined above, use the following macro com-
mand:

 $!RUNMACROFUNCTION "graycontour"

If the macro function requires any parameters, you combine them into a parenthesized list 
which you give as a second argument to $!RUNMACROFUNCTION, as in the following example:

$!RUNMACROFUNCTION "Process Plane" (K,|LOOP|)

You can use the $!RUNMACROFUNCTION command within other macro functions; calls may be 
nested up to ten deep.

27.2. Macro Play Back
Once you have created a macro file, you have four methods in Tecplot for playing it back.



Chapter 27. Macro Commands

464

The four different methods are:

• From the command line.

• From the File menu, under the Macro Play option in the interface.

• Stepping through commands using the Macro Viewer.

• From the Quick Macro Panel.

The following sections explain each of these methods.

27.2.1. Macro Play Back Preparation

Often, the commands in a macro file rely on Tecplot being in a particular state. It is usually a 
good practice to have commands at the start of a macro that force Tecplot into a known state, 
$!NEWLAYOUT is a good command to do this since it deletes all data sets and frames and 
creates a single empty frame with a default size and position.

If you will always run your macro from the command line, then you can be sure Tecplot will be 
in its initial state when the macro begins processing. Including layout files, data files or 
stylesheet files on the command line along with the macro file is fine as long as the macro 
expects them.

If your macro performs some intermediate task, it is up to you to make sure Tecplot is in the 
same (or a similar) state when you run the macro as the state the macro was designed to start 
in.

27.2.2. Macros from the Command Line

You can immediately play a macro when you first start Tecplot by simply including the name 
of the macro file on the command line. In Windows, this can be accomplished by either drag-
ging and dropping a macro file onto the Tecplot icon, or by using the command line from an 
MS-DOS dialog.

For example, to run the macro file mymacro.mcr from a UNIX or DOS command line 
prompt, type:

tecplot mymacro.mcr

If you name your macro file without the .mcr extension you can still run Tecplot with the 
macro file. However, you must include the -p flag on the command line. To run the macro file 
called mymacro.mmm you would type:

tecplot -p mymacro.mmm

In Windows you cannot drag and drop a macro file onto the Tecplot icon if it does not have the 
.mcr extension. Tecplot will think it is an ASCII data file and attempt to read it in as such.

If you want the macro viewer to automatically appear so you can see the macro commands 
prior to their execution, you can include the -z flag on the command line.
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27.2. Macro Play Back

Macros can also be played back in batch mode (i.e., no graphics are displayed). See 
Chapter 28, “Batch Processing,”  for details.

27.2.3. Macros from the Interface

You can play a macro from within Tecplot by using the Play option under the File main menu. 
This plays back the macro file without stopping until it reaches the end of the file.

To play back a macro file from the Tecplot interface:

1. From the File menu, choose Macro, then choose Play. The Load/Play Macro File dialog is 
displayed.

2. Specify a macro file name.

3. Click OK.

Tecplot immediately starts playing the specified macro file.

27.2.4. Macros from the Quick Macro Panel

The Quick Macro Panel (Figure 27-2) is Tecplot’s quick access mechanism for storing and 
retrieving your favorite, commonly used macro functions. This panel allows you to quickly 
play a macro function by clicking on the button in the panel that is linked to that macro func-
tion.

The Quick Macro Panel is linked to a special macro file that contains only macro function def-
initions. When Tecplot first starts up, it looks for this file under one of the following names, in 
the following order:

1. The file tecplot.mcr in the current directory.

2. The file .tecplot.mcr in your home directory (UNIX), or tecplot.mcr in the your 
home directory (Windows). Under Windows, your home directory is determined by the two 
environment variables HOMEDRIVE and HOMEPATH. If they are not set, Tecplot skips your 
home directory.

3. The file tecplot.mcr in the Tecplot home directory.

If Tecplot finds the file, it loads it and associates each button on the Quick Macro Panel with a 
specific macro function.

You can specify a different Quick Macro file by adding the -qm option flag in front of the 
macro file name to the command line.

The following command starts Tecplot and installs the macro functions defined in the file 
myteccmd.mcr into the Quick Macro Panel:

tecplot -qm myteccmd.mcr

If you want Tecplot to call up the Quick Macro Panel immediately after start up, include the    
-showpanel option flag at the end of the command as well.
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For example, the following command starts Tecplot and immediately calls up the Quick Macro 
Panel:

tecplot -qm myteccmd.mcr -showpanel

To see an example of a macro function file, look at the Quick Macro file qmp.mcr located in 
the examples/mcr sub-directory below the Tecplot home directory.

Once the Quick Macro Panel has been installed you can run a macro by pressing its associated 
button on the Quick Macro Panel.

27.2.5. Macro Linking to Text and Geometries

Each text or geometry you create can be linked to a macro function. This macro function is 
called whenever the user holds down the control key and clicks the right mouse button on the 
text or geometry.

Figure 27-2. The Quick Macro Panel.
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27.3. Macro Debugging

For example, if you have pieces of text, each representing a different well, Ctrl-right click on 
any piece could run a macro that brings up an XY-plot of that well’s data.

Macro functions are specified with the “Link to Macro function” field in the Geometry dialog 
or in the Text Options dialog. If desired, the macro function may be listed with one or more 
parameters.

27.3. Macro Debugging
Use the Macro Viewer to step through and debug your macro file. This dialog allows you to 
add and delete breakpoints, view and set watch variables, and view state variables local to the 
macro currently loaded into the Macro Viewer. Selecting View from the Macro sub-menu dis-
plays the Macro Viewer dialog, shown in Figure 27-3. Using the Macro Viewer to look at a 
macro file built with the Macro Recorder is a quick and easy way to explore the Tecplot macro 
language.

To load a macro file into the Macro Viewer, click Load Macro. This calls up the Load/Play 
Macro File dialog for you to specify which macro file to load. Macro files typically have the 
extension .mcr.

The specified macro is loaded into the macro viewer for you. If you already had a macro 
loaded, it is discarded and the new macro is loaded in its place.

The Macro Viewer dialog displays the text of the currently loaded macro file at the top of the 
dialog. A > (greater than) marks the currently active line, that is, the line that Tecplot is about 

Figure 27-3. The Macro Viewer dialog.
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to evaluate. Click Step to evaluate the currently active line. The > sign then moves to the next 
line. 

27.3.1. Macro Context

In the Macro Viewer dialog, the field labeled Macro displays the name of the macro or macro 
function you are currently evaluating. In most cases, this field displays the name MAIN, which 
means that the macro commands currently shown in the macro text display come from within 
the main macro body, that is, not from inside a macro function. If the macro you are viewing 
contains a call to a macro function, then when you evaluate (or step into) that macro function 
call (when you evaluate a $!RUNMACROFUNCTION command) the name displayed in the 
Macro field changes. The new name displayed is the name of the macro function just called. At 
the same time, the display in the top of the Macro Viewer dialog changes to show the macro 
function text for the called macro function.

Pressing on the up and down arrows located at the right hand side of the Macro display field 
shifts the macro context, that is, it lets you move between the text of the called macro function, 
and the text of the calling macro or macro function. If you switch context to the calling macro 
function, the $!RUNMACROFUNCTION command that called the macro is displayed with a ^ 
(caret) in front of it. This helps you quickly determine which command line called the macro 
function currently under evaluation. The down arrow then moves you back down a level to the 
called macro you were just viewing.

27.3.2. Macro Command Display Format Changes

Tecplot displays the macro in the viewer in one of two formats: a short format that lists the 
macro commands, one command per line, and a long format which expands a single, simple 
macro command to show all of its sub-commands and parameters. The short format is the 
default for the Macro Viewer.

• To choose the short form, select the List Commands option.

• To choose the long form, select the Expand Commands option.

27.3.3. Macro File Evaluation with the Macro Viewer

The Macro Viewer dialog’s main purpose is to allow you to step through a macro’s commands 
in a variety of ways so you can view and debug a macro file. With this dialog you can evaluate 
each line, including the commands within nested macro function calls, or just have Tecplot run 
the macro automatically while you watch.

27.3.3.1. Macro Step-Through Line by Line. The main activity you do in the Macro 
Viewer dialog is evaluate macro commands line by line. The > (greater than) marks the cur-
rently active command, that is, the command that Tecplot is about to evaluate. It moves to the 
next command after the currently active command is evaluated.
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27.3. Macro Debugging

To evaluate a macro command, click Step. When a $!RUNMACROFUNCTION command is 
encountered, the macro viewer steps into the called function.

Step Over also processes each macro command, line by line however, when a $!RUNMACRO-
FUNCTION command is encountered the entire function is processed.

You can also view or play a macro all the way through without stopping. To play the macro 
without stopping after each step, click Go. Tecplot continues until it either receives a stop 
signal from the Stop button, or it finishes playing the macro, or it encounters a breakpoint. See 
Section 27.3.4, “Breakpoint Addition and Deletion,” on using breakpoints.

To stop the playing of a macro that the Go control started, click Stop.

You can restart a macro from the beginning, so you can evaluate it again from within the 
Macro Viewer. To restart the evaluation of a macro, click Reset.

Note: If your macro assumes Tecplot is in a particular state when it starts processing then you 
must make sure Tecplot is in this state before you click Reset and start the macro processing.

27.3.4. Breakpoint Addition and Deletion

An important debugging feature that the Macro Viewer provides is the ability to add break-
points within a macro’s command stream. A breakpoint is a flag you can insert anywhere in a 
macro that tells Tecplot to immediately suspend evaluation. Tecplot stops the action of a 
playing macro at the breakpoint to allow you to explore what is happening at that point in the 
macro file. 

To add a breakpoint to a macro command:

1. Highlight the command in front of which you want to place the breakpoint by clicking on 
the command with the mouse cursor.

2. Click Add Break to add a breakpoint at the selected macro command. A B displayed at the 
beginning of the highlighted macro command indicates the breakpoint’s placement.

To delete a breakpoint from a macro command:

1. Highlight the command for which you want to delete the breakpoint by clicking on the 
command with the mouse cursor.

2. Click Delete Break to delete the breakpoint.

To delete all the breakpoints set in a macro, click Delete All Breaks. This removes all the 
breakpoints within a macro.

27.3.5. Variable Value Viewing while Debugging

Another debugging feature that the Macro Viewer provides is the ability to specify and view 
specific user defined, or system defined internal variables—that is, to specify watch variables. 
Use the Macro Variables dialog, shown in Figure 27-4, that is displayed after clicking Watch 
Variable to specify and view watch variables. 
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To specify a watch variable in a macro:

1. Click Watch Variables in the Macro Viewer dialog to bring up the Macro Variables dialog.

2. Type the name of the variable you want to watch in one of the User-Defined or Internal 
Variable text fields.

Leave this dialog open, off to one side, to watch the changing values in the Value column to the 
right of the variable name as the macro is playing.

The Macro Variables dialog also automatically displays any loop iteration values and 
command parameter stack calls that occur as a macro is played. In the Loops display area, the 
Value column for loops displays the loop iteration counter and changes as the system cycles 
through the loop sequence. The End Value displays the total number of iterations set for that 
loop. Tecplot lists the iteration values for up to three levels of nested loops. The Call Stack area 
displays the parameter values used in calling the currently active macro function. Each field 
displays one parameter value up to the limit of eight parameters per macro function call. The 

Figure 27-4. The Macro Variables dialog.
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27.4. Doing More with Macros

display changes to show the state of the currently called macro function as Tecplot evaluates a 
$!RUNMACROFUNCTION command.

27.3.6. Macro Variable Modification

After a breakpoint stops macro evaluation, you can change the value of a variable, a loop, or a 
stack call parameter. The ability to change these values in the middle of evaluating a macro 
allows you to either check a certain condition or to get out of a problem situation. 

To change the value of a variable, a loop or a call stack parameter:

1. Highlight the variable value you want to change by selecting the value in the text field.

2. Type the new value.

3. Click Go or Step to continue the macro evaluation with the new value.

27.4. Doing More with Macros
There is much more to macro files than just recording and playing them. Tecplot provides you 
a whole macro programming language that allows you to develop tools for performing various 
functions, from developing your own interactive demonstration to transforming your data with 
a series of algorithms. See the Tecplot Reference Manual for details of Tecplot’s macro lan-
guage and macro files.

27.4.1. Multiple File Processing

Suppose you need to create hardcopy plots with a specific style for a large number of input 
data files. You can do this with a macro that does the following:

• Reads in data files named tnnn.plt where nnn counts from 1 to 50.

• Applies a predefined layout to the data set.

• Generates a PostScript file named tnnn.ps (nnn counting from 1 to 50), one for each 
data file.

There are a number of ways to create a macro like the one described. The easiest way involves 
using the $!OPENLAYOUT command feature that allows you to replace data files referenced 
in the layout file itself with other data files:

1. Read in a representative example data file and create the layout you want to plot. If you are 
creating a contour plot make sure the contour levels you choose will be good ones for all 
files that are processed.

2. Create a macro file that references the layout file created in Step 1.

If the layout file generated in Step 1 is called cont.lay then the final macro to process the 
data files is as follows:

#!MC 1000 
#       Use a variable to store the number of  
#       files to process. 
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$!VarSet |NumFiles| = 50 
#       Make sure the output is PostScript.  
$!ExportSetup 
  ExportFormat    = PS 
  Palette         = MONOCHROME 
 #       Begin the loop 
$!Loop |NumFiles| 
#       Here is where we make use of the special feature 
#       (i.e. the AltDataLoadInstructions option) of the $!OPENLAYOUT  
#       command that allows us to override the named  
#       data files within the layout file. Also make use of  
#       the intrinsic LOOP macro variable. 
$!OpenLayout "cont.lay" 
  AltDataLoadInstructions = "t|LOOP|.plt" 
# 
#       Set the name of the file to be printed. 
# 
$!ExportSetup 
  ExportFName = "t|LOOP|.ps" 
# 
#       Create the PostScript file. 
# 
$!Export 
$!EndLoop 
$!Quit

27.5. Macros, Layouts or Stylesheet Use
Tecplot layout files are simply macro files. Why not just create the plot you want, then save a 
layout to preserve it, rather than recording a macro to recreate it? Layout files are typically 
very simple macro files; they do not include loops, data alterations performed by many add-
ons, or any such “programming.” Macros are generally used to do more complex tasks than 
layout files.

Tecplot processes layout and stylesheet files in a slightly different manner than it does macro 
files. In general, commands processed from a macro file undergo rigorous error checking and 
adjustments are sometimes made when values are outside certain limits. Layout and stylesheet 
files are treated more as a single unit by Tecplot. Individual commands are given more latitude 
because Tecplot assumes that the layout or stylesheet at one time represented a valid state. This 
is also why, while stepping through a macro file, the $!OPENLAYOUT and  
$!READSTYLESHEET commands are processed in a single step and you are not able to step 
“into” either of these commands. For layout and stylesheet files, error checking is not done 
until after the file is processed. By contrast, macro files are checked and adjusted line by line 
during processing. So, results from a layout file or stylesheet that you modify by hand may not 
be the same as those from a macro file.
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CHAPTER 28 Batch Processing 

You can run Tecplot in batch mode to create plots without displaying any graphics to the 
screen. This saves a lot of time when processing multiple files for printing or export. In batch 
mode, Tecplot can be executed locally on your workstation computer or, under UNIX, 
remotely using an ASCII terminal. The only limitation for batch mode operation is that under 
UNIX, you must use the Mesa version of Tecplot to create export files in bitmap formats. (The 
OpenGL version requires screen resources not available in batch mode.) Under Windows, all 
export formats are available.

28.1. Batch Processing Setup
To prepare for batch processing, you generally perform the following steps:

1. Create a macro file to control the batch processing. You may do this either interactively, by 
recording a Tecplot session, or using an ASCII text editor, or both. See Chapter 27, “Macro 
Commands.” 

2. Create layout and stylesheet files as necessary.

3. Prepare data files.

4. Debug the macro file by running Tecplot while not in batch mode.

Macros are necessary to do batch processing. When Tecplot is launched in batch mode it 
requires that you provide the name of a macro file to execute. The minimal command to launch 
Tecplot in batch mode is as follows:

tecplot -b -p macrofile

The -b flag instructs Tecplot to run in batch mode and the -p macrofile tells Tecplot the 
name of the macro file to execute. See Appendix A, “Tecplot Command Line Options,” for 
more command line options.

How the macro file interacts with layout and/or stylesheet files is the subject of the following 
sections. Different strategies work with different situations depending on your data and what 
you want to do with it.

28.2. Batch Processing Using a Layout File
Combining layout files with batch processing is both powerful and flexible. With layout files 
you can organize a plot using one or more frames in a single file. The layout file manages data 
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sets and can be altered on the fly, either on the command line or within a macro that loads the 
layout file.

For example, suppose you want to do the following sequence of tasks in batch mode:

• Load a data file from a user supplied file name.

• Create a specific style of plot.

• Create a PostScript file of the plot.

You can set up the batch job as follows:

1. Obtain a representative data file to be plotted.

2. Interactively, create a layout of the style of plot you want. (For this example, name the file 
batch.lay).

3. Create (using a text editor) the following macro (for this example call this macro 
batch.mcr):
#!MC 1000 
$!ExportSetup 
  ExportFormat = PS 
  Palette = MONOCHROME 
$!Export 
$!Quit

The above macro can be modified to choose a different driver or palette depending on your sit-
uation.

Use the following command to run the job in batch mode:

tecplot -b -p batch.mcr -y tecplot.out batch.lay mydatafile

Layout files are self-contained. They contain all the information necessary to create a plot 
including the name(s) of the data file(s) to load. When you supply the names of data files on 
the command line (mydatafile in the above example) along with the layout file, Tecplot 
replaces the data files referenced in the layout file with the ones from the command line. If two 
or more data files are to be combined to form a single data set, use the “+” symbol to join the 
data file names.

The final result is a file called tecplot.out which contains the PostScript commands.

28.3. Multiple Data File Processing
In Section 28.2, “Batch Processing Using a Layout File,” we set up Tecplot to process a user-
supplied data file (or data files) and create a single output file. If the above procedure is to be 
repeated for a large number of input files (one at a time), you can do this by using a loop: either 
outside Tecplot in the operating system or within Tecplot using the flow-of-control commands 
in the Tecplot macro language.
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28.3. Multiple Data File Processing

28.3.1. Looping Outside Tecplot

The following examples show the command files for launching Tecplot in an operating system 
loop on two different operating systems. Tecplot processes five data files named dnn.plt and 
creates ten output files named dnn.out where nn goes from 1 to 10.

28.3.1.1. Looping Outside Tecplot (UNIX).  Create a shell script with the following com-
mands:

#!/bin/sh 
n=1 
while test $n -le 10 
do 
    tecplot -b -p batch.mcr -y d$n.out batch.lay d$n.plt 
    n=‘expr $n+1‘ 
done

28.3.1.2. Looping Outside Tecplot (Windows).  Create a batch file with the following 
commands:

for %%f in (d1 d2 d3 d4 d5 d6 d7 d8 d9 d10) 
do tecplot -b -p batch.mcr -y %%f.out batch.lay %%f.plt

28.3.2. Looping Inside Tecplot

In Section 28.3.1, “Looping Outside Tecplot,” we set up Tecplot to process multiple data files 
using the operating system language to do the looping. There are two drawbacks to this proce-
dure:

•  The operating system languages are not portable between different operating systems.

•  Tecplot must be continuously started and stopped each time a new data set is processed.

A more efficient approach is to loop through the data files inside Tecplot. Here, the layout file 
and the data files are all named within the Tecplot macro. The command line in this example is 
simple, as follows:

 tecplot -b -p batch.mcr

The Tecplot macro is set up as follows:

#!MC 1000 
$!EXPORTSETUP 
  EXPORTFORMAT = PS 
  PALETTE = MONOCHROME 
$!LOOP 10 
$!OPENLAYOUT "batch.lay" 
  ALTDATALOADINSTRUCTIONS = "d|LOOP|.plt" 
$!EXPORTSETUP 
  EXPORTFNAME = "d|LOOP|.out" 
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$!EXPORT 
$!ENDLOOP 
$!QUIT

The $!OPENLAYOUT command loads in batch.lay but replaces the data file referenced in 
the layout with the file names in the ALTDATALOADINSTRUCTIONS sub-command. The 
$!EXPORTSETUP command is used in two places. Initially it is used to set the export format. 
Later it is used just to change the name of the file to export to. The $!EXPORT command does 
the actual exporting.

28.4. Batch Processing Using Stylesheet Files
Instead of using layout files, you can use stylesheet files when batch processing. In general, 
batch processing with stylesheets works just like the batch processing described above in “Pro-
cessing Multiple Data Files,” except a stylesheet file is used instead of a layout file.

If you want to make many different plots using the same data set, stylesheets will be more effi-
cient than layout files.

28.5. Batch Processing Diagnostics
Each time Tecplot is run in  batch mode it creates a file defined by the name in the   
BATCHLOGFILE environment variable, or, if the environment variable is not defined, by a file 
named batch.log in the directory where Tecplot was started. If the name given in the 
BATCHLOGFILE environment variable is a relative path, the directory name where Tecplot 
was started is prefixed. A running commentary on actions performed in Tecplot, as well as 
warning and error messages, are sent to the batch.log file.

28.6.  Macros Moved to Different Computers or 
Directories

The file tecplot.phy is created each time you run Tecplot interactively. It contains infor-
mation about the physical characteristics of your computer system as well as information about 
the size of the Tecplot process window used during the last Tecplot session. It also contains the 
name of the last layout file used by Tecplot. If you are developing macros on one computer, but 
using them for batch processing on a different computer, you must transfer the  
tecplot.phy file from the development computer to the computer where you will run 
Tecplot in batch mode. Under UNIX, the same is true if you are developing macros in one 
directory, but will be processing them in batch mode in a different directory. See Section 30.6, 
“Tecplot.phy File Location Configuration,” for information on the location of your tec-
plot.phy file.
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CHAPTER 29 Animation

Animation is the process of showing a succession of still images to give the impression of 
motion. Tecplot provides a variety of methods for creating animated plots, and exporting them 
to movie files for playback at a later time. There are three basic animation methods available:

• Animation Tools: Perform simple animations using the dialogs in the Animate sub-menu 
under the Tools menu. The Animate sub-menu allows you to animate zones, mappings, 
contour levels, IJK-planes, IJK-blanking, and streamtraces. The animation is viewed within 
Tecplot, or exported to a movie file which can be played back outside of Tecplot.

• Manually: Interactively create movies by creating an initial plot, exporting the image as 
either a AVI or Raster Metafile movie, then repeatedly changing and appending new 
images to the same movie file.

• Macros: Use a macro to perform multiple, repetitive changes, and write each image to a 
movie file.

This chapter discusses these methods, as well as ways to play back movies that have been 
created in Tecplot.

29.1. Animation Tools
Use the Animate sub-menu under the Tools menu to have Tecplot cycle through your data, 
automatically displaying zones, IJK-planes, or any of several other plot elements, one after the 
other, until your entire data set has been displayed. The following plot elements may be ani-
mated using the dialogs in the Animate submenu:

• Contour Levels.

• IJK-Planes.

• IJK-Blanking.

• Mappings.

• Slices.

• Streamtraces.
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• Zones.

29.1.1. Contour Level Animation

Use the Animate Contour Levels dialog to display all or a specified subset of the contour levels 
defined in the current frame, one at a time. 

To animate contour levels:

1. From the Tools menu, choose Animate, then choose Contour Levels. The Animate Contour 
Levels dialog appears, as shown in  Figure 29-1.

2. Specify a start contour level (the first contour level you want displayed), an end contour 
level, and a contour level skip in the fields provided. If you specify a start level having a 
higher number than the end level, Tecplot cycles backward from the start to the end.

3. If you want Tecplot to create a movie file containing the animation, select “to AVI file” or 
“to RM file” from the Animate drop-down.

4. Click Animate to run the animation automatically, or use the + and - in the Current Level 
area to “step through” the animation one contour level at a time. (These cycle through the 
range of levels specified by Start Level Number and End Level Number; if your range is 
reversed, so are their actions.)

29.1.2. IJK-Plane Animation

Use the Animate IJK-Planes dialog to display all or a specified sub-set of the IJK-planes in the 
current data set, one at a time. You can choose to animate either the I-, J-, or K-planes.

To animate IJK-planes:

1. From the Tools menu, choose Animate, then choose IJK-Planes. The Animate IJK-Planes 
dialog appears, as shown in Figure 29-2.

2. Specify the set of planes to animate: I-Planes, J-Planes, or K-Planes.

Figure 29-1. The Animate Contour Levels dialog.



479

29.1. Animation Tools

3. Specify a start index (the first plane you want displayed), an end index, and an index skip in 
the fields provided. If you specify a start index having a higher number than the end index, 
Tecplot cycles backward from the start to the end.

4. If you want Tecplot to create a movie file containing the animation, select “to AVI file” or 
“to RM file” from the Animate drop-down.

5. Click Animate to run the animation automatically, or use + and - in the Current Index area 
to “step through” the animation one plane at a time. (These cycle through the range of 
planes specified by Start Index and End Index; if your range is reversed, so are their 
actions.)

Figure 29-3 shows an example of animating I-planes in an IJK-ordered zone.

29.1.3. IJK-Blanking Animation

Use the Animate IJK-Blanking dialog to animate a sequence of Tecplot renderings starting 
with an initial set of blanked IJK indices and proceeding in a series of interpolated steps to a 
final set of blanked IJK indices. Before you can animate IJK-blanking, you must first specify 
which zone you want to use in the IJK-Blanking dialog.

Figure 29-2. The Animate IJK-Planes dialog.

Figure 29-3. An animated sequence of I-planes.
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To animate a sequence of IJK-blankings, you must first turn on IJK-blanking, then use the 
Animate IJK-Blanking dialog:

1. From the Style menu, choose IJK-Blanking. The IJK-Blanking dialog appears.

2. Select the Include IJK-Blanking check box. The remaining controls in the dialog become 
active.

3. From the Zone drop-down, select the desired zone and specify whether the interior or exte-
rior of the zone should be blanked.

4. Click Close.

5. From the Tools menu, choose Animate, then choose IJK-Blanking. The Animate 
IJK-Blanking dialog appears, as shown in Figure 29-4.

6. Specify an initial set of blanked IJK-indices in the text fields grouped under the title Start-
ing Index (% of Max). Enter a range of indices for each of I, J, and K. Index values are 
entered as percentages of the maximum index.

7. Specify a final set of blanked IJK-indices in the text fields grouped under the title Ending 
Index (% of Max). Enter a range of indices for each of I, J, and K. 

8. Specify the number of steps—that is, the number of renderings required to move from the 
initial IJK-blanking to the final IJK-blanking. The minimum number of steps is two.

9. If you want Tecplot to create a movie file containing the animation, select “to AVI file” or 
“to RM file” from the Animate drop-down.

10. Click Animate to run the animation automatically, or use + and - in the Current Step area to 
“step through” the animation one step at a time.

Figure 29-4. The Animate IJK-Blanking dialog.
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29.1.4. Mapping Animation

Use the Animate Mappings dialog to display all or a specified subset of the XY or Polar Line 
mappings defined in the current frame, one at a time. 

To animate mappings:

1. From the Tools menu, choose Animate, then choose Mappings. The Animate Mappings 
dialog appears, as shown in  Figure 29-5.

2. Specify a Start Map (the first line mapping you want displayed), an End Map, and a Map 
Skip in the fields provided. If you specify a Start Map having a higher number than the End 
Map, Tecplot cycles backward from the start to the end. 

3. If you want Tecplot to create a movie file containing the animation, select “to AVI file” or 
“to RM file” from the Animate drop-down.

4. Click Animate to run the animation automatically, or use + and - in the Current Map area to 
“step through” the animation one mapping at a time. (Theses cycle through the range of 
mappings specified by Start Map and End Map; if your range is reversed, so are their 
actions.) 

You can try this with the demo data file, demo/xy/rainfall.plt.

29.1.5. Slice Animation

Use the Animate Slices dialog to animate a sequence of slices through your data. Use the Slice 
tool or the 3D Slice Details dialog to configure the start and end slices for your animation. The 
Animate Slices dialog is shown in Figure 29-6. 

To animate a sequence of slices perform the following steps:

1. Use the Slice tool or the 3D Slice Details dialog to define a start and end slice.

2. From the Tools menu, choose Animate, then select Slices. The Animate Slices dialog 
appears, as shown in Figure 29-6.

3. Enter the number of slices to animate.

Figure 29-5. The Animate Mappings dialog.
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4. If you want to create a movie file containing the animation select “to AVI file” or “to RM 
file” from the Animate drop-down.

5. Click Animate.

If the slices are currently assigned to I-, J-, or K-planes, the total number of slices you can 
animate is limited to the total number of I-, J-, or K-planes possible between the start and end 
slice planes. If the slice planes are X-, Y-, or Z-planes you may specify any number of slices 
larger than or equal to two.

29.1.6. Streamtrace Animation

Use the Animate Streamtraces dialog to create animated images of streamtraces. You specify 
the number of images shown for each streamtrace cycle, and the number of cycles to show. The 
resulting animation shows streamtrace markers and/or streamtrace timing dashes at each step 
of the animation, “moving” down the streamtrace. Before you can animate streamtraces, you 
must turn on either the timing dashes or timing markers or both, using the Streamtrace Details 
dialog under the Field menu. See Section 12.6, “Streamtrace Timing,” for details.

To animate your streamtraces:

1. Create a number of streamtraces. (For information on how to do this, see Chapter 12, 
“Streamtraces.”)

2. If you have not already done so, select Show Dashes or Show Markers from the Timing 
page of the Streamtrace Details dialog. (Choose Streamtrace Details from the Field menu to 
call up this dialog.)

3. From the Tool menu, choose Animate, then choose Streamtraces. The Animate 
Streamtraces dialog appears, as shown in Figure 29-7.

4. If you want Tecplot to create a movie file containing the animation, select “to AVI file” or 
“to RM file” from the Animate drop-down.

5. Specify the number of steps per cycle and the number of cycles in the fields provided.

6. Click Animate to begin the animation.

Figure 29-6. The Animate Slices dialog.
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29.1.7. Zone Animation
Use the Animate Zones dialog to display all or a specified subset of the zones in the current 
data set, one at a time. 

To animate zones:

1. From the Tools menu, choose Animate, then choose Zones. The Animate Zones dialog 
appears as shown in Figure 29-8.

2. Specify a start zone (the first zone you want displayed), an end zone, and a zone skip in the 
fields provided. If you specify a start zone having a higher number than the end zone, Tec-
plot cycles backward from the start to the end. 

3. If you want Tecplot to create a movie file containing the animation, select “to AVI file” or 
“to RM file” from the Animate drop-down.

4. Click Animate to run the animation automatically, or use + and - in the Current Zone area 
to “step through” the animation one zone at a time. (These cycle through the range of zones 
specified by Start Zone and End Zone; if your range is reversed, so are their actions.) 

For example, suppose you have several sets of 2-D data defined at different times. At each time 
value, the data point positions are the same, but the variables defined at the data points are dif-

Figure 29-7. The Animate Streamtraces dialog.

Figure 29-8. The Animate Zones dialog.
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ferent. You could organize this body of data into one data file where each time value is allo-
cated to a separate zone. In Tecplot, you could set up the plot style the way you want for all 
zones, then use Animate Zones to view the data for all time values by activating each zone, one 
at a time.

As an example, you might try loading the data file demo/2d/cylinder.plt and animat-
ing its zones. The cylinder data set has three zones.

29.1.8. Movie File Creation

Each of the animation dialogs offers you the option of saving the current animation as an AVI 
or Raster Metafile (Framer Movie File).

To save the current animation as a movie file:

1. In the appropriate Animation dialog, select “to AVI file” or “to RM file” from the Animate 
drop-down. When you click Animate, the appropriate Export dialog will appear.

2. Choose the image width and whether to use multiple color tables.

3. If you choose AVI as the export file type, you may specify animation speed in frames per 
second. Animation speed is only available for AVI files.

4. When you click OK, the Select Move File dialog will appear. Enter a file name.

5. Click OK to create the movie file. The images are written to the movie file while the Work-
ing dialog is displayed on your screen. (The screen image will not change.)

See Section 29.5.2, “Raster Metafiles Viewing in Framer,” for information on running Framer 
on your movie files.

29.2. Movie File Creation Manually
You can create a sequence of Raster Metafile images interactively as follows:

1. Create the first plot.

2. Select Export from the File menu and select Raster Metafile from the list.

3. Setup the desired characteristics on the Raster Metafile dialog, and click OK.

4. Select a file name when the Select Export File dialog is presented, then click Save.

5. The first image will be saved after you click Save on the Select Export File dialog, then the 
Record Animation File dialog will appear.

6. Create the next plot interactively.

7. When satisfied with the next image, click Record Next Image on the Record Animation 
File dialog.

8. Repeat steps 6 and 7 to continue adding images to the animation. When done, click Finish 
Animation on the Record Next Image dialog.
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29.3. Movie Creation with Macros
The Tecplot macro language expands the capabilities of Tecplot’s standard animation features. 
The macro commands allow you to do almost anything you can do interactively, and export 
images to movie files. You can also use loops to repeatedly rotate 3-D objects, cycle from one 
active zone to another, and so on, to create your movie. See Chapter 27, “Macro Commands,” 
for detailed information regarding the Tecplot macro language.

A typical macro file for making movies has the following form:

#!MC 1000 
 ... optional commands to set up the first image 
$!EXPORTSETUP  
  EXPORTFORMAT = AVI 
  EXPORTFNAME = "mymovie.avi" 
$!EXPORTSTART  
$!LOOP 50  
 ... commands to set up next image 
  $!REDRAWALL 
  $!EXPORTNEXTFRAME 
$!ENDLOOP                                                 
$!EXPORTFINISH

For example, the following macro file duplicates the actions performed by the Animate Zones 
dialog:

#!MC 1000 
##  Set up Export file type and file name. 
$!EXPORTSETUP  
  EXPORTFORMAT = AVI 
  EXPORTFNAME = "C:\temp\timeseries.avi" 
##  Begin Animating 
$!LOOP |NUMZONES| 
## Change the active zone. 
## The |Loop| variable is equal to the current 
## loop cycle number. 
  $!ACTIVEFIELDZONES = [|Loop|] 
  $!REDRAWALL 
##  This series of $!IF statements ensures 
##  that a new AVI file will be created when 
##  the macro is started. 
  $!IF |Loop| == 1 
    $!EXPORTSTART  
  $!ENDIF 
  $!IF |Loop| != 1 
    $!EXPORTNEXTFRAME  
  $!ENDIF 
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$!ENDLOOP                                                       
$!EXPORTFINISH

To run this macro, do the following:

1. Create a macro file like the example above. Edit the macro file to specify a new export file 
name if necessary.

2. Load in a multi-zone data file.

3. Switch to 2D Cartesian plot type.

4. From the File menu, choose the Play option from the Macro sub-menu, then choose the 
macro file you specified in step 1.

Note: Version 8.0 macros for creating animation files (Raster Metafiles or AVI) must be 
revised to work with Version 9.0 or later, as shown in the example above.

29.4. Advanced Animation Techniques
There may be times when you want to include information in your animation which tells 
viewers about the time step, current zones, or a mapping. There are several ways this can be 
done.

29.4.1. Image Size 

When you need a particular size for your animation image, such as 300 by 250 pixels, first edit 
your frame to the correct width and height. Then export only the current frame.

29.4.2. Text Changes by Attaching Text to Zones

This method works best if you are using the Zone Animation function under the Tools menu. 
First, create several text strings in your data file, and use the ZN= parameter to attach each text 
string to a zone or mapping. (See section 4.1.3, “Text Record,” for details on attaching text to 
zones.) You should have a separate text string for each zone in your data set that will be used in 
your animation. An example of this is:

ZONE T="Temp. distribution, Time = 0.5 seconds" I=51, J=51 F=POINT

.

.

.

list of variable values

.

.

.

TEXT X=70, Y=90, T="Time = 0.5 seconds", F=COURIER, CS=FRAME, H=2, ZN=1

ZONE T="Temp. distribution, Time = 1.0 seconds" I=51, J=51 F=POINT
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.

.

.

list of variable values

.

.

.

TEXT X=70, Y=90, T="Time = 1.0 seconds", F=COURIER, CS=FRAME, H=2, ZN=2

Next, use the Animate Zones or Mappings tool to create your animation. Only the text string 
attached to the current zone in your animation will be visible. You can also use Tecplot’s 
dynamic text feature (see Section 16.1.11. “Dynamic Text”) to insert a zone name into your 
text strings. For example:

ZONE T="Time = 1.0 seconds" I=51, J=51 F=POINT

.

.

.

list of variable values

.

.

.

TEXT X=70, Y=90, T="&(ZONENAME:2)", F=COURIER, CS=FRAME, H=2, ZN=2

29.4.3. Text Changes Using the Scatter Symbol Legend

You also can show the name of the current zone in your animation with the use of the scatter 
legend. Although you may not be using Scatter zone layer in your plot, the scatter legend will 
show the name of the current zone during the animation. See Section 13.7, “Scatter Legends,”  
for more information about using the scatter legend in Tecplot.

Turn on the scatter legend by selecting the Scatter Legend option on the Field menu, then make 
the scatter symbol invisible in the legend by changing the scatter color to white for all of your 
zones in the Scatter page of the Zone Style dialog (or changing to the same color as your frame 
background if it is not white).

29.4.4. Text Changes Using Macros

If you are using a macro to generate your animation, you can include a command to attach a 
text string that contains the current time step:

$!Loop 20

  $!Pick AddAll 

    SelectText = TRUE

  $!Pick Clear
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  .

  .

  .

  Commands to change the existing plot

  .

  .

  .

  $!AttachText

    Text = "Time = |Elapsed_Time| seconds."

    XYPos

    {

     X = 70

     Y = 90

    }

  $!Redraw

  $!If |Loop| == 1                                                                         
$!ExportStart                                                       $!EndIf                                                                         
$!If |Loop| == 1                                                     
$!ExportNextFrame                                                       
$!EndIf

     $!Varset |Elapsed_Time| += 0.5

$!EndLoop

The above loop is an example of how you could use a user-defined macro variable (discussed 
in the Tecplot Reference Manual) to insert an increasing time value into a text string. This 
example uses a variable called |Elapsed_Time|, which we consider to be the current time. 
One could alternatively set |Elapsed_Time| to be a text string that uses dynamic text:

$!Varset |Elapsed_Time| = "%(ZONENAME:|LOOP|)"

With each loop iteration, the |LOOP| macro variable will increment and the name for each 
zone will be inserted into |Elapsed_Time| each time through the loop. (Zone 1, 2, 3, 4, 
and so on.)

29.4.5. Multiple Frames Animation Simultaneously

Animation of plots in multiple frames requires the use of a macro. The $!FRAMECONTROL 
PUSHTOP command is used to switch between each frame. The following template demon-
strates how this is done with a layout where each frame contains a similar plot:

#!MC 1000 
 
##Set the number of images (movie frames) in the animation.  
$!VARSET |NumCycles| = 10 
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$!EXPORTSETUP 
  EXPORTFNAME   = "2frames.rm" 
  EXPORTFORMAT  = RASTERMETAFILE 
  BITDUMPREGION = ALLFRAMES 
. 
. 
Insert commands to set up first frame, if necessary. 
. 
. 
## Outer loop. 
$!LOOP |NumCycles| 
  ##  Inner loop cycles through each frame in the current layout. 
  $!LOOP |NumFrames| 
    . 
    . 
    Insert commands to change the plot in the current frame. 
    . 
    . 
    ##This command pushes the topmost (active) frame to the back,  
    ##making the next frame active. 
    $!FrameControl PushTop 
  $!EndLoop 
  ##  This series of $!IF statements ensures 
  ##  that a new AVI file will be created when 
  ##  the macro is started. 
  $!IF |Loop| == 1 
    $!EXPORTSTART  
  $!ENDIF 
  $!IF |Loop| != 1 
    $!EXPORTNEXTFRAME  
  $!ENDIF 
$!ENDLOOP

$!EXPORTFINISH

29.5. Movie File Viewing
The following tools allow you to view movie files you have created with Tecplot.

29.5.1. AVI Files
AVI format is the standard video format for Windows platforms. Below are some applications 
that can be used to view and/or edit AVI files:

• Media Player: A standard movie viewer included with Windows.

• Xanim: A program for playing a wide variety of video formats on UNIX X11 machines. 
More information is available at xanim.polter.net.
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• Premier: A powerful tool for professional digital video editing. More information is avail-
able at www.adobe.com.

29.5.2. Raster Metafiles Viewing in Framer
Raster Metafile is a NASA-defined standard format for storing bit images and may contain one 
or more images. You can create a Raster Metafile in Tecplot either interactively, or using a Tec-
plot macro. For many types of repetitive plots (such as rotations, where each image is a slightly 
rotated version of the previous image), macros provide a very convenient means of simplifying 
Raster Metafile creation. 

The Raster Metafile format is defined in the following reference:

Taylor, N., Everton, E., Randall, D., Gates, R., and Skeens, K., NASA TM 102588, Raster 
Metafile and Raster Metafile Translator. Central Scientific Computing Complex Docu-
ment G-14, NASA Langley Research Center, Hampton, VA. September, 1989.

Once you have created your Raster Metafile, you can view the resulting file with Framer. 
Framer is a utility program that is included with Tecplot. It allows you to view files stored in 
Raster Metafile format and runs independently of Tecplot. You may freely distribute Framer so 
that others may view your movies.

The Motif version of Framer is run from your shell prompt; the Windows version can be 
launched from the Tecplot program folder under the Start button. You may freely distribute the 
Framer executable to allow others to view your animation. 

To launch Framer at a command line (shell prompt, Run command, and so forth), use the fol-
lowing command: 

framer [options]  [rmfile] 

where [rmfile] is the name of a file containing Raster Metafile bitmaps created by Tecplot, and 
[options] is one or more of the options listed in Section 1 of Appendix B, “Utility Command 
Line Options.”

To run Framer on UNIX type:

framer [filename]

If you do not specify a file name, Framer prompts you for one. (Under Windows you get the 
file dialog shown in Figure 29-9. In this dialog, you can choose to set buffering [equivalent to 
the -b flag] and/or multiple color maps [equivalent to the -m flag].) For a list of Framer 
command lines, see Appendix B.1, “Framer.”

Figure 29-10 shows the main Framer window under Windows. 
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Figure 29-9. The Framer Open File dialog under Windows.

Figure 29-10. The Framer application window under Windows.
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CHAPTER 30 Customization

Tecplot comes with a complete set of factory defaults for creating plots of all kinds: frame 
attributes, such as the initial frame size, background color; axis attributes, such as axis line 
color and range; plot attributes, such as boundary line thickness and contour plot type; and so 
on. You can modify virtually all of these defaults through the use of a configuration file. A Tec-
plot configuration file is a special type of Tecplot macro file that Tecplot reads on start up; the 
settings in the configuration file override Tecplot’s factory defaults.

You can create a configuration file from scratch, using any ASCII text editor, or you can have 
Tecplot create one for you using the Save Configuration option in the File menu’s Preferences 
sub-menu. You can also use the Preferences sub-menu and the Display Performance dialog to 
modify many settings interactively.

This chapter discusses creating and editing configuration files. The names of the files used will 
vary from platform to platform; this chapter concentrates on UNIX and Windows files.

30.1. Configuration Files
Tecplot looks for configuration files in one of three places: the current working directory, the 
user’s home directory, and the Tecplot home directory. In the current working directory, Tec-
plot searches for a file named tecplot.cfg. If it finds it, it uses the settings in that file to 
override the factory defaults. If not, Tecplot searches your home directory for a file named 
.tecplot.cfg (tecplot.cfg in Windows). If Tecplot finds this file, it uses the settings 
in that file to override factory defaults. If there is no .tecplot.cfg file in your home direc-
tory, Tecplot looks in the Tecplot home directory for a file named tecplot.cfg, and uses 
the settings in that file to override the factory defaults. (Under Windows, your home directory 
is determined by the two environment variables HOMEDRIVE and HOMEPATH. If they are not 
set, Tecplot skips your home directory.)

You can save configuration files with any valid file name. To have Tecplot use them, you must 
either rename them to have one of the names Tecplot searches for by default, or, more com-
monly, use the “-c” command line option when starting Tecplot. For example, the following 
command starts Tecplot using the configuration settings in the file mydefs.cfg:

tecplot -c mydefs.cfg

System administrators can use the tecplot.cfg file in the Tecplot home directory to set 
system-wide defaults, then others on the system can copy the system configuration file to their 
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own home directories and make any desired changes. The settings in your local configuration 
file are used instead of the settings in the system configuration file. A configuration file needs 
to include only those options for which you want to override defaults.

Tecplot under Motif has a second type of configuration file, an X11 resource file (app-defaults 
file) that controls the appearance of the Tecplot application and its dialogs. Most users do not 
need to concern themselves with this file; nothing in the resource file has any affect on the 
plots you create with Tecplot, either on screen or on paper. However, if you are an experienced 
Motif and X11 user, you may want to modify some of the resources to improve the appearance 
of Tecplot’s windows and dialogs on your display. Section 30.4, “Interface Configuration 
Under UNIX,” explains how to do this.

30.1.1. Configuration File Creation
The simplest way to create a configuration file is to change the appropriate settings using the 
Tecplot interface, then save the configuration. For example, suppose you want to have your 
paper orientation default to portrait and have your default export format be Encapsulated Post-
Script (EPS). You can modify the settings using the appropriate Tecplot dialogs, then save the 
configuration file.

To save a Tecplot configuration file:

1. Change settings as desired using Tecplot dialogs.

2. From the File menu, choose Preferences, then choose Save Configuration. The Save Con-
figuration dialog appears as shown in Figure 30-1.

Figure 30-1. The Save Configuration dialog.
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3. Check the file name listed. If the file name is correct, click OK. If you want to save to a dif-
ferent file, click Change File Name and specify a new file name.

Here is the configuration file resulting from the changes described above:

#!MC 1000 
$!PAPER  
  ORIENTPORTRAIT = YES 
$!EXPORTSETUP  
  EXPORTFORMAT = EPS 
$!FRAMELAYOUT  
   XYPOS 
    { 
    X = 1 
    Y = 0.25 
    } 
  WIDTH = 9 
  HEIGHT = 8

This configuration file specifies portrait orientation, and sets the Export format to EPS, just as 
desired. The only other settings saved are the default frame layout settings.

You can, however, obtain a configuration file that includes most of the factory defaults as fol-
lows:

1. From the File menu, choose Preferences, then choose Save Configuration. The Save Con-
figuration dialog appears.

2. Select the check box labeled Include Factory Defaults.

3. Check the file name listed. If the file name is correct, click OK. If you want to save to a dif-
ferent file, click Change File Name and specify a new file name.

The created file contains factory defaults for the following types of Tecplot settings:

• Interface details.

• RGB color assignments for Tecplot’s basic colors.

• Default paper layout.

• Print and export setup information.

If you modify any setting from these four types interactively and then save your configuration, 
the modifications are saved. However, modifications to other types of settings will not be 
saved.

You are not limited, however, to changing merely those settings which appear in the saved con-
figuration file. Most settings which can be modified by one of Tecplot’s SetValue macro com-
mands can be changed in the configuration file. These other settings must be changed, 
however, by editing the configuration file.The simplest way to do this is to create a layout or 
macro with the settings you want, then copy and paste the appropriate SetValue commands into 
your configuration file. (Once you become more familiar with the macro language, it may be 
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simpler to type in the appropriate SetValue command directly.) See the Tecplot Reference 
Manual for complete details on the SetValue and other macro commands.

For example, suppose you want your 2-D axes to appear cyan. You can add this preference to 
your configuration file as follows:

1. Using the Tecplot interface, create a 2-D plot with cyan axes, either recording your steps as 
a macro, or saving the result as a Tecplot layout.

2. Edit the resulting macro or layout, scanning for the lines that set the 2-D axis colors. The 
following example shows the commands that specify the X- and Y-axis details in a layout 
of a 2-D plot with cyan axes:
$!TWODAXIS 
  XDETAIL 
    { 
    RANGEMIN = -2.99985003471 
    RANGEMAX = 15.001799985 
    GRSPACING = 5 
    AXISCOLOR = CYAN 
    } 
  YDETAIL 
    { 
    RANGEMIN = -2.99985003471 
    RANGEMAX = 13.4283224277 
    GRSPACING = 2 
    AXISCOLOR = CYAN 
    }

3. Discard everything but the lines that actually set the color:
$!TWODAXIS 
  XDETAIL 
    { 
    AXISCOLOR = CYAN 
    } 
  YDETAIL 
    { 
    AXISCOLOR = CYAN 
    }

4. Paste the resulting lines into your configuration file.

30.1.2. Plot Default Setting
A single $!FIELD command can be included to set plot defaults. The command cannot spec-
ify a zone, and is not effective for values set dynamically by Tecplot, such as Mesh Color. In 
the example below, the default contour type is Flood, scatter symbol shape is Delta, and scatter 
size is 1.8.

$!FIELD
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   CONTOUR

     {

     CONTOURTYPE = FLOOD

     }

   SCATTER

     {

     FRAMESIZE = 1.8

     SYMBOLSHAPE

       {

       GEOMSHAPE = DEL

       }

     }

In the same way, a single $!LINEMAP command can be added for line mapping defaults. In 
the example below, XY and Polar Line mappings will have a dashed line pattern, and symbols 
will be filled circles.

$!LINEMAP

   LINES

     {

     LINEPATTERN = DASHED

     }

   SYMBOLS

       {

       SYMBOLSHAPE

          {

          GEOMSHAPE = CIRCLE

          }

       FILLMODE = USELINECOLOR

       }

30.1.3. Interface Configuration

The many members of the $!INTERFACE macro help you configure Tecplot’s user interface 
and graphics drawing capabilities. Although some of these commands can be executed in any 
Tecplot macro the best place to put these is in the Tecplot configuration file, tecplot.cfg. 
Below are a few examples. Refer to the Tecplot Reference Manual for a complete listing.

30.1.3.1. Interface Configuration Options. 

$!INTERFACE MOUSEACTIONS = {MIDDLEBUTTON {SIMPLEDRAG=ZOOMDATA}}
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Specify the action of the middle mouse button click and drag. Several other options for the 
middle and right mouse buttons are listed in the Tecplot Reference Manual. These commands 
can only be executed from the Tecplot configuration file.

$!INTERFACE UNIXHELPBROWSERCMD = string

Specify the command to execute to launch the browser on UNIX systems for viewing the Help 
files. This command can only be executed from the Tecplot configuration file.

$!INTERFACE SHOWWAITDIALOGS = (YES, NO)   

You can disable the launch and display of all Wait dialogs by setting this to NO. (Wait dialogs 
are launched during long operations and give you the ability to cancel the operation.) This is 
useful on some Linux systems where transient dialogs do not drop properly, leaving a gray box 
that obscures part of Tecplot’s drawing area.

$!INTERFACE USESTROKEFONTSONSCREEN = (YES, NO)

If set to YES all text drawn in the work area will be drawn using Tecplot's internal stroke fonts. 
If set to NO the native True Type fonts will be used instead. This option has no effect under 
UNIX.

$!INTERFACE USESTROKEFONTSFOR3DTEXT = (YES, NO)

If set to YES all 3-D text drawn in the work area will be drawn using Tecplot's internal stroke 
fonts. 3-D text consists of ASCII scatter symbols, and node and cell labels when the current 
plot type is 3D Cartesian. For 3-D text, this setting overrides the setting of USESTROKE-
FONTSONSCREEN. If set to NO the native True Type fonts will be used instead. This option 
has no effect under UNIX.

30.1.3.2. OpenGL-Specific Configuration Options. Several options are available to 
further tune Tecplot to operate with the OpenGL capabilities of your platform. To assign values 
to these parameters you must use the $!INTERFACE OPENGLCONFIG. A complete list of 
these options is given in the Tecplot Reference Manual.

$!INTERFACE OPENGLCONFIG 

  { SCREENRENDERING { DOEXTRADRAWFORLASTPIXEL = (YES, NO)}}

Some OpenGL implementations use an optimization for line drawing that omits the last pixel 
in the line. Set this to YES to change all line drawing to force the last pixel to be drawn. This 
setting applies only to drawing on the screen.

$!INTERFACE OPENGLCONFIG 

  { SCREENRENDERING { STIPPLEALLLINES = (ALL, CRITICAL, NONE)}}

Set to ALL to make all lines drawn using stippling. Set to CRITICAL to use stippling for 
stroke and user-defined fonts. Set to NONE to disable stippling. This setting applies only to 
drawing on the screen.

$!INTERFACE OPENGLCONFIG
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  { IMAGERENDERING { DOEXTRADRAWFORLASTPIXEL = (YES, NO)}}

Some OpenGL implementations use an optimization for line drawing that omits the last pixel 
in the line. Set this to YES to change all line drawing to force the last pixel to be drawn. This 
setting applies only to exporting images from Tecplot.

$!INTERFACE OPENGLCONFIG 

  { IMAGERENDERING { STIPPLEALLLINES = (ALL, CRITICAL, NONE)}}

Set to ALL to make all lines drawn using stippling. Set to CRITICAL to use stippling for 
stroke and user-defined fonts. Set to NONE to disable stippling. This setting applies exporting 
images from Tecplot.

30.1.4. Default File Name Extensions

The default extensions for file names in file input-output dialogs can also be changed in the 
configuration file. These settings are changed via the FNAMEFILTER sub-command in the 
$!FILECONFIG macro command.

• COLORMAPFILE: Specifies the default extension for color map files.

• INPUTDATAFILE: Specifies the default extension for input data files.

• OUTPUTASCIIDATAFILE: Specifies the default extension for ASCII output files.

• OUTPUTBINARYDATAFILE: Specifies the default extension for binary output files.

• INPUTLAYOUTFILE: Specifies the default extension for input layout and layout package 
files.

• OUTPUTLAYOUTFILE: Specifies the default extension for output layout files.

• OUTPUTLAYOUTPACKAGEFILE: Specifies the default extension for output layout pack-
age files.

• STYLEFILE: Specifies the default extension for stylesheet files.

• MACROFILE: Specifies the default extension for macro files.

• EQUATIONFILE: Specifies the default extension for equation files.

For example, to change the default extension for input data files to be .tbl use:

         $!FILECONFIG

           FNAMEFILTER

           {

             INPUTDATAFILE = "*.tbl"

           }

30.1.5. Default Temporary Directory

Tecplot writes out a number of temporary files. To tell Tecplot where to place these files, put 
the following macro command in the tecplot.cfg file:

   $!FILECONFIG
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    TEMPFILEPATH = "tempfilepath"

where tempfilepath is the new path. The default path is system dependent.

30.2. Interactive Customization
Using the Preferences sub-menu under the File menu, you can interactively control the colors 
used throughout Tecplot, the size options available in most Tecplot dialogs, and several miscel-
laneous parameters.

30.2.1. Color Preferences Dialog

To change the RGB values of Tecplot’s basic colors, use the Color Preferences dialog, shown 
in Figure 30-2. This dialog is displayed by selecting Preferences/Colors... from Tecplot’s File 
menu.

To change a color, click on it in the palette and alter its RGB values with the sliders. As you 
move the sliders, the box in the upper right corner of the dialog shows the color as currently 
specified. You may alter multiple colors by selecting those colors and changing their RGB 
values. Choosing Reset Selected Color or Reset All Colors will restore the default RGB values. 
All color changes take effect when you click OK.

Figure 30-2. The Color Preferences dialog.
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30.2.2. Size Preferences Dialog

To set size options, use the Size Preferences dialog, shown in Figure 30-2. This dialog is dis-
played by selecting Preferences/Sizes... from Tecplot’s File menu.

These options determine the choices available in drop-down such as Line Thickness that occur 
throughout the interface.

You can control the following sets of sizes:

• Line thickness.

• Symbol size.

• Pattern length.

• Arrowhead size.

• Tick mark length.

• Text height (in both points and frame units).

• Translate step size.

• Rotate step size.

• Magnification step size.

• Stroke font line thickness.

Figure 30-3. The Size Preferences dialog.
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30.3. Display Performance Dialog
Various aspects of what is displayed in the Tecplot workspace may be configured with the 
Display Performance dialog. Some of these options control the look of the workspace, while 
others enhance the graphics performance. The Display Performance dialog is shown in 
Figure 30-4. 

There are many different combinations of computer systems and graphics card capabilities. 
Because of this no one setting is optimal for all hardware configurations. In addition, there are 
many different types of plots that can be made with Tecplot. Different plots can often be ren-
dered faster if Tecplot is configured one way; others may be rendered faster if Tecplot is con-
figured in a different way.

The Display Performance dialog allows you some control over how Tecplot manages the 
graphics resources. Often there is a trade off between level of detail or accuracy on the screen 
versus drawing speed.

For most general uses of Tecplot it is probably unnecessary to use the Display Performance 
dialog. However, if you are dealing with large data sets it is likely that you will want to make 
some adjustments.

The Display Performance dialog addresses four different areas:

• On screen performance.

• Graphics cache settings.

Figure 30-4. The Display Performance dialog.
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• Status line options.

• Image export options.

The first two deal with changing Tecplot’s performance by changing the level of detail of what 
is drawn or how often something is drawn. The second two merely allow you change what is 
seen in the work area or change the method of exporting plots to gain better performance.

30.3.1. On Screen Performance

Here you can configure the responsiveness of Tecplot and the level of detail.

30.3.1.1. Use Auto Redraw. Choose whether Tecplot automatically redraws the plot when 
the plot is changed. A drawing can always be interrupted by the user by clicking with the 
mouse in the work area

Note: There are a number of phases Tecplot goes through when processing a drawing in the 
work area. Most of the phases can be interrupted by clicking with the mouse in the work area. 
However, there are some phases that cannot be interrupted.

30.3.1.2. Approximate Plots for Better Speed. Selecting this option instructs Tecplot to 
render plots with a lesser degree of detail according to the Approximation Mode. The Approx-
imation Mode can be one of the following:

30.3.1.3. Automatic. In this mode Tecplot will choose when the drawing in each frame is to 
be approximated based on the Point Threshold for Automatic Approximation. If the number of 
points used in a drawing in a frame exceed the Point Threshold then Tecplot will create an 
approximated version of the plot and render that first and then proceed to work on rendering a 
complete drawing. You will see the approximated plot quickly and you can at that point elect to 
make other changes to the plot. If you proceed in Tecplot before the final drawing is completed 
Tecplot will interrupt the processing of the detailed drawing. During rotation, translation, or 
smooth zoom, the plot will remain approximated until the mouse button is released.

30.3.1.4. Non-Current Frames Always Approximated. Choosing this option is like 
Automatic except that all non-current frames are always approximated. After a change in the 
current frame you will see all frames with an approximate drawing followed by the current 
frame drawn in full detail. The non-current frames are left as is. You can see a full detail 
drawing in all frames by clicking Redraw All on the sidebar or clicking with the middle mouse 
in the work area (outside of any frame).

30.3.1.5. All Frames Always Approximated. In this mode the drawing in all frames is 
always approximated while you change views or style. You can see a full detail plot of the cur-
rently active frame by clicking Redraw on the sidebar or by clicking the middle mouse in the 
current frame. You can see a full detail plot of all frames by clicking Redraw All on the sidebar 
by clicking with the middle mouse in the work area (outside of any frame).
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30.3.1.6. Point Threshold for Automatic Approximation. The drawing in a frame is a 
candidate to be approximated if the number of points used to draw the full plot exceeds this 
value. This is only a factor if the Approximation Mode is Automatic or Non-Current Frames 
Always Approximated.

30.3.1.7. Approximate Plot as % of Full Plot. When a plot is approximated it will be 
drawn with this percentage of the original data. In some cases Tecplot will plot more than this 
percentage to preserve the shape of the data.

30.3.1.8. Show Text/Geometries in Approximate Plots. Text and geometries are not 
approximated because it is assumed that they do not affect performance. If you are plotting a 
large number of text or geometries then you can unselect this option to remove text and geom-
etries from the approximated views.

30.3.2. Graphics Cache

The Graphics Cache is used to store instructions for OpenGL display lists used to draw in the 
work area. If a significant amount of processing is needed to create the instructions, then 
saving the instructions for repeated use can increase the rendering speed significantly. The 
graphics cache can greatly speed up drawing for a number of situations including 3-D view 
changes, changing the style in a sub-set of the plot (that is, changing the style of iso-surfaces 
only), or for repairing of the Tecplot work area after it has been damaged because a dialog has 
moved on top.

Some computers may have limited graphics resources compared to the amount of data to be 
plotted. In these cases it may be beneficial to either cache only "lightweight" graphics objects 
or do not cache anything at all.

If graphics are not cached you may experience situations where most or all of your plot is not 
drawn on the screen. This can occur when the work area is damaged by moving another dialog 
on top of it for example. If you have Auto Redraw turned off, the work area will have frames 
that are not drawn at all and remain that way until you click Redraw All.

30.3.2.1. Status Line. Three check boxes used to configure the status line are located at the 
top of the Performance Options dialog. You may enable or disable the display of running coor-
dinates, status line messages, or turn off the status line altogether.

30.3.3. Image Export Options

This section allows you to choose between on-screen and off-screen rendering for image 
exporting. On the Macintosh, this also affects copying the plot to the clipboard. Safe (off-
screen) exporting is the default. Choose Fast (on-screen) rendering to improve performance, or 
to avoid problems encountered on some systems with off-screen rendering.
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30.4. Interface Configuration Under UNIX
In UNIX, the style of the graphical user interface for Tecplot is configured for the most part by 
a resource file called Tecplot100 which resides in the app-defaults sub-directory 
below the Tecplot home directory. If you edit this file the changes will affect all users. Alterna-
tively, you can add entries to a file called .Xdefaults which resides in your own $HOME 
directory if you want the changes to apply only to your own execution of Tecplot. If the file 
.Xdefaults does not already exist in your home directory, you can create one.

30.4.1. Default Size of Tecplot

The resource lines that affect the default Tecplot process window size are:

*Tecplot.main_dialog.width: 900

*Tecplot.main_dialog.height: 720

Changing either the value 900 or the value 720 will change the default size of the Tecplot 
process window.

30.4.2. Accelerator Keystrokes

Changing accelerator keystrokes is easiest using the following method:

1. Find the menu options to which you can assign accelerator keys in Tecplot. Use the grep 
command as follows:
grep _mbopt.labelString Tecplot100

2. Find the accelerator keys not already assigned. The assigned keys can be found using the 
following command:
grep accelerator Tecplot100

3. Add an entry to the Tecplot100 or to the .Xdefaults file in your $HOME directory to 
add an accelerator. For example, the following line will let you press just the letter N to 
open a new layout:
Tecplot*main_filenew_mbopt.accelerator: <Key>N

The following example will let you press Ctrl-N to open a new layout:
Tecplot*main_filenew_mbopt.accelerator: Ctrl<Key>N

30.4.3. Default Positions for Dialogs

On UNIX platforms, you can customize the default positioning of modeless dialogs (those that 
can remain up while you do other things in Tecplot) by adding a few entries to your            
.Xdefaults file.

To change the default position for a given dialog, do the following:

1. Determine the base name of the dialog from table xxxx below.

2. Add the following lines to your .Xdefaults file:

Tecplot*bbbbbb_dialog.defaultPosition: FALSE
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Tecplot*bbbbbb_dialog.x: xxxxxx

Tecplot*bbbbbb_dialog.y: yyyyyy

Where:

          bbbbbb is the base name of the dialog.

          xxxxxx is the X-position you want the dialog to start in.

          yyyyyy is the Y-position you want the dialog to start in.

The XY-position is relative to the upper left corner of the screen. Here are the base names of 
modeless dialogs in Tecplot.

advancedbandopts animaterecord atprobe axisedit cellcenter colormap
contcoloropts contlabel contlegend contlinemode contourlevels contourvar
createcircularzonecreatelinezone createmirrorzone createrectzone createsubzone dataalter       
datalabels datarotate2d datasetinfo dataspreadsheetdeletezone depthblank         
dupzone editframe editprobe enterxyzone extractcurrent3dslice
extractfebound extractslice frameaxis geom globalscat globalstream
ijkblank invdistinterp isosurface kriging linearinterp linkframes
macrorecord macrovariables macroview optionstext orderframes paperplotattr     
polartorect probe quickedit quickmacro scatlegend slicedetails      
smooth stream text threedadvanced threedlightsrc translate    
triangulate twod valueblank vectorhead vectorlength view3d      
viewrotate3d xyeditprobe xylegend

30.5. Custom Character and Symbol Definition
When Tecplot starts up, it reads the font file (‘‘tecplot.fnt’’). This file contains informa-
tion that defines the appearance of text characters on the screen. Tecplot defines and draws 
characters on the screen as a set of straight lines called strokes. These stroked characters 
approximate the appearance of characters for the screen.

The font file is an ASCII file that can be edited using an ASCII text editor. You can modify the 
shape, size, and resolution of existing stroke-font characters or add completely new ones. In 
PostScript print files, text characters are generated using PostScript defined fonts, not the 
stroked fonts. If you are using the Windows version of Tecplot and the Windows print drivers 
are active, then all text except text using the User-Defined fonts is serviced by the Windows 
printer driver. However, HP-GL and HP-GL/2 print files use the stroked fonts, and the text 
characters in bitmap export files are also in stroked fonts (since they are generated from the 
screen). The inter-character spacing in all output files is determined by the character-width def-
initions in the font file. When using PostScript print files or the Windows print drivers, chang-
ing the font commands affects only the character shape for User-Defined fonts and the 
character spacing for all fonts.

The Font File is structured as follows:

#!FF 4 
 CharCellHeight 
 Stroke command set for Helvetica Font 
 Stroke command set for Greek Font 
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 Stroke command set for Math Font 
 Stroke command set for User-Defined Font 
 Stroke command set for Times Font 
 Stroke command set for Times Italic Font 
 Stroke command set for Courier Font

The file type and version are on the first line (‘‘FF’’ means Font File). CharCellHeight is the 
interline spacing (that is, the height of a capital M plus some vertical space) in the units of a 
two-dimensional coordinate system used to define the stroke-font characters. The baseline of 
the characters is at zero. Before Tecplot uses the character definitions, they are normalized by 
the character cell height.

Following the character cell height, there are seven sets of stroke commands, one set for each 
font as shown above. Each stroke command set consists of definitions for the characters in the 
font. Each font has a base set of 96 characters (character indices 32 to 127). Some fonts also 
include an extended set of characters (character indices 160 to 255). The extended characters 
are needed to complete the character sets for most of the common European languages.

All seven stroke command sets must be present, and each must have at least one character 
defined. Each stroke command set begins with the definition for a space (character index 32). 
After that, characters within a stroke command set may be defined in any order. If a character 
is not defined in the Font File, it is drawn as a blank.

Each character in a stroke command set is defined as follows:

CharIndex NumCommands CharWidth 
 Command1 
 Command2 
 Command3 
 . 
 . 
 . 
 CommandNumCommands

CharIndex is the character index which ranges from 32 to 127 and 160 to 255 for each font (see 
Figure 16-5 for the matching of the character index to the English, Greek, Math, and standard 
User-Defined font characters), NumCommands is the number of stroke commands defining the 
character that follows, and CharWidth is the character width, which determines the spacing of 
the characters.

A command may be in one of the following forms:

• m x y.

• d x y.

• mr dx dy.

• dr dx dy.
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A command that begins with an m is a move command. A command that begins with a d is a 
draw command. Commands mr and dr are relative move and relative draw commands. The x 
and y are the absolute coordinates within the character cell. The dx and dy are the relative coor-
dinates with respect to the previous location (increments from the position attained by the pre-
vious command). All coordinates are specified as integers. Figure 30-5 shows an example of a 
character cell and the commands used to define the lowercase letter ‘‘y.’’ The height of the 
character cell is 48.

Figure 30-6 shows a symbol being defined. Symbols should be centered about (0, 0) so that 
they are centered about the point they mark. The font file included with Tecplot contains many 
User-Defined font stroke commands. Most of these are for creating extra plotting symbols, 
accessible when you use the Symbol Type “Other,” enter an ASCII character, and specify the 
User-Defined font.

30.6. Tecplot.phy File Location Configuration
Whenever Tecplot starts, it tries to load a tecplot.phy file. This file contains information 
useful for running macros in batch mode (see Chapter 28, “Batch Processing,” for more infor-
mation) and also the name of the last layout file used in Tecplot. Whenever Tecplot exits, it 
writes out a new tecplot.phy file.

The place Tecplot looks for the tecplot.phy file is based on the following search:

Figure 30-5. Defining a user-defined character.
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1. Tecplot checks the environment variable TECPHYFILE. If this variable is set, Tecplot uses 
the value of this variable as the name of the tecplot.phy file. By default, this variable 
is not set. You can set this environment variable to control the location and name of the 
tecplot.phy file on a user-by-user basis.

2. (Windows Only) Tecplot checks the Windows registry for the key 
HKEY_LOCAL_MACHINE\SOFTWARE\Amtec Engineering, Inc.\Tecplot 
10.0. If the value PhyFile is set under this key, then it is used as the name of the 
tecplot.phy file. This value is set by the installation program. You can use the com-
mand regedit from the Start Menu’s Run option to edit the registry if you want to change 
or delete this key.

3. Tecplot uses the file called tecplot.phy in the directory where Tecplot is started. Note 
that this is the default behavior under UNIX.

Thus, using the default installation, Windows versions of Tecplot will write a tecplot.phy 
to one specific location (usually the Tecplot home directory), and UNIX versions will always 
use a tecplot.phy file in the directory where Tecplot is started.

The Windows version can be made to act like the UNIX version by deleting the value 
PhyFile from HKEY_LOCAL_MACHINE\SOFTWARE\Amtec Engineering, 
Inc.\Tecplot 10.0 in the Windows registry with regedit.

Under both Windows and UNIX, the environment variable TECPHYFILE can be set to over-
ride this behavior.

Figure 30-6. Defining a user-defined plotting symbol.
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CHAPTER 31 Add-Ons

Add-ons are a way to extend the basic functionality of Tecplot. They are executable modules 
designed to perform specific tasks. Amtec has produced a number of add-ons that load data in 
a variety of formats, allow advanced editing, or extend Tecplot’s capabilities. By using the Tec-
plot Add-on Developer’s Kit (ADK), users can create their own add-ons to generate plots, 
transform or analyze data, or perform a broad range of specialized tasks.

31.1. Tecplot Add-Ons
Add-ons are external programs that attach themselves to Tecplot and are accessed through the 
Tecplot interface. When Tecplot is started, it goes through various initialization phases, includ-
ing the processing of the tecplot.cfg file, the loading of the Tecplot stroke font file (tec-
plot.fnt) and the initialization of the graphics. After all of this has been completed, Tecplot 
begins to look for add-ons.

A number of the add-ons currently used by Tecplot are data file loaders or converters, which 
allow users to read non-Tecplot data files. These are:

• loadplot3d: A PLOT3D data loader.

• loadxls: An Excel file loader (Window).

• loadss: A spreadsheet file data loader.

• gridgen: A GridGen file data loader.

• loaddxf: A Data eXchange Format (DFX) data loader.

• loadhdf: A Hierarchical Data Format (HDF) data loader.

• loaddem: A Digital Elevation Map (DEM) data loader.

• loadimg: An add-on that loads bitmaps as a group of geometries.

• loadcgns: A CFD General Notation System (CGNS) data loader.

• loadfluent: A Fluent data loader for .cas and .dat files (versions 5 to 6.1).

These show up under the Import option of the File menu. The primary difference between 
loaders and converters are that loaders bring up more complex dialogs than do converters, 
which only bring up dialogs based on Tecplot’s standard Load Data File(s) option.

Tecplot also uses add-ons for extended curve-fits with XY Line plots. They may be accessed 
by selecting the Curve Type’s Extended option, located on the Mapping Style dialog.
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Curve-fit add-ons include:

• crvstineinterp: A curve-fit using Stineman interpolation.

• crvgen: A curve fit where users define the equation.

Other add-ons may be accessed through the Tools drop-down on Tecplot’s menu bar. They 
include:

• advqet: This calls up the Advanced Quick Edit dialog.

• crsfez: Allows extractions from finite-element sub-zones.

• cstream: Circle stream (this allows users to place a rake of streamtraces in a circular pat-
tern).

• statechange: View all Tecplot state change information (used primarily for add-on devel-
opment).

• viewbin: Binary data file viewer.

31.1.1. Advanced Quick Edit
The Advanced Quick Edit dialog is shown in Figure 31-1.

Selecting the Advanced Quick Edit Tool option from Tecplot’s Tools menu allows you to make 
rapid changes to text and geometries selected in the current frame. This tool allows operations 
that cannot be performed with the standard Quick Edit Tool accessible via the Quick Edit 
option.

Controls on the Advanced Quick Edit Tool dialog are sensitive to user input only when one or 
more text and/or geometries are selected. Some controls are specific to either text or geome-
tries, while others apply to both. If the selected objects are a mix of text and geometries, the 

Figure 31-1. The Advanced Quick Edit dialog.
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controls that apply only to geometries will only affect the geometries you have selected. Simi-
larly, controls that apply specifically to text will only affect text, even if the selected objects are 
a mix of text and geometries.

For more information, access Tecplot’s Help.

31.1.2. Circle Stream
The Circle Stream add-on is used to place a “rake” of streamtraces starting from a selected cir-
cle geometry. The Circle Stream dialog is shown in Figure 31-2.

For more information, and to see an example using Circle Stream, access Tecplot’s Help.

31.1.3. Create Multiple Frames
Use the Create Multiple Frames add-on to make a set of new frames with uniform size and 
spacing within the current frame. The total number of new frames will be the product of the 
frames across and the frames down.

The Create Multiple Frames dialog is shown in Figure 31-3.

For more information, and to see an example using Create Multiple Frames, access Tecplot’s 
Help.

Figure 31-2. The Circle Stream dialog.

Figure 31-3. The Create Multiple Frames dialog.
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31.1.4. Create Finite-Element Sub-Zone
Selecting the Create SubFEZone option from Tecplot’s Tools menu allows you to create a 
finite-element zone containing all elements that are completely visible in the current frame. 
This option is only available for 2D Cartesian plot types, and all elements must be of the same 
type, either triangular or quadrilateral. The Create FE Sub-Zone dialog is shown in 
Figure 31-4.

For more information, and to see an example using Create SubFEZone, access Tecplot’s Help.

31.1.5. Export DXF
The Export DXF File dialog is shown in Figure 31-5.The DXF Export add-on exports data in 

DXF (drawing interchange) format. If the data type is finite-element and the element type is 
triangular or quadrilateral:

Figure 31-4. The Create FE Sub-Zone dialog and its resulting Information dialog.

Figure 31-5. The Export DXF File dialog.
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• If the plot type is 3D Cartesian, a DXF 3DFACE entity is created for each triangle or quad-
rilateral.

• If the plot type is not 3D Cartesian, a DXF POLYLINE entity is created for each triangle or 
quadrilateral.

• If the element type is not triangular or quadrilateral, then no DXF entities are exported.

If the data type is I-, IJ-, or IJK-ordered:

• If the plot type is 3D Cartesian and JMax = 1 and KMax = 1, then a DXF POLYLINE entity 
is exported for all points in the selected zone(s).

• If the plot type is 3D Cartesian and JMax or KMax is greater than 1, then DXF 3DFACE 
entities are exported for all points in the selected zone(s).

• If the plot type is not 3D Cartesian, then a DXF POLYLINE entity is exported connecting 
all points in the selected zone(s).

For more information, access Tecplot’s Help.

31.1.6. Extend Macro
The Extend Macro add-on extends Tecplot’s macro language with macro commands. The com-
mands include:

$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.ZONENAMEBYNUM nnn VVV’

Get the string for zone nnn and assign to variable VVV.
$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.VARNAMEBYNUM nnn VVV’

Get the string for variable nnn and assign to variable VVV.
$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.ZONENUMBYNAME 
"zonename" VVV’

Get the number of zone named zonename and assign to variable VVV.
$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.VARNUMBYASSIGNMENT 
assignment VVV’

Get the number of variable by assignment and assign to variable VVV.

These are the assignment options:

• X: Variable assigned to the X-axis.

• Y: Variable assigned to the Y-axis.

• Z: Variable assigned to the Z-axis.

• U: Variable assigned to be the U-vector component.

• V: Variable assigned to be the V-vector component.

• W: Variable assigned to be the W-vector component.

• C: Variable assigned to contours.

• S: Variable assigned to scatter sizing.

• B: Variable assigned to the first constraint for value-blanking.
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$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.DATASETTITLE VVV’

Get the string for the data set title and assign to variable VVV.
$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’STRING.LENGTH StrSource VVV’

Get the length of string StrSource and assign to variable VVV.
$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’STRING.FINDPATTERN StrSource 
StrPattern VVV’

Get the sub-string from StrSource starting at pattern StrPattern and going to the end of 
StrSource. Returns "NOTFOUND" if not found.

$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’STRING.SUBSTRING StrSource 
start end VVV’

Get the sub-string from StrSource starting at position start and ending at position end. Put 
the result in VVV.

$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.ACTIVEZONES VVV’

Get the set of active zones and put the result in VVV.

Note: The set string does not include any blank spaces. If zones 2, 4, 6, 7 and 8 are active, VVV 
would have the string "2, 4, 6-8."

$!ADDONCOMMAND ADDONID=’extendmcr’ COMMAND=’QUERY.ISZONEACTIVE ZZZ VVV’

Test to see if zone ZZZ is currently active. If so, VVV is set to "YES," otherwise it is set to 
"NO."

More information on the Extend Macro add-on is available via Tecplot’s Help.

31.1.7. Extrude
The Extrude Options dialog is shown in Figure 31-6.The Extrude add-on creates a 3-D volume 

or surface zone by duplicating the source zone and translating it in the Z-direction until the 
specified number of K-cells are created. If the source zone is a surface, a volume zone will be 
created. If the source zone is a line, a surface zone will be created.

Figure 31-6. The Extrude Options dialog.
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An example of using Extrude would be to create a cylindrical (open ended) surface by extrud-
ing a circular line. For simplicity, the circular line will be created as a sub-zone of a 2-D, 
Tecplot-generated, circular zone.

To do this, perform the following steps:

1. Generate a circular zone by selecting Circular from the Data menu’s Create Zone sub-
menu. The Create Circular Zone dialog appears. Set K to 1 and click Create.

2. Select the Tool’s menu Extrude option. The Extrude dialog appears. Set the Extrusion Dis-
tance to 5, use the defaults for the other fields, then click OK.

3. Answer Yes when asked if you want to create the Z-variable. The result is shown in 
Figure 31-7.

For more information on Extrude, including another example of using Extrude, access Tec-
plot’s Help.

31.1.8. General Text Loader
The General Text Loader add-on allows you to read ASCII text data files in a variety of for-
mats. You can specify variable and data set title information or indicate specific places in your 
data file to read them from. Instruction settings for reading a type of file can be saved and 
restored so they do not have to be entered again each time a new file of the same type is loaded.

The General Text Loader dialog is shown in Figure 31-8. For more information, and to see an 
example using General Text Loader, access Tecplot’s Help.

31.1.9. Prism-Grid
The Prism-Grid dialog is shown in Figure 31-9. The Prism-Grid add-on creates a 3-D volume 
grid from a surface grid defining the bottom of a body of water. (For example, measured points 
defining the bed and banks of a river.) The volume grid, composed of layers of prisms, extends 
from the bottom to the surface. Points in the original surface zone above the specified water 
lever are blanked so they are not used in the definition of the volume grid.

Figure 31-7. An example of using the Extrude Options dialog.
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An example of using Prism-Grid would be to define the bottom of a body of water. Normally 
the data defining the bottom (depth) of the body of water would be read from a file. In this 
example, however, we generate a rectangular zone with a simple parabolic variation of depth.

To do this, perform the following steps:

1. Generate a rectangular zone by selecting Rectangular from the Data menu’s Create Zone 
sub-menu. The Create Rectangular Zone dialog appears. Set XMin to -1, YMin to -1, and 
the I- and J-dimensions to 50. Accept the defaults for the rest of the fields.

2. Create the depth variable with the Specify Equations option from the Data menu’s Alter 
sub-menu. The Specify Equations dialog appears. Use the equation {Depth} = x**2 + 
y**2 - 0.5.

3. Select Prism-Grid from the Tool’s menu. Accept the defaults and click OK.

Figure 31-8. The General Text Loader.

Figure 31-9. The Prism-Grid dialog.
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Sections of the surface which are above the water level (zero) are removed, the rest of the 
surface is triangulated, and the volume between the bottom and the water level is filled with 
ten layers of triangular prisms. The result is shown in Figure 31-10. 

At this point, experimental data, such as water temperatures or velocities, could be interpolated 
to the volume data and iso-surface, slices, or streamtraces could be generated. For more infor-
mation, including macro commands for Prism-Grid, access Tecplot’s Help.

31.1.10. Sort
The Sort dialog is shown in Figure 31-11.The Sort add-on sorts the values of a data set using 

one variable as a key. Further variables can be selected in order to further define how the data 
is sorted. Sort will only work with ordered data. Data may be sorted in either ascending or 
descending order. Also, data may be sorted In Place or To Zone. For more information, includ-
ing macro commands for Sort, access Tecplot’s Help.

31.1.11. Statistics Calculator
The Statistics dialog is shown in Figure 31-12. The Statistics Calculator extends Tecplot’s 
capability to compute simple descriptive statistics. It computes mean, median, variance, stan-

Figure 31-10. An example of using Prism-Grid.

Figure 31-11. The Sort dialog.



Chapter 31. Add-Ons

520

dard deviation, average deviation, geometric mean, and chi square. For more information, 
including macro commands and formulas for Statistics Calculator, access Tecplot’s Help.

31.1.12. Tecplot GUI Builder
Tecplot GUI Builder’s dialog is shown in Figure 31-13.The Tecplot GUI Builder is used to 

generate graphical user interfaces for Tecplot add-ons. You will commonly start with the file, 
gui.lay, which was created by default if you used the Add-On Wizard or CreateNewAd-

Figure 31-12. The Statistics dialog.

Figure 31-13. The Tecplot GUI Builder dialog.



521

31.1. Tecplot Add-Ons

dOn shell scripts to create your add-on. To build an interface, open this layout file in Tecplot 
and add an assortment of controls to modal or modeless dialogs. For more information, access 
Tecplot’s Help.

31.1.13. Tetra-Grid
The Tetra-Grid dialog is shown in Figure 31-14.The Tetra-Grid add-on takes well data and 

generates a tetrahedral mesh. Value-blanking may be used to eliminate wells and/or data points 
within wells.

The following requirements must be met for Tetra-Grid to work:

• The wells must be I-ordered zones.

• There must be at least three wells.

• Each well must contain at least two data points that are not blanked.

The Tetra-Grid dialog contains a list of I-ordered zones in the current data set. Choose the 
zones you want to use and click OK. The tetrahedral zone will be created and added to the end 
of the list of zones. You must activate this zone yourself.

As an example of using Tetra-Grid, say data for five different wells has been collected. Some 
wells have three data points, others have four. The data for each well is assigned to a separate I-
ordered zone in Tecplot.

The input data is:
VARIABLES = "Easting (m)" "Northing (m)" "Elevation (ft)"

ZONE T="41-14-08" I=3, J=1, K=1,F=POINT

 3.437500000E+00 9.375000000E-02 2.819946289E+00

 3.375000000E+00 9.375000000E-02 1.811889648E+00

 3.437500000E+00 9.375000000E-02 8.199462891E-01

ZONE T="41-14-09" I=4, J=1, K=1,F=POINT

 2.687500000E+00 1.796875000E+00 2.212158203E+00

 2.687500000E+00 1.796875000E+00 1.500000000E+00

Figure 31-14. The Tetra-Grid dialog.
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 2.437500000E+00 1.796875000E+00 1.179992676E+00

 2.375000000E+00 1.796875000E+00 1.799926758E-01

ZONE T="41-14-11" I=3, J=1, K=1,F=POINT

 1.875000000E+00 4.000000000E+00 2.509948730E+00

 1.875000000E+00 4.000000000E+00 1.509948730E+00

 1.812500000E+00 4.000000000E+00 5.018920898E-01

ZONE T="41-15-02" I=4, J=1, K=1,F=POINT

 0.000000000E+00 2.375000000E+00 2.089965820E+00

 0.000000000E+00 2.375000000E+00 1.089965820E+00

 0.000000000E+00 2.375000000E+00 5.089965820E-01

 0.000000000E+00 2.375000000E+00 8.996582031E-02

ZONE T="41-15-03" I=3, J=1, K=1,F=POINT

 1.250000000E+00 0.000000000E+00 2.000000000E+00

 1.500000000E+00 0.000000000E+00 1.016113281E+00

 1.250000000E+00 0.000000000E+00 4.687308319E-10

The wells do not have to be vertical or even straight. The resulting plot is shown in 
Figure 31-15. The figure shows the wells before and after running Tetra-Grid. A slice is added 

to the plot with the new tetrahedral mesh to show how you can demonstrate volume properties 
with the new zone. For more information, including macro commands and another example 
using Tetra-Grid, access Tecplot’s Help.

31.1.14. View Binary
The View Binary dialog is shown in Figure 31-16. The ViewBin add-on allows you to view the 
information in a Tecplot binary data (.plt) file.

The ViewBin dialog has the following option:

• Show Raw Data: Select this option to view zone data.

On some machines the font used to display the header information may not be a mono-pitched 
font and consequently some of the results may not line up directly below the table header. For 
more information, access Tecplot’s Help.

Figure 31-15. The original well data (left), tetrahedral zone from the well data (right).
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31.2. Tecplot Utilities
Several utilities are included with the Tecplot distribution. They are discussed in the following 
sections.

31.2.1. Excel Macro
The Excel Macro provides a convenient way to load data directly from your Excel spreadsheet 
into Tecplot. When loaded it adds an option to Excel’s Tools menu called Tecplot, and a tool-
bar containing a button marked Tecplot. Both launch Tecplot and load the data in the high-
lighted region of the spreadsheet. The Excel macro offers many advantages over the Excel 
loader in Tecplot (accessed from the Import option from the File menu).

These include:

• Highlight and Plot: The Excel macro is easier to use than the conventional Excel loader. 
Click in the upper left cell of the region or highlight the entire region, and then click on the 
Tecplot button in the tool bar or on the Tecplot option in Excel’s Tools menu.

• Multiple Zones: The Excel Macro makes loading multiple zones much easier. Highlight 
the entire region and then click on the Tecplot button in the tool bar or on the Tecplot option 
in Excel’s Tools menu. If your zones are separated by blank rows or columns, then the 
macro will load them to Tecplot.

• Formulas: The highlighted region of the spreadsheet can contain formulas, or can be cre-
ated entirely with formulas. The current Excel loader (using the Import option from the File 
menu) does not work where formulas are present.

A Read Me file, located in the Util/Excel directory, further describes installation and use 
of this macro.

As an example, let’s say you have 3-D data obtained by drilling a number of wells and measur-
ing contaminant concentrations of various chemicals at different depths. Your data is in Excel, 
and you want to load the data into Tecplot to get a visual representation of the contamination. 
The data has nine variables and twenty-seven zones, as shown in Figure 31-17.

Figure 31-16. The View Binary dialog.
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Perform the following steps to import your data and visualize the contaminant plumes:

1. Load your Excel data using the new Excel macro. (Accessing this dialog is shown in 
Figure 31-18.) Make sure you have a blank row separating the zones in Excel.

2. Starting with the top left-hand cell, highlight all twenty-seven zones and nine variables, as 
shown in Figure 31-19.

3. Click on Tecplot in Excel’s Tools menu. The menu option launches Tecplot with the 
selected data loaded.

Figure 31-17. The beginning well data in Excel.

Figure 31-18. Accessing the Excel Loader macro via Excel’s menu bar.

Figure 31-19. Highlighting your data in Excel.
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4. Switch to 3D Cartesian plot mode to see the location and measurement depths of the well 
samples. The resulting plot is shown in Figure 31-20. Your wells have different depths, so 

the number of measurements are not the same for each well (there are only three measure-
ments at well five).

31.2.2. Framer
A shareware utility for viewing RasterMetafile animations created by Tecplot. It is described in 
Section 29.5.2, “Raster Metafiles Viewing in Framer,” and Appendix B.1, “Framer.” Framer is 
shown in Figure 31-21.

31.2.3. Lpkview
A utility to catalog, preview or unpack a layout package file into its component data and layout 
files. It is described Section 5.3.3.3, “Layout Package Utility,” and Appendix B.2, “LPKView.” 

Figure 31-20. The Excel well data plotted in Tecplot.

Figure 31-21. The Framer interface.
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31.2.4. Preplot
A utility to convert an ASCII data file into a Tecplot binary file. It is described Section 4.5, 
“ASCII Data File Conversion to Binary,” and Appendix B.3, “Preplot.” 

31.2.5. Rmtoavi
A utility to convert a RasterMetafile animation into an AVI animation. It is described in 
Appendix B.4, “Raster Metafile to AVI (rmtoavi).” 

31.2.6. Pltview
A utility to view the header information for a Tecplot binary file. The Pltview utility is 
shown in Figure 31-22.

31.2.7. Poly-Grid
This utility converts almost-random data into finite-element data. The random data must be 
arranged in non-intersecting polylines where each polyline can have any number of points. It is 
documented in detail in TEC100\util\polygrid\readme.txt.

31.3. Add-on Use
To use these add-ons, you may edit the tecplot.add file (located in the TEC100HOME 
directory), uncommenting the appropriate lines. For example, to use the advqet add-on, find 
the line which reads #$!LoadAddOn "advqet" in the tecplot.add file, remove the # 
sign, then save your changes. When you start Tecplot again, Advanced Quick Edit Tool will be 
an option under the Tools menu.

Finally, there are a number of add-ons related to Amtec’s ADK (Add-on Developer’s Kit). This 
consists of one add-on, GuiBuild, or Tecplot GUI Builder, along with several samples. 
These samples are add-ons which do not load automatically when you first install Tecplot.

If you want to build your own add-ons, you should refer to ADK documentation in the   
<tecplot-home-dir>/adk/doc. If this is not present, you may install the ADK by 
running the Tecplot installation program again, selecting to include the ADK during the instal-
lation.

Figure 31-22. The Pltview utility.
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31.3.1. Add-On Loading
You can customize lists of add-ons to be loaded by different Tecplot users in your network, or 
by a single user starting Tecplot with different commands.

31.3.1.1. Add-Ons Loaded by All Users. In a normal installation of Tecplot, the add-ons 
you want loaded by all users of Tecplot are named in an add-on load file called tec-
plot.add, located in the Tecplot home directory. The only command allowed in a tec-
plot.add file is the $!LoadAddOn command. The following is an example of a typical 
tecplot.add file:

#!MC 1000

$!LoadAddOn "cfdtool"

$!LoadAddOn "streamtool"

31.3.1.2. Secondary Add-On Load File Specification. You may also instruct Tecplot to 
load a different list of add-ons by naming a second add-on load file using one of the following 
methods:

• Include -addonfile addonfilename on the command line.

or

• Set the environment variable TECADDONFILE.

Both of these methods tell Tecplot the name of another add-on load file to process.

31.3.1.3. Add-On on the Command Line Specification. You can also instruct Tecplot 
to load a particular add-on via the command line. The following flags are available:

-loadaddon libname

or
-loadaxaddon activeXname

where

libname

The full name (including path and extension) of a V7Standard add-on 
(the only choice in UNIX).

activeXname

The name of an ActiveX style add-on. (The supplier of the add-on will tell 
you what type it is.)

You may specify the -loadaddon or -loadaxaddon flag as many times as you want on 
the command line.

If your add-on is named with the proper suffix for your platform (.dll for Windows, .sl for 
HP UNIX, and .so for all other UNIX platforms) you can simply name the add-on on the 
command line without using the -loadaddon flag.
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After add-ons are loaded, Tecplot re-processes all command line arguments not processed 
earlier (for graphics and add-on initialization). This ordering allows for a data reader add-on 
(discussed later) to be used to load data specified on the command line.

31.3.2. $!LoadAddOn Command Use
The tecplot.add file is a special macro file that is executed at startup time and contains 
one or more $!LoadAddOn commands to load add-ons into Tecplot. $!LoadAddOn is, in 
fact, the only macro command allowed in a tecplot.add file. The syntax for the 
$!LoadAddOn command is:

$!LoadAddOn "libname" 
  AddOnStyle = addonstyle

where

libname

The name of the shared object library file (see below). This must be in 
quotes.

addonstyle

The add-on style. This can be either V7Standard or V7ActiveX. 
V7Standard is the default.

Special rules govern how libname name is specified. In all cases the filename extension is 
omitted. If you assign libname to just the base name of the shared object library, then Tecplot 
will do the following:

• UNIX: The shared library to load will come from the file specified by:

-  Tecplot-Home-Directory/lib/lib+basename+platform-specific-extension

where platform-specific-extension is .sl for HP platforms and .so for all others.

• Windows: If the add-on is of type V7Standard and just the base name is supplied, the 
add-on basename.dll will be searched for in the following directories (in this order):

- The directory where the Tecplot executable resides.

- The Windows system directories.

- The directories in your PATH environment variable.

If an absolute path name is used in libname, then in Windows, .dll is appended and in UNIX 
.so or .sl is appended. 

On Windows using V7ActiveX style add-on libraries, Tecplot connects to the add-on via the 
libname entry in the registry.
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APPENDIX A Command Line 
Options

A.1. Tecplot Command Line
The general form of the Tecplot command line is:

tecplot [options] [layoutfile] [datafiles] [macrofile] 

where options is one or more of the following:

-addonfile filename Load add-ons listed in filename.

-b Run Tecplot in batch mode (-p option is also required).

-c cfgfile Use cfgfile for the configuration set up instead of the default 
configuration file. 

-d or -display computername Displays Tecplot on computer computername (UNIX only). 
The computer, computername, must have X-server capability 
with the GLX extension.

-datasetreader readername Instruct Tecplot to use the data set reader readername when 
loading data files specified on the command line. See Section 
A.7, “Specifying Data Set Readers on the Command Line,” 
for details.

-debug dbugfile Send debug information to the file dbugfile. Information is 
displayed to aid in debugging a new Tecplot configuration 
file, macro file, or binary data file. You may specify the minus 
sign (“-”) for dbugfile to send the debug output to the “stan-
dard output.” 

-demo Run Tecplot in demo mode (only reads demo files).

-develop Launch Tecplot in a mode used to develop add-ons (UNIX 
only).

-f fontfile Use fontfile for the font file instead of the default font file 
tecplot.fnt. 

-h homedir Use homedir for the Tecplot home directory instead of the 
default home directory or the directory stored in the operating 
system environment variable TEC100HOME. (See the Tecplot 
Installation Notes.)
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In the command line, data files is one or more data files. These files are assigned to the first 
data set. You can also give the name of a layout file (typically having a “.lay” extension). 
Tecplot processes the layout immediately upon starting up. If both a layout file and data files 
appear on the command line, Tecplot substitutes the data files from the command line for the 
data files referenced in the layout file. When you read in a layout package file (“.lpk”) you 
will not get this behavior.

A.2. Using the Command Line in Windows
Most of the Tecplot command line options are available in Windows. To use them, you should 
start Tecplot from the Run command. In Windows the Run command is launched from the 
Start button. Under Windows you may also use the command line from the DOS prompt (oth-
erwise known as the command prompt).

-loadaddon "addonname" Load add-on addonname.

-loadaxaddon "axaddonname" Load Active-X add-on axaddonname (Windows only).

-m cmapfile Select initial color map file to load.

-n List node information (UNIX only).

-nobatchlog Suppress creation of the file batch.log during batch mode 
operation.

-nostdaddons Do not load add-ons in tecplot.add.

-p macfile Play the macro in the file macfile. Note that if your macro file 
has an .mcr extension you do not need to use -p. 

-q Use quick playback mode. Ignores delay and pause com-
mands. 

-qm quickpanelfile Load macro functions for the Quick Macro Panel from quick-
panelfile instead of the default file tecplot.mcr.

-r prtfile Set the default file name for routing Print Files to prtfile. This 
name can be reassigned interactively while running Tecplot.

-s stylfile Use stylfile as a stylesheet for the first Tecplot frame.

-showpanel Show the Quick Macro Panel immediately when Tecplot 
starts up.

-v Print version number of Tecplot.

-x Run Tecplot full screen.

-y exportfile Same as -r except for exported files. 
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A.3. Using Command Line Options in Windows 
Shortcuts

All of the command line options that can be entered at the DOS or Command prompt by using 
the Run command can also be used in a Windows shortcut.

A.3.1. Creating Shortcuts
If you frequently run Tecplot using the same command line flags, it may be useful to create a 
shortcut on your Windows desktop that launches Tecplot with the desired command line flags. 
Here’s how this can be done:

1. Right click in any blank space on your Windows desktop. A drop-down appears.

2. Select New.

3. Select Shortcut from the next drop-down that appears.

4. The “Create Shortcut” dialog will appear (Figure A-1).

Type the location of the Tecplot executable, along with any command flags you want to spec-
ify. You can also click Browse if you are not sure where Tecplot is located. An example 
command line is:

“C:\Program Files\TEC100\BIN\Tecplot.exe” -p C:\Me\mymacro.mcr

5. Click Next.

6. Select a name for your shortcut, then click on Finish. An example name would be:

 

Figure A-1. The Create Shortcut dialog in Windows.
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Run my Macro

A new shortcut icon will be placed on your Windows desktop. To run Tecplot using the 
command line options you specified, simply double-click on the new shortcut icon.

A.3.2. Changing Shortcuts

You can alter an existing shortcut by doing the following:

1. Right-click on the shortcut icon you want to change.

2. Select Properties from the drop-down.

3. On the Shortcut page (Figure A-2), modify the command line by changing the setting for 
Target. To change the working directory that Tecplot runs under, change the Start in loca-
tion.

A.4. Additional Command Line Options in Motif
Under UNIX, you can use additional command line flags which are passed to the window man-
ager to control how the application window is displayed. These include -geometry (for 
specifying the location and position of the application window), -fg and -bg (for specifying 
foreground and background window colors), and others. See the X11 reference for your system 
for complete details on these options.

 

Figure A-2. The Shortcut page in Windows.
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A.5. Overriding the Data Sets in Layouts by Using "+" on the Command Line

A.5. Overriding the Data Sets in Layouts by Using "+" on 
the Command Line

This section describes how to load an alternate data set into a layout using the command line. A 
method for overriding the layout data set interactively, in the Open Layout dialog, is described 
in Section 5.1.2, “Loading Data from Other Software Packages.” 

When loading a layout from the command line, you may override the data files used in that 
layout by specifying them on the command line after the layout file name. For example:

 tecplot amt.lay t4.plt

This loads the amt.lay layout with the t4.plt data file instead of the data file specified in 
amt.lay.

If amt.lay had more than one data set associated with it, t4.plt would replace the first 
data set. If you wanted to replace multiple data sets, specify each file on the command line like 
so:

  tecplot amt.lay t4-1.plt t4-2.plt t4-3.plt

This will use t4-1.plt as the first data set, t4-2.plt as the second, etc.

If amt.lay's first data set had more than one data file associated with it, t4-1.plt would 
replace all data files in the first data set. If you wanted to specify more than one data file for the 
data set, you can use the + to specify they are all part of the first data set like so:

tecplot amt.lay t4-1.plt+t4-2.plt+t4-3.plt

In this case, t4-1.plt, t4-2.plt, and t4-3.plt are all combined into one data set that 
replaces the first data set of amt.lay.

You can combine both multiple data sets and multiple files per data set like so:

tecplot amt.lay ds1a.plt+ds1b.plt ds2.plt ds3a.plt+ds3b.plt

In this case, the files ds1a.plt and ds1b.plt are combined and replace the first data set, 
ds2.plt replaces the second data set, and ds3a.plt and ds3b.plt are combined to 
replace the third data set in amt.lay.

If you do not know which data set to substitute in your layout, look at the top of the layout file. 
It will look something like this:

#!MC 1000

$!VarSet |LFDSFN1| = ’temp.plt’

$!VarSet |LFDSFN2| = ’chem.plt’

$!VarSet |LFDSFN3| = ’pos.plt’

So you can, for example, replace chem.plt with chem1.plt and chem2.plt using the 
following command line:
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tecplot amt.lay temp.plt chem1.plt+chem2.plt pos.plt

A.6. Tecplot Command Line Examples 
To run Tecplot without pre-loading any data files, use:

tecplot

To run Tecplot loading the data file ex1.plt as the first data set, use:

tecplot ex1.plt

To run Tecplot loading the data files ex1.plt, ex2.plt, and ex3.plt as the first data set, 
use:

tecplot ex1.plt ex2.plt ex3.plt

To run Tecplot using /usr/myhome as the Tecplot home directory and loading the Tecplot 
configuration file /usr/myhome/myset.cfg, use:

tecplot -h /usr/myhome -c /usr/myhome/myset.cfg

To read a Tecplot layout file sumtr1.lay, you would use:

tecplot sumtr1.lay

To read a Tecplot layout file calc.lay and replace the first data set referenced in the layout 
file with the data file temp.plt, you would use:

tecplot calc.lay temp.plt

For example, suppose the layout file t.lay has two frames. The two frames reference differ-
ent data sets. Suppose you want to start Tecplot, load this layout file, and have frame one use 
the data set defined in a.plt and have frame two use the data set defined by loading in 
b.plt and c.plt together. You can do this with the following command:

tecplot t.lay a.plt b.plt+c.plt

In UNIX, to determine the path or alias that the tecplot command calls, you would use:

which tecplot

A.7. Specifying Data Set Readers on the Command Line
Special care should be taken when using the -datasetreader option on the command line. 
The following rules apply if -datasetreader is used:

1. The -datasetreader flag must be followed by the data set reader name and then 
immediately followed by a space separated list of commands to be passed on to the data set 
reader. No further Tecplot options are allowed after this point.

2. The data set reader name must be placed in quotes if it contains spaces.

3. Only one data set reader can be specified on the command line.
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A.7. Specifying Data Set Readers on the Command Line

4. If a layout file is also specified (prior to -datasetreader) then you can only override 
the first data set load instructions referenced in the layout file.

Following is an example:

Suppose you have a layout file (mylayout.lay) that uses the PLOT3D loader. To launch 
Tecplot via the command line and override the PLOT3D load instructions use:

   tecplot mylayout.lay -datasetreader "plot3d loader" -ISET 1,,5 -b -
3DW -GF blunt.g

Everything from the -ISET parameter and following are instructions to be sent to the 
PLOT3D loader. Note that the instructions themselves are not entirely contained within any 
quotes. If your data reader requires instructions that themselves contain spaces then you must 
surround those instructions with quotes.
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B.1. Framer

APPENDIX B Utility Command Line 
Options

B.1. Framer
To launch Framer at a command line (shell prompt, Run command, and so forth), use the fol-
lowing command: 

framer [options]  [rmfile] 

where [rmfile] is the name of a file containing Raster Metafile bitmaps created by Tecplot, and 
[options] is one or more of the following:

-b [nf] Use buffered mode. Framer reads nf frames into memory and 
displays only those frames. Frames not read are not displayed. 
This mode displays images much faster, but requires extra mem-
ory. If nf is not specified, Framer reads as many frames as possi-
ble up to the total limit on frames (see -max parameter).

-c nc Use no more than nc colors (X-Windows only). On some 
machines, you may need to use “-c 128” to allow two copies 
of Framer to run at the same time.

-cycle nn Start Framer in “cycle” mode (as if C were pressed), and con-
tinue for nn complete cycles (unless interrupted by user input), 
and then exit.

-d dfile Send debug information to dfile. Use “-d2,” “-d3,” “-d4,”, 
etc., for more detailed debug information.

-f start,end,skip Display frames starting with frame number start and ending 
with frame number end, skipping by skip frames.

-g Use gray scale for image instead of color.

-help Print help information.

-loop nn Start Framer in “loop” mode (as if L were pressed), and con-
tinue for nn complete loops (unless interrupted by user input), 
and then exit.

-m Allow for multiple color maps. Without this flag, Framer 
assumes the first color map in the Raster Metafile is valid for all 
images in that file.
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If you do not specify a file name, Framer prompts you for one. You can choose to set buffering 
(equivalent to the -b flag) and/or multiple color maps (equivalent to the -m flag).

While Framer is running, you can press the following keys to control it:

Under Windows, these Framer commands are also available from the Go and Step menus.

B.2. LPKView
Following is a description of the utility’s syntax. Brackets ([]) surround optional parameters 
and the vertical bar (|) separates one mutually exclusive set of options from another:

    lpkview [[-t] | [-ild] | [[-c <preview command>] -p]] filename

-max nn Specify upper limit on total number of images in the Raster 
Metafile. The default value is 512.

-noinfo Do not print initial copyright notice, help info, or count of buff-
ered frames.

-p ms Pause at least ms milliseconds between each frame. This does 
not affect the rate of the single frame keys (+ and -). 

-w wc Width correction. (Use “-w -1” for Tecplot Version 4 images.)

-x Run full screen.

B Move backward through frames (or left mouse button).

C Cycle forward and backward through frames.

F Move forward through frames (or middle mouse button on a three-button 
mouse or right mouse button on a two button mouse).

L Loop repeatedly forward through frames.

Q Quit Framer (or right mouse button on three button mouse) or Escape key.

S Stop cycling or looping (or spacebar).

R Redraw the current frame.

1 Move to the first frame.

+ Move forward one frame.

- Move backward one frame.

< Increase the minimum delay between frames by 50 milliseconds. This 
decreases the speed at which frames are displayed.

> Decrease the minimum delay between frames by 50 milliseconds. This 
increases the speed at which frames are displayed.
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B.2. LPKView

where the options are described as follows:

Option -t may not be used with any other options and options -i, -l, and -d may not be 
used with options -c and -p. If no command line options are specified -i, -l, and -d are 
assumed by default.

Note: Under UNIX, if the -p option is specified without specifying a preview command, -c, 
the following default preview command is used:

        $MOZILLA_HOME/netscape -remote "OpenURL(%s)"

where %s is substituted by lpkview with the file name of the temporarily extracted preview 
image. The default command assumes that the environment variable $MOZILLA_HOME is set, 
Netscape is installed under $MOZILLA_HOME, and that lpkview has been added to 
Netscape as a helper application.

To add lpkview as a helper application bring up Netscape’s Preferences dialog. This is 
usually accomplished by selecting Preferences from Netscape’s Edit menu. Within the Prefer-
ences dialog locate and select the Applications page. Within the Applications page select New 
and add lpkview as a new helper application by entering the following information:

Description:<optionally leave this blank>

MIMEType: application/x-tecplot-lpk

Suffixes: lpk

Handled By: <select "Application">

Application: $TEC90HOME/bin/lpkview -p %s

Assuming that you have correctly set the $TEC90HOME environment variable, if you browse 
with Netscape and click on a layout package file, it will run lpkview as a helper application 
and display the preview image in your browser.

If you choose to specify your own preview command, there are several requirements:

• The path to the preview command must be fully specified.

• If relative, it must be located in one of the directories specified in your $PATH environment 
variable

-t Show table of contents.

-i Extract image (for example, a Portable Network Graphics or .png format).

-l Extract layout.

-d Extract data.

-c (UNIX only) Specify preview command.

-p (UNIX only) Preview image.
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• The command must contain a %s that can be substituted by lpkview with the file name of 
the temporarily extracted preview image.

For example, if you wanted the preview command to be the UNIX file utility. Then, running 
the following command:

        lpkview -c "file %s" -p myplot.lpk

might produce the following output:

        /var/tmp/aaaa005L7:    data

Where file /var/tmp/aaaa005L7 is the temporarily extracted preview image. The tempo-
rary file is removed as soon as the preview command completes.

B.3. Preplot
The following options are used with standard Tecplot data files:

-d Turn on debug echo. Use -d2, -d3, -d4 for more detailed debug informa-
tion.

-r Reverse the bytes of the output binary data file (generally not required).

-iset [zone], [start], [end], [skip]

Create the binary data file using only the specified range and skipping for the 
I-index. The arguments are optional, but the commas are not. The zone parame-
ter specifies which zone this option affects; if not specified, all zones are 
affected. The start parameter is the starting I-index; the default is one. The end 
parameter is the ending I-index; the default is the last index value. The skip 
parameter specifies the I-interval, that is, the distance between indices; one 
means every index is used, two means every other index, and so on. 

For example, -iset 1, 3, 7, 2 indicates that for zone 1 only I-index val-
ues of 3, 5, and 7 are used. Only one -iset option is allowed per zone.

-jset [zone], [start], [end], [skip]

Same as -iset above, except with respect to the J-index.

-kset [zone], [start], [end], [skip]

Same as -iset above, except with respect to the K-index.

-zonelist start[:end[:skip]], ...

Specify the zones to process. You may supply more than one specification. By 
default Preplot processes all zones.
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B.4. Raster Metafile to AVI (rmtoavi)

The following options are used with PLOT3D data files:

B.4. Raster Metafile to AVI (rmtoavi)
The rmtoavi utility will convert a Raster Metafile animation to an AVI animation. The fol-
lowing is a description of the utility’s syntax. Brackets ([]) surround optional parameters. 
Options must be specified separately.

  rmtoavi [options] filename[.rm] [outputfilename]

Filename is the name of the Raster Metafile to convert. Only one file name may be specified. 
The input file must end with the.rm extension.

The [outputfilename] is the name of the converted output AVI file. If the output file name is 
not specified, the input file name is used with an.avi extension. If any of the file names 
contain spaces, they must be enclosed in quotes.

For example, the command rmtoavi test.rm will create the file test.avi. If the 
output file exists, rmtoavi will prompt to overwrite it unless the -y option is used (see 
below).

-d Turn on debug echo. Use -d2, -d3, -d4 for more detailed debug informa-
tion.

-r Reverse the bytes of the output binary data file (generally not required).

-plot3d Input file is in PLOT3D format. This flag is required for PLOT3D data.

-b Input file is binary.

-f Input file is binary-FORTRAN, that is, there are record markers.

-foreign Reverse bytes of input file.

-function The .q file is a .f file.

-functionandq There are both .f and .q files present.

-gridonly Read grid variables only.

-i Input file includes PLOT3D IBLANK variable.

-m Input file is multi-grid (usually more than one grid block).

-ip ilist Extract planes of constant i for all i in ilist. (Requires 3-D whole data.)

-jp jlist Extract planes of constant j for all j in jlist. (Requires 3-D whole data.)

-kp klist Extract planes of constant k for all k in klist. (Requires 3-D whole data.)

-1d Input PLOT3D file is 1-D.

-2d Input PLOT3D file is 2-D.

-3dp Input PLOT3D file is 3-D planar.

-3dw Input PLOT3D file is 3-D whole.
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The [options] are described as follows

-help Prints help information.

-q Suppress startup banner and information message.

-y Suppress query to overwrite an existing AVI file.

-d [nn] Progress indicator. This prints a dot (.) every [nn] 
frames processed. If [nn] is not specified, it defaults to 
ten.

-m Use multiple color palettes in the converted AVI file. 
Each frame of an AVI or Raster Metafile animation is lim-
ited to 256 colors. AVI animations can use either one set 
of 256 colors for the entire animation or a separate set of 
256 colors for each frame. If you use the  -m option, then 
each frame of the output AVI file will use a separate set of 
256 colors. Since color information is read from the input 
Raster Metafile, this option only affects the output AVI 
animation if the Raster Metafile was originally exported 
using multiple color palettes. 

-speed nn Sets the speed of the output AVI file to nn frames per sec-
ond. The default is ten.
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C.1. Extended Mouse Operations

APPENDIX C Mouse and Keyboard 
Operations

C.1. Extended Mouse Operations
The middle and right mouse buttons are powerful tools you may use to immediately zoom and 
translate your data without having to switch to the Zoom or Translate tools on the sidebar. This 
advanced mouse/keyboard functionality is available when using any 3D rotate, Contour, 
Geometry (except Polyline), Probe, Slice, Streamtrace Placement, Translate, Zoom, or Zone 
Creation tools. If you have a two button mouse use the Ctrl key in conjunction with the right 
mouse button to achieve middle mouse button capabilities.

The following table lists all of the capabilities of the middle and right mouse buttons.

Action Middle Button/Ctrl-Right Button Right Button

Click Redraw. If the pointer is in the current 
frame then the current frame is redrawn. 

Otherwise, redraw all frames.a

a. This is the default action for a click. It may be configured with the                                      
$!INTERFACE MOUSEACTIONS {MIDDLEBUTTON... command.

Switch from the current tool to the 

Selector.b

b. This is the default action for a click. It may be configured with the                                      
$!INTERFACE MOUSEACTIONS {RIGHTBUTTON... command.

Drag Smoothly zoom in or out. An upward 
motion zooms out. A downward motion 
zooms in.

Translate.

Alt-Drag In 3D Cartesian plots, move the viewer 
further from (upward motion) or closer to 
(downward motion) the object. In all 
other plot types, this behaves like the 
Drag action

Same as the Drag action.
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C.2. Mouse Tool Operations
The following tables contain all mouse/keyboard operations you may use with the various side-
bar tools. All mouse button operations utilize the left button.

3D Rotate tools: 

Contour Add tool: 

Contour Remove tool: 

Geometry Polyline tool: 

Drag Rotate about the defined rotation origin with your current Rotate tool.

Alt-Drag Rotate about the viewer position using your current Rotate tool.

C Move rotation origin to probed point, ignoring zones.

O Move rotation origin to probed point of data.

R Rollerball rotation.

S Spherical rotation.

T Twist rotation.

X X-axis rotation.

Y Y-axis rotation.

Z Z-axis rotation.

Alt-Click Place a contour line by probing on a streamtrace, slice, or iso-surface.

Click Place a contour line.

Ctrl-Click Replace the nearest contour line with a new line.

Drag Move the new contour line.

- Switch to the Contour Remove tool.

Click Removes the contour line nearest to the probed location.

+ Switch to Contour Add tool if you are using Contour Remove.

A Allow translation of polyline segments in all directions.

H Restrict translation of current polyline segment to horizontal.

U Pen up, while drawing polyline.

V Restrict translation of current polyline segment to vertical.
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Probe tools.

Slice tools: 

Click If the pointer is over a valid cell return the interpolated 
field values from all nodes in the cell. If multiple cells are 
candidates then, for 2D Cartesian plots the cell from the 
highest number zone is used and for 3D Cartesian plots 
the cell closest to the viewer is used.

Ctrl-Click If the pointer is over a valid cell return the field values from 
the nearest node in the cell. If multiple cells are candidates 
then, for 2D Cartesian plots the cell from the highest 
number zone is used and for 3D Cartesian plots the cell 
closest to the viewer is used. If the pointer is not over any 
cell then the field values from nearest data point as mea-
sured in distance on the screen are returned.

Shift-Ctrl-Click Return the field values from the nearest point on the screen 
ignoring surfaces and regardless of zone number or depth 
of the point. This is useful in 3-D for probing on data points 
that are on the back side of a closed surface without having 
to rotate the object. In 2-D this is useful for probing on data 
points for zones that may be underneath other zones 
because of the order in which they were drawn.

Alt-Click Same as Click except ignore zones while probing. (Probe 
only on streamtraces, iso-surfaces, or slices.)

Alt-Ctrl-Click Same as Ctrl-Click except ignore zones while probing. 
(Probe only on streamtraces, iso-surfaces, or slices.)

Alt-Ctrl-Shift-Click Same as Shift-Ctrl-Click except ignore zones while prob-
ing. (Probe only on streamtraces, iso-surfaces, or slices.)

T, R
X, Y

When probing, press R or T on your keyboard to switch 
dependencies in Polar Line or X or Y in XY Line.

+ Turn on the start slice if no slices are active, or turn on 
the end slice if slices are already active.

- Turn off the end slice if the end slice is active, or turn 
off the start slice if the end slice is not active.

Click Place a start slice.

Drag Move the start slice.
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Streamtrace Placement tools (3D Cartesian plots only): 

Translate/Magnify tool: 

Alt-click/Alt-drag Determine the XYZ-location by ignoring zones and 
looking only at derived volume objects (streamtraces, 
slices, iso-surfaces, slices).

Shift-click Place the end slice.

Shift-drag Move the end slice.

I, J, K (ordered 
zones only)

Switch to slicing constant I-, J-, or K-planes respec-
tively.

X, Y, Z Switch to slicing constant X-, Y-, or Z-planes respec-
tively.

0-9 Numbers one through nine activate intermediate slices 
and set the number of intermediate slices to the number 
entered; zero turns off intermediate slices.

D Switch to streamrods.

R Switch to streamribbons.

S Switch to surface lines.

V Switch to volume lines.

1-9 Change the number of streamtraces to be added when placing a rake of 
streamtraces.

Drag Translate the data.

Shift-Drag Translate the paper.

- If the drag was started with Shift, this will reduce the magnification 
of the paper. Otherwise, this will reduce the magnification of the 
data.

+ If the drag was started with Shift, this will increase the magnification 
of the paper. Otherwise, this will increase the magnification of the 
data.

- drag Decrease magnification on the paper.

+ drag Increase magnification on the paper.
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C.3. Picked Object Options

Zoom tool: 

C.3. Picked Object Options

C.4. Other Keyboard Operations 

Click Center the zoom around the location of your click.

- Reduce the size of the object. If multiple objects are selected, 
all object positions will be shifted towards the first object 
selected.

- Increase the size of the object. If multiple objects are 
selected, all object positions will be shifted away from the 
first object selected.

Del Delete picked object(s).

Ctrl-C Copy picked object(s) to the clipboard.

Ctrl-V Paste picked object(s) from the clipboard.

Ctrl-X Cut picked object(s).

Ctrl-A Paste stored frame view to current frame.

Ctrl-C Copy selected objects to paste buffer.

Ctrl-D Redraw all frames.

Ctrl-F Fit current image to full size.

Ctrl-L Restore last frame view.

Ctrl-O Open layout.

Ctrl-P Print.

Ctrl-Q Exit Tecplot.

Ctrl-R Redraw the current frame.

Ctrl-S Save current layout.

Ctrl-U Call up the Publish dialog to control Web publishing.

Ctrl-W Save current layout as a specified file.
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APPENDIX D Glossary

The following terms are used throughout the Tecplot User’s Manual and are included here for 
your information.

2-D

Plotting in two dimensions. Line plots of one or more variables (XY and Polar Line plots) are 
not considered 2-D.

2-D Cartesian Plot

A plot of some variable by location on a single plane using two axes.

3-D

Plotting in three dimensions. Three-dimensional plotting can be subdivided into 3-D surface 
and 3-D volume.

3-D Cartesian Plot

A plot displaying a 3-D scattering of points, surfaces, or volumes using three axes.

3-D Sorting

The process by which Tecplot determines which surface to plot first. The various cells are 
sorted relative to the viewer and then plotted from farthest away to closest.

3-D Surface

Three-dimensional plotting confined to a surface. For example, the surface of a wing.

3-D Volume

Three-dimensional plotting of data that includes interior data points of a volume, as well as 
those on the surface. For example, the vector field around a wing.

Active Zone

A zone that is activated in the Zone Style dialog.

Antialiasing

In computer graphics, the process of removing or reducing the jagged distortions in curves and 
diagonal lines so that the lines appear smooth or smoother.

ASCII Data File

A data file composed of human-readable statements and numbers using ASCII characters.
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Aspect Ratio

The ratio of lengths of the sides of an object. In the 3D Cartesian plot type, the ratio is that of 
the longest side to the shortest side.

Auxiliary Data

Metadata attached to zones, data sets, and frames.

Banded Contour Flooding

A field plot where the surface between contour lines is filled with a constant color.

Binary Data File

A data file composed of machine-readable data. This type of file is created by converting 
ASCII data files with Preplot, or by directly creating them from an application.

Blanking

A feature of Tecplot that excludes certain cells and points from a plot. There are three types of 
blanking: value-blanked, IJK-blanking, and depth-blanking.

Block

A data file format in which the data is listed by variable. All the point values of the first 
variable are listed first, then all the point values of the second variable, and so forth.

Boundary

A 2- or 3-D field plot option. Plotting the boundary of a zone plots the connection of all outer 
lines (IJ-ordered zones), finite-element surface zones, or planes (IJK-ordered zones).

Boundary Cell Faces

A set of un-blanked cell faces in a 3-D volume zone which have only one neighboring volume 
cell. In contrast, interior cell faces have two neighboring volume cells, one on either side, 
which share the face. For an IJK-ordered zone the boundary cell faces are on the exterior of 
the zone. That is, the first and last I-planes, the first and last J-plans, and the first and last K-
planes. For a finite-element 3-D volume zone, boundary cell faces are on the exterior of the 
zone and the surface of any voids within the zone.

Bounding Box of Data

The smallest rectangular box, aligned with the coordinate axes, which completely encloses all 
data points.

Brick

An element type of finite-element volume data composed of eight node points arranged in a 
hexahedron-like format. This element type is used in 3-D volume plotting.
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Carpet Plot

A 3-D surface plot formed by a 3-D plot where the variable is plotted in the third dimension 
and is singular-valued with respect to the independent variables.

Case Insensitive

Text that may be in upper- or lowercase letters.

Cell

Either an element of finite-element data, or the space contained by one increment of each 
index of IJ- or IJK-ordered data.

Cell-Centered Values

Values located at the center of the cell (assumed to be the centroid).

Color Map

A color spectrum used to plot contour flooding and multi-colored objects.

Color Map File

A file that contains a description of a color map.

Connectivity List

The second portion of a finite-element data file where the relationships between points are 
given to define elements. Cells of the appropriate element type are defined by listing the node 
point indices. The number of node points per cell is determined by the element type.

Continuous Contour Flooding

A field plot where a color is assigned to each point in a mesh, based upon the contour variable 
and the color map. Each face is filled with colors interpolated between the corner nodes. This 
results in a smooth variation of color over the surface.

Contour

A field plot type that plots iso-valued lines, or color flooding based on the values of a 
specified variable.

Curve Type

The function used to fit the data points in an XY-plot.

Custom Labels

Text strings contained within a data file or text geometry file which define labels for your 
axes or contour table. You may select Custom Labels anywhere you can choose a number 
format, the result is the text strings in place of numbers.

Cutaway Plot

A 3-D volume plot where a portion of a 3-D volume zone is cut-away by blanking to reveal 
the interior.
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Cutting Plane

A planar surface used to slice 3-D volume or surface zones.

Data File

A file that contains data used for plotting in Tecplot.

Data Format

The type of zone data as specified by the format parameter in a Tecplot data file, such as: 
BLOCK, POINT, FEBLOCK, or FEPOINT.

Data Loader

A Tecplot add-on which allows you to read non-Tecplot data files.

Data Point

An XYZ-point at which field variables are defined.

Data Set

A set of one or more zones. A data set may be plotted in one or more frames, however, a 
single frame may only plot one data set. A data set may be created by loading one or more 
data files.

Dependent

An axis mode requiring the axes to maintain a fixed ratio to one another.

Depth

For image export, the number of bits stored per pixel. For depth-blanking, the component of 
distance from the viewer position in a screen normal coordinate system.

Depth-Blanking

A blanking option which excludes cells in a 3-D plot, based upon their depth into the image. 
Cells closer than a plane of a certain depth, as well as cells further than a plane of another 
depth, may be blanked.

Derived Volume Objects

Graphic objects which are visible in the plot and created from zone data, but are not zones. 
Examples include iso-surfaces, 3-D slices, and streamtraces.

Display List

A group of OpenGL commands that have been stored for subsequent execution. Using display 
lists can, depending upon the hardware involved, dramatically speed up graphics rendering. 
Using display lists also requires more memory.
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Draw Level

A draw behavior setting for modifying the image quality and rendering speed during various 
operations, such as rotation. Options vary from Trace, a simplified wire-frame mesh which is 
rendered quickly, to Full.

Element Type

The form of individual elements in a finite-element zone. There are four types: Triangle and 
Quadrilateral (finite-element surface types), and Tetrahedron and Brick (finite-element 
volume types). The element type of a zone determines the number of nodes per element and 
their orientation within an element.

Exposed Cell Faces

The set of those cell faces in 3-D volume zones that have only one un-blanked neighboring 
volume cell. By comparison, interior cell faces have two neighboring cells, one on either side, 
which share the face. The exposed cell faces include boundary cell faces and interior cell 
faces exposed by blanking. (One of the neighboring cells has been blanked.)

Extended Curve-Fit

A Tecplot add-on which extends Tecplot’s XY-plot curve-fitting capabilities.

Extra 3D Sorting

Perform extra work to resolve hidden surface problems encountered during 3-D sorting.

FE

An abbreviation for finite-element, a common means of arranging data for calculations. 
(Often referred to as “unstructured.”)

FEBLOCK

A data file format for finite-element zones in which the node data is listed by variable. All the 
node values of the first variables are listed first, then the node values of the second variable, 
and so forth. This section is followed by a connectivity list.

Fence Plot

A plot of planes of a 3-D data field.

FEPOINT

A data file format for finite-element zones in which the node data is listed by point-by-point. 
All the variable values of the first point are listed first, then the variable values of the second 
point, and so forth. This section is followed by a connectivity list.

FE Surface

A finite-element zone of the element type Triangle or Quadrilateral. These zones are used for 
2- and 3-D surface plots.
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FE Volume

A finite-element zone of the element type Tetrahedron or Brick. These zones are used for 3-D 
volume plots.

Field Plot

Includes 2D Cartesian and 3D Cartesian plot types. Generally used to display the spacial 
relationship of data. Mesh, Contour, Vector, Scatter and Shade are all considered field plots. 
XY and Polar Line plots and the Sketch plot type are not field plots.

File Path

An option which specifies the directory for Tecplot to search for a given type of file. For 
instance, a linked layout saved with absolute file path contains the complete directory 
structure to load the associated file.

Finite-Element

A type of data point ordering. Data is arranged by listing the data points (called nodes), and 
then listing their relationships (called elements). The element type of the zone determines the 
number of nodes which are contained in each element, as well as the exact relationship of 
nodes within an element. There are four different element types supported by Tecplot: 
triangle, quadrilateral, tetrahedron and brick.

Font Modifier

The modifier used to embed Greek, Math, or User-Defined characters in a text string.

Frame

Boxed areas within the workspace where sketches and plots are created.

Geometry

An arrangement of objects or parts that suggests geometric figures.

Grid Area

One or more rectangular regions defined and bounded by the grid axes.

Grid Axes

An axis option which displays the coordinates of the grid along the various spatial dimensions.

Gridline

A set of lines drawn from one or more axes that extend from the tick marks on an axis across 
the grid area.

Grid Point

In 2-D, the intersection of gridlines.
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I-Ordered

A type of data point ordering where each point is listed one at a time (that is, by one index). 
Used mainly in XY-plots. In 2- or 3-D, this type of data point ordering is sometimes called 
irregular, and is only useful for scatter plots, or for interpolating or triangulating into 2-D, 3-D 
surface, or 3-D volume zones. (This type of data can also be used for 2- or 3-D vector plots if 
streamtraces are not required.)

IJ-Ordered

A type of data point ordering where the points are arranged in a 2-D array. used for 2-D and 
3-D surface plotting.

IJK-Blanking

A feature to include or exclude portions of an IJK-ordered zone based on index ranges.

IJK-Ordered

A type of data ordering where the points are arranged in a 3-D array. Used for 3-D volume 
plotting as well as 2-D and 3-D surface plotting.

Image Format

Any of the raster or bit-mapped graphic formats supported by Tecplot.

Inactive Zone

A zone loaded into Tecplot which does not appear in the plot. A zone can be deactivated 
using the Zone Show option on any page of the Zone Style dialog.

Independent

Axis mode allowing each axis to have a range that is not affected by the ranges of other axis 
or axes.

Interpolate

To assign new values for the variables at data points in one zone based on the data point 
values in another zone (or set of zones).

Internal Macro Variable

A read-only macro variable which allows you to access certain key values in Tecplot. For 
example, $NUMVARS gives the number of variables.

I-Plane

In an ordered zone, the connected surface of all points with a constant I-index. In reality, I-
planes may be cylinders, spheres, or any other shape.

Irregular Data

Points which have no order, or at least no order which can be easily converted to IJ- or IJK-
ordering.
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Iso-Surface

A surface within a 3-D zone where the contour variable has a constant value at all locations.

Journal

Place where data manipulation/creation/deletion instructions are logged.

JPEG

Joint Photographic Experts Group (development group for lossy compressed 24 bit color 
image storage format; also a file extension).

J-Plane

In an ordered zone, the connected surface of all points with a constant J-index. In reality, J-
planes may be cylinders, spheres, or any other shape.

K-Plane

In an IJK-ordered zone, the connected surface of all points with a constant K-index. In reality, 
K-planes may be cylinders, spheres, or any other shape.

Layout File

A specialized macro file which preserves a plot created within Tecplot. When the layout is 
opened, it restores Tecplot to the state it was in when the layout file was saved.

Layout Package File

A binary layout file with the data embedded.

Line Map

A set of points from a single zone where one variable is assigned to an X-axis and another is 
assigned to a Y-axis. You can define many XY-maps for an XY-plot.

Macro

A file containing a list of instructions, called macro commands, which can duplicate virtually 
any action performed in Tecplot.

Macro Command

An instruction given to Tecplot in a macro file. Macro commands always start with a dollar 
sign and then an exclamation mark. For example, $!Redraw refreshes a plot view.

Macro File

A file which contains a series of macro commands. Macro files are run from the command 
line, or through the Run option of the Macro sub-menu of the File menu.

Macro Function

A self-contained macro sub-routine that can be called.
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Macro Variable

A holding place for numeric values in a macro file. There are two types of macro variables: 
user-defined (you set and retrieve the value), or internal (Tecplot sets the value and you may 
retrieve it).

Map Layer

One way of displaying a line mapping, such as with line, bars, symbols, and so forth. One 
mapping may be displayed with one or more layers.

Median Axis

In 3-D, the grid axis which when scaled is not the shortest nor the longest axis.

Menu Bar

The top bar of the Tecplot screen used to select menu options.

Mesh

A 2- or 3-D field plot type which plots connections between data points.

Multi-Colored

Any Tecplot object which is colored by the value of the contouring variable. Multi-colored 
objects may include mesh, scatter symbols, vectors, contour lines, and streamtraces.

Multi-Line Text

Text which spans two or more lines.

Node

A point in finite-element data.

Number Format

The style of numbers to display for a data or axis label; exponent, integer, float, and so forth.

OpenGL

A graphics library for high-end 3-D graphics. It usually takes advantage of hardware 
acceleration for 3-D rendering.

Ordered Data

A type of data point organization which consists of a parameterized series of points. There are 
seven types of ordered data: I-, J-, K-, IJ-, JK-, IK-, and IJK-ordered. I-, IJ-, and IJK-ordered 
are the most common.

Plot Type

Determines the type of plot which is displayed in a frame. For example, 2D Cartesian plot, 3D 
Cartesian plot, XY Line plot, Polar Line plot, or Sketch plot.
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PLOT3D

A plotting package developed by NASA. Useful because the file format can be converted to a 
Tecplot binary data file by Preplot.

Point

A data file format for an I-, IJ-, or IJK-ordered zone in which the data is listed by point. All of 
the variable values for the first data point are listed first, then all the variable values for the 
second data point, and so forth.

Polar Line Plot

A plot of radius versus angle, or visa versa. The polar axes are the radial axis (by default zero 
at the origin) and theta axis (by default zero for any data on the right running horizontal line).

Precise Dot Grid

In 2-D, the points of intersection of the imaginary lines extending from the X- and Y-axes’ 
tick marks.

Preview Image

A display of your plot as it will appear when printed.

Primary Corner

The point in an ordered zone’s cell that has the minimum index values for that cell, or the first 
listed node of a finite-element cell.

Print File

An output file which contains a description of the plot. (Used for making hard copies.)

Print Format

The type of print output. For example. PostScript, HP-GL/2, and so forth.

Quadrilateral

An element type of finite-element surface data which is composed of four node points 
arranged in a quadrilateral. Used in 2- and 3-D surface plotting.

Quick Macro Panel

A user-defined panel accessed from the Tool menu which allows quick access to your macro 
functions.

Rake

A specified line from which two or more streamtraces are generated.

RGB Color Flooding

The assignment of color based on Red, Green, and Blue components defined at field data loca-
tions.
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Ribbon

(See Streamribbon.)

Rod

(See Streamrod.)

Scatter

A 2- or 3-D field plot type which plots a symbol at each data point.

Shade Plot

A 2- or 3-D field plot type which plots solid color or colors with lighting effect over the cells 
of the data.

Sharing

Variable sharing allows a single storage location to be used by more than one party. For exam-
ple, if the X-variable is shared between zones five and seven only one storage location is cre-
ated. The storage is not freed by tecplot until the number of parties accessing the data is 
reduced to zero. Variables and connectivity information may be shared.

Sidebar

The area to the left of the Tecplot workspace.

Sketch Plot

A plot which displays only text and geometries. These plots are in the Sketch plot type.

Slice

A set of data created by the intersection of a plane with 3-D zones.

Snap-to-Grid

Lock any object on the screen to the closest grid point. The position and size of the object will 
be affected by changes to the grid.

Snap-to-Paper

Lock any object on the screen to the underlying paper. The position and size of the object will 
not be affected by changes to the grid.

Sort

A measurement from one to two of the amount of work Tecplot should do to resolve hidden-
surface problems during 3-D sorting. Selecting two will increase the time required for each 
redraw and will generate messages about the number of cells with a potential conflict.

Specular Highlights

Rendering a surface such that it displays qualities similar to those of a smooth reflecting 
surface such as metal.
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Step Size

The fraction of a cell over which Tecplot streamtraces are integrated. Step size in Tecplot is 
variable, changing with the vector field and the size and aspect ratio of the cells.

Stream

An option of vector plots to plot particle traces through the vector field.

Stream Format

The current type of streamtraces being placed in Tecplot. For example, Surface Line, Volume 
Line, Volume Ribbon, or Volume Rod.

Streamline

A 2- or 3-D line which is parallel to the vector filed along its entire length. For a steady state 
vector field, this is the same as a simple particle trace which marks the path of a massless 
particle in the vector field.

Streamribbon

A particle trace with a width which not only follows the flow field (its center being a regular 
streamline), but which also twists with the vorticity of the vector field.

Streamrod

A particle trace with a polygonal cross-section and a width which not only follows the flow 
field (its center being a regular streamline), but which also rotates with the vorticity of the 
vector field.

Streamtrace

Any type of particle trace: streamlines, streamribbons, or streamrods.

Streamtrace Zone

Any streamtrace which has been extracted to form a new zone.

Stylesheet

A type of file which contains the definition of how the plot in a single frame is to be plotted. 
The stylesheet does not contain any zone data but does contain information about views, axes 
positions, zone attributes, and so forth.

Supersampling Factor

When antialiasing an image for export, the factor Tecplot uses when creating an intermediate 
image that is then resized down to the final image size. The larger the value, the smoother the 
resulting image at the cost of performance. Values of more than 3 are seldom necessary.

Surface Line

A type of 3-D streamline which is confined to remain on a 3-D surface. Also used to refer to 
2-D streamlines.
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Tetrahedron

An element type of finite-element surface data which is composed of four node points 
arranged in a tetrahedron. (Used in 3-D volume plotting.)

Translucency

A property allowing you to see through an object to areas within or beyond it. In Tecplot you 
may vary the amount of translucency, controlling the extent that an object closer to you 
obscures one it overlays.

Triangle

An element type of finite-element surface data which is composed of three node points 
arranged in a triangle. (Used in 2- and 3-D surface plotting.)

Unordered or Unorganized Data

(See Irregular Data.)

Value-Blanking

A feature of Tecplot used to trim or eliminate cells based on one or more user-defined 
constraints for variable values.

Variable

One of the values defined at every data point in a Tecplot data set or data file.

Vector

A short line or arrow showing the direction and or the magnitude of vector qualities.

Volume Line

A type of 3-D streamline which is not confined to remain on a surface and may travel through 
3-D volume data.

Volume Zone

Any zone that is IJK-ordered, finite-element tetrahedron, or finite-element brick.

Vorticity

The measurement of the tendency of a vector field to rotate about a point. (Also called 
“curl.”)

Workspace

The portion of your screen where you can create Tecplot frames. This includes but is not 
limited to the region covered by the displayed paper.

XY-Dependent

A 3-D axis mode where X and Y are fixed (dependent), but Z is free to vary in ratio 
(independent).
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XY Line Plot

Plots one variable assigned to one axis versus another variable assigned to another axis. Log 
plots, bar charts, curve fitted lines are all examples of XY Line plots.

Zone

A subset of a data set which is assigned certain plot types. Zones may be activated (plotted) or 
deactivated (not plotted). Each zone has one type of data ordering: I-, IJ-, IJK-, or finite-
element. Zones are typically used to distinguish different portions of the data. For example, 
different calculations, experimental versus theoretical results, different time steps, or different 
types of objects, such as a wing surface versus a vector field around a wing.

Zone Layers

One way of displaying a 2- or 3-D plot’s data set. The plot is the sum of the active zone 
layers, which may include mesh, contour, vector, shade, scatter and boundary.
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APPENDIX E Limits of Tecplot 
Version 10

The following hard limits apply to Tecplot Version 10.0.

Item Limit

Maximum number of data points per variable Over 2 billion

Maximum number of zones per data set 32,700

Maximum number of variables per data set 32,700

Maximum number of mappings 32,700

Largest floating point absolute value 10150

Smallest non-zero floating point absolute value 10-150

Maximum number of picked objects 1500

Maximum number of data sets 128 (Limited by max. 
number of frames)

Maximum number of frames 128

Maximum number of value blank constraints 8

Maximum number of contour groups 4

Maximum number of geometries limited by memory

Maximum number of polylines per line geometrya 50

Maximum number of points per circle or ellipse 720

Maximum number of custom label sets 10

Maximum number of custom labels per set 5000

Minimum frame width or height 0.1 inches

Maximum frame width 500 inches

Maximum streamtraces per frame 5000

Maximum number of color map overrides 16
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The following soft limits may be changed via the Tecplot configuration file:

Maximum preview width for EPS files 1024

Maximum preview height for EPS files 1024

Maximum number of user-defined color map control points 50

Maximum number of raw user-defined color map entries 800

Maximum number of characters in variable name 128

Maximum number of characters in zone title 128

Maximum number of characters in data set title 256

Maximum number of views per view stack 16

Maximum number of characters in an auxiliary data string 32000

a. A polyline is a continuous series of line segments, and can be a subset of a line 
geometry.

Number of: Windows UNIX Hard Limit

Points per linea

a. Points per line is the limit on the number of points allowed in the following: line 
segment geometries, stream termination lines, and contour lines. For line segment 
geometries, this is the total number of points used in all polylines contained in the 
geometry.

3000 5000 500,000

Contour levels 150 400 5000

Characters per text label 1023 1023 10,000

Item Limit



565

The following hard limits apply to plot style: 

Item Limit

Printing Gouraud shaded plots with continuous flooding On screen or 
exported bitmap 
image only

Printing plots with translucency On screen or 
exported bitmap 
image only
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Index

Symbols
# in files 402
* in equations 392, 394
** in equations 394
+ in equations 391, 394
/ in equations 394
{ } in equations 390

Numerics
2D Cartesian plot type 4, 123

shade plots 259
2D Cartesian plots

rectangular zones 410
2-D data

circular zone creation 412
2D Draw Order option 136
2-D field plots

cell elimination 450
contour plot 199
element elimination 450
rotating 409
scatter plot 247
shade plots 259
value-blanking 450
vector plot 221

2-D frames
value-blanking 450

2-D plots
circular zone creation 412
creating 124
mesh field 193

2D Rotate dialog 409
2D Rotate option 409
3-D

axis limits 143
cylindrical zones 414
translating 140
zooming 140

3D Axis Limits option 137
3D Cartesian plot type 4, 123

shade plots 260
3D Cartesian plots

rectangular zones 411
3D Depth Blanking option 458
3D Details dialog

specify lift fractions 141
3D Light Source dialog 137
3-D lines

creating in geometries 52, 53
example of geometry record 53
geometry record 51, 53

3D Orientation Axis dialog 142
3D Orientation Axis option 137
3-D plots

axis limits 137
carpet 144
controlling 136
creating 125, 126, 127
lift fractions 141
orientation axis 137
overlay mesh 194
Perform Extra 3D Sorting option 140
projection to a plane 419
reset axis 137
rotation 137, 139
sorting 140
vector plots 228, 229

3D Reset Axis option 137
3D Rotate dialog 139
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3D Rotate option 137, 139
3-D Rotation mouse modes 6
3-D spherical coordinates

rectangular, transforming to 407
3-D surface zones

three projections 419
3-D vectors

see Vector
3D View Details dialog 22, 137, 138, 141
3D View Details option 137
3-D volume data

analytic functions in iso-surface plots 355
analytic iso-surface plots 354
controlling volume mode IJK-ordered data 339
creating specialized plots 339
cutaway plots 457
extracting IJK-planes 344
extracting iso-surfaces 345
extracting outer surfaces of finite-element 

volume zone 339
fence plots 354
finite-element 339
generating iso-surfaces 339
hidden line mesh 194
IJK-blanking 454
IJK-ordered data 34
interpolating irregular data 339, 343
overlay mesh 194
probing plots 437
slicing with a plane 339
wire frame mesh 194
zone probing 437
zones 454

A
Absolute path 90, 91
Absolute value 397

data operations 394
Add Circle option 281
Add Circle tool 281
Add Contour Label tool 211
Add Ellipse option 281
Add Ellipse tool 281
Add Polyline option 281
Add Polyline tool 281
Add Rectangle option 281
Add Rectangle tool 281
Add Square option 281

Add Square tools 281
Add Streamtrace Termination Line tool 239
Add Text option 267
Addition

binary operator 394
Add-On Developer’s Kit 43, 99, 116, 121, 526
Add-Ons 511

$!LoadAddOn command 528
advqet 512
crsfez 512
Crvgen 512
Crvstineinterp 512
cstream 512
Gridgen 511
Loadcgns 511
Loaddem 511
Loaddxf 511
Loadfluent 511
Loadhdf 511
Loadimg 511
loading 527
Loadplot3d 511
Loadss 511
Loadxls 511
running 511
specifying on command line 527
statechange 512
Tecplot GUI Builder 526
viewbin 512

Adjustor mouse mode
editing data 446

Adjustor tool 6, 240, 288
data editing 446
probing 445

ADK 526
Advanced 3D Control dialog 137, 140, 141

Perform Extra 3D Sorting option 140
Advanced 3D Control option 140
Advanced Quick Edit add-on 512
Advqest add-on 512
Algorithms

least-square 169
polynomials 169
straight line fit 168

Allow Data Point Adjustment option 433, 445
Alter menu

Specify Equations option 388
Alter option 385, 388, 409
Amtec
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Technical Support 12
Analytic functions 410

iso-surface plots 355
Anchor position

for text 273
Angles

2-D data rotation 409
polar to rectangular coordinate 

transforming 407
rotating 3-D view 137

Animate Contour Levels dialog 478
Animate IJK-Blanking dialog 479
Animate IJK-Planes dialog 478
Animate Mappings dialog 481
Animate option 477
Animate Streamtraces dialog 482
Animate XY-Mappings dialog 481
Animate Zones dialog 483
Animation 477

advanced techniques 486
animated sequence 482
AVI file viewing 489
blanking 477
contour levels 477, 478
Framer creation 490
Framer viewing of Raster Metafiles 490
frames, multiple 488
IJK-blanking 477, 479
IJK-planes 477, 478
image size alteration 486
I-planes sequence 482
legends 487
macro animation 485
macros 477
manual creation 477
mappings 477, 481
movie files 484
planes 477
Raster Metafile conversion to AVI 541
Raster Metafile viewing with Framer 490
size 486
slice 477
still images 477
streamtraces 477, 482
techniques 486
text 487
text changes 486
text changes with macros 487
tools 477

value-blanking 477
zones 477, 478, 483

Antialiasing 369, 371, 374, 375, 376, 377, 379, 
382

Supersample Factor 369, 371, 374, 375, 376, 
377, 379, 382

Approximated by Number of Sides option 287
Arbitrary cutting planes 352
Arccosine

data operations 394
Arcsine

data operations 394
Arctangent

data operations 394
Arithmetic

operator precedence 394
Arrow keys

moving frames 14
positioning objects with 11

Arrowheads
angles 226
filled 224
geometry records 52
hollow 224
in polyline geometries 52
plain 224
polyline addition 286
polyline arrowhead controls 286
size 225
streamtraces 237
style 224
vector 224

ASCII characters
ordinal values 272
stream markers 241

ASCII data files 79
ASCII files

BLOCK format description 87
example 44
POINT format description 87
writing in BLOCK format 87
writing in POINT format 87

ASCII fonts
scatter plots 254

ASCII format
symbol shapes 160

ASCII terminal
Tecplot execution 473

Aspect ratio 143
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Attach to Zone/Map option 274, 286
Attributes

assign by zone 129
Audio Visual Interleaved (AVI) files 367
Auto Redraw 4
Auto Spacing option 164
AutoCAD DXF files

importing 103
AUXDATA parameter 46
Auxiliary data 43, 46, 55

AUXDATA parameter 46
data record 55
Data Set Information dialog 42, 393
DATSETAUXDATA 43
equation syntax 392
examples 56
PLOT3D Loader 120

AVI files 367
creating 369
image creation 369
Raster Metafile conversions 541
viewing 489

Axes
3-D limits 143
3-D orientation 263
3-D orientation axes 142
3-D reset 142
assign to XY-mappings 150
change dependency 143
controls 297
custom labels 55
default assignments 44
dependent 323
editing 147, 163
ellipse axes modifying 287
limits for 3-D plots 137
line plot customization 163
line plot range 163
line plots 153
log 164
multiple X- and Y-axes 164
orientation for 3-D plots 137
Probe 442
ranges, linked 323
reset for 3-D plots 137
reversing 180
scaling 143
variable assignment in mesh plots 126

Axis

clip data 302
dependency 300
direction 300
display 298
grid area 304, 318
gridline cutoff 305
gridline draw order 306
gridlines 304
Independent 301
labels 310
length preservation 299
lines 316
Polar 301
polar plots 164
positioning 317, 318
precise dot grid 305
range modification 298
reverse direction 300
R-origin 303
Theta mode 302
Theta Period 302
Theta Value on Right Circle 303
tick mark display 307
tick marks 306
title display 314
title offset 315
title position 315
titles 314
variable assignment 298
XY Dependent 301
XYZ Dependent 301

Axis Details dialog 147, 163, 298
Area page 318
Grid page 304
Line page 316
log axes 164
Range page 299
Ticks page 306
Title page 314

Axis details dialog
Reverse Axis Direction 180

Axis variables
assign to XY-mappings 150
mappings 153

B
Background light 265
Bar charts 145, 183
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map layer 5, 183
Mapping Style dialog 184
pure 183
vertical or horizontal bars 184

Batch mode
Tecplot running 473

Batch processing 529
batch.log diagnostic file 476
BATCHLOGFILE 476
bitmap format limitations 473
command line option 529
data files 474
data set looping 475
data sets, multiple 474, 475
diagnostics 476
layout files 473, 474
limitations 475
looping inside Tecplot 475
looping inside Tecplot limitations 475
looping outside Tecplot 475
macro file creation 473
plot styles 474
printing 473
setup 473
stylesheet file use 476

Batch.log file
running batch mode 476

BATCHLOGFILE 476
Best float tick marks 310
Binary data file viewer add-on 512
Binary files 79

ASCII conversion 43
efficiency 43
PLOT3D Loader 118
writing 86, 87

Binary operators 394
equations 394
precedence 394

BIT data type
format registration 46

Bitmap files 97
Raster Metafile 490

Bit-mapped image
raster 367

Black and white
color map, gray scale 218

Blanking 449
animation 477
Boundary zone layer 449

cells 449
cutaway plot creation 457
cutaway plots 454
data 449
depth 449, 458
exterior domain 457
field plots 449
finite-element volume zones 263
IJK-blanking 449, 454
IJK-ordered data 449
IJK-ordered zones 263, 454, 458
IJK-ranges 456
IJK-zones 456
IJ-ordered data 449
interior domain 457
I-ordered zones 449
iso-surfaces 457
limitations 450
line plots 459
precise 450, 452
value-blanking 450
whole cell 450
zones 449

BLOCK format 127
3-D data files 332
creating data file 326
description 87
example in FORTRAN with I-ordered data 62
example of triangle mesh 72
example with IJK-ordered data 68
example with IJ-ordered data 66
example with I-ordered data 62
examples 64
FORTRAN example for triangle mesh 73
FORTRAN example with IJK-ordered data 69
FORTRAN example with IJ-ordered data 66
Triangle element type 72
writing ASCII 87

BMP files 367
creating 370
image creation 370

Bottom error bars 180
Boundaries

boundary zone triangulation 423
displaying 196
finite-element 336
finite-element extraction 336
Simple boundary conditions 399
smoothing 431
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specifying 197
zone boundary smoothing limitations 432

Boundary 399
Boundary conditions 399

creating 399
Boundary plot layer 197
Boundary plots 193

definition 193
Boundary zone layer 5, 123

blanking 449
Boxed text 273
Branching shared variables 446
Breakpoints

macros 469
Brick

FE-volume element type 38
Brick element type 71, 127

connectivity list 71
Brick polyhedral elements 329

FE-volume zones 325
Buttons

Help 12
Object Details 4
Performance 4, 5
Quick Edit 4, 8
Redraw 4, 5
Redraw All 4, 5
Tools 4

BYTE data type 69

C
C

writing data to binary 43
Carpet

3-D surface plot 144
Carpet data format

in Excel Loader 107
CAS files

Loadfluent add-on 511
Cell Center

field plot viewing 438
Cell-centered data 39
Cells

blanking 449
eliminating 450
finite-element 449
Hexahedral 449
labeling 135

precise blanking 450
Quadrilateral 449
viewing information 438
whole cell blanking 450

CGNS Data Loader
Loadcgns add-on 511

CGNS files 511
Characters

custom creation 295
customization 506

Circle
example of geometry record 53
geometry record 51, 52, 53
symbol shape 159

Circle Stream add-on 512
Circles

controls 287
creation 282
selecting 281

Circular zones
creating 412

Clamped spline
fitting 172, 173

Color map
banded color distribution 207
choosing 217
color cutoff 208
command line file specifying 530
continuous color distribution 207
control point modification 218
control point movement 218
control point numbers 219
control points 218
copy to file 219
cycles 209
distribution methods 207
file creation 219
file macro commands allowed 219
file specifying 530
file specifying on command line 530
files 97, 219
frame-specific options 217
gray scale 218
Large Rainbow 217, 218
Modern 218
paste from file 220
Raw User-Defined 218
Raw User-Defined modifying 219
reversing 209



573

RGB value modification 218
RGB values 218
Small Rainbow 217
specifying 217
Two Color 218
User-Defined 218, 219
Wild 218

Color Map dialog 217, 218
Color Map option 217
Color maps

limits in Tecplot 563, 564
Color Preferences dialog 500
Colors

basic 15, 131
continuous coloring 207
fill colors in geometries 51
geometries 51
mesh plots 131
RGB 215
RGB coloring options 215
RGB Mode 216
scatter plots 251
scatter symbols 251
streamtraces 236
surface color contrast 265
text 49
zones 49

Command line
batch processing 529
color map file specifying 530
data set overrides in layouts 533
data set readers specifying 534
examples 534
Framer 537
last view in frame restoration option 24
layout reading 530
loading data files 534
macro playing 530
macro running 464, 530
options 529
Preplot options 540
shortcut creation 531
shortcut editing 532
UNIX options 532
Windows run options 530
Windows shortcuts 531
Windows start options 530

Comments
data files 43

Complex boundary conditions 399
Components

equation use 391
Configuration files 493

creating 494
creating and editing 493
Motif 494
saving 493, 494
specifying 529
UNIX 493, 505

Connectivity list 36
examples 74
finite-element 70
finite-element data lists 326
for Brick element type 71
limitations 337

Connectivity sharing
CONNECTIVITYSHAREZONE 

parameter 47, 74
saving to data files 87

Contacts
Amtec 12
Technical Support 12

Continuation lines
in data files 43

Continuous coloring 207
Continuous flooding

limits 565
Contour Add tool 345

shortcuts 544
Contour Delete tool 345
Contour Details dialog 199, 206
Contour group 131
Contour labels

Add Contour Label tool 211
adding automatically 212
clearing 213
definition 211
interactively adding 211

Contour legend
contour plot creation 213
custom labels 55
definition 213

Contour levels
adding 206
animation 477, 478
deleting 206
exponential distribution specifying 205
limits in Tecplot 564
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number 204
range 204
removing 206
specifying by range and delta 205
specifying by range and number 205

Contour lines
controlling 210
modes 210

Contour plots 199
adding contour legend 213
blanking 457
creating 199
data requirements 199
line controls 210
line plots 199
variable selection 204

Contour Remove tool
shortcuts 544

Contour table
see Contour legend 213

Contour tool
shortcuts 6

Contour Variable dialog 131
Contour Variable option 204
Contour variables 397

assigning 199
choosing 204

Contour zone layer 4, 123, 204
Control lines

for zone types 48
Controls

arrow keys 11
Contour tools shortcuts 544
coordinate systems 19
mouse tool shortcuts 7, 22
operations 9
Performance button 5
Quick Edit button 8
Redraw 5
Redraw All 5
Slicing tool shortcuts 351
Snap modes 8
Streamtrace tools shortcuts 546
Translate/Magnify tool 24
Zoom tool shortcut 547

Coordinate systems 13, 19
frame 21
geometries in frames 284
grid 272

grids coordinates with geometries 284
text 49
text heights 272
text in frames 49
text positioning 272

Coordinates
transforming 407

Copy 13
color map to file 219
frame style 89
style to file 89
views between frames 24

Copy Layout to Clipboard dialog 380
Copy Plot to Clipboard 26
Copy Plot to Clipboard option 3
Copy Style Options dialog 90
Copy Style to File dialog 89
Copy View option 22, 24
Copying

connectivity lists 71
zones 412

Cosine function
data operations 394

Create 1-D Line Zone dialog 410
Create Circle Zone dialog 413
Create Circular Zone dialog 413
Create Circular Zone tool 413
Create Duplicate Zone dialog 418
Create Frame mouse mode 13
Create Mappings dialog 148
Create Mirror Zone dialog 419
Create Rectangular Zone dialog 410, 412
Create Rectangular Zone tool 411
Create SubZone dialog 344, 416
Create SubZone option 416
Create Zone option 145, 385, 410, 412
Create Zones from Polylines dialog 421
Cross error bars 180
Crsfez add-on 512
Crvgen add-on 512
Crvstineinterp add-on 512
Cstream add-on 512
Ctrl-A (Paste View) 22, 24
Ctrl-click

in interface 10
Ctrl-F (Fit to Full Size) 24
Ctrl-L (Last) 22, 24
Cubic spline 172
Curly braces 405
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Current frame 13
blanking 449

Curve Fit Settings dialog 168
Curve fits

point sorting 152
Curve Information dialog 178
Curve type

exponential fit 166
linear fit 166
paraspline 167
polynomial fit 166
power fit 166
spline 167

Curve-coefficient files 97, 178
Curve-fits

add-ons 512
Crvgen add-on 512
Crvstineinterp add-on 512
loading with add-ons 512

Curves
Crvgen add-on 512
Crvstineinterp add-on 512
curve-fit loading with add-ons 512
curve-weighting variables 176
dependent and independent variables 175
detail and data point extraction 178
detail viewing 178
exponential fits 170
fitting 166
fitting straight lines to data 168
parametric spline fits 173
polynomial fits 169
power fits 171
spline fit 172

Curve-weighting variables
assigning 177

Custom characters
creating 506

Custom label record 43, 55
Custom labels 311

axes 55
contour legend 55
example 55
limits in Tecplot 563
loading records 82
nodes 55
record parameters 61
saving record to file 86

Custom tick marks 310

CUSTOMLABELS Record 310
Cut 13

Ctrl-X shortcut 14
Cutaway plots 457

3-D volume plot 354
IJK-blanking 454

Cutting planes
arbitrary 352
defining with 3 points 353

Cylinder data 123
Cylindrical zones

creating 412

D
d . 493
d2di2 399
d2dij 399
d2dik 399
d2dj2 399
d2djk 399
d2dk2 399
d2dx2 399
d2dxy 399
d2dxz 399
d2dy2 399
d2dyz 399
d2dz2 399
DashDot line pattern 157
DashDotDot line pattern 157
Dashed line pattern 157
DAT files

Loadfluent add-on 511
Data

ASCII data files 76
ASCII file example 44
ASCII file format 43
ASCII files 79
binary data files 43, 79
BIT type 45
BLOCK format 127
BLOCK format description 87
BLOCK format example 64
BYTE type 45
cell-centered 39
clamped spline fits 173
combining files 30
concatenates ASCII files 44
connectivity list 70
continuation line in files 43
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converting ASCII to binary 43
data set information 392
Data Set Information dialog 39
data set renaming 393
DOUBLE type 45
example of I-ordered in POINT format 62
FE Volume 38
FEPOINT format example 126, 127
file header 56
finite-element 136
finite-element mesh plots 126
functions 394
geometry record files 51, 60
IJK-ordered 31, 34, 67, 125, 126, 136
IJK-ordered 3-D volume 339
IJK-ordered data blanking 263
IJK-ordered one variable files 69
IJK-ordered with line plots 147
IJK-ordered zone record 67
IJ-ordered 125
IJ-ordered in mesh plots 124
IJ-ordered in POINT format 124
IJ-ordered maximum index 65
IJ-ordered organization 65
IJ-ordered with line plots 147
IJ-ordered zone record 65
IK-ordered 32
I-ordered 31, 33, 61
I-ordered files 45
I-ordered one variable files 69
I-ordered probe limitations 434
irregular 424
JK-ordered 31, 32
J-ordered 32
K-ordered 32
line length maximum in files 43
load variables by name 83
load variables by position 83
loading 79
LONGINT type 45
nodal 39
operations, see also Data operations 387
ordered 31
ordered data format 61
partial read options 81, 82
PLOT3D file options with Preplot 77
PLOT3D files 77
point extraction 416

POINT format 126, 127
POINT format description 87
POINT format example 63
POINT format for I-ordered 61
POINT format triangle mesh example 71
point probing 433, 435
point values 423
preprocessing files with Preplot 76
quote strings in files 43
random 423
reading files 80
reading multiple files 81
saving custom label record 86
saving in layout files 91
saving modified 387
scaling in frames 23
SHORTINT type 45
SINGLE type 45
ungridded 424
unordered 423
variables 390
viewing inside frames 21
writing binary 87
writing binary files 86
writing files 86
writing selected record types 86
writing selected variables 86
writing selected zones 86
XY-data entry 415
zone creation 409

Data extraction tools 6
Data files

appending 393
batch processing 474
command line readers 534
comments in files 43
custom label record 43
custom label record files 61
custom label record loading 82
dialogs for reading and writing 9
Drawing Interchange Files (DXF) 103
DXF 103
Escape character in files 43
example of IJK-ordered in BLOCK format 68
example of IJK-ordered in POINT format 67
example of IJ-ordered in BLOCK format 66
example of IJ-ordered in POINT format 65
example of I-ordered in BLOCK format 62
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example of I-ordered in POINT format 61
geometry record file format 51
geometry record files 43
geometry records 82
Gridgen Loader 113
HDF 114
loading from the command line 534
one variable files 69
one variable IJ-ordered files 69
PLOT3D Loader 117
readers 99
specifying zones in files 82
text record 43
text record file format 49
text record files 59
text records 82
text records in files 49
variables 390
writing ASCII 87
writing ASCII files 86
writing ASCII in BLOCK format 87
writing ASCII in POINT format 87
zone record 57
zone record types 49

Data Fit 21
Data Format dialog 386
Data labels 188
Data Labels dialog 135
Data Loaders 99

DXF 103
Excel 105
for DEM files 103
Gridgen 113
HDF 114
PLOT3D 116
SDS 114
Spreadsheet Loader 121
Text Spreadsheet 121

Data menu 3
2D Rotate option 409
Alter option 385, 388, 409
Create SubZone option 416
Create Zone option 145, 385, 410, 412
Curve Info option 178
Data Set Info option 39
Delete Zone option 422
Duplicate option 418
Enter Values option 415
Extract option 336, 347, 417

Extract Slice from Plane option 352
Interpolate option 424, 427, 429
Inverse Distance option 424
Kriging option 427
Linear option 429
Mirror option 419
Points from Geometry option 417
Points from Polyline option 417
Probe At option 436, 443
Smooth option 430
Spreadsheet option 385
Transform Coordinates option 409
Triangulate option 335, 423

Data operations
1-D line zone creation 410
2-D circular zone creation 413
2-D data creation 410
2-D data rotation 409
3-D cylindrical zone creation 414
3-D rectangular zone creation 411
3-D spherical coordinates to rectangular 407
absolute value 394
addition 394
Adjustor tool editing 446
Allow Data Point Adjustment 433
analytic functions 410
Arccosine 394
Arcsine 394
Arctangent 394
binary equation operators 394
boundary smoothing 431
boundary zone triangulation 423
circular zone creation 412
coordinate transforming 407
coordinate variable smoothing 430
Cosine function 394
cylindrical zone creation 412
data altering 401
data editing with Probe 446
data point adjustment 445
data point extraction 416
data rotation 409
data set modifying 388
data set renaming 393
data type for variables 400
derivative functions 398
difference functions 398
discrete point extraction 417
edit with Probe 433, 446
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equation altering 401
equation examples 396
equation file comments 402
equation file loading 402
equation indices 395
equation operators 394
equation restriction overriding 401
equation variables 390
equations 389
equations in macros 402
exponentiation 394
file appending 393
functions 394
geometry point extraction 417
index range and skip selections 400
interpolate, linear 424
interpolating 423
interpolation alternatives 430
interpolation, inverse-distance 424, 449
interpolation, kriging 424
interpolation, linear 428, 449
inverse-distance interpolation 424, 449
irregular point triangulation 422
kriging 449
kriging interpolation 424, 426
linear interpolation 424, 428, 449
Logarithms 394
macro use 461
macros, equations 402
mirror zone creation 419
multiplication 394
ordered zones 400
Outside Points in interpolation 429
polyline point extraction 417
probe editing 433
rectangular zone creation 410
rectangular zones 410
rotation in 2-D 409
Rounding function 395
Sine function 394, 395
smoothing 430
smoothing limitations 431
spreadsheet alteration 386
square root 394
sub-zone extraction 416
tangent function 394
triangulation of irregular data points 422
Truncate function 395
variable data type specifying 405

variable names 405
variable renaming 393
variable value location specifying 405
variables 390
XY-value entry 415
zone creation 409
zone creation, circular 412
zone creation, cylindrical 412
zone deletion 421
zone duplication 418
zone number specifying for operands 404
zone renaming 392
zone specifying 396

Data point sorting 152
Data points 32

Allow Data Point Adjustment option 433
discrete point extracting 417
exact probing 435
extracting 178, 416
labeling 135
labels 188
limits in Tecplot 563
probing 445

Data set indices
Nearest Point mode 437

Data Set Info option 39, 114
Data Set Information dialog 39, 392

Aux Data page 42
auxiliary data 42, 393
Data Set page 41
Journal page 41
Sharing page 41
Zone/Variable page 39

Data sets
auxiliary data record 55
clamped spline fits 172
command line overrides of layouts 533
curve fits 166
curve-weighting variables 176
Data Set Information dialog 39
displaying indices 135
exponential curve fits 170
finite-element 337
finite-element brick 329
finite-element brick creation 330
finite-element creation 326
finite-element mesh plots 124
finite-element POINT format 124
finite-element quadrilaterals 326
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finite-element volume 329
finite-element volume tetrahedral 333
fitting lines to 168
fitting points in frames 21
fitting to frames 24
information on 392
limits in Tecplot 563
modifying 387, 388
parametric spline fits 173
polynomial fitting 169
power fits 171
probe specific location 444
probing 437
processing multiple 474
renaming 393
spline fit 172
spreadsheet viewer 385
tetrahedron 329
title limits in Tecplot 564
triangulated FE-surface data 334
variables, maximum number 563
viewing information 393

Database Network
importing GRIDGEN files 113

DATASETAUXDATA 43
-datasetreader flag 534
ddi 399
ddj 399
ddk 399
ddx 399
ddy 399
ddz 399
Defaults

extensions for file names 499
modifying 493

Delete
contour level 206
frames 14
zone 421

Delete Zone dialog 422
Delete Zone option 422
Delta

symbol shape 159
DEM files

importing 103
DEM Loader 511
Dependent variables

assign with Mapping Style dialog 175
Depth-blanking 449, 458

limitations 450
Derivative 399
Derivative boundary conditions 399
Derivative functions 398, 399

boundary conditions 399
restrictions 399

Dialogs
Display Performance 502

Diamond
symbol shape 159

Difference functions 398
complex boundary conditions 399
restrictions 399
simple boundary conditions 399

Digital Elevation Map (DEM) files
importing 103

Discrete points
extracting 417

Discrete Points option 417
Display Performance 24
Display Performance dialog 5, 140, 493, 502
Division

binary operator 394
Domain

IJK-blanking 456
Dotted line pattern 157
Drawing interchange files

importing 103
Drawing speed 502
Duplicate option 418
Duplication

connectivity lists 71
frames 26
geometries 26
objects 26
text 26
zones 418

DXF files
importing 103
viewing in 3-D file 105

DXF Loader
Loaddxf add-on 511

Dynamically linked libraries
loading add-ons 528

E
Edit

Pop 284
Push 284
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Edit Current Frame dialog
resize and position frames 14

Edit menu 2, 26
Allow Data Point Adjustment option 433
Copy Plot to Clipboard option 3

Element type
Brick 127
brick 38, 71
quadrilateral 38, 70
tetrahedron 38, 71
triangle 38, 71, 72, 75

Elements
eliminating 450

Ellipse
axes modifying 287
controls 287
creation 282
geometry record 51, 52
line segment modifying 287
number of points in geometries 52
selecting 281

E-mail
for Technical Support 12

Encapsulated PostScript
format 97

Encapsulated PostScript files 367
format 371
preview image 372

Enter ASCII Character dialog 241
Enter Contour Level Range dialog 205
Enter Mapping Name dialog 151
Enter XY-Values to Create a Zone dialog 415
Environment variables

add-on loading 527
as text 280
BATCHLOGFILE 476
MOZILLA_HOME 539
TEC100HOME 1
tecplot.phy set up and location 509
Windows home directory 493

EPS
limits in Tecplot 564

EPS files 367
format 371
printing 371

EPS format 97
Equation

create boundary conditions 399

Equation files 97
ASCII text editor 402

Equations 389
alterations 401
ASCII text editor for files 402
binary operators 394
components use 391
data operations 389
derivative and difference functions 398
examples 396
file loading 402
indices 391, 395
letter codes 391
macro example files 406
macro file comments 402
macros 402
macros, variable data type 405
macros, variable value location 405
modifying 388
restriction overriding 401
variables 390
zone numbers 395

Equations in macros
ranges and skip factors 404

Equilateral triangle shape 159
Error bars 145, 179

bottom 180
colors 181
cross 180
crossbar size 181
horizontal 180
left 180
Mapping Style dialog 180
modifying 181
Quick Edit colors 181
right 180
spacing 182, 183
thickness 182
top 180
type selection 180
vertical 180

Error Bars map layer 5
Escape character

data files 43
Excel Data Loader 105

limitations 110
Loadxls add-on 511
spreadsheet data format 106
table data format 106
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Exponential curves
fitting 170
fitting with Mapping Style dialog 170
fitting with Quick Edit 170

Exponential Fit option 166
Exponential tick marks 310
Exponentiation

binary operator 394
data operations 394

Exponents
plotting 394

Export
files 97, 368
format 367
plots into other applications 367, 380
raster graphics files 367
vector graphics files 367, 373, 375

Export dialog 367, 368
Export Sun Raster dialog 377
Extended curves 167
Extract

discrete points 417
IJK-planes 344
iso-surfaces 345
points from geometry 417
points from polyline 417

Extract Data Points dialog 417
Extract Data Points to File dialog 417
Extract FE-Boundary dialog

image 336
Extract Iso-Surfaces dialog 347
Extract option 336, 347, 417
Extract Slice from Plane dialog 352
Extract Streamtraces dialog 243
Eye distance 141

F
F1 key (Help) 12
Face Neighbor

field plot viewing 438
FE volume 38
FEBLOCK format

finite-element 70
Fence plots 354
FEPOINT format

BIT data type restriction 46
example data file 126, 127

Field data
loading options 82

Field layers 4
Field plots

boundary plots 193
contour plots 199
mesh plots 193
scatter plot 247
shade plots 259
vector plots 221

File dialogs
basic procedures 9
Motif 9

File headers 43
parameters 56
title 44
variable names 44

File menu 2
Import option 99
Load Data File(s) option 80
Macro option 406
Open Layout option 93
Preferences option 493
Print option 357, 358, 360
Print Preview option 365
Publish option 96
Save Configuration option 493, 495
Save Layout As option 91, 94
Save Layout option 91, 94
Write Data File option 335, 387
Writing Data File option 86

Files
absolute path 91
animation 484
animation file creation 478, 479, 480, 481, 

482, 483
ASCII file formats 43
Audio Visual Interleaved (AVI) 367
Batch mode printing 473
batch processing layout files 473
batch processing with stylesheets 476
bitmap 97
BLOCK format description 87
BMP 367, 370
Color Map 97, 219, 530
command line file reading 530
configuration 493
data file batch processing 474
Encapsulated PostScript (EPS) 97, 367
equation 97
equation file loading 402
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export 97
export format 367
font file 506, 529
formats 88
HDF Loader 114
HP-GL 134, 367
HP-GL/2 367
JPEG 367, 373
layout 88, 90
layout file batch processing 473
layout file composition 91
layout package 88
layout package file use 94
macro 97, 461
macro examples 406
macro specifying 530
Motif configuration files 494
movie 477
multiple file printing 473
name extension 402
name extension defaults 499
name filters 9
opening layout files 93
opening layout package files 94
PNG 367, 375, 376
POINT format description 87
PostScript 367
print 97
Raster Metafile (RM) 367, 375, 484, 489
relative path 91
saving via HTTP 91
streamtrace formats 231
stylesheet formats 88
stylesheets 88
Sun Raster 368, 377
Tagged Image File Format (TIFF) 368, 378
Windows Bitmap 367
Windows Metafiles (WMF) 97, 368
writing ASCII 86, 87
writing ASCII in BLOCK format 87
writing ASCII in POINT format 87
writing binary 86, 87
X-Windows 368

Fill color
symbol choices 161

Filled arrowheads 224
Filled symbols 161
Filters

file name 9

Point format
see also FEPOINT format

Finite-element
3-D volume 339
3-D volumes 329
BLOCK format 127, 332
boundary extraction 336
boundary lines 336
brick 71
brick data sets 329
brick element creation 329
Brick element type 127
brick polyhedral elements 325
cells 449
connectivity list limitations 337
data 43, 325
data connectivity list 36, 70
data set connectivity lists 326
data set creation 326
data sets 337
definition 36
differentiation limitations 337
duplicating variables 75
element type in zones 49
example of node variable parameters 73
extracting outer surfaces of volume zone 339
FEBLOCK format 70
irregular data point triangulation 423
iso-surface zones 347
limitations 337
line description 36
mesh plot data 126
mesh plots 124
mixing element types 70
number of elements in zones 49
number of nodes 49
plotting 36
POINT format 124, 127, 331
quadrilateral data sets 326
quadrilateral element type 38
smoothing limitations 337
spreadsheet data viewer 385
surface data points 37
surface description 36
surface triangulated data sets 334
surface zones 70, 325
tetrahedral polyhedral elements 325
tetrahedron element type 38
tetrahedron volume data sets 329
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triangle element type 38, 325
triangulated data sets 334
volume brick data set creation 330
volume data 38
volume data connectivity list 126
volume data sets 329
volume data value list 126
volume description 36
volume tetrahedral data set 333
volume zone blanking 263
volume zones 71, 325
zone boundary extraction 336
zone formats 438
zone probing 439
zone record data 58
zone slicing 353
zone smoothing limitations 431
zones 48, 49, 409, 422, 424

First-derivative 399
Fit All Frames to Workspace 25
Fit Paper to Workspace 25, 26
Fit Selected Frames to Workspace 25
Fit to Full Size 24, 105

Ctrl-F shortcut 22, 24
Floating tick marks 310
Flooding

continuous 202, 203, 208, 365
RGB continuous 215

Flow-of-control commands
processing data sets 474

Fluent Data Loader 110
Fluent Data Loader dialog 111
Fluent Loader

Loadfluent add-on 511
Fluent Loader Options dialog 112
Fonts

creating 506
file 506
font file specifying 529
text editing 269
text record 59
user-defined 506

Foreign data files
Gridgen Loader 113

Foreign data formats 99
DEM 103
DXF 103
Excel Data Loader 105
HDF Loader 114

PLOT3D 116
SDS Loader 114
Text Spreadsheet Loader 121

FORTRAN
BLOCK format triangle mesh 73
example of I-ordered in BLOCK format 62
example with BLOCK format 66
POINT format triangle mesh 72
triangle finite-element point data 73
writing data to binary 43

Frame linking 321
attributes 321
axes 321
axis ranges, linked 323
contour levels 321
position 321
size 321
views 321

Frame menu 3
Delete Current Frame 14

Frame mouse modes 6
Framer 477, 490, 537

animation creation 490
commands 537, 538
Motif version 490, 537
Raster Metafile format 490
Raster Metafile movie creation 367
Raster Metafile viewing 490
Windows options 538

Frames
animation 488
attribute linking 321
axis linking 321
axis ranges, linked 323
background color 15
blanking 449
border controls 15
centering plots 22
contour level linking 321
coordinate systems 13, 19, 21
coordinate systems for positioning text 272
Copy Plot to Clipboard option 26
Copy View 22
copying 26
copying views 24
Create Frame mode 13
creating 13
current 13
cutting 26
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deleting 14
deleting groups 14
fitting data 24
fitting data points 21
fitting plots to 13
frame units for geometries 51
geometry coordinate systems 51, 284
geometry propagation in like frames 285
header colors 15
header controls 15
header options 15
height minimum 563
invisible borders 15, 25
last view 24
like frames 274
like frames with geometries 285
limits in Tecplot 563
limits on number 13
linking 321
macro use 461
managing workspace 13
moving 10
moving with arrow keys 14
moving with Translate/Magnify 22
multiple view copying and pasting 24
name changing 16
Pasting views 22, 24, 26
popping 16
position linking 321
positioning 10, 14
pushing 16
resizing 14
resizing with Edit Current Frame 14
resizing with mouse 14
resizing with Translate/Magnify 22
saving style to stylesheets 89
scaling data 23
Select All 26
Show In All Like Frames option 274
showing or hiding headers 16
size 14
size linking 321
sizing 14
stacking 16
text coordinate system 49
text height units 50
text propagation 274
transparent 15
units 21

using Zoom 22
value-blanking 450
view linking 321
view stack 24
views of data 21
width maximum 563
working with 13
Zoom 21

FTP
reading via 91

Function definitions
macros 461

Functions
data manipulation 394

G
Geometries

3-D lines 52, 53
alignment 294
alignment with Quick Edit 294
alignment with Selector 294
arrowheads 52
circle attributes 287
circle creation 282
color controls 282
coordinate system controls 284
copying 26
creation 281
cutting 26
data file examples 54
ellipse attributes 287
ellipse creation 282
ellipses 282
file formats 51
filled or unfilled 282
frame coordinate systems 284
keyboard shortcuts 544
limits in Tecplot 563
line and fill color 282
line pattern controls 283
line patterns 282
line thickness controls 283
macro linking 295
macro links 466
map attachment 285
modifying 282
mouse mode 6
origin controls 284
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pasting 26
point changes with Adjustor tool 288
point extraction 417
polyline arrowheads 286
polyline creation 281
popping 294
position controls 284
positioning 284
propagate to like frames 285
pushing 294
rectangle controls 288
rectangle creation 282
scope controls 285
Select All 26
shortcuts 544
sizing 284
Sketch plot type creation 280
square creation 282
zone attachment 285

Geometry dialog 282, 283, 284, 285, 287, 288, 
295

Approximated by Number of Sides option 287
Attach to Zone/Map option 286
Show in All Like Frames option 285

Geometry record 43, 86
3-D line 51, 52, 53
circle 51, 52, 53
color 51
control line 51
ellipse 51, 52
example of 3-D lines 53
example of circle 53
file format 51
line 51, 52, 53
line thickness 51
line type 51
parameters 60
polyline 51, 53
polyline example 53
rectangle 51, 52, 53
square 51, 52

Geometry records 51
arrowheads 52
loading options 82

Geometry tool
shortcuts 544

Ghostscript
PostScript conversion software 361

Gouraud shade plot types 263

Gradient
symbol shape 159

Graphics performance 502
Gray scale

color map 218
macros 463

Grid
display 19
snap to 18
spacing 19
units 19
workspace 18, 25

Grid coordinate system
geometries 51

Grid units
text 50

Gridgen Loader 113
add-on 511
Gridgen add-on 511

Gridlines
axis 304
draw order 306

Group Select dialog 294

H
H

keyboard shortcut to restrict horizontal 
adjustment 442, 446

HDF Loader 114
limitations 115
Loadhdf add-on 511

HDF Loader dialog 115
Headers

showing or hiding 16
Height units

text 50
Help

accessing 11
by pressing F1 12
from the status line 11
Status line 8
Technical Support 12
Tecplot license 3

Help dialog 11
Help menu 3, 12
Hexahedral

cells 449
Hidden Line mesh plots 194
Hollow arrowheads 224
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Horizontal error bars 180
HP-GL 134

files 367
print format 360
print precision 362

HPGL
exporting 373

HP-GL/2
files 367
print format 361

HPGL/2
exporting 373

HTML
creating with Publish 96
saving 96

HTTP
saving via 91

I
Icon

Windows, with command line options 531
I-index

range 185
IJK-blanking 449, 454

3D plot type 450
animation 477, 479
domain 456
Exterior option 456
IJK-ranges 456
Interior option 456
zones 456

IJK-Blanking dialog 456, 457
IJK-ordered data 31, 34, 67, 136

3-D volume 339
blanking 263, 449
example in BLOCK format 68
example in POINT format 67
FORTRAN example in BLOCK format 69
FORTRAN example with POINT format 68
index skip 256
indice selection 184
line plots 147
maximum J-index 67
maximum K-index 67
mesh plots 125, 126
one variable data files 69
POINT format 126
scatter plots 256

IJK-ordered zones 454, 457
blanking 454, 458
fence plots 354
smoothing limitations 431

IJK-planes
animation 477, 478
extracting 339, 344

IJK-skip 82
IJ-ordered data

blanking 449
example with BLOCK format 66
example with POINT format 65
FORTRAN example in POINT format 66
index skip 256
line plots 147
maximum index 49, 65
mesh plots 124, 125
one variable data files 69
organization 65
POINT format 124
sample FORTRAN code for creating 65
scatter plots 256

IK-ordered data 32
I-lines 34

family 33
Image Geometry Details dialog 290
Image Loader

Loadimg add-on 511
Image region

exporting Raster files 378
Images

Antialiasing 369, 371, 374, 375, 376, 377, 379, 
382

still 477
Import option 99
Include IJK-Blanking option 456
Include Value-Blanking option 450
Independent variables

assign with Mapping Style dialog 175
Index offsets

for equations 395
Index skip

in IJ- and IJK-ordered data 256
Indices

cell display 438
equations 395
in equations 391
point display 438

Insert menu 3
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Integer
constant 395

Integer tick marks 310
Interface

arrow keys 11
default resetting 505
Help 11
macro running 465
mouse use 9
operations 9
preferences 8
scaling 11

Interior option 456
Interpolate

alternatives 430
Kriging 424, 426
linear 428
Outside Points option 429

Interpolate mode
line plot probing 440
probing 433, 439, 443

Interpolate option 424, 427, 429
Interpolated variable values 434
Interpolation 423
Inverse Distance Interpolation dialog 424
Inverse Distance option 424
Inverse-distance algorithm 426
Inverse-distance interpolation 424
I-ordered data 31, 33, 61

blanking 449
data point table example 32
example in POINT format 61
example with BLOCK format 62
example with POINT format 62
files 45
FORTRAN example in BLOCK format 62
maximum I-index 61
maximum index 49
one variable data files 69
POINT format 61
probe limitations 434

I-ordered zones 146
I-planes 35

animation 482
description 34

Irregular data 424
interpolate 3-D volume 339
triangulating 422

ISO-Latin 1 characters 272

Iso-Surface Details dialog
Definition page 345
Style page 346

Iso-surfaces 343, 346
3-D volume analytic function plot 355
adding 346
blanking 457
contour flooding 346
contour line color 347
contour line thickness 347
contour lines 346
contour type 346
deleting 346
extraction 347
FE-surface zones 347
generating 345
lighting effect 347
locating 345, 346
mesh 346
mesh color 346
mesh line thickness 346
shade color 347
shading 347
translucency 347
zone extraction 347

J
JK-ordered data 31, 32
J-lines 34

family 33
J-ordered data 32
JPEG

files 367, 373
J-planes 35

description 34

K
Keyboard 543
Keyboard shortcuts 543

3-D rotation 138
Contour Add tool 544
Contour Remove tool 544
Ctrl-A (Paste View) 22, 24
Ctrl-F (Fit to Full Size) 24
Ctrl-F(Fit to Full Size) 22
Ctrl-L (Last) 22, 24
Ctrl-X (Cut) 14
enlarge or reduce 11
F1 help 12
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for mouse tools 544
geometries 544
H and V keys to restrict horizontal and vertical 

adjustment 442, 446
mouse tool modes 7, 22
O (Origin reset) 138
plot translation 140
plot zooming 140
R (Rollerball rotation) 138
rotate 138, 544
S (Spherical Rotation) 138
Slice tools 545
streamtraces 546
T (Twist rotation) 138
Translate/Magnify tool 24, 546
UNIX creation 505
X (X-axis rotation) 138
Y (Y-axis rotation) 138
Z (Z-axis rotation) 138
Zoom tool 547

K-ordered data 32
K-planes 35

description 34
Kriging 426

algorithm 428
data interpolation 424
interpolation 426

Kriging dialog 427
Kriging option 427

L
Label Points dialog 188
Labels

see also Custom label record
cells 135
contour 211
creating 135
Custom 311
CUSTOMLABELS Record 312
data points 135
limits in Tecplot 563
on contour levels 211
tick mark label display 309
tick mark label spacing 313
tick marks 309

Large Rainbow color map 217, 218
Last View

Ctrl-L shortcut 22

Last Workspace View 25, 26
Undo 26

Layer display 129
Layers

Boundary 197
draw order 136
Vector 221

Layout files 88, 90
absolute path 91
batch processing 473, 474
command line reading 530
format 88
macro use 90
opening 93
relative path 91
saving 91
saving via FTP 91
saving via HTTP 91
saving via URL 91
what they include 91

Layout Package files 88, 94
archiving 94
creating with Publish files 96
opening 94
saving 94
using 94
viewing with lpkview 94

Least-squares
algorithm 169
standard and weighted regression 168

Left error bars 180
Left triangle

symbol shape 159
Legends

contour 213
line 153
Line Legend 187
line plots 187
RGB 216
scatter plots 257
text in animations 487

Length
vectors 226

Letter codes
equations 391
variables 391

License number 3
Lift fractions 137

specify with 3D Details dialog 141



589

Light source 137
3D Light Source dialog 137
background light 265
intensity 264
Light Source dialog 264
position 137
positioning 264
surface color contrast 265
zone color shading 260

Light Source Position control 263
Lighting 261, 263

optimizations 265
specular highlights 265

Lighting effect
iso-surfaces 347
streamribbons 238
streamrods 238
streamtraces 238

Lighting zone effect 5, 194, 261
Limitations

axis 143
smoothing 431

Limits
3-D axis 143
Tecplot 563

Line Color
Mapping Style dialog 156

Line Legend 187
Line Legend dialog 187
Line legends 153, 187
Line Pattern

Mapping Style dialog 156
Line pattern

DashDot 157
DashDotDot 157
Dashed 157
Dotted 157
geometry 51
LongDash 157
Solid 157

Line plots
axis range 163
bar charts 148, 183
blanking 459
contours 199
curve fits 166
curve-coefficients 97
default plot type 146
IJK-ordered data 147

IJ-ordered data 147
Interpolate mode probing 440
I-ordered zones 146
least-squares fit 168
legends 187
line color 157
line patterns 157
line thickness 158, 162
lines 148
log axes 164
Mapping Style dialog 147
multi-zone example 63
pattern length 158
plot of speed example 145
point labels 188
probing 439
requirements 32
style attributes 154
symbol 145
symbol attributes 158
symbol sizes 162
symbol spacing 162
symbols 148
symbols filled or outline 161
symbols spacing 163
XY-axis customization 163

Line Segments 166
Line Segments option 166
Line Show

Mapping Style dialog 156
Line Thickness

Mapping Style dialog 156
Line thickness

editing with Quick Edit 158
specifying 182
XY-plots 158

Line type
geometries 51
Line Segments 166

Line zones
1-D 410

Linear Fit option 166
Linear interpolation 428
Linear Interpolation dialog 429
Linear option 429
Lines

3-D line in geometry record 51
arrowheads in geometries 52
arrowheads in polyline geometries 52
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axis 316
contour line controls 210
contour line modes 210
families of 65
fitting to data 168
geometry record 51, 53
lift fraction controls 137
line plot color 157
line plots 148
mesh line pattern 132
pattern 132, 282
pattern controls 283
pattern length 133
printing limitations 134
selecting 281
specify thickness 162
streamline color 236
styles 282
thickness 134
thickness controls 283
thickness limitations 134

Lines map layer 5, 154, 155
mappings 156
Quick Edit dialog 157

Load Data File dialog 80
Load Data File Options dialog 81
Load Data File(s) option 80
Load Single Data File dialog 80
Load/Play Macro File dialog 461, 465
Loadcgns add-on 511
Loaddxf add-on 511
Loadfluent add-on 511
Loadhdf add-on 511
Loadimg add-on 511
Loading add-ons

$!LoadAddOn command 528
Loadss add-on 511
Loadxls add-on 511
Log axes 164
Log scale 164
Logarithms

data operations 394
plotting 394

Logical space 34
LongDash line pattern 157
LPKView utility 94, 95, 538

example 95

M
Macro Language

PLOT3D Loader 119
Macro Recorder dialog 461
Macro Variables dialog 470
Macro Viewer dialog 461, 467, 468

debugging with 467
file evaluation 468
internal variables 469
loading with 467
macro evaluation 468

Macros
animation 477
animation creation 485
batch processing 473
breakpoints 469
color map files 219
command display format 468
command evaluation line by line 468
command line running 464
commands 461
computer moving 476
context 468
control commands 461
creating 461
data file reading 461
data operations 461
data transformation with algorithms 471
debugging features 469
directory moving 476
duplicating actions 461
editing 462
equations 402, 405, 406
equations in 404
evaluating 468
example files 406
file benefits 472
file debugging 467
file evaluation 468
file playback 530
file recording 461
file specifying 530
file viewing 467
files 97, 461
frame set up 461
function definitions 461, 462
function file example 466
function installation 465
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function naming 463
functionname 463
geometry linking 295, 466
gray scale 463
hardcopy plot creation 471
ignoring messages 530
interactive demonstration development 471
interface running 465
layout file reading 461
layout files 90
loading with Macro Viewer 467
looping 461
message ignoring 530
modifying 461
movie creation 485
moving 468, 476
playback 461, 463, 530
playing by stepping through Macro Viewer 

commands 464
playing from the command line 530
playing from the File/Macro/Play option 464
playing from the Quick Macro Panel 464
Quick Macro Panel running 465
record 461
repetitive actions 461
retaining functions 463
text changes in animation 487
text linking 295, 466
text moving 468
variable modifying 471
variable name changing 405
variable value modifying 471
view 461
watch variable specifying 470
watch variables 469
zone specifying 403

Magnification factor 23
Magnifying

onscreen image 25
paper and image 25
within a frame 23

Make Current View Nice option 3, 21
Map Layers 4
Map layers 3, 154

activating and deactivating 154
Bar charts 5
Bars 5, 183
changing 154
Error Bars 5

Lines 5, 154, 155, 156
Symbols 5, 155, 159

Map Show option 152
Mapping Style control 4
Mapping Style dialog 147, 152

assign dependent variables 175
assign independent variables 175
Bars page 184
clamped spline fits 172, 173
Curves page 166, 168
Definitions page 165
Dependent Variable option 175
error bars 182
Error Bars page 179, 180, 181
exponential curve fitting 170
Fill color 159
fill color 161
Indices page 147, 184, 185
Line Color 156
Line color 157
Line Pattern 156
Line Show 156
Line Thck 158
Line Thickness 156
Line thickness 158, 159
line thickness 162
Line Type 166
Lines page 156, 157
Outline color 159, 160
parametric spline fits 173
Pattern Length 156
Pattern length 158
power fits 171
spline fits 172
Symbols page 158, 159, 161, 162

Mappings 145, 147, 187
activate 150
animation 477, 481
axis variables 150, 153
coefficient extraction 178
curve-weighting variables 176
deactiviate 150
defaults 497
defining 148
Dependent Var 151
editing 150
fill color 161
geometry attachment 285
Independent Var 151
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indices 185
line legends 153
Lines map layer 156
lines to show 156
name changes 150
Quick Edit 156
style alteration 154
symbols 159
varying index 184
X-Axis Num 151
Y-Axis Num 151
zone names 151
zones 150, 152

mappings
X- and Y-variables 152

Maximize Workspace option 19
Maximum value 395
Menu bar 2
Menus

Data 3
Edit 2, 26
File 2
Frame 3
Help 3, 12
Insert 3
Menu bar 2
Plot 3
Style 267
Tools 3
View 3
Workspace 3

Mesh plots
2-D creation 124
2-D field plot creation 124
3-D creation 125, 126, 127
3-D overlay 194
axis variable assignment 126
creating 124
definition 193
displaying for selected zones 130
displaying selected zones 129
finite-element data 124, 126
finite-element volume data 127
Hidden line 194
IJK-ordered data 125, 126
IJ-ordered 124, 125
line pattern 132
line pattern length 133
line thickness 134

modifying 193
Multi-color option 131
Overlay 194
pattern length 134
type 194, 195
wire frame 194
zone color 131

Mesh zone layer 4, 123
Meshes

iso-surfaces 346
quadrilateral 336
streamribbons 237, 238
streamrods 237, 238
streamtraces 237, 238
triangular 336

Minimum value 395
Mirror option 419
Modern color map 218
Modes

3D rotation tool 6
Adjustor tool 446
contour line 210
Create Frame 13
Data extraction 6
Frame tool 6
Geometry tool 6
mouse 6
mouse tool shortcuts 6, 7, 22, 543
Probe 6, 433
Probe Nearest Point 437, 442
shortcuts 543
Snap 3, 8
Snap to Grid 18
Snape to Paper 18
Streamtrace tool 6
Text tool 6
Tools 4
Translate/Magnify 22
Translate/Magnify tool 24
Zone creation tool 6
Zoom 21

Mopup string 362
Motif

command line options 532
configuration files 494
file dialogs 9
file name filters 9
Framer running 537
print setup 360
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printing 360
Mouse

Ctrl-click in Tecplot 10
moving objects 10
positioning objects 10
scaling 11
selecting objects 10
use 9

Mouse modes
3D rotation 6
Add Contour Label tool 211
Add Streamtrace Termination Line 239
Adjustor and Selector 6
Adjustor tool 446
Create Frame 13
data extraction 6
Frame 6
Pointer 6
Probe 6, 433
resizing frames 14
shortcuts 543
streamtrace 6
Tool shortcuts 6, 7
tool shortcuts 22
Tools 4
Tools shortcuts 543
Translate/Magnify 22
Translate/Magnify tool 24
view 6
zone creation 6
Zoom 21

Movies 477
AVI file viewing 489
creation 484
file creation 478, 479, 480, 481, 482, 483, 484
files 477
Raster Metafile viewing with Framer 490

Moving
paper and image 25

Multi-color option 131
scatter plots 251

Multiple zones 31
Multiplication

binary operator 394
Multi-zone line plot

example 63

N
Names

variable name display 438, 439
variable naming 405
zone names in animations 486

Nearest N option 425, 428
Nearest Point mode

data set indices 437
probe 433, 442, 445
probing plots 439

Newline
multiple lines in text record 50

Nice Fit to Full Size option 3, 21
Nodal data 39
Nodes

custom labels 55
labeling 135

O
O (Origin reset shortcut) 138
Object Details button 4, 7
Object Details option 446
Objects

moving 10
positioning 10
scaling 11
selecting 10

Octant option 425, 428
Octothorp (#) 402
Offsets

for equations 395
One Line per Variable option 438, 439
Open Layout dialog 93
Open Layout option 93
OpenGL

configuration options 498
Operands

number specifying 404
Operations

coordinate systems 13, 19
cut, copy and paste 13
managing workspace 13
working with files 13
working with frames 13

Operator precedence 394
Ordered data 31, 43

format 61
IJK-ordered 67, 125, 339
IJ-ordered 124, 125
IK-ordered 32
JK-ordered 32
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J-ordered 32
K-ordered 32
spreadsheet viewer 385

Ordered zones 46, 400
maximum J-index 49
maximum K-index 49
record parameters 57

Ordinal values
ASCII characters 272

Orientation
paper 359

Orientation option
printing 359

Orthographic projection 141
zooming 140

Outline Color 159
Outlined symbols 161
Outside Points

interpolation 429
Overlay plots 16, 194
Override Layout Data dialog 93

P
Paneled shade plot types 263
Paper

coordinate systems 19
displaying 18
fill color 18
landscape orientation 18
moving 25
orientation 18, 358
Orientation option 359
Paper Fill Color option 359
portrait orientation 18
setup 17, 358
size 17, 358, 359
source 358
zooming 25

Paper Fill Color option 359
Paper ruler 14
Paper Setup dialog 18, 358

paper orientation 358
paper size 358

Parametric splines
fitting 173
fitting to data 173

ParaSpline option 167
Parasplines 167

fitting 173
Parentheses ( ) 395
Partial read options 86
Paste 13

color map from file 220
style from file 89

Paste Style from File dialog 90
Paste Style Options dialog 90
Paste View 22

Ctrl-A shortcut 22, 24
Paste View option 24
Pattern Length

Mapping Style dialog 156
Pattern length

editing with Quick Edit 158
specifying 158

Pause in Framer 538
Pen Plotter Device Configuration dialog 363
Pen Plotter option 363
Pen plotters

configuring 363
Plotter Speed option 363

Perform Extra 3D Sorting option 140
Performance 502

rotating 140
translating 140

Performance button 4, 5
Perspective plots

zooming 140
Perspective projection 141
Phone Number

for Technical Support 12
Pixels

frame size 14, 486
Place Streamtrace mouse mode 232
Place Streamtrace tool 232
Plain arrowheads 224
Planes

animation 477
I 35
IJK-plane extracting 339
J 35
K 35
slice plane definition 348
slicing 348
slicing volumes 339

Plot layers
Boundary 197
Contours 199
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Vector 221
Plot menu 3, 126, 129, 135

2D Draw Order option 136
Advanced 3D Control option 137, 140
Contour Variable option 204
Reference Vector 229
Slices option 348
Streamtraces 235
Vector Arrowheads option 225, 226

Plot type
Polar Line 4, 558
XY Line 5, 146

Plot Type control 3
Plot Types

3D Cartesian 137
coordinate systems in Sketch 272
text position in Sketch 272
view stack 24

Plot types
2D Cartesian 4, 123
3D Cartesian 4, 123
grid coordinate system in Sketch 272
Sketch 4, 267
text size in Sketch 272
XY Line 4, 147

PLOT3D Data Loader 116
PLOT3D files 76, 77

examples with Preplot 78
Loadplot3d add-on 511
PLOT3D Loader 116
Preplot options 77
solution files 77

PLOT3D Loader
auto detect option 117
auxiliary data 120
binary files 118
description 116
file combinations 116
instruction syntax 119
limitations 121
macro language 119
unstructured data files 117

PLOT3D Loader dialog
Data Subset page 118
File Selection page 116
File Structure page 117

Plotter Speed option 363
PNG files 367

creation 375, 376

image creation 375, 376
POINT format 106, 108, 109, 124, 126, 127

3-D volume data files 331
BIT data type restriction 46
creating a data file 326
description 87
example data file 124
example of I-ordered data 61
example with IJK-ordered data 67
example with IJ-ordered data 65
example with I-ordered data 62
examples 45, 63
FORTRAN example for triangle mesh 72
FORTRAN example with IJK-ordered data 68
FORTRAN example with IJ-ordered data 66
I-ordered data 61
triangle mesh example 71
writing ASCII 87

Points
extracting 417
text height units 50

Points from Geometry option 417
Points from Polyline option 417
Polar

axis position 317
Polar axis 301
Polar coordinates

transforming 407
Polar Drawing Options dialog 190
Polar Line

axis control 164
Polar Line plots 4, 558
Polar plots

drawing characteristics 190
Polylines

3-D geometry record 53
arrowheads 52, 286
create from zones 421
creation 281
geometry record 51, 53
limits in Tecplot 563
line thickness controls 283
point extraction 417
selecting 281
Sketch plot type creation 280

Polynomial Fit option 166
Polynomials

algorithms 169
fitting 169
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Pop geometry 284
Portable Network Graphic files 367
PostScript

conversion software 361
exporting 375
print format 360
print precision 362

PostScript files 367
Power curves

fitting 171
fitting with Quick Edit 171

Power Fit option 166
Precise blanking 450, 452
Precise dot grid

axis 305
Predictor-corrector algorithm

streamtraces 244
Preferences

color 500
configuring with Display Performance 

dialog 502
Interface 8
performance 6
size 500
Status line 6

Preferences option 493
Preplot 43, 540

ASCII data to binary 43
command line options 540
converting ASCII to binary 79
examples 76, 77, 78
options 76
PLOT3D options 77
preprocessing data files 76
running under Windows 76
special character requirements 272

Preserve Screen Distance
Distance ratio 141

Preview image
Encapsulated PostScript files 372

Print
Batch mode printing 473
continuous flood plot limits 565
EPS files 371
Extra Precision option 362
file name specifying 530
formats 360
HP-GL print format 360
HP-GL2 print format 361

line thickness limitations 134
mopup strings 362
Motif systems 357, 360
multiple files 473
Paper Fill Color option 359
paper orientation 358, 359
paper setup 358
paper size 358
pen plotter configuration 363
Pen Plotter option 363
pen plotters 363
Plotter Speed option for pen plotters 363
PostScript conversion for printer 

incompatibility 361
PostScript print format 360
precision controls 362
precision with PS, HPGL 362
preview 365
Print Preview option 365
print spoolers 361
PS files 371
spool commands 361
Spooler Cmd option 361
startup strings 362
Tecplot version number 530
translucent plot limits 565
translucent plots 262
tray selection 358
UNIX print spoolers 361
UNIX spool commands 361
version number, Tecplot 530
Windows default 360
Windows printers 360

Print dialog 357
Preview option 365
Print Setup option 358, 360

Print files 97
destination 530
file name specifying 530

Print option 357
Print Preview option 365
Print Render Options dialog 364

Color option 364
Force Extra Sorting for all 3D Frames 

option 364
Image option 364
Resolution option 365
Vector option 364

Print Setup dialog 358, 360, 361, 362
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Extra Precision option 362
paper orientation 358
paper size 358
paper source 358
Pen Plotter option 363

Print Setup option 358, 360
Print to a File dialog 357
Printers

PostScript conversion software for 
incompatible printers 361

Windows setup 360
Probe 433, 435, 436, 444

3-D volume 436, 437
3-D volume zone 437
Adjustor tool editing 445
at specified locations 444
axes 442
cell center values 439
controls 436
data editing 446
data modification interactively 433
data point exact results 435
data points 433
data set indices 437
data sets 444
data viewing 438
editing 433
field plot data 438
finite-element zones 439
Interpolate mode 433, 439
I-ordered data limitations 434
line plots 439
line plots with Interpolate 440
Nearest Point mode 433, 439, 442
planes 438
points 433
precise controls 436
shortcuts 545
spatial coordinates 436
specific locations 436, 443, 444
variable values 438
viewing values of all variables 433
XY-data specifying coordinates and 

indices 443
Probe At dialog 433, 436, 443
Probe At option 436, 443
Probe dialog 433, 434, 435, 438, 439, 441
Probe Interpolate mode 440
Probe mouse mode 6, 433

Probe Nearest Point mode 442
Probe tool 6, 433, 434, 436, 442
Probe/Edit Data dialog 445, 446
Projection 141

orthographic 141
perspective 141

PS files 367
printing 371

Publish Options dialog 96
Publishing plots on the Web 96
Push geometry 284

Q
Quadrilateral

cells 449
element type 38, 70
mesh 336

Quadrilateral polygonal elements
FE-surface zones 325
finite-element data 326

Quick Edit button 4, 7, 8
Quick Edit dialog 11, 127, 130, 131, 132, 195, 

224, 225, 251
catter symbols 252
changing symbol shapes 160
editing filled or outlined symbols 161
editing symbols 159
enable or disable plot layers 130
error bar colors 181
error bars 181
fitting exponential curves with 170
fitting power curves 171
fitting splines to data 172
Geometry 282
geometry alignment 294
geometry creation 282
line color 157
line display 157
line pattern length 133
line thickness 134, 158, 162
line types 166
Lines map layer button 157
mappings 156
parametric spline fits 173
parasplines 173
pattern length 158
specify line pattern 132
specify zone color 131
symbol attributes 159
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Symbol outline color 160
symbol shapes 159
symbol size 162
symbol spacing 162
text alignment 294

Quick Macro Panel 465
Quotes strings

in data files 43

R
R (Rollerball rotation shorcut) 138
Rakes

streamtraces 231, 233
Random data 423, 424
Range best float tick marks 310
Raster formats 367

export region 369, 370, 372, 373, 375, 376, 
377, 378, 379, 380

file export 367
Raster Metafile 367
Sun Raster 368
TIFF 368
X-Windows 368

Raster Metafiles
AVI conversions 541
bitmaps 490, 537
creating 375
Framer movie file 484
Framer viewing 490
interactive creation 484
raster format for Framer 367
viewing 489

Raw User-Defined color map 218
modifying 219

R-Axis Var versus All Other Variables 150
RBG coloring

scatter symbols 251
Record keywords

index 43
Record types

partial read options ??–82
Rectangle

geometry record 51, 52, 53
Rectangles

creation 282
selecting 281
size controls 288

Rectangular coordinates

transforming 407
Rectangular zones

creation 410
in 2D Cartesian plots 410
in 3D Cartesian plots 411

Redraw 4, 5, 21
Redraw All 5, 25
Reference scatter symbol 255
Reference Scatter Symbol dialog 255
Reference vector 229
Reference Vector dialog 229
Regression

least-squares methods 168
Relative path 90, 91
Reset 3D Axes option 142
Resizing

onscreen image 25
Reverse Axis Direction option 180, 300
RGB coloring

channel variable range 216
channel variables 216
continuous 215
description 215
legend 216
of streamtraces 236
options 215
RGB Mode 216
variable assignment 215

RGB Legend 216
RGB Mode 216
RGB values 97
Right error bars 180
Right triangle

symbol shape 159
RM files 367
rmtoavi utility 541
Rotate 22

3-D plots 139
3-D view 137
fly-through motion 139
perspective projection 139
shortcuts 138, 544
speed improvement 140

Rotate dialog 22
Rotation 22
Rounding function 395
Ruler

workspace 25
Ruler/Grid dialog 19
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Ruler/Grid option 19
Rulers

display 19

S
S (Spherical rotation shortcut) 138
Save

as HTML 96
layout package files 94

Save Configuration dialog 494
Save Configuration option 493, 495
Save Layout As option 91, 94
Save Layout dialog 91, 94
Save Layout option 91, 94
Scale

changing 11
enlarge 11
reduce 11

Scatter Legend dialog 257
Scatter plots 247

ASCII fonts 254
color specification 251
creating 247, 248
filled symbol choices 252
legend 257
multi-color options 251
printable character use 249, 250
reference scatter symbol 255
scatter symbol choice 248, 250, 255
sizing by variable 253, 254, 255
specifying STX multiplier 254
symbol lift fraction controls 137
symbol outline color 251
symbol shapes 248, 250
symbol sizes 252
symbol spacing 256

Scatter Size/Font dialog 255
Scatter symbols

3-D shapes 252
outline color 251
Quick Edit dialog 252
reference 255
RGB coloring 251
spacing 256

Scatter zone layer 5, 123, 247
Scatter-sizing variable 391, 397
Scientific Data Sets loader 114
Screen distance 141
SDS Loader 114

Second Order option 431
Second-derivative 399
Select All

frames 26
geometries 26
objects 26
text 26
zones 26

Selector tool 6, 195, 197, 240, 269, 294
Send Output to File option 357
Shade

iso-surfaces 347
Shade Color option 260
Shade plots 259

2-D 259
3-D surface 260
color translucency 260
lighting, Gouraud 263
lighting, Paneled 263
printing 262

Shade zone layer 5, 123, 259, 260
Shared library

loading add-ons 528
Shared variable

data editing 446
Shared variables 399

branching 446
Sharing, connectivity 47
Sharing, variable 46
Shortcuts 543

3D Rotate 544
3-D rotation 138
Contour tools 6, 544
creating and editing in UNIX 505, 532
Ctrl-A (Paste View) 22, 24
Ctrl-F (Fit to Full Size) 22, 24
Ctrl-L (Last) 22, 24
Ctrl-X (Cut) 14
duplicate connectivity lists 71
enlarge or reduce 11
geometries 544
H and V keys to restrict horizontal and vertical 

adjustment 442, 446
Help by pressing F1 12
keyboard 543
modes 543
mouse tool modes 7, 22
O (Origin reset) 138
plot translation 140
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plot zooming 140
R (Rollerball rotation) 138
rotate 138, 544
S (Spherical Rotation) 138
Slicing tool 7, 351, 545
Streamtrace tools 6, 546
streamtraces 546
T (Twist rotation) 138
Tools 6
Translate/Magnify tool 24, 546
Windows icon with command line options 531
X (X-axis rotation) 138
Y (Y-axis rotation) 138
Z (Z-axis rotation) 138
Zoom tool 7, 547

SHORTINT data type 69, 70
Show in All Like Frames option 274, 285
Show Invisible Borders 15
Show Invisible Frame Borders 25
Sidebar 3

Map Layer 3
Mapping Style 4
Object Details 4
Performance 4
Plot Type 3
Quick Edit 4
Snap Modes 4
Zone Effects 4
Zone Layer 3
Zone Style 4

Sign function
data operations 395

Simple boundary conditions 399
Sine function 394
SINGLE data type 69
Size

default size changes 505
Size Preferences dialog 501
Sketch plot type 4, 267

ASCII files 506
circles 287
coordinate system 272
displaying text 274
ellipses 282, 287
geometries 280, 281, 282
geometry alignment 294
geometry attachment to maps and zones 285
geometry position controls 284
line pattern controls 282

line thickness controls 283
polyline arrowheads 286
polylines 280, 281
rectangles 282, 288
squares 282, 287
text addition 267
text alignment 294
text attachment to zones 274
text editing 269
text position 272, 273
text size 272
text string 270
User-Defined fonts 506

Skip factors 82
Slice 343

animation 477
arbitrary slice extraction 352
creation 348
cutting plane specifying 353
extraction 352
finite-element surface zone 353
plane definition 348
pre-defined slice extraction 352

Slice Details dialog 348
Slice tool 348

shortcuts 7, 351, 545
Small Rainbow color map 217
Smooth

IJK-ordered zones limitations 431
Smoothing 430

boundary conditions 431
coordinate variables 430
data 430
finite-element zone limitations 431
limitations 431
zone boundaries limitations 432

Snap modes 3, 4, 8
Snap to Grid mode 18
Snap to Grid option 273
Snap to Paper mode 18
Snap to Paper option 273
Sorting 140

controls 137
Perform Extra 3D Sorting option 140

Space
logical 34

Spacing
between text lines 50

Spatial coordinates
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probing plots 436
Specify Equations dialog 388, 390, 392, 400, 419
Specify Number Format dialog 310
Specular highlights 265
Speed 502
Spherical coordinates

3-D to rectangular transform 407
transforming 407

Spline option 167
Splines

clamped 172, 173
fitting 172
parametric 173
with Quick Edit 172

Spooler Cmd option 361
Spreadsheet Loader 121

limitations 121
Loadss add-on 511

Spreadsheet option 385
Spreadsheets

data alteration 386
data alteration with Data Format 386
data format 106
data viewer 385

Square
creation 282
geometry record 51, 52
selecting 281
size controls 287

Square root
data operations 394
plotting 394

Startup string 362
State Change add-on 512
Status line 8

configuration 6, 8, 504
help 11

Step size
translation 23

Still images 477
Stream dashes

creating 242
skip factor 243
timing 243

Stream markers 241
ASCII characters 241
creating 241, 242
restricting 242
timing 242

Streamlines 235, 343
creating 231
volumes 231

Streamribbons 231, 237, 343
contour flooding 238
creating 233
lighting effect 238
mesh 237
shade color 238
shading 238
translucency 238
width 237

Streamrods 231, 237, 343
contour flooding 238
lighting effect 238
mesh 237
shade color 238
shading 238
translucency 238
width 237

Streamtrace Details dialog 233, 237, 239, 242, 
243, 245, 482

Line page 235
Position page 238

Streamtrace mouse modes 6
Streamtrace Placement dialog 232
Streamtrace tool

shortcuts 6, 546
Streamtraces 221, 231

animation 477, 482
arrows 237
color 236
concatenating 243
contour flooding 238
dashes 241
deleting 238
direction 232, 235
displaying 236
formats 231
integration 244
lighting effect 238
limits in Tecplot 563
line thickness 237
lines in volume streamtraces 231
markers 241
mesh 237
Multi-Color options 236
predictor-corrector algorithm 244
rakes 231, 233
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rod points 237
rod/ribbon width 237
shading 238
starting positions 233, 235
step number 245
streamlines 235
streamribbons 237
streamrods 237
style 235
surface line creation 231
termination line 238
termination line in 3D Cartesian plots 239
timing 241, 243
translucency 238
volume 231
volume formats 235
volume ribbons 231, 237
volume rods 231, 237
zone data type 244

STX multiplier
scatter plot specifying 254

Style
XY-plot legend 257

Style menu 267
Stylesheets 88

batch processing use 476
copying 89
creating or applying 88
format 88
pasting 89
saving frame style 89
specifying 530

Subscripts
creating 270

Subtraction
binary operator 394

Sub-zones
creation 418
extraction 416

Sun Raster files
creating 377
image creation 377
raster format 368

Supersample Factor 369, 371, 374, 375, 376, 
377, 379, 382

Superscript tick marks 310
Superscripts

creating 270
Surface color contrast 265

Surfaces to plot 194
Symbol plots

see Scatter plots
Symbols

ASCII formats 160
attributes 158, 159
choosing filled or outline colors 161
custom creation 295
customization 506
editing with Quick Edit 160, 161
filled 161
line plots 148, 158
outlined 161
Quick Edit 159, 160
shapes 159
sizes 162, 252
spacing 162, 163, 256

Symbols map layer 5, 155
activating 159

T
T (Twist rotation shortcut) 138
Table data format

in Excel Data Loader 106
Tagged Image File Format 368
Tangent function

data operations 394
Tangent vectors 228
TEC100HOME environment variable 1
Technical Support

information 12
Tecplot version number printing 530

Tecplot
Add-Ons 511
basic operations 9
command line 529
command line options, UNIX 532
configuration files 493
customizing 24
Help 11
home directory 1, 529
license information 3
limits 563
starting 1
starting add-ons 511
Technical Support 12

Tecplot GUI Builder add-on 526
tecplot.fnt file 529
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tecplot.phy file
configuring location 508

Telephone Number
for Technical Support 12

Termination lines 238
3D Cartesian plots 239
activating 239
controlling 239
creating 239
displaying 240

Tetrahedral polyhedral elements
FE-volume data set 329, 333
FE-volume zones 325

Tetrahedron element type 38, 71
Text 49

adding 267
alignment 294
anchor position 50, 273
box 50, 273
controls 268, 272
copying 26
cutting 26
deleting 269
dynamic 275
editing 269
fonts 269
mouse mode 6
pasting 26
popping 294
position 272, 273
pushing 294
size 272
tool 6

Text Details dialog 268, 269, 273, 274
Text formatting tags 269
Text Options dialog 273, 274, 295
Text record 43, 86

anchor position 49
boxed 50
color 49
control line 49
coordinate system 49
examples 63
file format 49
height units 50
line spacing 50
origin 49
parameters 59
specify height 50

text string 49
Text Spreadsheet Loader 121

limitations 121
Text strings 270

plot titles and labels 267
subscript creation 270
superscript creation 270

Text tool 267
Theta mode axis option 302
Theta Period 302
Theta Value on Right Circle option 303
Theta-Axis Var versus All Other Variables 149
Theta-Axis Var versus R-Axis Var for All 

Zones 149
Theta-Axis Var versus R-Axis Var for One 

Zone 149
Tick marks 306

axis 306
best float 310
custom 310
direction 308
display 307
display options 3, 21
exponential 310
floating 310
Integer 310
label display 309
label formats 310
label spacing 313
labels 309
length 308
minor 308
range best float 310
superscript 310

TIFF files
creating 378
image creation 378
raster format 368

Titles
axis 314
axis title display 314
axis title offset 315
zones 49

Tool Details button 7
Tool modes 4
Tools 3

Add Circle 281
Add Contour Label 211
Add Ellipse 281
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Add Polyline 281
Add Rectangle 281
Add Square 281
Adjustor 6, 240, 288, 445
animation 477
Contour Add 345
Contour Delete 345
Create Circular Zone 413
Create Frame 13
Create Rectangular Zone 411
Data extraction 6
Frame 6
Geometry 6
Place Streamtrace 232
Probe 6, 433, 434, 436, 442
Quick Macro Panel 465
Selector 6, 240, 269, 294
shortcuts 6, 543
sidebar 6
Slice 348
Streamtrace 6
Text 6, 267
Translate 140
Translate/Magnify 23
Zone creation 6
Zoom 140

Tools menu 3
Animate option 477

Tools mouse modes 4
Top error bars 180
Trace

current slice 353
Transform Coordinates dialog 407
Translate 140

paper and image 25
speed improvement 140
within a frame 23
workspace 25

Translate tool 140
Translate/Magnify dialog 22, 23
Translate/Magnify tool 23, 24

shortcuts 546
Translucency 261

iso-surfaces 347
limits 262, 565
plot printing 262
streamribbons 238
streamrods 238
streamtraces 238

Translucency zone effect 5, 261
Triangle element type 38, 71, 72, 75

FORTRAN code sample 73
in BLOCK format 72

Triangle Keep Factor 423
Triangular mesh 336
Triangular polygonal elements

FE-surface zones 325
Triangulate dialog 423
Triangulate option 335, 423
Trigonometric functions

plotting 394
Truncate function 395
Two Color color map 218

U
Undo 2

description 26
frames 24
Last Workspace View 26
last workspace view 26

Ungridded data 424
UNIX

command line options 532
dialog defaul positions 505
Framer 537
interface default resetting 505
looping outside Tecplot 475
multiple data sets 475
print setup 360
print spoolers 361
printing 360
Spooler Cmd option 361
Tecplot customization 493

Unordered data 423
URL

for Technical Support 12
saving via 91

User-Defined characters 269
User-Defined color map 218, 219

specifying number of control points 219
User-defined data format

in Excel Loader 107
User-Defined fonts

Sketch plot type 506
Utilities

Framer 490, 537
LPKView 94, 95, 538
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Preplot 43, 76, 77, 78, 272, 540
rmtoavi 541

V
V

keyboard shortcut to restrict vertical 
adjustment 442, 446

Value list
for volume data 126

Value-blanking 406, 449, 450
2-D field plots 450
3-D field plots 450
animation 477
Line, 2D, and 3D plot type 450
precise 452

Value-Blanking dialog 450, 453
Var Values

field plots 438
Variable sharing 559

data set information dialog 393
saving to data files 87
VARSHARELIST parameter 46, 74

Variable, shared
data editing 446

Variables 390
case sensitivity 390
cell center viewing 439
collapsing lists 86
connectivity list sharing 74
contour 204
coordinate variable smoothing 430
creating new 390, 400
curly braces 391
curve-weighting 176, 177
data operations 390
data type specifying 400
data types 400
default axis assignments 44
dependent and independent 175
equations 390
interpolated values 434
letter codes 391
loading by name options 83
location 39
macro watch variables 469
maximum number per data sets 563
name changing with macros 405
name display 438, 439
name length limits in Tecplot 564

name reference 390
naming 405
number per data point 400
one variable data files 69
renaming 393
shared 399
specifying Double precision 87
specifying Float precision 87
system macros 469
value viewing 438
values 188
viewing information 393
viewing range of 393

Varying index
mappings 184

Vector
components 221, 231, 232
controlling length 226
field 231
length in 3-D 229
reference 229
relative length 226
skipping 227
tangent vectors 228
variable selection 221

Vector Arrowheads dialog 225, 226
Vector graphics

exporting files 367
Vector Length dialog 226, 227
Vector plots 221, 231

3-D 229
3-D creation 228
head style 224
index skip 227
length of vectors 226
spacing 227
specifying 224
streamtrace 231

Vector Variables dialog 232, 235
Vector zone layer 5, 123, 231
Vectors

lift fraction controls 137
Version number

printing 530
Vertical error bars 180
View

3D View Details dialog 141
angular orientation 137
center 22
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changing in workspace 17
controlling plot view 13
copy 22, 24
data fit 21
distance 137
modifying 21, 141
orientation 137
paste 22, 24
Performance button 4
plot projections 140
plot translation 140
plot zooming 140
Pop 284
position 137
Push 284
redraw 5, 21
restore last 22

View menu 3, 21
3D Rotate option 137, 139
3D View Details option 137
Copy View 24
fit plot to full frame 24
Fit to Full Size option 24, 105
Paste View 24

View mouse modes 6
View stack 24
View stack depth

limits in Tecplot 564
Viewbin add-on 512
Views

modifying in workspace 24
paste style from file 89

Volume data
controlling volume mode of IJK-ordered data 

in 3-D 339
extracting outer surfaces of finite-element 

volume zone 339
generating iso-surfaces in 3-D 339
interpolating irregular in 3-D 339
slicing 339

Volume data value list 126
Volume Grid

importing GRIDGEN files 113
Volume plots

creating specialized 3-D volumes 339
Volume ribbons 231

creating 233
width 237

Volume rods 231

creating 233
width 237

W
Watch variables

macros 469
specifying 470

Web
address for Technical Support 12

Weighting
inverse-distance 424

Whole cell blanking 450
Wild color map 218
Windows

command line run options 530
command line shorcuts 531
command line start options 530
Copy and Paste options 380
default printer 360
file dialogs 9
Framer commands 538
looping outside Tecplot 475
printer choices 360
Tecplot running 1

Windows Bitmap files 367
Windows Metafile export

in Unix and Windows 379
Windows Metafile format 97
Windows Metafiles files 368
Wire Frame plots 194
WMF files 368
WMF format 97
Workarea

see Workspace 19
Workspace 8

configuring with Display Performance 
dialog 502

fit all frames 25
fit paper 25, 26
fit selected frames 25
grid 18, 25
last view 25
managing 13, 17
maximizing 19
modifying view 24
paper ruler 14
paper setup 17
positioning objects 10



607

redraw all frames and paper 25
regenerating 5
restoring last view 22
ruler 25
ruler spacing 19
selecting objects 10

Workspace menu 3
Color Map option 217
Maximize Workspace option 19
Ruler/Grid option 19

Write Color Map dialog 219
Write Data File option 335, 387
Write Data File Options dialog 86, 335
Write Data Points to File dialog 178
Write Macro File dialog 461
WWW

for Technical Support 12

X
X (X-axis rotation shortcut) 138
X-Axis Var versus All Other Variables 149
X-Axis Var versus Y-Axis Var for All Zones 149
X-Axis Var versus Y-Axis Var for One Zone 149
X-Windows

raster format 368
XY Line plot type 4, 5, 147

Mappings 147
XY-axes

log 164
multiple 164

XY-data
entering 415

XY-value entry 415
XY-variables

axis range 164
mappings 152

Y
Y (Y-axis rotation shortcut) 138
Y-Axis Var versus All Other Variables 149

Z
Z (Z-axis rotation) 138
Zero value 398
Zombie zones 86
Zone creation mouse modes 6
Zone Effects 4

Lighting 5, 194, 261
Translucency 5, 261

Zone Layers 4
Zone layers 3, 4

Boundary 5, 123, 193
Contour 4, 123, 204
displaying 129
draw order 136
enabling for field plot zones 130
Mesh 4, 123, 193
Scatter 5, 123, 247
Shade 5, 123, 259, 260
Vector 5, 123, 231

Zone numbers
zone number specifying for operands 404

Zone record
BLOCK format 68
connectivity list 70
element type 49, 70
element types 70
finite-element data 49, 58
formats 44
IJK-ordered data 67
IJ-ordered data 65
initial color 49
I-ordered data 61
maximum index 67
maximum J-index 49
maximum J-nodes 67
maximum K-index 49
maximum K-nodes 67
number of elements 49, 70
number of nodes 49, 70
numerical values 46
ordered data 57
parameters 57, 58
repeating values 46
title 49
type 49

Zone Style control 4
Zone Style dialog 127, 130, 131

activating and deactivating zones 129
Boundary page 197
Contour page 200
Effects page 261
enable or disable plot layers 130
line pattern 132
line pattern length 133
line thickness 134
Mesh page 130, 132, 133, 134, 193
Points page 341
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Scatter page 248, 251, 252
Shade page 259
Surfaces page 339
Vector page 222, 223, 227
Volume page 233
zone color 131

Zone types
parameters 48

Zone/Cell Info
field plot viewing 438

Zones
1-D line creation 410
2-D circular creation 413
2-D rectangular 410
3-D cylindrical creation 414
3-D rectangular creation 411
3-D surface zone projections 419
3-D volume 454
3-D volume zones 437
activate and deactivate 129
altering 400
animation 477, 478, 483
assign to XY-mappings 150
blanking 449
boundary extraction 336
boundary smoothing limitations 432
boundary zone triangulation 423
collapsing 82, 86
colored Gouraud shading 260
colored Paneled shading 260
colors in plots 131
Create Rectangular Zone tool 411
creating 409
cutaway plots 457
data alteration 388
data point values 423
data structuring 31
deleting 421
dimension reporting 438
displaying mesh 129
displaying selected zones in plots 130
duplicating full zones 418
extracting outer surfaces of finite-element 

volume zone 339
finite-element 409, 422, 424
finite-element boundary extraction 336
finite-element formats 438
finite-element slicing 353
finite-element surface 70

finite-element volume zone blanking 263
finite-element volumes 325
finite-element zone smoothing limitations 431
geometry attachment 285
IJK-blanking 456
IJK-indice maximums 438
index range 400
I-ordered 146
iso-surface zone extraction 347
light source shading 260
macro specifying 403
mappings 152
mirror creation 419
multiple 31
multi-zone line plot example 63
names in animations 486
names in scatter legend 257
number specifying for operands 404
numbers in equations 395
ordered 46, 400
Ordered format 438
partial read options 82, 86
record 44, 46
rectangular zone creation 410
renaming 392
reporting numbers 438
Select All 26
selecting 400
skip selections 400
solid flooding 259
solid shading 260
specify color in plots 131
streamtrace zone data types 244
sub-zone creation 418
sub-zone extraction 416
text attachment 274
title limits in Tecplot 564
type parameters 48
type reporting 438
view 129
viewing information 392, 438
weighting 424
writing selected zones 86
XY-data creation 415
XY-value entry 415
zombie 86

Zones to Alter option 419
Zoom

3-D 140
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orthographic plots 140
paper and image 25
perspective plots 140
speed improvement 140
within a frame 22
workspace 25
zooming plots 13

Zoom tool 140
shortcut 7
shortcuts 547
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